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Chromera Overview   

Chromera is a powerfully-easy data system for liquid chromatography.  It provides highly 
configurable and responsive LC instrument control for multi-detector systems, combined with an 
elegantly simple user interface for interactive processing, and flexible, multi-channel quantitation 
and reporting. Chromera is designed to display all of the necessary information on the screen to 
give you complete control of your system.  The screen layout consists of a Navigation pane on 
the left that contains buttons and tree lists to select various views within the software. The views 
are composed of different combinations of controls contained within separate panes or frames. In 
many cases a control contained within one pane will interact with other controls contained in 
other panes. The views are pre-determined but as you become more familiar with Chromera, you 
are able to construct views of your own, save them, and recall them on demand. 

The main Chromera window includes standard elements such as a title bar, a menu bar, and 
a toolbar. The main area of the window includes a navigation pane on the left-hand side, 
Status and Control panels on the right-hand side, and a main display in the center whose 
contents vary depending on the selected environment. You can hide the Navigation pane, 
Control panel, and Status panel to provide maximize usable main display screen space The 
Status panel and Control panel will not be displayed in an offline instance of Chromera. 

 

When more than one frame is displayed in the main display area (as shown in this example 
where it contains two frames: a plot and a parameter section) you are able to adjust the 
relative sizes of the frames by means of a splitter bar between the two frames. The main 
window title bar will always display Chromera. In an online instance Chromera is followed 
by – the instrument name followed by – the user name in parenthesis. For example: 

Chromera – Instrument 1 (GolayM) 
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An offline instance associated with an instrument will look essentially the same but with 
Offline following the instrument name. An offline instance not associated with a particular 
instrument will show Offline and then just the user name: 

Chromera – Instrument 1 Offline: (GolayM) 

The main environments in Chromera are Run Time, Method, Sequence, Post Run, Reprocess 
and Reports. 

About Fast User Sw itching 

Fast User Switching, is a feature of Windows XP Home Edition and Windows XP Professional 
(when it is not joined to a domain) that makes it possible to switch between users without 
actually logging off from the computer. Multiple users can share a computer and use it 
simultaneously, switching back and forth without closing the programs they are running. 

Operation of Chromera is not compatible with Fast User Switching and therefore Fast 
User Switching must be turned off under User Accounts in any workstation on which 
Chromera will be run. 
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Run Time 

The Run Time environment consists of three views, one for each of the three modes of 
operation: Manual Control, Single Run, and Sequence. Each of these views contains two 
frames: a graphics frame for displaying the signal from one or more channels, and a frame 
that displays control parameters relating to the mode of operation.  The active mode of 
operation is selected via the set of radio buttons in the upper section of the navigation pane. 

 

 

Manual Control Displays settings to provide immediate control of the 
instrument devices. 

Single Run Displays the controlling method or run parameters such as 
sample name and vial number. 

Sequence Displays the sequence or the method from the current row (or 
a selected row when sequence is not running) 

 

For full details see Run Time. 
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Method Editor 
In the Method Editor environment sections of the method are displayed in the center of the 
screen. The specific section displayed depends on the selection in a tree control shown in the 
upper section of the Method pane. You can select and display the Instruments, Channels, 
Peak Detection, Calibration, or Reports section. 

 
For full details see Method Editor. 
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Sequence Editor 

In the Sequence Editor environment the main display area contains a single frame that 
displays a view of the sequence. The specific view displayed depends on the selection made 
via radio buttons in the upper section of the navigation pane. You can select Global 
Settings or Sample List. 

 

For full details see Sequence Editor. 
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Post Run 

The Post Run environment contains two frames, one for graphics and one for result data. 
You may maximize one or the other. The selection in the Views tree determines the 
configuration of the chromatograms frame, while the selection in the Data tree determines 
the selected chromatogram and the contents of the results frame. 

 

For full details see Post Run Environment. 
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Reprocess 

The Reprocess environment contains two frames. The upper frame contains controls for 
setting up the reprocessing functions and the lower frame both displays the batch to be 
reprocessed and allows selection of the sample in the batch to be reprocessed. 

 

For full details see Reprocess. 
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Reports 

The main area of Report Viewer is a PDF viewer. It provides the basic requirements of page 
selection, a variable magnification display, and printing. In addition it provides some search 
capabilities. 

 

For full details see Report Viewer.  
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Navigation Pane 

The Navigation pane consists of two main panels: the upper Navigation Panel and the 
lower Button Panel. The Button Panel contains context-switching buttons that provide 
access to the major environments of the software. The Navigation Panel contains secondary 
navigation and selection controls specific to the current environment. The contents of the 
upper panel of the Navigation Pane depend on the selected environment. 

The buttons available in the Navigation Pane are: Run Time, Method, Sequence, Post Run, 
Reprocess, and Reports.  They can be displayed as buttons or icons.  They can be displayed 
as buttons or icons. A selected button is highlighted to indicate the current environment. 
Moving the mouse pointer over a button will temporarily highlight it. You can resize the 
button panel by dragging the divider above the buttons. As the size is reduced, buttons are 
removed from the bottom of the list. Hidden buttons are displayed as icons displayed on the 
bottom section of the panel (the icon bar), which is always visible. 

The title at the top of the navigation pane is the same as the text on the currently selected 
button. The icon bar at the very bottom of the button panel is always displayed. Clicking on 
the icon at the right hand side of the icon bar displays a popup menu. When there are no 
buttons the popup menu icon will still be available. The iconized buttons are: 

Button  Icon 

Run Time 
 

Method 
 

Sequence 
 

Post Run 
 

Reprocess 
 

Reports 
 

The Navigation pane can be pinned in place at the left hand side of the screen or set 
to the AutoHide mode, so that it appears when the Navigation tab is selected from 
the fly-out panel and then disappears a few seconds after the mouse pointer is 
moved elsewhere on the screen.  
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Device Connections 

The Device Connections dialog appears when you first start Chromera to show the 
instruments connected, indicated by a checkbox in the Connected column. You can also 
connect or disconnect devices while running Chromera by selecting Device Connections 
from the Control Panel and clicking on the Connect/Disconnect button. 

 

When starting Chromera, if a Device does not connect (as indicated in the Device 
Connections dialog) turn the device off (power down the device), wait about 30 seconds, 
then turn it back on. This usually establishes the connection. If not, click the 
Connect/Disconnect button for that device. 

Control Description 

Dialog A row is displayed for each instrument module configured on the 
system.  The module is identified by the name given to the device by 
the analyst during configuration. 

Device The name given to the device by the analyst during configuration 

Connected? A check box indicating the current connection state of the module. 
The box is checked if the software is currently in communication with 
the instrument. You are not able to directly change the state of this 
control by clicking on it. 

Connect/Disconnect Click the button to make the software attempt to connect to the 
module or to disconnect from it (depending on the current 
connection state). In the case of the ICP-MS, the software attempts 
to communicate via the NEXUS interface, or terminate 
communications, as applicable. 

For the other modules, if the software is currently controlling the 
module it will release it. If the software is not currently controlling 
the module it will attempt to communicate with it (and seize it where 
applicable).  

Tries Displays the number of attempts the software has made to connect 
to the device. 

 

Messages 

If there are messages associated with the current session of the Device Connections dialog 
then they are displayed associated with the appropriate device and are viewed by expanding 

the device row by clicking on the  sign.  
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When the dialog is opened from the Tools menu and you initiate an action (e.g. by clicking 
on the Connect button for a device), a message is displayed below the display to confirm the 
action. Similarly, if an error results from that action then an error message is displayed in the 
same area. This ensures you will see the messages, even if the row for that device is not 
expanded. 

 

All device messages are cleared when the Device Connections dialog is closed (although 
errors will be retained in the Error Log and can be viewed at any time). Whenever the Device 
Connections dialog is opened from the Tools menu, it will initially contain no device 
messages (unless one happens to be generated coincidentally). 
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Common Menus 

There are menu items common to every environment (File, Edit, View, Tools, and Help). 
Since the contents of the File menu is customized for every environment that menu is 
described in the sections specific to each environment and not here (but see Exit Dialog for 
details of the Exit dialog). 

For example, a set of functions you might want to access from any environment are gathered 
into the Tools menu. Each of these common tools is independent of any specific 
environment and it operates in a separate window. These functions include: (Batch) 
Reprocess, Export, Import, Preferences, Report Format Wizard, and Sequence Wizard. 

 
Menu Command Description 

View Run Time Switches to the Run Time environment. The same action as 
clicking the Run Time button in the Navigation Pane. 

  Method Switches to the Method environment. The same action as 
clicking the Method button in the Navigation Pane. 

  Sequence Switches to the Sequence environment. The same action as 
clicking the Sequence button in the Navigation Pane. 

  Post Run Switches to the Post Run environment. The same action as 
clicking the Post Run button in the Navigation Pane. 

  Reprocess Switches to the Reprocess environment. The same action as 
clicking the Reprocessing button in the Navigation Pane. 

  Reports Switches to the Report Viewer. 

  Log Viewer Opens a special mode of the Data Selector which displays a 
Microsoft Windows Event Viewer styled listing of the current 
events recorded in the database. 

  Toolbars 
►       View         

Toggles display of the View toolbar. 

         Tools Toggles display of the Tools toolbar. 

  Graphics Toggles the display of the Graphic toolbar. 

  Show Small Icons When selected the toolbar icons displayed will be 16x16 

  Show Large Icons When selected the toolbar icons displayed will be 24x24 

Tools Export ► 
   Chromera Results… 

Methods… 

Sequences… 

Report Templates… 

Displays the Database export dialog. 

Displays the Method export dialog. 

Displays the Sequence export dialog. 

Displays the Report template Export  dialog. 
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  Import ► 
   TotalChrom Data… 

Chromera Results… 

Chromera Methods… 

Chromera 
Sequences… 

Chromera 2.0 Data... 

Report Templates… 

   
 Displays the Import window. 

Displays the Import Results dialog. 

Displays the Import Methods dialog. 

Displays the Import Sequences dialog. 

Displays the Import Chromera 2.0 data dialog. 

Displays the Report template Import dialog. 

  Preferences Displays the Preferences window, showing the preferences 
associated with the current user (see Setting Preferences). 

  Report Format Wizard Displays the Report Format Wizard in New Report mode (see 
Report Format Wizard). 

  Sequence Wizard Displays the Sequence Wizard. 

  Device Connections Displays the Device Connections dialog. 

  View Current Session 
Logs 

Displays the Data Selector - Event Viewer with session log 
information. 

  Error Log Displays the Error Log dialog. 

  Dictionary Editor Displays the Dictionary Editor dialog 

  Reprocess Initiates the Batch Reprocessing function by displaying the Data 
Selector (see Batch Reprocess). It is disabled in an online 
instance when data acquisition is in progress, or a sequence is 
running. 

  Batch Builder Displays the Batch Builder dialog. 

  View Retrieved Archived 
Logs 

Displays a dialog to select a retrieved event logs database to 
display in the Data Selector - Retrieved Session Logs Viewer. 

Help Topics Opens the Chromera Help window. 

  Consumables and 
Accessories 

Opens the PerkinElmer Consumable and Accessories Catalog 

  About Chromera Displays the copyright and version dialog. 
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Common Toolbars 

There are two common toolbars displayed in every environment: View and Tools. A 
Standard toolbar will always appear but the contents will change depending on the 
environment. The standard toolbar is defined within the sections describing the individual 
environments. 

View  Toolbar 

This toolbar simply mirrors the buttons in the Navigation Pane and the commands in the 
View menu. 

 
 
Icon Command Description 

 
Run Time  Switches to the Run Time environment. The same 

action as clicking the Run Time button in the Navigation 
Pane. 

 
Method  Switches to the Method environment. The same action 

as clicking the Method button in the Navigation Pane. 

 
Sequence Switches to the Sequence environment. The same 

action as clicking the Sequence button in the Navigation 
Pane. 

 
Post Run Switches to the Post Run environment. The same action 

as clicking the Post Run button in the Navigation Pane. 

 
Reprocess Switches to the Batch Reprocess environment. The 

same action as clicking the Batch Reprocessing button 
in the Navigation Pane. 

 
Reports Switches to the Report Viewer. 

 

 Tools Toolbar 

This toolbar includes the most commonly used commands from the Tools menu. 

 

Icon Command Description 

 Reprocess Initiates the Batch Reprocessing function by displaying the 
Data Selector in single batch selection mode. 

 Export ►  
Chromera 
Results… 

 

Methods… 

 

Sequences…  

 
Initiates the Export of Chromera results by displaying the 
Database export dialog. 

Initiates the Export of Chromera methods by displaying 
the Database export dialog. 

Initiates the Export of Chromera sequences by displaying 
the Database export dialog. 

 Import ►   
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TotalChrom Data… 

Chromera 
Results… 

Chromera 
Methods… 

Chromera 
Sequences… 

Displays the Import window. 

Displays the Import Results dialog. 

Displays the Import Methods dialog. 

Displays the Import Sequences dialog. 

 Preferences Displays the Preferences window, showing the preferences 
associated with the current user. 

 Report Format 
Wizard 

Displays the Report Format Wizard in New Report mode. 

 Sequence Wizard Displays the Sequence Wizard. 

 Device 
Connections 

Displays the Device Connections dialog. 
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Exit Dialog 

The one File menu command that is common to all environments is Exit. If you select Exit 
in an online instance of Chromera when either a Single Run mode run is in progress or a 
sequence is running, then one Exit dialog displays if User Management is active and a 
different dialog displays if User Management is not active. 

User Management Active Version 

If User Management is active the dialog includes Log Off and Cancel buttons and the 
message text is: 

 

Chromera cannot be closed while an instrument is active. Before closing Chromera you must 
stop any data acquisition or running sequence. Alternatively you can log off Chromera, which 
will hide the Chromera window while data acquisition continues. You can log on again later 
through the Chromera Manager to redisplay the window. 

If you click the Log Off button, the instance of Chromera is locked and hidden, while data 
acquisition continues. If you click the Cancel button then the Chromera window remains 
open and visible. 

W ithout User Management 

If User Management is not active the dialog includes just a Close button and the message 
text is: 

 

Chromera cannot be closed while an instrument is active. Before closing Chromera you must 
stop any data acquisition or running sequence.  

When you click the Close button the Chromera window remains open and visible. 





 

 

Setting Preferences 
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About Setting Preferences 

User Preferences are typically set within the Preferences window. Also, additional user 
preferences are set within the environment with which they are associated. The user 
interaction associated with implicit preferences is described within the environment (e.g. Plot 
Layout) or control (e.g. Plot Styles). Within an instance of Chromera, only the preferences for 
the current instrument and current user displays. 

 

To set preferences, select Preferences from the Tools menu in Chromera. 

1. Set the System Preferences associated with a device. These are Yes/No flags that 
set certain behaviors of user interaction. 

 

2. Set the preference settings associated with each hardware device that includes 
default method settings.  
In addition, some devices have settings enabling you to define limits for status panel 
items. Icons are displayed in the status panel when the current value for such an 
item is above or below the defined range. 
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System Preferences 

You can set following System Preferences: 

 

Preference Description 

Notification when ready 
for manual injection 

Select Yes or No from the drop-down list whether or not an 
Outlook-style notification message is displayed in the lower 
right-hand corner of the screen when a system without an 
autosampler becomes ready for injection. See Manual 
Injection. 

Reload last data set on 
startup for 
Method/Sequence 

Select Yes or No from the drop-down list whether or not the 
data set displayed in each environment at the time the user 
closes an instance of Chromera is reloaded when an instance 
of that type is reopened. 

Automatically load data 
into Post Run during 
acquisition 

Select Yes or No from the drop-down list whether data 
generated by the active sequence is automatically displayed 
in the post run environment as they are generated.  

Automatic reprocessing 
in graphic edit modes 

Select Yes or No from the drop-down list if the data are 
automatically reprocessed with each change made in the 
graphic editors, or if reprocessing only occurs on user 
command. 

Automatic spectral 
reprocessing in graphic 
edit modes 

Select Yes or No from the drop-down list if the spectral data 
are automatically reprocessed with each change made in the 
graphic editors, or if reprocessing only occurs on user 
command. 
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Implicit Preferences 

The term implicit preferences is used only to indicate that you will not enter these settings in 
the Preferences window. However, you enter many of the settings in dialogs while using the 
environment with which they are associated.  

Implicit preferences are: 

Plot options Control the display of chromatograms (and other channel graphics). 
They are set within a dialog and are described in detail in Plot Styles. 

Plot layouts  Defines layout of plots in Run Time and Post Run. They are set within 
dialogs, described in detail in sections (Run Time Graphic Plot Layout 
Dialog, Stacked Plots View, and Matrix View). There are separate 
settings for Run Time, Post Run - Stacked View, Post Run - Matrix 
View.  

Control Panel 
display 

State (floating, pinned or auto-hide) and width. Set by popup menu 
commands and/or direct manipulation of the window. 

Status Panel 
display 

Contents, state (floating, pinned or auto-hide) and width. The content  
are set within the Status Panel Setup dialog. Also, other behavior set  
popup menu commands and/or direct manipulation of the window. 

Navigation Panel 
display 

State (floating, pinned or auto-hide) and width. Also button display 
state (full or iconized). It is set by popup menu commands and/or 
direct manipulation of the window. 

Main display area 
layout 

The relative sizes of each pane. 
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Pump Preferences (Flexar or Series 200) 

Set the following Pump Preferences: 

Control Description 

Lower pressure limit Set lower limit of the pressure below which the pump will 
shut off.  Refer to your pump specifications to determine 
an appropriate value. 

Upper pressure limit Set the upper limit of the pressure, above which the pump 
will shut off. Refer to your pump specifications to 
determine an appropriate value. 

Stop Time After Equil 
(min) 

Set the number of minutes that the pump remains in a 
READY state, after which it will shut down. (The range is 
15.0 min to 999.0 min in 0.1 min increments.) 

Solvent: A  Solvent: B 
Solvent: C  Solvent: D 

Define the name of solvent in reservoir A, B, C, and D 
using up to 25 characters. 

NOTE:  This is the solvent name and it should not include 
% but it is required for correct operation of the Status 
Panel.  

Standby Time (min) Set the number of minutes that the pump will remain in 
the Ready state before changing to the standby flow rate. 
(The range is 15 to 999 min.) 

Standby Flow (mL/min) Set the flow rate to be set after the Standby Time has 
elapsed. 

0.00 to 3.00 mL/min for microbore pumps 

0.00 to 10.0 mL/min for other Series 200 pumps 

Pressure Units Select the pressure units (psi, bar, or MPa) from a drop-
down list to be used throughout the user interface for this 
instrument. When the units are changed, the values for the 
Upper and Lower pressure limit preference settings are 
converted and displayed in the new units. 

NOTE:  The actual maximum value when units are bar or MPa will be the equivalent to 6100 psi 
based on the conversion factors used. 



36 . Chromera User's Guide 

 

Pump Preferences (Flexar SS Pumps) 

Set the following Flexar SS Pump Preferences: 

Control Description 

Lower pressure limit Set lower limit of the pressure below which the pump will 
shut off.  Refer to your pump specifications to determine 
an appropriate value. 

Upper pressure limit Set the upper limit of the pressure, above which the pump 
will shut off. Refer to your pump specifications to 
determine an appropriate value. 

Stop Time After Equil 
(min) 

Set the number of minutes that the pump remains in a 
READY state, after which it will shut down. (The range is 
15.0 min to 999.0 min in 0.1 min increments.) 

Solvent reservoirs used Select from the drop-down list the pair of solvent 
reservoirs (A1/B1, A1/B2, A2/B1, A2/B2) to be used in 
defining the mobile phase composition during the run. 

Solvent A: 1  
Solvent A: 2  
Solvent B: 1  
Solvent B: 2 

Select a name from the solvents dictionary (which 
populates the drop-down list), or enter a new solvent 
name, for reservoir A1, A2, B1, and B2. 

Compressibility  Select from the drop-down list a compressibility factor that 
most closely matches the selected solvent, for reservoir A1, 
A2, B1, and B2. 
 
The compressibility values are: Water: 46, Acetonitrile: 
115, Chloroform: 100, Ethyl Acetate: 104, Hexane: 150, 
Isopropanol: 100, Methanol: 121, THF: 95, Toluene: 87 

Standby Time (min) Set the number of minutes that the pump will remain in 
the Ready state before changing to the standby flow rate. 
(The range is 15 to 999 min.) 

Standby Flow (mL/min) Set the flow rate to be set after the Standby Time has 
elapsed. 

0.00 to 3.00 mL/min for microbore pumps 

0.00 to 10.0 mL/min for other Series 200 pumps 

Pressure Units Select the pressure units (psi, bar, or MPa) from a drop-
down list to be used throughout the user interface for this 
instrument. When the units are changed, the values for the 
Upper and Lower pressure limit preference settings are 
converted and displayed in the new units. 

NOTE:  The actual maximum value when units are bar or MPa will be the equivalent to 6100 psi 
based on the conversion factors used. 
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Autosampler Preferences (Flexar or Series 200, 225, or 275) 

Set the following Autosampler Preferences. 

Control Description 

Flush Volume (µL) Set the volume of flush liquid used for each flush cycle. (The 
range is 1 to 2500 µL in 1 µL increments with a default 
setting of 1000.) 

Flush Speed Select the speed at which the pump will flush the system. 
(The selections are Very Slow, Slow, Medium, Fast and Very 
Fast with a default set to Fast.) 

Number of Pre-Injection 
Flushes 

Set the number of flush cycles before each sample injection. 
(The range is 0 to 9 with a default setting of 0.) 

Number of Post-Injection 
Flushes 

Set the number of flush cycles after each sample injection. 
(The range is 0 to 9 with a default setting of 1.) 

Temperature Control Select On or Off from the drop-down list to set whether the 
tray temperature control 
will be active or not. This is not displayed for No Peltier 
models. 

Tray Temperature (°C) Set the temperature to be maintained when the Peltier 
autosampler tray is installed. (The range is 4 to 60 °C (and -
1 = Off) with a default setting of 20.) 

Tolerance (± °C) Set the deviation from set temperature allowed for the Ready 
condition. (The range is 0.1 to 60.0 with a default setting of 
2.0.) 

Loop Size (µL) Set the sample loop size. (The range is 0 to 2500 µL with a 
default setting of 200.) 

Air Cushion (µL) Set the air cushion between sample and flush solvent. (The 
range is 0 to 99 µL in 1 µL increments with a default setting 
of 10.) 

Sample Syringe Size (µL) Set the volume of the syringe used to dispense sample. (The 
range is 50 to 2500 µL with a default setting of 250.) 

Sample Speed Select from the drop–down list the speed at which you want 
sample dispensed. (The selections are Very Slow, Slow, 
Medium, Fast and Very Fast with a default set to Fast.) 

Injection Delay Time (min) Set the time after the autosampler has sent the Start signal to 
the other instrument devices that the injection is actually 
made. (The range is 0.00 to 99.99 min with a default of 0.00.) 

NOTE: The Series 225 and 275 have a similar set of preferences to the Series 200 except Excess 
Volume and Fixed Mode are not present for Series 225/275. 
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Autosampler Preferences (Flexar DS) 

Set the following Autosampler Preferences. 

Control Description 

Flush Volume (µL) Set the volume of flush liquid used for each flush cycle. (The range 
is 1 to 2500 µL in 1 µL increments with a default setting of 1000.) 

Flush Speed Select the speed at which the pump will flush the system. (The 
selections are Very Slow, Slow, Medium, Fast and Very Fast with a 
default set to Fast.) 

Number of Pre-Injection Flushes A Set the number of flush cycles with solvent A before each sample 
injection. 

Number of Pre-Injection Flushes B Set the number of flush cycles with solvent B before each sample 
injection. 

Number of Post-Injection Flushes A Set the number of flush cycles with solvent A after each sample 
injection. 

Number of Post-Injection Flushes B Set the number of flush cycles with solvent B after each sample 
injection. 

Temperature Control Select On or Off from the drop-down list to set whether the tray 
temperature control will be active or not. This is not displayed for 
No Peltier models. 

Tray Temperature (°C) Set the temperature to be maintained when the Peltier 
autosampler tray is installed. (The range is 4 to 60 °C (and -1 = 
Off) with a default setting of 20.) 

Tolerance (± °C) Set the deviation from set temperature allowed for the Ready 
condition. (The range is 0.1 to 60.0 with a default setting of 2.0.) 

Loop Size (µL) Set the sample loop size. (The range is 0 to 2500 µL with a default 
setting of 200.) 

Air Cushion (µL) Set the air cushion between sample and flush solvent. (The range 
is 0 to 99 µL in 1 µL increments with a default setting of 10.) 

Sample Syringe Size (µL) Set the volume of the syringe used to dispense sample. (The range 
is 50 to 2500 µL with a default setting of 250.) 

Sample Speed Select from the drop–down list the speed at which you want 
sample dispensed. (The selections are Very Slow, Slow, Medium, 
Fast and Very Fast with a default set to Fast.) 

Injection Delay Time (min) Set the time after the autosampler has sent the Start signal to the 
other instrument devices that the injection is actually made. (The 
range is 0.00 to 99.99 min with a default of 0.00.) 

 

 



Setting Preferences.  39 

 

UV/ Vis Detector Preferences (Flexar or Series 200) 

Set the following UV/Vis Detector Preferences: 

Control Description 

Wavelength (nm) Set the wavelength value in nm. 

Data Rate Parameter A drop-down list to set the parameter that appears in the 
method for setting data acquisition rate. (The selections 
are: Sampling Rate (pts/s) and Peak Width (s)) 

Column Oven Preferences (Flexar or Series 200) 

Set the following Oven Preferences: 

Control Description 

Temperature (°C) An edit field to set the oven temperature. (The range is  
5 °C to 90 °C with a default setting of 25.) 

Tolerance (± °C) An edit field to set an acceptance value. (The range is  
1 °C to 90 °C with a default setting of 1.) 

Fluorescence Detector Preferences (Flexar or Series 200a) 

Set the following Fluorescence Detector Preference: 

Control Description 

Lamp Life Limit (hrs) Hours of use before the detector will flag a lamp error. 

ICP-MS Preferences 

Set the following ICP-MS Preferences: 

Control Description 

 Dead Time (ns) Enter a value (from 0 to 100) for dead time to be used in 
reprocessing data from the ICP-MS.  

Short Settling Time in 
Use 

Select On or Off from a drop-down list to use the Short 
Settling Time in place of the Normal Settling Time. This is 
applicable to Pulse mode only. 

Sweeps Enter the number of sweeps (from 0 to 100) through the 
mass spectrum that is averaged to yield each data point. 
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Status Panel Limits 

The Device Status Panel Item preferences enable you to define warning limits for certain key 
parameters, such that if the value fails outside the defined range a warning icon will appear 
in the Status Panel.  

 

 

Control Description 

Display Title Enter the name of the parameter in the Status Panel. 

Units Display the units of the parameter, where applicable. 

Range Check 
Type 

Select from the drop-down list None, Min/Max to define if range 
checking is to be performed.  

User Min Value Enter the minimum allowed value for the parameter. 

User Max Value Enter the maximum allowed value for the parameter. 

 The parameters for which such range checking is available are defined below, for each 
device. 

Pump Status Panel I tems 

• Pump Pressure 

• Pump Flow 

Autosampler Status Panel I tems 

• Peltier Tray Temperature 
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Detector Status Panel I tems 

• Absorbance 

• Lamp Hours 

• Hours Since Cal. 

Fluorescence Detector Status Panel I tems 

• EX Wavelength 

• EM Wavelength 

• Fluorescence 

• EX Energy 

• EM Energy 

• Xe Lamp Hours 

• Hg Lamp Hours 

Refractive Index Detector Status Panel I tems 

• Temperature offset 

• Lamp Voltage 

• Lamp Hours 

• Drift 

• Noise 

• Refractive Index 

• Temperature 

Oven Status Panel I tems 

• Oven Temperature 

ICP-MS Status Panel I tems 

• Vacuum Pressure 

• Nebulizer Gas Flow 

• ICP RF Power 

• Lens Voltage 

• Main Water Temperature 

• Interface Water Temperature 

• Torch Box Temperature 

• Cell A Gas Flow 

• Cell B Gas Flow 

• MGF Gas Flow 





 

 

Control Panel 
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About the Control Panel 

The Control Panel provides convenient control of the instrument functions in Real Time and 
lets you control certain instrument settings after you have set up an instrument. The actual 
parameters available depend on the configuration setup. The Control Panel is available at all 
times and contains Start/Stop Items and Adjustments. 

 

The panel may be pinned in place at the right hand side of the screen or it may be set in 
Auto Hide mode so that it appears when the Control Panel tab is selected from the fly-out 
panel and then disappears a few seconds after the mouse pointer is moved elsewhere on the 
screen. The Control Panel and Status Panel share the right hand edge of the screen. When 
both are pinned the control panel appears at the top and the status panel at the bottom, 
with a slider bar between them, allowing resizing of the relative space occupied by each. 

• You can float or dock the Control Panel anywhere in the application. If you move the 
Control Panel out, double-click on it to return it to its default position. 

• You can also hide/unhide the Control Panel by clicking the thumbtack in the upper 
right corner of the dialog. 

The instrument configuration determines the commands available in the Control Panel 
since each command is associated with a device. The displayed string will be exactly as 
shown below when only a single device of that role (e.g. pump or detector) is configured, 
but will be preceded by the user name for the device when more than one device of that role 
is present. For example, Autozero would be displayed if a single UV-Visible detector was 
configured but if a UV-Visible and a fluorescence detector were configured the commands 
might be: 

My UV-Vis: Autozero 
My FL: Autozero 

When the mouse pointer hovers over a Control Panel button, in addition to the button being 
highlighted, a tool tip indicates the formal model name of the device associated with the 
command (e.g. Series 200 Quaternary Pump). 
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Using the Control Panel 

The Control Panel is a convenient tool for conditioning a column (performing the equilibrium 
between the mobile phase and the column). It defaults to the conditions of the last active 
method. The panel allows flushing of the Autosampler based on the last active method. The 
LC and ICP-MS controls easily accessible are: Start/Stop Sequence, Start Peristaltic Pump, 
Start the Plasma, Start/Stop LC Pump, control the Switching Valve, PCI Valve, Manual 
Control, Monitor Baseline, and Device Connections. 

NOTE: Any change that is made on the Control Panel w ill affect the current active method.  

The Control Panel displays on the right side of the screen; however, it can float or dock 
anywhere in the application. 

Control Description 

Start/Stop Sequence Allows you to start or stop the sequence at any time.  

Start/Stop Peristaltic 
Pump  

Allows you to start the ICP-MS Peristaltic pump. This is 
necessary for draining the spray chamber. 

Start/Stop Plasma Allows you to start or stop the plasma. 

Start/Stop LC Pump Allows you to start or stop the LC pump. 

Switching Valve Directs the output from the LC to either the ICP-MS or 
waste. 

PCI Valve Controls the state of the post–column injection (PCI) valve. 

Manual Control Displays the Manual Control view.  Through this dialog you 
have the following LC instrument control; pump, purge, 
autosampler, Peltier tray, and column oven. 

Monitor Baseline Allows the baseline to be monitored for a selected method. 
No injections are made or data stored in this window. 

Device Connections Displays the connected devices and provides the ability to 
Connect or Disconnect a device. 
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Control Panel 

The following icons are examples of what may be displayed in the Control Panel: 

Icon Function Instrument Description 

 
Turn PDA Vis Lamp 
On 

Detector Sends a PDA Vis lamp On command to the 
detector 

 
Turn PDA Vis Lamp 
Off 

Detector Sends a PDA Vis lamp Off command to the 
detector 

 
Turn PDA UV Lamp 
On 

Detector Sends a PDA UV lamp On command to the 
detector 

 
Turn PDA UV Lamp 
Off 

Detector Sends a PDA UV lamp Off command to the 
detector 

 Start LC Pump Pump Sends the start command to the pump module. 

 Stop LC Pump Pump Sends the stop command to the pump module. 

 
Turn Lamp On Detector Sends a lamp on command to the detector (UV 

/Vis and/or Fluorescence detector) 

 
Turn Lamp Off Detector Sends a lamp off command to the detector 

(UV/Vis and/or Fluorescence detector) 

 
Autozero Detector Sends an autozero command to the detector 

(UV/Vis, RI and/or Fluorescence detector). 

 
Start Peristaltic 
Pump 

ICP-MS Sends a start peristaltic pump command to the 
ICP-MS software. 

 
Stop Peristaltic 
Pump 

ICP-MS Sends a stop peristaltic pump command to the 
ICP-MS software. 

 
Start Plasma ICP-MS Sends a Start Plasma command to the ICP-MS 

software. 

 
Stop Plasma ICP-MS Sends a Stop Plasma command to the ICP-MS 

software. 

 

 

Switching Valve Valve Changes the state of the switching valve. 
(one icon per state) 

 

 

PCI Valve Valve Changes the state of the Post Column Injection 
valve. (one icon per state) 
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Pump Commands (Flexar or Series 200) 
Start/Stop LC Pump Clicking Start sends the start command to the pump module and 

then (assuming the command is accepted) changes the Control 
Panel to show Stop LC Pump. If the instrument includes more 
than one pump there is a separate command for each pump, 
distinguished by a numeric suffix. The tooltip associated with the 
command shows the full model name for the pump module.  

Autosampler Controls (Flexar or Series 225/ 275) 

The Flexar or Series 225/275 Autosampler will not automatically recognize a change of 
sample tray under all situations and hence this procedure must be directed by the software 
in order to be successful.   

1. To begin this process, click the Change Tray button in the Control Panel. 
Change Tray enables you to change the sample tray installed in a Flexar or Series 
225/275 Autosampler. The software will then display a dialog indicating the current 
tray and instructing the user what to do next. 

 

2. After changing the tray, click Done. 
The software will read the identity of the new tray and display a second dialog, 
confirming the change has been successfully recognized: 
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UV/ Visible Detector Commands (Flexar or Series 200) 
Turn Lamp On Sends a lamp on command to the detector. Since the state of the lamp 

cannot be read by Chromera the Turn Lamp On and Turn Lamp Off 
commands will always be shown together. 

Turn Lamp Off Sends a lamp off command to the detector. Since the state of the lamp 
cannot be read by Chromera the Turn Lamp On and Turn Lamp Off 
commands will always be shown together. 

Autozero Sends an autozero command to the detector. 

ELSD Commands 
 

Autozero ELSD Issues an Autozero signal to the ELSD. 

Turn ELSD Gas On Issues the Gas On command to the ELSD. Only displayed when 
ELSD is in Active mode.  

Turn ELSD Laser On Issues the Laser On command to the ELSD. Only displayed when 
ELSD is in Active mode. 

ELSD to Standby Turns off Gas, Laser, Drift Tube Temperature and Spray Chamber 
Temperature. When changes to Standby state, controls for Gas 
and Laser are hidden. 

(ELSD to Active) (Turns on Gas, Laser, Drift Tube temperature and Spray Chamber 
Temperature.) When changes to Active state, controls for Gas 
and Laser are displayed and set to ‘Turn ELSD Gas[/Laser] Off’. 

PDA Detector Commands 
Turn ON/Off Vis Lamp Sends a visible Lamp On or Lamp Off command to the detector. 

Turn ON/Off UV Lamp Sends a deuterium Lamp On or Lamp Off command to the 
detector. 

Fluorescence Detector Commands (Flexar or Series 200a) 

Turn Lamp On (Off) Sends a Lamp On command to the detector. The command will 
change to Lamp Off when the software determines that the lamp 
is on.  

Autozero Sends an Autozero command to the detector. 

Refractive Index Detector Commands (Flexar or Series 200a) 
Autozero Sends an autozero command to the detector. 
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ICP-MS Commands 
Start Peristaltic Pump Sends a Start Peristaltic Pump command to the ICP-MS software. 

Since the state of the pump cannot be read by Chromera the 
Start and Stop commands will always be shown together.  

Stop Peristaltic Pump Sends a Stop Peristaltic Pump command to the ICP-MS software. 
Since the state of the pump cannot be read by Chromera the 
Start and Stop commands will always be shown together. 

Start (Stop) Plasma Sends a Start Plasma command to the ICP-MS software. The 
command will change to Stop Plasma when Chromera determines 
it has been successful. 

Sw itching Valve Commands 

Switching Valve Commands change the current state (position) of the valve using Direct 
Control. Chromera uses the LC/UHPLC Rheodyne flow switching and column selector valves. 

The commands are Home, Next Column and Previous Column. 

Home – moves the valve to the home position. This moves the valve to position 1 
very slowly. 

Next Column – moves the valve one position clockwise. Does not go past position 6. 

Previous Column – moves the valve one position one position counterclockwise. 
Does not go past position 1. 

Here is Direct Control with the valve at column 1: Note that Previous Column is not available. 

 

Here is Direct Control for columns 2-5: 

 

Here is Direct Control for column 6:   Note that Next Column is not available. 
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Post Column Injection Valve Commands 
Post Column Injection Valve Commands change the current state (position) of the PCI valve. 



 

 

Status Panel 
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About the Status Panel 

The Status Panel displays the general status of all instruments currently configured on your 
system. Since the Status Panel also displays information other than instrument status in some 
environments, there are tabs on the Status Panel so that you can select the information to be 
displayed. The Instrument tab is always available, although the tab itself may be suppressed 
when no other tabs exist, to maximize the available display space. A second tab, Properties, 
displays information relevant to your analysis. For example when in Post Run information about 
the selected plot is provided. 

    
 

The Status Panel may be pinned in place at the right hand side of the screen or it may be set 
in Auto-Hide mode so that it appears when the Status Panel tab is selected from the fly-out 
panel and then disappears a few seconds after the mouse pointer is moved elsewhere on the 
screen. 
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About System Status I tems 

There are different types of system statues items, such as: 

• Overall Instrument Status. This includes settings such as No Method, Not Ready, 
Ready and Running. The full set of status messages depends on the configuration 
and is derived from the Instrument Descriptor definitions. 

• Database Status. This provides an indication of the amount of space available, for 
example as % Free Space. Since the data store consists of multiple databases, this 
status shows the state of the results database, which is the one most likely to become 
filled. 

• Database Size. This reports the total space occupied by all the Chromera databases.  

• Injection Number. Displayed as 'n of m' where n is current injection and m is number 
specified in the sequence. 
  

NOTE:   The Injection Number will always be 1 in Single Run mode. 

About Instrument Status 

• All status information supplied by each device is available for display.  

• You are able to select from the available status values those to be displayed, 
on an instrument-by-instrument basis. 

• The display of each status item indicates whether or not it is at the set value 
(where applicable). 

• The display of each status item indicates if the value is out of range. 

• In addition to individual device status items, an overall instrument status (Not 
Ready, Equilibrating, Ready, Running, etc) is provided. 

• The combination of status items selected for display for each instrument is 
saved as User Preferences. 

• Where available, diagnostic information is available as status items. 
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Overall Instrument Status 

This panel provides an overall view of the instrument status, by displaying the state of each 
device configured on the instrument. The following status is displayed: 

Not 
Connected 

One or more devices in the configured instrument are not 
connected to the software 

No Method The devices are currently not under control of a method 
(although Manual Control may be in use) 

Not Ready One or more devices are not yet at the initial conditions set in 
the controlling method 

Equilibrating All devices are at set conditions but an equilibration stage is in 
progress 

Ready The instrument is at set conditions and equilibration is complete 

Running An analytical run is in progress 

Monitor Baseline monitoring is in progress (only on instruments that 
require specific monitor mode) 

Error An unrecoverable error has occurred on the instrument 

 

NOTE:  If the controlling sequence has been paused then you are notified of this by appending it to 
the above status. For example:   Ready — Paused 
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How to Setup Parameters in the Status Panel 

To configure the parameters displayed in the Status Panel: 

1. Right-click on the Status Panel to display the Status Panel popup menu and 
select Status Dialog.  

 

2. The Status Panel Setup dialog consists of an expandable list that shows all the 
parameters available to be displayed, along with the current status (for quick 
summary checking). 

 

3. Select a Device. Each Device contains a list of status Items. 

4. Each status Item has a checkbox, to select the parameters you want to display in 
the Status Panel. When an item is checked or unchecked to View, the Status Panel 
is updated immediately to reflect the change. 

5. Right-click in the Status Panel Setup dialog to display a popup menu for additional 
control. 

6. Click Close to close the dialog and the Status Panel will be updated. 
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Database Status 

Database status is reported as the % of free space available in the results database. This is 
because, in the multi-database structure, this individual database is most likely to reach 
capacity.  

Of course, given enough time, any of the other databases could reach capacity (except for 
raw data, which will utilize a database chaining scheme to provide indefinite capacity limited 
only by disk space). Therefore, for all databases (including results), if any of them should 
reach 95% capacity then this is treated as an error condition and an error is displayed. 

You also can view total database size (encompassing all elements of the database set), to 
see the amount of space required for a backup (the backup should always require less space 
than this value since it is a compressed format). 



 

 

Method 
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About the Method 

A method is a collection of parameters that determine how Chromera acquires and analyzes 
data from your chromatography equipment, based on the specific requirements of your 
instrument and your sample. Each method contains the following major sections:  

• Instruments: Setup and control of the functions and parameters of the devices 
making up the instrument 

• Channels: Defines the chromatographic data channels from which data is acquired 

• Peaks: Parameters defining processing of the acquired data streams and definition of 
specific components to be analyzed in the sample 

• Calibration: Calibration information to convert processed data to component 
amounts 

• Reporting: Contains the Channel specific plotting options 

Clicking the Method button in the Navigation Pane displays the method tree and the first 
page of the method. 

 

The upper section of the Navigation Pane displays the major sections of the Method whose 
contents are based on the configuration of the displayed method (that is, the configuration of 
the associated instrument), while the main display area (the large area in the middle of the 
screen) displays the part of the method associated with your selection. 

The major sections of a method: Instruments, Channels, Peaks, Calibration, and 
Reporting always appear in the Navigation Pane. You can reorder these sections (by right-
clicking and selecting Move Up/Move Down commands) but they will remain at the same 
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level. With a configured PDA detector the child nodes of the second level nodes of the 
method tree: Instrument, Channels, Peaks, Calibration and Reporting will each reflect the 
presence of the PDA detector. 

A device name appears under Instruments for each device configured. The text displayed 
is the name you give to the device, as defined in the instrument configuration. Each device 
that generates a data stream that is subject to peak detection (e.g., a detector) also appears 
under Peaks, Channels, and Calibration. The text displayed for is the name of the channel, as 
defined in the Channels section. 

The part of the method displayed in the main display area of the screen depends on the 
selection in the navigation Pane. For example: 

Method name                                  A unique name to identify the method 

Instrument                                Instrument settings for all devices 

Device node                            Instrument settings for selected device only 

Channels                                    Channel parameters for all devices 

Detector (Devices) node         Channel parameters for selected detector only 

Data Streams                          Data stream for the selected detector 

Peaks                                       Peak Detection parameters and component 
information for all detectors 

Detector node                        Peak Detection parameters and component 
information for selected detector only 

Calibration                                 Calibration information for all detectors 

Device node                            Calibration information for selected detector only 

Reporting                                   Channel specific plotting options 

Method editing consists of modifying existing method parameters. This includes a 
modification to the method name, since in Chromera the name is a method parameter like 
any other (the method is uniquely identified by a database index that is not visible to a user). 
After making changes and saving the method, the previous version of the method is replaced 
by the modified version. Only a single version of a method is saved in the database. Also, a 
method cannot be saved with the same name as another method in the Group. To create a 
copy of an existing method but with a different name, leaving the original method 
unchanged, use the Save As command. 
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Method Menu Commands 

The following menu items appear in the File menu when you are in the method environment.  

Menu Command Description 

File New Method If the current method has been modified then you will 
first be asked if the modified method should be saved. 

Displays a new default method. For an online instance 
the method configuration is that of the connected 
instrument. In the case of an offline instance the user is 
prompted to select or create a configuration. 

  Open Method… If the current method has been modified then you will 
first be asked if it should be saved. 

Displays the data selector in single sample result 
selection mode. When you has selected a method, it is 
displayed. 

  Save Method Save the current method replacing the existing version in 
the database. 

  Save Method As… Displays a dialog to enter a Name and a Group for the 
new method, which will then be saved under a new 
identifier (index) in the database. 

  Extract Method from 
Results… 

If the current method has been modified then you are 
first asked if it should be saved. 

Displays the Data Selector in single sample injection 
result selection mode. When a single sample has been 
selected the method parameters (instrument, channels, 
peaks and calibration) is read from the results and 
displayed in the editor. The Method Name and Group 
fields on the Identification page of the method will also 
be filled in (and Description and Notes will be copied 
from the results if they exist). You may be required to 
change the Name or enter a new Group name before the 
method can be saved, if a name conflict occurs. 

  Print Preview Method Displays the Print Method dialog. When you select the 
required options in the Print Method dialog (and click OK) 
the method displays in a print preview method in 
accordance with the current print options. 

  Print Method… Displays the Print Method dialog. When the user has 
selected required options in the Print Method dialog (and 
clicked OK) the method is printed. 
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  Lock Only displayed when user authentication/tracking is 
active. 

Minimizes the Chromera window to the taskbar. Before 
the window can be restored the valid password for the 
associated user must be entered. 

  Exit Online instance: If data acquisition or a sequence is 
running then you are prompted that the instrument must 
be in an idle state before the application can be closed. If 
the instrument is not active then the following procedure 
for an offline instance will apply. 

Off line instance: If the current method has been 
modified then you are first asked if it should be saved. If 
unsaved data are present in any other environment then 
you are prompted to save each in turn. Closes the 
application window. 

View Run Time Switches to the Run Time environment. The same action 
as clicking the Run Time button in the Navigation Pane. 

  Method Switches to the Method environment. The same action as 
clicking the Method button in the Navigation Pane. 

  Sequence Switches to the Sequence environment. The same action 
as clicking the Sequence button in the Navigation Pane. 

  Post Run Switches to the Post Run environment. The same action 
as clicking the Post Run button in the Navigation Pane. 

  Reprocess Switches to the Reprocess environment. The same action 
as clicking the Reprocessing button in the Navigation 
Pane. 

  Toolbars ►    View Toggles display of the View toolbar. 

  Tools Toggles display of the Tools toolbar. 

  Show Small 
Icons Show 
Large Icons 

Toggles the size of the icons in the Graphic toolbar. 

Tools Export ► 
  Chromera Results… 

Methods… 

Sequences… 

Report Templates… 

   Displays the Database export dialog. 

Displays the Method export dialog. 

Displays the Sequence export dialog. 

Displays the Report template Export  dialog. 
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  Import ► 
   TotalChrom Data… 

Chromera Results… 

Chromera Methods… 

Chromera Sequences… 

Report Templates… 

    

 Displays the Import TotalChrom data dialog. 

Displays the Import Results dialog. 

Displays the Import Methods dialog. 

Displays the Import Sequences dialog. 

Displays the Report template Import dialog. 

  Preferences Displays the Preferences dialog, showing the preferences 
associated with the current user (see Setting 
Preferences). 

  Report Format Wizard Displays the Report Format Wizard in New Report mode 
(see Report Format Wizard). 

  Sequence Wizard Displays the Sequence Wizard (see Sequence Wizard). 

  Device Connections Displays the Device Connections dialog. 

  View Current Session 
Logs 

Displays the Data Selector - Event Viewer with session 
log information. 

  Error Log Displays the Error Log dialog 

  Dictionary Editor Displays the Dictionary editor dialog 

  Reprocess Initiates the Batch Reprocessing function by displaying 
the Data Selector (see Batch Reprocess). It is disabled in 
an online instance when data acquisition is in progress, 
or a sequence is running. 

  Batch Builder Displays the Batch Builder dialog. 

  View Retrieved 
Archived Logs 

Displays a dialog to select a retrieved event logs 
database to display in the Data Selector - Retrieved 
Session Logs Viewer. 

Actions Standard Method Editor Displays the standard configuration of the method editor, 
as shown in About the Method Editor (that is a single 
frame in the main display and the method tree in the 
navigation pane. 

  Edit Method Graphically If no data has yet been associated with the current 
method for this session then the data selector is 
displayed in select sample results mode. When you select 
one or more sample results, the window is displayed in 
the graphic method editing configuration. 
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  Copy Components ► 

Between Channels… 

From TotalChrom 
Method… 

  

Displays the Copy Components Between Channels dialog. 

Displays the Copy Components From TotalChrom Method 
dialog. 

  Update Search 
Windows… 

Displays the Update Component Search Windows dialog. 

Help Topics Opens the Chromera Help window. 

  Consumables and 
Accessories 

Opens the PerkinElmer Consumable and Accessories 
Catalog 

  About Chromera Displays the copyright and version dialog. 
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Method - Standard Toolbar 

This toolbar displays in the standard Method Editor mode: 

 

Or when user authentication active this toolbar displays: 

 

The following table describes the icons: 

Icon Command 

 Opens a New Method 

 Open Method - Displays the Data Selector 

 Save Method 

 Save Method As 

 Print Preview Method 

 Print Method 

 Lock (Only when user authentication active) 

 Exit Chromera 

 Standard Method Editor 

 Edit Method Graphically 

 Opens Help 
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Common Toolbars 

There are two common toolbars displayed in every environment: View and Tools. A Standard 
toolbar will always appear but the contents will change depending on the environment. The 
standard toolbar is defined within the sections describing the individual environments. 

View  Toolbar 

This toolbar simply mirrors the buttons in the Navigation Pane and the commands in the 
View menu. 

 
 

Icon Command Description 

 Run Time  Switches to the Run Time environment. The same 
action as clicking the Run Time button in the Navigation 
Pane. 

 Method Switches to the Method environment. The same action 
as clicking the Method button in the Navigation Pane. 

 Sequence Switches to the Sequence environment. The same 
action as clicking the Sequence button in the Navigation 
Pane. 

 Post Run Switches to the Post Run environment. The same action 
as clicking the Post Run button in the Navigation Pane. 

 Reprocess Switches to the Batch Reprocess environment. The 
same action as clicking the Batch Reprocessing button 
in the Navigation Pane. 

 Reports Switches to the Report Viewer. 
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 Tools Toolbar 

This toolbar includes the most commonly used commands from the Tools menu. 

 
 
Icon Command Description 

 Reprocess Initiates the Batch Reprocessing function by 
displaying the Data Selector in single batch selection 
mode. 

 Export ►  
Chromera Results… 

 

Methods… 

 

Sequences…  

 
Initiates the Export of Chromera results by displaying 
the Database export dialog. 

Initiates the Export of Chromera methods by 
displaying the Database export dialog. 

Initiates the Export of Chromera sequences by 
displaying the Database export dialog. 

 Import ►  
TotalChrom Data… 

Chromera Results… 

Chromera Methods… 

Chromera Sequences… 

 
Displays the Import window. 

Displays the Import Results dialog. 

Displays the Import Methods dialog. 

Displays the Import Sequences dialog. 

 Preferences Displays the Preferences window, showing the 
preferences associated with the current user. 

 Report Format Wizard Displays the Report Format Wizard in New Report 
mode. 

 Sequence Wizard Displays the Sequence Wizard. 

 Device Connections Displays the Device Connections dialog. 
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Method Tree Popup Menu 

Right-clicking anywhere within the method tree control in the Navigation pane will display a 
popup context menu. The contents of the menu will always be the same but which 
commands are enabled will depend on what specific part of the tree is clicked. 

Command Description 

Expand Displays the child nodes of the node clicked on. 

Collapse Hides the child nodes of the node clicked on. 

Expand All Fully expands the tree to show all nodes. 

Collapse All Hides all nodes in the tree other than the root node (the method 
name). 

Move Up Moves the clicked node, and its children, up one position in the 
tree. This allows you to position method sections, the instrument 
modules within the Instrument section, and channels within 
other sections of the method in the desired order. 

Move Down Moves the clicked node, and its children, down one position in the 
tree. This allows you to position method sections, the instrument 
modules within the Instrument section, and channels within other 
sections of the method in the desired order. 

 

NOTE: If you click in empty space within the control and not on a node, then the only commands 
enabled are Expand All and/or Collapse All, as applicable. 
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How To Create a New  Method 

To create a new method: 

1. Click the Method button  or icon  to open the Method 
window. 

2. Choose the New Method command from the File menu. A blank Method dialog 

appears with a message bar   on the bottom of the screen.  

 

3. In the top level row of the method screen, enter a Method Name (this is the name 
the method will be saved as in the database), the name of the Group (virtual folder) 
where the method will be stored, a Description of the method, and Notes about 
the method. 

4. Click on Instruments in the Method tree to display the instruments that are 
controlled by this method. 

 

5. Click the button  to Expand each instrument section to show the parameter 
settings for each device (instrument) configured on the system. 
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6. For each device (instrument) enter or edit parameter settings as required. 

Device Parameter Setting Description 

LC Pump Settings Enter the LC pump analytical program and pump parameters. 

LC Autosampler Settings Enter the LC autosampler settings. 

LC Detector Settings 
Fluorescence, UV/Vis, or PDA 

Enter the LC detector settings. 

LC Column Oven Settings Enter the LC column oven temperature. 

ICP-MS Settings (for 
Speciation) 

Enter the ICP-MS parameters; analytes, species, etc. 

PCI Valve (Post Column 
Injection for Speciation) 

Enter the valve settings to control the injection of a standard 
into the mobile phase after the chromatographic column and 
before it enters the ICP-MS nebulizer. 

In a device (instrument) row is an Advanced checkbox. Checking this box expands the 
method row to display the parameters normally set in Preferences. You can set the 
parameter values here so that they override the Preference values only for this method. 

7. Save the method by choosing the Save Method/Save Method As... command 
from the File menu. 

NOTE:  After making a change to the method you must save the method to retain the changes made. 
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How to Modify a Method Used for Spectral Processing 

Methods used with a PDA interact with the Spectral Processing Window (SPW).  The following 
procedure outlines the interaction between Chromera and the SPW to modify a method. You can 
modify the method three ways: 

• Create a new channel 
• Optimize operations 
• Modify the Component List 

To modify a method used for spectral processing: 

1. Open your method that is used with the PDA. 

2. Select Edit Method Graphically from the Actions menu.  
The Data Selector opens. 

 

3. Click the check box to the left of the Batch Name you want to open, click the plus 

sign  to expand the batch, click the Sample Name check box, then click the 
Open button. 
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The Method opens in Graphic method Editor (GME). This is the template 
chromatogram. 
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To Create a New  Channel 

1. If you want to create a new channel select Channels in the Method tree, then from 
the Actions menu, select Create channel definition from spectral data.  
The SPW window opens in Preview Chromatogram. 

 

2. Here you can perform SPW Operations on your channel. 

3. When done you can add this new channel to the method clicking the Add to 
Method button in Preview Chromatograms. 

4. Save this method by selecting Save Method or Save Method As... from the 
Chromera File menu. 
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To Optimize the Operations   

1. To optimize a channel in the Method tree (in this example 254:10:400:10 is 
selected), select Edit Spectral Operation Graphically from the Actions menu. 
The SPW window opens in Peak Purity. 

 

2. Now you can optimize the different operations in SPW for this channel. 

3. When done save this method by selecting Save Method or Save Method As... 
from the Chromera File menu. 
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To Modify the Component List  

1. To modify the component list select Peaks in the Method tree (in this example 
254:10:400:10 is selected), select Component list using spectral library search 
matches from the Actions menu. 
The SPW window opens in Peak Library Search. 

 

2. Click the Library List button to open the Library List dialog and browse for a library. 

 

3. When done use the spectra to update the component list in the method by clicking 
the Update Component List button. 
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An updated list identifies where the name comes from (for example, _PLS is Peak 
Library Search) 

4. You can see the GME Results when you select the Show Results command from 
the Actions menu. 

 

5. When done save this method by selecting Save Method or Save Method As... 
from the Chromera File menu. 
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New Method Configuration Dialog (Offline Instance) 

The New Method Configuration dialog is displayed when you select the New Method command 
from the File menu in an offline instance of Chromera. It enables you to define the instrument 
configuration to be used for the new method. You may select an existing configuration or define 
an instrument structure specifically for use with the new method.  The default selection is the 
current instrument configuration with the current devices displayed. 

 

When you want to Define an instrument configuration a list of available devices displays. 
Select the devices you want and click the Add button. 
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Control Description 

Select from my instrument 
configurations  

Select to indicate that an instrument configuration assigned to the 
current user will be selected for the new method. 

Select from all instrument 
configurations 

Select to indicate that an instrument configuration from the full 
system collection will be selected for the new method. 

Define an instrument 
configuration 

Select to indicate that you will construct an instrument 
configuration for the new method. 

Instruments Displays existing instrument configurations for you to select to 
define the new method structure.  

The list displays all of your existing defined configurations or all of 
the instrument configurations defined on the system (depending 
on the radio button selection). 

Available Devices Displays the devices comprising the instrument for the new 
method. It is only displayed when the third radio button option is 
selected. 

The list displays all instrument devices supported by the Chromera 
software (manufacturer's name displayed). 

Configured Devices Displays the devices making up the instrument.  
 
If an existing instrument is selected from the Instruments list box 
then the devices assigned to that instrument will be displayed in 
this list box. If an instrument configuration is being defined then 
the list box contains those devices assigned to the instrument so 
far. 

When Define an instrument configuration is selected: 
Displays the device names added to the configuration, in the order 
in which they were added. This order also defines the order in 
which they will appear in the method editor tree. Multiple 
selections are allowed in this mode. 

Existing configuration option selected: Displays the names of 
devices making up the selected instrument configuration, in the 
order they appear in the configuration. This order also defines the 
order in which they will appear in the method editor tree 

 
When a device name is selected in the Available Devices list, 
clicking this button copies the device name to the Configured 
Devices list. If a device of that type already exists then a numeric 
identifier will be appended, so that each occurrence of the device 
can be distinguished. 

When items from the Available Devices list are added to the 
Configured Devices list, the selected items in the Available 
Devices list will be deselected/unhighlighted. 

 
Selecting one or more device names in the Configured Devices 
list, clicking this button, removes the device name(s) from the list. 
All items will then be deselected in the Configured Devices list. 
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Selection from a Dictionary 

Chromera maintains several dictionaries to facilitate the consistent entry of component 
names and solvent descriptors into methods, and standard names and units associated with 
calibration. The functionality of these dictionaries is identical. Each dictionary is made 
available via a combo box. This combo box is used directly (such as in the Component 
column of the component list in the Peaks section of the method), otherwise the combo box 
is contained in a selection dialog displayed as a result of some command. 

  

When you type an initial character in the edit field of the combo box, if one or more entries 
starting with that character are found within the dictionary then the first entry found will be 
displayed in the combo box. As you type in more characters of the desired component name, 
as long as a match is found within the dictionary then an entry will be displayed. If entry 
cannot be found in the dictionary then the autocomplete action is discontinued and only your 
entry will be displayed in the edit field. When you accept the entry by leaving the Component 
field then the contents of the field will be added to the dictionary. 

At any time a dictionary item is displayed in the combo box you can use the up/down arrow 
keys to select the previous/next item in the dictionary. The dictionary display is always 
ordered alphabetically (with a sort mode suitable for the current locale). 
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Update Component Search W indows 

This dialog is displayed when the Update Search Windows… command is chosen from the 
Actions menu in the Method Editor. 

  
Control Description 

Update these components Select from the drop-down list the scope of the changes 
to be made to the component search windows. The 
choices are: All Components, Internal Standards 
Only, Reference Peaks Only, or Selected 
Component Only 

<check list box> Select the components whose search windows are to be 
updated. Displayed are all components from the method, 
regardless of the channel. This is only enabled when 
Selected Component Only is selected in the Update 
these components drop-down list. 

Absolute window (± s) Enter a value to set the component search window size, in 
seconds. (The range is 0.0 to 999.9 s.) 

Relative window (± % of RT) Enter a value to set part of the component search 
window size, as a percentage of the expected retention 
time for the component. (The range is 0.0 to 500.0.) 

Clicking the OK button updates the search windows for all the specified components on the 
basis of the settings in the dialog. This update process can only produce search 
windows that are centered on the expected retention time of the component. For asymmetric 
search windows the user must enter values manually or define the window graphically. 

The search window values generated for each specified component are: 
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Active Method 

The Active Method is the set of parameters currently controlling the various devices (pump, 
autosampler, detector, oven) of the instrument. The active method is available by default 
within the Run Time environment but you can also display it within the Method 
environment.  

NOTE:  These two environments are functionally distinct; that is, they can be displaying different 
methods at any given time. 

Display 

Because the behavior of editing the active method is radically different from that of editing 
an offline method the appearance of the editor is different to help you see which mode is in 
effect. 

When an instrument is running and the active method is displayed, there are attributes 
applied to the parameter display to indicate which parameters can be changed and which 
cannot. This display is updated as the run progresses.  

For example, if Step 1 of a UV/Vis detector wavelength program is being executed then that 
step is shown as read-only but subsequent steps (if any) are shown as editable. But when 
Step 1 is complete and the detector begins executing Step 2, that step will become read-only 
and only subsequent steps are shown as editable. 

NOTE: Some parameters may always be shown as read-only in the active method display, if the 
device does not permit the value to be changed during a run. For other parameters it will 
depend on the current state of the run (i.e. position in device program steps), while other 
parameters may be accessible at all times. 

Changes 

A change made to the method will not be immediately downloaded to the instrument; this 
occurs when you explicitly request that changes made be applied to the instrument (see Run 
Time environment for details of the user interaction). The instrument control software is 
responsible for determining the appropriate control structure to send to the device. For 
example, a change to the wavelength of a UV/VIS detector program will require downloading 
the complete program step. 

Changes to other sections of the method (channels, peak detection, and calibration) will take 
effect the next time they are used. This includes use of peak detection parameters for the 
purpose of real-time integration as well as normal end-of-run processing and reporting. 

All such changes to the active method generate a log entry associated with the acquired 
data, indicating: 

• The device the change was made to (and the channel if applicable) 

• The change to parameter value or setting that was made 

• The date and time of the change 

• The person who made the change (the Full Name defined in the OS if available, 
otherwise the user account name) 
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For example - Channel BBC1: Step 2: Wavelength: From: 254 To: 285 At: 02:34:55 PM 
November 25, 20087 By: Gene 

In addition to the log entry the method name associated with the data is flagged as being 
Modified during the run.  

Persistence of Changes 

Sequence Mode 

By default the changes made to an active method will persist only for the current sequence 
row. It is important to note that this could mean for subsequent replicate injections specified 
for that row as well as just for the active analysis.  

If you take no other action, prior to the next sample row the stored copy of the method 
specified for that row is downloaded to the instrument and the modified copy of the method 
for the prior row is discarded. If, after modifying the active method, you Save it, then the 
modified version replaces the version stored in the database and this modified version is 
used for all subsequent rows that specify that method.  

Single Run Mode 

The situation here is different from that when a sequence is run. The active method in single 
run mode continues to define the conditions at the instrument for as long as the session 
persists (this could be across several Chromera sessions). This is true whether or not the 
method is saved. Thus in single run mode the ‘active method’ is an entity of some 
permanence. For further details see Run Time - Single Run and Run Time Method States. 
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Method: Identification Section 

The Identification section of the method is used to avoid redundancy and potential 
confusion of having the Method Name, Group, and Description fields repeated in every 
section. It also contains a Notes section where you can enter more detailed information 
about the method, such as column information or sample preparation steps. 

1. Begin by entering the following information, starting with Method Name, into the 
dialog to identify your method. 

 
 

Control Description 

Name Type a name for the method. You must enter a method name (using up 
to 25 characters) before the method can be saved and the name must be 
unique within the Group. After typing a name and pressing Enter, the 
name also appears in the title bar of this dialog. 

NOTE: Changing the name in this field it does not create a new method. 
It renames the existing one. 

Group This is a way to categorize (or group) your information. Here you assign the 
method to an existing group (using up to 25 characters) or to a new group. 
To use an existing group you can type in the group name or select it from 
the drop-down list. To create a new group and assign the method to it type 
a group name that does not already exist. 

Description Type a description of the method using up to 50 characters. 

Notes You can type more extensive details of the method. 

2. When done, click on Instruments in the Navigation pane to display the instrument 
parameters. 
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Instrument Parameters 

The content of the display when the Instrument (in this example the instrument is PDA Plus 
Analysis) is selected depends on the configuration of the associated instrument. For example, 
you can have an LC instrument consisting of a pump, autosampler, PDA detector, and oven. 

 

When the Instruments node is selected all instrument bands are displayed. The order in 
which the bands are shown on the screen depends on the order they appear in the Method 
tree. By default the devices appear in the order in which they were entered at configuration. 
You can reorder the devices in the tree (and hence on the screen) using Move Up and Move 
Down commands in the context menu associated with the tree. 

NOTE: The In Use check box when checked indicates that the device is controlled by Chromera 
when the method is used for an analysis. When the box is unchecked the method will not be 
downloaded to that device but the display of status from the device will continue. Unchecking 
the In Use box will not stop Chromera from trying to connect to a device when an 
instrument instance is started. Since the software has no idea what method you plan to use 
it must attempt to connect to all configured devices on startup. 

When a device node is selected, only the parameters associated with that device are displayed. 
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Associated Instrument 

Each method in the database has an instrument configuration associated with it. This 
instrument configuration determines what sections are displayed when the method is loaded 
in the Method Editor. This means that the method will appear exactly the same when it is 
imported into a different Chromera system, even one that has no instruments configured.  

However, in order to accommodate changes to an existing instrument configuration, a check is 
made before a method is loaded for use in an acquisition as to whether the associated 
instrument is currently configured on the system and, if it is, whether its present configuration 
matches that stored with the method. If it does then the method is loaded and displayed. If there 
is a mismatch between the configurations then the user is informed and is given the option to 
allow the software to update the method to the current configuration or to have the method 
displayed in conformance with the stored configuration. If the latter option is chosen the method 
can be edited and saved but it cannot be set up on the instrument. 

When a new method is created within an online instance of Chromera (see Offline/Online) the 
method will assume the configuration of the associated instrument. When a new method is 
created within an offline instance of Chromera, you are able to select the instrument configuration 
to be used. This may be an existing configuration defined on the system or an ‘ad hoc’ 
configuration made up of devices selected from the system device pool. See New Method 
Configuration Dialog for the user interaction associated with this process. 

Run Time Reconciliation 

When a method is saved the software will compare the total run time of the pump to the end 
time for each detector configured on the system. If the pump run time and the detector end 
times are all equal then the method is saved without comment. Any other condition will 
(optionally) generate a message. 

Pump Run Time less than detector End Time 

If the end time specified for any detector is longer than the pump run time then the following 
message is displayed: 

The pump run time is less than the data acquisition end time for the following devices: 
<first detector with end time exceeding pump time> 
… 

Do you want the end time of the above to be reduced to be the same as the pump run time? 

Yes and No buttons are provided. Clicking Yes then adjusts the detector end time to be 
equal to the pump run time. If necessary, the detector program is adjusted to conform to 
this end time, by eliminating any program change that occurs after the new end time. 
Clicking No, saves the method with the current settings. 

Pump Run Time exceeds detector End Time 

If the pump run time is longer than the end time specified for any of the detectors then the 
following message is displayed: 

The pump run time exceeds the end time for the following devices: 
<first detector with end time exceeding pump time> 
… 
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Do you want the end time of the above to be extended to be the same as the pump run 
time?’ 

Yes and No buttons are provided. Clicking Yes extends the detector end time to be equal to 
the pump run time. Clicking No, saves the method with the current settings.  

Disabling Run Time Reconciliation 

Run time reconcilation is enabled for new methods however for those cases where the 
difference between pump run time and detector end time is intentional, it is possible to 
disable run time reconcilation for a method simply by unchecking the Run Time Reconcilation 
check box at the end of the main pump band. 

Method: Pump Settings (Flexar or Series 200) 

The LC Pump Settings portion of the method is used to define the pump parameters; more 
specifically, you define the pump program which consists of steps, step type, step time, flow 
rate, mobile phases, mobile phase composition, composition curve, timed events, and 
pressure limits. 

NOTE: When configuring more than one pump in an LC system, please make sure that each 
pump’s upper pressure limit is properly set within the method. This will depend on the 
individual pump’s role in the system; be it for column re-equilibration, post-column functions 
or otherwise. 

When a method is created, the default solvent names are taken from the instrument 
preferences, and you have the ability to change them. The solvent names will be stored 
within the method and subsequently will never change (regardless of what modifications to 
names are made in preferences), unless you explicitly change them within the method. 

1. Enter your initial LC Pump Settings. 

 
 

2.  
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Parameter Description 

Transition Defines the type of analysis: 
• Isocratic – Constant mobile phase composition 

throughout the analysis. 
• Gradient – Varying mobile phase composition 

throughout the analysis. 

Initial Equil Time (min) The equilibration time prior to the first isocratic analysis run 
in a sequence. This field is not displayed when the Transition 
type is set to Gradient. 

For an Isocratic run, there are no changes to the solvent 
composition. Therefore, the compositions are set in Step 0 
and maintained throughout the Pump Program.  The 
equilibration time required between runs is therefore minimal 
but equilibration is required prior to the first run. This value 
is used for the initial equilibration but it is replaced by the 
Equil Time in Step 0 for subsequent runs.  

Total Run Time (min) 
Displays the total run time of the pump program (that is, 
the combined step times for steps 1 to n (where n is the 
final step). This value is used for the purpose of run time 
reconciliation with the detectors. 

Run Time Reconciliation 
When a method is saved the software will compare the total 
run time of the pump to the end time for each detector 
configured on the system. If the pump run time and the 
detector end times are all equal then the method is saved 
without comment. Any other condition will generate a 
message. 

Standby Time (min) 
Enter the number of minutes (15 to 999 min) that the pump 
will remain in the Ready state before changing to the 
standby flow rate. 

Standby Flow (mL/min) 
Enter the flow rate (0.00 to 10.0 mL/min) to be set after 
the Standby Time has elapsed. 

Stop Time After Equil 
(min) 

Enter the length of time the pump will wait for an external 
command before shutting the pump down. 

Upper pressure limit 
Enter the upper limit of the pressure, above which the 
pump will shut off. 

Lower pressure limit 
Enter the lower limit of the pressure, below which the pump 
will shut off. 

3. Enter your initial LC Pump Steps. 

Step The steps in the pump program. 
Step 0 – Is the equilibration step. All programs must 
begin with Step 0. 
Step 1 through 19 – Are the steps in the pump 
program during data collection. For an ICP-MS method, 
the sum of the times in Steps 1 - 19 should equal the 
run time in the ICP-MS portion of the method. 
Wash step is always last step, where the column is 
cleaned. No data is collected during this step. 
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Step Type Equilibration for Step 0, allows time for the column to 
equilibrate prior to data collection. Run for subsequent steps 
indicates data collection. Wash is where the column is 
cleaned and no data is collected. 

Step Time (min) The duration of the current step in minutes. 

Flow (mL/min) The flow rate of the mobile phase (solvents) in mL/min. 

%A, %B, %C, %D The percentage of each of the four solvents comprising the 
mobile phase. The percentage are entered by the user. 
Percentage of D is calculated (100 – %A –%B – %C) 
However, D can never be less than zero. If a user entry 
would cause this to happen, then the amount by which D 
would go negative is subtracted from the next available 
solvent.  For example, if you increase B by 20% and D is only 
10% then 10% would be subtracted from C (or from C and A 
if necessary). Similarly if you enter a value in D, solvent C 
(and/or B and/or A) is adjusted as necessary to maintain a 
total of 100%. 

Curve The solvent gradient curvature (change in concentration) 
during the step. This parameter is only displayed when 
Gradient is selected as the Transition type. A Curve of 1 is 
linear. A Curve of 0 is a step gradient. Curves -9.9 to 9.9 (in 
0.1 increments) are concave/convex profiles. 

NOTE: If a Wash step is used, it must be the last step for both the Isocratic and Gradient curves 
since no data is collected during this step. 

4. Enter your initial LC Pump Timed Events. 

Parameter Description 

Step Type Select the Step from a drop–down list indicating whether the event will 
occur during Equilibration, Run, or Wash. 

TE Time (min) The time into the run at which the event will occur. 

TE Select the event relay to be activated. There are two relays available: 
TE1 and TE2. 
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Method: Flexar SS Pump Settings 

The LC Solvent Switching Pump Settings portion of the method is used to define the pump 
parameters; more specifically, you define the pump program which consists of steps, step 
type, step time, flow rate, mobile phases, mobile phase composition, composition curve, 
timed events, and pressure limits. 

NOTE: When configuring more than one pump in an LC system, please make sure that each pump’s 
upper pressure limit is properly set within the method. This will depend on the individual 
pump’s role in the system; be it for column re-equilibration, post-column functions or 
otherwise. 

When a method is created, the default solvent names are taken from the instrument 
preferences, and you have the ability to change them. The solvent names will be stored 
within the method and subsequently will never change (regardless of what modifications to 
names are made in preferences), unless you explicitly change them within the method. 

1. Enter your initial LC Pump Settings. 
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Parameter Description 

Transition Defines the type of analysis: 
• Isocratic – Constant mobile phase composition throughout the 

analysis. 
• Gradient – Varying mobile phase composition throughout the 

analysis. 

Initial Equil Time 
(min) 

The equilibration time prior to the first isocratic analysis run in a sequence. 
This field is not displayed when the Transition type is set to Gradient. 

For an Isocratic run, there are no changes to the solvent composition. 
Therefore, the compositions are set in Step 0 and maintained throughout 
the Pump Program. The equilibration time required between runs is 
therefore minimal but equilibration is required prior to the first run. This 
value is used for the initial equilibration but it is replaced by the Equil Time 
in Step 0 for subsequent runs. 

Advanced Settings 
expander 

Displays the additional pump parameters for which defaults are set in 
Preferences. 

Total Time (min) Displays the total run time of the pump program (that is, the combined step 
times for steps 1 to n (where n is the final step). This value is used for the 
purpose of run time reconciliation with the detectors. 

Run Time 
Reconciliation 

When this checkbox is checked, when a method is saved the software will 
compare the total run time of the pump to the end time for each detector 
configured on the system. If the pump run time and the detector end times 
are all equal then the method is saved without comment. Any other 
condition will generate a message. 

Solvent reservoirs 
used in this 
method 

Define the pair of solvent reservoirs to be used in defining the mobile phase 
composition during the run by making a selection from the drop-down list 
(A1/B1. A1/B2, A2/B1, or A2/B2). 

Solvent Selection 
expander 

Parameter Description 

Solvent A: 1 
Solvent A: 2 
Solvent B: 1 
Solvent B: 2 

Select a name from the solvents dictionary 
(which populates the drop-down list), or enter a 
new solvent name, for reservoir A1, A2, B1, and 
B2. 

Compressibility  Select from the drop-down list a compressibility 
factor that most closely matches the selected 
solvent, for reservoir A1, A2, B1, and B2. 

The compressibility values are: Water: 46, 
Acetonitrile: 115, Chloroform: 100, Ethyl Acetate: 
104, Hexane: 150, Isopropanol: 100, Methanol: 
121, THF: 95, Toluene: 87 
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Advanced LC Pump Settings 

The following parameters display when you click the Advanced expander. 

Parameter Description 

Standby Flow 
(mL/min) 

Enter the flow rate to be set after the Standby Time has elapsed. 

Range: 0.00 to 3.00 mL/min for Series 275 HiRes Micro, Flexar Binary Micro, FX-10 

0.00 to 5.00 mL/min for FX-15/FX-20 

0.00 to 10.0 mL/min for all other pumps 

Standby Time 
(min) 

Enter the number of minutes (15 to 999 min in 0.1 min increments) that the pump 
will remain in the Ready state before changing to the standby flow rate. 

Stop Time 
After Equil 
(min) 

Enter the length of time the pump will wait for an external command before 
shutting the pump down. 

Upper Pressure 
Limit Enter the upper limit of the pressure, above which the pump will shut off. 

Lower Pressure 
Limit Enter the lower limit of the pressure, below which the pump will shut off. 

The allowed overall range of pump pressure limits is shown the the table below. 

 Flexar FX-15/FX-20 Flexar FX-10 and  
Series 275 HiRes Micro 

All other pumps 

Range in psi 0 to 18000 0 to 10000 0 to 6100 

Range in bar 0 to 1241 0 to 689 0 to 420 

Range in MPa 0 to 124 0 to 68 0 to 42 

NOTE: The Pressure Units are set in Preferences. 
The Standby Time range is the same for all of the Flexar/Series 200 pumps supported in this 
release. 
The Standby Flow range is the same for all of the Flexar/Series 200 pumps supported in this 
release, with the exception of the microbore pumps, for which the range is 0.00 to 3.00 mL/min. 
 

Pump Steps Description 

Step 
The steps in the pump program. 
Step 0 – Is the equilibration step. All programs must begin with Step 0. 
Step 1 through 19 – Are the steps in the pump program during data collection. For 
an ICP-MS method, the sum of the times in Steps 1 - 19 should equal the run time in 
the ICP-MS portion of the method. 
Wash step is always last step, where the column is cleaned. No data is collected 
during this step. 
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Step Type Equilibration for Step 0, allows time for the column to equilibrate prior to data 
collection. Run for subsequent steps indicates data collection. Wash is where the 
column is cleaned and no data is collected. 

Step Time (min) The duration of the current step in minutes. 

Flow (mL/min) The flow rate of the mobile phase (solvents) in mL/min. 

%A, %B, %C, 
%D 

The percentage of each of the four solvents comprising the mobile phase. The 
percentages are entered by the user. 

Percentage of D is calculated (100 – %A –%B – %C) However, D can never be less 
than zero. If a user entry would cause this to happen, then the amount by which D 
would go negative is subtracted from the next available solvent. For example, if you 
increase B by 20% and D is only 10% then 10% would be subtracted from C (or 
from C and A if necessary). Similarly if you enter a value in D, solvent C (and/or B 
and/or A) is adjusted as necessary to maintain a total of 100%. 

Curve The solvent gradient curvature (change in concentration) during the step. This 
parameter is only displayed when Gradient is selected as the Transition type. A 
Curve of 1 is linear. A Curve of 0 is a step gradient. Curves -9.9 to 9.9 (in 0.1 
increments) are concave/convex profiles. 

NOTE: If a Wash step is used, it must be the last step for both the Isocratic and Gradient curves since no 
data is collected during this step. 

Pump Timed 
Events 

Description 

Step Type Select the Step from a drop–down list indicating whether the event will occur during 
Equilibration, Run, or Wash. 

TE Time (min) The time into the run at which the event will occur. 

TE Select the event relay to be activated. There are two relays available: TE1 and TE2. 

Method: Autosampler Settings (Flexar or Series 200/ 225/ 275) 

When an autosampler is configured as part of an instrument, the vial number, injection 
volume and number of injections settings in the sequence row act as control parameters for 
the autosampler. These are in addition to the control parameters in the instrument method 
(in the case of injection volume the sequence value over-rides the value from the method). 

The autosampler instrument method includes the Injection Delay parameter. This causes the 
autosampler to delay sample injection for a set period of time after the run has started (that 
is, after the autosampler has sent the 'start' signal to the other devices making up the 
instrument). Chromera also supports the Fixed Mode of injection for the Series 200 
autosampler. This is applicable to loop sizes of 200µL or less.  
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Chromera also supports the Flexar or Series 225 and Series 275 autosamplers, which are 
largely compatible with the Series 200, with the exception of the parameters in the following 
table: 

Parameter Series 200 Flexar/Series 225/275 

Excess Volume (µL) Yes N/A 

Fixed Mode Yes N/A 

Mode   N/A Yes (Partial Loop/Fixed Loop/µPickup) 

Needle Level  Yes (0 to 100) Yes (2.0mm to 6.0 in 0.5mm increments) 

Each autosampler supports specific trays: 

Series 200 Autosampler: 

Series 200 Autosampler Tray Description Display Name 

25-Position 6mL vial tray 25-Position Tray 

80-Position Sample Tray, Dilution Kit; for serial dilutions 80-Position Tray  w/ Dilution Tank 

85-Position Sample Tray; (80) 2mL vials plus (5) 6mL 
reagent vials (for pre-column automated sample 
derivatization) 

85-Position Tray (80 x 2mL + 5 x 6mL) 

100-Position 2mL vial tray 100-Position Tray 

205-Position sample tray; (195) 0.2mL micro-vials plus (10) 
2mL vials 

205-Position Tray (195 x 0.2mL + 10x2mL) 

225-Position 0.2mL micro-vial tray 225-Position Tray 

2 x 96-well 'shallow' (200-300L) micro-titer tray; w/ hold-
down mechanism 

96-Well "Shallow" Microtiter tray 

2 x 96-well 'deep' (0.8-1 mL) micro-titer tray; w/ hold-
down mechanism 

96-Well "Deep" Microtiter tray 

100-Position 2mL vial Peltier Temperature-Controlled Tray 
Accessory (100 standard 2mL vials). Temperature 
controlled from 4 to 60° C within ± 1° C 

100-Position Tray  w/ Peltier 

2 x 96-well "shallow" Micro-titer Peltier Temperature-
Controlled Tray Accessory (supports 2 "shallow" (200-
300L) or "medium" (400-500  L) depth microtiter plates). 
Temperature controlled from 4 to 60° C within ± 1° C 

96-Well "Shallow" Microtiter Tray w/ Peltier 

2 x 384-well "shallow" Micro-titer Peltier Temperature-
Controlled Tray Accessory (supports 2 "shallow" (100L) 
depth microtiter plates). Temperature controlled from 4 to 
60° C within ± 1° C 

384-Well "Shallow" Microtiter Tray w/ Peltier 

Flexar/Series 225/275 Autosampler: 

Flexar/Series 225/275 Autosampler Tray Description  Display Name 

25-Position 6mL vial tray 25-Position Tray 

80-Position 2mL vial tray with 60mL dilution tank (for serial dilution 
applications) 

80-Position Tray  w/ Dilution Tank 

85-Position tray; (80) 2mL vials plus (5) 6mL reagent vials (for pre-
column automated sample derivatization) 

85-Position Tray (80 x 2mL + 5 x 6mL) 

100-Position 2mL vial tray 100-Position Tray 
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205-Position tray; (200) 0.2mL micro-vials plus (5) 2mL calibration 
vials 

205-Position Tray (200 x 0.2mL + 5 x 
2mL) 

96-well 'shallow' adaptor (1 adaptor is required to use the Series 
225/275 autosampler with either one or two 96-well 'shallow' micro 
titer plates) 

96-Well "Shallow" Microtiter Plates 

96-well 'deep' adaptor (1 adaptor is required to use the Series 
225/275 autosampler with either one or two 96-well "deep" micro 
titer plates) 

96-Well "Deep" Microtiter Plates 

384-well adaptor (1 adaptor is required to use the Series 225/275 
autosampler with either one or two 384-well micro titer plates) 

384-Well Microtiter Plates  

Flexar or Series 200/ 225/ 275 Method Values 

 Enter method values for the following Autosampler parameters. 

You use this row to setup and configure the method for the Autosampler settings. The 
primary setting is the Injection Volume, but additional parameters are accessible in the 
Advanced settings. 

 
 

Parameter Description 

Injection Volume (µL) The amount of sample injected.   

Temperature Control Select On or Off from the drop-down list to set whether 
the tray temperature control will be active or not. This is 
not displayed for No Peltier models. 

Tray Temperature (°C) The temperature to be maintained when the Peltier 
autosampler tray is installed. 

Tolerance (± °C) The deviation of the Tray Temperature from set 
temperature allowed for the Ready condition. 
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Advanced Autosampler Settings 

 

Advanced Band Description 

Injection Mode Select from the drop-down list the operational mode of 
autosampler.  

 Loop Size (µL) The size of the installed sample loop. 

Air Cushion (µL) The volume of the air cushion between the sample and flush 
solvent. 10 µL is recommended. 

Flush volume (µL) The volume of flush solvent used to flush the injector needle 
for each flush cycle. 

Syringe Size (µL) The volume of the syringe used to withdraw and inject sample. 

Injection Delay Time (min) Define the time (from 0.00 to 99.99 min) after the autosampler 
has sent the Start signal to the other instrument devices to when 
the injection is actually made.  

Needle Level (mm) Select from the drop-down list the position of the sampling 
needle in the sample vial (2, 2.5, 3, 3.5, 4, 4.5, 5, 5.5, 6 mm) 

Needle Tube Volume  (µL) Enter the volume used to center the sample within the sample 
loop in µL (1 to 20) – Pickup mode. 

Sample Speed The rate (Very Slow, Slow, Medium, Fast and Very Fast) at 
which the sample syringe fills the injection loop. 

Flush Speed The speed (Very Slow, Slow, Medium, Fast, and Very Fast) at 
which you want the pump to flush the system. 

Flush volume (µL) The volume of flush solvent used to flush the injector needle 
for each flush cycle. 

Number of Pre-injection 
flushes 

The number of flush cycles you want before each sample 
injection. 

Number of Post-injection 
flushes 

The number of flush cycles you want after each sample 
injection. 

NOTE: The method for the Series 225/ 275 autosamplers is slightly different. 
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The Series 225/275 autosamplers do not use the Excess Volume parameter and exhibit 
differences from the Series 200 in the Mode and Needle Level parameters. 

Method: Autosampler Settings (Flexar DS Autosampler) 

When an autosampler is configured as part of an instrument, the vial number, injection 
volume and number of injections settings in the sequence row act as control parameters for 
the autosampler. These are in addition to the control parameters in the instrument method 
(in the case of injection volume the sequence value over-rides the value from the method). 

The autosampler instrument method includes the Injection Delay parameter. This causes the 
autosampler to delay sample injection for a set period of time after the run has started (that 
is, after the autosampler has sent the 'start' signal to the other devices making up the 
instrument).  

Flexar/Series 225/275 Autosampler Tray Description  Display Name 

25-Position 6mL vial tray 25-Position Tray 

80-Position 2mL vial tray with 60mL dilution tank (for serial dilution 
applications) 

80-Position Tray  w/ Dilution Tank 

85-Position tray; (80) 2mL vials plus (5) 6mL reagent vials (for pre-
column automated sample derivatization) 

85-Position Tray (80 x 2mL + 5 x 6mL) 

100-Position 2mL vial tray 100-Position Tray 

205-Position tray; (200) 0.2mL micro-vials plus (5) 2mL calibration 
vials 

205-Position Tray (200 x 0.2mL + 5 x 
2mL) 

96-well 'shallow' adaptor (1 adaptor is required to use the Series 
225/275 autosampler with either one or two 96-well 'shallow' micro 
titer plates) 

96-Well "Shallow" Microtiter Plates 

96-well 'deep' adaptor (1 adaptor is required to use the Series 
225/275 autosampler with either one or two 96-well "deep" micro 
titer plates) 

96-Well "Deep" Microtiter Plates 

384-well adaptor (1 adaptor is required to use the Series 225/275 
autosampler with either one or two 384-well micro titer plates) 

384-Well Microtiter Plates  

Flexar Autosampler DS Method Values 

 Enter method values for the following Autosampler parameters. 

You use this row to setup and configure the method for the Autosampler settings. The 
primary setting is the Injection Volume, but additional parameters are accessible in the 
Advanced settings. 
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Parameter Description 

In Use Click in the check box to use the autosampler when running 
this method. When not checked it ignores the autosampler 
when running a method. 

Injection Volume (µL) The amount of sample injected.   

Temperature Control Select On or Off from the drop-down list to set whether the 
tray temperature control will be active or not. This is not 
displayed for No Peltier models. 

Tray Temperature (°C) The temperature to be maintained when the Peltier 
autosampler tray is installed. 

Tolerance (± °C) The deviation of the Tray Temperature from set temperature 
allowed for the Ready condition. 

Inter-Method Flushes 

Select the following values. Note that these flushes are in addition to any pre-injection 
flushes defined for the method but they occur only at initial set up of the method. 

Control Description 

Number of Flushes Prior to Method Setup: A Select from the drop-down list the number of flush 
cycles (from 0 to 9) with solvent A when the method is 
first set up. 

Number of Flushes Prior to Method Setup: B Select from the drop-down list the number of flush 
cycles (from 0 to 9) with solvent B when the method is 
first set up. 

Advanced Autosampler Settings 

Select the Advanced expander to display the additional autosampler parameters for which 
defaults are set in Preferences. 
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Advanced expander Description 

Injection Mode Select from the drop-down list the operational mode of 
autosampler.  

Loop Size (µL) The size of the installed sample loop. 

Air Cushion (µL) The volume of the air cushion between the sample and flush 
solvent. 10 µL is recommended. 

Flush volume (µL) The volume of flush solvent used to flush the injector needle 
for each flush cycle. 

Syringe Size (µL) The volume of the syringe used to withdraw and inject sample. 

Injection Delay Time (min) Define the time (from 0.00 to 99.99 min) after the autosampler 
has sent the Start signal to the other instrument devices to when 
the injection is actually made.  

Needle Level (mm) Select from the drop-down list the position of the sampling 
needle in the sample vial (2, 2.5, 3, 3.5, 4, 4.5, 5, 5.5, 6 mm) 

Needle Tube Volume  (µL) Enter the volume used to center the sample within the sample 
loop in µL (1 to 20) – Pickup mode. 

Sample Speed The rate (Very Slow, Slow, Medium, Fast and Very Fast) at 
which the sample syringe fills the injection loop. 

Flush Speed The speed (Very Slow, Slow, Medium, Fast, and Very Fast) at 
which you want the pump to flush the system. 

Flush volume (µL) The volume of flush solvent used to flush the injector needle 
for each flush cycle. 

Number of Pre-injection 
flushes A 

The number of flush cycles with solvent A before each sample 
injection. 

Number of Pre-injection 
flushes B 

The number of flush cycles with solvent B before each sample 
injection. 
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Number of Post-injection 
flushes A 

The number of flush cycles with solvent A after each sample 
injection. 

Number of Post-injection 
flushes B 

The number of flush cycles with solvent B after each sample 
injection. 

NOTE: The method for the Series 225/ 275 autosamplers is slightly different. 

The Series 225/275 autosamplers do not use the Excess Volume parameter and exhibit 
differences from the Series 200 in the Mode and Needle Level parameters. 

Method: Autosampler Sample Preparation (Derivatization or 
Dilution ) 

The Sample Preparation tab for Derivatization or Dilution enables you process each sample 
and then inject the resultant.  The sample preparation step applies to a row of the sequence, 
not to an injection.  That is, the sample preparation is performed for the current row and 
then each specified injection and acquisition for that row will follow, before execution 
proceeds to the next row.  

A new Status item is used with Sample Preparation – Sample Vial.  This is specifically the vial 
from which sample is taken for the purposes of derivatization or dilution. This is (or may be) 
distinct from the vial from which the injection is made (the target vial), which is what will be 
shown for the existing Status items ‘Current Vial’ and ‘Injection Number’ (this is how these 
items work). The item ‘Sample Vial’ will always show the vial number from the current 
sequence row.  Having this in Status along with the target vial (as shown by ‘Current Vial’ 
and ‘Injection Number’) allows you to see the full sample preparation picture in one place. 

The following examples show Derivatization and Dilution settings. 

Derivatization Example 

This is a typical example of derivatization, indicating that more than one reagent can be 
used. The sample preparation steps to take place when the program is run are: 

1. 500 µL of sample is transferred from the sample vial to the target vial – which is 
offset by 50 from the sample vial (the vial defined in the current row of the 
sequence, where applicable). 

2. 50 µL of reagent A is transferred from vial 1 to the target vial. Mixing will be 
performed to ensure a homogeneous mixture is obtained. A wait time of 1 minute 
will then be allowed to elapse before the next transfer. 

3. 60 µL of reagent B is transferred from vial 2 to the target vial. Mixing will be 
performed to ensure a homogeneous mixture is obtained. A wait time of 2 minutes 
will then be allowed to elapse before the injection proceeds. 

Following the preparation process, the amount specified for the Injection Volume in the 
current row of the sequence will be injected from the target vial. 

This derivatization process requires ‘Offset of Target Vials from Sample Vials’ to be set to 50 
and two items in the Reagents/Diluents: 
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The fact that the reagent transfers are to be made from a pair of specific vials (rather than a vial 
series) suggests that either the 85-Position tray (80 x 2mL + 5 x 6mL) or the 205-Position tray 
(200 x 0.2mL + 5 x 2mL) is likely to be required, if any significant number of samples is to be 
derivatized. This is not an issue during the creation of the Method but it will be discussed further 
under Sequence. 

The sample preparation steps for this example derivatization are defined in the Transfers to Target: 

 

Dilution Example 

The sample preparation steps to take place when the program is run are: 

1. 500 µL of diluent is transferred from the Diluent Tank to the target vial – which is 
offset by 40 from the sample vial (the vial defined in the current row of the 
sequence, where applicable. 

NOTE: Applicable depends on a couple of factors.  Firstly, the sample preparation method is not 
executed for rows that do not involve injection (e.g. Background, Wash).  Secondly, if the 
‘Execute sample preparation for ‘Sample’ row types only’ flag is checked, the sample 
preparation will not be executed for ‘Standard’, ‘Matrix’, ‘Calib’ or other non ‘Sample’ rows. 

2. 100 µL of sample is transferred from the sample vial to the target vial. Mixing will be 
performed to ensure a uniform diluted sample is obtained. 

Following the preparation process, the amount specified for the Injection Volume in the 
current row of the sequence will be injected from the target vial. 

This dilution process requires just a single item in the Reagents/Diluents grid: 
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The use of the Tank implies use of a specific autosampler tray (80-Position tray − with 
dilution tank). This is not an issue during the creation of the Method but it will be discussed 
further under Sequence. 

The sample preparation steps shown above are defined in the Transfers to Target table: 

 

Note that neither the Source ‘Sample’ nor the Target has to be defined in the 
Reagents/Diluents table. The Sample is a default item that is always present (effectively the 
item with index=0). The Target is defined by the value of ‘Offset of Target Vials from Sample 
Vials’ (in this case a value of 40 would be entered as indicated in step 1 above). 

Sample Preparation 

The existing autosampler parameters will appear on the first tab – labeled ‘Basic’ .  A new 
static text label and the bottom of the view will indicate whether or not an active sample 
preparation program exists in the method.  

By default the Sample Preparation tab will appear as shown below: 

NOTE: Air Mixing Volume control is only for the Series 200 autosampler. For all other autosamplers 
(Series 225, 275 and Flexar) the Air Mixing Volume control will not appear.  
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Click the check box to set each of the two options at the top of the tab that affect the general 
behavior of the sample preparation program. 

Control Description 

Enable Sample Preparation program A check box that determines whether or not the sample 
preparation defined on this page will be executed when the 
method is used for acquisition. 

Execute sample preparation for ‘Sample’ row 
types only 

A check box that determines whether the sample 
preparation defined on this page will be executed for all 
(injection-type) rows of the sequence or only for rows of 
type ‘Sample’. 

NOTE:  Although checking ‘Enable Sample Preparation program’ is not really valid when no program exists, 
this control will not be disabled if there is no program.  The reason for this is a consequence of the 
fact that the logical place for this control is at the top of the page. To be forced to leave this setting 
until a program has been entered and then have to remember to go back and check the (now 
enabled) control would be annoying and open to error. If the method download code will have a 
problem with a program of zero steps then we should implement a method validation rule that will 
stop the method from being saved if there are no program steps while ‘Enable Sample Preparation 
program’ is checked. 

Samples/ Targets Group 

This group box contains three items related to the definition of the source and target vials. 
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Control Description 
Samples originate from the vials defined in the 
Sequence rows. 

A static text field indicating that the location of the current 
sample (source) vial is taken from the current sequence 
row. 

Offset of Target Vials from Sample Vials An integer numeric field that enables the user to define the 
starting position of a target vial (the vial from which the 
injection will be made) relative to the source (sample) vial 
defined in the sequence tray. 

Initial Target Volume (µL) A numeric field that defines the initial volume of liquid 
present in each target vial (meaning the vial [series] from 
which the injection will be made). 

M ix ing Group 

This group contains the parameters related to sample mixing. The Air Mixing Volume 
parameter only appears for the Series 200 autosampler. 

Control Description 
Mix Speed – In Liquid mixing: The speed of the flush syringe when it picks up 

sample plus reagent (or diluent) from the target vial for mixing. Air 
mixing: The speed of the flush syringe when it draws in air. 

Mix Speed – Out Liquid mixing: The speed of the flush syringe when it ejects up 
sample plus reagent (or diluent) back into the target vial for mixing.  
Air mixing: The speed of the flush syringe when it expels the air into 
the target vial for mixing. 

Air Mixing Volume (µL) 
(Series 200 autosampler 
only) 

The volume of air drawn into the syringe for mixing. 

Reagents/ Diluents 

This section contains definitions of the ‘ingredients’ to be used in sample preparation – 
excluding the original sample itself. Up to 6 ‘ingredients’ can be defined. 
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Control Description 

 
This button adds a new row at the end of the Reagents/Diluents/Target Vials 
grid. 

 
This button deletes the currently selected row of the Reagents/Diluents/Target 
Vials grid. 

Description Type a description to identify the item. Any string of characters that can be 
entered via the keyboard. Ideally there should be no length restriction but 
testing does not need to exceed 50 characters (which can be used as a limit by 
the software if necessary). 

Type Select from the drop-down list the kind of source item being defined. 
Vial Enter a number in the edit box to identify the vial in the autosampler tray to be 

the source of an item of ‘Type’ = ‘Vial’.  
Enter from 1 to 225 (384/768-well microtiter plates are not supported for 
sample preparation.) 

Offset From 
Sequence Vial 

Enter a number (from 0 to 100) to define the starting position of a ‘Vial Series’ 
relative to the source vial defined in the sequence tray. 

Transfers to Target 

The rows define the specific liquid transfers to be made as part of the sample preparation 
prior to injection.  Up to 10 rows may be used. 

Control Description 

 
This button adds a new row at the end of the Transfers table. 

 
This button deletes the currently selected row of the Transfers table. 

 
This button inserts a row above the currently selected row of the Transfers 
table. 

Source  Use this drop-down list to define the source of the current transfer operation.  
Sample (meaning the vial defined in the current sequence row) plus all items 
defined in the Reagents/Diluents/Target Vials table. 

Volume (µL) Enter a number (from 1 to Syringe Size) to define the amount of liquid that will 
be transferred from the Source to the Target. 
NOTE: For the Series 200 this is the Sample Syringe size (from the Basic 
settings tab).  For other autosamplers this is the Syringe Size from the Basic 
settings tab 

Mix Cycles Select from the drop-down list a number of mixing cycles (from 0 to 9) that will 
be performed for the current transfer operation. 

Wait Time (min) Enter a number (from 00.00 to 99.99) to define the time that will be allow to 
elapse following completion of the current transfer before the next transfer (if 
any) or the sample injection (if no further transfers) will be initiated. 
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Method: ELSD Settings 

The Evaporative Light Scattering Detector (ELSD) does not itself recognize a Not Ready 
state, it goes directly to Ready when set from Standby into active mode, even if the various 
thermal zones are not yet at their setpoints. To ensure the detector is in a stable state 
Chromera will monitor various elements of the ELSD when it is set to Active mode and only 
post the Ready status when all are within specified limits. The specific elements monitored 
and the conditions for Ready defined below: 

Drift tube and spray temperatures are stable at setpoint (within 1.5 degrees) 

Gas On and Pressure  

• Gas On and pressure >= 30 psi 

• Signal response > 10 mV and < 1 V 

• Laser On 

If any of the above conditions is not met the ELSD status will be reported as Not Ready. 

 Enter your initial method parameters for the ELSD: 

 

Settings Description 

In Use Click in the check box to use the ELSD when running this method. When not 
checked it ignores the ELSD when running a method. 

Spray Chamber 
Temperature (ºC) 

Enter a temperature (from 10 to 60 ºC) for the spray chamber.  

Drift Tube 
temperature (ºC) 

Enter temperature (22 to 120 ºC) for the drift tube. 

Gain Select from the drop-down list the gain (Normal or Low) of the amplifier. 
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Filter type Select from the drop-down list the type of filtering (Standard or Baseline). 

Filter Level Select from the drop-down list the degree of standard or baseline filtering 
(Off, 1 to 10). 

End Time (min) Set the length of time (from 0.0 to 999.9 min) for which data is acquired in 
the run (starting at time 0.0). Must be greater than (or equal to) the highest 
setting for Elapsed Time in the wavelength program table. 

Method: UV/ Vis Detector Settings (Flexar or Series 200) 

The UV/Vis detector is a single channel, programmable wavelength device.  

NOTE: Chromera also supports the Flexar or Series 200 HS UV/Vis detector, which is identical to the 
standard detector, except for the addition of a sampling rate of 100 pts/s (equivalent to Peak 
Width of 0.05s). 

1. Enter your initial method parameters for the UV/Vis Detector: 

 
 
Parameter Description 

Channel Name Enter a name (from 1 to 25 characters) to be used as an 
identifier for the data channel in the Channels, Peak Detection 
and Calibration sections of the method.  
The Series 200 UV/Vis detector only supports one channel but 
this field is required in the future for multi-channel detectors.  
A name must be entered before the method can be saved. The 
name must be unique within the channels of the method. 
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Sampling Rate (pts/s) The data acquisition rate from the detector. Select the rate (0.5, 
1.0, 2.0, 5.0, 10.0, 20.0, 50.0, pts/s) from a drop-down list. The 
UHPLC version has a 100 pts/s selection.  

The detector front panel provides three modes of access to this 
setting: Data Rate, Rise Time and Peak Width.  
See notes below. 

Peak Width (s) Select one of the peak width at half height settings (25.00, 
10.00, 5.00, 2.50, 1.00, 0.50, 0.25, 0.10) supported by the 
detector from the drop-down list.  See notes below. 

End Time (min) Set the length of time (from 0.0 to 999.9 min) for which data is 
acquired in the run (starting at time 0.0). Must be greater than 
(or equal to) the highest setting for Elapsed Time in the 
wavelength program table. 

 

NOTES: (1) The Series 200 UV/VIS detector supports a different sampling rate for each 
wavelength program step of the method, as would the Chromera data acquisition 
software. However, the normal processing of wavelength programmed runs is to 
concatenate the data streams and perform peak detection on the complete 
chromatogram. Since the current peak detection algorithms do not support multiple 
sampling rates within a single analysis, the sampling rate is set for the channel as a 
whole. (2) Either Sample Rate or Peak Width is displayed, depending on the user 
preference setting. 

2.  Enter Detector Wavelength Program parameters (1 to 20 steps can be created). 
 

Detector Wavelength 
Program Parameter  
(1 to 20 steps can be created) 

Description 

Elapsed Time (min) The time (from 0.0 to 999.9 min) into the run at which the 
settings are to take place. Time is always 0.0 for the mandatory 
first program step and cannot be edited. 

For subsequent steps, if you enter a value that is larger than 
the current End Time setting then End Time is set equal to that 
value. 

Wavelength (nm) The wavelength to be monitored for this step.  
Deuterium lamp: 190 to 700 nm 
Tungsten lamp: 360 to 700 nm 

Autozero A check box indicating whether the detector should perform an 
autozero (yes) at the beginning of the step. 
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3. Enter the Timed Event parameters (Up to 20 steps can be created). 
 

Timed Event 
Parameters 

Description 

TE Time (min) The elapsed time (from 0.00 to 999.99 min) into the run at 
which the specified event should occur. Up to 20 events may 
be specified. 

TE1 Select No Action, Open, Close, or Momentary from a drop-
down list to specify the action to be performed with event 
#1.   
No Action = leave in current state. 

Momentary = close for 2 seconds and then reopen. 

TE2 Select No Action, Open, Close, or Momentary from a drop-
down list to specify the action to be performed with event 
#2.  No Action = leave in current state 

Momentary = close for 2 seconds and then reopen. 

Description Enter a comment about the event using up to 50 characters. 

 

Method: PDA Detector Settings 

The PDA detector is a multi-channel, programmable wavelength device. 

NOTE: The lamp is automatically selected based on the wavelength selected for the channel 

1. Enter your initial method parameters for the PDA Detector: 

 

 

Parameter Description 

In Use This check box enables you to use or ignore the PDA detector when 
running the method. If the box is not checked then the PDA detector will 
be ignored when the method is applied to the instrument. 

Sampling Rate 
(pts/s) 

Select from the drop-down list the data acquisition rate from the 
detector. Chromera will use a single value for the entire run. 

Sampling Rate (pts/s) 1000, 500, 333, 250, 100, 50, 20, 10, 5, 2, 1, 0.5, 
0.2 pts/s. 
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End Time (min) Set the length of time (from 0.0 to 999.9 min) for which data is acquired 
in the run. 

2. After entering your method parameters, select Channel in the Method tree and 
enter the Channel parameters for this method. 

Method: PDA Plus Detector Settings 

The Flexar PDA Plus detector is a multi-channel, programmable wavelength device. 

NOTE: The lamp is automatically selected based on the wavelength selected for the channel. 

1. Enter your initial method parameters for the PDA Plus Detector: 

 

 

Settings Description 

In Use This check box enables you to use or ignore the PDA Plus detector when 
running the method. If the box is not checked then the PDA Plus detector will 
be ignored when the method is applied to he instrument. 

Sampling Rate 
(pts/s) 

Select from the drop-down list the data acquisition rate from the detector. 
Chromera will use a single value for the entire run. 

Sampling Rate (pts/s): 200, 100, 50, 20, 10, 5, 2, 1, 0.5, 0.2 pts/s 

End Time (min) Set the length of time (from 0.0 to 999.9 min) for which data is acquired in 
the run. 
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Advanced Settings 
(For advanced users) 

Description 

Pixel Read Time (ms) Enter the time for which signal from each pixel of the array will be read to 
generate a data point. Only integer values may be entered (from 2.0 to 100.0 
ms).  

The Pixel Read Time field only accepts an entry of numeric characters (0 to 9) 
and a decimal point. If the Pixel Read Time value entered is to more than 1 
decimal place, it will be rounded to 1 decimal place. 

NOTE: Selecting Pixel read times longer than 5 ms will limit the fastest 
selectable sampling rates. 

Pixel Read time and Sampling Rate are inter-related. With a Pixel Read Time 
of 5.0 ms (the default) or less, all sampling rates (from 0.2 to 200pts/s) will be 
available. At higher Pixel Read Times, some of the faster rates will become 
unavailable.  

Pixel Read 
Time (ms) 

Valid Sampling Rates (pts/s) 

2.0 to 5.0 0.2, 0.5, 1.0, 2.0, 5.0, 10.0, 20.0, 50.0, 100.0, 200.0 

5.1 to 10.0 0.2, 0.5, 1.0, 2.0, 5.0, 10.0, 20.0, 50.0, 100.0 

10.1 to 20.0 0.2, 0.5, 1.0, 2.0, 5.0, 10.0, 20.0, 50.0 

20.1 to 50.0 0.2, 0.5, 1.0, 2.0, 5.0, 10.0, 20.0 

50.1 to 100.0 0.2, 0.5, 1.0, 2.0, 5.0, 10.0 
 

 
Analog Output 
Settings 

Description 

Analytical 
Wavelength (nm) 

Enter the central analytical wavelength (from 190 to 790) for the analog 
output. The default is 254. 

Analytical Bandwidth 
(nm) 

Enter the wavelength range around the central analytical wavelength for the 
analog output (from 1 to 25; odd numbers only). 

Reference 
Wavelength (nm) 

Enter the central reference wavelength (from 190 to 790) for the analog 
output. The default is 395. 

Reference Bandwidth 
(nm) 

Enter the wavelength range around the central reference wavelength for the 
analog output (from 1 to 25; odd numbers only).  

Add Channel Click the button to create a Chromera data channel from the currently displayed 
Analog Output settings. 

When the Analog Output parameters all contain valid values the Add Channel 
button will be enabled. When the button is clicked a Chromera data channel will 
be created with these values (even if a channel already exists with these 
values).  

2. After entering your method parameters, select Channel in the Method tree and enter 
the Channel parameters for this method. 
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Method: Fluorescence Detector Settings (Flexar or Series 200a) 

The Fluorescence Detector portion of the method is used to define the Fluorescence detector 
parameters. 

 

1.   Enter your initial Fluorescence Detector settings. 

Parameter Description 

Channel Name A text field (from 1 to 25 characters) that is used as an identifier for the 
data channel in the Channels, Peak Detection and Calibration sections of 
the method. Note that the Series 200 Fluorescence detector only 
supports one channel but this field is required in the future for multi-
channel detectors. 

Slit Width Select Standard or Wide from a drop-down list to define the detector’s 
Emission Bandwidth value. 

Offset Enter an Offset value (from 0 to 1000) to which detector output is set by 
an autozero operation. 

Sampling Rate 
(pts/s) 

Select the Sampling Rate from the drop-down list that specifies the data 
acquisition rate (of 20, 10, 5, 2.5, 1.25, 0.625, 0.3125) from the 
detector.  
The actual detector parameter is Sampling Period but this is mapped to 
points per second in the GUI, for consistency with other Chromera 
detectors. The detector’s Time Constant parameter is set to conform to 
the sampling rate defined (see below). 

End Time (min) An edit field specifying the length of time for which data is acquired in the 
run (starting at time 0.0 and continuing to 999.9 min). Must be greater 
than (or equal to) the highest setting for Elapsed Time in the wavelength 
program table (see below). See Run Time Reconciliation. 
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Sampling Rate to Time Constant mapping: 

Sampling Rate (pts/s) Time Constant (ms) 

20 0.05 

10 0.1 

5 0.1 

2.5 0.5 

1.25 1.0 

0.625 2.0 

0.3125 4.0 

2.   Enter your Detector Program settings (1 to 20 steps can be created). 
 

Detector Program Parameter (1 
to 20 steps can be created) 

Description 

Elapsed Time (min) An edit field defining the time (from 0.0 to 600.0 min) into the 
run at which the settings are to take place.  
Time is always 0.0 for the mandatory first program step and 
cannot be edited. 

For subsequent steps, if the user enters a value that is larger 
than the current End Time setting then End Time is set equal to 
that value. 

Excitation Wavelength (nm) Set the excitation wavelength (from 200 to 850 nm) for this 
program step. 

Emission Wavelength (nm) Set the emission wavelength (from 250 to 900 nm) to be 
monitored for this program step. 

Sensitivity Define the detector’s PMT Voltage parameter (Previous, Super 
High, High, Medium, Low, Super Low) from the drop-down list. 
(Previous means that the Sensitivity value is not changed by this 
step, so it remains as it was.) 

Baseline Mode A drop-down list to set how the baseline level is set (Autozero, 
Hold, or None) at the beginning of each program step.  
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Method: Flexar USB A/ D Settings 

The Flexar USB A/D are analog to digital (A/D) interfaces that acquire data from a 
chromatograph. You may perform a run either via manual injections or with an autosampler. 
The NCI 902 contains two A/D converters where the second A/D converter allows you to 
collect data from two detectors during a single run. 

 

1. Enter your initial method parameters for the Flexar USB A/D Settings: 

Parameter Description 

In Use Check this box to use or ignore the A/D when running the method. If the 
box is not checked then the A/D will be ignored when the method is 
applied to the instrument. 

Settings 

Voltage Range Select the voltage range from the drop-down list for the detector. 
Chromera will use a single value for the entire run. 

Unipolar -0.125v to +1.250v 
Bipolar -1.250v to +1.25v 

Sampling Rate 
(pts/s) 

Select the data acquisition rate from the drop-down list for the detector. 
Chromera will use a single value for the entire run. 

Sampling Rate (pts/s) 200 (single channel), 100, 50, 25, 20, 15, 10, 5, 2, 
1, 0.5, 0.2 pts/s 

End Time (min) Set the length of time (from 0.0 to 999.9 min) for which data is acquired 
in the run. 

Channels 

Channel A In Use Channel A is always selected. 

Channel B In Use Click this box to use Channel B. 
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Timed Events 

Description Enter a description for this relay action. 

Relay Select a Relay 1 through 6 from the drop-down list. 

Action Select On or Off from the drop-down list. 

Time (min) Enter a time for this action to occur. 

2. After entering your method parameters, select Channel in the Method tree and enter 
the Channel parameters for this method. 

 

Method: Refractive Index Detector Settings (Flexar or Series 200a) 

The Refractive Index Detector portion of the method is used to define the RI detector parameters. 

 

1.   Enter your initial RI Detector settings. 

Parameter Description 

Channel Name Enter an identifier (from 1 to 25 characters) for the data 
channel in the Channels, Peak Detection and Calibration 
sections of the method.  

The Series 200a Refractive Index detector only supports 
one channel. 

Temperature (°C) Set the temperature (Off, 30 to 50°C) of the RI cell.  

Sensitivity Set the detector sensitivity/dynamic range. Select from a 
drop-down list High (125 µRIU/V) or Low (500 µRIU/V) 
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Sampling Rate (pts/s) Set the data acquisition rate from the detector. The actual 
detector parameter is Response Time but this are mapped 
to points per second (i.e. 1 / response time). Select the 
Sampling Rate (pts/s) values from the drop-down list: 10, 
5, 2, 1, 0.66, 0.5 

End Time (min) Set the length of time (0.0 to 999.9 min) for which data is 
acquired in the run (starting at time 0.0). 

Must be greater than (or equal to) the highest setting for 
Elapsed Time in the wavelength program table. 

NOTE: The Flexar or Series 200a Refractive Index detector has no internal run clock, so the End 
Time and program steps are implemented by the Chromera software. 

2. Enter your Detector Program from 1 to 20 steps can be created. 
 

Parameter Description 

Elapsed Time (min) Enter the time into the run at which the settings are to take 
place.  Time is always 0.0 for the mandatory first program 
step and cannot be edited. 

For subsequent steps, if you enter a value that is larger than 
the current End Time setting then End Time is set equal to 
that value. 

Polarity Set the polarity by selecting from the drop-down list (+, -) for 
this step. 

Autozero A check box indicating whether the detector should perform an 
autozero at the beginning of the step. 

Method: NCI 901/ 902 Settings 

The NCI 901 and NCI 902 are analog to digital (A/D) interfaces that acquire data from a 
chromatograph. You may perform a run either via manual injections or with an 
autosampler.  The NCI 902 contains two A/D converters; the NCI 901 contains one. On the 
NCI 902, the second A/D converter allows you to collect data from two detectors during a 
single run. 

1. Enter your initial method parameters for the NCI 902 or NCI 901. 
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NCI 902 Display with Channels  NCI 901 Display without Channels 

Parameter Description 

In Use Check this box to use or ignore the A/D when running the method. If 
the box is not checked then the A/D will be ignored when the method 
is applied to the instrument. 

Settings 

Voltage Range (V) Select the voltage range from the drop-down list for the detector. 
Chromera will use a single value for the entire run. 

Voltage Range (V)  10.0, 2.0, 0.1 1.0 V 

Sampling Rate 
(pts/s) 

Select the data acquisition rate from the drop-down list for the 
detector. Chromera will use a single value for the entire run. 

Sampling Rate (pts/s)  50, 20, 10, 5, 2, 1, 0.5, 0.2 pts/s 

End Time (min) Set the length of time (from 0.0 to 999.9 min) for which data is 
acquired in the run. 

Channels (NCI 902 only) 

Channel Name If you have an NCI 902, it Displays A or B. 

Channel A or B In 
Use 

Click this box to use or ignore the channel A or B.  If you ignore 
channel B, the NCI 902 behaves like an NCI 901. 

Timed Events 

Description Enter a description for this relay action. 

Relay Select a Relay 1 through 7 from the drop-down list. 

Action Select On or Off from the drop-down list. 

Time (min) Enter a time for this action to occur. 

2. After entering your method parameters, select Channel in the Method tree and enter 
the Channel parameters for this method. 
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Method: Column Oven Settings (Flexar or Series 200) 

 

 
      Parameter Description 

In Use Check this box to use or ignore the oven when running the 
method. If the box is not checked then the oven will be ignored 
when the method is applied to the instrument. 

Temperature (ºC) The temperature to which the column oven is heated. 

Tolerance (+/- ºC) Set an accepted the + / - range for your over temperature. 

Equil Time (min) Set the length of time for the oven to achieve set temperature. 

Method: ICP-MS Settings 

The ICP-MS section of the method is used to define the ICP-MS parameters is used for 
speciation analysis. 

 

Parameter Description 

Run time (min) The entire chromatogram (data collection) run time. This is set on a per-
method basis. 
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DRC Mode  
(this only appears 
when DRC is 
configured) 

or 

Cell Mode 

The operational mode of the Dynamic Reaction Cell (DRC). Select from 
the drop-down DRC–A, DRC–B, Standard. When you select DRC-A or B 
the following two fields appear. 

Gas A or Gas B Flow - Displays the flow rate for the reaction gas 
chosen in the DRC mode. 

RPq - Displays the RPq value applied to all the analytes. 

Tuning File or  
Mass Cal 

Specifies the name of the ICP-MS tuning file that is used for calibration 
of the ICP-MS. 

Optimization File or 
Condition 

Specifies the name of the ICp-MS DAC file that will be used for the ICP-
MS parameters. 

Dwell Time (min) Determines the length of time spent measuring the analyte during a 
single sweep. 

It is the total time spent at the mass corresponding to the individual 
analyte listed. 

Auto Lens 

 

The spectrometer permits the ion lens to be synchronously scanned with 
the actual quadrupole mass scan, permitting dynamic adjustment of the 
lens voltage for optimum ion throughput. This functionality can be turned 
on or off. 

RPa Only in DRC: -A or B, it displays the RPa value for all the analytes. 

Detector Mode Specify which detector signal should be used during a 
determination.  Selected per method. 

Pulse - (Default setting) Specifies use of the detector's pulse counting 
signal option only. This option is applicable if you are performing a 
measurement on a sample likely to produce a low signal level. 

Analog - Specifies use of the detector's analog signal measurement 
option. This option is applicable if you are performing a measurement on 
a sample likely to produce a very high signal level. 

Dual - The detector measuring both the pulse count and analog signals. 

Use Short Settling 
Time 

This option applies to Standard mode elements only for DRC series 
instruments, and to all elements for the ELAN 6000, 6100, and 9000 
instruments. By selecting this option, the settling time for the 
quadrupole becomes much shorter (for example, 200 microseconds). 
This disables the Extended Dynamic Range feature; only the pulse 
stage of the detector is used. 

Sampling (pts/sec) Value calculated by the software will be provided. It is calculated by 
Sample Frequency = 1 / (Dwell Time * # Isotopes). 

Readings This entry defines how many individual readings will be acquired during 
the course of a single sample injection. 

Readings = total run time / ( Dwell Time * # Isotopes) 

Analytes 

Parameter Description 

Analyte The element to be analyzed. Values may be typed in or selected. 

To select an analyte click the button to display a pop–up window 
containing the Periodic Table, from which you can select the element 
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and isotope. 

Mass Populated with the mass of the selected isotope. You may also type a 
mass in this field. 

Use MSIS Constant Select Yes or No from a drop down list indicating whether a constant–
level Mass Spectral Internal Standard (MSIS) will be used. This element 
is typically spiked in the mobile phase to produce a constant signal 
during a chromatogram. 

MSIS Used Select the analyte Used. The button displays a pop–up window 
containing a depiction of the Periodic Table, from which the element 
(and isotope, where applicable) can be selected. 

MSIS Mass The isotope mass may be typed in or, if the pop–up Periodic Table 
dialog was used to select the standard, the value will be entered 
automatically. 

View Equation A check box that displays the Interference Correction Equation entry 
field.  

Equation In Use Indicates if a correction equation is being used. 

Method: Valves 

Chromera uses the following LC/UHPLC Rheodyne flow switching and column selector valves: 

• Rheodyne 6-column selector valve   (6000psi limit) 

This column selector valve, optional on Peltier column ovens, allows you to select one 
of up to 6 columns for each method 

• Rheodyne 750 6-port/2-postion valve   (6000psi limit) 

Depending on how it is configured in Chromera, this valve can be used as a general 
purpose LC flow switching valve, as well as either a diverter or post-column ISTD 
injection valve for LC-ICPMS applications. 

• Rheodyne MX II valve module  - includes TitanHT valve   (18000psi limit) 

Depending on how it is configured in Chromera, this valve, available as either a 6-port 
or 10-port valve, can be used for a multiple of LC/UHPLC tasks.  To list a few: 

• General purpose LC flow switching valve (6 or 10-port) 
• 2-column selector valve (6-port; must be configured as such) 

• Equilibrating one column while running another (requires 10-port valve and 
second pump) 

• Pre-concentration/purification (6-port) 

Method Parameters for Various Valve Configurations 

Rheodyne MX II/TitanHT 2-Position UHP Column Selector and the Rheodyne 
6-Column Selector  

• Enter following column selector parameters. 

Parameter Description 

Column Select the Column (2-position: Column 1 or 2; 6-position: 
Column 1 through Column 6) from the drop–down list. 
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Description Type a description for the selected column. 

  
Rheodyne MX II/TitanHT 2-Position UHP Switching Valve and the Rheodyne 
750 2-Position 6k psi Switching Valve  

• Enter following switching valve parameters. 

Parameter Description 

Time (min) The time into the run at which the post–column injection is 
to take place. 

Valve Position (1 or 2) Select 1 or 2 from the drop–down list. 

Description Type a description for the valve position. 

Method: Post-Column Injection 

The Post-Column Injection section controls the injection of a standard into the mobile phase 
after the chromatographic column and before it enters the ICP–MS nebulizer. The injection is 
carried out using a sampling valve dedicated to this procedure. Use the Post Column 
Injection (PCI) Valve only with CIS Blanks. 

 Enter values for the following Post-Column Injection parameters. 

Parameter Description 

Start Position A drop–down list indicating the fill position of the sampling 
valve. 

Duration (sec) The length of time the valve will remain in the inject 
position. 

Start Offset Time (min) The time into the run at which the post–column injection is 
to take place. 

Method Sw itching between Gradient and Isocratic Modes 
The rules defined below will apply when a pump method is switched between gradient 
method and isocratic method. 
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When a gradient method is switched to isocratic the action will be: 

1. All Pump steps will assume the composition settings of step 0. 

2. The curve field will be set to zero for all rows, and it will be hidden. 

3. All subsequent pump steps (1 and higher) will be disabled, including any new rows 
inserted. 

Conversely, when an isocratic method is switched to a gradient method the actions will be: 

1. Curve values will be displayed (all will be initially set to zero). 

2. Any disabled rows present will be enabled. 
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Channel Parameters 

A Channel Name band appears for each data channel defined in the hardware. The Channel 
Name is just an identifier for the channel and cannot be edited in this section. Bands will 
also appear for subsidiary channels. 

 

An example with a UV-Vis Detector 

 

An example with a PDA Detector 

Example Channels section with Channels node selected in method tree. 

General Data Channel Parameters Band 

Parameter Description 

Time Adjustment (min) An adjustment to be applied to the data from this 
channel, to correct for difference in mobile phase transit 
time between detectors plumbed in series. To correct 
for difference in mobile phase transit time between 
detectors enter an adjustment (0.000 to 5.000 min). 

Unretained Peak Time (min) Enter or select from the drop-down list the time taken by 
an unretained peak to elute from the chromatographic 
column. (User entry: 0.000 to 9999.999 min. List items: 
Use first peak) 

When a PDA is configured as a device you can identify specific PDA channels and enter additional 
parameters. 
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PDA Chromatographic Data Channel Parameters 
The PDA detector differs from most other detectors in that no chromatogram channels will be 
available from the detector and only spectral data will be downloaded. All chromatograms will be 
derived, extracted from the Spectral data. 

NOTE:  The lamp is automatically selected based on the wavelength selected for the channel. 

For the PDA detector, the channel parameters consist of: 

• Channel Name - An identifier for the derived/extracted chromatographic channel. This 
name will be created from the user-entered or derived channel parameters. This Channel 
Name will appear for Channels, Peak Detection, Calibration and Reporting sections of the 
method. 

• Time - The time of the wavelength change. 

• Analytical Wavelength - This specifies the central analytical wavelength. This is 
the wavelength used to monitor the chromatographic channel. 

• Analytical Bandwidth - This specifies the wavelength range around the central 
analytical wavelength. The width is in nm of that monitoring channel. 

• Reference Wavelength - This specifies the central reference wavelength. This 
wavelength is used to correct the chromatographic channel for lamp instability and 
drift. 

• Reference Bandwidth - This specifies the wavelength range around the central 
reference wavelength. The width is in nm of the correcting information. 

You can define the derived Channels to generate on the Channels section of the method.  
 

 
 
Derived Channels  Description 
Channel Name An identifier of the new derived data channel. The 

name is created automatically as the derived channel 
parameters are being entered. 

 
Analysis and Reference 
Wavelengths 

Description 

Time (min) Enter the time (>0 to Pump Time) into the run at 
which the settings are to take place. Time is always 0.0 
for the mandatory first program step and cannot be 
edited. Times greater than the pump time will not be 
accepted.  If the pump time is modified after this field 
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has been entered and Run Time reconciliation has 
been checked this field will be automatically updated.  

Analytical Wavelength (nm)  Enter the central analytical wavelength (190 - 700). 
Setting or modifying a wavelength will automatically 
set the required Lamp Used flag. 

Analytical Bandwidth (nm) Enter the wavelength range around the central 
analytical wavelength. The range is Calculated on the 
current Analytical Wavelength. 

Reference Wavelength (nm)  Enter the central reference wavelength (190 - 
700).  The reference channel eliminates background 
chromatographic or lamp drift.  No limitation is placed 
on the allowed entry, providing it is within the 
instrumental range.  It is therefore possible to set it 
equal to the Analytical Wavelength! 

Reference Bandwidth (nm) Enter the wavelength range around the central 
reference wavelength. The range is Calculated on the 
current Reference Wavelength  

Autozero A check box to specify if an autozero should be 
performed at the start of this segment.  By preference, 
the checkbox should not be present for the first 
step.  It is never editable for the first step. 

NOTE:  End time for a PDA channel is defined on the Instrument: PDA section of the method.  Since all PDA 
channels are extracted from a single spectral array, all channels must have the same end time. 

Other Parameters 

Time Adjustment (min) 

A time adjustment can be applied to the data from this channel to correct for a difference in 
mobile phase transit time between detectors plumbed in series (or unequal parallel 
arrangements). If this value is greater than zero then the raw data acquired from the start of 
the run up to the time adjustment value is ignored for processing and display purposes.  

NOTE:  The data is saved with the raw data set in the database and could be viewed by a 
subsequent modification to the time adjustment setting. The effect of this is that peaks in the 
adjusted channel will appear to have retention times less than indicated by their position in 
the complete raw data stream. 

For the PDA data this time adjustment is applied to the spectral array and not to the 
individual derived chromatograms to ensure that we maintain synchronicity between the 
chromatographic and spectral data.  This also ensures that all the derived channels will have 
exactly the same time adjustment. 

So that an adjusted data channel does not display less data than an unadjusted channel, the 
user-entered End Time is extended by the amount of the Time Adjustment. Although this 
means the actual elapsed time between the start of the run and end of acquisition for the 
adjusted detector is slightly longer than specified in the method, the net data acquisition time 
(after adjustment) is what the user has requested. (This automatic correction does assume 
that the user is not so clever as to specify a slightly longer End Time himself in order to take 
account of the Time Adjustment setting!) 

Clearly, although the Time Adjustment value can be adjusted post run, the amount of data 
acquired cannot be. Therefore a post-run modification to the Time Adjustment value will lead 
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to display of chromatograms of different length between channels, even if they had the same 
nominal End Time.  

The Time Adjustment value entered by the user must be automatically updated if the pump 
flow rate is modified in the method. This is straightforward for isocratic analyses: 

       
Where: 

TA'     Updated Time Adjustment value 

TA      Original Time Adjustment value 

A gradient program however provides the user with the option of setting a different flow rate for 
each step. Since such a program would cause the transit time between detectors to vary during 
the run, which simply cannot be handled by the simple time adjustment functionality described 
here. Therefore, in the case of gradient programs, the Time Adjustment value is updated based 
solely on changes made to the flow rate in step 1. If this behavior is not suitable for the 
application the user has the option of disabling the automatic update via a user preference. 

Unretained Peak Time (min) 

This is the time taken by an unretained peak to elute from the column. This value is used in 
Relative Retention and System Suitability calculations. 

In addition to being able to enter a specific time value to be used, the user will have the 
option of selecting ‘Use first peak’, which will cause the software to use the retention time of 
the first peak detected in the run for that channel as the unretained peak time. 

The Unretained Peak Time must be updated (assuming it is an entered value and not set to 'Use 
first peak') if the pump flow rate is modified in the method, in the same manner as is done for 
Time Adjustment. As with Time Adjustment, the update will only be performed when a change is 
made to flow rate for step 1. (Principally because that is often the only step that will affect the 
unretained peak time!) 

Derived/ Extracted Channel Name 

Sub-Channel Name is the new derived data channel name. The name is created automatically as 
the derived channel parameters are being entered.  You may however overwrite the default name.  

The name is created automatically from the four parameter fields, Analytical Wavelength, 
Analytical Bandwidth, Reference Wavelength and Reference Bandwidth in that order, using 
“:” as separators.  If the band defines the start of a wavelength program then the postfix “P” 
is added to the created name. The name should be created/modified as the four controlling 
fields are edited.  Thus, starting with all four fields empty, you are able to observe the name 
being built up. You may replace the default name with your own name. 

Editing of any of the four fields, Analytical Wavelength, Analytical Bandwidth, Reference 
Wavelength and Reference Bandwidth, replaces any existing name, user or automatic, with 
the default automatic name. Adding a Band 3 entry, i.e. creating a wavelength program, will 
simply add a “P” to the end of the current name plus the number of the parent band with 
which it is associated. It’s important that the sub-channel names should be unique and if the 
names created are similar to the one already existing, then the name should increment with 
a next higher number at the end of it. 
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Peak Detection Parameters 
The Peaks section of a method shows the general layout; in particular the ordering of the 
parameters in the different bands. This example is a dual-detector, single channel per detector 
for an LC Application, where the channel name is used as the identifier (as opposed to using 
Mass as the identifier for an LC/ICP-MS application). 

 

The whole structure shown under Device (in this example a PDA detector), the Component and 
component Event bands, are repeated for each active channel that requires integration. If you 
are using an LC system (i.e. no ICP-MS configured) the term Component displays and if you 
have an ICP-MS system the term Species displays. 

The available integration events are described in the Integration Timed-Events section. 

Common Parameters  Description 

Device Displays the current detector. 

Channel Name Enter an identifier for the data channel in the Channels, 
Peak Detection and Calibration sections of the method. 

Common Parameters 

Bunching Factor An edit field containing the bunching factor value used 
for integration of the analyte chromatogram. 

Area Threshold 

 

An edit field containing the area threshold value used for 
integration of the analyte chromatogram.  

Noise Threshold An edit field containing the noise threshold value used for 
integration of the analyte chromatogram.  
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RRT Ref Component Select from the drop-down list the component to be used 
for the calculation of Relative Retention. The RRT 
reference component must be from the current channel.  

Note that this setting is not related to peak identification 
in any way; it is just used for the calculation of RRT 
values. See Relative Retention Time (RRT). 

Unidentified Peak Quant 
Component 

Select from the drop-down list the component whose 
calibration curve is used to calculate all unidentified peaks 
detected on the channel. 

The component should be from the current channel. 

Auto Peak Detect 

 

 

Click in the check box to turn Auto Peak Detect On or Off. 

Auto Peak Detect is an algorithm that will automatically 
search for and integrate peaks when selected. If this box 
is checked, all manual peak detection parameters and 
timed events for this channel will be grayed out and 
unavailable. Method Preferences are used to set the 
default selection for this parameter, but can be overwritten 
here. 

 

Chromatogram 
Smoothing 

Description 

Function Select a desired function: Savitzky-Golay, Mean, or Gaussian 
from the drop-down list. 

Savitzky-Golay takes an average of the intensities weighted 
by a quadratic curve. This tends to enhance peak and valley 
shapes, as well as preserving the height of the peaks better 
than the Moving Mean. However, Savitzky Golay does tend to 
produce small artifacts on either side of the real peaks. 

Mean: For each data point in the source curve the processed 
curve is calculated as the average of the data points within the 
specified window. 

Gaussian sets how well a bell curve mathematically correlates 
with the displayed peak. 

Size The number you specify is the half-width of the smoothing 
window in scans. 

Passes Enter the number of times the smoothing algorithm should be 
applied to the window specified.  

Order Select the Polynomial Order curve fit to apply from the drop-
down for Savitzky-Golay. (This selection will only appear when 
the Savitzky-Golay smoothing is selected.) 
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Component/Species Description 

Component 
(Species for ICP-MS) 

Enter a component (species) name (from 1 to 50 
characters), select an existing name from the list, or select 
a name from the component dictionary via the drop-down 
list. Editing this field in this section reflects to changes made 
to the Calibration section also. 

Retention Time (min) Displays the mass of the analyte from the method.  

Peak Search Start (min) Enter the time in minutes or seconds or select a point or 
range in the graph.  

Peak Search End (min) Enter the time in minutes or seconds or select a point or 
range in the graph.  

Matching Select from the drop-down list what process will be used 
for matching a component when more than one peak falls 
within the peak search window. Use Tallest or use Closest. 

 
Component Type Description 

Type Select from the drop-down list the type of component being 
defined.  This depends on the application. Multiple type 
properties can be defined but a component cannot specify 
incompatible options (see note below). 

Uses a CIS - Chromatography Internal Standard ratio 
where every peak in a chromatogram is compared to this 
peak. 

Uses a Retention Time Reference - Accounts for peak 
shifts in a chromatogram. 

Reference Peak Select from a list populated from the retention time reference 
peaks included in the method (or defined here). 

NOTE: A component that specifies Uses a Retention Time Reference cannot also specify Is a 
Retention Time Reference. Similarly a component that specifies Uses an Internal 
Standard cannot also specify Is an Internal Standard. 

Baseline Events Description 

Event Type Commands that affect the peak detection and/ or integration 
at specific times in a chromatogram. Select the event type 
from the drop-down list. 

Start Time The time at which the event is to occur (for an instantaneous 
event) or start (for a event of specific duration). 
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End Time The time at which the event will end (for a event of specific 
duration). 

Value The value associated with the baseline event (where 
applicable). 

 For values that have a Start Time and End Time, you can draw a box in the chromatogram to 
define the region (Start/Stop times) where the events will be implemented. 

 For values that have just a Start Time or an End Time, you can click on the box, then click on 
the desired point in the chromatogram to set that time value. 

Entry of a New  Component 

You can enter new components in this section. Click the plus button  to add a blank line 
at the end of the component list can be used to define a new component (or species) rather 
than just select one defined elsewhere. This is the primary point of entry for Species in an 
ICP-MS system. 

 

Entry of a Component name acts to create a new component record, with appropriate default 
values where applicable. 

NOTE: A component name can also be selected from the component dictionary via a drop-down list. 

Scope of Component List 

The method effectively contains only one component list (regardless of the underlying 
database structure). Thus any change to the component list (such as editing of a component 
name or addition of a new component) in the Peaks section will automatically be reflected in 
the component list in the calibration section, and vice versa. While the component 
information on the other tab may be incomplete (for example, a component newly added in 
the Peaks section will not show any standard levels or calibration data when first viewed in 
the Calibration section) the component names comprising the list will always match in the 
two sections. 
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How to Copy Components Between Channels 

This dialog is displayed when the Between Channels… command is chosen from the Copy 
Components submenu of the Actions menu within the Method Editor. 

Set the following in this dialog: 

Control Description 

Copy from channel Use the drop-down list to set the source of the components to 
be copied. All data channels n the method that have 
components defined. 

Copy to channel Use the checkbox list to set the data channel(s) the 
components are copied to. The list displays all data channels 
in the method except the Copy from channel. This list 
contains nothing until the Copy from channel is selected. The 
list is then populated will all other data channels from the 
method. You can copy the component to more than one 
channel by selecting the required channels within this control. 

Copy these 
components 

Use the drop-down list (select All, All but internal 
standards, Internal standards only) to set which 
components are copied.  

Include integration 
events 

A check box (Yes or No) to set the integration events from 
the source channel should also be copied to the destination 
channel. 

Include calibration 
standards 

A check box (Yes or No) to copy the calibration standard 
amounts with the other component information. 

Clicking the OK button copies the components from the source channel to the destination 
channel. In general, the copied components are merged with the existing components and 
does not replace them. However, if a component with exactly the same retention time exists 
in the destination channel then that component will not be copied. 
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Calibration Parameters 

The Calibration View is used for viewing and interpreting calibration curves generated from 
the measurement of your standard solutions. The Calibration View allows you to evaluate the 
quality of the calibration by viewing both the graphic plot of the calibration points and by 
reviewing statistical information on the curve fit. You can also evaluate the effect of 
eliminating individual calibration points or replicates and changing the origin treatment.   

In the calibration graphs the results from each replicate injection is plotted and not the 
average. This also means that the ability to exclude a calibration point will mean exclusion of 
a single replicate and not an entire level. You are able to select whether each replicate is 
included in the calibration curve using the In Use checkbox displayed for each replicate. 

The Calibration section contains two sections Setup Standards and Channels View (which 
contains the Summary, and Details tabs).  

The Set Up Standards screen is designed to provide an easy approach to creating 
standards and entering standard amounts for all components. 

The Summary tab shows thumbnails displays of the curves for all components/species; for 
all detector devices or a single device, depending on the method tree selection. 

The Detail tab shows details of the calibration for a selected component. Double-clicking on 
a curve on the Summary tab will cause the Detail tab to be displayed with that component 
selected. 

Set Up Standards 

The Set Up Standards screen is designed to provide an easy approach to creating standards 
and entering standard amounts for all components. 

Setup Standards has a top level entry for the Standard Name followed by a table display 
containing a row for each Component defined in the method. The displayed component list 
will always be the same as the component list in the Peaks section and the Calibration-Detail 
section. Unlike the Details view, the new Standards view does not have sub-bands for the 
calibration standard levels but instead has a column for each level. 

 

Since the entry of values in these columns is the primary reason for having this view, these 
are the first columns shown following the Component name column. Additional columns for 
new Standards can be added. A column for Units is to accommodate the Units Dictionary 
function. 
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Any edits made on this tab will be immediately reflected in the other calibration tabs. You 
can reorder the columns by using drag-and-drop. 

Summary Tab 

The Summary tab shows thumbnails displays of the curves for all components/species; for 
all detector devices or a single device, depending on the method tree selection. 

  

NOTE: This example is for a pure LC instrument; for an ICP-MS instrument Analyte Name are used 
in place of Channel Name. 
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Detail Tab 

Calibration Parameters provides an overview of calibration. 

The Detail tab shows details of the calibration for a selected component. Double-clicking on 
a curve in the Summary tab displays the Detail tab with that component selected. 

 

The above example of an LC Application shows the channel name used as the identifier (as 
opposed to the Analyte name for the LC/ICP-MS application). The whole structure shown 
above is repeated for each active channel that includes calibration. You can reposition 
columns in the display using drag-and-drop. 

 Identification Description 

Device Displays the name of the device 

Channel Name Enter an identifier for the data channel in the Channels, Peak 
Detection, and Calibration sections of the method. 

Outlier Limit (%) Set the maximum permitted deviation between replicate 
calibration results. The range is 0.0 to 10000.00 

Components List - One row  per component 

Component Description 

Component 
(Species for ICP-MS) 

Enter a component (species) name (from 1 to 50 characters), 
select an existing name from the list, or select a name from 
the component dictionary via the drop-down list. 

Calibration Type Select from the drop-down list the type of calibration curve 
used (Average Calibration Factor and Linear). 
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Calibration Reference Select from the drop-down list the component (or None) to 
reference. 

  Origin Treatment Select from the drop-down list whether or not the origin is 
considered when fitting the calibration curve (Ignore, Include, 
or Force). 

Quantify Using Options Select from the drop-down list the response mode (Area or 
Height) used for quantitation for the component. 

Scaling Factor  Select from the drop-down list  (None, 1/X, 1/(X*X), log(X), 
1/log(X)) to set the type of scaling to be applied to the plotted 
amounts. 

Weighting Factor  Select from the drop-down list (None, 1/X, 1/Y, 1/(X*X), 
1/(Y*Y)) to set the weighting to be applied to the calibration 
points.  

Y-Intercept Displays the y-intercept value from the curve fit.  

Slope (X) Displays the slope (Linear) or x coefficient from the curve fit. 

r-squared Displays the r² value, reflecting the goodness of fit of the 
calibration equation to the standard sample results. 

 

NOTE:  If the calibration type is Average Response Factor then the ONLY fields in this band are 
the component name, the calibration type, and the average response factor value. 

Standards List - One row  per calibration level 

Standards Description 

Standard Name Enter the name of the standard level. 

Amount Set the amount (0.000000 to 999,999.999999) of the current 
component in the current standard. 

Units An display of the units of the previous field. The units are set 
on the Setup Standards tab. 

Avg Area Displays the average area from the individual replicate 
injections. 

Avg Height Displays the average height from the individual replicate 
injections. 

In Use  A check box to indicate whether the standard level is included 
in the calibration curve. 

Avg Area/Ht Ratio Displays the average area/height ratio from the individual 
replicate injections. 
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Replicates Data - One row  per injection of the standard 

Replicates Description 

Injection Number A counter field indicating the replicate number. 

Area Displays the peak area from the standard injection. 

Height Displays the peak area from the standard injection. 

Area/Ht Ratio Displays the peak area/height ratio average area/height ratio 
from the standard injection. 

In Use A check box to indicate whether the replicate data is included in 
the calibration curve. 

Int Std In Use A check box to indicate whether the internal standard is 
included in the calibration curve. 

How  to Perform a Calibration 

The following steps provide an overview on how to perform a calibration. 

1. Make calibration standards, usually consisting of a blank and 2-5 standards covering 
the expected concentration range of species in the samples. 

2. Place the calibration standards in the LC autosampler. 

3. Create a Method and define the species and calibration standards in the Method. 

4. Create a Sequence and define the calibration standards in each line of the 
Sequence in the Sample Type column.   

a. For a calibration blank, the appropriate Sample Type is Blank (pt by pt). 
b. For a calibration standard, the appropriate Sample Type in Standard. 

5. In the Sample Name column of the Sequence, type a unique sample name for the 
calibration standards. 

6. In the Vial column of the Sequence, define the autosampler locations of the 
calibration standards. 

7. In the Method column of the Sequence, select the appropriate Method (where the 
calibration standard amounts were defined). 

8. In the Standard column of the Sequence, select which calibration standard in the 
method corresponds to the calibration standard in that row.   
 
For example, if in the Method, 10 µg/L was defined as Standard 2, select “Standard 
2” from the drop-down menu in the Standard column of the line defining the 10 µg/L 
standard in the Sequence.  (Note:  the entries in the Standard column are linked to 
the method specified in the Method column). 

9. In the Injections column of the Sequence, define how many times each sample 
should be run (i.e., the number of times it is injected).   
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NOTE:  If more than 1 injection is performed, the average of the injections will be reported. 

10. After the last Sample Type calibration standard in the Sequence, define a Calibration 

Review decision point (clicking on the  next to the last Standard and selecting 
Calibration Review under Decision Point Type.) 

11. Save the Sequence (from the File menu > Save Sequence). 

12. Start the Sequence (from the Control Panel > Start Sequence). 

13. When the Species Calibration review window appears, review and make any 
necessary changes.  When the calibration appears as desired, click the Close button 
to continue the sequence.  
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Reporting Parameters 

Plot Parameters 

These settings define the chromatogram image file(s) that are to be generated from the 
channel data; for use in reports. 

P lot Main Band - multiple records can be created 

The plot parameters define the number and format of plots to be generated for each run on 
the identified channel. In addition to all plots defined on this tab, overlay plots consisting of 
all the plots defined for all channels are generated. 

 

Parameter Description 

Plot Title Enter a set of plot parameters (using up to 50 characters). 

Scaling Type Select from the drop-down list the scaling option (Autoscale, 
Auto Baseline, or Manual) to be applied to the plot.  

Y Units The units in which the Y-axis is to be plotted. The units are 
detector dependent. 

Y min Set the Y-axis minimum (in the units specified). This value 
must be less than Y max.   
NOTE: The minimum and maximum values for the plot are 
determined by the specific device. The allowed range is 
defined in the Device Descriptor (aka Instrument Descriptor) 
for each applicable supported device and will not be 
duplicated here. 

Y max Set the Y-axis maximum (in the units specified). This value 
must be greater than Y min. 
NOTE: The minimum and maximum values for the plot are 
determined by the specific device. The allowed range is 
defined in the Device Descriptor (aka Instrument Descriptor) 
for each applicable supported device and will not be 
duplicated here. 

Start Time (min) An edit field indicating the setting of the X-axis minimum. 
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End Time (min) An edit field indicating the setting of the X-axis maximum. 

Sample ID A check box indicating whether the Sample ID will appear on 
the printed plot. 

Baselines A check box indicating whether baselines are drawn in on the 
printed plot (using the user’s preferences for color and line 
type). 

P lot Annotations Band 

Band 2 Description 

RTs A check box indicating whether peak retention times will 
appear on the printed plot (using the user’s preferences for 
text properties). 

Peak Names A check box indicating whether peak names will appear on 
the printed plot (using the user’s preferences for text 
properties). 

Timed Events A check box indicating whether time event annotations 
(integration and instrument events) will appear on the 
printed plot (using the user’s preferences for text properties). 

Wavelengths A check box indicating whether wavelength changes will 
appear on the printed plot (using the user’s preferences for 
instrument event text properties). 

X Axis Label A check box indicating whether the X-axis label Time (min) 
will appear on the printed plot. 

Y Axis Label A check box indicating whether the Y-axis label (Response 
(mV) or Response (mAU), according to Y units setting) will 
appear on the printed plot. 

Other Device Channels Bands 

These bands are also associated with scaling of plot data - the subsidiary data channels that 
can be overlaid on chromatograms. The only applicable channels are pump pressure and 
oven temperature.  Below the Other Device Channels band there are bands for each 
applicable device. 

Pump Band Description 

Device Displays the user name for the pump. 

Pressure Units Displays the pressure units currently in effect for the pump. 

Pressure Plot Min Set the Y axis minimum to be used for the pressure plot. 
0 to 6100 psi;  0 to 420 bar;  0 to 42 MPa 

Pressure Plot Max Set the Y axis maximum to be used for the pressure plot. 
0 to 6100 psi; 0 to 420 bar;  0 to 42 MPa 
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Scaling Type 

The available options are: 

• Automatically scale the chromatogram to the height of the largest peak. 

• Scale both the X and Y axes to user-supplied values. 

• Scale the Y axis to a user-supplied full scale setting above an automatically 
determined baseline offset. 

• Allow the y axis to be scaled in any units applicable to the detector. 

Additional Scaling Parameters 

Y min Setting of the Y axis minimum 

Y max Setting of the Y axis maximum 

Start Time (min) Setting of the X axis minimum 

End Time (min) Setting of the X axis maximum 

Annotations 

Any combination of the following may be specified to appear on the plot: 

Sample identification The sample name from the sequence will appear at the top of the plot. 

Baselines The baselines (including drop lines and skim lines) are drawn in. 

Retention times Peak retention times are shown. 

Component names Names of identified peaks are displayed. 

Timed events Integration and instrument timed events are marked. 

Wavelength settings Changes of detector wavelength are marked. 

X-axis label The label Time (min) will appear on the X axis. 

Y-axis label The label for the units defined for the channel will appear on the Y axis. 
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Operation Parameters 

The PDA Operations functions and parameters in the Chromera method are all copied from 
the similarly named Operations views within the Spectral Processing window (SPW).  The 
Spectral Processing method is a container to hold these operations parameters developed 
and applied within the spectral processing window.  The Operations parameters are viewable 
from within the Chromera method but they are not editable.  They will only be editable from 
within the Spectral Processing window. 

Spectral Operations is channel based and each channel may have a different set of Spectral 
Operations controlling parameters.  In reality, all Spectral Operations are based on the use of 
spectra which, of course, are injection based not channel based.  Therefore results obtain 
from one channel will be identical to all other channels derived from the same spectral data. 

 

They are, Peak Purity, Absorbance Ratio, Wavelength Maximum, Spectral Standard 
Confirmation, Spectral Library Confirmation, Peak Library Search, Retention Time 
Adjustment, Apex Optimized Chromatogram, and Printing. 
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Method Operations - Peak Purity 

 
 
Parameter Description. 

Minimum Wavelength Displays the minimum wavelength to be used in the purity 
calculation. 

Maximum Wavelength Displays the maximum wavelength to be used in the purity 
calculation. 

Minimum Data Points  Displays the minimum number of data points that must be used 
for the result to be valid. 

Baseline Corrected 
Spectra 

A check box to use baseline corrected spectra for the calculations. 

Purity limit Displays the maximum limit for an acceptable match. 

Use at % of Peak 
Height 

Displays where on the peak the results are calculated. 

Auto Threshold A checkbox that specifies if the Absorbance Threshold used in the 
calculation is calculated automatically or manually. 

Absorbance Threshold Displays the minimum absorbance value to be used in the 
calculation when set manually. 

 

Operations - Absorbance Ratio 

 
 
Parameter Description. 

Wavelength A Displays the first wavelength to be used. 

Wavelength B Displays the second wavelength to be used. 
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Baseline Corrected 
Spectra 

A checkbox that uses the baseline corrected spectrum for the 
calculation. 

Auto Threshold A checkbox that specifies whether to set the minimum 
absorbance value used in the calculation automatically. 

Absorbance 
Threshold 

Displays the minimum absorbance value to be used in the 
calculation. 

Method Operations - Wavelength Maximum 

 
 
Parameter Description. 

Minimum Wavelength Specifies the minimum wavelength to be used. 

Maximum Wavelength Specifies the maximum wavelength to be used. 

Baseline Correct 
Spectra 

A checkbox to use baseline corrected spectra for the 
calculations. 

Auto threshold A checkbox that specifies if the Absorbance Threshold used in 
the calculation is calculated automatically or manually. 

Absorbance Threshold Displays the minimum absorbance value to be used in the 
calculation when set manually. 
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Operations - Spectral Standard Confirmation 

 
 
Parameter Description. 

Minimum Wavelength Displays the minimum wavelength to be used in the Spectral 
Standard Confirmation. 

Maximum Wavelength Displays the maximum wavelength to be used in the Spectral 
Standard Confirmation. 

Baseline Correct Spectra A checkbox to use baseline corrected spectra for the calculations. 

Minimum Data Points  Displays the minimum number of data points that must be used 
for the result to be valid. 

Pass Threshold Displays the maximum value set for a match. 

Sample Auto Threshold A checkbox that determines the Absorbance Threshold used in 
the calculation for the sample should be calculated automatically. 
If checked the minimum absorbance value used in the calculation 
is to be determined automatically. 

Sample Absorbance 
Threshold 

Displays the minimum absorbance value for the sample to be 
used in the calculation. 

Standard Auto 
Threshold 

A checkbox that determines the Absorbance Threshold used in 
the calculation for the standard should be calculated 
automatically. If check the minimum absorbance value used in 
the calculation is to be determined automatically. 

Standard Absorbance 
Threshold 

Displays the minimum absorbance value for the standard to be 
used in the calculation. 

Standard Chromatogram Displays the name of the method selected for use in acquiring 
and processing data in the sequence. The method is selected by 
clicking on the browse button following the field. 
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Method Operations - Spectral Library Confirmation 

 
 
Parameter Description. 

Minimum Wavelength Specifies the minimum wavelength to be used in the Spectral 
Library Confirmation. 

Maximum Wavelength Specifies the maximum wavelength to be used  in the Spectral 
Library Confirmation. 

Hit Distance Threshold Displays the maximum value for which the result is considered a 
pass. 

Baseline Correct 
Spectra 

A checkbox to use baseline corrected spectra for the calculations. 

Library List Click the drop-down button to display a card view that contains a 
check list of the available libraries to be matched against. 

 
Method Operations - Peak Library Search 

 
 
Parameter Description. 

Minimum Wavelength Specifies the minimum wavelength to be used in the Peak 
Library Search. 

Maximum Wavelength Specifies the maximum wavelength to be used in the Peak 
Library Search. 

Match Retention Time A checkbox that sets the retention time of the spectrum as 
one of the search criteria Will use the retention time of the 
spectrum as one of the search criteria 

Tolerance % Displays a window around the retention time of the spectrum 
using the percentage value as a plus and minus for the 
retention time match 
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Hit Distance Threshold Displays the maximum value for which the result is considered 
a pass. 

Baseline correct 
spectra 

A checkbox to use baseline corrected spectra for the 
calculations. 

Library List Click the drop-down button to display a card view that 
contains a check list of the available libraries to be matched 
against. 

Method Operations - Retention Time Adjustment 

 
 
Parameter Description. 
Minimum Wavelength Specifies the minimum wavelength to be used in the 

Retention Time Adjustment. 
Maximum Wavelength Specifies the maximum wavelength to be used in the 

Retention Time Adjustment. 
Hit Distance Threshold Displays the maximum value for which the result is 

considered a pass. 
Baseline Correct Spectra A checkbox to use baseline corrected spectra for the 

calculations. 
Library List The drop-down button displays a card view that contains a 

check list of the available libraries to be matched against. 

Method Operations - Apex Optimized Chromatogram 

This operation can be used to create an optimized version of the current chromatogram or to 
build an optimized method for future chromatograms.  The Apex Optimized Chromatogram 
operation yields parameters used in creating additional derived chromatograms using a 
wavelength program.  The results of this operation can be used to add a wavelength program to 
the derived channels section of the Chromera PDA method for the current chromatogram as well 
as creating a wavelength program in a PDA method for use with future chromatograms.  Multiple 
wavelength programs can exist in the PDA section of the method, each program being optimized 
for specific compounds being analyzed.   

In addition to the ability to create an optimized wavelength program for future use, the Apex 
Optimized Chromatogram operation within Spectral Processing Window is an automated process, 
containing a set of controlling parameters that allow an Apex Optimized Chromatogram to be 
created automatically during the running of a sequence.  (In this respect it is similar to the Base 
Ion Chromatogram function used in an LC Mass Spec.)  As with the other Spectral Processing 
Window operations, these parameters will need to be stored in the hidden Spectral Processing 
Window section of the Chromera method for recall during automated operation. 
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The wavelength program created by the Apex Optimized Chromatogram operation and 
passed to the Chromera PDA method consists of multiple bands each band contain the 
following parameters. 

Time - Analytical Wavelength - Analytical Bandwidth - Reference Wavelength - Reference 
Bandwidth 

This set of parameters is repeated for each wavelength changed required in the method. 

 
 
Parameter Description. 

Minimum Wavelength Displays the minimum wavelength to be used in the Peak 
Library Search. 

Maximum Wavelength Displays the maximum wavelength to be used in the Peak 
Library Search. 

Maximum Analytical 
Bandwidth 

Displays the maximum analytical bandwidth to be used. 

Reference Wavelength Displays the reference wavelength to be used. 

Reference Bandwidth Displays the reference bandwidth to be used. 

Absorbance Threshold Displays the minimum absorbance value to be used in the 
calculation. 

Baseline Corrected 
Spectra 

A checkbox to use baseline corrected spectra for the 
calculations. 

Auto Threshold A checkbox that specifies if the Absorbance Threshold used 
in the calculation is calculated automatically or manually. 

 



146 . Chromera User's Guide 

 

Editing a Method 

Method editing consists of modifying ex isting method parameters. This includes a 
modification to the method name, since in Chromera the name is a method parameter like 
any other (the method is uniquely identified by a database index that is not visible users). 
After making changes and saving the method, the previous version of the method is replaced 
by the modified version. Only a single version of a method is saved in the database. Also, a 
method cannot be saved with the same name as another method in the Group. 

To create a copy of an existing method but with a different name, leaving the original 
method unchanged, use the Save As command. 

Method Access 

A method in use (meaning it is on any row of a running sequence) in an online instance of 
Chromera cannot be edited and saved as the same method in any other instance of 
Chromera. Use of the Save As command to create a copy of the method will however be 
permitted. 

How  to Edit a Method 

To edit a method: 

1. Select the Method window and choose the Open Method command from the File 
menu. The Data Selector - Single Method dialog appears. 

 

2. Expand  the Method Group to see a list of the available methods. 

 

3. Click in the box in the Select column to select the method; then click Open. 

4. In the top level row of the method screen, modify the Method Name, a Description of 
the method and the name of the Group (virtual folder) where the method will be stored. 
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5. Click on Instruments in the Navigation pane.  

6. Click the Expand All button to open all devices to edit the parameters. 

 

7. For each device (instrument) enter or edit parameter settings as required. 

In a device (instrument) Advanced section, you can set the parameter values here so that 
they override the Preference values only for this method. 

8. Save the method by choosing the Save Method/Save Method As... command 
from the File menu. 

NOTE:  After making a change to the method you must save the method to retain the changes made. 

Online vs. Offline 

Within an Online instance of Chromera only methods configured for the associated instrument 
can be created. If you choose to open a method created for a different instrument the software 
offers to update it to the configuration of the current instrument. Updating is performed on a 
device type basis; that is, if the configured instrument has a device type that is not in the 
method, then a set of default parameters are provided for that device. Devices referenced in 
the method that are not present in the instrument configuration are eliminated from the 
method. No mapping of parameters from one device type to another is attempted. When a 
method is updated in this way, the Method/Save command will not be available (only Save 
As will), so that the original method is not destroyed. 

If you choose not to update the method to the configuration of the current instrument you 
can still view the method but it is recommended that you do not edit it in this situation. 

A different situation applies in Offline (Data Only) mode. In this case it is possible to 
generate a method for the associated instrument, any other configured instrument or for an 
arbitrary configuration defined by selecting items from the pool of supported devices. It is 
also possible to edit any method stored in the database, regardless of its instrument 
configuration, (provided it is not in use). Of course in Data Only mode the Run Time 
environment does not exist and hence no conflicts can arise. 

Extracting a Method from Results 

A copy of the full set of method parameters used to acquire and process the data are stored 
with each and every result data set (that is, the data collected and calculated from a single 
injection). This set of method parameters will often simply be a copy of the method specified 
on the sequence row defining the analysis but it may also be an edited version of a method 
resulting from graphic reprocessing. That is, the results may contain a method that never 
existed as an independent entity in the database. For this reason (and also because the 
result data set may have been imported so the method never existed on the system at all) it 
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is possible to extract a method from a result data set and save it as a new method in its own 
right. 

How  to Copy Components from TotalChrom 

This dialog displays when you select the From TotalChrom Method… command from the 
Copy Components submenu of the Actions menu within the Method Editor. 

Control Description 

Copy from 
TotalChrom method 

Displays the source of the components to be copied. The field is 
populated by selecting a file from a standard File Open dialog 
displayed when the browse button is clicked. 

 A browse button that displays files with .mth extension in a 
standard Windows File Open dialog, enabling you to select a 
TotalChrom method file. 

Copy to channel A checkbox list to set the data channel(s) the components will be 
copied to. The list is populated with all data channels from the 
method. You can copy the components to more than one channel 
by selecting the required channels within this control. 

Include integration 
events 

Check this box to copy the integration events from the TotalChrom 
method to the destination channel. 

Include calibration 
standards 

Check this box to copy the calibration standard amounts with the 
other component information. 

<component list>  A display listing the components found in the TotalChrom method, 
together with their retention times. 

 

NOTE:  The OK button is disabled until you select a TotalChrom method and at least one destination 
channel (as required). 

When the OK button is clicked the components from the TotalChrom method are copied to 
the destination channel(s). In general, the copied components are merged with the existing 
components and will not replace them. However, if a component with exactly the same 
retention time exists in the destination channel then that component will not be copied.  All 
components will be copied; any selection made in the component list has no impact on the 
component copied. 

How  to Copy Components Between Channels 

This dialog is displayed when the Between Channels… command is chosen from the Copy 
Components submenu of the Actions menu within the Method Editor. 
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Set the following in this dialog: 

Control Description 

Copy from channel Use the drop-down list to set the source of the components to 
be copied. All data channels n the method that have 
components defined. 

Copy to channel Use the checkbox list to set the data channel(s) the 
components are copied to. The list displays all data channels 
in the method except the Copy from channel. This list 
contains nothing until the Copy from channel is selected. The 
list is then populated will all other data channels from the 
method. You can copy the component to more than one 
channel by selecting the required channels within this control. 

Copy these 
components 

Use the drop-down list (select All, All but internal 
standards, Internal standards only) to set which 
components are copied.  

Include integration 
events 

A check box (Yes or No) to set the integration events from 
the source channel should also be copied to the destination 
channel. 

Include calibration 
standards 

A check box (Yes or No) to copy the calibration standard 
amounts with the other component information. 

Clicking the OK button copies the components from the source channel to the destination 
channel. In general, the copied components are merged with the existing components and 
does not replace them. However, if a component with exactly the same retention time exists 
in the destination channel then that component will not be copied. 

 Update Component Search Windows 

This dialog is displayed when the Update Search Windows… command is chosen from the 
Actions menu in the Method Editor. 
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Control Description 

Update these 
components 

Select from the drop-down list the scope of the changes to 
be made to the component search windows. The choices 
are: All Components, Internal Standards Only, 
Reference Peaks Only, or Selected Component Only 

<check list box> Select the components whose search windows are to be 
updated. Displayed are all components from the method, 
regardless of the channel. This is only enabled when 
Selected Component Only is selected in the Update 
these components drop-down list. 

Absolute window (± s) Enter a value to set the component search window size, in 
seconds. (The range is 0.0 to 999.9 s.) 

Relative window (± % of 
RT) 

Enter a value to set part of the component search window 
size, as a percentage of the expected retention time for the 
component. (The range is 0.0 to 500.0.) 

Clicking the OK button updates the search windows for all the specified components on the 
basis of the settings in the dialog. This update process can only produce search windows that 
are centered on the expected retention time of the component. For asymmetric search 
windows the user must enter values manually or define the window graphically. 

The search window values generated for each specified component are: 
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Graphic Method Editing (GME) 

Features of the graphic method editing environment include: 

• The same basic presentation of the method parameters as within the standard 
method editor. 

• All parameters in the method are available for editing within the graphic method 
editing mode. 

• The graphics are highly interactive (e.g., drag-and-drop of integration events, 
component search windows). 

• Reviewing the effect of the modified method on different raw data sets are quick and 
convenient. 

The main display area is divided into two frames, with the controls in the lower frame and a 
plot showing the selected chromatogram in the upper frame (this is also referred to as the 
chart). The tree control used to select the method section will be reduced in area to make 
room for a tree control showing the selected data set. This could be a single sample run, 
multiple samples or a complete batch.  

 

Interaction w ith the Spectral processing Window 

The selection of the channel for the template chromatogram is from the Method Tree rather 
than the Data Tree.  When you enter the Spectral Processing window from the Chromera 
GME environment, if no instance of the GME mode of the Spectral Processing window exists, 
it will be created, even if a GRE/Post-Run instance of the Spectral Processing window exists. 
(An existing, GRE, instance will not be terminated and will be accessible through either the 
GRE/Post-Run environment within Chromera.)   

When the Spectral Processing window is accessed from Graphic Method Edit within 
Chromera, the data tree passed is generated from the Batch, Sample, Injection nodes 
displayed within the current Chromera data tree combined with the channel data present in 
the current Chromera method tree.  The currently selected channel within Chromera will be 



152 . Chromera User's Guide 

 

passed to the Spectral Processing window together with the memory resident copy of stored 
version of the referenced method   (The memory resident copy of the method is used since 
you may have modified any parameters within the method before it is passed to the Spectral 
Processing window. In order to retain these earlier changes, the Spectral Processing window 
passes back any changed parameters to this memory resident version of the method). 
Operations within the Spectral Processing window will initially use the spectral operations 
parameters contained in this passed method.  These parameter values may be modify to 
optimize your results. 

Within one channel, you are able to move freely between spectral operations and the 
Spectral Processing window is responsible for updating Chromera with any changed results 
and/or method parameters. 

Since, in Graphic Method Edit, the displayed chromatogram is simply a template and not the 
object which is being modified, you are able to move freely between any chromatograms 
present in the data tree.  The Spectral Processing window is responsible for ensuring that 
Chromera is updated with any information required for maintaining any spectral annotations 
that may be being displayed in Chromera in the Graphic Method Edit environment. 

How  to Access Graphic Method Editing 

Graphic Method Editing can be accessed in either of two ways: 

• From within the Method Editor – by choosing the Edit Method Graphically from 
the Actions menu and then selecting a suitable data set to be used as the basis for 
graphic editing. 

• From within the Post Run environment – by choosing the Go to Graphic Method 
Editor command from the Actions menu. This switches context to the Method Editor 
and uses the data set from Post Run mode as the basis for graphic editing. 

In either case, the specified data set (or at least the currently selected injection) is immediately 
reprocessed with the current version of the method (that might be a modified version of the 
stored method if graphic editing was reached from the Method Editor). 

Main Menu Commands 

The menus in graphic editing mode are basically the same as in standard display mode, with 
some minor changes as described in the table below. 

Menu Command Description 

The following are inserted into the File menu. 

File Open Data… Replaces all existing data in the data tree with new 
data. 

Displays the data selector in multiple batch/samples' 
selection mode. When the user has selected one or 
more data sets, the data tree will be populated with 
those items and the first chromatogram in the data 
set will be selected, processed with the method and 
displayed. If unsaved data exist you are prompted if 
the current unsaved data should be saved prior to 
display of the data selector. 
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 Add Data… Adds new data sets to the end of the data tree. 

Displays the data selector in 'multiple batch/samples' 
selection mode. When the user has selected one or 
more data sets, the data will be added at the end of 
the data tree and the first newly added data set will 
be selected, processed with the method and 
displayed. 

Display Rescale Displays the Rescale Axes dialog. 

 Auto Rescale Redraws the contents of the active plot frame at 
default scaling. 

 Radar Window Toggles display of the radar window on and off. Radar 
Window is only enabled according to options set in 
Plot Options (not displayed/displayed in all single plot 
views/displayed in graphic edit only). 

 Plot Styles Displays the Plot Styles dialog. 

Actions The following is appended to the Actions menu in graphic editing mode: 

 Peak Integration 
Wizard 

Displays the Peak Integration Wizard dialog. 

 Reprocess Current 
Chromatogram 

Reprocesses the currently displayed chromatogram 
with the current (displayed) version of the method. 
This command is only used when automatic updating 
after each change to the method is disabled in 
preferences (see Preferences). 

 Show Results  Displays the Results window. 

 Signal to Noise 
Measurement 

Displays the Noise Measurement dialog so you can 
enter values to measure the signal to noise. 

 Edit Spectral 
Operation 
Graphically 

Displays the Spectral Processing window in the Peak 
Purity Spectral Operation view with the same 
chromatogram you were viewing in the Graphic 
Method Edit environment. This chromatogram 
contains the parameters taken from the Peak Purity 
parameters in the Operations section of thr 
corresponding method. 

This command is visible only if the user is in the 
Peaks or Operations section of the Method.  It 
will be hidden for all other method sections. 

Enabled only when a PDA channels is being displayed. 
Disable for all non-PDA channels. 
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 Current 
Chromatogram and 
Spectral 
Reprocessing 

Reprocesses the chromatogram and the spectra. 

Enabled only when a PDA channel is being displayed. 
Disabled for all non-PDA channels. 

 Component List 
using Spectral 
Library Search 
Matches 

Creates or extends the component list in a method 
using the results obtained from a Spectral Library 
Search. 

This will display the Spectral Processing window 
in the Peak Library Search Operation view, displaying 
the same chromatogram you were viewing in the 
Graphic Method Edit environment with the parameters 
taken from with the Peak Library Search parameters 
in the Operations section method being displayed in 
the Graphic Method Edit environment within 
Chromera. 

This command is visible only if you are in the 
Peaks section of the Method.  It will be hidden for 
all other method sections. 

Enabled only when a PDA channels is being displayed. 
Disabled for all non-PDA channels. 

 Create Channel 
definition from 
Spectral Data 

Displays the Spectral Processing window in the Preview 
Chromatograms view with the same chromatogram you 
were viewing in the Graphic Method Edit 
environment.  The channel definition of the displayed 
channel is shown in the top section of the view.  The 
last, user specified channel definition is used for the 
default preview channel.   

This command is visible only if you are in the 
Channels section of the Method. Hidden for all 
other sections. 

Enabled only when a PDA channels is being displayed. 
Disabled for all non-PDA channels. 
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 Edit Spectral 
Operation 
Graphically 

Displays the Peak Purity Spectral Operation mode with 
the same chromatogram you were viewing in the 
Graphic Method Edit environment with the parameters 
taken from with the method being displayed in the 
Graphic Method Edit environment within Chromera. 

A new GME instance is created through this command.  

If Spectral Processing is already open in GME mode, 
the new Data is passed on to the open instance of 
Spectral Processing. 

This command is visible ONLY when the Method 
Tree contains visible PDA nodes. 

Since this command is intended to examine the spectra 
of the chromatogram you are currently viewing this 
command will be enabled only if a PDA chromatogram 
is currently being display in the chart region. 

If execution of the command fails to launch Spectral 
Processing, error dialogue is displayed and an entry is 
made into the Error Log. 

NOTE: The display menu is restricted in Graphic Method Editing. 

The following item exhibits a change in behavior in graphic edit mode. 

Open Data…         If unsaved data exist you are prompted if the current unsaved data 
should be saved prior to display of the data selector. 

Graphic Method Editing Standard Toolbar 

This toolbar adds two buttons for Action menu items (Optimize Peak Detection and 
Reprocess Current Chromatogram) to those available in the standard Method Editor. 

 

Or when user authentication is active: 

 
 

Icon Command 

 File/New Method 

 File/Open Method 

 File/Save Method 

 File/Save Method As 

 File/Print Preview Method 



156 . Chromera User's Guide 

 

 File/Print Method 

 File/Lock (Only when user authentication 
active) 

 File/Exit 

 Actions/Standard Method Editor 

 Actions/Edit Method Graphically 

 
Actions/Edit Spectral Operation Graphically 

 
Actions/Create Channel definition from 
Spectral Data 

 Actions/Reprocess Current Chromatogram 

 Help/Topics 

Method Tree 

The form of this tree in the navigation pane is unchanged from that in the standard method 
editor (other than the reduced space it occupies). 

 

The currently selected node is indicated even when the control does not have focus. During 
graphic editing the method tree affects the display in the plot frame and results tab, in 
addition to the method parameters display (see Interactions between Controls for details). 

Data Tree 

The form of this tree is the same that displays in the Post Run environment but it has a 
somewhat different behavior.  Graphic Method Editor always displays one chromatogram and 
the chromatogram node selected in the data tree is always checked and displayed. The check 
boxes are effectively superfluous. 
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Synchronization w ith the Spectral Processing Window  Data Tree  

1. The data tree in the Spectral Processing window shows the Batch, Sample, and 
Injection of the Chromera Data Tree and the channels, from the method section in 
Chromera.   

2. If you select a channel from anywhere in the Chromera method it will be displayed in 
the graphic plot in Chromera and the same channel will be selected in the Spectral 
Processing window data tree and displayed in the client region of the Spectral 
Processing window. 

3. When a channel is selected from the Method section, the corresponding 
chromatogram is displayed in the graphic pane in Chromera. The corresponding data 
tree is also passed to the Spectral Processing window which then displays the 
appropriate chromatogram in the graphic pane of the Spectral Processing window.   

4. If you delete a channel from the Method Section in Chromera, the corresponding 
channels in the Data Tree in the Spectral Processing window will be deleted.  

5. If the deleted channel was being displayed in the Spectral Processing window the 
plot will also be cleared. 

 

Chromatogram Control 

Annotations on the chromatogram are determined by the Plot Styles settings. The plot 
exhibits the full range of interactive behavior described in Plot Control. 

In graphic editing only one chromatogram is displayed at a time. That is, a single plot control 
(no stack) and no overlaid chromatograms. This is to make it clear as to which 
chromatogram the integration and component settings apply to. 
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When a sample injection includes data from multiple channels, the chromatogram displayed 
depends on the current selection in the method tree. 

Component Search Window Tool 

This is a graphic element that enables you to set the expected retention time and the search 
window for a component. The tool initially appears (assuming that Component Search 
Windows are selected as displayed Annotations) when you click on the chart to indicate the 
peak to be identified as the component. The selected form of the tool is similar to the 
Bunching Factor tool but it has an additional triangle marker indicating the expected 
retention time of the component within the search window. You can drag this central triangle 
to a new position within the search window, as well as repositioning the whole tool and 
resizing the tool. Whenever you make a change to the position or size of any element of the 
tool, the Retention Time, Peak Search Start and Peak Search End fields will be updated in the 
parameters grid of the selected channel. 

 

When the mouse pointer is positioned over any of the triangular handles the cursor changes 
to  , indicating that the width of the object can be changed and the central marker can be 
moved. 

When multiple component tools are displayed, the single selected component is indicated by 
its different form as well its different color. The colors used for the body of the tool in the 
case of selected and non-selected components are user-selectable within Plot Options. The 
handles for resizing the gadget are always black. 
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Method Parameters 

The contents of the method parameter display are determined by the current setting in the 
method tree, in exactly the same way as in the standard method editor. The contents of the 
Method parameter display can be edited in the usual way. Certain parameters can also be 
edited interactively as described elsewhere in Graphic Method Editing. 

Results Window 

The Results window displays when you select the Show Results command from the 
Actions menu. The Results window displays in an Always on top mode. 

 

The results displayed are those from the sample injection associated with the currently 
displayed chromatogram. However, the data from all channels will be displayed, rather than 
just the displayed channel, so that you can make comparisons if necessary. 

The results are updated when you reprocess the chromatogram or when a different 
chromatogram (injection) is selected. If the selected chromatogram has not been processed 
and has no results, then a blank display is shown (rather than leaving the results for the last 
chromatogram displayed).  

Results W indow  Popup Menu 

The area within the Results window has the same popup menu as in the Results area within 
the Post Run Environment. In general the behavior of the commands are the same as in Post 
run but with one significant exception: The Save to Spreadsheet commands will save only 
the results for the displayed injection and not the whole batch. 
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How to Develop a New  Method 

Develop a New  Method 

The basic principle of this environment is that the annotations on the currently displayed 
chromatogram always reflect the results of the processing of that chromatogram by the 
currently displayed method. 

The following procedure describes the steps that would typically be performed when 
developing a method to process an acquired chromatogram or set of chromatograms. This 
example assumes that you are starting with a completely new method, or at least a method 
in which no entries have been made within the Peaks or Calibration section, and that the 
method is open in the Method environment. 

1. Choose Edit Method Graphically from the Actions menu or click the  toolbar 
button. 

2. Select one or more sample data sets from the Data Selector. For the purposes of 
this workflow it is assumed that the channels in the data sets correctly match the 
channels defined in the method. The consequences when this is not the case will be 
discussed later. 
By default, the chromatogram from the first injection of the first sample opened will 
be selected in the data tree but which channel is displayed depends on the current 
selected in the method tree. If a channel-specific section is selected (e.g. 
Peaks/Chan A), then the chromatogram from that channel will be displayed in the 
graphics frame. If the method tree selection does not define a specific channel then 
the chromatogram from the first data channel will be displayed. 

3. The display in the frame remains unchanged up to this point and simply reflects the 
current selection in the method tree, in the usual way. 

4. The displayed chromatogram is processed with the method as it exists, regardless of 
the current selection in the method tree and which section of the method is 
displayed. Because the method contains no values for Bunching Factor, Area 
Threshold, or Noise Threshold (as stated at the beginning of this workflow), the 
software automatically determines suitable values for these parameters (by assessing 
the intrinsic signal noise) as the first stage of processing. These values will be 
assigned to the appropriate fields in the Peaks section for the selected channel, even 
if that section is not currently visible.  

5. Annotations on the chromatogram are updated based on the processing results and 
the current on/off settings for annotations. 

6. At this point the most likely course of action is to select the Peaks node in the 
method tree (assuming it, or a child node, is not already selected). The display 
displays the Peaks section for all channels. If you select the specific channel node 
associated with the displayed chromatogram then only the parameters for that 
channel will appear. If you select a different channel within the Peaks section then 
the chromatogram for that channel is displayed in the graphics frame, it will be 
processed (i.e. return to step 5) and its parameters (only) will be displayed. 

7. The situation where the Peaks node is selected and parameters for all channels are 
displayed, while a single chromatogram is displayed in the graphics frame, will not 
persist for long. As soon as you click on a field within the display, the channel 
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associated with that field becomes the selected channel and all elements of the 
window will update to reflect that. That is, the method tree shows that channel 
selected under the Peaks node, the data tree will show that channel selected and the 
graphics frame will display the chromatogram from that channel. Also, the display 
updates to show only the parameters from the selected channel. This same basic 
procedure occurs when you select the Channels or Calibration node, and 
subsequently selects a channel-specific parameter.  

NOTE:  You are not prevented from selecting these top-level nodes, since that would seriously 
violate behavior that is normal in the standard method editing mode. 

8. After selecting the Peaks section for a specific channel, you can examine the 
chromatogram integration and decide if the Bunching Factor and Threshold values 
determined by the software are satisfactory. If they are not you can update them. 

9. Define components and map them to detected peaks. 

10. Select a different data channel within the method tree then that chromatogram will 
be displayed and processed as described above. If BF, AT and NT values do not 
currently exist in the Peaks section of the method for the newly selected channel 
they will be calculated as described in step #5 above.  

11. Select a different chromatogram within the data tree then that chromatogram will be 
displayed and processed (using the currently displayed version of the method) as 
described above. 

Updating Bunching Factor, Area Threshold, and Noise Threshold Values 

The following procedure can be used to update these parameters. 

1. Select the Bunching Factor field in the method parameter area for the selected 
channel. This causes the prompt below the parameter band to be displayed. 

2. Scale the chromatogram as required to zoom in on a peak of interest. 

3. Hold down the Control key and draw a box around the base of the peak of interest. 
As you release the mouse button a new BF value is calculated (and shown in the 
parameter display field) based on the size of the drawn box. The Bunching Factor 
field remains selected. 

4. Repeat steps 2 and 3 until a satisfactory value has been obtained. 

5. Select either the Area Threshold or the Noise Threshold field. The Thresholds prompt 
displays below the parameter band. 

6. Scale the chromatogram as required to zoom in on a section of baseline. 

7. Hold down the Control key and draw a box encompassing the required section of 
baseline. As you release the mouse button, new Area and Noise Threshold is 
calculated based on the signal characteristics in the defined time region. 

8. Repeat steps 6 and 7 until satisfactory values have been obtained. 
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Adding a Component 

To define a new component in the selected data channel: 

1. Select the Name field in the New Component row within the Peaks section of the 
method for the selected channel. A name for the component can be defined either 
by selecting an existing value from the component dictionary contained in the drop-
down list, or by typing in a new name (which will then be added to the dictionary). 

2. When a name has been defined, the retention time field will be automatically 
selected in the grid and the mouse pointer on the chart will change to an upward 
pointing arrow, indicating that the expected retention time of the component can be 
set by clicking on the chart. 

3. Click on the chart (it will not matter whether or not you hold down the Ctrl key) to 
enter a value into the RT field for the component and the search window sets to 
default size (defined by Start and End values entered into the appropriate fields in 
the display. The value set for the RT depends on where you click and on the current 
state of the chromatogram. If the chromatogram is integrated and you click within a 
peak envelope (between start and end times) then the calculated crest of that peak 
(based on curve fit, where applicable) will be entered as the component expected 
RT. If any other conditions apply then the time at which you clicked on the chart will 
be entered as the component expected RT. 

4. The component search window tool displays on the chart as soon as you define the 
component RT and the default search window start and end times have been 
calculated.  

5. After clicking on the chart to define the component RT, the chart cursor reverts to 
the standard mouse pointer and the chart is once again in zooming mode. 

6. Adjust the size of the component search window as required by drag-and-drop using 
the start and end handles of the component search window gadget. Updated values 
for these times will be entered into the grid upon each drop. 

Adding/ Deleting Channels 

You have the ability to view a modified or new channel in the Chromatogram pane when it is 
added to the Channel section of the Method.  In addition the new or modified channel and 
will be added to the Method Tree. 

Adding Channels 

Behavior within Chromera 

The basic behavior of adding a channel in GME is the same as in the Standard Method 
Edit.  If a PDA injection has been associated with a method in GME, then, when that new 
channel is selected in the data tree, the new channel will be extracted from the spectral data, 
displayed in the graphic pane and processed.    

Behavior within the Spectral Processing window 

Adding a channel within the Chromera method while in GME with the Spectral Processing 
window currently running will update the Spectral Processing window data tree and the 
added channel will be added to every injection within the Spectral Processing window data 
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tree.  The new chromatogram will be displayed in the Spectral Processing window when 
selected in the method tree within Chromera. 

Adding a channel to a method in Chromera from the Spectral Processing window 

Channels may also be added to the channels section of the Chromera method while in GME 
from the Preview Chromatograms operation within the Spectral Processing window  

If you transfer the Previewed Channel to the Chromera method, it will be added to the 
Chromera Method section in exactly the same manner as if added manually from within 
Chromera.  The channel added to Chromera will then be added to the Spectral Processing 
window data tree. 

If the channel name is already present in Chromera then the channel name will auto-
incremented. 

Deleting Channels 

Behavior within Chromera 

The behavior is the same as in the Standard Method Edit, the only difference being that the 
channel will also be deleted from the Spectral Processing window.   

Behavior within the Spectral Processing window. 

The data tree within the Spectral Processing window, which consists of the Batch, Sample, 
Injections nodes from the selected batch or batches with Chromera concatenated with the 
channels nodes from the current version of the open method will be update and the deleted 
channel deleted from every injection within the Spectral Processing window data tree. 

Adding an Integration Event 

To define a new integration event in the selected data channel. 

1. Select the required timed event from the Type drop-down list in the new event row 
within the Peaks section of the method for the selected channel, or click the required 
event button within the integration event toolbar (if applicable). 

2. If the event type requires a single time entry, the mouse pointer on the chart will change 
to an upward pointing arrow, indicating that the time of the event can be set by clicking 
on the chart. If the event requires start and end times then the mouse pointer will 
change to crosshairs, to indicate that the times can be set by drawing a box.  

3. Click or drag on the chart and the event annotation(s) appear on the chart at the 
designated time(s). 

4. The event start time is displayed in the display (as well as the end time where this is 
applicable). 

5. After clicking (or dragging) on the chart to define the event time (or times), the chart 
cursor reverts to the standard mouse pointer and the chart is once again in zooming 
mode. 

6. If the event type requires a value you can enter this in the Value cell of the row. 
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7. Once the event is complete the chromatogram will be reprocessed and the chart will 
be redisplayed to show the new integration. 

Interactive Field Prompts 

When a field that can be set interactively is selected a prompt displays below that line. There 
are three basic cases. 

NOTE: These prompts only appear in the GME mode and not in standard Method editor mode (when 
no chart is displayed). 

Integration Parameters 

When the Bunching Factor, Area Threshold, or Noise Threshold field is selected a prompt 
displays. 

 
 
Field selected Prompt 

Bunching Factor 
selected 

To set the Bunching Factor, hold down the Ctrl key and draw a box around 
the narrowest peak on the plot. 

Area Threshold or 
Noise Threshold 

To set the Area and Noise Thresholds, hold down the Ctrl key and draw a 
box around a region of baseline on the plot. 

 

 Component Parameters 

The prompt displayed for a component row depends on the state of the row; for example, 
when the Retention Time field is selected during component addition.  

 
 
State Field Selected Prompt 

Adding New 
Component 

Retention Time Type a value or click a peak in the curve to set the 
Retention Time and Search Window. 

Editing 
Component 

Retention Time  Type a value or move the component marker to 
modify the Retention Time. 

Any Peak Search Start Type a value or resize the component marker to 
adjust the Peak Search Start time. 

Any  Peak Search End Type a value or resize the component marker to 
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adjust the Peak Search End time. 

Integration Events    

As in the case of components, the prompts associated with integration events are different 
depending on whether the event is being added or edited. In this case the type of event 
being added also affects the prompt displayed. The prompt are displayed in the usual 
location, when a time field is selected. 

 

Events which require a single time value 

State Field Selected Prompt 

Adding New 
Event 

Start Time Hold down the Ctrl key and select a point on the 
curve to set the event time. 

Editing Event Start Time Type a value or move the event annotation to modify 
the time. 

 
Events which require start and end time values 

State Field Selected Prompt 

Adding New 
Event  

Start Time or End 
Time 

Hold down the Ctrl key and draw a box on the plot to 
set the Start and End times for the event. 

Editing Event  Start Time or End 
time  

Type a value or move the event annotation to modify 
the time. 

Action w ith Mismatched Channel 

The purpose of Graphic Method Editor is to optimize a method for acquisition or processing 
using one or more example files of data acquired from the same instrument. The normal 
situation will be that the channels defined in the method match (in name and data type) 
those that exist in the data set. However, since it cannot be guaranteed that the user will 
always make an appropriate selection of data, the consequences of mismatched channels 
must be defined. There may also be legitimate cases where the method has more channels 
defined than exist in the data set, or vice versa. 

The data channel in the method must be of the same type (i.e. the same basic detector type) 
and have the same name as a channel in the sample data set in order to be edited 
graphically. In this context, all ICP-MS models are of the “same detector type” and the 
standard and “HS” models of the Series 200 UV/Visible detector are also of the “same 
detector type.”  

Two basic mismatch cases exist: 

1. The method includes a channel for which no matching channel exists in the data set. 
In this case, whenever that channel is selected in the method (i.e. from the method 
tree or by selection in the grid frame), the chart will be blanked. 
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2. The data set includes a channel for which no matching channel exists in the method. 
In this case, whenever a chromatogram from that channel is selected in the data 
tree, the grid frame will be blanked. 

Peak Integration Wizard 

The Peak Integration Wizard provides an easy way to set the bunching factor and area and 
noise thresholds for your method.   

NOTE: You cannot enter values in the Wizard. They are calculated when you perform the described 
action. 

The Peak Integration Wizard appears within the Graphic Method Editor. Since it is a 
wizard the instructions are included on every screen.  

NOTE: Care must be taken in the use of this wizard to assure that you select the appropriate regions 
of the chromatogram for evaluation. The functions for setting the Bunching Factor, Noise 
Threshold, and Area Threshold for a chromatogram are exactly the same as those accessible 
from the Menus and Toolbar in Graphic Method Edit and in Post Run. Suggested values for 
these parameters are calculated upon the specific baseline noise and peak width selections 
made by the user.  The primary purpose of this wizard is to facilitate the process of setting 
these values, rather than to make those determinations automatically for you using the 
current chromatogram. 

How  to use the Peak Integration Wizard 

1. Select Peak Integration Wizard from the Actions menu. 

 

2. On the initial screen the Calculated Bunching Factor field will be blank until you 
draw a box on the plot to indicate the peak width at base of the peak for which the 
bunching factor should be calculated.  
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This is intended to be the narrowest peak that is desired to be integrated. You do 
not need to select the entire peak because only the starting and ending times of the 
region selected will be used. However, the appropriate width for this peak is critical 
for the calculation, because drawing the box too wide or too narrow may result in 
the suggested Bunching Factor being too high or too low. And if the sampling rate is 
too slow for adequate integration of the peak initially, adjusting the Bunching Factor 
will have little or no effect. 

The chromatogram will be reprocessed (using the updated Bunching Factor value) each time 
you make a new selection for the width of the narrowest peak. The Calculated Bunching 
Factor is shown highlighted to indicate that it is the value used for the current integration 
display. 
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NOTE:  You cannot directly edit any of the fields in the Wizard. You can affect what is displayed in 
the Calculated Bunching Factor field by outlining a peak width on the plot but cannot enter 
numbers directly, here or elsewhere. 

3. When you click the Next button the next page of the Wizard will be displayed, 
enabling you to set optimum initial Area and Noise Threshold values.  

 
The Calculated Thresholds fields will be blank until you draw a box on the plot to 
indicate the region of baseline to be used for Noise and Area Threshold calculation. 
The height of the box drawn is not important. Only the data between the starting and 
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ending times of the region selected will be used. However, the selection must be made 
carefully to ensure that only data considered by the user to be noise is included in the 
calculation. If true peaks are included in this region, then the determination of Noise 
and Area Thresholds may be erroneous, and improper integration of peaks may result. 
The chromatogram will be reprocessed (using the updated parameters) each time a new 
selection for noise determination is made, and the calculated values will be displayed in 
the appropriate read-only fields. The calculated fields are now highlighted to 
indicate that these are the values employed for the displayed integration: 

 

4. When you click the Next button the software will determine if the Bunching Factor 
(BF) should be increased by a the application of a BF Timed Event later in the 
chromatogram, for peaks that are at least double in width compared to the peak 
used for the initial determination. The procedure for this is described at the end of 
this document (see Determination of Bunching Factor Timed Events).  
If the software determines a Bunching Factor event should be added the following 
screen will be displayed: 
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  NOTE: This screen will not appear if no BF events are found to be necessary. 

If you click the Add Event button the event will be added and the chromatogram will be 
reprocessed to show the updated integration. 

If the software determines another BF update is required later in the chromatogram 
(because of another doubling of peak width), the above screen will be redisplayed but with 
the appropriate time and bunching factor values added. The table will also display the BF 
event added previously. 

When you determine that no further BF events are required, the following summary screen is 
displayed, listing all the events added. 



Method.  171 

 

 

NOTE:  As with the other fields in the Wizard, the timed events list is not directly editable by a user. 

5. Having reviewed the events and the integration, you can click Next and proceed to 
the next stage. Alternatively, you could click Back, to repeat the timed event process 
from the beginning (i.e. with no timed events in the list). This is a way for you to 
undo the entry of the timed events if so desired. 

6. When you click Next, the final review screen will be displayed: 
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Initially the calculated parameter values will be highlighted and the chromatogram display 
will reflect the integration produced from those values. 

If you click the Keep original method values radio button, then the original parameter fields 
will be highlighted and the chromatogram will be reprocessed with the original conditions. In 
this way you can compare the two sets of parameters before deciding on which set to use in 
the method.  

 

7. When you click Finish, the selected set of parameters will be entered into the Peaks 
section for that channel. Clicking Cancel will have the same effect as selecting the 
Keep current method values option. 

Determination of Bunching Factor Timed Events 

The input to this procedure will initially be the results derived from processing the 
chromatogram using the bunching factor and the area and noise thresholds accepted by the 
user in the first two screens of the Wizard. These results include the suitability values 
(specifically the Peak Width @Base values) calculated for the detected peaks.  

8. For each detected peak the software will calculate: 
 

           Peak Width @Base / Width of current bunch 

                  where:  width of current bunch = Current BF in effect / Sampling Rate 

9. If the calculated value is greater than 60 then the software will propose adding a 
Bunching factor event just prior to the start of the peak (say peak start time – ½ 
Peak Width @Base), with a value equal to double the current Bunching Factor. 
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If you accept the events, then the chromatogram will be reprocessed with the revised 
conditions and the procedure will start again with the updated peak list – beginning at the 
peak following the peak that triggered the BF event. 

If you decline to add the event then no further action will take place; you must either 
proceed to the next step or cancel the whole process. 

Differences between GME and Post Run Versions 

Functionally the Wizard will operate in exactly the same manner in the two environments. 
The only differences will be in labeling, to clarify as to what is being modified. Specifically, 
the words “in method” will not appear in the Post Run version, since the actual method is not 
being modified. The term ‘Original’ is used throughout for the values in use when you 
entered the Wizard. The term ‘Current’ is restricted to the active Bunching Factor at various 
times during the run in the part of the Wizard where timed events are suggested. 
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Print Method/ Calibration and Print Preview  
Method/ Calibration 

Selecting the Print Method/Calibration or Print Preview Method/Calibration command 
from the File menu within the Method environment displays the Print Method dialog. It opens 
with the most recently used report template associated with the currently selected option (i.e. 
method or calibration – method by default when the dialog is opened). If no most recently used 
template exists for this user/instrument, then the field will be blank. In this latter case the 
Report to be generated: field will also be blank. The dialog allows you to define what 
sections of the method are printed, on which printer the report is printed, and report template 
to be used. If you select the Calibration report option the dialog changes. 
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Set the following in this dialog: 

Control Description 

Current Selection  Displays the name of the current method. 

Print: Method 
parameters  

Select to generate and print a standard method report listing 
the method parameters. 

Print: Calibration report  Select to generate and print a calibration report from the 
calibration data in the method, rather than a standard report 
listing the method parameters. 

Printer 
Click this browse button  to display the standard 
Windows Select Printer dialog and select a printer to be 
used to output the method report. 

Method/Calibration 
Report template  

To generate the method or calibration report, click this 
browse button  ,  to display the standard report template 
selection dialog. The templates available for selection are 
filtered, so that only templates appropriate to the currently 
selected option are shown.  

Method parameters selected: The method template most 
recently used by the current user on this instrument (within 
this dialog). 

Calibration report selected: The calibration report 
template most recently used by the current user on this 
instrument (within this dialog). 
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From Group: Displays the name of the Group the currently selected report 
template is assigned to. 

Report selections…  Clicking the plus sign next to Report Selections expands the 
dialog. This control is hidden when the Calibration report 
option is selected. 

Instrument and 
Channel parameters 

A check box to include the Instrument and Channels section 
of the method in the printout. 

Peaks/Calibration 
information 

A check box to include the Peaks and Calibration sections of 
the method in the printout. 

Calibration standards A check box to include the list of standards and associated 
amounts for each component in the printout. 

Reporting Parameters A check box to include the Reporting section of the method 
in the printout. 

Report to be generated: When the report template field is populated, the software 
examines the template to determine its basic characteristics. 
This information about the selected template is displayed in 
the multi-line, Report to be generated: field. 
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Sequence 
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About the Sequence 

A Sequence is a list of samples to be run that is created prior to an analysis.  A sequence 
controls the acquisition and analysis of chromatographic data produced by a series of 
injections in Chromera.   Each row in the sequence contains, directly or by reference, all 
information relevant to the collection, processing and reporting of one sample. This includes: 

 

• Sample identification information (Sample name, description and type; plus 
standard name for a calibration sample) 

• The method to be used for instrument control, data acquisition, processing and 
quantitation. 

• The vial number, injection volume and number of injections to be made from the 
vial  

• The type of sample, which determines the nature of the processing and 
calculations to be performed on the sample data 

• Sample-specific values used in quantitation (such as sample amount, dilution 
factor, internal standard amounts) 

• Decision points, during the execution of the sequence, that enable the user to 
examine results and take appropriate actions. For each row it is possible to 
define a Decision Point Type, which is an action associated with the row. 
Examples of Decision points are as follows: 

• Peak Detection Review - Displays peak integration results for review and 
modification 

• Calibration Review - Displays calibration plot(s) and data for review 

• Data Review - Displays integrated chromatograms and results 

• Report - Sends results to the printer, screen or file 

• Shutdown - Only available with the Sample Type Wash 
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You can create a sequence in he following ways: 

• use the Sequence Wizard, to generate long sequences based on a fixed pattern of 
standard and samples quickly and easily. 

• build new sequence in the Sequence Editor 

• edit an existing sequence. 

• Import an existing Chromera sequence.  

 



182 . Chromera User's Guide 

 

Building a Sequence (About Sequence Parameters) 

When you build a sequence, you must specify a Sample Type from the provided drop-down 
list. Another key entry on each row of a sequence is the analysis Method. The default 
method is the method currently in the method editor, but you can specify a different method 
by clicking the button in that cell and choosing a method using the Open Method dialog.  

When an autosampler is in use the tray position to be sampled is indicated in the Vial 
number field. This number will automatically increment by one as rows are added to the 
sequence. You can also specify the number of times you want to inject a sample 
(Injections) from the Vial using the conditions of this sequence row. Each time you inject 
from the vial you will run through the conditions set in that row.  

For each row it is possible to define a Decision Point Type, which is an action associated 
with the row. Examples of Decision points are as follows: 

• Peak Detection Review - Displays peak integration results for review and 
modification 

• Calibration Review - Displays calibration plot(s) and data for review 

• Data Review - Allows review of the integrated chromatograms and results (without 
editing) 

• Report - Sends results to the printer, screen or file 

• Shutdown - Only available with the Sample Type Wash 

Any row can be removed from the sequence without affecting any other item. 

NOTE:  After making a change to the sequence you must save the sequence to retain the changes 
made. Only a single version of a sequence is saved in the database. When you make 
changes and select the Save command, the previous version of the sequence is replaced by 
the modified version. This includes a modification to the sequence name, since in Chromera 
the name is a sequence parameter like any other (the sequence is uniquely identified by a 
database index that is not visible to the user).  

To create a copy of an existing sequence but with a different name, leaving the original 
sequence unchanged, the Save As command is used.  

NOTE:  A sequence running in an online instance of Chromera cannot be edited and saved as the 
same sequence in any other instance of Chromera. Use of the Save As command to create a 
copy of the sequence will however be permitted. 
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Sequence Editor - Global Settings 

Global Settings can be set on a per sequence basis. In this way, if you have different 
reporting needs for different analyses you won’t have to edit preferences constantly or 
pretend to be someone else half the time. 

The Global Settings are displayed when the Global Settings view is selected in the 
Navigation pane. 

 

Per Sample Report Band - Up to 10 rows may be defined. 

Control Description 

Sample Type Select application-specific sample types from the drop-down 
list of application-specific sample types that control 
processing of the acquired data. 

LC Sample Types: Calib: Replace, Calib: Average, Sample, 
Matrix, Background, No Injection, Wash 

Speciation Sample Types: Blank, Standard Blank, Standard, 
CIS Blank, Reagent Blank, Sample, Wash 

Frequency Select the frequency as to when to generate the report for a 
row with multiple injections from the drop-down list.  The 
selections are Report per Sample and Report per Injection. 

Report Template A selection field to name the report template. Select the 
template from a database selector dialog by clicking on the 
button. 

Output Target Select from the drop-down list the way you want the report 
output.  The selections are File or Printer. 

File Type Select from the drop-down list the type of file to be created 
as output for a report. The selections are Adobe Acrobat 
(pdf) or Microsoft Excel (xls). 
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Output Name Target Type = File - the path where the report output files 
will be saved (under names constructed automatically from 
the sample name). Selected via a standard Browse for Folder 
dialog. 

Target Type = Printer - the name of the printer where the 
report is printed. Selected via a standard Print dialog. 

 

NOTES: (1) The Per Sample Report allows multiple rows rather than only two (per sample/per 
replicate). This provides more flexibility in the global general report definitions. (2) The 
term Report per Injection is used as an option for Frequency since this is more 
consistent with the use of the Injections field in the sequence itself. 

Sample Naming Template Band (at least one row  per sample type 
can be defined) 

Control Description 

Prefix Type (up to 25 characters) a prefix to define the beginning 
of each Sample Name for the added rows. The Sample 
Name consists of the Prefix, Number (incremented by one 
for each sample), and Suffix concatenated, without 
intervening spaces. 

Number Type the initial value of the incrementing number appearing 
in the Sample ID. The range is 0 to 9999 with as many digits 
as entered (e.g. 0000 is a valid entry). 

Suffix Type (up to 25 characters) a suffix to define the end of each 
Sample ID for the added rows. 

Vial Start Type the vial number for the first row. 

Vial Increment Type a number using values 1 to 9 to define how the vial 
number will change for each row added. 

Apply To Select from the drop-down list the Sample Type(s) the 
naming template is applied to. 

How  the Sample Naming Template Works 

NOTE:  The software will cease looking for matching rows within the Sample Naming Template rows 
as soon as one match is found. If you enter more than one row for any sample type only the 
first will ever be used. Similarly if you enter a row with Apply To set to All now rows 
following that will ever be used, since that is a match for all sample types. 

Adding a Row 

Selecting a Sample Type in the last row of the display causes the software to determine if a 
matching sample type exists in the global Sample Naming Template list type (note that all 
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sample types will match a row with Apply To set to All). If a match is found then the 
sample name defined by that template will be constructed, taking account of the current 
state of the Number count, and entered into the sample name cell – provided that cell is 
currently blank. Note that an automatically generated sample name will never overwrite an 
existing entry.  

If this is the first row of the specified sample type then the vial number field will be initialized 
as defined within the Sample Naming Template row. 

Adding Rows via Dialog 

Selecting a Sample Type in either the Add Rows or Insert Rows dialog causes the software 
to determine if a matching sample type exists in the global Sample Naming Template list 
type (note that all sample types will match a row with Apply To set to All). If a match is 
found then the fields in the dialog will be filled from the settings in the matching Sample 
Naming Template row. This action will only occur when you change the Sample Type 
setting in the dialog; the initial default of Sample does not cause the fields to be filled. 
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Sequence Editor - Sample List 

The Sample List parameters for the LC sequence editor or speciation sequence editor are 
described below. 

 
 

 

Identification (Band 1) 

Parameter Description 

Name Type the name associated with the sequence. A name must be 
entered before the sequence can be saved and name must be unique 
within the group specified below. Changing the name in this field does 
not create a new sequence it merely renames the existing one. 

Description Type a description of the sequence. 
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Group Assign the sequence to an existing group or to a new group. To use 
an existing group type the group name or select it from the drop-
down list. To create a new group and assign the sequence to it, 
simply type a group name that does not already exist. 

Author Displays the user name of the person who created the sequence. 
Once this field has been populated it will never be changed. 

Editor Displays the user name of the person who last saved changes to the 
sequence. This field will be updated each time the sequence is saved. 

Sample Tray 
Type  

Select the autosampler tray type to be used for the sequence from 
the drop-down list. This field is not present (or will be disabled) when 
the associated instrument configuration does not include an 
autosampler. The contents of this list depends on the autosampler 
configured. 

 

NOTE:  This band can also include fields displaying the Date/Time the sequence was created and the 
Date/Time is was last edited (and saved) but these are not displayed by default.  

Sample Information (Band 2) 

Parameter Description 

Sample Type Select from the drop-down list of application-specific sample types that 
control processing of the acquired data. 

LC Sample Types: Calib: Replace, Calib: Average, Sample, Matrix, 
Background, No Injection, Wash 

Speciation Sample Types: Blank, Standard Blank, Standard, CIS Blank, 
Reagent Blank, Sample, Wash 

Sample 
Name 

Enter a unique description of the sample (using up to 50 characters). This 
field is used as an identifier (together with channel name and injection 
number) when the chromatogram(s) acquired are displayed. 

Vial  Set the vial position from which the current sample will be taken. The display 
indicates the size of the vial in addition to its position. This cell will be blank 
and disabled if no Sample Type has been defined for the row. The allowed 
range depends on the selection for Sample Tray Type. 

Internal 
Standard Amts 

Single ISTD in method: Enter a number (greater than zero to 999,999.999) to 
specify the amount of the internal standard in the sample. 

Multiple ISTDs in method: A pop-up editor field (see below), enabling you to 
enter an amount for each internal standard in the sample. 

You can enter a single number if the method defines only one internal 
standard, or it will display a button to provide access to a pop-up editor if 
more than one internal standard is defined. 
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Sample 
Amount 

Enter a number (greater than zero to 999,999.999999) to set the actual 
amount of the sample used in the sample preparation from which the 
injection was made, excluding the amount of internal standards. This value 
is used to convert absolute amounts calculated for unknown samples to 
concentration units. 

Injection 
volume (µL) 

Enter a number to set the volume injected by the autosampler. This cell will 
be blank and disabled if the row does not have a Vial number defined. 

Normalization 
Factor 

Enter a number (greater than zero to 999,999.999999) to set the factor by 
which Area % values are multiplied by when reporting Normalized % (or 
Final Amount values when reporting Normalized Amount). 

Normalized % = Area % x Normalization Factor / 100. 
Normalized Amount = Final Amount x Normalization Factor / 100. 

Multiplier Enter a number (greater than zero to 999,999,999.99) to set a value by 
which the software multiplies preliminary amounts to generate final 
amounts. 

Divisor Enter a number (greater than zero to 999,999,999.99) to set a value by 
which the software divides preliminary amounts to generate final amounts. 

Addend Enter a number (greater than zero to 999,999,999.99) to set a value which 
the software adds to the preliminary amounts to generate final amounts. 

Details  A button that displays a popup window containing a card view of the 
parameters not displayed in the main sample band. 

 

NOTE:  The defaults values shown above for numeric parameters apply to the first row in a 
sequence. Rows added subsequently will use the value from the previous row as default. 

When the button in the Internal Standards field is clicked, a pop-up editor is displayed, listing 
the internal standards defined in the method. Here you can enter the individual amount for 
each internal standard present in the sample. 
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Decision Point Row  (Band 3) 

NOTE:   Different fields will be editable or de-selected depending upon which Decision Point Type 
is chosen. 

 Enter the following Sequence Decision Point information. 

 

NOTE:  The Standard report template is displayed in the Report View  window. You will need to 
maximize this window to view the Report. The report will only be viewable for the current 
run. You can save it in the Microsoft Excel format for later viewing. 

 

Parameters Description 

Decision Point Type Select one of the following action for the sequence row 
from the drop–down list: 

Calibration Review, Peak Detection Review, Data 
Review, and Report.  If your Sample type is Wash, 
Shutdown appears.  

Decision Mode Select one of the following from the drop down list. 
This field is for selecting on which injection(s) the 
decision point should occur: 

After First Injection, After Last Injection, and After Each 
Injection (where Injection refers to the number of 
injections specified in the main row). 

Input Name Select the name of the Report Template desired for this 
sample by clicking on the button and selecting the file 
from a File Open dialog. 

Target Type Enter the file type (Printer, File, or Email). 

File Type Select the type of file to be created as the output for a 
report. 

Adobe Acrobat (pdf) or Microsoft Excel (xls). 

Output Target Select where the report will be sent. Select either File or 
Printer. 
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Main Menu Commands-Sequence 

The menu commands shown in the table below appear in the sequence environment. 

Menu Command Description 

File New Sequence If the current sequence has been modified, then you are 
first asked if it should be saved.  

New Sequence displays a new default sequence. For an 
online instance the sequence configuration is that of the 
connected instrument. In the case of an offline instance 
you are prompted to select a configuration (see New 
Sequence Configuration Dialog). 

 Import Sample List ... Opens the Import Sample List Wizard so you can import a 
sample list into a sequence. 

 Open Sequence … If the current sequence has been modified then you are 
first asked if it should be saved.  

Open Sequence displays the data selector in 'single 
sequence' selection mode. When you select a sequence it 
is displayed. 

 Save Sequence Saves the current sequence, replacing the existing 
version.  

 Save Sequence As… Displays a dialog enabling you to enter a Name and a 
Group for the new sequence, which will then be saved 
under a new identifier in the database.  

 Print Preview 
Sequence ... 

Displays the current sequence in a print preview method 
in accordance with the current print options (see Print 
Sequence Dialog). 

 Print Sequence … Displays the Print Sequence Dialog. After selecting the 
required options in the Print Sequence dialog (and click 
OK) the sequence is printed. 

 Lock Only displayed when user authentication/tracking is active. 
It minimizes the Chromera window to the taskbar. Before 
the window can be restored the valid password for the 
associated user must be entered. 

 Exit Online instance: If a single run is in progress or a sequence 
is running then you are prompted that the instrument must 
be in an idle state before the application can be closed (see 
Exit Dialog). If the instrument is not active then the 
following procedure for an offline instance will apply. 

Off line instance: If the current sequence has been 
modified then the user will first be asked if it should be 
saved. If unsaved data are present in any other 
environment then you are prompted to save each in turn. 
Closes the application window. 
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View Run Time Switches to the Run Time environment. The same 
action as clicking the Run Time button in the 
Navigation Pane. 

 Method Switches to the Method environment. The same 
action as clicking the Method button in the 
Navigation Pane.  

 Sequence Switches to the Sequence environment. The same 
action as clicking the Sequence button in the 
Navigation Pane.  

 Post Run Switches to the Post Run environment. The same 
action as clicking the Post Run button in the 
Navigation Pane.  

 Reprocess Switches to the Reprocess environment. The same 
action as clicking the Reprocessing button in the 
Navigation Pane.  

 Toolbars 
►         View         Toggles display of the View toolbar.  

        Tools Toggles display of the Tools toolbar.  

 Graphics Toggles the display of the Graphic toolbar. 

Tools Export ►  
Chromera Results… 

Methods… 

Sequences… 

Report Templates… 

Displays the Database export dialog. 

Displays the Method export dialog. 

Displays the Sequence export dialog. 

Displays the Report template Export dialog. 

 Import ►  
TotalChrom Data… 

Chromera Results… 

Chromera Methods… 

Chromera Sequences… 

Chromera 2.0 Data... 

Report Templates… 

   

 Displays the Import TotalChrom data dialog. 

Displays the Import Results dialog. 

Displays the Import Methods dialog. 

Displays the Import Sequences dialog. 

Displays the Import Chromera 2.0 data dialog. 

Displays the Report template Import dialog. 

 Preferences Displays the Preferences window, showing the 
preferences associated with the current user (see 
Setting Preferences).  

 Report Format Wizard Displays the Report Format Wizard in New Report 
mode (see Report Format Wizard).  

 Sequence Wizard Displays the Sequence Wizard (see Sequence 
Wizard).  
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 Device Connections Displays the Device Connections dialog.  

 Error Log Displays the Error Log dialog 

 Dictionary Editor Displays the Dictionary editor dialog 

 Reprocess Initiates the Batch Reprocessing function by 
displaying the Data Selector (see Batch 
Reprocess). It is disabled in an online instance 
when data acquisition is in progress, or a sequence 
is running. 

Display No Commands 

Action No Commands 

Help Topics Opens the Chromera Help window.  

 Consumables and 
Accessories 

Opens the Consumable and Accessories Catalog 

 About Chromera Displays the copyright and version dialog.  
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Sequence Editor Standard Toolbar 

This toolbar displays in the Sequence Editor: 

 

Or when user authentication active: 

 
 

Icon Command 

 File/New Sequence 

 File/Open Sequence 

 File/Save Sequence 

 File/Save Sequence As 

 File/Print Preview Sequence 

 File/Print Sequence 

 File/Lock (Only when user authentication 
active) 

 File/Exit 

 Help/Topics 
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Common Toolbars 

There are two common toolbars displayed in every environment: View and Tools. A 
Standard toolbar will always appear but the contents will change depending on the 
environment. The standard toolbar is defined within the sections describing the individual 
environments. 

View  Toolbar 

This toolbar simply mirrors the buttons in the Navigation Pane and the commands in the 
View menu. 

 
 
Icon Command Description 

 Run Time  Switches to the Run Time environment. The same action 
as clicking the Run Time button in the Navigation Pane. 

 Method  Switches to the Method environment. The same action as 
clicking the Method button in the Navigation Pane. 

 Sequence Switches to the Sequence environment. The same action 
as clicking the Sequence button in the Navigation Pane. 

 Post Run Switches to the Post Run environment. The same action 
as clicking the Post Run button in the Navigation Pane. 

 Reprocess Switches to the Batch Reprocess environment. The same 
action as clicking the Batch Reprocessing button in the 
Navigation Pane. 

 Reports Switches to the Report Viewer. 
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 Tools Toolbar 

This toolbar includes the most commonly used commands from the Tools menu. 

 
 
Icon Command Description 

 Reprocess Initiates the Batch Reprocessing function by 
displaying the Data Selector in single batch selection 
mode. 

 Export ►  
Chromera Results… 

 

Methods… 

 

Sequences…  

 

Initiates the Export of Chromera results by displaying 
the Database export dialog. 

Initiates the Export of Chromera methods by 
displaying the Database export dialog. 

Initiates the Export of Chromera sequences by 
displaying the Database export dialog. 

 Import ►  
TotalChrom Data… 

Chromera Results… 

Chromera Methods… 

Chromera Sequences… 

 

Displays the Import window. 

Displays the Import Results dialog. 

Displays the Import Methods dialog. 

Displays the Import Sequences dialog. 

 Preferences Displays the Preferences window, showing the 
preferences associated with the current user. 

 Report Format Wizard Displays the Report Format Wizard in New Report 
mode. 

 Sequence Wizard Displays the Sequence Wizard. 

 Device Connections Displays the Device Connections dialog. 
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Import Sample List 

The Import Sample List Wizard is designed to make creating a Chromera sequence from external 
data quick and easy.  The wizard remembers and displays the settings from the previous session 
for the current user on the current instrument, so the process can be even simpler on 
subsequent occasions.  

On the initial page of the Wizard you can select the file from which the sample list information is 
to be imported, indicate how the mapping of columns from the source file to the Chromera 
sequence will be managed, and select the Chromera Method to be specified for each imported 
row.  To select a new source file the click on the Browse button, which displays a standard 
Windows file selector.  The Files of type option available in the Sequence File Selector dialog 
is a Delimited Text (CSV) file.  After selecting a file and closing the dialog, the selected file name 
will appear in the edit field within the Wizard. 

The Sample List Import Wizard process will add samples defined in a delimited text file (CSV) 
to a new sequence constructed for the current instrument. 

How  to Import a Sample List 

To import a sample list/table into a Chromera sequence, follow these steps: 

1. Select Sequence or Run Time (Sequence mode) environment. 

2. Open a sequence or create a new sequence. 

3. Select Import Sample List from the File menu.    

NOTE: In Run Time this command will be disabled if the sequence is currently running.  It will be 
available when the sequence is stopped or paused. 

The Import Sample List Wizard starts displaying Step 1 of 2 (the first dialog of the Wizard).  
The Wizard will display the settings from the previous session for the current user 
on the current instrument. 
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4. To Select the file from which the sample list is to be imported, click the 
Browse button to display the Sequence File Selector dialog and navigate to the 
directory containing your files.   

5. Select a delimited text file (for example, .csv) from which to import a sample table. 
The first row of the delimited text file must contain the names of the columns within 
the file. 

6. Click the Open button.  
The file name displays in the Import file text field. 

7. To Select how columns from the worksheet will be mapped to the 
Chromera sequence columns, you can select one of the following: 

• I will set up my own mapping.  
Using this selection, you will set up your own mapping in the Sample List Import 
Wizard Step 2 of 2. 

• Use the mapping scheme from the specified template. 
Using this selection, click the Browse button to display the Select Import 
Template dialog.  The template name displays in the text field.  You can create a 
template once you have initially defined a mapping scheme in the Sample List 
Import Wizard Step 2 of 2, so that you will never need to define that scheme again. 

 

8. To Select the Chromera method to be used in the sequence, click the Browse 
button to display the Data Selector - Single Method dialog.  Navigate to and 
select the method.  Click the Open button to display the method in the Method 
Name / Group Name text field. 

9. Click Next. 
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The Sample List Import Wizard Step 2 of 2 dialog displays.   

 
If you selected I will set up my own mapping on the previous screen (Step 1 of 
2), then the dialog displays a list of the .csv source information headers in Input 
Columns Available and the Import Column is blank. 

10. To define the mapping scheme for standard Chromera sequence columns, drag items 
from the Import Columns Available list and drop them in an Import Column cell 
adjacent to the appropriate Chromera Sequence Column item. 
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To define custom Chromera sequence fields, drag items from the Import Columns 
Available list to a Custom Column cell in the lower table. When an item is 
dropped in this table the data Type, Visible, and Editable drop-down lists will be 
activated. 

 

 NOTE: In the following example table AxION Solo/Xpo is shown as an example but not functional. 

Control Description Options 

Type A drop-down list to define the nature of custom 
field  

Text 
Number 
AxION Solo/Xpo: Substance List 
AxION Solo/Xpo: Substance Name 
AxION Solo/Xpo: Formula  

Visible A drop-down list to indicate if the custom field 
will be visible in the Chromera Sequence Editor  

Text /Number fields:  Yes, No 

AxION Solo/Xpo fields: n/a (disabled) 

Editable  A drop-down list to indicate if the custom field 
can be edited in the Chromera Sequence Editor  

Text /Number fields:  Yes, No 
AxION Solo/Xpo fields: n/a (disabled) 

11. Once a mapping scheme has been defined, save this as a template by clicking the 
Save As Template button and entering identification for the template.  
The template preserves only the user fields that are mapped to Chromera sequence 
fields or defined as custom fields.  Entries for the Template Group and Template 
Name fields are mandatory and the Save button will only be enabled when entries 
exist for both items. An entry in the Notes field is optional. 
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This template can then be specified for use in subsequent import sessions by 
selecting the template in Use the mapping scheme from the specified 
template on the initial page of the Wizard. 

NOTE: Since the settings on the first page of the Wizard are saved from session to session, if the 
import operation is a routine in which a file of the same name and structure is imported 
every day, all you have to do is select Import Sample List from the File menu, review the 
contents of the first wizard page and click Finish.  The created sequence can then be 
reviewed and customized (e.g. with reports or other decision points) as required. 

12. When done click the Save button. 

13. Click the Finish to import the sample list. 

The Import Progress dialog displays. 

      

• A
  

green circle with a  indicates that all data imported successfully. 

• A
  

red circle with an X indicates that all rows did not import successfully. 

• A
  

yellow triangle with an ! indicates that all rows imported 

successfully but there may be a problem with the fields. 

14. If you want to check the import status, click the summary log link next to the green , 

red X, or yellow !.  The log indicates the success or failure for importing each data row in 
the import file. 

15. Click the Close button.  If no sequence is currently open one is created for the 
current instrument. 
The sample table is imported (appended to any existing rows) and displayed. 

16. When done remember to name and save the sequence. 
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Importing Substance Data 

Users importing sample list data from a .csv file are able to define a custom field as being a 
Substance List field.  Chromera will interpret this as a string to be imported and saved in the 
custom field flagged as a substance list. This identification of the field is crucial to the correct 
passing of this information to the substance list source software when the sequence row is 
executed. 

As an alternative to being able to define the name of a pre-existing substance list, you are able to 
indicate that fields being imported from the .csv file represent elements of a single target file.  By 
definition, this is a file that does not yet exist and must be created during the import process. 

 

If a column is headed Formula in the user’s .csv file it has been defined as a Formula. This 
means that for every row imported an XML single target file will be created with the Formula 
element of the XML populated with the contents of the Formula field from the .csv file.  If a 
user’s data does not define the other element in the single target file (Substance Name), this 
element will not appear in the created single target file. 

Note that for the substance list and the other elements in the custom fields grid shown above the 
Visible and Editable fields will be disabled and will show n/a. This is because these elements 
will have been written to the substance list XML file and will therefore not be available 
individually.  The Chromera sequence will only retain the file name of the substance list or single 
target file and not the individual elements. By contrast, in the example above, the user could 
elect to display the Compound ID field in the Chromera sequence, since this is a simple text field 
and not part of a substance list or single target file. 

NOTES: 

1. If the user maps a .csv field to Substance List it will not be possible to map another field to any 
single target element (Name, Formula).  The converse is also true – once an import field has been 
defined as a single target element it will not be possible to define another field as a Substance 
List. 

2. Only one instance of any element can appear in the custom table.  That is, it is not possible 
to define two substance lists, two Formula elements, or two Name elements. 
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New Sequence Configuration Dialog (Offline) 

When you are in an offline instance of Chromera, the New Sequence Configuration dialog is 
displayed when you select the New Sequence command from the File menu. It enables 
you to define the instrument configuration to be used for the new sequence. Then you can 
select an existing configuration or define an instrument structure specifically for use with the 
new sequence. 

 

 

Control Description 

Select from my instrument 
configurations  

Select to indicate an instrument configuration assigned to 
the current user will be selected for the new sequence. 

Select from all instrument 
configurations 

Select to indicate an instrument configuration from the 
full system collection will be selected for the new 
sequence. 

Define an instrument 
configuration 

Select to indicate that you will construct an instrument 
configuration for the new sequence. 

Instruments Displays a list of existing instrument configurations for 
you to define the new sequence structure.  

This list displays all of your existing defined 
configurations or all of the instrument configurations 
defined on the system (depending on the radio button 
selection). 

Available Devices Displays a list of devices comprising the instrument for 
the new sequence. It is only displayed when the third 
radio button option is selected. 

The list displays all instrument devices supported by the 
Chromera software. 
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Configured Devices Displays a list of the Configured Devices making up 
the instrument.  
 
If an existing instrument is selected from the 
Instruments list then the devices assigned to that 
instrument are displayed in this list. If an instrument 
configuration is being defined then the list contains those 
devices assigned to the instrument so far. 

 
When a device name is selected in the Available 
Devices list, clicking this button copies the device name 
to the Configured Devices list. If a device of that type 
already exists then a numeric identifier will be appended, 
so that each occurrence of the device can be 
distinguished. 

When items from the Available Devices list are added 
to the Configured Devices list, the selected items in 
the Available Devices list are deselected/unhighlighted. 

 
Selecting one or more device names in the Configured 
Devices list and clicking this button, removes the device 
name(s) from the list. All items are then deselected in the 
Configured Devices list. 

 

NOTES:  An instrument configuration is required in association with a sequence for two reasons: (1) 
An ICP-MS instrument sequence uses a different set of Sample types from 'pure' LC 
instruments. (2) If a Series LC 200 autosampler is to be used when the sequence is run, a 
tray type must be defined. This also serves to set the allowed range for vial number within 
the sequence. 
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Sequence Editing Tools 

The sequence Editing Tools are available as a tab on the right side of the sequence. To display 
them, move the cursor over the Editing Tools tab. To display those tools permanently, click on 
the thumbtack icon on top of the Editing Tools window. Use the editing tool to modify your 
sequence. 

 

To delete a Sequence item (row) highlight the row and press the Delete key on your 
keyboard. To select multiple rows, hold down the Ctrl key and select the rows you want to 
delete, then press the Delete key. 

You can also fill a column with the same information by right-clicking in a cell and select Fill 
Down or Fill All.  To clear an entry in the cell select Clear. 

Control Description 

Edit Controls  

Add Displays the Add Item to Sequence dialog which will add 
samples to the end of the Sequence. 

Insert Before Displays the Insert Item in Sequence dialog. It places a 
new item before the selected row. 

Insert After Displays the Insert Item in Sequence dialog.  It places a 
new item after the selected row. 

Cut Deletes selected rows from the sequence but retains them 
on a clipboard (not the Windows clipboard). Any existing 
rows on the clipboard will be replaced by the new Cut 
action. 

Copy Copies selected rows from the sequence and retains them 
on a clipboard. Any existing rows on the clipboard will be 
replaced by the new Cut action. 
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Paste Before 

 

Inserts rows held on the clipboard into the sequence above the 
currently selected row. The clipboard rows are pasted as a 
contiguous block even if they were not adjacent when originally 
copied to the clipboard. 

If there is more than one selected row when the Paste 
command is given, the rows will be pasted above the first row 
number selected. If there is no selected row, an error message 
will be displayed. 

Paste After Inserts rows held on the clipboard into the sequence below the 
selected row. The clipboard rows are pasted as a contiguous 
block even if they were not adjacent when originally copied to 
the clipboard. 

If there is more than one selected row when the Paste 
command is given, the rows will be pasted below the last row 
number selected. If there is no selected row, an error message 
will be displayed. 

View Controls  

Expand All Displays all decision point rows for every line of the 
sequence. 

Collapse All Hides all rows of a sequence except for the identification 
row (first row). 
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Popup Menu 

Right-clicking in a cell displays the sequence editor context menu to assist you in editing the 
sequence. It contains the following commands. 

Command Description 

Fill Selected  Copies the value in the first cell of the selection to the 
remaining cells in the selection. See NOTE below. 

Fill Down Copies the value in the current cell to the 
corresponding cell in all rows below (where 
applicable).  See NOTE below. 

Fill All Copies the value in the current cell to the 
corresponding cell in all rows (where applicable). See 
NOTE below. 

Select Columns…  Displays the Sequence Column Selection dialog 

Expand All Fully expands the results grid to show all bands. 

Collapse All Hides all peaks bands in the grid leaving only the 
sample/injection bands shown. 

 

NOTE:  The Fill Selected, Fill Down, and Fill All commands are disabled for Decision Point rows, 
since they make little sense in that context.  The Fill Down and Fill All commands have 
slightly different behavior on the Vial cell. In this case the value is incremented for each 
applicable cell. The Fill Selected command copies the value from the first cell in the 
selection to the remaining cells. 
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Sequence Column Ordering 

The feature of column ordering by drag-and-drop is used in the sequence parameter display. 
This allows you to display the selected columns in each band in the preferred order. The 
order of the columns will be retained at the end of the session and used the next time that 
you open the sequence editor. 

The Sequence Column Selection dialog (displays when you right click in the sequence) lists 
the columns available for display in all sections of the sequence in a hierarchical format.  

 
 
Control Description 

Select columns to show  Select from the drop-down list the parameters to display in the 
list beneath, they are: 

All – Shows all parameters for all sections of the sequence. 

Decision Points – Shows only the decision point parameters. 

Per Sample Report – Shows only the columns for the Per 
Sample Report global parameters. 

Sample Naming Template – Shows only the columns for the 
Sample Naming Template global parameters. 

Sequence Row Items – Shows only the columns available for 
Sequence Row Items sequence sample rows. 

Sequence – Shows only the global sequence identification 
items. 

Sequence  A section of the check list that shows the sequence 
identification parameters, they are: Author, Created Date/Time, 
Description, Editor, Group, Last Modified Date/Time, Name, and 
Sample Tray Type. 
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Sequence Row Items  A section of the check list that shows the parameters for each 
sample row, they are: Addend, Dilution Factor, Divisor, 
Injection Volume, Injections, Method, Multiplier, Normalization 
Factor, Sample Amount, Sample Description, Sample Name, 
Sample Type, Standard, and Vial. 
NOTE: The Details and Internal Standard Amounts columns 
contain buttons and therefore cannot be hidden by this 
mechanism. 

Decision Points  A section of the check list that shows the decision point 
parameters, they are: Decision Mode, Decision Point Type, File 
Type, Input Name, Output Target, and Target Name. 

Per Sample Report  A section of the check list that shows the Per Sample Report 
global parameters, they are: File Type, Frequency, Output 
Name, Output Target, Report Template, and Sample Type. 

Sample Naming 
Template  

A section of the check list that shows the Sample Naming 
Template global parameters, they are: Apply To, Number, 
Prefix, Suffix, Vial Increment, and Vial Start. 
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About Decision Points 

Decision Points can be used in a running sequence or a reprocessing sequence. One type 
pauses the operation of the system and the other type performs an action. 

 The Peak Detection Review, Calibration Review, and Data Review Decision 
Points pause the operation of the system thereby enabling you to examine the 
results, and take appropriate action. If executed during real time, the sequence 
pauses. You must be present to interact with Chromera since the system will remain 
in the paused state until a decision is made. 

For example: After running all the standards you can set a decision point to 
determine if the calibration curve is acceptable.  If the calibration curve is not 
acceptable you can make changes (e.g., excluding a data point) and the adjusted 
calibration curve will be applied to all the subsequent runs.  

 You do not need to be present for the Report and Shutdown Decision Points as 
they perform an action and the sequence continues. 

For example: If you select Report, a report is printed or saved at that point in the 
sequence. 

Decision points may be executed after the first injection, after the last injection, or after each 
injection. There is no limit to the number of decision points. 

Example of Decision Points in a Sequence 
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Example of Decision Points in Reprocess 

 
 

How  to Set Decision Points 

The following Decision Points can be set in a Sequence. 

Setting a Peak Detection Review  Decision Point 

Selecting the Peak Detection Review decision point essentially pauses the sequence at 
this point and opens the Graphic Method Editor. Information that can be modified includes: 
Component Identification (Names, Retention times, and Search Windows), Data Handling 
Optimization (Bunching Factor, Noise and Area Threshold, and Baseline Timed Event). 

After making modifications click Accept. The changes are saved to the method and the 
sequence progresses. 
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Setting a Calibration Review  Decision Point 

Selecting the Calibration Review decision point essentially pauses the sequence at this 
point and displays the curve information, data, and the calibration curve. Information you 
can modify includes: Type of Calibration, Data points used, and Treatment of the Origin 
(Ignore, Include, or Force).  
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Outlier points are calculated by Chromera based on the entered Outlier Limit value. When a 
point is calculated as an outlier the Outlier box is checked and the point is represented as an 
X on the graph. Also, the In Use box is not checked.  In this example, Injection 3 is 
determined to be an outlier. The actual information on the screen is wider than your display 
so you need to use the scroll bar on the bottom of the screen to view all of the displayed 
information. 

 

 

To include the Outlier in the calculations of the calibration curve check the In Use box. This 
is indicated by a check mark in the In Use Changed by User column. 
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After making modifications, click the Accept button. This immediately updates the results. 

Setting a Data Review  Decision Point 

Selecting the Data Review decision point essentially pauses the sequence at this point to 
review integrated chromatograms and results. The Results cannot be edited. Data Review 
has two views: Integration (Retention Times and Baseline Timed Events) and Results (Area, 
Height, Concentration, etc). 

  

After reviewing click Accept and the sequence progresses. 
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Setting a Report Decision Point 

Selecting a Report decision point enables the printing or saving of a specified type of report (e.g., 
Calibration, Method, Summary) at that point in the sequence. There is no user interaction with this 
Decision Point. Reports generated in this way are in addition to those specified as Global Reports in 
the sequence, or Per Sample Reports. Multi-sample Summary reports can ONLY be generated through 
a Report type Decision Point. 

 

Setting a Shutdown Decision Point 

The Shutdown decision point is ONLY available with a Wash sample type. In an LC 
application the pump stops and the detector lamp turn off. For LC/ICP-MS, the pump stops, 
the plasma turns off and peristaltic pump stops, the detector lamp turns off, and the oven 
temperature drops to 25 °C  

This is executed after the Wash row in the sequence has been run. 



Sequence.  215 

 

Sequence Details View  

Clicking the Details button on any row displays a popup window showing the parameters for 
the selected sample row that are not currently displayed. 

 

The parameter values are editable within the popup window and the popup menu commands 
Fill Down and Fill All are available to propagate values from the current sample row to other 
sample rows. You are able to order the parameters within the View using drag-and-drop. 
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Vial Entry Validation 

The samples vials defined within a sequence must be consistent with the type of sample tray 
selected for use with the sequence. There will be three distinct instances of validation, 
relating to different user actions. See also the discussion regarding tray and vial validation 
under Run Time. 

NOTES:  Not all trays include vial positions that are a single contiguous range. The valid range or 
ranges of vial numbers for each tray type are defined in the Instrument Descriptor file for 
each autosampler model. 
 
The only check is to ensure that every vial defined within the sequence actually exists in 
the specified tray. 

Direct Vial Entry 

When you make an entry in the Vial field of a sequence row, what is actually occurring is a 
look-up in the list of available vials contained in the drop down list.  If you press a character 
key that results in an entry not contained in the list, that character will not be displayed. For 
example, if the selected tray is the default 100-position tray and you press the key sequence 
1 2 3, the final 3 will not appear since it creates an invalid vial number; leaving a vial entry of 
12. It should therefore be impossible for you to enter an invalid vial number directly. 

Add Rows or Fill Down 

When you specify a range of sequence rows to be assigned a series of incrementing (not 
necessarily by 1) numbers, the software will check to ensure no vial numbers that do not 
exist for that tray are included in the generated series. If the Add procedure cannot be 
completed because it requires more vials than are available in the specified tray then an 
error message displays 

 

If the Fill Down cannot be completed because it requires more vials than are available in the 
specified tray then the Vial position Error message displays. 

 

Clicking OK sets the Vial field for the indicated rows to NONE. This allows you to locate those 
rows easily once the error dialog has been closed, and to make the decision whether to 
delete the rows or assign valid vial numbers.  
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Tray Type change 

If you change the tray type selection for an existing sequence, the software will check to see 
if all the vials specified in the sequence are available in the new tray. If any are not available 
then the Vial(s) Out of Range error message displays, indicating the vial positions not 
available in the new tray. 

 

If you click OK the vial positions that are not available in the new tray type will be changed 
to NONE.  This allows you to locate those rows easily once the error dialog has been closed, 
and to make the decision whether to delete the rows or assign valid vial numbers.  

If you click Cancel, the tray type setting will revert to the prior selection. 

Sequence Wizard Parameters 

The validation action of the Sequence Wizard is to ensure that it never creates a sequence 
that references an invalid vial. If the specified tray includes discontiguous ranges, the wizard 
will take this into account and jump the gaps as necessary when building the sequence. If 
the building procedure cannot be completed because it requires more vials than are available 
in the specified tray then Sequence Wizard Tray capacity exceeded error message displays. 
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How to Build a Sequence using Sequence Wizard 

The Sequence Wizard provides a quick and simple way to build a sequence for routine 
sample analysis. It provides dialogs to enter information in a logical and structured way.  The 
dialogs also contain next and back buttons to help you step through a sequence. The Wizard 
creates a sequence containing intermixed blanks, calibration standards, and samples, with 
the following constraints: 

• The same method is used for all rows in the sequence 

• If calibrations are specified, the first rows of the sequence (and hence first vials in the 
autosampler) is a calibration set 

• Each calibration set will consist of one row per standard defined in the method 

• If repeat calibrations are required they will appear at regular intervals (i.e. with a 
constant number of samples between them) 

• Blanks can be inserted but only at regular intervals (i.e. with a constant number of 
samples between them) 

A sequence created using the Wizard can be edited in any way desired, using the standard 
Sequence Editor. 

Sequence Identification Page 

Use the Sequence Wizard initial screen to enter information to identify the sequence and 
select the method to be used. Required fields are indicated with an asterisk.  

 

The Next button is enabled after entering a Sequence name and selecting a Method. 
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If the selected method is capable of being calibrated, that is if it contains at least one 
component with a valid calibration scheme (e.g. Linear through origin with one standard level, 
Linear with two standard levels, etc.), then the Calibration button will appear in the list.  

Enter the following parameters: 

Control Description 

Sequence name Type a name that defines the name by which to identify 
the sequence. 

Description Type a description about the sequence. 

Group Type a virtual folder name that can be used to assist in 
locating sequences in the database. You can also select 
an existing group name from the drop-down list. 

Method Select the method name to use in acquiring and 
processing data in the sequence. The method name is 
selected by clicking on the browse button. 

 
Click the browse button to display the data selector in 
method mode, to select a method from the database. 

 

The next page defines the Autosampler settings for the sequence. 
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Autosampler Page 

The Autosampler page of the Wizard will only appear if an autosampler is configured on the 
instrument. This is where you select the autosampler control settings. 

 

The page shown here is specific to the Series 200, Series 225, Series 275, and Flexar 
autosamplers, which are the models supported. Enter the following parameters: 

Control Description 

Tray type Select the tray to be used for injections made from this 
sequence. The list contains all available tray types for 
the current instrument. 

Starting vial number Set the vial position from which the current sample will 
be taken. Allowed range depends on the selection for 
Tray Type. 

 

The next page defines the Blanks settings for the sequence. 
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Blanks Page 

The Blanks page is where you set the type and frequency of blanks to be subtracted from 
sample analyses. 

 

Enter the following parameters: 

Control Description 

Include Blanks in the 
sequence 

A check box to indicate that blanks will be run as part 
of the sequence. 

Number of injections per 
blank 

Set the number of times (from 1 to 9) each blank will 
be run. You can type in a value or use the buttons to 
set it. 

Blank type Select one of the applicable blank types for the current 
instrument. 

For Speciation: Blank (pt by pt), Reagent Blank, 
Standard Blank, CIS Blank 

For General LC: Matrix, Background 

Number of samples 
between blanks 

Set a value when an additional blank will appear in the 
sequence. You can type in a value (from 1 to a 
maximum number of vials available in the specified tray) 
or use the buttons to set it. 

 

The next page defines the Calibration settings for the sequence. 
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Spectral Standards Page 

The Spectral Standards page is where you set the type and frequency of blanks to be 
subtracted from sample analyses. 

 

Enter the following parameters: 

Control Description 

Include spectral 
standards in the 
sequence 

A check box to indicate that spectral standards will be 
run as part of the sequence. 

Number of injections per 
spectral standards 

Set the number of times (from 1 to 9) each spectral 
standard will be run. You can type in a value or use the 
buttons to set it. 

Number of samples 
between spectral 
standards 

Set a value when an additional spectral standard will 
appear in the sequence. You can type in a value (from 1 
to a maximum number of vials available in the specified 
tray) or use the buttons to set it. 

 
 

Calibration Page 

The Calibration page defines the interval at which calibration sets are inserted into the sequence, 
as well as the calibration types for the initial calibration set (first n rows of the sequence, where n 
is the number of standards defined in the method) and all subsequent sets. 
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Enter the following parameters: 

Control Description 

Include calibration 
standards in the sequence 

A check box to indicate that calibration standards will be run 
as part of the sequence. 

All calibrations from one 
vial set  

A check box to indicate that only one set of calibration vials is 
present and that this set of vial numbers will be applied each 
time a calibration set is entered into the sequence. 

Number of injections per 
standard 

Set the number of injections (from 1 to 9) to be made of each 
calibration standard. You can type in a value or use the 
buttons to set it. 

Calibration type for initial 
standard set 

Select from the drop-down list the calibration type for the first 
set of calibration standards (the first rows) in the sequence. 

• for LC: Calib: Replace, Calib: Average 
• for ICP-MS: Standard 

Calibration type for repeat 
standard sets 

Select from the drop-down list the calibration type for 
additional sets of calibration standards appearing later in the 
sequence. 

• for LC: Calib: Replace, Calib: Average 
• for ICP-MS: Standard 

Number of samples 
between standard sets 

Set when an additional standard set will appear in the 
sequence. You can type in a value (from 1 to a maximum 
number of vials available in the specified tray) or use the 
buttons to set it. 

The next page defines the Sample set for the sequence. 
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Samples Page 

The Samples page enables you to define samples and sample numbering. 

 

Enter the following parameters: 

Control Description 

Number of samples Set the number of injections (from 1 to a maximum number of 
vials available in the specified tray) to be made of each 
calibration standard. You can type in a value or use the buttons 
to set it. 

Number of 
injections per 
sample 

Set the number of injections to be made of each sample. You 
can type in a value from 1 to 9 or select it from the list. 

Prefix Set the start of each Sample Name for the added rows. The 
Sample Name  consists of the Prefix, Number (incremented 
by one for each sample) and Suffix concatenated, without 
intervening spaces. You can use up to 25 characters. 

Leading zeroes Set the number of leading zeroes (from 0 to 4) appearing 
before the incrementing number within the sample name. 

Number Set the initial value of the incrementing number appearing in 
the Sample ID. The range is 0 to 9999 with as many digits as 
entered (e.g. 0000 is a valid entry). 

Suffix Set the end of each Sample ID for the added rows. You can use 
up to 25 characters. 
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Assign sample 
names to 
calibrations 

A check box to set if the sample names constructed from 
Prefix/Number/Suffix should be entered for calibration 
standards as well as samples. The selections are Yes or No. This 
setting is enabled if calibration standards are included in the 
sequence. 

View sequence A check box to load the sequence into an editor for viewing 
after being generated. 

In Editor 
In Run Time 

Set the editor in which the generated sequence will be loaded. 

 

NOTE:  The Assign sample names to calibrations check box on the page determines whether 
the sample names automatically generated from the ‘Prefix’, ‘Number’ and ‘Suffix’ fields is 
applied only for samples or also to calibration standards. 

When you click the Finish button, the sequence is built according to the settings within the 
Wizard and (optionally) displayed in the specified environment. 
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About Active Sequence 

Any part of the sequence that has not yet been used, or is in the process of being used, can 
be changed. This means that the active row and all completed rows are read-only.  

If you change the value of an editable sequence parameter and indicates the entry is 
complete (for example, by pressing the Tab key or selecting a different field) then the active 
sequence is updated immediately and the new value will replace the previous value as soon 
as that parameter is used. 

All such changes to the active sequence will generate a log entry associated with the 
acquired data, indicating: 

• The Row number and Sample Name of the changed row 

• The change to parameter value or setting that was made 

• The date and time of the change 

• The user who made the change (the Full Name defined in the OS if available, 
otherwise the user account name) 

For example - Row 5: Sample: “My test sample” Sample Amount: From: 1.0000 To: 2.5678 
At: 02:34:55 PM August 30, 2008 By: Deb Peterson 

The modified sequence row stored with the results data set will of course reflect the 
parameters that were actually used.  

However, the sequence itself will remain unchanged in the database, unless the user chooses 
to save it. File/Save replaces the existing copy of the sequence with the modified version, as 
usual. The Save As command is available during active sequence editing but it will not affect 
the name of the active sequence or the name of the stored batch. 

About Sequence Run Control 

Starting/ Ending Rows 

By default a sequence is executed from the first row to the last, however it is possible for the 
user to specify starting and ending rows prior to giving the Start Sequence command. 

Processing/ Reporting 

Options are available prior to starting (or resuming) a sequence to suppress all processing 
(peak detection to reporting) or just to suppress reporting. The latter (suppress reporting) 
setting over-rides both individual row decision point reporting as well as any global report 
setting. 

Pause/ Resume 

During execution of a sequence it can be paused. This will have no effect on the currently 
running analysis (if any) but the next analysis will not take place while the sequence is 
paused. When you select Resume, by default the sequence will continue with the analysis 
immediately following the last completed one, however you may specify new a starting 
(resuming) row and/or ending row prior to giving the resume command. 
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Also, a paused sequence may be stopped in which case the Resume command is no longer 
applicable. 

Error Conditions 

If for any reason the autosampler cannot make an injection from the specified vial (for 
example, there is no vial in the specified tray position), the software logs this event and 
continues sequence execution with the next row. 

Print Sequence/ Print Preview  Sequence Dialog 

The Print Sequence dialog is displayed when the Print Sequence… or Print Preview 
Sequence… command is chosen from the File menu within the Sequence environment. The 
dialog allows you to define on which printer the report will be printed and the report 
template to be used. 

 

Set the following in this dialog: 

Control Description 

Current selection: Displays the name of the current sequence. 

Printer Displays the name of the printer to be used to output the 
sequence report. You can select from all the printers 
configured under Windows for the logged on (Windows) user. 

 
Click the button to display the standard Windows select 
printer dialog. The name of the printer selected in the 
standard Windows dialog will be entered into the Printer field. 

Sequence report 
template 

Displays the name of the template to be used for generating 
the sequence printout. 

 Click this button to select any of the sequence report 
templates available. Clicking this button displays the data 
selector with the filter set to sequence report template 
mode. 
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From Group: Displays the name of the Group the currently selected report 
template is assigned to. 

 Report to be generated: This field displays information about the selected template. 

 

 

When this dialog is displayed, the default report template shown is the most recently used 
sequence report template used in this dialog. If no most recently used template exists for 
this user/instrument, then the field is blank. In this latter case the From Group text and 
Report to be generated: field will also be blank. 

NOTE:  Although report templates are actually stored as files, the template name will be shown here 
without the file extension. 

When the folder button is clicked the standard report template selection dialog is displayed. 
However, the templates available for selection are filtered, so that only sequence templates 
will be shown. 

When the report template field is populated, the software examines the template to 
determine its basic characteristics. These are then displayed in the Report to be 
generated: field, as defined below. 



 

 

Run Time 
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About the Run Time Environment 

In the Run Time environment you can interactively control an instrument. For example, using 
the manual control of a specific device, data acquisition using a method, and sample analysis 
using a sequence are all controlled from here. 

Run Time is accessed by clicking the Run Time button in the Navigation Pane (or selecting the 
Run Time command from the View menu or clicking the Run Time toolbar button). The Run 
Time environment is designed to bring together all elements required to monitor and control 
instrument operation. The intent here is that this environment should enable you to accomplish 
your primary instrument-related workflows in an intuitive and efficient manner. 

 

The workflows considered in the development of Run Time analysis are: 

• Start up an instrument from shutdown or standby 

• Routine analysis 

• Instrument method development 

NOTE: In an online instance of Chromera, or an offline instance with an assigned instrument 
configuration, the title bar of the main display area always displays the name of the instrument. 
When data acquisition is in progress it also displays the name of the sample being analyzed. 

By default the main area of the screen contains two frames: a graphics frame to display the 
chromatograms and an instrument/sequence frame to display the settings. The basic contents of the 
instrument/sequence frame will depend on the Control Mode selection made in the upper section 
of the navigation pane.  

If you are configured with a PDA, the graphics frame includes a real-time Contour Map monitor 
that flies-out from the right-hand side. The contour map also contains a Tools tab for you to control 
and scale the contour map. 
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• When Manual Control is selected, the controls enabling a user to make the various 
devices of the instrument ready for analysis is displayed. 

The Single Run and Sequence modes have a toolbar below the title/status bar. 

• When Single Run is selected, the frame will contain various run parameters or the 
method selected for control, depending on a toolbar selection. 

• When Sequence is selected, the frame displays the sequence selected for control. 

Navigation Pane 

In the Run Time environment the Navigation Pane area above the buttons contains three 
sections: 

• Control Mode 

 Control Mode Selection Description 

 Manual Control Disabled when a single run is in progress 
(for an automated injection this means 
from the time the Injection command is 
issued) or when a sequence is running. 

 Single Run Disabled when a sequence is running. 

 Sequence Disabled when a single run is in progress 
(for an automated injection this means from 
the time the Inject command is issued to 
the autosampler). 

• Plots 

• Reference Plots - Select channels to compare against the displayed graphics. 

• Manual Control Devices - (when Manual Control is selected) or Method (when 
Single Run or Sequence is selected).  

The display area of each of these sections can be toggled closed or open by clicking on the plus 
or minus button in the title bar.  
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NOTE: The relative sizes of the two frames can be changed by dragging the splitter bar between them; 
or, double-clicking in the title bar of one of the frames will toggle between a maximized and 
restored view. 

Run Time Main Menu Commands - Manual Control 

The menu commands displayed in the Run Time environment will depend on the run mode 
selected. All modes will have File, View, Display, Tools, and Help menus but the contents of the 
File menu differ for Manual Control, Single Run, and Sequence modes.  

NOTE: The Actions menu does not appear in Manual Control mode (all actions are controlled by 
buttons in that mode) and its contents are different in Single Run and Sequence modes. 

The table below displays the commands available in Manual Control mode. These commands 
are in addition to those described in Common Menus. 

Menu Command Description 

File Lock Lock is only displayed when user 
authentication/tracking is active. It minimizes the 
Chromera window to the taskbar. Before the window 
can be restored the valid password for the associated 
user must be entered. 

 Exit Closes the Chromera instance. 

Display Rescale Displays the Rescale Axes dialog. 

 Auto Rescale Redraws the contents of the active plot frame at 
default scaling. 

 Auto Offset Applies to real-time plots only. Auto Offset redraws the 
contents of the active plot frame to reset the Y axis 
minimum value so that the current signal level is 
displayed at approximately 5% of full scale. The Y axis 
maximum is also adjusted so that the full scale span 
remains the same. 

 Plot Styles Displays the Plot Styles dialog. 

 Clear Graphics Clears the existing display of all real-time plots and 
starts plotting again for each selected channel. Also 
restores any data displayed for previous run or 
reference chromatograms. 

 Snapshot Displays the active plot in a full screen window. 
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Run Time Main Menu Commands - Single Run Mode 

The table below displays the commands available in the Single Run mode. These commands 
are in addition to those described in Common Menus. 

Menu Command Description 

File 

 

New Method If the current method has been modified then you 
will first be asked if it should be saved. It creates 
a default method for the current instrument 
configuration and displays it. New Method is 
disabled when a run is in progress. 

 Open Method… If the current method has been modified then you 
will first be asked if it should be saved. It displays 
the data selector in select method mode. When 
you select a method it is displayed. Open Method 
is enabled at all times. 

 Save Method Saves the displayed method, replacing the existing 
version. Save Method is enabled when a method is 
displayed.  

 Print Preview Method ... Displays the Print Method dialog. After you have 
selected the required options in the Print Method 
dialog the method will be printed. Print Preview 
Method is enabled at all times. 

 Print Method … Displays the Print Method dialog (see Print Method 
). The method prints after selecting the required 
options in the Print Method dialog. Print Method is 
enabled at all times. 

 Lock Only displayed when user authentication/tracking 
is active.  

Minimizes the Chromera window to the taskbar. 
Before the window can be restored the valid 
password for the associated user must be entered. 

 Exit If a single run is in progress or a sequence is 
running you are prompted that the instrument 
must be in an idle state before the application can 
be closed (see Exit dialog). If the instrument is not 
active then if any unsaved data exists in any 
environment the software will ask the user if it is 
to be saved before exit. 

Actions Run Options Displays the Run Options dialog appropriate to the 
current mode. 
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 Inject Displayed only when an autosampler is configured 
on the instrument. Initiates an injection on the 
autosampler. 

Inject is disabled when a run is in progress (i.e. 
when injection cycle begins). It is re-enabled 
when the run ends. It is not required that the 
instrument be in Ready state before an injection 
can be initiated; just that it is not acquiring data. 

 End Run ... End Run is enabled when a run is in progress and 
displays the End Run dialog. 

 Extend Run Time ... Extend Run Time is enabled when a run is in 
progress on an LC-only instrument, it is always 
disabled for an ICP-MS instrument, and displays the 
Extend End Run dialog. 

 

Run Time Main Menu Commands - Sequence Mode 

The table below displays the commands available in Sequence mode. These commands are in 
addition to those described in Common Menus. 

Menu Command Description 

File 

 

New Sequence If the current sequence has been modified then you are 
first asked if it should be saved then it displays a new 
default sequence. The sequence configuration is that of 
the connected instrument. It is disabled in an when a 
sequence is running, otherwise it is enabled. 

 Open Sequence … Open Sequence is disabled when the sequence is 
running or paused. If the current sequence has been 
modified then you are first be asked if it should be 
saved. It displays the data selector in single sequence 
selection mode. Selecting a sequence displays it. 

 Save Sequence Save Sequence is enabled when a sequence is 
displayed. It saves the current sequence, replacing the 
existing version.  

 Save Method Save method is enabled when a method is displayed. It 
saves the current method, replacing the existing stored 
version. 

 Print Preview ►  
Method ... 

 

          

Enabled when a sequence is open. When a method is 
displayed that will be the method printed or previewed. 
When the sequence is displayed, the method printed or 
previewed will be that from the selected row or the first 
row, if no row is currently selected. Displays the Print 
Method dialog. The method prints after you have 
selected the required options in the Print Method 
dialog. 
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  Sequence ... Enabled when a sequence is opened. It displays the 
Print Sequence dialog. The sequence prints after 
selecting the required options in the Print Sequence 
dialog. 

 Print ► Method … 

 

 

           Sequence ... 

Enabled only when the Method is actually displayed in 
Sequence mode. Displays the Print Method dialog . The 
method prints after you have selected the required 
options in the Print Method dialog. 

Enabled when a sequence is displayed. Displays the 
Print Sequence dialog. The sequence prints after 
selecting the required options in the Print Sequence 
dialog. 

 Lock Only displayed when user authentication/tracking is 
active. It minimizes the Chromera window to the 
taskbar. Before the window can be restored the valid 
password for the associated user must be entered. 

 Exit If a single run is in progress or a sequence is running 
then you are prompted that the instrument must be in 
an idle state before the application can be closed. If the 
instrument is not active then if any unsaved data exists 
in any environment the software will ask the user if it is 
to be saved before exit. 

Display Rescale Displays the Rescale Axes dialog. 

 Auto Rescale Redraws the contents of the active plot frame at default 
scaling. 

 Auto Offset Applies to real-time plots only. It redraws the contents 
of the active plot frame to reset the Y axis minimum 
value so that the current signal level is displayed at 
approximately 5% of full scale. The Y axis maximum is 
also adjusted so that the full scale span remains the 
same. 

 Plot Styles Displays the Plot Styles dialog. 

 Plot Layout Displays the Run Time version of the Plot Layout dialog. 

Displayed in Sequence mode only.   

Displayed in Sequence mode only.   

Actions Run Options Displays the Run Options dialog appropriate to the 
current mode (see Run options). It is disabled in 
Manual Control mode. 

 Set as Start Row Enabled when the sequence is idle (or Paused) and a 
row is selected in the sequence. Sets the selected row 
as the first row to be run when the sequence is started. 
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 Set as End Row Enabled when the sequence is idle (or Paused) and a 
row is selected in the sequence. Sets the selected row 
as the last row to be run when the sequence is started. 

 Start Sequence Enabled when a sequence is open. Initiates the 
sequence run. The Start button also acts to restart the 
sequence from the Paused state. 

 Pause Sequence Enabled when a sequence is running. Inhibits the next 
injection when the current run (if any) is complete. 
Subsequent use of the Start Sequence command 
would (by default) cause the sequence to resume 
running with the next injection. 

 Stop Sequence Enabled when a sequence is running. Inhibits the next 
injection when the current run (if any) is complete. 
Subsequent use of the Start Sequence command 
would (by default) cause the sequence to begin running 
from the Start Row. 

 End Run Enabled when a run is in progress. It displays the End 
Run dialog. 

 Extend Run Time Enabled when a run is in progress on an LC-only 
instrument. It is always disabled for an ICP-MS 
instrument. It displays the Extend Run Time dialog. 
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Acquisit ion 

About Channels 

A channel is a digital data set received from an instrument, or derived from data received from 
an instrument. Some channels (those representing chromatograms) are processed by the 
software; others (such as solvent gradient profiles and pump pressure curves) are acquired and 
stored for subsequent display only. A channel may be a directly acquired signal from a device or 
it may be a derived stream (e.g. a chromatogram extracted from spectral data or a resultant 
chromatogram derived by subtracting a stored blank data stream from an acquired signal). The 
latter is used by the speciation application. 

The supported detectors all provide data in the form of chromatograms. However, derived 
channels produced by the subtraction of one chromatogram from another will also be supported 
by the LC application. 

There is no arbitrary limit to the number of channels that can be acquired, for example: 

1. Simultaneously from a single detector (for example, absorbance output at different 
wavelengths). 

2. Simultaneously from multiple detectors on a single instrument. 

3. Simultaneously from multiple instruments. 
 

Acquisit ion via a Method 

In general, data acquisition is controlled by a sequence defining calibration standards and 
multiple samples. However, Chromera also supports a method only or single run mode of 
acquisition. This is described in the Single Run Mode. 

Acquisit ion Via a Sequence 

A sequence controls the acquisition and analysis of chromatographic data produced by a series 
of injections. Each row in the sequence contains, directly or by reference, all information 
relevant to the collection, processing and reporting of one sample. For further details refer to 
the Sequence section. 

Acquired Data Sets 

When data are acquired, a copy of the method used to control the acquisition is stored with the 
data. This copy will include all parts of the method; including peak detection and calibration 
replicate information for all channels, even if the data were acquired with the Suppress 
Processing flag set. That is, a copy of the complete method is stored with the batch entry even 
if no results were generated. 

When data are acquired via a sequence, a copy of the sequence row used to control the 
acquisition is stored with the data. Since one sequence row may result in several sample data 
sets, resulting from multiple injections, the data will also include the injection number. This 
information is available for examination by the user whenever a data set is viewed in the Post 
Run/Graphic Editing windows. 
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When data are acquired using Single Run mode (using a method but no sequence), the subset 
of sequence parameters entered prior to the injection is stored with the data, in place of the 
complete sequence row. 

Run Control 

You can control a run by the following: 

Extending an Analysis 

A means is provided to extend the time of an analysis quickly and conveniently, separately from 
direct modification of the active method within the Method Editor. When you determine that a 
longer run is needed to allow expected peaks to elute you may not have time to examine all 
sections of the instrument method to find all those places where times need to be increased. 
When a run is extended the software performs the task of sending the necessary commands to 
all instrument devices that operate on a time basis. The devices are held at their final conditions 
(where programming occurs) for the additional time period. 

Stopping an Analysis 

When an analysis is in progress the following functions are available: 

1. You can terminate data acquisition on all active channels and perform processing as 
specified. The raw data are stored as usual.  

2. You can terminate data acquisition on all active channels and discard the raw data 
acquired up to that point.  
In the case of acquisition controlled by a sequence, you have a secondary option as to 
whether the next run should be a repeat of the current run (same sample, same 
injection number) or if execution should continue with the next injection in the 
sequence.  

In both cases you are given two additional options: 

• Whether the instrument devices should be commanded to reset immediately to initial 
conditions or whether they should be left to stop according to the current method 
conditions.  

• Whether the next injection should be made as soon as the system comes ready or 
whether the sequence should pause until resumed by the user. (for instruments with a 
configured autosampler only) 
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Real-Time Plot 

The term real-time plot is defined as the graphical display of the signal(s) from the channel(s) 
of an instrument during an analytical run. Each instance of Chromera associated with an 
instrument will include a view where the real-time plot(s) for that instrument can be viewed.  

Function Description 

Presentation Real-time plots are displayed using the Plot control described in the Plot 
Control section. If multiple channels are to be plotted the user may select 
whether they should be displayed within the same plot control (overlaid), or 
in separate plot controls (the layout of which is controlled by the user), or a 
combination of the two. Within a single plot control all plots are displayed on 
the same time scale, whereas for separate plot controls different time 
segments could be displayed in the different controls. 

Signals Plotted You can select to plot one or more of the data channels provided by the 
instrument. This includes detector output channels and channels from other 
devices, such as pump pressure or solvent gradients. The signals are all time-
based and operating on the same basic time scale (although some channels 
may terminate before others). 

Scaling Any of the rescaling mechanisms provided by the plot control is available for 
a real-time plot. Real-time plot (and baseline monitor) also exhibit two 
additional scaling behaviors - one applied to the X axis and one to the Y-axis.  

Scrolling Scrolling (only during baseline monitor mode): The amount of time displayed 
across the plot remains the same and the percentage of scroll is fixed and 
not selectable by the user. 

Auto Offset This provides a simple mechanism to reset the Y axis minimum value so that 
the current signal level (assuming it is baseline, otherwise it’s not a good idea 
to do this) is displayed at approximately 5% of full scale. The Y-axis 
maximum is also adjusted so that the full scale span remains the same. 

Auto Zero A command is available when the real-time plot window is displayed to auto 
zero the detector itself - for those detectors that support this feature. 

Baseline Monitor 

It is possible to monitor the detector signals from an instrument graphically, outside the context 
of an analytical run. This allows you to examine the stability of the detector in terms of noise, 
drift, ghost peaks, etc. The following sections define the intended functionality of the monitoring 
feature, however, the limitations of the device being monitored may impose constraints that will 
prevent the full functionality being implemented for some detector devices. 

Baseline monitor differs from real-time plot in the following ways: 

• The baseline can be monitored at any time (except during a run). Run Time plot 
depends on data acquisition activity. 

• The time scale of baseline monitor is not constrained to the method run time (unless 
the instrument device imposes this) 

• No data are stored permanently from a baseline monitoring session since it is clearly 
impracticable to save an infinite amount of data for this purpose. Data are only 
persisted for the purpose of rescaling.  
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Baseline monitor will not specifically exclude the display of channels other than detector output 
signals but some other channels will not be of much value outside the context of an analytical 
run (e.g. solvent gradients).  

All features of real-time plot described in Signals Plotted to Auto Zero are shared by baseline 
monitor; real-time integration is not available. 

Access to Baseline Monitor 

Access to the baseline monitor function is from the Run Time environment.  

• For general LC, Baseline Monitor is an inherent feature of the Run Time environment and 
available in any run mode (Manual Control, Single Run, Sequence).  

• For the ICP-MS application, Baseline Monitor displays in the Manual Control mode only (see 
ICP-MS Controls).  

 

 

Control Description 

Method Name Displays the Method selected in Browse for Method.  

Browse for Method Click this button to open the Data Selector and select a Method created in 
Chromera. 

Start/Stop Click Start to download the method displayed in the Method Name box to the 
Mass Spec. A check for the Source will occur here, and if the method is 
incompatible with the installed source, an error message is displayed. As the 
method runs, the Start button changes to Stop. When the method has finished 
or Stop has been clicked. The Start button appears again. 
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How to Use Run Time Graphics 

This section describes the how real-time plotting works. 

Run Time Plot Chart 

Only a single chart is displayed within the graphics frame of the Run Time environment. All 
active channels will be plotting in overlay fashion on the single chart. Each curve will be plotted 
in a different color, based on the settings in Plot Styles. 

 
 

 
 
Run Time plot with one active channel 

The default behavior of curves for the Y axis is to be autoscaled on the chart. In Manual Control 
mode the default timescale will be 5 minutes; in Single Run or Sequence mode the default time 
scale will be the set run time. Baseline monitoring mode (in Manual Control or other modes 
outside a run) will also exhibit a scrolling time scale by default. When the plotted curves fill the 
time span across the screen, the time scale will be reset so the start and end times are both 
increased by 10%.  

You are free to rescale the chart manually, using the Rescale Axes command. This action will 
disable the automatic rescaling of the chart, until the start of the next run.  
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Plots Tree 

The Plots tree will always contain a single top-level node (Plot 1) corresponding to the single 
chart. At the second level of the tree there is a node for each independent Y axis required, 
depending on the instrument configuration. The following table indicates the possible entries at 
this level of the tree. 

Configured (and Active) Device Y-Axis Node 

UV/Vis Detector  Absorbance (mAU) 

Refractive Index Detector Refractive Index (µRIU) 

Fluorescence Detector  Fluorescence (mFLU) 

Pump  Pump Pressure (psi) [or other units as 
defined in Preferences] 

Column Oven Temperature (°C) 

ICP-MS Intensity (cps) 

 

NOTE:  A device marked not In Use for the set up method is inactive and hence its channel(s) will not 
appear in the plot tree. 

Below each Y axis node, at the third level of the tree, will be each channel that is associated 
with that Y axis node.  

 

This example shows three devices, each with one active 
channel having different Y axis units.  

The UV/Vis detector (user name: Series 200UV) has an 
active channel named “UV-Vis1.” 

The Refractive Index detector (user name: Series 200aRI) 
has an active channel named “RI1.” 

The LC pump (user name: Quat) has an active pressure 
channel, which always has the name “Pump Pressure.” 

Detector channels will always appear first in the tree, 
followed by the subsidiary channels (pump pressure, oven 
temperature). 

 

The top Y axis node is the primary axis, which appears at the left hand side of the chart. All 
other axes will appear on the right, in the order in which they appear in the tree, as shown 
below: 
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The chart from the plot tree shown above with Absorbance as the primary Y axis 

You can change the order of items in the plot tree, to make the required curve occupy the 
primary axis, if this is not the default case. 

Run Time Chart Popup Menu 

The popup menu available on the chart within run time will be a subset of the menu available in 
Post Run.  

 
 
Command Description 

Expand All Fully expands the tree to show all channels under all Y axis nodes. 

Collapse All Collapses all lower levels so that only the ‘Plot 1’ node is shown 

Move Up Moves the selected (clicked on) Y axis node up one position in the plot tree. 
The chart will be redrawn to reflect the change in Y axis order. Disabled on 
any node other than a Y axis node. 

Move 
Down 

 Moves the selected (clicked on) Y axis node down one position in the plot 
tree. The chart will be redrawn to reflect the change in Y axis order. Disabled 
on any node other than a Y axis node. 
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Manual Control 

There are numerous possibilities for actions performed in this environment. It is designed to 
allow you a close and immediate degree of control over the instrument devices, for preparation 
or diagnostic purposes. A typical series of actions, for an instrument consisting of pump, 
detector(s), autosampler and column oven, is outlined here. 

To prepare the instrument for use from shutdown: 

• Set purge conditions and purge the pump 

• Set analytical pump initial solvent composition and flow conditions, to begin system 
equilibration 

• Set column oven temperature 

• Set Peltier tray temperature (if required) 

• Turn detector lamp on (if required) 

• Set conditions and flush autosampler 

• Monitor instrument status and detector signal(s) to assess instrument readiness  
(for the PDA: monitor instrument status and column equilibration via the PDA contour 
map to assess instrument readiness) 

The content of the parameter frame in manual control mode depends on the currently 
connected devices configured on the instrument. For a pump module there are two bands: 
Pump Settings and Purge Pump. In general, each other device has a single band, but if the 
Autosampler has a Peltier Tray installed a separate band displays for this. Similarly the Peltier 
tray band displays for models of the Flexar or Series 225/275 Autosampler that are equipped 
with heating and/or cooling.  

 

When the view is displayed each band is populated with the settings currently set in that device 
(with the exception of the Purge Pump settings, which is those last set for the current 
instrument). Any changes to the displayed values are only downloaded to the instrument device 
when the associated button is clicked. 

When you leave the Manual Control environment, the instrument remains at the conditions last 
set in Manual Control until these are changed by means of a single run or sequence setup. 
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The parameter bands displayed for each device are summarized in the tables below. 

1. Addition of a Number of Flush Cycles parameter to the Flush Autosampler band. This 
determines how many flush cycles are performed when the user clicks the Flush button.  

2. For consistency with other devices, Apply is used for buttons associated with 
Autosampler, Oven, and Peltier tray. (The autosampler flush is a rather different action 
and hence merits a different command.) 

There are manual controls for the ICP-MS. These provide access to the Baseline Monitor facility 
that previously occupied a separate window. 

Pump Controls 

The following pump controls are available: 

Control  Description 
Flow Rate (mL/min) Flow rate of the LC mobile phase. 

%A( ), %B( ), %C( ), 
%D( ) 

Percentage for solvents A, B, C and D in the mobile 
phase. Any assigned solvent name will appear in  the 
parentheses. 
A, B, C and D for quaternary pump. A, B for binary pump. 
A (always 100%) for isocratic pump. 

Apply Start the pump (if not already running) and apply 
displayed settings. 

 

NOTE:  The solvent names displayed by default in Manual Control will always be those from the 
instrument preferences.  For your convenience it is also possible to edit the names from within 
Manual Control (via a context menu that displays the solvent dictionary). 

Purge Pump 

Control  Description 
Flow Rate (mL/min) Flow rate of the LC mobile phase during purging. 

%A( ), %B( ), %C( ), %D( ) Checked box indicates the solvent to use for purging. 
These check boxes actually act like radio buttons 
since only one can be selected. 
A, B, C and D for quaternary pump. A, B for binary 
pump. A (always 100%) for isocratic pump. 

Apply Start the pump (if not already running) and apply 
displayed settings. 
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Detector Controls 
The following detector controls are available: 

PDA Detector 

Control  Description 
Wavelength (nm) Wavelength of the single (chromatographic) channel to be 

extracted from the spectra and displayed in real 
time.  (Only a single pixel will be monitored and there is 
therefore no bandwidth or reference wavelength 
parameters required here.) (Range 190 – 700nm in 1nm 
steps.  The system will select the nearest pixel to the 
selected wavelength.) 

Sampling Rate (pts/s) 
or Peak Width (s) 

The data acquisition rate for the detector (0.2, 0.5, 1, 2, 5, 
10, 20, 50 samples/second). A user preference setting will 
determine which of these is displayed (see Method: PDA 
Detector).  

Apply Turns the lamp on (if not already on) and applies the 
displayed settings. 

UV/ Vis Detector 

Control  Description 
Wavelength (nm) Wavelength to be monitored for signal output. 

Sampling Rate (pts/s) 
or Peak Width (s) 

The data acquisition rate for the detector. A user preference 
setting will determine which of these is displayed (see 
Method: Series 200 UV/Vis Detector).  

Apply Turns the lamp on (if not already on) and applies the 
displayed settings. 

Fluorescence Detector 

Control  Description 
Excitation Wavelength (nm) Excitation wavelength to be set. 

Emission Wavelength (nm) Wavelength to be monitored for signal output. 

Slit Width Emission Bandwidth value 

Sensitivity PMT Voltage parameter 

Sampling Rate (pts/s The data acquisition rate for the detector  

Apply Turns the lamp on (if not already on) and applies the 
displayed settings 

Refractive Index Detector 

Control  Description 
Temperature (°C) Temperature to be set for the RI cell. 

Sensitivity (µRIU/V) Detector sensitivity/dynamic range. 
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Polarity Polarity of the signal. 

Sampling Rate (pts/s) The data acquisition rate for the detector. 

Turn On Purge   Click to change to Turn on Purge. 

Apply Applies the displayed settings. 

Autosampler Controls 

The following autosampler controls are available: 

Flush Autosampler 

Control  Description 
Flush Volume Volume of solvent to be used to flush the autosampler. 

Number of Flush Cycles Number of times the flush operation is to be performed. 
(Range: 1 to 9) 

Apply Initiates the defined flush operation 

Peltier Tray 

Control  Description 
Temperature Sets the temperature for the Peltier tray 

Apply Updates the Peltier tray with the new temperature setting 

Oven Controls 

The following oven controls are available: 

Control  Description 
Temperature Sets the temperature for the column oven 

Apply Updates the oven with the new temperature setting 

 

ICP-MS Controls 

The following ICP-MS controls are available: 

Control  Description 
Method Specifies the method to be used for control of the ICP-MS during 

baseline monitoring. The method can be selected by clicking on the 
button in the grid cell. 

Start Baseline 
Monitoring 

Initiates plotting of the ICP-MS signal in the run time graphics frame. 
When monitoring is in progress the button changes to Stop Baseline 
Monitoring. 

Stop Baseline 
Monitoring 

Terminates plotting of the ICP-MS signal and returns the ICP-MS to 
idle state. 
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Manual Injection 

If no autosampler is configured on the instrument then the Inject toolbar button does not 
appear. Instead, when the instrument attains the Ready state, a notification is displayed at the 
bottom right of the screen. 

 

The notification remains displayed until either: 

• You explicitly close the notification window 

• You make an injection and start the run. Once Chromera detects the run start the 
notification is removed. 

NOTE: The instrument does not have to be in the Ready state in order for a manual injection to be 
recognized. Once the software indicates that an Active method is present an injection can be 
made and acquisition will occur. 

The notification message display is enabled by default for a manual injection system but it may 
be disabled within User Preferences. 

Run Time Manual Control Standard Toolbar 

In this mode the toolbar contains only two buttons: Exit and Help Topics. 

 

Or when user authentication active: 

 
 

Icon Command 

 File/Lock (Only when user authentication active) 

 File/Exit 

 Help/Topics 
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About the Single Run Mode 

The Single Run mode allows you to define the sample to be a run using single sequence row 
parameters (including sample name, vial number and method) and then initiate the single injection. 
Calibration cannot be performed automatically from this mode but if the specified method is 
already calibrated it is possible to obtain a quantitative report. This mode is intended primarily for 
instrument method development. 

Parameters to identify the session are: 

• Batch name 

• Description 

• Group 

NOTE:  The Tray Type setting is also included with the above parameters, if an autosampler is 
configured. 

Parameters available to identify and control the sample run are: 

• Method (this will not be present as a specific parameter field; the method itself is 
displayed)  

• Sample Name 

• Vial Number 

•  Sample Description 

• Internal Standard Amounts 

• Sample Amount 

• Dilution Factor 

• Normalization Factor 

Decision Points available are: 

• Peak Detection Review 

• Calibration Review 

• Data Review 

• Report  

• Shutdown (Wash sample type only – this is the only available decision point for Wash rows) 

The options to suppress processing and/or reporting will also be available in this mode. 

The data sets acquired during a single run mode session are associated together in a manner 
similar to that of a standard batch acquired via a sequence. The session is uniquely identified by 
the name you entered. The session is also identified with the instrument name and time and 
date of the most recent acquisition. 

A single run mode session continues until a new session is started (by entry of a new batch 
name) or a sequence is set up on the instrument. 
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Run Time - Single Run 

When selecting the Single Run mode the parameter display area displays either run parameters 
or the open method, depending on which is selected via the toolbar. When Chromera is run, by 
default, the last method open in this environment is opened but not activated (i.e. not 
downloaded to the instrument). 

 

Single Run Mode - Run Parameters 

The run parameters are a subset of the sequence parameters. The following indicates which 
parameters are displayed and in what order. Note that the Batch Parameters are exact 
equivalents for the same parameters at the top of a sequence. Data acquired in the Single Run 
mode session is stored under this batch. This information is recalled the next time you select 
Single Run mode on the instrument, so that data can be added to the batch if desired. This 
behavior is distinct from that of a standard batch. 

Band 1 – Batch Parameters 

Name 
Description 
Group 
Sample Tray Type 

Band 2 - Sample Parameters 

The sample parameters will be handled in Single Run mode in exactly the same way 
as in Sequence. That is, the parameters to be displayed in columns can be selected by 
the user and the remaining parameters will be accessible via the drop-down Details 
field. The main difference is that in Single Run mode only a single row can be defined. 

Band 4 - Decision Points 

The Decision Points band will behave exactly as in the Sequence Editor. 
 

NOTE:  The values of the run parameters are saved with the data set at the end of the run, prior to 
processing and decision points. This means that you can change any parameter value during 
the run and it will be saved with the data set.  

Single Run Mode - Method 

The method display and editing facilities in the Run Time environment will not simply be a 
mirror of the Method Editor environment; it is possible for the two to contain different methods. 
It is possible to display the active method in the main Method Editor environment but it will not 
occur by default.  
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When a method is opened in the Run Time method frame it will not automatically become the 
active method; you must click the Apply button to have the method parameters downloaded to 
the devices and activated. Similarly if you edit the method in the Run Time window, those 
changes are not downloaded to the instrument until the Apply button is clicked. Since the 
displayed method may represent neither the method currently controlling the instrument nor the 
version of that method as it exists in the database, a clear indication of the method status is 
essential. For a complete discussion of Run Time method states see Run Time Method States. 
This status is shown in the title bar at the top of the grid frame, as described below. 

Single Run Mode - Title Bar 

Not only does the title bar at the top of the grid frame indicate that Single Run mode is selected 
but it also serves to convey status information concerning the method. 

The basic format of the title bar contents are: 

[No] Method ([<edit status> - ] <download status>) : <method name>  

• The initial No will appear only in the message No Method, when there is no method 
loaded. This will only occur when the system is first started after installation or when 
the last method opened in the previous session is no longer present in the database (or 
no longer matches the current instrument configuration). 

• <edit status> indicates the current state of the method displayed relative to the 
database copy. Currently the only edit status defined is ‘Modified’. The edit status (and 
the following hyphen) will not appear if the method displayed is the same as the version 
in the database. 

• <download status> indicates whether or not the displayed method is being used to 
control the instrument devices. Values are Active and Not Active. 

• <method name> is the name of the displayed method  

The following five examples illustrate the contents of the title bar under various conditions: 

1. First access or last used method not found or not valid 

 

2. Method open but not downloaded to instrument 

 

3. Method downloaded and controlling instrument 

 

4. Displayed method has been edited but not downloaded 

 

5.  Method has been edited and downloaded to instrument 
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Run Time Single Run Mode Standard Toolbar 

This toolbar displays in the Single Run mode: 

 

Or when user authentication active: 

 
 

Icon Command 

 File/New Method 

 File/Open Method 

 File/Save Method 

 File/Save Method As 

 File/Print Preview Method 

 File/Print Method 

 File/Lock (Only when user authentication active) 

 File/Exit 

 Help/Topics 
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Single Run Mode - Toolbar 

 
 

Icon Command Description 

 
 

 

Inject Issues a command to the autosampler to inject the specified 
volume from the currently specified vial. Disabled when there is 
no active method or when the autosampler is not ready. 

NOTE: It is not required for the pump to be ready or the 
detector to be ready for this command to be enabled. 

NOTE: This button will not appear if there is no autosampler 
configured on the instrument. See Manual Injection below. 

   Run Options Displays a dialog enabling you to disable processing or disable 
generation of reports. See Run Options dialog for further 
details. 

 

 
End Run Displays a dialog enabling you to confirm the run is to be 

stopped and providing options associated with stopping the 
run. See End Run dialog for further details. End Run is only 
enabled when a run is in progress. 

 

 
Extend Run Displays a dialog enabling you to confirm the run is to be 

extended (or cancel the command) and to specify the length of 
time for which the run is to be extended. See Extend Run 
dialog for further details. Only enabled when a run is in 
progress on an LC-only instrument. It is always disabled for an 
ICP-MS instrument. 

 Run Parameters Displays the run parameters. 

 Method Displays the method parameters in the grid frame. Enabled 
when a method is open. 

Apply Activate Method Downloads the method parameters to the instrument devices 
and activates them. 

This button is disabled when the displayed method is identical 
to the active method. (For example, immediately after the 
method has been downloaded.) 

Restore 
Active 

Restore Active 
Method 

Replaces the displayed method with the method currently active 
in the instrument. 

This button will only be visible when the displayed method is 
different from the active method (either because another 
method has been opened or the method has been modified). 
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Manual Injection 

If no autosampler is configured on the instrument then the Inject toolbar button does not 
appear. Instead, when the instrument attains the Ready state, a notification is displayed at the 
bottom right of the screen. 

 

The notification remains displayed until either: 

• You explicitly close the notification window 

• You make an injection and starts the run. Once Chromera detects the run start the 
notification is removed. 

NOTE:  It is not required that the instrument be in the Ready state in order for a manual injection to be 
recognized. Once the software indicates that an Active method is present an injection can be 
made and acquisition will occur. 

The notification message display is enabled by default for a manual injection system but it may 
be disabled within User Preferences. 

Using the Single Run Mode 

Prior to using Single Run mode first prepare the instrument using the Manual Control mode. 
To perform a typical single run analysis: 

1. Select Single Run mode from the radio buttons in the upper panel of the navigation 
bar. 

2. Choose the method to be run from the selector dialog displayed when the Open 
Method button is clicked.  

3. Review the method as required by selecting devices or sections of interest from the 
method tree in the lower panel of the navigation bar. 

4. Make changes to the method as desired (optionally saving the method back to the 
database). 

5. Enter sample identification and other run parameters (including decision points) as 
required. 

6. Click Apply to download the method to the instrument devices. 

7. Review the status display and baseline monitor plot(s) to determine when the 
instrument is ready for the analysis. 

8. Click the Inject button (to initiate an injection from the configured autosampler) or 
make a manual injection. 
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9. Review the chromatogram(s) displayed in the real-time plot frame. 

10. Make adjustment to the run time (extend or stop early) if required. 

11. At the end of the run, review data in Peak Detection decision point (if specified) or 
Post Run environment, as required. 
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About Run Time Sequence 

The sequence in this environment is independent of that in the Sequence Editor. The only 
interaction is that a sequence open in Run Time cannot be saved under its existing name in the 
Sequence Editor (Save As is still available). 

This frame is basically a mirror of the display in the Sequence Editor. Any changes made here 
are reflected in the main Sequence Editor window and vice versa. Similarly when the sequence 
is running the currently executing row is highlighted in both views, and rows that are set read-
only (because they have been executed or are currently executing) cannot be edited in either 
view. 

Selecting the Sequence mode displays either the sequence or the method (from currently 
selected row), depending on which is selected via the toolbar. When Chromera is run, by default 
the last sequence open in this environment is opened but not activated (i.e. no method 
parameters from the sequence are automatically downloaded to the instrument). 

 

Sequence mode with sequence displayed 

NOTE: The Editing Tools fly-out tool panel appears in this environment just as it does in the main 
Sequence Editor. 
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Sequence mode with method from selected row displayed 

Run Time Main Menu Commands - Sequence Mode 

The table below displays the commands available in Sequence mode. These commands are in 
addition to those described in Common Menus. 

Menu Command Description 

File 

 

New Sequence If the current sequence has been modified then you are 
first asked if it should be saved then it displays a new 
default sequence. The sequence configuration is that of 
the connected instrument. It is disabled in an when a 
sequence is running, otherwise it is enabled. 

 Open Sequence … Open Sequence is disabled when the sequence is 
running or paused. If the current sequence has been 
modified then you are first be asked if it should be 
saved. It displays the data selector in single sequence 
selection mode. Selecting a sequence displays it. 

 Save Sequence Save Sequence is enabled when a sequence is 
displayed. It saves the current sequence, replacing the 
existing version.  

 Import Sample List ... Opens the Import Sample List Wizard so you can import 
a sample list into a sequence. 

 Save Method Save method is enabled when a method is displayed. It 
saves the current method, replacing the existing stored 
version. 
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 Print Preview ►  
Method ... 

 

Enabled when a sequence is open. When a method is 
displayed that will be the method printed or previewed. 
When the sequence is displayed, the method printed or 
previewed will be that from the selected row or the first 
row, if no row is currently selected. Displays the Print 
Method dialog . The method prints after you have 
selected the required options in the Print Method 
dialog. 

  Sequence ... Enabled when a sequence is opened. It displays the 
Print Sequence dialog. The sequence prints after 
selecting the required options in the Print Sequence 
dialog. 

 Print ► Method … 

 

 

           Sequence ... 

Enabled only when the Method is actually displayed in 
Sequence mode. Displays the Print Method dialog . The 
method prints after you have selected the required 
options in the Print Method dialog. 

Enabled when a sequence is displayed. Displays the 
Print Sequence dialog. The sequence prints after 
selecting the required options in the Print Sequence 
dialog. 

 Lock Only displayed when user authentication/tracking is 
active. It minimizes the Chromera window to the 
taskbar. Before the window can be restored the valid 
password for the associated user must be entered. 

 Exit If a single run is in progress or a sequence is running 
then you are prompted that the instrument must be in 
an idle state before the application can be closed. If the 
instrument is not active then if any unsaved data exists 
in any environment the software will ask the user if it is 
to be saved before exit. 

Display Rescale Displays the Rescale Axes dialog. 

 Auto Rescale Redraws the contents of the active plot frame at default 
scaling. 

 Auto Offset Applies to real-time plots only. It redraws the contents 
of the active plot frame to reset the Y axis minimum 
value so that the current signal level is displayed at 
approximately 5% of full scale. The Y axis maximum is 
also adjusted so that the full scale span remains the 
same. 

 Plot Styles Displays the Plot Styles dialog. 

 Plot Layout Displays the Run Time version of the Plot Layout dialog. 

Displayed in Sequence mode only.   

Displayed in Sequence mode only.   
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Actions Run Options Displays the Run Options dialog appropriate to the 
current mode (see Run options). It is disabled in 
Manual Control mode. 

 Set as Start Row Enabled when the sequence is idle (or Paused) and a 
row is selected in the sequence. Sets the selected row 
as the first row to be run when the sequence is started. 

 Set as End Row Enabled when the sequence is idle (or Paused) and a 
row is selected in the sequence. Sets the selected row 
as the last row to be run when the sequence is started. 

 Start Sequence Enabled when a sequence is open. Initiates the 
sequence run. The Start button also acts to restart the 
sequence from the Paused state. 

 Pause Sequence Enabled when a sequence is running. Inhibits the next 
injection when the current run (if any) is complete. 
Subsequent use of the Start Sequence command 
would (by default) cause the sequence to resume 
running with the next injection. 

 Stop Sequence Enabled when a sequence is running. Inhibits the next 
injection when the current run (if any) is complete. 
Subsequent use of the Start Sequence command 
would (by default) cause the sequence to begin running 
from the Start Row. 

 End Run Enabled when a run is in progress. It displays the End 
Run dialog. 

 Extend Run Time Enabled when a run is in progress on an LC-only 
instrument. It is always disabled for an ICP-MS 
instrument. It displays the Extend Run Time dialog. 

Sequence Mode - Validity Checks 

When a sequence is opened, several checks must be performed. These include: 

• That the sequence is compatible with the instrument. This means, for example, if the 
sequence specifies a Mega Sample Tray that the instrument has configured and it is 
not a PerkinElmer Series 200 Autosampler.  If a different tray is installed a message 
displays indicating that the sequence cannot be run with a tray different from the one 
specified in the sequence. 

• If the sequence includes any vial positions set to NONE (see Vial Entry validation) a 
message displays indicating that the sequence cannot be run until these rows are 
updated with valid vial positions or deleted. 

• Method incompatibility will only be checked when the method is to be downloaded – so 
only the first method will be checked when the Sequence is run. If an incompatibility is 
found, that sequence row will be skipped and a message will be added to the error log.  
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Sequence Mode - Method 

The method displayed is equivalent to the method display in Single Run mode but with the 
difference that a method can be selected for display only by selecting a row in the sequence. 
You can access a stored method by selecting an accessible row in the sequence, and then 
clicking the Method button, or the active method by selecting the currently executing row (i.e. 
when the sequence is running) and then clicking Method.  

 

A modification to the active method will only take effect when you click the Apply button. This 
change will remain in effect for the run in progress (where applicable) and for all remaining runs 
from the currently executing row. For the change to be retained for subsequent rows (assuming 
they reference the same method) you must save the method.  

A change to any method from a row yet to be executed will only take effect if you save the 
method, since the method is not read from the database until the row becomes the currently 
executing row. 

NOTE: You can only access and modify one active copy of the method and one stored copy. The active 
method is accessed by selecting the currently executing row; the stored method by selecting 
any other row (that references the same method). 

Sequence Mode - Title Bar 

Not only does the title bar at the top of the display frame indicate that Sequence mode is 
selected but it also serves to convey status information concerning the sequence and the 
method from the current (or pending current) row. The basic format of the title bar contents 
depends on the current data set displayed.  

When the sequence is displayed the format is: 

[No] Sequence ([<edit status> ]) : <sequence name>  

• The initial No appears only in the message “No Sequence”, when there is no sequence 
loaded. This will only occur when the system is first started after installation or when 
the last sequence opened in the previous session is no longer present in the database. 
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• <edit status> indicates the current state of the sequence displayed relative to the 
database copy. Currently the only edit status defined is ‘Modified’. The edit status does 
not appear if the sequence displayed is the same as the version in the database. 

• <sequence name> is the name of the displayed sequence 

Note that the sequence run status is included in the title bar even though it is also indicated by 
the highlighting of the currently executing row (in green). This is because there is less space for 
display of the sequence in the Run Time environment and it is possible that the user may have 
scrolled the display, thereby concealing the currently executing row. Also, the currently 
executing row will not be visible when the Method display mode is selected. 

When the method is displayed the format is: 

[No] Sequence ([<edit status> - ]<run status>) : <sequence name> / Method ([<edit 
status> - ]<download status>) : <method name>  

The added method information is essentially the same as described for Single Run mode, except 
that the ‘No Method’ case cannot occur. When there is no sequence displayed the Method 
toolbar button is disabled so the method grid cannot be displayed. 

The following examples illustrate the title bars under various conditions: 

1. Sequence open but not running 

 

2. Sequence running; method active and displayed 

 

3. Sequence paused; method active and displayed 

 

4. Sequence modified; method displayed, not active 

 

5. Sequence modified; method active and displayed 
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Sequence Mode - Parameter Display 

When the sequence is Idle you can select any row and it is highlighted in the standard way. 

 

When the sequence is Running, the currently executing row is indicated by being highlighted by 
turning the background color for all cells in the row to green (note that the text color does not 
change to white as occurs with standard Windows highlighting).  

 

If the sequence is Paused, the Start Row is updated and hence all rows completed are displayed 
with a gray background (see Setting Start and Stop Rows for details of setting Start and Stop 
rows). The resume point in the sequence (by default) is the next row shown with a white 
background. 
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You can reset the Start Row to a different row if desired and this would update the display to 
indicate the new resume point.  

Run Time Sequence Mode Standard Toolbar 

In this mode the Standard toolbar contains buttons to access commands for both sequence and 
method actions. 

 

Or when user authentication active: 

 
 

Icon Command 

 File/New Sequence 

 File/Open Sequence 

 File/Save Sequence 

 File/Save Method 

 File/Print Preview ► Method 
                             Sequence 

 File/Print ► Method 
                 Sequence 

 File/Lock (Only when user authentication active) 

 File/Exit 

 Help/Topics 
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Sequence Mode - Toolbar 

The toolbar in the Run Time sequence mode contains the following commands: 

 

Icon Command Description 

 Start Sequence Begins execution of the sequence from the specified row. You 
can also use the Start button to restart the sequence from the 
Paused state.  

 

  

Pause Sequence Does not begin the next run after the current run (if any) is 
completed. 

NOTE: If the sequence is paused the new default Start Row 
becomes the next row after the one completed before the 
pause takes effect (see Setting Start and Stop Rows). 

 Stop Sequence Terminates a running sequence when the current run (if any) 
is completed. 

 Start Row Sets the currently selected row as the staring row when the 
sequence is started (or restarted). Start Row is disabled when 
the sequence is running or when no row is selected. See 
Setting Start and Stop Rows. 

 Stop Row Sets the currently selected row as the ending row when the 
sequence is started (or restarted). Disabled when the 
sequence is running or when no row is selected. See Setting 
Start and Stop Rows. 

 

 

Run Options Displays a dialog enabling you to select starting and ending 
rows for running (or resuming) the sequence, or to disable 
processing or disable generation of reports. See Run Options 
for further details. 

NOTE: Changing starting and ending rows will have no 
immediate effect if the sequence is running. 

   End Run Displays a dialog enabling the user to confirm the run is to be 
stopped and providing options associated with stopping the 
run. See End Run for further details. 

 

 

Extend Run Displays a dialog enabling you to confirm the run is to be 
extended and to specify the length of time for which the run 
is to be extended. It is only enabled when a run is in progress 
on an LC-only instrument and always disabled for an ICP-MS 
instrument. See Extend Run for further details. 

 Sequence Displays the sequence. 

 Method Displays the method parameters. 
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Apply Activate Method Downloads the method parameters to the instrument devices 
and activates them. This button is only visible when the 
method page is selected (or always disabled when the 
sequence page is selected). 

This button is disabled when the displayed method is identical 
to the active method. (For example, immediately after the 
method has been downloaded.)  

Before the sequence is started the Apply button will be active 
when the starting row (Whether this is row 1 or another row) 
is selected. In this way you can download the initial method 
prior to starting the sequence, and monitor its stability at the 
set conditions. 

When the sequence is running the Apply button is disabled 
when the displayed method is not the active method (that is, 
when a method from a row other than the active row is being 
viewed). 

Sequence Mode - Autosampler Tray Change 

After changing an autosampler tray a validation is performed. Different actions will occur 
depending on whether the sequence is running or idle (not running or paused). 

Sequence Idle 

If a different tray from that specified in the sequence is replaced in the autosampler an error 
message will be displayed immediately warning that the sequence cannot be run with the 
installed tray. If you attempt to start the sequence (before fixing the problem) the same 
message will be displayed again and the sequence will remain idle. 

If you do not install a new tray but leave the autosampler empty, any attempt to start the 
sequence will cause an error message to be displayed warning that the sequence cannot be run 
until the correct tray is installed. 

Sequence Running 

If a different tray from that specified in the sequence is replaced in the autosampler an error 
message will be displayed immediately warning that the sequence cannot be run with the 
installed tray. The sequence will be paused.  If you attempt to restart the sequence (before 
rectifying the problem) the same message will be displayed again and the sequence will remain 
idle. 

If you do not install a new tray but leave the autosampler empty, no error will appear until the 
system is ready to perform the next injection (since the user could replace the tray at any time 
prior to that, which should not trigger an error), at which time an error message will be 
displayed warning that the sequence cannot continue until the correct tray is installed. The 
sequence will be paused.  If you attempt to restart the sequence (before rectifying the problem) 
the same message will be displayed again and the sequence will remain idle. 
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Setting Start and Stop Rows 

The Start Row  and Stop Row  toolbar buttons are enabled when a row is selected in 
the sequence (and the sequence is not running).  

Clicking on the Start Row  button causes all rows in the sequence prior to that row to be 
shown as inactive; that is, with a cell background color of medium gray. 

Similarly, if the Stop Row button is clicked then all rows following that row to the end of the 
sequence is marked as inactive. 

Marking a row inactive does not prevent it being selected, so that the Start and Stop rows can 
easily be redefined. However, a Start Row cannot be set if it conflicts with an existing Stop Row, 
or vice versa. If you attempt to set a Stop Row earlier than the current Start Row then an error 
message is displayed (Stop Row must be later than the Start Row). Similarly, if you attempt to 
set a Start Row later than the current Stop Row then an error message is displayed (Start Row 
must be earlier than the Stop Row). 

NOTE: When a sequence is paused the Start Row is automatically updated to the row following the last 
one completed before the pause takes effect. In this way the Run command will, by default, 
resume the sequence from the next row.  However, the user is able to change the default Start 
row to some other row and hence change execution of the sequence. 

Using the Sequence Mode 

Prior to using Sequence mode first prepare the instrument as required using Manual Control 
mode. To analyze a set of samples in the run time Sequence mode: 

1. Select Sequence mode from the radio buttons in the upper panel of the navigation bar. 

2. Choose the sequence to be run from the selector dialog displayed when the Open 
Sequence button is clicked 

3. Review the sequence and make any required changes (optionally saving the sequence 
back to the database) 

4. Review the method(s) specified in the sequence, make any required changes and save 
the method(s) 

5. If the sequence is not be run in its entirety, set starting and sending rows 

6. Review the status display and baseline monitor plot(s) to determine when the 
instrument is ready to begin analysis 

7. Click the Start button to initiate sequence execution (If manual injection, make the 
injection when prompted) 

8. Review the chromatogram(s) displayed in the real-time plot frame 

9. If Peak Detection or Calibration decision points are specified, review and take action as 
required 

When the sequence is complete, review results in the Post Run environment, as required. 
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End Run Dialog 

This dialog is displayed when the End Run command is chosen in Single Run or Sequence 
mode, via either the toolbar button or menu item. There are two versions of the dialog; one for 
Single Run mode and one for Sequence mode. The Single Run mode version is a simple subset 
of the Sequence version. 

 
Single Run mode End Run dialog  

 
Sequence mode End Run dialog 

 

 

Controls Description 

Data Acquisition Radio buttons to select whether the data acquired from the 
run in progress is saved or discarded. If the data are 
discarded then no batch entry will exist for the run. 

Instrument Control Radio buttons to select whether the other instrument 
modules (i.e. other than detectors) are left to complete the 
run or are immediately reset to initial conditions. 

Sequence Options Radio buttons to select whether the current run is repeated 
or if sequence execution will continue with the next logical 
run. If the current run is the final injection for a sample then 
the Continue with next injection option will cause the 
next sample to be injected. 

Restart Options Radio buttons to select whether the next run will begin 
automatically or whether the system will pause until you give 
a  command. 
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Extend Run Dialog 

The Extend Run Time dialog is displayed when the Extend Run command is chosen in Single 
Run or Sequence mode, via either the toolbar button or menu item. The dialog is identical in 
both modes. 

 
 

Controls Description 

Extend run by (minutes) Enter the amount by which the run time is 
extended (from 0 to 120.0 minutes).   

Note that this is not the new run time but the 
length by which the run is extended. 

Do not extend data 
acquisition 

A check box to set whether or not the data 
acquisition is extended as well as the 
instrument run time. 

Current run time 
(minutes) 

This display indicates the current run time. This 
is generally the pump run time. 

 

The high-level mechanism (i.e., the way the active method is changed) for extending the run 
time for the various devices are: 

Pumps                Extend the time of the final step (this has been determined to be possible for 
the PerkinElmer pumps). 

LC Detectors      Extend the time of the final step or add a new final step as required (and 
hence increase End Time) – unless acquisition not extended 

If the instrument includes a device for which extending the run is impossible then the Extend 
Run command is disabled. 
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Run Options Dialog 

This dialog is displayed when the Run Options command is chosen in Single Run or 
Sequence mode, via either the toolbar button or menu item. There are two version of the 
dialog; one for Single Run mode and one for Sequence mode. The Single Run mode version is a 
simple subset of the Sequence version. 

 
Run Options dialog in Single Run mode 

 
Run Options dialog in Sequence mode 

 
 

Controls Description 

Starting row Enter a number to set the first row in the sequence The 
starting row must be less than the ending row. If it is not 
then the OK button is disabled. This setting does not appear 
in Single Run mode. 

Ending row Enter a number to set the last row in sequence. The ending 
row must be greater than the starting row. If it is not then 
the OK button is disabled. This setting does not appear in 
Single Run mode. 

Suppress processing A check box to set whether or not data acquired during the 
run is automatically processed at the end of the run. If 
Suppress proceeding is checked then Suppress reports 
is disabled, since the option is not available unless 
processing will occur.  

Suppress reports A check box to set whether or not any reports specified for 
the injection (via the global sequence parameter or via a 
Report decision point) is generated.  This is disabled if 
Suppress proceeding is checked. 

 





 

 

Post Run 
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About the Post Run Environment 

The Post Run environment is where you review stored data. The examination of 
chromatograms, peak integration, and results are all performed here. You enter the Post Run 
environment by clicking the Post Run button in the Navigation Pane (or selecting the Post 
Run command from the View menu or clicking the Post Run toolbar button).  

The Post Run environment is designed so that you can review all aspects of acquired data in 
a convenient and efficient manner. You are able to select between various views, each of 
which is designed to provide optimal display of a specific type of data set. In particular, you 
can configure the chromatogram display to accommodate the flexibility of instrument 
configurations supported by Chromera. 

 

NOTE: The relative sizes of two frames can be changed by dragging the splitter bar between them or 
double-clicking in the title bar of one of the frames toggles between a maximized and restored views. 

The basic concepts in matching the display environment to Chromera data are outlined in Display 
Data Sets.  

The navigation pane is divided into two sections, a Views tree and a Data tree. By default the 
main area contains two frames: a graphics frame and a parameter frame. The basic format of 
the graphics frame depends on the selection made in the tree control located in the upper 
section of the navigation pane. The parameters frame displays results but the exact format will 
depend on user preferences.  

The graphics frame in Post Run is configurable such that you can define a view port into a virtual 
display of columns and rows, with each cell containing a chromatogram. If the view port is only a 
subset of the full display then scroll bars are displayed in the frame as appropriate (i.e. vertical 
and/or horizontal.) To provide ease of use several predefined views are provided but you have a 
degree of flexibility to adjust these views to your needs. 

Interactions between the various components of the Post Run environment are described 
below (see Interactions in the Post Run Environment). 
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Main Menu Commands 

The commands shown in the table below are those for a Post Run display mode. 

Menu Command Description 

File Open Data… Replaces all existing data in the data tree with new 
data. 

Displays the data selector in multiple batch/samples 
selection mode. Selecting one or more data sets, 
populates the data tree with those items and selects 
the first data set and displays it as determined by the 
current View mode. 

 Add Data… Adds new data sets to the end of the data tree. 

Displays the data selector in multiple batch/samples 
selection mode. Selecting one or more data sets, adds 
the data at the end of the data tree but the current 
selection in the tree and display will not be changed. 

 Close Batch  Closes the batch of which the currently selected plot is 
a part. All plots will be blanked but the view type will 
remain unchanged. This is enabled when the data tree 
is populated and an item in it is selected. 

 Print Preview Report…  Displays the Print Report dialog. When you select the 
required options in the dialog (and click OK) a report 
will be generated from the data associated with the 
currently selected node in the data tree using the 
selected template and the selected print options. This 
report will be displayed in a standard Print Preview 
window. 

 Print Report… Displays the Print Report dialog. After selecting the 
required options in the dialog (and clicked OK) the data 
associated with the currently selected node in the data 
tree is reported using the selected template and the 
results are printed in accordance with the selected print 
options (see Print Results).  

 Lock Only displayed when user authentication/tracking is 
active. Minimizes the Chromera window to the taskbar. 
Before the window can be restored the valid password 
for the associated user must be entered. 

 Exit If a single run is in progress or a sequence is running 
then you are prompted that the instrument must be in 
an idle state before the application can be closed (see 
Exit dialog). If the instrument is not active then if any 
unsaved data exists in any environment the software 
will ask if it is to be saved before exit. 
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View 

 

Run Time Switches to the Run Time environment. The same 
action as clicking the Run Time button in the Navigation 
Pane. 

 Method Switches to the Method environment. The same action 
as clicking the Method button in the Navigation Pane.  

 Sequence Switches to the Sequence environment. The same 
action as clicking the Sequence button in the Navigation 
Pane.  

 Post Run Switches to the Post Run environment. The same action 
as clicking the Post Run button in the Navigation Pane.  

 Reprocess Switches to the Reprocess environment. The same 
action as clicking the Reprocessing button in the 
Navigation Pane. 

 Reports Opens the Report Viewer. 

 Toolbars 
►         View         

Toggles display of the View toolbar.  

 Tools Toggles display of the Tools toolbar.  

 Graphics Toggles display of the Graphics toolbar.  
It is disabled when the Graphics toolbar is not 
displayed. 

 Show Small Icons 
Show Large Icons 

Toggles the size of the icons in the Graphic toolbar. 

Tools Export ►   

 Chromera 
Results… 

Displays the Database Export dialog. 

 Methods… Displays the Method Export dialog. 

 Sequences… Displays the Sequence export dialog. 

 Report 
Templates... 

Displays the Report Template Export dialog. 

 Import ►  
 

 TotalChrom Data… Displays the Import TotalChrom Data dialog. 

 Chromera Results… Displays the Import Results dialog. 

 Chromera Methods… Displays the Import Methods dialog. 
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 Chromera 
Sequences… 

Displays the Import Sequences dialog. 

 Chromera 2.0 Data  Displays the Import Chromera 2.0 Data dialog. 

 Report Templates... Displays the Report Template Import dialog. 

 Preferences Displays the Preferences dialog, showing the 
preferences associated with the current user (see 
Setting Preferences).  

 Report Format Wizard Displays the Report Format Wizard in New Report mode 
(see Report Format Wizard).  

 Sequence Wizard Displays the Sequence Wizard (see Sequence Wizard).  

 Device Connections Displays the Device Connections dialog. 

 Error Log Displays the Error Log dialog 

 Dictionary Editor Displays the Dictionary editor dialog 

 Reprocess Initiates the Batch Reprocessing function by displaying 
the Data Selector (see Batch Reprocess). It is disabled 
in an online instance when data acquisition is in 
progress, or a sequence is running. 

Display Instrument Method Displays the Instrument parameters (only) stored with 
the selected sample injection, in a separate window. 
Enabled when the data tree is populated. 

NOTE: The parameters cannot be edited in this 
window. 

 Peak Detection 
Parameters  

Displays the Peaks section (only) of the method stored 
with the selected sample injection, in a separate 
window. Enabled when the data tree is populated. 

NOTE: The parameters cannot be edited in this 
window. 

 Channels Displays the Channels section of the method stored 
with the selected sample injection, in a separate 
window. Enabled when the data tree is populated. 

NOTE: The parameters cannot be edited in this 
window. 

 Component (Species) 
Calibration 

Displays the Calibration section (only) of the method 
stored with the selected sample injection, in a separate 
window. Enabled when the data tree is populated. 

NOTE: The parameters cannot be edited in this 
window. 

 Rescale Displays the Rescale Axes dialog for you to set the X-
Axis and Y-Axis minimum and maximum values. 



276 . Chromera User's Guide 

 

 Auto Rescale Redraws the contents of the active plot frame at default 
scaling. 

 Previous Layer Enabled only in views that define layers (e.g. Stacked 
Plots or Matrix) and only when more than one layer of 
data exists. Displays the previous logical layer. 

 Next layer Enabled only in views that define layers (Stacked Plots 
or Matrix) and only when more than one layer of data 
exists. Displays the next logical layer. 

 Overlay Enabled in Stacked and Matrix views only (i.e. where 
layers may exist) but only where applicable for the 
current data set. Not enabled in graphic edit modes. 

NOTE: The Overlay display action depends on the view 
(see descriptions of each view mode.) 

 3-D Enabled in Overlay mode and the Overlay view only. 
Toggles 3-D mode on/off for all displayed plots. 

 Radar Window Toggles display of the radar window on and off. Only 
enabled in Single Plot views (this includes graphic 
editing modes). 

 Plot Style Displays the Plot Styles dialog (see Plot Styles). 

 Plot Layout Displays the appropriate version of the Plot Layout 
dialog for the selected view (see section Stacked Plots 
View). Plot Layout is enabled in standard Post Run 
mode only and in Stacked Plot and Matrix views. 

 Snapshot Displays the active plot in a full screen window. Use the 
slider at the top of the window to increase or decrease 
the transparency. 

Actions Standard Post Run 
Display 

Displays the standard configuration of the Post Run 
environment (that is with a user configured graphics 
pane and an optional Results pane in the main display 
area. 

If unsaved data exist (from graphic editing) you are 
first be prompted if the current unsaved data should be 
saved. 

 Peak Identification 
Review 

Displays the graphic editing screen to optimize the 
results in the Post Run environment (that is with a 
single plot pane and a tabbed Results/Integration 
pane). 
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 Go to Graphic Method 
Editor 

Switches to the Method Editor environment in graphic 
edit mode. The data from the data tree are carried over 
and the first data set is reprocessed with the current 
(stored in the database) version of its referenced 
method (see section Accessing Graphic Method 
Editing). 

NOTE: In order for this action to be performed the 
sample must have a method that exists in the 
Chromera database associated with it. If it does not 
(e.g. for imported data) the following error message 
will be displayed: ”The sample data was not processed 
with a Chromera method. Data must have been 
processed within Chromera before this command can 
be used.” 

 Examine Spectra (PDA) This will start and display the spectral processing in the 
Chrom/Spectra view mode.  

This selection is visible whenever the data tree contains 
a PDA node.  If a PDA node is not present the selection 
is hidden. 

If execution of the Examine Spectra command fails to 
launch an error dialogue will be displayed with, if 
possible, the cause and solution to the problem. An 
entry into the Error Log will be made. 

 Reprocess Current 
Chromatogram 

Reprocesses the currently displayed chromatogram with 
the current (displayed) version of the method. This 
command is only used when automatic updating after 
each change to the method is disabled in user 
preferences (see Preferences). 

Help Topics Opens the Chromera Help window.  

 Consumables and 
Accessories 

Opens the Consumable and Accessories Catalog 

 About Chromera Displays the copyright and version dialog.  

 
Batch node 
selected 

Report generated with default Summary template (most recently 
used in Results Print dialog), using all checked chromatograms 

Sample node 
selected 

If multiple injections per sample then report generated with 
default Replicate template (most recently used in Results Print 
dialog), using all checked chromatograms. If only single injections 
per sample then report generated with Sample template. 

Chromatogram 
node selected 

Report generated with default Sample template (most recently used i  
Results Print dialog). If the node is one of multi-channel data set then 
all channels are reported if the template accommodates them, 
otherwise just the selected channel is reported. 

 
                    



278 . Chromera User's Guide 

 

Post Run Standard Toolbar 

This toolbar displays in the standard Post Run mode: 

 

Or when user authentication active the following toolbar displays: 

 
 

Icon Command 

 File/Open Data 

 File/Add Data 

 File/Print Preview Report 

 File/Print Report 

 File/Lock (Only when user authentication 
active) 

 File/Exit 

 Actions/Standard Post Run Display 

 Actions/Peak Identification Review 

 Actions/Examine Spectra 

 Help/Topics 

 
 

Post Run - Views Tree 

The Views tree contains a fixed set of items under a single main heading: General Views. 

 

 
General Views contains the following sub items: 

• Single Plot 
• Stacked Plots 
• Matrix 
• Overlay 
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Post Run - Data Tree 

The Data tree contains the levels: Batch, Sample, Injection, Device, and Channel. Each 
batch from which data have been selected for display is identified by a top level node consisting 
of the batch name. The data control tree has a check box associated with each node.  

 

 

In this example, Batch (011309seq2-void time 1) , 
Sample (std 1), Injection (inj 1), Device (PDA 
Detector), and Channel (254:10:400:10). 

The data tree may be populated: 
• When you make selections in the data selection 

dialog, accessed from the File>Open menu 
command.  

• Automatically as data are generated during 
data acquisition. 

NOTE: When an item in the tree is selected it is 
checked (and hence becomes the displayed plot). In 
other words, if an item is currently unchecked and it is 
selected by clicking on the text, the check box is 
automatically checked. 
When a data set is added to the tree, all 
chromatograms in the data set are checked by default 
and the first chromatogram in the data set becomes 
the selected plot. Which items in the data set are 
displayed will depend on the current view. 

Check/ Uncheck Data 

When a top level node is checked or unchecked, all 
nodes under the top level are set to the same state.  

Check/Uncheck nodes in the tree as follows: 

Shift 
+ 

Click 

If the Shift key is held down while 
checking (or unchecking) an item in the 
data tree, then all items of that channel 
are checked (or unchecked). 

Ctrl + 
Click 

If the Ctrl key is held down while 
checking and/or unchecking items in the 
data tree, the graphics display is not 
updated until you release the Ctrl key.  

 

 Data Tree: Popup Menu 

Right-clicking anywhere within the Data tree control will display a popup menu. The contents 
of the menu is always the same but which commands are enabled will depend on what 
specific part of the tree is clicked. If you click on a node in the tree, that node will first be 
selected before the command is implemented. If you click in empty space within the control 
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and not on a node then the only commands enabled are Expand All and/or Collapse All, as 
applicable. 

Command Description 

Expand Displays the child nodes of the node clicked on. 

Collapse Hides the child nodes of the node clicked on. 

Expand All Below Here Fully expands the tree below this point to show all nodes. 

Collapse All Below Here Hides all nodes in the tree below this point other than the 
root node (the method name). 

Select All in This Batch Checks all items in the currently selected batch (i.e. the 
batch containing the selected node). 

Select Only This Item Removes the check from all items in the currently selected 
batch except for the currently selected node. 

Close Batch  Closes the batch of which the currently selected plot is a 
part. 

 

Post Run - Graphics 

The graphics frame has two levels of configurability, enabling the presentation of data in the 
most appropriate manner. The first level of configuration is by selection of a basic layout 
from the General Views branch of the Views tree. The General Views are: Single Plot, 
Stacked Plots, and Matrix. The predefined views that include multiple plot panes also allow 
you to define the number of visible panes and how data are distributed in the panes, thereby 
providing a second level of configurability. 

Single P lot View  

This is the simplest view, where only one plot control (see Plot Control) is contained in the 
graphics frame. If more than one chromatogram is checked in the data tree then a vertical 
scroll bar is displayed. Operations on the scroll bar always result in display of a single, 
complete chromatogram. Clicking either of the arrows or clicking within the scroll bar displays 
the adjacent plot (previous or next as appropriate). Dragging and dropping the thumb will 
cause the plot nearest to the drop position to be displayed; it will not be possible to drag the 
thumb such that the display will show the bottom half of one plot and the top half of the 
next. 
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Stacked Plots View  

In this view the plot frame is divided into a number of stacked plots. You can define the 
number of plots visible and saved as a user preference associated with this view. By default, 
the visible stack will contain one plot per channel (up to a maximum of four - if more 
channels exist it is necessary to scroll the display to see the additional channels). For 
example, you can have a Stacked View with data and pump pressure. 
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All Display Mode features of the plot control (as described in Plot Control) is exhibited by 
each plot in the stack. This includes: 

• Scaling changes via zoom box or by setting values in the Rescale dialog 

• Display of baselines, peak labels, user labels  

As before, manipulation of the scroll bar always results in the display of complete, not partial, 
plots. In this view the minor increment (arrow click) is one plot and the major increment 
(scroll bar click) is by the number of plots in the frame. For example, in the above example 
clicking in the scroll bar below the thumb would cause the two channels for the next sample 
to be displayed. 

Layers 

The Stacked Plots view introduces the concept of layers in the data organization to handle 
multiple injections of the same sample. In the default case the first injection of each sample 
from each channel is displayed initially and this is termed the primary layer. If there are 
replicate injections they are treated as invisible layers that can be made visible in place of the 
current display or by being overlaid on the current display. The Next Layer and Previous 
Layer commands allow you to move from injection to injection (in the default case) and the 
Overlay command will cause all injections to be displayed overlaid for the currently displayed 
sample/channels. 

For example you can use the Next layer command to show the layers in succession (as three 
successive screen displays not a single screen). 

 
Injection 1 

 

 
Injection2 

 

 
Injection 3 
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If a chromatogram that is not currently checked is selected in the data tree then that 
chromatogram will be overlaid on the currently displayed plot associated with that 
sample/channel. For example, if the Injection 1 layer above was currently displayed and the 
unchecked item for injection 2 of the UV-Vis channel was selected in the data tree then that 
item would be automatically checked and the chromatogram overlaid on the chromatogram 
for injection 1 of the UV-Vis channel. The item selected in the data tree will always be 
displayed (and hence it will be checked). 

Also, all layers may be viewed simultaneously by choosing the Overlay command. 

 

Note that the above description refers only to the default case; the user has other options 
available. For example, the user may select to display injections in the visible stack, in which 
case the channels will appear in layers. Or the user could elect to eliminate separate layers 
altogether and display all chromatograms in the primary layer. Details of configuration of the 
graphics frame in Stacked Plots view are described below.  

Configuration of Stacked Plots View  

When the Stacked Plots view is selected choosing the Layout Options command from the 
Display menu will display the Stacked Plots Layout Options dialog.  
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Control Description 

Display all 
chromatograms 

A radio button to display (or not display) all chromatograms 
defined in the data tree in the primary layer (in the order 
shown in the data tree) and that the number of plots in the 
visible stack is as defined by the Maximum plots to 
display control. 

Populate as defined 
below 

A radio button to indicate that the Stack control will define 
the contents of the visible stack. 

Stack A drop-down list (containing Channels or Injections) to 
define the composition of the visible stack in the graphics 
frame. 

Layers A display indicating the source of data for secondary layers 
of the display.  It displays Injections if Channels selected 
in the Stack control or Channels if Injections is selected in 
the Stack control. 

Maximum plots to display A text box defining the maximum number of plots (from 1 to 
8) to be displayed in the visible stack within the graphics 
frame.  

 

NOTE: The Maximum plots to display control only defines the size of the visible stack when 
Display all chromatograms is set, or when the number of items defined by the Stack 
selection (e.g. channels) exceeds the value of Maximum plots to display. 

Matrix  View  

In the Matrix View you can change a two-dimensional view port into a virtual 3-D grid of x 
columns by y rows by z layers, with each grid cell containing a chromatogram. If the view 
port is only a subset of the full grid then scroll bars is displayed in the frame as appropriate 
(i.e. vertical and/or horizontal).  
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The following example shows a view port of three rows and two columns. The full data set 
includes more data in rows, as indicated by the vertical scroll bar. The organization of data in 
this example is that each sample in the batch occupies a row in the display with each data 
channel occupying a column. Replicate injections occupy layers that can be displayed one at 
a time, using the Next/Previous Layer commands, or simultaneously using the Overlay 
command (depending on the presentation required). 

 

All Display Mode features of the Plot Control are exhibited by each plot in the grid. This 
includes: 

• Scaling changes via zoom box or by setting values in the Rescale dialog 
• Display of baselines, peak labels, user labels  

The action of the scroll bar is similar in this view to that in the Stacked Plots view. That is, 
the minor increment is one row (scroll in the top sample and scroll in the next one in the 
above example) and the major increment is by the number of rows displayed (display the 
next three samples in the above example). 

Configuration of the Matrix  View  

When the Matrix view is selected choosing the Layout Options command from the 
Display menu will display the Matrix Layout Options dialog. 
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Control Description 

Display chromatograms 
in successive grid cells 

Select this radio button to indicate that the display grid is 
filled sequentially, cell by cell, using all chromatograms 
defined in the data tree. The number of plots in the view 
port (visible in the frame) is as defined by the Maximum 
rows to display and Maximum columns to display settings. 

Populate grid as defined 
below 

Select this radio button to indicate that the Rows and 
Columns controls will define the contents of the grid. 

Rows Select from this drop-down list (Samples, Channels, and 
Injections) to define the contents of rows in the graphics 
frame. 

Columns Select from this drop-down list (Samples, Channels, and 
Injections) to define the contents of columns in the 
graphics frame. 

Layers Displays the source of data for secondary layers of the 
display. (The item of Samples, Channels, and Injections 
that has not been selected in the Rows and Columns 
controls.) 

Maximum rows to 
display 

Enter the maximum number of rows (from 2 to 8) to be 
displayed in the view port within the graphics frame.  

Maximum columns to 
display 

Enter the maximum number of plots (from 2 to 8) to be 
displayed in the view port within the graphics frame.  

 

NOTES: (1) The Maximum rows to display control only defines the number of rows displayed in the 
view port when Display all chromatograms in successive grid cells is set, or when the 
number of items defined by the Rows selection (e.g. samples) exceeds the value of 
Maximum rows to display. (2) The Maximum columns to display control only defines the 
number of columns displayed in the view port when Display all chromatograms in 
successive grid cells is set, or when the number of items defined by the Columns selection 
(e.g. channels) exceeds the value of Maximum columns to display. 
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Overlay View  

When Overlay View is selected (assuming some data is loaded into the Post Run environment), the 
data being inherited from the previous view will be examined to see how many items are checked. 
Firstly, the information about which items is retained for use if you switch back to a different view. If 
the number checked is less than or equal to the maximum number defined (shown here as ‘N’), then 
the same items will remain checked in overlay view and all selected curves will be displayed on the 
chart. If the number checked is greater than N then checks will be removed from all but the first N 
items and only this first N curves will be displayed on the chart. In addition, a message box will be 
displayed saying “The number of items checked in the data tree exceeded the maximum (N) that can 
be overlaid. The first N checks have been retained and these curves are displayed in the overlay 
view. To display other curves you must first uncheck some of the items currently checked.”  

 

• If more data displays than you wish to view, you can clear the chart (and subsequently 
uncheck all of the Data tree nodes) by pressing and holding the CTRL key as you click 
Overlay in the Views pane. Once cleared you can check each item in the Data tree you want 
to display in the chart. 

As you check and uncheck items in the data tree, the chart will update to show the currently 
selected curves (but always less than N+1). If you attempt to check a N+1 item it is prevented 
or a message displays informing you that the maximum number (N) of curves that can be 
overlaid are already selected. To display other curves you must first uncheck some of the items 
currently checked. The set of items checked in the data tree is maintained within overlay view, 
without affecting the set of items checked in the other views. 

This view is customized for the display of multiple overlaid chromatograms. Its key features are: 

1. Only a single chart will be displayed, although this can include multiple Y axes. 

2. There will never be a vertical scroll bar in the graphics pane. 

3. Overlay view will display the same data tree contents as the other Post Run views 
but it will maintain a separate set of checkmarks. That is the plots that are selected 
for display in Overlay mode can be different from those selected in the other modes. 

4. Up to 150 curves can be displayed on the chart at a time. 
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5. One of the curves displayed on the overlay chart can be selected as the active curve 
by clicking on it. 

6. When data are opened in Overlay view, items will be unchecked by default. 

7. The Display/Overlay menu command and the Overlay toolbar button will be disabled 
in Overlay view. 

8. The Display/Plot Layout command will be disabled in Overlay view. 

9. The Display/Previous Layer and Display/Next Layer commands will be disabled in 
Overlay view. 

The View finder 
The Viewfinder provides you with the ability to adjust the position and/or size of the view 
port onto the data set. It is accessed by selecting the Viewfinder command from the popup 
menu displayed by right-clicking in the graphics frame of the Stacked Plots or Matrix View. 

The principal purpose of the Viewfinder is to locate a particular chromatogram (or related 
chromatograms such as replicates or multiple channels from the same sample) within the 
batch data set. This is similar to the picture thumbnails in a digital camera. For this reason 
the chromatograms displayed within the Viewfinder should not be so small that the basic 
topography of the chromatograms cannot be discerned. To maximize the useful display area, 
chromatograms within the Viewfinder do not include Y axis labels since these are not of great 
significance in the pattern recognition process employed. However, they will have plot titles 
(displayed in the smallest legible font and shortened by the insertion of an ellipsis if 
necessary), otherwise distinguishing between similar samples would be impossible.  

The view port does not change unless you change it. For this reason 
there are no scroll bars on the Viewfinder, since if you scrolled the 
display the viewport indicator would either get left behind and 
inaccessible or would have to move in some arbitrary manner.  

The Viewfinder displays as much of the current data set at once (in the 
defined X / Y grid format) as can be accommodated on the screen, while 
maintaining a useful plot size. When the Viewfinder is first displayed the 
region of the data set where the view port is currently located will 
always be visible. In the example shown here the view port 
encompasses both channels of Sample03, Sample04 and Sample05.  

The view port can be moved or sized by the usual drag-and-drop 
techniques (summarized in the table below) but it will resized as 
necessary at the drop point such that it always encompasses 
complete plots (i.e. rounded up or down to the nearest plot 
junction. Also, the minimum view port size is a single plot. 

The buttons at the top and bottom of the dialog indicate that other 
samples exist in the dataset. Clicking on one of these buttons (when 
active) will scroll the display but this mechanism will only be 
required if the user wants a view port larger than the number of 
plots visible in the Viewfinder. If the first sample in the dataset is 
shown then the top arrow is grayed out (or invisible); similarly if the 
last sample is displayed the bottom arrow is grayed out (or 
invisible).  
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Dragging the view port (or the top or bottom boundary) to the top or bottom of the dialog 
then the plot thumbnails scroll appropriately. The scrolling speed must be set carefully to 
ensure this is a usable feature. Increasing the scrolling speed as long as the view port 
rectangle is kept at the top or bottom of the dialog would be a useful feature, as long as the 
rate of increase is not too great. 

Clicking OK updates the main display to show the plots defined by the new view port size 
and position. 

NOTE:  If the images used by the Viewfinder are not available for any reason, the Viewfinder will not 
be displayed. Instead a error message dialog will be displayed saying “There are no images 
to display in the Viewfinder.” The Viewfinder Help topic should elaborate on this message 
since it will not be obvious to the user that the Viewfinder uses previously generated 
‘thumbnail’ images rather than display regular plots. 

View Port Moving and Sizing 

Icon Action - Icon type Position where cursor changes to icon and action on 
drag 

 
Move - four pointed 
arrow 

Within view port and not within ‘hit’ range of an edge 

Moves view port to a new location in the data set 

 
Resize - arrow NW to 
SE 

Upper left, lower right corners of view port 

Upper left - Change size of view port, leaving lower right 
corner fixed in place. 

Lower right - Change size of view port, leaving upper left 
corner fixed in place. 

 
Resize - arrow NE to 
SW 

Upper right, lower left corners of view port 

Upper right - Change size of view port, leaving lower left 
corner fixed in place. 

Lower left - Change size of view port, leaving upper right 
corner fixed in place. 

 
Resize - vertical arrow Upper, lower edges of view port 

Upper - Change height of view port, leaving lower edge 
fixed in place. 

Lower - Change height of view port, leaving upper edge 
fixed in place. 

 Resize - horizontal 
arrow 

Left, right edges of view port 

Left - Change width of view port, leaving right edge fixed in 
place. 

Right - Change width of view port, leaving left edge fixed in 
place. 

 

NOTE:  The icons shown here are the Windows defaults; the actual icon displayed is defined in your 
Windows settings. 
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Post Run - Graphics: Popup Menu 

Post Run graphics plots inherits the basic plot popup menu items (Save Plot Image to 
Rescale Tools) and includes some additional ones to provide quick access to key plot 
properties. This menu is displayed whenever you click on an area of the plot other than an 
existing object, such as a user label or, when in graphic edit mode, a timed event.  

 

 

 
 
 
 
 

 

The menu commands are described below. 

Command Description 

Zoom Select zoom then hold the left mouse button to draw a 
zoom box by dragging the mouse across the plot area. 
Releasing the mouse button immediately rescales the 
plot. Depending on the relative X and Y dimensions of the 
box, the plot will be rescaled on the X axis, Y axis, or 
both.  

Plot Information Displays the Plot Information dialog for the selected plot. 

Viewfinder Displays the Viewfinder for moving or resizing the current 
viewport into the Grid View. It is displayed in Stacked and 
Matrix Views only. 

Add User Label… Displays the User Label dialog. The default text for a new 
label is the Y axis position (in minutes) at the point where 
the mouse was clicked. 

Annotations  Displays the Annotations dialog. 

Plot Style Displays the Plot Style dialog. 
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Save Plot Image... Displays the Save As dialog for you to name and save the 
image to a directory of your choice. 

Print Preview Opens a preview window and displays the chromatogram 
as it will be printed. You can select Portrait or Landscape 
orientation. 

Print... Prints the current chromatogram display to a selected 
printer. You can select Portrait or Landscape orientation. 

Copy Image to Clipboard Copies the current chromatogram display to the clipboard 
in bitmap format.  

Copy Data to Clipboard Copies the X and Y values for the current chromatogram 
to the clipboard in text format, with one pair of values 
per line. This command will only be available when a 
single chromatogram is displayed. Alternatively, it could 
just copy the values for the selected chromatogram (but 
that is not even always displayed in Chromera currently) 
or it could copy concatenate the sets of values for 
different plots. 

Export Data to Excel Exports to current data to Excel. 

Rescale Tools  ►  Rescale Axes 

             Restore Default Scaling 

Displays a dialog box to set the X- and Y- Axes. 

Click to restore the X- and Y-axes to the default settings. 

Signal to Noise Measurement 

Signal to Noise measurement is available in Post Run and in the Graphic Method Editor. 

1. Select Signal to Noise Measurement (S/N) from the Actions menu. 

 
The Noise Measurement dialog appears. 
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2. When the Noise Measurement dialog displays, the focus is in the Start box for 
Noise. 

3. Enter the appropriate values for determining the S/N, into the dialog. These values 
represent: 

• The start time and end time of a baseline segment you select as 
representative noise.  

• The start time and end time of an integrated peak whose signal to use for 
the calculation. 

NOTE: Values may be entered into the dialog either manually or graphically.  If the values are 
entered manually, the Compute button must be clicked for the calculations to occur. If the 
values are selected graphically, the calculations are performed automatically. The following 
steps describe the graphical technique for selecting these values. 

4. To select the Noise Start and End times, hold the CTRL key while dragging the 
mouse across a segment of baseline where the noise measurement is to be made. 
Within this window, the algorithm fits a straight line through that segment and 
determines the RMS noise for the selected baseline.  This value is displayed in the 
Noise box in the lower half of the dialog. 

NOTE: (RMS = Root Mean Square. When comparing actual data with expected data the straight line, 
in this case, square the error at each data point add the squares together take the square 
root of that sum.) 

5. Then, the focus shifts to the Peak Start text box.  

6. To select a peak whose signal will be used for the S/N calculation, either click on an 
integrated peak in the chromatogram, or hold the CTRL key and drag the mouse 
across the chromatogram to define a time window that includes a peak of interest. 
When a peak is selected by click-and-drag, it does not have to be an integrated 
peak. (See “How it Works” below.) The Peak Height of that peak is displayed in the 
lower half of the dialog. 
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7. Once both the noise segment and peak of interest have been selected, the calculated 
RMS Signal to Noise value will be displayed, along with the baseline Noise and Peak 
Height values used. A label containing the calculated S/N value will be added to the 
chromatogram, with an anchor line pointing to the peak selected.  

   

Peak selection may be repeated as often as desired. If a different peak is selected, the new 
Signal to Noise value will be calculated automatically.  To define a new noise window, simply 
click in one of the Noise text boxes in the dialog to move the focus back to that field, and 
then select or enter new values for the Start and End times.  Again, the new Signal to Noise 
value will be calculated automatically. 

How  it Works  

Here's what happens when you select a peak window, either by typing in Start and End time 
values or by CTRL-click dragging the mouse. 

1. Within the selected window, the point of maximum amplitude is assigned to be the 
peak crest.  

2. The points of minimum amplitude to the left and right of this crest are assigned as 
the ends of the peak's baseline. 

3. The times in the Peak Minutes windows in the dialog are changed to show the 
actual peak window that was found in this way. 

4. Peak height is determined as the vertical distance from the Crest point to the 
baseline that is drawn between the two points that were found in Step 2. 
If the peak you desire to use for the S/N calculation has already been detected and 
integrated, you do not need to define the peak window.  All you need to do is to click 
within the peak on the chromatogram, and the existing baseline and peak-height 
values from the Results table will be used for the calculation. 
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Copying the Information 

 Clicking the Copy button copies the measurement and identifying data for the channel to the 
Clipboard, and displays the information dialog shown below. From there, it may be pasted 
into any text editor. 

NOTE: There is no provision to print this information directly. 
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Post Run Graphics Annotations Dialog 

This dialog is displayed when the Annotations command is selected in the Graphics 
Popup Menu. It is provided so that you can make several changes to the annotations 
selection at one time. Unlike most dialogs this one is positioned at the point where the user 
clicked the popup menu, so that you do not have to move the mouse far to make the 
required changes. 

 
 Command Description 

      

Baselines A check box that indicates peak integration 
baselines will be displayed on all 
chromatograms. 

Legend A check box that indicates a legend relating 
curve color to sample name will be displayed 
above each chart. 

Peak data  A check box that indicates the peak data 
items defined in Plot Options will be displayed 
for each integrated peak, in the orientation 
defined in plot options. 

Peak fill A check box that indicates integrated peaks 
will be filled in with the color defined in Plot 
Options. 

Peak names  A check box that indicates names will be 
displayed for each peak that has been 
matched to a component 

Peak search 
windows 

A check box that indicates the peak search 
window gadget will be displayed for each 
component when graphic editing mode is 
active. 

Timed events  A check box that indicates (instrument and) 
integration events from the processing 
method will be displayed on each 
chromatogram (where applicable). 

User labels  A check box that indicates labels created by 
the user will be displayed on each chart for 
which labels have been created. 

Clear All A command button that will clear all check 
boxes in the dialog. 

Clicking OK automatically applies the settings from the dialog to the current display and will 
sets in Plot Options. These are currently global settings and hence the Annotations dialog 
and Plot Options always show the same settings. Clicking Cancel in the Annotations dialog 
causes no changes to the display or Plot Options. 
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Peak Identification Review  

Selecting Peak Identification Review from the Actions menu is an extension of the Post 
Run environment. The following shows how to switch from standard post run display to a 
graphic editing display to optimize results. 

 

                             Standard Post Run Display 

 

                                  Peak Identification Display 

At first this display looks very similar to that for graphic method editing, however there are 
several key differences. The most noticeable difference is that there is no method section 
tree. This is because there is no method in this case, or, more accurately there is no single 
entity called by a single method name that can be edited. A result may contain parameters 
from more than one method (instrument parameters from one method and processing 
parameters from a different method), and it is invalid to edit some of these parameters (for 
example the instrument parameters). In place of the Method tab from Graphic Method Editor 
the Graphic Results environment has an Integration tab. This provides convenient access to 
the parameters that you can edit. 
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The Views section in the Navigation Pane is eliminated in graphic results editing mode, since 
the plot frame only ever contains a single plot control displaying a single chromatogram.  

Editing Toolbar 

 

 

Control Command/Caption Description 

 (unselected) 

 (selected) 

Review Calibration A button that indicates whether Review Calibration 
mode is selected. 
 
NOTE: It will be possible for both Review 
Calibration and Review Samples to be unselected 
at the same time.) 

 (unselected) 

 (selected) 

Review Samples A button that indicates whether Review Samples 
mode is selected. 
 
NOTE: It will be possible for both Review 
Calibration and Review Samples to be unselected 
at the same time.) 

 (inactive) 

 (active) 

Apply Calibration A button that updates the sample results using the 
current version of the 'composite calibration’.  
The button will be inactive (disabled) if no changes 
to calibration standards are currently pending. That 
is the button becomes active (enabled) when one 
or more calibration standards are edited and will 
be inactive again after it has been clicked to 
update the sample results. 
The terms ‘inactive and ‘active’ are used (rather 
than simply ‘disabled’ and ‘enabled’) because for 
this control its state being active should indicate to 
the user that the command must be performed 
before proceeding to review samples. 

 Set n of m Displays the current ‘set’ number and the total 
number of ‘sets’ in the batch. 
NOTE: This will not actually be displayed if the 
batch consists of only one ‘set’ (as shown in the 
mockup example). 
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Control Command/Caption Description 

 

Prev (Previous) A button that causes the previous chromatogram in 
the current ‘set’ (as defined in Option) to be 
displayed.  
If there are unsaved changes to the current 
chromatogram the user will be prompted whether 
to save the changes, discard them or cancel the 
‘Previous’ command). 
This button will be disabled when Review 
Calibration is selected and the first channel of the 
first injection of the first calibration standard 
channel in the batch is displayed, or when Review 
Samples is selected and the first channel of the 
first injection of the first sample is displayed. 

 

Next A button that causes the next chromatogram in the 
current ‘set’ (as defined in Options) to be 
displayed.  
If there are unsaved changes to the current 
chromatogram the user will be prompted whether 
to save the changes, discard them or cancel the 
‘Next’ command) 
This button will be disabled when Review 
Calibration is selected and the last channel of the 
last injection of the last calibration standard 
channel in the batch is displayed, or when Review 
Samples is selected and the last channel of the last 
injection of the last sample is displayed. 

 

Options A button that displays the Options dialog, which 
enables the user to customize elements of the user 
interaction.  

 

Save A button that saves any integration or peak 
identification changes made to the current 
chromatogram.  
If the current chromatogram is a calibration 
standard then the composite calibration will be 
updated automatically.  
Optionally a ‘Save’ command will automatically 
execute a ‘Next’ command also. 
This button will only be enabled when unsaved 
changes exist to the current chromatogram. 

 

Cancel A button that cancels any unsaved changes made 
to the current chromatogram and restores the 
original integration/peak identification – 
parameters and display. 
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Peak Identification Review  Options 

In addition, a number of options have been provided that enable users to customize certain 
elements of the process to better fit their specific needs. 

 

Group/Field Description 

Next button action options 

Display next channel (same or 
next injection) 

A radio button that sets the action of the ‘Next’ button 
to display the next detector channel, according to the 
data tree hierarchy. 

Display same channel next 
injection (same or next 
standard/sample) 

A radio button that sets the action of the ‘Next’ button 
to display the next instance of the current channel, if 
any, within the current review group (standards or 
samples).  

Save button action options 

Save changes to current injection 
only 

A radio button that sets the action of the Save button 
to save parameter and results changes to the current 
channel/injection only. 

Save and apply changes to all 
injections of this standard/sample 

A radio button that sets the action of the Save button 
to apply the parameter changes to all replicates of the 
current sample/channel, and to save the results. 

Do ‘Next’ automatically after 
‘Save’ 

A check box that invokes the Next action (as defined 
herein automatically after the Save function. The Save 
option setting has no effect on which chromatogram 
will be displayed, since applying changes to all 
replicates does not change the current chromatogram.  
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Main Menu 

Menu Command Description 
File The following is inserted into the File menu following the Add Data command. 

 Save Result Saves the results for the selected sample run as a new 
version within the existing batch. 
Saves the results for all updated data sets as new 
versions within the existing batch. 

 Save Method As… Saves the displayed Integration, Identification and 
Calibration parameters, together with the Instrument 
section and Channels section from the method saved with 
the current data set, as a new method. 
Displays a dialog to enter a Name and a Group for the 
new method, which is then saved under a new identifier 
in the database. 

Display Rescale Displays the Rescale Axes dialog (enabled when the 
data tree is populated). 

 Auto Rescale  Redraws the contents of the active plot frame at default 
scaling (enabled when the data tree is populated). 

 Radar Window Toggles display of the radar window on and off. 
Only enabled according to options set in Plot Styles (not 
displayed/displayed in all single plot views/displayed in 
graphic edit only). 

 Plot Styles Displays the Plot Styles dialog. It is enabled at all times. 

 Snapshot Displays the active plot in a full screen window. 

Actions The following is appended to the Actions menu in graphic editing mode: 

 Reprocess 
Current 
Chromatogram 

Reprocesses the currently displayed chromatogram with 
the current (displayed) version of the method. This 
command is only used when automatic updating after each 
change to the method is disabled in user preferences (see 
Preferences). 

Standard Toolbar 

This toolbar adds two buttons for Action menu items (Optimize Peak Detection and 
Reprocess Current Chromatogram) to those available in the standard Post Run environment: 

 

 Or when user authentication is active: 
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Icon Command 

 File/Open Data 

 File/Add Data 

 File/Print Preview Report 

 File/Print Report 

 File/Lock (Only when user authentication 
active) 

 File/Exit 

 Actions/Standard Post Run Display 

 Actions/Peak Identification review 

 Actions/Reprocess Current Chromatogram 

 Help/Topics 

Chromatogram Control 

Annotations on the chromatogram are determined by the Plot Styles settings. The plot 
exhibits the full range of interactive behavior described in Plot Control. 

In graphic editing only one chromatogram is displayed at a time. That is, a single plot control 
(no stack) and no overlaid chromatograms. This is to make it clear as to which 
chromatogram the integration and component settings apply to. 

 

When a sample injection includes data from multiple channels, the chromatogram displayed 
depends on the current selection in the method tree. 

Component Search Window Tool 

This is a graphic element that enables you to set the expected retention time and the search 
window for a component. The tool initially appears (assuming that Component Search 
Windows are selected as displayed Annotations) when you click on the chart to indicate the 
peak to be identified as the component. The selected form of the tool is similar to the 
Bunching Factor tool but it has an additional triangle marker indicating the expected 
retention time of the component within the search window. You can drag this central triangle 
to a new position within the search window, as well as repositioning the whole tool and 
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resizing the tool. Whenever you make a change to the position or size of any element of the 
tool, the Retention Time, Peak Search Start and Peak Search End fields will be updated in the 
parameters grid of the selected channel. 

 

When the mouse pointer is positioned over any of the triangular handles the cursor changes 
to  , indicating that the width of the object can be changed and the central marker can be 
moved. 

When multiple component tools are displayed, the single selected component is indicated by 
its different form as well its different color. The colors used for the body of the tool in the 
case of selected and non-selected components are user-selectable within Plot Options. The 
handles for resizing the gadget are always black. 

 

Tab Control 

Results Tab 

The data displayed on this tab will depend on the selection in the data tree. If a sample node 
is selected then results from all channels for all injections is displayed in the peak table. If a 
channel node is selected then the results from just that channel is displayed.  
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This means that results may be displayed for a chromatogram that is not currently visible but 
the convenience outweighs the inconsistency (this is also true for Post Run). Note that the 
results displayed are those generated by processing the selected data set with the currently 
displayed version of the method parameters – even on the initial display. Results stored in 
the database for the selected data set are never displayed here, although it is possible that 
the results are the same if the method and the peak processing algorithms are unchanged.  

NOTE:  Although it can be disconcerting to see different results here from in the Post Run 
environment, it is an inevitable consequence of bringing in data from an earlier release that 
had different integration algorithms. To see old results unaffected by updated algorithms 
simply view the data in standard Post Run mode. 

The first band in the results grid will always display the Sample Name, Sample Description, 
and Injection Number for the selected data set. If the selected data set is a single injection 
of a sample (i.e. not the top level batch name node) then the Injection Number is displayed 
also (as in the above example). The format of the secondary band (i.e. the columns 
displayed) can be defined by the user in a Properties dialog, accessed via a right-click popup 
menu. The contents of the display cannot be edited on this tab. 

Integration Tab 

This tab displays the Peaks section of the method for the selected channel. The term 
Integration is used rather than Peaks to help reinforce the fact that this is not a free-standing 
method that is being edited. 

NOTE:  The In Use field does not appear here since it is not applicable in the post run environment 
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Post Run - Results 

The basic layout of the Results pane in Post Run is a band for each injection, which in turn 
each have a secondary band containing a row per reported component/peak (this may be all 
peaks or identified peaks only). The top level bands can be expanded or collapsed in the 
usual way. 

 

You can define the columns displayed in each band by right-clicking within the results area to 
display a popup menu.  This displays a dialog to select the displayed columns. 

Results Displayed 

A selection in the data tree will determine which result node is visible (i.e. selected and 
brought into view) in the results display but all results are displayed at all times. 

Results Column Selection Dialog 
The Results Column Selection dialog lists the columns available for display in the injection 
band and the peak table in a hierarchical format.  
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Control Description 

Select columns to show  Select from the drop-down list the parameters to be 
displayed in the list. The selections are: 

All – Shows both sample/injection parameters and peak 
table columns. 

Components – Shows only the peak table columns. 

Injections – Shows only the sample/injection 
parameter columns. 

Injections  A section of the check list that shows the sample/injection 
parameters. 

The initial default display includes: Sample Name, Sample 
Description and Injection Number. Any change you make 
will be remembered and the display will reflect the user’s 
preferences the next time the results frame is displayed. 

Components/Peaks  A section of the check list that shows the peak table 
columns.  
The initial default display includes: Components, Channel, 
Retention Time, Component Name, Area, Height, Final 
Amount and Final Amount Units. Any change you make will 
be remembered and the display will reflect the user’s 
preferences the next time the results frame is displayed. 

Close  Clicking this button closes the dialog and updates the results 
table display based on the current settings. 

Post Run - Results Popup Menu 

The Results popup menu appears whenever you right-click anywhere within the results area. 

 
 

Command Description 

Column Selection... Displays the Column Selection dialog. 

Expand All Fully expands the results grid to show all bands. 

Collapse All Hides all peaks bands in the grid leaving only the 
sample/injection bands shown. 

Save to Spreadsheet Displays a standard File Save dialog, enabling you to save 
the results in Excel (.xls) format. The entire batch will be 
saved with sample/injection information in header rows, 
followed by the results table, as a set of expanding rows 
below the header rows. 
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Post Run Snapshot Window 

The Snapshot command displays the currently selected chromatogram (at default scaling) in 
a full-screen window, with exactly the same content of the display in the Post Run view. The 
only manipulations of the chart within the snapshot window are to zoom (via rubber-band 
box) and unzoom (via popup menu).  

 

The slider control at the top of the window allows you to control the transparency of the 
Snapshot window. As transparency is increased (by moving the slider from right to left) the 
Chromera Post Run window below will become more and more visible, enabling you to 
review the contents of the view without closing the Snapshot window.  

The Snapshot window has its own icon in the Windows taskbar, enabling you to switch to 
Chromera (or any other application) and back to the Snapshot as required. You can close the 
Snapshot window by clicking the standard Windows close button in the top right-hand 
corner. 

Snapshot Window  Popup Menu 

A popup menu containing an Unzoom command is available in the Snapshot window after 
you have zoomed in on the plot using the standard rubber-band box technique. This restores 
the Snapshot window to its previous scaling. No scaling changes made in the Snapshot 
window will be reflected in the main display when the Snapshot window is closed. 
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User Label Dialog 

When the mouse pointer is on the plot, right-clicking displays a pop-up menu where one 
selection is Add User Label. This allows you to add custom text at the location designated 
by the mouse click. Note that this means the location of the initial mouse click that displayed 
the context menu, not the mouse position when the command was selected (which you have 
no control over). 

NOTE: Entering a new User Label to an existing chromatogram will take the current format settings. 
The existing User Labels will keep their original format settings and not change to the current 
format settings. You must re-enter the User Labels to get the updated format settings. 

In addition to specifying the text, you can set its text properties, and also specify whether the 
label is to be locked to X and/or Y data. If the label is locked to X data then it always appears at 
the same time on the plot, regardless of the scaling. If it is not locked to X data then it always 
appears at the same relative distance along the X-axis (i.e. as % of time span), and therefore 
moves relative to the chromatogram topography when the scaling changes. Similarly, if the label 
is locked to Y data then it always appears at the same response level, regardless of scaling. If it 
is not locked to Y data then it always appears at the same relative distance along the Y-axis (i.e. 
as % of full scale). 

 
 

Control Description 

Label text Enter text (up to 25 characters) to be displayed as a user label. 

Time/Response Position Select to display the label locked to the data. That is, at the data 
coordinates defined by the right mouse click. The label X/Y position 
is affected by plot scaling just as the chromatogram is affected. 

Time and absolute 
vertical position in the 
window 

Select to display the label locked to the time defined by the right 
mouse click but always at the same vertical position (i.e. % full 
scale) in the plot window. The X position of the label is affected by 
plot scaling but not the Y position.  

Absolute position in the 
window 

Select to display the label at the absolute position (% full scale of X 
and Y) in the plot window defined by the right mouse click. Neither 
X or Y position of the label in the plot window are affected by plot 
scaling. 
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User Label Popup Menu 

The popup menu appears whenever you right-click on a user label. 

Command  Description 

Change Label Font 
and Color  

Displays standard Windows Font dialog, allowing the user to set 
Font Name, Style, Size and Color. 

Change Label 
Background Color  

Displays standard Windows color selection dialog, allowing the 
user to select the background color for the label. 

Label Border Toggles display of a black border around the label (one pixel 
thickness) on or off. The menu item is checked (or highlighted) 
when a border is displayed. 

Delete This User Label  Deletes the selected user label (without confirmation). There is 
no undo. 

Delete All User Labels  Deletes all user labels from the selected chart (without 
confirmation). There is no undo. 

 
 

Print Report/ Print Preview  Report Dialog 

The Print Report dialog displays when the Print Report… or Print Preview Report… 
command is chosen from the File menu within the Post Run environment. The dialog allows 
you to define what type of report will be printed (Summary report template or Sample report 
template depending on data selection), on which printer the report will be printed, and the 
report template to be used. Note that only one report can be generated at a time.  
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Set the following in this dialog: 

Control Description 

Current Selection  Displays the identification for the item selected in the data tree. 

Batch node:  Displays ‘Batch – ‘ + batch name 

Sample node: Displays ‘Sample – ‘ + sample name 

Injection/Channel node: Displays Sample:Channel:Injection – ‘ + 
sample name + ‘:’ + channel name + ‘:’ + injection number 

Printer 
Clicking the browse button  displays the standard Windows 
printer selection dialog to select a printer to be used to output the 
report. 

Summary/Sample 
report template 

Clicking the browse button  ,  displays a standard File Open 
dialog for you to select a report template file to be used for 
generating the results printout.  The caption associated with the 
field indicates the type of report that can be generated from the 
current data selection. 

From Group:  Displays the name of the Group the currently selected report 
template is assigned to. 

Report to be 
generated:  

Displays information about the selected template. 

When the dialog is displayed, the default report template shown will the most recently used 
template associated with the current data selection type (i.e. Batch or 
Sample/Channel/Injection). If no most recently used template exists for this user/instrument, 
then the field is blank. In this latter case the Report to be generated: field will also be 
blank. 

Clicking the Report Template Selection folder button, the standard report template selection 
dialog is displayed. However, the templates available for selection are filtered, so that only 
templates appropriate to the current data selection are shown. When a batch node is 
selected, only Summary report templates are listed. When a sample or channel/injection 
node is selected, only Sample report templates are listed. 

When the report template field is populated, the software examines the template to 
determine its basic characteristics. These are displayed in the ‘Report to be generated:’ field. 
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Reprocess 
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About Reprocess 

After you have acquired data and stored it, you can process the data repeatedly. This is called 
reprocessing the data.  Reprocessing allows previously acquired data to be viewed and 
reprocessed under its original conditions or modifications can be made to the original 
conditions.  For example, if reports were not generated when the original data were acquired, the 
original data file can be reprocessed so that reports are generated. 

Reprocessing matches the processing performed during data acquisition; that is, each row 
(and each injection) is processed according to its designated sample type. For example, if a 
Blank/Matrix row appears then the data from that run is subtracted from standards and 
samples that follow (and use the same method). Similarly, the presence of standards will 
result in a change to the calibration of the method, if Calibration is included in the processing 
functions specified. 

The term "batch data set" reflects the set of data initially generated by execution of a sequence, 
that is, data acquisition. A batch data set consists of the following:  

• Identification for the batch derived from the sequence name, group and date/time at 
the start of sequence execution 

• The sequence parameters from each row used to acquire the data 

• The results data for each channel (peak RTs, areas, amounts, etc) 

• The method parameters used to control the instrument and process each channel of 
data  

• References to the raw data acquired (time/response values derived from the 
detector(s) 

• References to auxiliary data from some non-detector devices (e.g. time/pump 
pressure values from a pump)  

The functionality of batch reprocessing within Chromera are: 

• The input data for reprocessing is any batch from the database, selected using the 
Chromera query and browsing tools 

• It is possible to reprocess all channels from a sample data set or just a selected 
subset  

• The reprocessing performs the actions required for the designated sample type (e.g. 
Calibration, Baseline Subtraction) 

• You may elect to reprocess with the current version of the method specified in the 
batch row or the version stored with the current results 

• It is possible to edit the sequence parameters prior to reprocessing 
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About the Data to be Reprocessed 

Batch 
Selection 

Basic selection of the batch data set to be reprocessed will be 
made using the standard Chromera data selection tools. At 
present you are restricted to selecting a single batch for 
reprocessing. 

Sample 
Selection 

Within the Reprocess environment you are able to elect not to 
reprocess certain samples but all of the batch will appear within 
the display. 

Channel 
Selection 

For any given sample it is possible to select to reprocess only 
specific channels of data within the data set. However, this 
option is not available if you change any sequence parameters. 
This is because sequence parameters are global to all channels 
and therefore reprocessing only one channel with modified 
parameters would result in inconsistent or invalid results. 

 

About Channels 

A channel is a digital data set received from an instrument, or derived from data received 
from an instrument. Some channels (those representing chromatograms) are processed by 
the software; others (such as solvent gradient profiles and pump pressure curves) are 
acquired and stored for subsequent display only. A channel may be a directly acquired signal 
from a device or it may be a derived stream (e.g. a chromatogram extracted from spectral 
data or a resultant chromatogram derived by subtracting a stored blank data stream from an 
acquired signal). The latter is used by the speciation application. 

The supported detectors all provide data in the form of chromatograms. However, derived 
channels produced by the subtraction of one chromatogram from another will also be 
supported by the LC application. 

There is no arbitrary limit to the number of channels that can be acquired, for example: 

• Simultaneously from a single detector (for example, absorbance output at different 
wavelengths). 

• Simultaneously from multiple detectors on a single instrument. 

• Simultaneously from multiple instruments. 
 

Processing Method 

You have two global options for reprocessing the batch: 

• To use the current version of the method specified in the batch row 
• To use the version of the method stored with the current batch data set 

These two options may provide a different set of available reprocessing functions.  

You also have the option of editing the batch row to specify a completely different method. 
Of course if this option is selected the current version of that method will always be used for 
reprocessing. 
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It is not possible to use sections from two different methods simultaneously, or different 
versions of the same method. However, in some cases, this can be achieved by using 
graphical reprocessing followed by batch reprocessing. For example, adjusting the integration 
of a chromatogram and then reporting it using the calibration stored with the original results 
could be accomplished in this way. 

Sequence Parameters 

Most sequence row parameters will be editable when batch reprocessing is set up and any 
modified parameters will be used during reprocessing. Changes to sequence parameters will 
have implications for the reprocessing functions available and/or for the resulting data set(s).  

Specific sequence row parameters that will not be editable are: 

• Vial Number - this clearly cannot be changed after acquisition when an autosampler 
is used  

• Injection Volume - this is currently a control parameter for acquisition and not used 
in calculations 

• Number of Injections - this clearly cannot be changed after acquisition 

Resulting Data Sets 

Reprocessing involving simply a modified (including recalibrated) method will generate a new 
version of results for that injection within the Batch dataset. These new results will become 
the default results displayed for that injection, although previous version will still be 
accessible via a database query. 

If any sequence parameters (more accurately, batch identification or sample parameters) are 
modified then a completely new batch data set is generated. The extent to which data are 
copied from the original batch to the new one depends on several factors, including the 
nature of the parameter changes made. 



Reprocess.  315 

 

Reprocess – Main Screen 
The general appearance of the Batch Reprocess environment showing a single Batch open 
for reprocessing is shown below: 

 
The main display area contains two frames: an options selection frame and a parameter 
control frame. The options frame will show controls for selection of the scope of batch 
reprocessing (start and end points and the channels to be reprocessed). The parameter area 
contains two tabs, one displaying the batch to be reprocessed in a format very similar to the 
sequence editor frame in Sequence or Run Time, and the other displaying Results identical to 
the one in Post Run. 

The header of the main display shows the name of the batch currently being viewed in this 
environment, together with its status (see Title Bar). 
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Menus and Toolbars 

Main Menu Commands 

Menu Command Description 

File Open Data… Displays the data selector in single batch selection 
mode. When you select a data set the parameter 
display is populated with those items. Any existing 
batch will be replaced by the new batch. 

 Lock Only displayed when user authentication/tracking is 
active.  

Minimizes the Chromera window to the taskbar. 
Before the window can be restored the valid 
password for the associated user must be entered. 

 Exit Online instance: If data acquisition or a sequence is 
running then the user will be prompted that the 
instrument must be in an idle state before the 
application can be closed (see Exit Dialog). If the 
instrument is not active then the following procedure 
for an offline instance will apply. 

Off line instance: If unsaved data are present in any 
other environment then the user will be prompted to 
save each in turn. Closes the application window. 

View Run Time Switches to the Run Time environment. The same 
action as clicking the Run Time button in the 
Navigation Pane. 

 Method Switches to the Method environment. The same 
action as clicking the Method button in the 
Navigation Pane.  

 Sequence Switches to the Sequence environment. The same 
action as clicking the Sequence button in the 
Navigation Pane.  

 Post Run Switches to the Post Run environment. The same 
action as clicking the Post Run button in the 
Navigation Pane. 

 Reprocess Switches to the Reprocess environment. The same 
action as clicking the Reprocessing button in the 
Navigation Pane.  

 

Reports Displays the Report Viewer window to view reports 
generated in this environment. 
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Toolbars ► 

     View         

     Tools 

     Graphics 

 

Toggles display of the View toolbar.  

Toggles display of the Tools toolbar.  

Toggles the display of the Graphic toolbar. 

Tools 

 

Export ►  
Chromera Results… 

Methods… 

Sequences… 

Report Templates… 

Displays the Database export dialog. 

Displays the Method export dialog. 

Displays the Sequence export dialog. 

Displays the Report template Export  dialog. 

 Import ►  
TotalChrom Data… 

Chromera Results… 

Chromera Methods… 

Chromera Sequences… 

Chromera 2.0 Data... 

Report Templates… 

Displays the Import TotalChrom data dialog. 

Displays the Import Results dialog. 

Displays the Import Methods dialog. 

Displays the Import Sequences dialog. 

Displays the Import Chromera 2.0 data dialog. 

Displays the Report template Import dialog. 

 Preferences Displays the Preferences window, showing the 
preferences associated with the current user (see 
Setting Preferences).  

 Report Format Wizard Displays the Report Format Wizard in New Report 
mode (see Report Format Wizard).  

 Sequence Wizard Starts the Sequence Wizard (see Sequence Wizard).  

 Device Connections Displays the Device Connections dialog.  

 Error Log Displays the Error Log dialog. 

 Dictionary Editor Displays the Dictionary editor dialog. 

 Reprocess Initiates the Batch Reprocessing function by 
displaying the Data Selector (see Batch Reprocess). 
It is disabled in an online instance when data 
acquisition is in progress, or a sequence is running. 

 Batch Builder Starts Batch Builder. 

Display ---------------------------- ------------------------------------------------------ 

Actions Run Options Displays the Run Options dialog, to set the Start and 
End Rows for reprocessing.   
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 Set as Start Row Sets the selected row as the first row to be run when 
the batch reprocess is started. Enabled when the 
batch is idle (or Paused) and a row is selected.  

 Set as End Row Sets the selected row as the last row to be run when 
the batch reprocess is started. Enabled when the 
batch is idle (or Paused) and a row is selected.  

 Start Reprocess Initiates the batch reprocess. Enabled when a batch 
is open.  

 Pause Reprocess Inhibits reprocessing of the next row when the 
current row is complete. Enabled when a batch is 
being reprocessed.  

Subsequent use of the Start Reprocess command 
would (by default) cause the batch to resume 
reprocessing with the next row. 

 Stop Reprocess Inhibits reprocessing of the next row when the 
current row is complete. Enabled when a batch is 
being reprocessed.  

Subsequent use of the Start Reprocess command 
would (by default) cause the batch to be 
reprocessed from the Start Row. 

 Clear Batch Closes the displayed batch. 

Help Topics Opens the Chromera Help window.  

 Consumables and 
Accessories 

Opens the Consumable and Accessories Catalog 

 About Chromera Displays the copyright and version dialog.  
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Batch Reprocess Toolbar 

 

The function of each command is described below: 

Icon Command Description 
 

 

Start Reprocess Begins reprocessing of selected rows only, starting 
with the specified Start Row. 

The Start button is enabled when the batch is not 
being processed. Each icon is always enabled when 
it is displayed. 

The current state of the batch is indicated in the 
header in the main display and by highlighting of 
the currently executed row in the display. 

 Pause Reprocess Does not process the next sample after the current 
sample has been reprocessing is completed. The 
Pause button is enabled when the batch is being 
reprocessed. 

 Stop Reprocess Terminates reprocessing of the batch when the 
current sample (if any) has been processed. 
Enabled when the batch is being processed or when 
paused. 

 Start Row Sets the currently selected row as the staring row 
when the batch is started (or restarted). If the 
designated Start Row is not marked for 
reprocessing then the first marked row following 
that is the first row reprocessed. This button is 
disabled when the batch is being processed. 

NOTE: Start and Stop Rows are defined in Batch 
Reprocess in a similar manner to that used in the 
Run Time environment (see Setting Start and Stop 
Rows). 

 Stop Row Sets the currently selected row as the stop row 
when the batch is started (or restarted). This must 
be a later row than the Start Row. If the designated 
Stop Row is not marked for reprocessing then the 
last marked row prior to that is the last row 
reprocessed. This button is disabled when the batch 
is being processed. 

 Clear Batch Clears the batch display from the current view. This 
button is disabled when the batch is being 
processed. 
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Method Options Select the method version from the drop-down list 

to use for processing. Options available are: 

Use Latest Stored Version of Method: The 
current version of the method specified in the 
sample row is read from the method database and 
used for reprocessing. 

Use Method Saved with Results: The version of 
the method saved with the results are used for 
processing (processing must start with Quantitation 
or later – see below). 

NOTE: Rows in which a new method name is 
selected will always be processed with the current 
version of that method. 

This is disabled when the batch is being processed. 

 
Save/Copy 
Options 

Select from the drop-down list whether a new batch 
should be created and what data should be copied to 
the new batch. 

Make new batch – copy all samples: Creates a 
new batch and copies all samples (and all injection 
versions) of the original batch to the new batch prior 
to reprocessing. 

Make new batch – copy reprocessed samples 
only: Creates a new batch and copies only the raw 
data of the samples selected for reprocessing, 
together with any injection version data required for 
reprocessing, to the new batch.  

Update current batch – no new copy: Updates 
the original batch with results of the reprocessing (as 
new injection versions). This is the default selection 
when a batch is opened. 

This is disabled when the batch is being processed. 

Batch Reprocess Standard Toolbar 

This toolbar displays in Reprocess:  
 

Or when user authentication active:  
 

Icon Command 

 File/Open Data 

 File/Lock (Only when user 
authentication active) 

 File/Exit 

 Help/Topics 
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Processing Functions and Rules 

Processing Functions 

Using the Options Panel on the Reprocess screen, you may select to have the software 
reprocess the data completely (from blank/baseline subtraction to report generation) or to 
perform only certain functions. For example, you may select to re-quantify results without re-
integrating or re-identifying the peaks. The process steps that may be selected are: 

 

1. Blank/Baseline Subtraction - (where applicable) 

2. Peak Detection and Integration – When peak areas, heights, and other peak 
properties are determined. 

3. Peak Identification - When detected peaks are identified and matched with 
components (species) in the method, based upon retention time windows and 
reference peaks, etc. 

4. Calibration – When identified peaks in a Calibration Standard Sample are used to 
update the component calibration section of the method, with the appropriate 
information from that standard. 

5. Quantitation – When the peaks in an Unknown Sample are processed against the 
current calibration information in the method, and new results are generated from 
that processing. 

6. Reporting – When new sample reports and/or chromatograms are generated, by 
simply reporting the current set of data for the current sample. 

Processing Rules and Other Considerations 

The following list summarizes the key rules concerning the scope of reprocessing: 

• An analyst is not allowed to select an ending step that occurs before the starting step. For 
example, it is invalid to start processing with Quantitation and end processing with Peak 
Identification.  

• Processing cannot skip steps.  For example, it is invalid to perform Peak Identification and 
Reporting without performing Quantitation. 

• Peak Detection and Integration are considered a single step for the purpose of reprocessing. 

• It is possible to reprocess unknown samples only, without the need to include calibration 
standard samples, by using the current calibration state of the method for each row to re-
quantitate that sample.  

• Quantitated results will not be calculated for calibration standard samples. Until the calibration 
is complete the results of using the intermediate states of the method can be grossly 
misleading.  If you wish to re-report calibration standards to treat them as samples, the batch 
must be reprocessed with the Sample Type changed from Calib to Sample (or Standard to 
sample for speciation applications).  

• All reportable data rows should have full accessibility to all reports. It is possible for the 
customer to print a Sample report for a calibration standard, if desired. 

• When reprocessing starts with the Reporting step no data will ever be changed; existing data 
are read and reported. 
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How Batch Reprocess Works 
There are different ways to arrive in the Batch Reprocess environment with a batch displayed 
and ready to be processed. Before describing the Batch Reprocess environment itself, the 
various ways of launching it, and populating it with data, is described. All approaches to 
Batch Reprocess share the characteristic that they will load a single batch at a time.  

NOTE: Ensure that the data set is correct before starting reprocess, rather than making adjustments 
as part of the reprocessing interaction itself. 
The following procedure is a overview on How Batch Reprocess Works. 

1. Clicking the Reprocess button in the Navigation Pane (or selecting the Reprocess 
command from the View menu or clicking the Reprocess toolbar button) displays the 
Batch Reprocess environment in its last-viewed state which can be one of the following:  

• The data display pane is blank if no data has ever been reprocessed, or if 
the you cleared the view. 

• The data display pane may contain a data set, consisting of samples from a 
single batch. 

2. To open data from within the Batch Reprocess environment the select Open Data... 
from the File menu.  This displays the Data Selector, enabling you to locate and 
select the data (Batch) to be reprocessed.  

• If you choose the Reprocess… command from the Tools menu the Data 
Selector is displayed (in single batch selection mode). After selecting the 
required data set (and click the Open button) the Data Selector closes, the 
Batch Reprocess environment becomes the active view and the selected data 
set are displayed there replacing any existing data set. 

3. After you select the Batch, click the Open.  The selected Batch data populates the 
Reprocess window. 

4. Select the samples to be reprocessed. 

5. Select the processing method for this reprocessed batch. 

6. Set the sequence parameters you wish to change.  Some cannot be changed. 

7. Set the processing functions and channels to be processed in the Options Panel. 

8. In the Reprocess Toolbar select the method version to be used for processing from 
the drop-down menu. 

9. In the Reprocess Toolbar select if a new batch should be created and what data 
should be copied to the new batch. 

10. Click the Start Reprocess button  to start the processing.  The sample row turns 
green as the row is being reprocessed 

11. Click the Results tab to see the results of the reprocessing. 
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The Displayed Data 

The display of the selected data in Batch Reprocess is very similar to that of a sequence in the 
Sequence or Run Time environments. The display shows the hierarchy of Batch/Sample/Decision 
Points and all the associated bands. The primary differences between the batch display and the 
sequence editor display are: 

• The batch display includes a Reprocess check box cell for each sample row. 

 

• Certain fields are set read-only in the Batch Reprocess environment, as defined below. 

• The editing tools fly-out panel is not shown in the Batch Reprocess environment. 

• Rows cannot be deleted from (or added to) the batch display. 

Changing Parameter Values 

Some sample parameters can be changed in the batch prior to reprocessing. In general, the 
following instrument related parameters cannot be changed: the Vial, Injections, and 
Injection Volume.  If you make any change to batch or sample parameters then a new batch must 
be created, since changing this information in the original batch is not permitted. For this reason, 
if you make such a change when the current batch save selection is set to ‘Update current 
batch – no new copy’ then a warning dialog displays, giving you the option of changing the 
save/copy option to one that creates a new batch or reverting to the original batch. 

NOTE:  Any change to sample parameters (but not batch information) will also require that all channels be 
reprocessed, since prior results from any channel are potentially rendered invalid by the sample 
parameter change. Therefore the channels selector will be set to ‘all’ and will be disabled. 

A new method can be specified if the method option is set to Use Latest Stored Version 
of method. If Use Method Saved with Results is selected the method column will be set 
read-only. If the method is changed the latest version of the method (i.e. in the method 
database) will always be used and the method option drop-down list will be set 
appropriately. 
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About the Options Panel 

The controls in the Option Panel are used to set two key aspects of the scope of batch 
reprocessing: The start and stop points of the processing cycle and the data channels to be 
reprocessed.  

Processing Start/ Stop Selector 

Use this control to select the step with which reprocessing will start and the step after which 
it will stop. 

 

The scale has six divisions representing the six steps of processing (see Processing 
Functions). The terminology used in labeling the processing steps on this control employs 
verbs, since these are shorter than the (usually employed) nouns and better convey the 
sense of action. 

The Start point marker (the left triangle) can be dragged to a new location, but only up to 
the current location of the Stop marker (the right triangle). Similarly the Stop marker can be 
dragged to a new location, but not before the Start marker. When a marker is dropped it is 
set to the nearest processing point. For example: 

 

Note that the limits indicator (the blue to orange band) resizes with the marker positions to 
show the range of processing steps that would be executed. 

When you click the left mouse button on one of the markers to start a drag operation, the 
limits indicator is updated immediately to show the valid range in which the marker can be 
dragged. For example in the example above, if you press the left mouse button over the 
green triangle the display would change to: 

 

When the Method option is set to Use Method Saved with Results the start point will be 
defaulted to Quantitation and it will not be possible to move it to an earlier stage. 



Reprocess.  325 

 

Channels Selector 

This control enables you to choose the data channels that are processed. It is a combination 
drop-down list and check list. 

 
• The drop-down list will always contain all the channels for which data exists in the 

batch. 
• If individual channel names are checked then when the control is closed it will 

display all the selected channel names, separated by commas (as shown in the 
example above). You are able to select and un-select all channels in one action via a 
popup menu that will appear when right-clicking on the drop-down list.  

• If any sample parameter is changed then the channels selector is automatically set 
to All Channels and disabled (see section Changing Parameter Values). 

Control and States 

The control of Batch Reprocessing follows the same pattern as the control of the sequence in 
Run Time. Also, its status is indicated in a very similar way.  

State State Indicators Possible Actions 

Batch Idle If Start/Stop Rows have been set the excluded rows 
are shown with a gray cell background (and 
Reprocess cell is unchecked). 

Set Start/Stop Rows 

Run 

Batch 
Processing 

Currently processed row is highlighted with green cell 
background 

Pause 

Stop 

Batch Paused Already processed rows (and excluded rows) are 
shown with a gray cell background, so the 'resume 
point' is the first row with white cell background. 

Set Start/Stop Rows 

Run 

Stop 

NOTE:  When reprocessing is paused the Start Row is automatically updated to the row following the 
last one completed before the pause takes effect. In this way the Run command will, by 
default, resume reprocessing from the next row.  However, you are able to change the 
default Start row to some other row and hence change reprocessing execution. If this 
involves a repetition of processing of rows already reprocessed then the prior results is 
retained and a new version of results are generated for these repeated rows. 



326 . Chromera User's Guide 

 

Title Bar 

The header above the main area displays the current batch name and state. This is similar to 
the behavior of the title bar above the frame in Sequence mode of Run Time.  

 Batch displayed but no 
activity is taking place 

 Batch is being 
reprocessed 

 Batch reprocessing has 
been paused 

Results Display 

Selecting the Results tab will display the results only after reprocessing is complete.  The 
results are not displayed for the original batch when it is first opened. This is identical to the 
Results tab displayed in Post Run (see Post Run - Results) 

Resulting Data Sets 

Depending on the various selections and entries made, the results of batch reprocessing 
could be: 

• Updating of the original batch with a new set of results. 
• A new batch containing all the original data or a subset of it, together with the new 

results. 
• One or more reports, with no change whatever to the original batch. 

Updated Batch 

If no change is made to any of the batch or sample values (e.g. if only parameters within the 
method have been changed), you can choose to have the original batch updated with the 
new results. The previous results are still retained within the database but in the current 
version of Chromera you only have access to the most recent set of results. 

New Batch 

You can always choose to have the results of reprocessing saved to a new batch. You can 
also select whether the new batch should contain all the original data, as well as the new 
reprocessed results, or if only the reprocessed samples and the latest results should be saved 
in the new batch. 

If you make changes to any values in the displayed batch grid then a new batch must be 
created.  This is because only one set of batch identification parameters and one set of 
parameters per sample are saved in the batch, and you are not permitted to overwrite the 
original values. When a new batch is created you have complete freedom to change most 
batch values (including Sample Type), however, you cannot change injection volume, 
number of injections, or vial number. 
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NOTE:  Any change to sample parameters will also require that all channels be reprocessed, since prior 
results from any channel are potentially rendered invalid by the sample parameter change. 

If the user has chosen to create a new batch but does not enter a new batch name then the 
software will append an identifier to the batch name to distinguish it from the original. 

The batch creation date will be set to the time at which the new batch is created in the 
database, since this operation will be treated as creation of a new batch and not modification 
of an existing one. 

New Batch Contents 

All originally acquired raw data from all channels for all samples (or optionally only those 
samples selected for reprocessing) are copied to the new batch. The existing processed data 
copied to the new batch depends on the ‘save’ option selected and the processing step 
defined as the Start point for reprocessing. The new data saved with the batch depends on 
the processing step defined as the End point for reprocessing.  

If you choose to copy all samples to the new batch, all prior versions of the results for all 
samples/injections will be copied to the new batch (in addition to the raw data). The exact 
nature of this data depends on the processing carried out in each case (see the table below). 

If instead you choose to copy reprocessed samples only, then only the raw data and any 
data required to perform the requested processing will be copied to the new batch. For 
example, by selecting to reprocess from Blank to Reports then only the raw data will be 
copied, since no other input is required.  However, if you select to start reprocessing at Peak 
ID then the peak data from the original batch (most recent injection version) would be 
copied to the new batch to act as the input for the Peak Identification stage. 

The table below defines the processed data saved with the batch for the injection version 
created by reprocessing. 

End Analysis New processed data saved to new batch 

Blank Subtraction Derived raw data from subtraction of blank from sample raw data. 

Peak Detection and 
Integration 

Derived raw data (from blank subtraction – if any) 

Peak data (RT, area, height, system suitability values) 

Peak Identification Acquired raw data, derived raw data (from blank subtraction – if any) 

Peak data (RT, area, height, system suitability values) 

Component identification information 

Calibration Acquired raw data, derived raw data (from blank subtraction – if any) 

Peak data (RT, area, height, system suitability values) 

Component identification information 

Component calibration results  

Quantitation Acquired raw data, derived raw data (from blank subtraction – if any) 

Peak data (RT, area, height, system suitability values) 

Component identification information and quantitation values 

Reporting No new batch will be created in this case 
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Reports Only  

When reprocessing starts (and, by definition also ends) with Reporting no new batch will be 
created nor will any changes be made to the original batch.  Since reporting only involves 
reading the batch there is no new (saved) data involved. 

Batch Copy Selection 

This dialog is displayed under the following circumstances: 

 

• When the current batch save/copy selection is Update existing batch – no new 
copy and you make change to any value in the batch (to batch or sample 
parameters). 

• When you have already made a change to a value in the batch and then change the 
save/copy selection from either of the ‘Make new batch’ options to ‘Update 
existing batch – no new copy.’ 

You are warned that making changes to the batch or sample information is incompatible with 
updating the existing batch.  You are given the option to undo the changes made or to make 
a new batch. 

If you choose to Create New Batch, the save/copy drop-down list changes to show the 
Make new batch – copy all samples selection.  You can change this to the Make new 
batch – copy reprocessed samples only option without triggering any additional 
warning.  

If your choose to Revert to Original then the original batch is reloaded, thereby undoing 
changes made to the batch or sample parameters. 



 

 

Batch Builder 

The Batch Builder utility enables you to create a custom batch containing the data from 
selected injections of selected samples copied from existing batches.  The resultant batch is 
flagged internally as a ‘synthesized’ batch but Chromera will treat it like any other batch, that 
is, it can be displayed, edited graphically or reprocessed and the results reported. 

Selecting Batch Builder from the Tools menu opens the Batch Builder dialog. The dialog 
contains a toolbar, two tree controls side-by-side and below them are a custom data table 
and a thumbnail graphics pane, like that in Data Selector.  Initially the two tree controls will 
be empty (and the custom data table and thumbnail graphics will not be displayed).  

Batch Builder Toolbar 

The toolbar contains the following Batch Builder functions: 

 
 

Icon  Command 

 
Open 

Click to open the Data Selector in multi-batch select mode. If one or more 
batches are selected then these replace any batches previously displayed 
in the Chromera data tree. This loads one or more Chromera batches into 
the data tree. 

 
Add 

Click to open the Data Selector in multi-batch select mode. If one or more 
batches are selected then these are appended to any existing batches 
displayed in the Chromera data tree. This Appends one or more Chromera 
batches to the data tree 

 
Create 

Click to start the process of creating the custom batch defined in the 
custom data tree. This creates the custom batch and save it in the 
Chromera database. 

 
Exit 

Click to close the Batch Builder dialog. 

 
Help 

Click to open a Help window with the How to Build a Batch topic selected. 
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How to Build a Batch 

The following procedure describes how to build a batch: 

1. Select Batch Builder from the Tools menu. 
The Batch Builder dialog opens. The dialog contains a toolbar, two tree controls side-
by-side and below them are a grid control and a thumbnail graphics pane, like that in 
Data Selector. 

 

2. Click the Open Data or Add Data button. 
The Data Selector opens in the multi-batch selection mode. When one or more 
batches have been selected and the ‘Open’ button in the Data Selector has been 
clicked, the selected batches will be loaded into the Chromera Data tree. As in Post 
Run, Open Data will replace any existing batches in the tree with the newly selected 
batches, whereas Add Data retains existing batches and appends the newly selected 
batches at the end of the tree. 

3. Review the Chromera data. 
When one or more batches are loaded into the Chromera Data tree, selecting nodes 
in the tree will display associated information in the table and graphic  thumbnail 
pane. 
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If more specific nodes are selected (i.e. injection, device, channel) the sample table display 
will remain unchanged but the thumbnail pane will be filtered to include only the applicable 
plots.  That is, with an injection node selected, plots for all channels of all devices from that 
injection will be displayed; with a device node selected, plots for all channels of that device 
only (from that injection) will be displayed; with a channel node selected, only the plot for 
that channel (from that injection) will be displayed.  The following example shows the display 
when a device node is selected (LC-MS in this case).  Note that the UV and pump channel 
plots (shown in the prior example) are no longer displayed. 
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4. Build a Custom Batch by selecting items to copy to the new batch. This can be 
accomplished by doing any of the following: 

• Dragging one or more selected sample and/or injection nodes from the 
Chromera Data tree and dropping them on the Custom Data tree. 

• Selecting one or more sample and/or injection nodes from the Chromera Data 
tree and then clicking the >> button. 

• Double-clicking a node. 
The following example shows the custom batch tree after a number of samples have 
been copied from the Chromera Data tree. 
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Note that with a node in the Custom Data tree selected, the Custom Data table and the 
thumbnail pane will display the data associated with that node.  In the above example 
the table displays the sample information for the sample ‘10.0 mg/L003’ and the 
thumbnail pane displays the NCI channel plots for injection 1. The label above the table 
displays ‘Custom Data’ in this case (as oppose to ‘Chromera Data’, which is shown in all 
the prior examples) to confirm which tree the information is coming from. 
Note also that with data in the Custom Data tree the Create button will become enabled. 

5. You can remove nodes from the Custom Data tree by basically reversing the action 
of adding them: 

• Dragging one or more selected sample and/or injection nodes from the Custom 
Data tree and dropping them on the Chromera Data tree. 

• Selecting one or more sample and/or injection nodes from the Custom Data tree 
and then clicking the << button. 

• Double-clicking a node. 

6. Identify the Custom Batch. 
The default batch name Custom Batch) can be modified by selecting the batch 
node in the Custom data tree and editing the batch name in the table.  The Group 
name for the batch and the Batch Description’ (‘Created from Batch Builder’ is the 
default) can also be edited in the table. The following example shows the display 
after editing the custom batch name and the batch group name. Note that the new 
batch name appears in the Custom Data tree as well as in the table. 
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The Created Date/Time field will initially show the time the first sample was added 
to the Custom Data tree but this value will be updated when the batch is actually 
written to the database (see next section).  By definition the ‘Reprocessed By’ and 
‘Reprocessed’ fields will always be blank for the custom batch.  The Created 
Date/Time, Reprocessed By and Reprocessed fields will not be editable. 

7. Save the Custom Batch. 
After adding all the required data to the Custom Data tree the batch can be 
generated and saved to the Chromera database by clicking the Create Custom 
Batch toolbar button. While the custom batch is being constructed in the database a 
message box is displayed, indicating that activity is in progress. 

    

8. Upon successful completion, click OK to clear the message and return to the Batch 
Builder dialog, the Custom Data tree will be blank, as it was when the dialog was 
first opened.  However, the Chromera Data tree contents will be unchanged (in case 
you wish to construct another batch from these data). 



 

 

Reports (Report Viewer) 
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About Report Viewer 

The main area of Report Viewer is a PDF viewer. It provides the basic requirements of page 
selection, variable magnification display, and printing. In addition it provides some search 
capabilities. 

 

The Report Viewer will display, by default, the reports from both Run Time and Reprocess 
environments. The reports are presented to you in the Navigation pane via a tree structure. 
When the Report Viewer environment is selected the tree structure is updated to show all the 
reports present in the directory structure for that instrument instance. 

The viewer lists all batches (as secondary nodes) and reports (PDFs, as extremity nodes 
under the batch) found in the Run Time directory in a tree control, under a top level node 
with the base name Run Time, and all reports found in the Reprocess directory in a tree 
control, under a top level node with the base name Reprocess.  There is only a maximum of 
one batch node for each environment, as previous batch nodes (and report files) are deleted 
when a new batch is acquired and/or processed. When you select a report in the tree, that 
report is displayed in the viewer pane.  

You can also set the Report Viewer into an alternate mode that allows you to browse for PDF 
files anywhere on the system and display them. This functionality is intended for the viewing 
of Chromera reports saved in PDF format but it will allow display of any PDF file. 
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Mode Control 

The mode control basically consists of two radio buttons: 

Online 
Reports 

Displays the reports generated from the last acquisition and reprocess 
actions performed for this instrument instance (or the last reprocess action 
only in the case of a Data-Only instance). 

Browse for 
Reports 

Allows you to select a directory and view the PDF files within that directory 
branch. 

 
Displays a Browse for Folder dialog which enables you to choose the 
directory branch displayed within the tree control. 
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Plot Control 
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About the P lot 

The Plot is a display of a chromatogram, or several overlaid chromatograms, annotated with 
any or all of the following: baselines, timed events, peak names, retention times, user labels, 
etc.  The Plot may also include instrument data profiles overlaid on the chromatogram(s).  

Plot Control is how you view and edit the displayed chromatograms and other run-related 
signals, such as solvent gradient profiles. This section describes some of its basic characteristics 
and general behavior. Plot Control is used in two distinct modes - Display and Edit. The 
Display mode allows you to examine any available aspect of the plotted data but without 
changing the results of data processing (obviously plot scaling and annotations displayed can be 
changed). In Edit mode you are able to alter parameters and interact with the data in other 
ways that affect the results. 

P lot Area 

In simple terms a plot is a set of axes and an area where the data is displayed. The Plot Area 
is the central subdivision of the whole plot in which the actual data are plotted. Since the 
general use of the control is to display chromatograms, we will refer to chromatograms most 
of the time and only reference other data when there is distinct difference of behavior. 

 

The radar plot always displays the full chromatogram with the part highlighted that is 
currently displayed in the main plot area. It exhibits an extremely limited set of capabilities 
that are closely tied to its associated plot. The radar window is only available when a single 
plot is displayed. 

When up to four overlaid chromatograms are shown, additional Y-axes will appear on the 
right-hand side of the plot. The labels on these axes use the same color as the associated 
chromatogram. The Y-axis displayed on the left-hand side is that of the currently active 
chromatogram. When more than four chromatograms are overlaid, no additional Y-axes are 
displayed (only that of the active curve). 
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The following terms describe the parts of the plot: 

Chromatogram In its simplest form the chromatogram is a curve drawn (plot) as 
a visual representation of the raw data collected of the data 
acquired from a chromatographic detector. Provided associated 
results data exist, the chromatogram may optionally be 
annotated with peak names, retention times, baselines and timed 
events. If results data exist, a peak may be selected by clicking 
on it (within the area enclosed by the signal and the baseline). 
 

Profile A curve displaying instrument signals other than detector output. 
For example solvent gradients, pressure or temperature profiles. 
 

Peak 
A peak is a sub-element of a chromatogram, providing that 
results data exist (i.e. the peak was detected and integrated).  

Peak Name 
(Components/Speci
es) 

Peak names are an example of system labels. The text is taken 
from the result data (or the method depending on the 
environment). You may choose to have the peak names 
displayed horizontally or vertically above the peak.  

If the peak apex is off scale then the name will be displayed 
superimposed on the peak (i.e. the label is moved down so that 
it is visible). A ‘tie line’ is used to connect the label to the peak if 
repositioning causes any ambiguity as to which peak the label is 
associated with. 

Peak Data Label 
You may select up to three data values as part of the peak 
annotation. Any three of the following items may be selected: 
RT, relative retention, area, height, area %, final amount, peak 
width (@ 5%, 10% 50% or base), resolution, plate number, 
alpha, k’, tailing factor. If the peak apex is off scale then the 
label is moved as described above for peak names. A ‘tie line’ is 
used to connect the label to the peak if this repositioning causes 
any ambiguity as to which peak the label is associated with. 

Peak data labels are displayed for unidentified peaks as well as 
identified peaks. In the case of identified peaks the peak name 
appears as an additional first item in the annotation. 
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Component Search 
Window There are two forms of the component search window – one 

purely for display (the unselected form) and one that allows 
modification of the search window and expected retention time 
(the selected form). 

The unselected form is a line displayed on the chromatogram to 
indicate the search window for all components. The triangle 
within the bounds of the window indicates the expected RT of 
the component (which does not have to be the center of the 
window). 

 

In Edit mode when a search window is selected, the selected 
form is displayed. 

 

This form has three handles (the black triangles), one at each 
end, indicating the overall search window region, and one in 
between that indicates the expected retention time of the 
component. Each of these handles may be dragged to a new 
position. Moving one of the two end handles will adjust the time 
period of the search window. Moving the handle within the 
window will update the expected RT of the component. The 
middle handle cannot be dragged outside the window, however 
the whole window can be moved to a new position by dragging 
in the region between the handles. 

Baseline You can optionally select to have baseline segments displayed on 
the plot, provided results data exist for the chromatogram. The 
term baseline segments includes drop lines drawn between 
unresolved peaks and skim lines (exponential or tangential). You 
may select the color and line type to be used to draw baselines. 

Legend This identifies each chromatogram displayed in the plot area, by 
displaying a sample of the line color together with the sample 
name. As occurs on the plot itself, the line for the selected 
chromatogram is double thickness. 

Axes Each axis zone consists of three elements: a title, divisions (tick 
marks) indicating the scale, and labels associated with some of 
these tick marks (major divisions).  

The title for each axis indicates the quantity displayed on that 
axis and the units. The title is displayed horizontally on X axis 
and vertically on the Y axis.  
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Timed Event A timed event is indicated by its standard Chromera abbreviation. 
A timed event label is generally located above the signal level at 
the time at which it occurs.  

In Edit mode, an event is moved simply by dragging it. Moving 
the timed event horizontally causes the time at which the event 
is to occur to be updated. Except in the case of UF events (to be 
described in detail in graphic editing), movement of the event in 
the vertical direction has no effect and the event will be relocated 
at the correct height when the event is dropped.  

The color and font attributes (including text and background 
colors) of timed events is a user preference (on a global basis). 

Annotation  Additional information displayed superimposed on the 
chromatogram or plot area. This can be in the form of lines (as in 
baselines), text, numbers or pictures. 

Labels Annotations consisting of text. These may be system labels or 
user labels. 

System labels Labels whose content is supplied by the system rather than by 
the user. System labels will generally be locked to the data (as 
for peak names) but certain types may be at a fixed position in 
the window (as for header information). 

User labels This consists of free form text that may be positioned anywhere 
on the plot. When you enter the label text you can also define 
(for each label) whether the label is linked to the chromatogram 
(in the manner of peak names positioned at the peak apex), 
displayed at a data axis location or shown at a fixed position in 
the window (regardless of rescaling). The color and font 
attributes (including text and background colors) of user labels is 
set as user preferences (on a global basis). A user label can be 
edited after it has been added to the plot.  

User labels added to a plot are associated with the raw data set; 
so that when that raw data set is displayed in the future the 
previous view of the data can be restored. Labels added when 
plots are overlaid are associated with the currently focused 
curve. 

Zoom box A rectangular object drawn on the plot by the user by performing 
a drag operation with the mouse, for the purpose of immediately 
rescaling the plot. To obtain an immediate rescaling of the plot 
you can draw a zoom box by dragging with the mouse across the 
plot area, when the default mouse pointer is displayed. 
Depending on the relative X- and Y-dimensions of the box, the 
plot is rescaled on the X-axis, Y-axis, or both. 

Coordinates Display As you move the mouse pointer around in the plot area, the 
coordinates of the hot spot are displayed (in the same units as 
the axes labels) below the plot. Note that when multiple plots are 
displayed only one set of coordinates is displayed. 
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Graphics Toolbar 

This toolbar is displayed whenever a plot control is displayed on the screen. Not all buttons 
are enabled in all environments where a plot control appears. The commands available in 
each environment are described in detail in the associated section below. 

 

Icon Command Description 

 

 

Rescale Displays the Rescale Axes dialog, enabling you to enter 
minimum and maximum settings for X and Y axes. The 
action of this command is affected by the Scaling Scope 
setting (see below). 

 AutoScale Sets the plot to default scaling settings. The action of this 
command is affected by the Scaling Scope setting (see 
below). 

 

 

AutoOffset Sets the Y axis minimum value so that the current signal 
level is displayed at approximately 5% of full scale. The Y 
axis maximum is also adjusted so that the full scale span 
remains the same. Displayed in Run Time environment only. 

 
Previous Layer Displays the previous layer in a three dimensional view 

consisting of a visible layer and hidden layers (for details 
see Stacked Plots View). Only enabled when a multi-layer 
view is displayed in Post Run. 

 
Next Layer Displays the next layer in a three dimensional view 

consisting of a visible layer and hidden layers (for details 
see Stacked Plots View). Only enabled when a multi-layer 
view is displayed in Post Run. 

 
Overlay Overlays multiple chromatograms.  Only enabled in Post 

Run when a suitable data set is displayed. See Post Run 
Environment.  

 3-D View Displays overlaid plots in 3-D Mode. Only enabled when 
overlaid plots are displayed. 

 Radar Window Toggles display of radar window. 

 Clear Graphics  Clears the current chart and starts plotting again from the X 
minimum. Displayed in Run Time environment only. 

 Snapshot  Displays the active plot in a full screen window. 

 
Scaling Scope  Determines the scope of scaling changes made using Rescale 

command, AutoScale command or zoom box (for example, 
all plots or single plot). Options available depend on the 
environment and the view. 
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About P lot Styles  

The global (at least global within each environment) setting of plot properties is referred to 
as Plot Styles. This is the command used to access these values and the title of the dialog 
used to set them. 

The plot properties/options are divided into three categories: 

Appearance general properties affecting the appearance of the plot window but not its 
content 

Annotations settings that determine the additional information to be displayed on the 
chromatogram and its appearance 

Curve Colors a list of colors to be used within curve sets and options defining their use 

The majority of plot properties are global. That is they will be used for all plots in all given 
environments for a given user/instrument. For example, changing the peak name text color 
to blue within Post Run would set all peak names displayed on all plots in that environment 
to blue but it would not change the color of peak names displayed in Graphic Results Editing 
or Run time.  

The key exceptions to the above rule is curve colors and user labels. Each chromatogram can 
be assigned a different color (if required) and user labels can specify individual lock 
properties as well as having individual text properties. 

Appearance 

The Appearance settings are: 

Title Set the optional title to appear at the top of the plot. You can define 
up to three title segments: left justified, centered, and right justified 
over the plot. Each segment contains a data item selectable from a list 
or text that you can enter. You can also specify the name, size, color, 
and style (regular, bold, italic, bold italic) of the font used for the title 
display. 

Plot style Set whether chromatograms are displayed as lines or as individual 
data points or as a combination of line and bunched data points 
(averaged response). 

Legend Set (check box) to display the legend relating chromatograms colors 
and identifiers (sample name + channel + injection). 

Grid lines Select to display the horizontal and vertical lines across the chart (from 
minimum to maximum) at each major division (i.e. labeled divisions) of 
the X- and Y-axes. The grid lines, when shown, are closely spaced 
dashed lines in black. 

Axis titles and 
units 

Set to label the X- and Y-axes with the quantities plotted. For the X-
axis this label (when shown) is always Time (min). The Y-axis label 
depends on the detector that generated the chromatogram. For 
example, chromatograms from a UV/Vis detector would show 
Absorbance (mAU). 
Note that this option does not affect display of the numeric marking of 
axis divisions – these are always displayed. 
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Annotations 

You are able to select the combination of annotations that should appear on chromatograms 
(this selection is global). Each annotation type also has a set of properties that can be set. 
Many of the annotations are text objects for which the following properties can be set: 

•  Font name 

•  Font size 

•  Text color 

• Text style (regular, bold, italic, bold italic) 

•  Background color 

•  Orientation (horizontal or vertical) 

•  Border (a thin, black, rectangular line surrounding the text) 

The annotations that can be selected for display are listed below: 

Baselines Lines indicating the integration of peaks. This includes both lines 
drawn under the peak and drop lines drawn separating unresolved 
peaks. 
You can define the color and style (solid, dashed, dotted) of the 
lines. 

Component 
Windows 

Markers indicating the search window used for matching peaks to 
components defined in the method. You can define the color of the 
markers. 

Timed Events Text abbreviations indicating the position of timed events affecting 
peak detection and integration, as well as those associated with 
instrument devices (i.e. contact closures). You can specify the text 
properties as defined above. 

Legend A key that matches the curve colors to the sample identifiers. 
Although the legend is not strictly an annotation, since it appears 
above the chart, it will be treated as one. 

Peak Data  Data values associated with a peak. You can select up to three 
items to be displayed. The text properties of Peak Data annotations 
are the same as those for Peak Names. 

Peak Names Names associated with peaks that have been matched to 
components defined in the method. You can specify the text 
properties as defined above. 

User Labels Text that you enter for display on the plot. You can specify the text 
properties as defined above. 

Curve Colors 

It is important to specify different colors for chromatograms displayed in overlay mode. 
However, the various views available within the Post Run environment allow for different 
arrangements of data sets that affect what combination of chromatograms is overlaid. The 
definition of curve colors therefore allows you to determine the context in which the colors 
are used. 

Curve colors definition will consist of a user-defined set of colors to be used in turn for 
chromatograms (of a specific type). Ideally this set should be unlimited in number but if a 
limit is required to simplify the implementation that number should be 20. 
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Setting Plot Styles 

The Plot Styles dialog displays when you choose Plot Styles from the Display menu or 
from the popup menu on a chart in Post Run, Run Time, or Graphic Method Editor. The Plot 
Styles dialog contains two main sections: (1) at the top is a parameter section, displaying the 
various user-settable parameters associated with charts, and (2) at the bottom is an example 
chromatogram, showing examples of many of the plot styles. The example display provides 
you with an immediate impression of what the selections will look like on the plot.  

 

When setting Plot Styles, it interacts with the rest of the Chromera software as follows: 

1. Changes made (and saved) within the Plot Styles dialog are reflected immediately 
(as applicable) within the Run Time, Post Run, and Graphic Edit environments. 

2. The Display settings in Plot Styles and the check boxes in the Annotations dialog are 
kept synchronized at all times, so that changes in either location are reflected in the 
other the next time it is accessed. 

Set the following Plot Styles: 

Title Description 

Display  A check box to set whether a title line will be display at the top of the 
chart. 

Left Justified  Select from the drop-down list the sample identification value to be 
displayed left-justified on the title line. Select one of the following: 

<none>, Name:Channel:Injection (the standard identifier), 
Acquisition Date/Time, Channel Name, Injection Number, 
Instrument Name, Analyst, Sample Description, Sample Name, Vial 
Number 
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Centered  Select from the drop-down list the sample identification value to be 
displayed centered on the title line. Same list as for Left Justified 

Right Justified Select from the drop-down list the sample identification value to be 
displayed right-justified on the title line. Same list as for Left Justified 

Font  Set the font to be used for the title. Set this value by clicking on the 
button in the cell and selecting the required properties in the displayed 
dialog. The font characteristics that can be set are: typeface (font 
name), size (small, standard, large), and style (regular, bold, italic, 
underline).  

 

 
Plot 
Appearance 

Description 

Bunched 
Points symbol 

Define the symbol and size to be displayed on the chromatogram for 
bunched points. Set this value by clicking on the button in the cell and 
selecting symbol properties (size and type) from the displayed dialog.  

 

Plot Style Select from the drop-down list the type of data display (Line, Raw 
Points, or Bunched Points) to be used for chromatograms.  

Axis Title and 
Units 

A check box to set whether the X and Y axes on each chart will be 
labeled with a title and the unit values. 

Legend A check box to set whether a color legend will be displayed above the 
plot area. This shows the color used to plot each displayed curve on the 
chart. 

Grid Lines  Select from the drop-down list whether grid lines (None, Vertical, 
Horizontal, or Both) will be displayed on each chart (at major axis 
divisions).  
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Grid Line 
Style 

Select from the drop-down list the type of line to display (Thin, Dashed, 
Dotted, or Thick). 

Grid Line 
Color 

Select the color using a popup color chart, which is displayed when the 
down arrow in the field is clicked. 

Background 
Color 

Set the color to be used as a background on each chart. Select the color 
using a popup color chart, which is displayed when the down arrow in 
the field is clicked. 

Tooltip A check box to set whether plot information will be displayed in a tooltip 
when the mouse pointer hovers over the chart. 

 
Curve 
Colors  

Description 

Curve 1 
through  
Curve 30  

Select a color from the drop-down list for each curve (1 - 30). 

 
Baselines  Description 

Display  A check box to set whether baselines will be displayed on integrated 
chromatograms. 

Color  Set the color to be used for baselines. Select the color using a popup 
color chart, which is displayed when the down arrow in the field is 
clicked. 

Line Style  Select from the drop-down list the line style (Solid Line, Dashed Line, or 
Dotted Line) to be used for drawing baselines on the plot. 

 
Peak Names  Description 

Display A check box to set whether peak names will be displayed for identified 
peaks. 

Font Set the font to be used for the peak names. Set this value by clicking on 
the button in the cell and selecting the required properties in the 
displayed dialog. The font characteristics that can be set are: typeface 
(font name), size (small, standard, large), and style (regular, bold, italic, 
underline). 

Orientation Select from the drop-down list the direction ( Horizontal or Vertical) peak 
names (and peak data labels) will be displayed on the chart. 

 
Peak Data Description 

Display  A check box field to indicate whether peak data labels will be displayed. 

Data Item #1  A drop-down list to indicate the first data item to be displayed for each 
integrated peak. 

<none>, Alpha, Area, Area %, Capacity Factor, Final Amount, Height, 
Peak Width (5%), Peak Width (10%), Peak Width (50%), Peak Width 
(Base) Resolution, Retention Time, Tailing Factor 
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Data Item #2  A drop-down list to indicate the second data item to be displayed for 
each integrated peak. 

Data Item #3  A drop-down list to indicate the third data item to be displayed for each 
integrated peak. 

 
Peak Fill Description 

Display  A check box set whether integrated peaks will be filled with color. 

Color A color field to set the color used to fill integrated peaks. Select the color 
using a popup color chart, which is displayed when the down arrow in 
the field is clicked. 

 
Peak Search 
Windows 

Description 

Display  A check box to set whether peak search windows will be displayed. 

Selected Color Set the color to be used for the currently selected peak search window. 
The color is selected using a popup color chart, displayed when the down 
arrow in the field is clicked. 

Unselected 
Color  

Set the color to be used for all unselected peak search windows. The 
color is selected using a popup color chart, displayed when the down 
arrow in the field is clicked. 

 
Timed 
Events 

Description 

Display  A check box to set whether timed event annotations will be displayed. 

Font  Set the font to be used for the timed event annotations. Set this value 
by clicking on the button in the cell and selecting the required properties 
in the displayed dialog. The font characteristics that can be set are: 
typeface (font name), size (small, standard, large), and style (regular, 
bold, italic, underline). 

 
Default User 
Labels 

Description 

Display A check box to set whether user labels will be displayed. 

Font  Set the font to be used for the user labels. Set this value by clicking on 
the button in the cell and selecting the required properties in the 
displayed dialog. The font characteristics that can be set are: typeface 
(font name), size (small, standard, large), and style (regular, bold, italic, 
underline). 

Note that, unlike other plot labels, each user label can have its properties 
(font, background color and border) customized after it has been 
created.  

Background Set the color to be used as background on each chart. Select the color 
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Color  using a popup color chart, which is displayed when the down arrow in 
the field is clicked. 

Border  A check box to set whether user labels will be surrounded by a border. 

 
Show plot style 
for: 

You can set different plot styles for different environments of Chromera. 
Select from the drop-down list (Graphic Method Editor, Post Run, 
Reporting, or Run Time).  

Save to all plot 
styles 

A check box to set whether or not you want to save the settings to all plot 
styles. 

Save as my 
default 

A check box to set whether or not you want to save the settings as your 
default plot styles. 

Save and 
Close, Save, or 
Close 

Click the button for the action you want to perform. 
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About P lot Information 

When you want to see more information about a specific chromatogram you can view a 
summary optionally in any of three formats: 

• As a popup tooltip when the mouse hovers over the chromatogram 

• In a modeless dialog 

• In the Status panel 

P lot Information Content 

The information displayed via all three mechanisms is the same, although the format (and 
behavior) will not be identical. The data items displayed are: 

1. Instrument name 

2. Channel name 

3. Vial number 

4. Operator (the name of the user who set up the instrument for acquisition) 

5. Sample name 

6. Time and date acquired 

7. Injection number (and total number of injections) 

8. Sequence name (or Session name if acquired via Single Run mode) 

9. Method name 

10.  Run time (i.e. the data acquisition time) 

11. Time Adjustment (min) (from Channel section of acquisition method) 

12.  Sampling rate 

13.  Sample description 

14.  Sample type 

15.  Standard name (if any) 

16.  Number of identified (named) peaks 

17.  Number of components not found 

18.  Number of unidentified peaks 
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Selection vs. Current 

There is an important distinction between the behavior of the tooltip display and the other 
two forms. The tooltip is displayed when the mouse pointer hovers over a plot regardless of 
whether that is the selected plot or not. The other two forms specifically display the plot 
information from the selected plot (if any). When there is no selected plot, rather than 
display nothing in the Status Panel and/or Plot Information dialog, summary information 
about the Batch is displayed instead.  

Status Panel Display 

When the plot information is displayed in the Status Panel, it is formatted in the manner of a 
properties tree. The information is divided into categories to make it easier to view. For 
example, Instrument, Data, Sample, Peaks. 

 

Tooltip Display 

The tooltip appears when the mouse hovers over the actual plot area within the axes and not 
in the blank area between plots. 
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Dialog Display 

The Plot Information dialog displays so that it is immediately adjacent to, but does not cover 
up, the plot it references. As long as the dialog is displayed, selection of a different plot (via 
the data tree or by clicking on a plot) will update the information in the dialog. 

 

It is possible to select some or all of the text in the list box and copy the information to the 
clipboard. This could be achieved either by use of a popup menu and/or using hot keys 
(Ctrl+A = Select All, Ctrl+C = Copy). Cutting and pasting of text is not possible. 

Batch Information Display  

In the Post Run environment, when there is no selected plot, rather than have the plot status 
tab and the plot information dialog be blank, some summary information about the batch is 
displayed. The following lists the information and indicates the basic format: 

Batch: <batch name> 

Created Date/Time: <created date/time> 

Instrument: <instrument name> 

Number of samples: <number of samples> 
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Total number of runs: <Total number runs (injections)> 
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Bunched Points Symbol Dialog 

This dialog displays when the button within the Bunched Points Symbol field of the Plot 
Appearance band is clicked. 

 
 

Control Description 

Size A set of radio buttons that indicate the size of the symbol. The 
choices are: Small, Standard, or Large. 

Drop-down 
list 

Select a symbol from the drop-down list . The choices are: Plus, 
Cross, Circle, Solid Circle, Square, Solid Square, Diamond, Solid 
Diamond, Upward Triangle, Solid Upward Triangle, Downward 
Triangle, or Solid Downward Triangle. 
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Font Dialog 

This dialog displays when the button is clicked in the Font field in the Title or Peak Names 
band. 

 
 
Control Description 

<font name>  Select a font from the drop-down list to be used for plot titles. The 
list contains all available fonts on the computer. 

Font Color  Click this button to display the standard Windows color selection 
dialog. This control is only displayed when the dialog is opened 
from the Peak Names band. 

<size>  Set the size (Small, Standard, or Large) of the Title font. 

Bold  A check box to set the title in boldface type. 

Italic  A check box to set the title in italic type. 

Underline  A check box to underline the title. 
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Other Commands 

The following commands are available in Plot Control. 

Save Plot Image Saves the current chromatogram display to a file. 

Copy Image to Clipboard Copies the current chromatogram display to the clipboard 
in bitmap format. 

Copy Data to Clipboard Copies the X, Y values for the current chromatogram to 
the clipboard in text format, with one pair of values per 
line. This command will only be available when a single 
chromatogram is displayed. Alternatively, it could just 
copy the values for the selected chromatogram (but that 
is not even always displayed in Chromera currently) or it 
could copy concatenate the sets of values for different 
plots (but that implies some additional lines of 
identification would be required.) 

Print Prints the current chromatogram display to a selected 
printer. 

Print Preview Opens a preview window and displays the chromatogram 
as it is printed. 

Rescale Axes Enables the user to set minimum and maximum values 
for the X and Y axes. 

Restore Default Scaling Restores the initial display scaling. 

Export Data to Excel Displays a Save As dialog (with File Type of .xls). When 
you enter a file name, the raw data (as time, intensity 
pairs) together with header information, for the active 
curve will be saved to an Excel file (Excel 2003 .xls 
format). 
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Interaction Modes and Mouse pointers 

Interaction Modes and Mouse Pointers 

The software indicates when it is in one of the special interactive modes by displaying a 
different mouse pointer. The following pointers are used for the indicated mode or sub-
mode. 

Mouse Pointer 
Icon 

When Displayed 

 

Default pointer for plot is used for drawing a zoom box. 

 

When over an object that can be selected or moved. 

 

When over a selected component search window use the 
handles for resizing the search window or adjusting the expected 
RT in graphic edit. 

 

When over a region of a selected component and the search 
window is between handles, it is used for moving the window to 
a new location (in graphic edit). 

 

When in add component oradd event with single time value 
mode, it indicates a single time value (in graphic edit). 

 

When in add event with start and end time values it is used to 
draw a box indicating start and end times (in graphic edit). 

 When mouse is moved beyond the left hand axis of a zoomed 
plot it is used to scroll the plot to an earlier time region. 

 When mouse is moved beyond the right hand axis of a zoomed 
plot it is used to scroll the plot to a later time region. 

 When mouse is moved beyond the top axis of a zoomed plot it is 
used to scroll the plot to display a higher intensity region. 

 When mouse is moved beyond the bottom axis of a zoomed plot 
it is used to scroll the plot to display a lower intensity region. 

 
 

How  to Interact w ith the P lot - Display or Edit Mode 

In the Display or Edit mode you can interact with the plot in the following ways. 

Scaling the Chromatogram via a Zoom Box 

When the default mouse pointer is displayed and your drag the mouse across the plot area, a 
zoom box is displayed. When you end the drag, the plot is rescaled. Usual behavior is that 
the plot is rescaled such that the area of the plot enclosed by the zoom box occupies the full 
plot area. 
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Scrolling a Zoomed Plot 

When the mouse pointer is moved just outside the confines of the plot area (i.e. onto the 
border surrounding the curve) on a zoomed plot, the mouse pointer changes to one of the 
shapes shown in the table. Clicking when such a pointer is displayed will cause the plot to 
scroll in accordance with Windows conventions. For example, clicking with a down-pointing 
arrow displayed causes the document (the plot) to move upward and display a region of 
lower intensity, and clicking with a right-pointing arrow displayed causes the document to 
move leftward to display a later time region. 

A single mouse click will scroll the plot 10% of the displayed region. If the Shift key is held 
down while the moue is clicked the plot will scroll 50% of the displayed region. 

Displaying System Annotations 

The primary system annotations are baselines, component names, component search 
windows, peak data labels and event mnemonics. The default display for each type of system 
annotation is set as part of the general plot properties.  

Each type of system annotation also has its own set of the following graphic properties: 

• For baselines, you can select the color and the line type.  

• For timed events you can select some of the text properties. 

• For component names you can select the display orientation and the text properties. 

• For component search windows you can select the colors for the selected and 
unselected windows. 

• For peak data labels you can select display orientation, text properties and the data 
items to be displayed. 

Adding a User Label 

When the mouse pointer is not over any other object on the plot, one of the items in the 
pop-up menu is Add User Label. This allows you to add custom text at the location 
designated by the mouse click. Note that this means the location of the initial mouse click 
that displayed the context menu, not the mouse position when the command was selected 
(which you have no control over). 

NOTE: Entering a new User Label to an existing chromatogram will take the current format settings. 
The existing User Labels will keep their original format settings and not change to the current 
format settings. You must re-enter the User Labels to get the updated format settings. 

In addition to specifying the text, you can set its orientation (vertical or horizontal), its text 
properties, and also specify whether the label is to be locked to X and/or Y data. If the label 
is locked to X data then it always appears at the same time on the plot, regardless of the 
scaling. If it is not locked to X data then it always appears at the same relative distance 
along the X-axis (i.e. as % of time span), and therefore moves relative to the chromatogram 
topography when the scaling changes. Similarly, if the label is locked to Y data then it always 
appears at the same response level, regardless of scaling. If it is not locked to Y data then it 
always appears at the same relative distance along the Y-axis (i.e. as % of full scale). 
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Moving a User Label 

Labels can be repositioned by being dragged to a new location. If the label was defined to be 
locked to the data or to a specific location within the plot area then the lock is updated to the 
new position. 

Deleting a User Label 

Right-clicking on an existing user label will display a context menu, providing to commands 
to delete the label or delete all labels. 

How  to Interact w ith the P lot - Edit Mode 

The following additional interactions apply in edit mode. By default, a change to any graphic 
object related to peak integration or identification (e.g. adding an integration event or 
resizing a component search window) will automatically cause the data to be reprocessed. 
You are able to disable automatic processing in Preferences, in which case a Reprocess 
command will become available, so that you can update results at a convenient time. 

Setting Initial Bunching Factor 

Refer to Chromatogram Control - Bunching Factor Tool 

Setting Initial Area and Noise Thresholds 

Refer to Chromatogram Control - Thresholds Tool 

Adding a Timed Event 

You can add a timed event... 

• From the Peak Detection Method, or 
• From the Toolbar 

From the Peak Detection Method 

Selecting an event type from the drop-down list on the blank line of the events list within the 
peak detection method window sets the plot into add event mode, and the mouse pointer 
changes appropriately. At least two mouse pointers appear; one indicating a single-point 
event and another for time zone events. For the former, only a single click is required to 
define the event. For the latter, a drag is required to indicate the start and end points. If you 
perform the wrong action for the event type the following will occur: 

• A single point event is positioned at the point of the button up action. (If the you 
click the event it will be at the click point; if you drag to create a rectangle, the event 
will be at the edge of the rectangle at completion of the drag.). 

• The start of a time zone event is positioned at the start and end of the rectangle 
drawn. If you click instead of dragging, the event will not be added to the plot; 
instead the software will remain in the adding event mode, with the Start field 
empty but selected. 

Ideally the mouse pointer would change to a prohibited icon (see below) if you move it into a 
zone where the current selected event would be invalid. 
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From the Toolbar 

Clicking one of the integration event toolbar buttons (shown below) sets the plot into the add 
event mode, and the mouse pointer changes appropriately. The behavior described above 
also applies here; the only difference being that here the event does not appear in the event 
list of the peak detection method view until your indicate the position on the plot. 

   
       

BF AT NT P N I S E LM RT 

 

          

HR HF CB V +X -X T SM M UF 

Moving a timed event 

If you drag the timed event to a new location on the chromatogram, the time of that event 
will be updated in the events list. The event label being dragged is highlighted to indicate 
that you are dragging the right (or wrong) event, when two events are very close together. 

The mouse pointer changes to a prohibition sign  if you drag it into a zone where the 
event is not permitted, based on the presence of other events.  

Deleting a timed event 

A timed event can be deleted by selecting the event in the method parameters display and 
pressing the Delete key. 

Manual Integration 

There are two kinds of manual integration features. The first is Manual Baselines, which is 
simply the addition of +M and -M timed events. The second is Manual Peak Integration, 
which is a special graphical approach to the addition of User Forced integration (UF) events. 

The major difference between these two functions is that Manual Peak Integration covers 
both peak detection and baseline drawing. While UF events are in effect the standard 
integration algorithms are not active and other baseline timed events are ignored. Manual 
Baselines, on the other hand, determines only where the baseline is drawn; peak detection is 
carried out as normal (modified by timed events if present).  

You cannot nest or overlap +M/-M and UF events. 
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Manual Baselines 

Adding a new manual baseline segment 

To specify a manual baseline, select the ‘Manual Baseline’ event and drag from the required 
peak start to the peak end. As the mouse is dragged a 'rubber-band' box is drawn from the 
start point to the current mouse position. When you release the mouse button a +M event is 
added at the start time and a -M event at the end time. The Y-axis location and size of the 
box is of no consequence, since +M/-M events always use the signal level at the specified 
time. The chromatogram is automatically reprocessed so that the display and report 
information reflect the new manual baseline.  

No overlap of any kind is allowed between manual baseline segments. If you draw a segment 
that wholly contains, or is contained, by an existing segment the software will assume that the 
new segment is to replace the existing one. No confirmation is required. If a new segment 
partially overlaps an existing one, the existing segment is truncated immediately before the start 
(or after the end as appropriate) of the new segment so that no overlap occurs. 

Editing a Manual Baseline 

Manual baselines may be edited simply by dragging the start or end event to a new location. 
The same limitations on the new location described above still apply. 

Adding a component 

To define a new component in the selected data channel follow this procedure. 

1. Select the Name field in the new component row within the Peaks section of the 
method for the selected channel. A name for the component can be defined either 
by selecting an existing value from the component dictionary contained in the drop-
down list, or by typing in a new name (which will then be added to the dictionary). 

2. When a name has been defined, the retention time field will be automatically 
selected in the grid and the mouse pointer on the chart will change to an upward 
pointing arrow, indicating that the expected retention time of the component can be 
set by clicking on the chart. 

3. When you click on the chart a value will be entered into the RT field for the 
component and the search window will be set to default size (defined by Start and 
End values entered into the appropriate fields in the grid. The value set for the RT 
depends on where you click and on the current state of the chromatogram. If the 
chromatogram is integrated and you click within a peak envelope (between start and 
end times) then the calculated crest of that peak (based on curve fit, where 
applicable) will be entered as the component expected RT. If any other conditions 
apply then the time at which you clicked on the chart will be entered as the 
component expected RT. 

4. The component search window gadget is displayed on the chart as soon as you 
define the component RT and the default search window start and end times have 
been calculated.  

5. Once you click on the chart to define the component RT, the chart cursor reverts to 
the standard mouse pointer and the chart is once again in zooming mode. 

6. You can adjust the size of the component search window as required by drag-and-
drop using the start and end handles of the component search window gadget. 
Updated values for these times will be entered into the grid upon each drop. 
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Radar Window  

The radar window is a frame displayed at the top of a graphics pane, with the working plot 
below. The radar window displays the full chromatogram and highlights the portion of the 
chromatogram displayed in the working plot frame below. The radar plot uses the curve color 
and background color set for the working chromatogram, and the region of the radar plot 
showing a selection (i.e. the portion displayed in the working plot) is displayed with a 
contrasting background color. 

The relative sizes of the radar window and working plot frames within the graphics pane is 
directly adjustable by dragging a dividing bar. The limits on the size of the radar window will 
be about 5% to 95% of the size of the plot window as a whole, however it is not possible to 
hide either window completely.  A command is available to toggle display of the radar plot on 
or off.  

Annotations such as baselines, retention times, component names, labels and events will 
never be displayed on the radar plot. Nor will the peak or peaks currently selected in the 
working chromatogram be shown as selected on the radar window. 

It is possible to scale the working plot by drawing a zoom box or selection box on the radar 
window. This is a means to zoom in on a portion of the working plot that is currently not 
even displayed in the working plot at its current scaling.  

Radar plot behavior 

When a data file is loaded (under default conditions) both the working plot and the radar plot 
show the full chromatogram. 

 

If you draw a zoom box on the working plot and expand it, the display changes to something 
like the following: 
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The highlighting within the radar chromatogram shows the portion displayed in the working 
area. 

Manipulating the Radar Window 

The selection rectangle marking the portion of the full chromatogram displayed in the 
working frame is movable. Dragging it to a different part of the radar plot causes the working 
chromatogram display to be updated to display the newly highlighted region. 

It is also possible to draw a new rectangle within the radar window area. When this is done 
the region outlined on the radar window is highlighted and the working chromatogram is 
rescaled to display just that region. 
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Multi-Chromatogram Overlay 

The plot control can display more than one chromatogram at a time in an overlay format.  

 
Overlayed Chromatograms 

NOTE: This example shows only the basic plot control and does not show the associated data tree 
and/or legend that would be present to identify the chromatograms. 

As described, the Y axis on the left is associated with the primary (selected) chromatogram 
and the additional Y axes on the right indicate the different scales of the overlaid plots. An 
optional legend at the top of the plot, occupying multiple rows if necessary, indicates the 
mapping of color to the chromatogram (identified by sample ID: channel: injection 
number).   

3-D Mode 

You can also display an overlay plot in a 3-D format. When the 3-D command is issued for an 
overlaid plot the presentation changes to show the plots spaced out along a Z axis. 

 

 
 Standard Overlay Mode 

 

 
3-D Overlay Mode 
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If the area under each curve is filled in and if the order in which the plots are drawn are set 
from back to front then this would effectively provide a hidden line display, as shown in the 
following example. This makes it much easier to track the peaks in each chromatogram. 

 

 





 

 

Processing 
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Processing 

The processing of detector channel output is the complete integration of the digital signal 
stream. A separate set of peak detection parameters (including an integration events list) is 
available for each detector channel configured on the instrument. 

By default acquired data are processed according to the specified method but there is an 
option to suppress processing (and/or report generation) when a sequence is run. 

What is Data Analysis? 

Data analysis is the process by which Chromera interprets the data obtained from an 
instrument and stored in the database. The outcome of this interpretation is stored as results 
within the database. 

Chromera analyzes data at three different points: 

• Immediately after the software collects the data from an instrument and stores it in 
the database. This is the original data analysis. 

• When you reprocess a batch of raw data using the Reprocessing function. 
• When you reprocess an individual raw data set using the Graphic Method Editor or 

Optimize Results function. 

Data Analysis Parameters 

Chromera acquires and analyzes data based on the values (parameters) you enter in a 
method. A method consists of four sections — instrument, channels, peaks, and calibration 
— each of which has its own set of parameters that guide their respective parts of the 
analysis. 

The instrument and channels sections are essential to all methods. Peaks and Calibration 
parameters are essential to identifying peaks and calculating component amounts. A 
separate but related file, the report format, defines the contents and layout of the printed 
report containing the results of the analysis. 

How  the Method Controls Data Analysis 

For every injection, you define the method parameters you want to use to analyze the data. 
For a series of injections, this is done through the sequence file, where you can use different 
methods to define the instrument, processing, and calibration parameters. This sequence file, 
which you create using the Sequence Editor, defines how you want Chromera to acquire and 
analyze the data from a particular series of injections. 

When you initialize and set up an instrument to acquire data from these injections, you 
specify the sequence name. Chromera then acquires and analyzes the data based on the 
information in this sequence. 

For more information on how to create and modify a sequence file, please refer Sequence. 
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Overview  of the Steps in Data Analysis  

There are distinct steps in the data analysis process. Some of the steps in data analysis are 
optional — their occurrence depends on the information you provide in the method and 
sequence. For example, you can omit from the method instructions for adding component 
names to peaks, generating a report and plot, and running a user program during analysis.  

Also, the calibration step is relevant only when Chromera analyzes the data from a standard 
sample. 

When you reprocess data, you can choose which steps you want to perform as part of the 
reprocessing operation. For example, you can start with component identification or 
quantitation and end with report generation. As analysis proceeds from one step to the next, 
the icon at the bottom of the screen changes to reflect the step currently under way. 

The following is a brief description of each step of data analysis. More detailed information 
about each step (except report generation) is discussed in the appropriate section. 

Channel Extraction — When the chromatographic channels defined in the method are 
extracted from the spectral array. 

Blank Subtraction — Subtracts the points in a baseline data set, obtained by running an 
instrument or a sample blank, from those in the current raw data set in order to correct the 
baseline. The results of this are stored in a modified raw data set (in addition to the raw data 
set). 

Peak Detection and Integration — Scans the data points in a raw data set (or modified 
raw data set) to find peaks. This produces a peak list that consists solely of peak starting and 
ending points. To edit peak detection parameters, refer to Peak Detection Parameters. Then 
peaks are grouped into clusters and the area under each peak is calculated. This adds final 
values to the results for peak starting and ending points, retention times, areas and heights. 
To edit peak integration parameters, refer to, “Developing Processing Parameters in the 
Method.” 

Component/Peak Identification (optional) — Determines the peak identities in the 
results by comparing their retention times with a pre-defined list of expected components 
and retention times specified in the Peaks section of the method. This step adds component 
names to peaks in the results. 

Spectral Processing — Performed solely by the Spectral Processing window either when 
requested by Chromera (post-acquisition calculations or commands to display spectral 
operations annotations or results) or by the user, from within the Spectral Processing 
window.  In either case the results will be passed back to Chromera for storage and 
display.  Only one set of spectral operation parameters will be available for each injection 
since the spectral data is common to all derived chromatographic channels from that 
injection.  Thus the identification obtained using a spectral library search of the 
chromatographic peak at 2.37 mins in derived chromatogram A will be exactly the same as 
the identification of the chromatographic peak at 2.37 mins in derived chromatogram B (it is 
after all searching on exactly the same spectrum). 

Calibration — Updates amount and response values for components during the analysis of 
calibration standards. Chromera stores calibration data, including the results of the analysis 
of standard samples, in the calibration section of the method. The calibration step in data 
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analysis also produces a report containing the current calibration data for each component. 
Refer to Calibration Parameters. 

Quantitation — Calculates the amounts of components represented by peaks in the result 
data set. These calculations are based on the peak areas or heights and on the calibration 
data for the corresponding components. This step adds component amounts to the results. 

Report Generation (optional) — Produces one or more reports containing the results of 
the analysis. You specify the reports in the Global Settings of the sequence controlling the 
analysis, or in Decision Points associated with individual sequence rows.  
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Peak Detection 

During the peak detection step in data analysis, Chromera scans the data points in a raw 
data file (or modified raw data file) to find peaks.  It saves the point data and point index 
data it collects in a file. A point index is a number indicating the position of a data point in 
the series of data points within the raw data file. 

Peak Detection Parameters 

The peak detection parameters include bunching factor, noise threshold, and area threshold. 

Bunching Factor 

The bunching factor specifies how many sequential data points in a raw data file are grouped 
in a bunch. During peak detection, Chromera counts bunches and then averages the voltage 
values of the points in each bunch. The resulting averages are assigned to bunched points. 

The following diagram shows how bunching smoothes out raw data, which helps prevent 
Chromera from identifying baseline noise as peaks. Small dots represent the raw data, and 
squares represent bunched points. In the following figure, one bunched point is shown for 
every five raw points; thus, the bunching factor is 5. Each bunched point is located at the 
same time position as the last raw point in a bunch. 

 

A bunching factor also compensates for over-sampling: that is, collecting more points than 
are necessary in a peak. Ideally, peaks will have about 20 points from start to end. This 
provides the best balance between acceptable processing time and correct peak detection 
and integration. 

If the sampling rate remains constant throughout a run, you might not be able to avoid over-
sampling because peak widths can vary, perhaps broadening later in the run. The broader a 
peak, the more points it is likely to have; thus, it can be over-sampled. 

In this situation, where both narrow and broad peaks occur in the same run, you cannot 
lower the sampling rate. However, you can increase the bunching factor one or more times 
by using a timed event. You specify the event (increasing the bunching factor) and the time 
in the run when the event will take place. 

Setting the bunching factor too high can lead to small, unresolved peaks being smoothed out 
completely, so they are undetected. The goal in setting a bunching factor by timed event is 
to maintain the number of points within the peaks reasonably close to the 20-point optimum. 



374 . Chromera User's Guide 

 

 
Too few bunched data points ( )  ca n  s m o o t h  sm a ll p e a k s , m a k       

Because bunched points are positioned at the time of the latest point in the bunch, a peak 
plotted from bunched data tends to shift to the right (refer to the above figure). This shift 
has no adverse effect on peak detection and integration because the bunched data are used 
only to identify the potential start, top, and end of a peak. After finding the potential peak 
values, the software reverts back to the bunched data points to pinpoint the actual peak 
start, top, and end. Therefore, there is no loss of resolution in calculating baseline positioning 
or peak integration. 

Stages in Peak Detection 

In order to use timed events and peak detection and integration parameters correctly, you 
must be familiar with the stages in the peak detection process. A simplified discussion of 
each stage in peak detection follows. 

Finding the Potential Peak Start 

To find the potential start of a peak, Chromera examines the difference in value between 
each bunched data point and the preceding one. If the difference exceeds the current noise 
threshold value, then a potential peak start point has been found. 

Confirming the Peak Start 

After a potential peak start is found, Chromera begins to sum the differences between each 
bunched point and the last baseline point. Because each bunched point represents an area 
slice, the sum is the accumulated area for the potential peak, as shown in the figure that 
follows. The differences between bunched points must also continue to exceed the noise 
threshold, or the peak start will be canceled. If the accumulated area exceeds the area 
threshold before a bunched point fails the noise threshold test, then the peak is confirmed. 



Processing.  375 

 

 

A peak is confirmed when it passes the area threshold test. 

After a peak is confirmed, the peak detection software scans backward from the potential 
peak start looking for the lowest raw data point. It scans backward through five bunches of 
raw data to find this minimum, but will stop the search if it reaches the end of the preceding 
peak. The lowest raw data point found in this process becomes the actual peak start. 

The following figure shows how the software finds the actual start point. In this example, the 
bunching factor is set to 2, so there are only two raw data points for each bunched point. 
Therefore, the bunched points do not rise much faster than the raw data. The potential peak 
start was found at a point well up the side of the peak because previous consecutive pairs of 
bunched points failed the noise threshold test. It is evident in this figure that, without the 
backward search, a high noise threshold would drastically alter the peak start value. The 
same principle applies to peak end values. 

 

Finding the Peak Top 

To find the top of the peak, the software first tries to identify a local maximum bunched 
point value. When a bunched point is lower than the previous one, the previous point is 
considered to be the potential peak top. To avoid finding a false peak top because of noise, 
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Chromera performs a confirmation test by summing the differences between the potential 
top and subsequent bunched points. If the sum exceeds two-thirds of the area threshold 
value, the potential peak top is confirmed. However, if a higher bunched point is found 
before the area test is passed, a new potential top is identified and the area test is restarted. 

 

I f the shaded area exceeds two-third of the area threshold,  the maximum point 
becomes the peak top. 

Note:   The reported retention time for a peak is not simply the time of the point identified as the 
peak top. The reported retention time is determined from a quadratic fit based on the five 
highest bunched data points.  

Because of this top-of-peak test, the choice of an area threshold value affects both peak 
confirmation and how shoulders are detected on the leading edge of a larger peak. Shoulders 
on the leading edge of a larger peak are not detected as peaks unless they have a 
discernible maximum point and a crest area that is greater than two-thirds of the area 
threshold. 

 

The shoulder in the first figure could be detected as a peak if the area threshold were lower. 
However, the shoulder in the second figure could not be detected automatically regardless of 
the peak detection parameter values that are used because it lacks a maximum. To separate 
this shoulder as a distinct peak, you must use the timed event S (split peak). 

Finding the Peak End 

There are two indicators of a peak end: 

• Two consecutive bunched point differences are less than half the noise threshold. 
                or 

• The start of another peak is detected. 
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Peak Separation Criteria 

Width Ratio and Valley-To-Peak Ratio are two peak separation criteria that are considered 
overlapped or separated. This determination will affect how the baseline is drawn beneath 
the peaks. In peak detection, a peak is defined as overlapped with its neighbor on the right if 
the pair meet two criteria: the valley-to-peak ratio is greater than 0.01, and the separation is 
less than 0.2w, where w is the width of the first peak in the pair. (You can change these 
values in Chromera.) Peaks defined as overlapped are assigned an overlap flag of 1; those 
not defined as overlapped receive an overlap flag of 0. A set of overlapped peaks is called a 
cluster and, by default, shares a common baseline. Peaks that are separated each have an 
individual segment of the baseline. 

The Width Ratio is the ratio of the distance(s) between the end of the first peak and the start 
of the second peak to the width of the second peak at its base (w). If this ratio is greater 
than the set value, the peaks are considered to be separated. Otherwise, they are marked as 
overlapped. 

 
Criteria for overlapping peaks 

The Valley-to-Peak Ratio is the ratio of the height of the valley between peaks (v) to the 
height of the smaller peak (p). If this ratio is less than or equal to the set value, the peaks 
are considered to be separated. 

Baseline Penetration at the Start or End of a Cluster 

In addition to checking each valley point, the 
software examines all the points of each cluster 
for baseline penetration. 

If any point penetrates the baseline, the start 
point of the first peak in the cluster is set to the 
point following the penetrator. If any of the 
final points penetrates the baseline, the end 
point of the last peak in the cluster is set to the 
point preceding the penetrator. A new cluster 
baseline is calculated, and the software 
continues testing for penetration. The software 
corrects baseline penetration at the start of a 
cluster. 
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Area Adjustment 

For some peaks, additional processing beyond dropline integration is required to obtain a 
suitable peak area. The system offers two methods to adjust peak areas: exponential 
skimming and tangential skimming. The necessity for an exponential skim is determined 
automatically by the software; however, you can also impose an exponential skim by means 
of a timed event. A tangential skim is never implemented automatically; it can only be 
imposed by a timed event. 

Exponential Skims 

An exponential skim is a curve drawn by 
using an exponential equation to 
approximate the trailing edge of a parent 
peak. The skim passes under one or more 
peaks that follow the parent. These are 
called child peaks. The area underneath 
the skim is subtracted from the child 
peaks and given to the parent peak. A 
small area above the skim is subtracted 
from the parent peak and given to the 
first child peak. All droplines, beginning at 
the end of the first child, are adjusted to 
drop only to the skim.  

 

 

 

Exponential Skim Criteria 

Peak Height Ratio, Adjusted Height Ratio, and Valley Height Ratio are exponential skim 
criteria that determine whether an exponential skim line will be used to calculate the area of 
a child peak eluting on the trailing edge of a parent peak. Chromera will not use these 
parameters if a +X timed event (which always forces an exponential skim) or a *X timed 
event (which prevents an exponential skim) is in effect. 

Peak Height Ratio is the ratio of the baseline-
corrected height of the parent peak (Hm) to the 
baseline corrected height of the child peak (Hd). 
This ratio must be greater than the set value for 
the child peak to be skimmed. To disable 
exponential skimming throughout a run, you can 
set this parameter to its maximum value 
(1.0e+06). Hm divided by Hd must exceed the 
set value for peak height ratio. 
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Adjusted Height Ratio is the ratio of the height of the 
parent above its start point (Lm) to the height of the 
child above the same point (Ld). This ratio must be 
greater than the set value for the child peak to be 
skimmed. Lm divided by Ld must exceed the set value 
for adjusted height ratio. 

 

 

 

 

 

 

Valley Height Ratio is the ratio of the baseline corrected 
height of the child peak (Hd) to the height of the valley 
between the parent and child peaks above the baseline 
(Hv). This ratio must be less than the set value for the 
child peak to be skimmed. Hd divided by Hv must be 
less than the set value for valley height ratio. 

 

 

 

 

Calculation of Exponential Skims 

Following is the equation you use to calculate an exponential skim: 

           Y = Hb + He - G(t-t0) 
where: 
Y is the height of the exponential skim at time t 
H is the height (above the cluster baseline) of 
the start of the exponential skim 
Hb is the height of the cluster baseline at the 
end of the exponential skim 
G is the decay factor of the exponential 
t0 is the time corresponding to the start of the 
exponential skim 
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Integration Timed Events 

Integration (baseline) timed events are commands defined in the processing section of the 
method that affect peak detection and/or integration at specific times during a run. Chromera 
implements compatibility rules for the list of timed events to prevent invalid combinations of 
events. For details see Compatibility Rules. 

Supported Events 

The following table provides an overview of the supported events. 

Control Description 

Set Bunching Factor A parameter in the processing section of the method that 
specifies how many sequential data points in the raw data file 
is grouped in a bunch. It can range from 1 to 99. Bunching 
factors should be based on the narrowest peak you want the 
system to detect. 

Set Noise Threshold A value that helps determines the difference between baseline 
noise and the start of a peak. 

Set Area Threshold A value that helps discriminates between noise spikes and 
peaks. As a general rule, set the area threshold to 
approximately five times the noise threshold. However, the 
optimal ratio depends on the actual peak size and signal-to-
noise ratio. 

Disable Peak Detection Stops peak detection during a run. At end time peak detection 
is enabled again. 

Inhibit End of Peak Detection When this event is in effect, the software does not attempt to 
determine the ending point of a peak. This may be used to 
include the area of a shoulder within in a peak when it might 
otherwise be interpreted as baseline.   

Enable Negative Peak Detection When this event is in effect the software will attempt to 
detect negative peaks as well as positive ones. Positive peak 
detection (+P) must be in effect before negative peak 
detection (+N) can be enabled. 

Force Start of New Peak Starts a new peak when the event occurs, regardless of 
whether a peak would normally be detected and confirmed at 
this position 

Force End of Peak The E event establishes a peak end at a specific point in time.  

Force Baseline Forces the baseline to the start of the current peak. (The 
current peak is the one on which the event occurs, or the one 
that follows the event if it occurs between peaks.) As a result, 
the preceding peak is treated as though it is resolved from the 
current peak. 

Force Common Baseline Causes the software to treat all peaks as though they were 
clustered even if they do not meet the criteria for being 
overlapped. 
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Force Horizontal Forward 
Baseline 

Projects a horizontal baseline from the time of the event to 
the end of the chromatogram or until the end of the event 
time. 

Force Horizontal Backward 
Baseline 

Projects a horizontal baseline from the time of the event back 
to the start of the run. 

Enable Valley-to-Valley 
Baselines 

Defines segment in which a baseline is drawn directly from 
each peak start to peak end (i.e. o common baselines or 
drop-lines from valley points) 

Force Exponential Skim A curve drawn by using an exponential equation to 
approximate the trailing edge of a parent peak. The skim 
passes under one or more child peaks. The area underneath 
the skim is subtracted from the child peak(s) and given to the 
parent peak. 

Prevent Exponential Skim Projects a horizontal baseline backward from the time the 
event is scheduled to the start of the chromatogram. The 
baseline is set at the voltage level and time value of the raw 
data point nearest the event placement. The software does 
not adjust the baseline to prevent penetration by valleys; thus 
the baseline remains horizontal. 

Enable Tangential Skim Use of a straight baseline segment, rather that an exponential 
curve, when skimming minor (child) peaks off the trailing 
edge of a tailing major (parent) peak. A tangential skim is 
never created automatically by the system. It must be 
accomplished by a this timed event placed between the peak’s 
start and end points. 

Locate Retention Time at 
Maximum 

Locates the peak retention time at the maximum data point 
that falls within the peak rather than attempting to fit a 
quadratic to the peak crest. 

Force Retention Time Forces the retention time of the current peak to be the event 
time. 

Enable Smooth Peak Ends Performs a Savitsky-Golay smooth of the raw data at the Start 
and End of peaks when determining the position of baseline. 
The value (representing the Savitsky-Golay smoothing 
interval) can be any odd value between 5 and 25, inclusive.  

Start Manual Baseline Defines the start and end of manual baseline for peak 
integration. 

About Bunching Factor, Noise Threshold, and Area 
Threshold Events 

Using the bunching factor (BF), noise threshold (NT)), and area threshold (AT) timed events 
allows you to override previously set values. These events take effect at the time they are 
scheduled: they do not work retroactively. For example, in the first figure that follows, the 
current area threshold is low, which enables Chromera to confirm the peak before the AT 
event occurs. The new area threshold value does not affect the confirmation of the peak. 
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In the second figure, the AT event is scheduled during peak confirmation, so Chromera uses 
the new, larger area threshold to determine where the peak actually starts. 

For best results, schedule the BF, NT, or AT timed events on the baseline as far away from 
peaks as possible. If you schedule these events at times too close to a transition from one 
peak detection stage to another, detection might differ significantly from chromatogram to 
chromatogram because of small shifts in retention time or random noise. For example, in the 
previous figure, a slight shift by the peak to an earlier retention time would move the AT 
timed event past the Confirm stage. 

Bunching Factor (BF) 

The BF event helps compensate for changes in peak width over the course of a run. Peaks 
tend to broaden as the run progresses. In these cases, scheduling this event at a higher 
value later in the chromatogram helps maintain the ideal 20-30 bunched points per peak. 

The bunching factor specifies how many sequential data points in a raw data file are grouped 
in a bunch. During peak detection, Chromera counts bunches and then averages the voltage 
values of the points in each bunch. The resulting averages are assigned to bunched points. 

Bunching smoothes out raw data, which helps prevent Chromera from identifying baseline 
noise as peaks. Small dots represent the raw data, and squares represent bunched points. 
One bunched point is shown for every five raw points; thus, the bunching factor is 5. Each 
bunched point is located at the same time position as the last raw point in a bunch. 

 

A bunching factor also compensates for over-sampling: that is, collecting more points than 
are necessary in a peak. Ideally, peaks will have about 20 points from start to end. This 
provides the best balance between acceptable processing time and correct peak detection 
and integration. 

If the sampling rate remains constant throughout a run, you might not be able to avoid over-
sampling because peak widths can vary, perhaps broadening later in the run. The broader a 
peak, the more points it is likely to have; thus, it can be over-sampled. 

In this situation, where both narrow and broad peaks occur in the same run, you cannot 
lower the sampling rate. However, you can increase the bunching factor one or more times 
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by using a timed event. You specify the event (increasing the bunching factor) and the time 
in the run when the event will take place. 

Setting the bunching factor too high can lead to small, unresolved peaks being smoothed out 
completely, so they are undetected. The goal in setting a bunching factor by timed event is 
to maintain the number of points within the peaks reasonably close to the 20-point optimum. 

 
Too few  bunched data points (*) can smooth small peaks, making them invisible 
to peak detection. 

Because bunched points are positioned at the time of the latest point in the bunch, a peak 
plotted from bunched data tends to shift to the right (refer to the above figure). This shift 
has no adverse effect on peak detection and integration because the bunched data are used 
only to identify the potential start, top, and end of a peak. After finding the potential peak 
values, the software reverts back to the bunched data points to pinpoint the actual peak 
start, top, and end. Therefore, there is no loss of resolution in calculating baseline positioning 
or peak integration. 

 

Noise Threshold (NT) 

The NT event helps compensate for changes in baseline noise. You can increase the noise 
threshold to decrease peak detection sensitivity or decrease the noise threshold to increase 
sensitivity. For example, suppose the beginning of a chromatogram is noisy because of fast-
eluting contaminants in the solvent, and this noise diminishes later in the run.  

To optimize peak detection, you would set the default noise threshold high enough to screen 
out the initial noise and schedule the NT event to decrease the noise threshold at the time 
when the noise diminishes. 

Expressed in units of microvolts, the noise threshold (NT) is the parameter that enables 
Chromera to discriminate between baseline noise and peaks. If the vertical difference 
between two consecutive bunched data points is greater than the noise threshold, Chromera 
recognizes the potential start of a peak. For example, point 4 would be detected as a 
potential peak start because the distance (b) between points 4 and 5 exceeds the noise 
threshold. Point 2 would not be detected as a peak start because distance (a) is too small. 
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The lower the noise threshold, the more sensitive peak detection will be. Conversely, raising 
the noise threshold decreases sensitivity. If the threshold is too high, however, Chromera will 
not be able to detect wanted peaks. 

Increasing the noise threshold affects peak detection. The lower the noise threshold, the 
earlier the peak start is detected, and the later the peak end. The data values at the end 
taper off to a point that is below the noise threshold. 

 
When the noise threshold is higher, peaks start and end more abruptly. 

A higher noise threshold requires a more abrupt rise between data values before a peak start 
can be detected. By the same token, the peak end is found sooner as differences between 
consecutive data values quickly reach the threshold. 

Area Threshold (AT) 

In addition to the noise threshold (NT) event, the area threshold (AT) event also affects peak 
detection sensitivity. If you are scheduling an NT event to change the noise threshold, 
schedule an AT event at the same time to change the area threshold. For example, if you are 
lowering the noise threshold to gain sensitivity, lower the area threshold as well. Otherwise, 
the system might not confirm the smaller potential peaks that the lower noise threshold 
allows it to detect. A general guideline is to set the area threshold to five times the value of 
the noise threshold. 

Area threshold is used to discriminate between noise spikes and peaks. Expressed in 
microvolts, this parameter is used after the noise threshold to confirm the potential start of 
peaks that pass the noise threshold test. 

After passing the noise threshold test, pairs of bunched data points must continue to exceed 
the noise threshold, and the cumulative sum of the bunched data points on the leading edge 
must eventually exceed the area threshold for the peak to be confirmed. 
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For example, You can have a noise spike whose first two points pass the noise threshold test, 
but subsequent pairs of consecutive bunched points fail the area threshold test. 
Consequently, the spike does not sustain a leading edge that accumulates enough area 
under it to exceed the area threshold. The spike is not detected as a peak. 

 

Another example illustrates a peak that passes the area threshold test. The sum of the 
bunched area slices on the leading edge exceeds the area threshold, so the peak is detected. 
There is no direct relationship between area threshold and the smallest peak that can appear 
on a report. To exclude all peaks smaller than 100 *V-sec, use the Area Reject setting in the 
Report Format Options dialog box. 

 
A peak is confirmed w hen it passes the area threshold test. 

Higher area threshold values make it harder to confirm a peak, and Chromera might not 
detect smaller peaks at all, especially those that appear as shoulders on the leading or 
trailing edges of larger peaks. 

A good policy when starting out is to use a low noise threshold and a high area threshold. 
This maintains a high degree of sensitivity in detecting peak starting and ending points, but 
still screens out noise spikes. You can visually optimize noise and area threshold 
settings/values for your data in the Graphic Method Editor.  

In addition to confirming a peak start, area threshold also helps determine a peak top. Refer 
to the Stages in Peak Detection. 

Disable/ Enable Peak Detection (-P/ +P) 

The pair of timed events -P and +P turn peak detection off and on, respectively, allowing you 
to disable and re-enable peak detection during a run. For example, if valve switching causes 
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noise spikes in the middle of a chromatogram, you can schedule a P event before the 
affected region and a +P event after it to avoid the detection of false peaks. 

If the software is at the point where it is searching for a peak ending point (for example, 
after the peak crest) when the P event occurs, the peak will end at exactly that point and all 
peak detection will stop. If the system is at any other point in peak detection, the process 
will stop and the current peak will not be detected. 

The +P event has no effect unless peak detection has been disabled by a -P event. Likewise, 
a -P event has no effect if peak detection is currently disabled.  

   

Without –P and +P timed events           With –P and +P timed events, peak  
insignificant peaks are detected.           detection is disabled in this region. 

 

Enable/ Disable Negative Peak Detection (+N/ -N) 

NOTE: Certain events are needed as pairs. For example, it will not be possible to include a +N event 
without also including a –N event (even if it is at the end of the run). Therefore, the name of 
this event within Chromera is simply Enable Negative Peak Detection (the disable is inherent 
when the enable expires). 

The pair of timed events +N and -N turn negative peak detection on and off, thereby 
enabling and disabling the detection of negative peaks during a run. However, positive peak 
detection (+P) must be in effect before negative peak detection (+N) can be enabled. By 
default, Chromera detects only positive signals, so a +N event must be included to have it 
detect negative peaks. 

When negative peak detection is in effect, the tests normally performed when the signal 
increases are also performed on a signal decrease. Thus, the software will detect a potential 
negative peak if a bunched data point value decreases from the previous bunched point 
value by more than the noise threshold. The negative peak is confirmed if the area 
accumulated between the horizontally projected baseline and the decreasing signal exceeds 
the area threshold. 

The following examples show the effect of the +N and -N timed events. 

• Without the +N and -N events, the negative peak is not detected, and a false 
positive peak is found. 
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• With the +N and -N events, the negative peak is detected, and then negative peak 

detection is disabled. 

 

The -N event takes effect immediately if peak detection is in the Begin or Confirm stages. 
Otherwise, it is delayed until the end of the current peak is found. 

If a +N event is added when negative peak detection is already enabled, the event has no 
effect. Likewise, nothing happens if a -N event occurs when negative peak detection is 
disabled. 

Inhibit/ Allow  End of Peak Detection (+I/ -I) 

The pair of timed events +I and -I inhibit and allow the stage in peak detection when the 
peak end is detected. When +I is in effect, Chromera does not attempt to determine the 
ending point of a peak. The -I event re-establishes peak detection for ending points.  

It is appropriate to use these events when isomers of a compound elute as shoulders on the 
trailing side of the main peak, and you want all isomers to be treated as part of the main 
peak. In this case, you can schedule the +I event to prevent Chromera from finding the end 
of the main peak, and schedule the -I event to allow peak end detection again after the last 
isomer. For example, without the +I and –I events, a peak at 31.58 minutes ends naturally, 
but the shoulder on its trailing edge goes undetected. 
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When you use the +I and –I events, the shoulder is included in the peak. 

 

The +I event forces the software to remain in the Find End stage. The result is that it will 
neither find a peak end nor detect the start of the next peak until the event is switched off. 
All data from the time of a +I event to the time of a *I event is perceived as part of the 
same peak. 

The +I event takes effect immediately, but has no impact on processing until peak detection 
naturally enters the Find End stage. The *I event takes effect immediately, and allows 
Chromera to find the first peak end it encounters, based on the current noise threshold. 

You should never use +I and -I events to group together distinct resolved peaks whose area 
you want to report as a single area. This is because the baseline that be would drawn under 
such a composite peak may be penetrated in places by the chromatographic signal.  If 
Chromera detects that this has occurred between the start of a peak and the crest (or the 
crest and the end point), it will adjust the start (or end) point to eliminate the penetration. 
(See Baseline Penetration at the Start or End of a Cluster) If this process occurs during a 
composite peak, you will get results you did not intend.  

Instead of +I/-I events, use the timed group component capability of Chromera to group 
distinct resolved peaks into a single component for quantitation and reporting. 

Force Retention Time (RT) 

The RT event forces the retention time of the current peak to be the event time.  
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The RT event can be used in combination with the User Forced Peak event (UFn). If it is 
used within a user forced events cluster with daughter peaks, the optional peak number n 
specifies to which peak the RT event is applied. 

Enable Smooth Peak Ends (+SM/ -SM) 

The SM event smoothes the beginning and ending of all peaks that start or end on a 
baseline. To illustrate this we can compare a peak before the SM event is added  to a peak 
after the SM event was added.  

 
This event applies a Savitsky-Golay smoothing algorithm to a group of n data points at both 
ends of a peak, where n can be any odd value between 5 and 25, inclusive. The algorithm 
adjusts the start and end data levels used for the baseline calculation to average baseline 
values (start and end times are not affected). The same peak after the SM event has been 
included shows the start and end point for each peak are put in the center of the noise band.  

 

The SM event is useful when a high noise level, regardless of the signal strength, or a poor 
signal-to-noise ratio makes baseline resolution a problem. It is especially useful where 
accurate, reproducible integration is critical. 

Force Baseline to Point (BL) 

The BL event forces the baseline to the start of the current peak. (The current peak is the 
one on which the event occurs, or the one that follows the event if it occurs between peaks.) 

BL causes Chromera to assign an overlap flag of 0 to the peak preceding the current peak. 
As a result, the preceding peak is treated as though it is resolved from the current peak. The 
software terminates the peak cluster at the end of the preceding peak by ending the cluster 
baseline there. Because the baseline is forced into this position, the baseline for the current 
peak is also forced to start at or near the peak start. 
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If this event occurs when peak detection is in the Begin or Confirm stages, the baseline of 
the current peak is forced to start at the bunched point representing the data bunch at the 
event's time. If the event occurs when peak detection is in the Find Top or Find End stages, 
the baseline is forced to start at the starting point of the current peak. 

When no BL event has been scheduled, a common baseline has been drawn for the two 
peaks because they meet the overlap criteria. Without the BL event, the two peaks are 
clustered and integrated by using drop lines.   

 

With the BL event when it occurs during the Find Top or Find End stages. The preceding 
peak is assigned a 0 overlap flag and thus has a valley-to-valley baseline. As a result, the 
baseline of the current peak is forced to begin at the peak starting point. With the BL event, 
a baseline is forced to begin at the peak start. 

 

You can use the BL event to reposition the theoretical baseline used for negative peak 
detection when a negative peak and a positive peak are contiguous. If the BL event is placed 
within the negative or positive peak, the theoretical baseline is moved to the level of the 
peak start. If the BL event is outside either peak, the theoretical baseline is set at the level of 
the point within whose range the event is scheduled. 

Force/ Discontinue Horizontal Baseline Forward (+HF/ -HF) 

The +HF event projects a horizontal baseline from the time of the event to the end of the 
chromatogram or until the event is turned off by a *HF event. When the +HF event is not in 
use, Chromera adjusts the baseline to avoid penetration by valleys. Without the +HF event, 
baseline placement is determined by peak separation criteria.  
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Conversely, the baseline established by the +HF event always remains horizontal. Peaks 
within the +HF event are treated as a single cluster and share a common, horizontal 
baseline. The –HF event restores normal baseline treatment. 

 

The +HF event takes effect at the time it is scheduled. The baseline is set at the voltage 
level and time value of the raw data point nearest the event placement. 

In sections of the chromatogram where the +HF event is in effect, peaks cannot have 
starting or ending points below the baseline. If the baseline intersects a peak, it is not likely 
to intersect exactly at a raw data point, so the peak starting and ending points usually lie 
some distance above the projected baseline. As a result, the area between the projected 
baseline and peak starting and ending points are excluded from the peak area. The peak 
starting and ending points usually lie above the horizontally projected baseline. 
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You must be careful where you place the +HF event. If the projected baseline is set too 
high, large areas of peaks will be submerged below the baseline and, therefore, will not be 
integrated. Some peaks might be submerged entirely and go undetected. To avoid this 
problem, do not schedule a +HF event on a peak: place it on the baseline just before the 
start of a peak. 

 

The -HF event discontinues the +HF event. Chromera then resumes evaluating each peak 
against the overlap criteria and assigns overlap flags of 0 or 1 as warranted. If Chromera is 
searching for a peak ending point when either event is encountered, the current peak will 
end at the event. Otherwise, the current peak (if any) will be discarded. 

You can schedule any number of +HF/-HF event pairs in a chromatogram, but they must not 
be overlapped. If two +HF events are scheduled in a row, without an intervening -HF event, 
the second event will be ignored. The lack of an intervening -HF event might even prevent 
Chromera from drawing a baseline. 
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Force Horizontal Baseline Backward (HR) 

The HR timed event projects a horizontal baseline backward from the time the event is 
scheduled to the start of the chromatogram. The baseline event is set at the voltage level 
and time value of the raw data point nearest the event placement. Chromera does not adjust 
the baseline to prevent penetration by valleys; thus the baseline remains horizontal. Without 
an HR event, peaks can have separate baselines. 

 

Where the HR event is in effect, peaks cannot have starting or ending points below the 
baseline. If the baseline intersects a peak, the intersection is not likely to occur exactly at a 
raw data point. Therefore, the peak starting and ending points will usually lie some distance 
above the projected baseline. As a result, the area between the projected baseline and the 
peak starting and ending points will be excluded from the peak area. This result is because of 
the algorithm that requires peak boundaries to occur at raw data points, not between them. 
With the HR event, a common horizontal baseline projects backward to the start of the 
chromatogram. 

 

To achieve the best result, do not schedule the HR event on a peak, but place it on the 
baseline between peaks or after any peak. This helps avoid baselines that are too high or too 
low. 

Force/ Discontinue Valley-to-Valley Baselines (+V/ –V) 

The +V event assigns an overlap flag of 0 to all peaks that occur while the event is in effect. 
As a result, during integration, all peaks are treated as though they are resolved, even if they 
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meet the criteria for being overlapped. Chromera draws an individual baseline for each peak 
extending from valley to valley. No peaks are clustered. Without the +V event, some peaks 
are clustered, having a common baseline. 

 

With the +V event, each peak has an individual baseline regardless of possible overlapping. 

 

The +V event takes effect at the time it is scheduled and applies to the current peak. It also 
applies to subsequent peaks. 

The -V event discontinues the +V event. Chromera resumes evaluating each peak against 
the overlap criteria and assigns overlap flags of 0 or 1 as warranted. This event takes effect 
immediately and applies to the current peak and subsequent peaks. 

Force Common Baseline (+CB/ -CB) 

The +CB event causes the software to treat all peaks as though they were clustered, even if 
they do not meet the criteria for being overlapped. A common baseline is drawn for these 
peaks. Without the +CB event, baseline placement is determined by the peak separation 
criteria.   
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With the +CB event, all peaks share a common baseline. 

 

NOTE: Even when the +CB event is in effect, the software checks the artificial cluster for valleys 
that penetrate the forced baseline. If such valleys are present, it redefines the baseline, 
where necessary, to eliminate penetration. 

The +CB event takes effect at the time it is scheduled and applies to the current peak — the 
peak on which the event is located, if any. It also applies to subsequent peaks. The -CB 
event takes effect immediately and applies to the current peak and subsequent peaks. 

Force Exponential Skim (+X) 

To ensure that Chromera creates an exponential skim, schedule the +X event anywhere 
within the parent peak on which you want the skim to start. The +X will have no effect 
unless you place it between the starting and ending points of a peak: it will have no effect if 
you place it on the baseline outside a peak. 

If you schedule more than one +X event on the same peak, only one event will be 
recognized. If you place +X events on two adjacent peaks in the same cluster, the software 
will ignore the second one because it cannot decipher multiple skims when they converge.  
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If you place +X events on non-adjacent peaks in the same cluster, the software draws 
exponential skims. However, what is drawn from the first peak will not extend past the start 
of the next peak with a +X event. 

See Area Adjustment for more information. 

Prevent Exponential Skim (–X) 

Scheduling a -X event anywhere on a peak ensures that Chromera will not create an 
exponential skim that originates on that peak. This event does not prevent the software from 
drawing a skim beneath the peak if the skim originated on a preceding peak. 

The -X event will have no effect unless placed between a peak's starting and ending points: 
it will have no effect if you place it on the baseline outside a peak.  

 

Tangential Skim (T) 

To create a tangential skim, Chromera draws a straight baseline from the starting point to 
the ending point of each child peak of a designated parent peak, as shown in the following 
figure. Such baselines are drawn for each child peak that occurs before the end of the 
cluster. The software then checks to see that the new baselines are not penetrated by the 
child peaks. Finally, new areas for the child peaks are calculated, and the difference between 
the old and new areas (the area between the tangent baselines and the cluster baseline) is 
added to the parent peak. 

 

Unlike an exponential skim, Chromera never creates a tangential skim automatically. If you 
want to adjust peak areas by using a tangential skim, you must use a T-timed event. The T 
event must be placed between a peak's starting and ending points; it will have no effect if 
you place it on the baseline outside a peak. 

If you schedule more than one T event on the same peak, the effect will be the same as 
having one T event. Avoid scheduling T events on more than one peak in a cluster. If you 
place T events on two adjacent peaks in the same cluster, the second one will be ignored. 
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Start/ End Manual Integration (+M/ –M) 

The timed events +M and -M allow you to manually integrate peaks. You place the +M event 
where you want a peak's baseline to start and the -M event where you want it to end. If 
necessary Chromera will interpolate within a data point to start and/or end manual 
integration at exactly the time you specify. 

Locate Retention Time at Maximum (LM) 

The LM event locates the peak retention time at the maximum data point that falls within the 
peak rather than attempting to fit a quadratic to the peak crest. 

Force Start of New  Peak (S) 

The S event starts a new peak when the event occurs, regardless of whether a peak would 
normally be detected and confirmed at this position. Typically, you use this event to force a 
split between a shoulder of a parent peak.  Without the S event, the shoulder on the peak at 
31.58 minutes is not detected as a separate peak. 

 
With the S event, the shoulder is integrated as a separate peak. 
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If there is no confirmed peak eluting at the time the S event occurs, the last raw data point 
of the current bunch (located at the time the event is scheduled) becomes the peak starting 
point. Also, Chromera enters into the Find Top stage. 

If there is a confirmed peak eluting at the time the S event is scheduled, the software forces 
the present peak to end on the last point of the current bunch, and a new peak is forced to 
begin. 

Force End of Peak (E) 

The E event establishes a peak end at a specific point in time. If there is no confirmed peak 
eluting at the time the E event occurs, the event will have no effect. Otherwise, the last point 
of the current bunch becomes the ending point. After this event, the software re-starts peak 
detection. Without the E event, the peak end is found automatically. 

 

With the E event, the peak end is set at the specified time. 
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About Calibration Processing 

This is an overview of the way that calibration processing is handled in the Chromera 
software. Specifics of the calibration curve types and the calculations associated with each 
are described in Calibration. 

Calibration processing uses the Replace/Average mechanism where calibration standards 
are processed in the order in which they appear in the sequence or batch, with new 
standards either replacing the existing calibration information for the identified calibration 
level in the method with values from the current calibration row, or averaging the new 
response values with those already existing in the method. The quantitation of unknown 
samples is then performed using this state of calibration for all subsequent sample injections 
in the sequence or batch, until new calibration injections are made and the calibration state 
changes again. At which point, any subsequent samples are processed using the new state of 
calibration (i.e. the current calibration factor or curve). 

As each calibration standard is processed, the peak response information from that standard 
is appropriately updated in the calibration section of the original or source method, as well as 
being stored with the batch records of the samples for which that calibration applies. In this 
way, the current version of the method file is always complete. That is, it always contains all 
of the constituent data from all the injections and replicates of its calibration, for each 
component and calibration level, since each level was last replaced. What this mechanism 
enables is the ability to acquire and process new data from unknown samples using the fully 
calibrated state of the current method, without making any new calibration injections, or 
without specifying new calibration standards in a sequence or batch. 

This mechanism requires two new sample types to be available in the sequence: 

Calib: Replace               A calibration standard for which the first injection replaces any 
existing calibration data for that standard (level) and any replicate 
injections are averaged with the first injection results. 

Calib: Average              A calibration standard for which results from all injections are 
averaged with the existing calibration for that standard (level). 
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How  Calibration Works 

The following steps outline how calibration works in the saving of the calibration information 
generated during data processing. 

1. The method always contains the entire table of calibration data history relevant to 
that method since each calibration level in the method was last replaced. 

2. It is possible to reprocess and re-quantitate a set of samples from a sequence or 
batch without the need to have calibration standards in the sequence. The 
calibration information to be used for quantitating those samples comes from the 
current state of calibration in the method specified for each of the rows in the 
sequence or batch. 

3. When a new calibration standard is analyzed using the Calib: Replace/Avg option for 
a calibration level of a method specified in the sequence, the peak responses (i.e., 
peak areas and heights) will replace those values currently existing in that method, 
for each of the identified compounds detected for that level in that calibration 
standard. The calibration factor or calibration curve is updated accordingly. 

4. When a new calibration standard is analyzed using the Calib: Average option for a 
calibration level of a method specified in the sequence, the peak responses (i.e. peak 
areas and heights) will replace those values currently existing in that method, for 
each of the identified compounds detected for that level in that calibration standard. 
The calibration factor or calibration curve is updated accordingly. 

5. The complete record of each calibration replicate, not just the cumulative averages, 
is saved in the method along with a reference to the associated raw data, so that the 
method contains all of the discrete processed calibration values, as well as the 
means to identify the original raw calibration data. The purpose for maintaining the 
discrete values within the method is to provide the ability to exclude individual 
calibration points and/or replicates, if desired, from quantitation of samples using 
that method. 

6. The complete set of calibration information used to quantitate a sample, including 
the replicate values, is saved with that batch record for that sample. 

7. Calibration standards will also be processed as any other sample. That is, quantitated 
amounts are calculated for them so sample reports can be printed for them, if so 
desired. 
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Calculations 

Calibration 

Average Calibration Factor 

The calibration factor for a component is the ratio of response (area or height) to (known) 
amount in a standard for external standard calibration, or the ratio of response-ratio to 
amount-ratio for internal standard calibration. This is effectively a single point linear fit forced 
through the origin.  

To obtain the average calibration factor (ACF), the calibration factors for all replicates are 
averaged using the equation: 

 
where: 

ACF is the average calibration factor 

Rspi is the response (response ratio in the case of 
internal standard calibration) for the i th replicate of 
the standard 

Amti is the amount (amount ratio in the case of internal 
standard calibration) for the i th replicate of the 
standard 

n  is the number of replicates for the standard 

 

For components using average calibration factor, the ACF value replaces the Slope value 
currently displayed for components using linear fit. This should be clearly indicated as 
Average Calibration Factor. No r2 value is calculated for ACF components. 

 

Scaling and Weighting 

Amount Scaling 

The software will offer alternatives to simply plotting response as a function of amount or 
response ratio as a function of amount ratio. For example, you can choose to plot response 
as a function of the log of the component amount. Or, in the case of internal standard 
calibration, you could plot response ratio as a function of the ratio: 

       
where: 

xcomp is the component amount 
xistd  is the internal standard amount 

          . 



402 . Chromera User's Guide 

 

The following is a list of the available functions for amount scaling: 

1/x            Response is a function of the reciprocal of the amount. 
1/x2          Response is a function of the reciprocal of the square of the amount. 
log(x)        Response is a function of the base-10 log of the amount. 
1/log(x)     Response is a function of the reciprocal of the log of the amount. 

Use of these scaling alternatives rules out some values for amount that otherwise would be 
allowed. Specifically, the amount 0.0 cannot be used with 1/x or 1/x2 scaling. Also, amounts 
less than 1.0 cannot be used with a logarithmic option; otherwise, an invalid operation will 
result. 

Weighting 

As shown in determination of least squares fit in Quadratic and cubic curve fits, different 
weighting can be applied to the various data points (levels) in the calibration curve.  

The following is a list of the available functions for weighting: 

1/X        The reciprocal of the point’s amount value 
1/Y        The reciprocal of the point’s response value 
1/X2       The reciprocal of the square of the point’s amount value 
1/Y2       The reciprocal of the square of the point’s response value 

Exclusion of Replicates 

It is possible to eliminate any replicate data point from the calibration, on a component-by-
component basis. When a point is excluded the calibration results (curve equation or average 
calibration factor) is automatically updated to reflect the change. The excluded point is 
retained in the method so that it can be restored for use in the calibration if necessary. 

Excluded points should be shown on the calibration curve in the calibration review window 
but using a distinct color and/or symbol to indicate it is an excluded point. 

Internal Standard Calibration 

Internal standards are compounds introduced in known amounts into chromatography 
samples * both samples to be analyzed and standard samples. One or more internal 
standards can be added to a sample. 

When the internal standard method is selected, the system relates amount ratios with 
response ratios to compute the calibration curve. The amount ratio is the amount of 
component in a standard sample divided by the amount of an internal standard component 
in the same sample. The response ratio is the area or height of the component divided by 
the response of an internal standard in the same sample. 

The amount and response ratios at each calibration level contribute a data point to a 
component's calibration curve. The amount ratio is the x coordinate (the independent 
variable), and the response ratio is the y coordinate (the dependent variable). For example, 
suppose a component has the following calibration data: 

Component Internal Standard 
Amount  Response Amount  Response 

10 10,000 10 10,000 
20 40,000 10 10,000 
30 90,000 10 10,000 



Processing.  403 

 

 
Using a quadratic curve fit, the system would generate the calibration curve. 

 
Method 

Internal standards will be treated in the method much like other sample components. That is, 
when a method for samples that contain internal standards is created, component 
information will be entered for the internal standards, as well as for the components to be 
quantified. This information includes calibration level data. Like other components, internal 
standards can have multiple calibration levels. 

Frequently, the amount of internal standard added will be the same for all calibration levels 
(and often in unknown samples as well), but, as long as the response for both components is 
linear, this will not be required to be the case. In some instances it is not practical to 
maintain exactly the same amount of internal standard in every sample, which is why the 
calibration curve plots response ratio against amount ratio, to eliminate any such variation. 
This is also why Chromera will support entry of individual amounts for multiple internal 
standards in the sample row of the sequence. 

 Computation of the Calibration Curve 

After a calibration replicate for a component is added to the method, the software will 
compute or recompute the component's calibration curve (except in the case of Average 
Calibration Factor calibration, when the ratio of response to amount is calculated for each 
replicate in all of the levels and averaged together to give the average calibration factor 
(ACF), as described in detail elsewhere). 

The data used to create a calibration curve depend upon the calibration method specified: 
internal standard or external standard.  

If the external standard method has been specified, the curve will show the relation between 
amount and response values. Response can be either the peak area or the peak height, 
whichever is specified for a given component in the method. 

If the internal standard method has been specified, the curve will show the relation between 
amount ratios and response ratios. 
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Calibration Quality Metrics 

Outlier Test 

This test checks the response for each component from a calibration run against the current 
expected response. That is, the current average calibration factor or the response given by 
the current calibration curve, depending on the calibration type specified. If the response 
falls outside the percentage deviation specified by the user the result is excluded from the 
calibration calculations but the result is retained within the calibration information for the 
method. In other words this test acts in the manner of a user reviewing calibration results 
and marking the replicate to be excluded from the calculation of calibration curve or ACF. 
When the user does review the calibration results the replicate is shown as excluded, so that 
he/she can include again if required. 

NOTE:  The outlier test is not performed if there is no existing calibration to compare the current 
result against (e.g. if the current standard is the first data at that level).  For internal 
standard analyses the outlier test is performed using the response ratio and not the raw 
response. One implication of this is that the outlier test is not performed on internal standard 
peaks themselves, only on the components associated with internal standards. Thus all 
internal standard replicate data are always reported and never excluded as will occur when a 
target component replicate fails the outlier test. 

Confidence Limits Test 

The following is an outline of the test.  

For any normal distribution, the confidence limits of the distribution can be expressed as 

 
where: 

µ is the true mean 

x-bar is the average of the replicates 

t  is the coefficient for the confidence interval at (n-1) 
degrees of freedom 

s is the standard deviation of the replicates 

n is the number of replicates 

 

To find if a given value is within the confidence interval, the right side of the equation is 
calculated compared to the value of interest. Chromera tests the hypothesis that.. 

 

or  rearranged 
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The first pass calculates the limits for the distribution without the current replicate and 
compares them for the 95% and the 99.9%. The second pass calculates the limits for the 
distribution including the current replicate at the same points. 

The above equations were derived from the discussion of confidence limits in J.C. Miller and 
J.N. Miller, “Statistics For Analytical Chemistry,” 2nd Ed., John Wiley and Sons, 1988, pp. 
41ff. 

The values for t were taken from a table in G.E.P. Box, W.G. Hunter, and J.S. Hunter, 
“Statistics for Experimenters,” John Wiley and Sons, 1978, p. 631. 

TotalChrom reports confidence limits ranges and such an approach is probably adequate for 
Chromera also. The ranges reported by Chromera are: 

1. Insufficient data for outlier test (<3 replicates) 

2. Significant outlier (failed at 99.9% 2nd pass) 

3. Probable outlier (failed at 95% 1st pass, failed at 95% 2nd pass) 

4. Probable outlier (failed at 95% 1st pass, failed at 99.9% 1st pass) 

5. Probably not outlier (failed at 95% 1st pass, passed at 99.9% 1st pass)  

6. Not outlier (passed at 95% 1st pass) 

NOTE:  The Confidence Limits test does not exclude any values from the calibration; it simply reports 
the confidence level for each replicate within the calibration (for each component). 

Component Amount 

Using Average Calibration Factor 

For external standard calibrations, the preliminary unknown amount is calculated as: 

 
where: 

Amtc is the amount for the component 
Rspc is the response for the component 
ACFc  is the average calibration factor for the component 

 

For internal standard calibrations, the preliminary unknown amount is calculated as: 

 
where: 

Amtc  is the amount for the component 
Rspc is the response for the component 
Rspis is the response for the internal standard 
Amtis is the amount of the internal standard 
ACFc is the average calibration factor for the component 
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Final Result 

Calculation of the reported amount (concentration) of a component in an analyzed sample in 
Chromera is basically a three stage process: 

1. Determination of the preliminary amount (or amount ratio) by solving the 
component’s calibration curve equation or by applying a calibration factor.  

2. Conversion of the amount ratio to amount by multiplying by the associated internal 
standard amount in the sample, where applicable (i.e. components using curve fit 
and internal standard calibration).  

  
where: 

A is the corrected component amount 

Aratio is the initial component amount ratio 

IS is the internal standard amount (taken from the 
sequence) 

3. Calculation of the final adjusted component amount using the following equation: 

 
where: 

Ainit  is the initial component amount (after ISTD 
correction where appropriate) 

DF is the Dilution Factor value from the sequence  

m is the Multiplier from the sequence 

d is the Divisor from the sequence 

S is the Sample Amount value from the sequence 

a is the Addend from the sequence 

Relative Retention Time (RRT) 

If a RRT reference peak has been defined in the method, this value is calculated for each 
peak in the run, using the equation: 

 
where: 

RTobs is the observed retention time of the peak 
RTref  is the observed retention time of the RRT reference 

peak 
void time is the observed retention time of an unretained peak 

           
This value is calculated for reporting purpose only and is not utilized in the peak identification 
process. 
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System Suitability 

System Suitability 

System Suitability values are calculated for all identified and unidentified peaks (where 
sufficient information exits) for all sample types. The values calculated are defined below. All 
calculated values are stored in the results data and will therefore be available for reporting. 

Peak Width 

Peak width at base is determined by performing a linear fit on the points between 60 - 80% 
of the baseline-corrected peak height (for both leading and trailing edges of the peak) and 
then finding the intersection of these lines with the baseline drawn under the peak. The base 
width is the time between the two intersections. If the peak is highly unresolved then this 
process may not be possible (e.g. the signal changes from +ve slope to –ve slope, or vice 
versa within the 60-80% region) and hence no value is available for peak width at base. 

Peak width at a specified percentage (e.g. 5%, 10%, 50%) of peak height is calculated in 
the following way.  Starting at the peak crest (which determines the corrected peak height) 
the software scans the preceding data (and then the data following), recalculating the 
corrected peak height for each data point, until the data points encompassing the desired 
percentage of peak height are located.  An interpolation is then performed to determine the 
exact times at which the desired fractional peak height occurs.  The peak width is the 
difference between these two times. 

Theoretical plates by the tangential method 

For ASTM and USP compliance, system efficiency Nsys is calculated using this equation: 

 

where: 

Tr is the peak retention time 
W is the calculated peak width at base (see Peak Width for the 

calculation) 
 

For BP compliance, the width of the peak is measured at half its height, and system 
efficiency Nsys is calculated using the equation: 

 

where: 

Tr is the peak retention time 

Wh/2 is the peak width at half height (in the same time units as 
Tr) (see  Peak Width for the calculation) 
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NOTE:  BP 2005 shows the multiplier to two decimal places only (5.54), although the traditional 
version of this equation (e.g. “Basic Relationships of Gas Chromatography” L.S. Ettre 1977) 
uses the factor 5.545. 

NOTE:  USP 29 states that the above equation may be convenient when an electronic integrator is 
used, but that "in the event of a dispute, only equations based on peak width at baseline are 
to be used." 

Theoretical plates by the Foley-Dorsey approx imation 

The Foley-Dorsey method provides a significantly more accurate calculation of theoretical 
plates than the tangential method. Foley-Dorsey assumes an exponentially modified Gaussian 
distribution as the skewed peak model. The equation for system efficiency Nsys is: 

 
where: 

Tr is the peak retention time 

W0.1 is the peak width at 10% of peak height. Again the value is in 
the same time units as Tr. (see Peak Width for calculation) 

B/A is an empirical asymmetry ratio (A is the width of the front half 
of the peak at 10% height and B is the width of the back half - 
so that A + B = W0.1 

 

Tailing factor (Symmetry Factor - BP) 

The tailing factor T is calculated by the equation: 

 
where: 

W% is the peak width at the specified % peak height (5 or 10 - see 
Peak Width for the calculation) 

f is the width (time) between the peak maximum and the front 
edge of the peak at the specified % peak height (5 or 10) 

NOTE:  USP 29 and BP 2005 only reference 5% of peak height for W and f measurement. 
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Alpha 

The alpha value reported for a given peak is the relative retention of that peak to the 
previous named peak.  
Alpha (relative retention) is calculated by the following equation: 

 
where: 

 

αp2p1 is the relative retention of peak 2 

Tp1 is the retention time of peak 1 

Tp2 is the retention time of peak 2 

Tv is the void time (retention time of an unretained peak) 

Capacity factor (k ′) 

The capacity factor is calculated using the following equation: 

 
where: 

Tr is the peak retention time 
Tv is the void time (retention time of an unretained peak) 

 

Resolution 

The resolution reported for a given peak is the value calculated between itself and the 
previous named peak. For USP compliance, resolution is calculated by the following equation: 

 
where: 

Rp2 is the resolution of peak 2 

Tp1 is the retention time of peak 1 

Tp2 is the retention time of peak 2 

Wp1   is the width at the base of peak 1 (in the same time units as 
the RT measurements) 

Wp2 is the width at the base of peak 2 

         



410 . Chromera User's Guide 

 

 
where: 

Rp2 is the resolution of peak 2 

Tp1 is the retention time of peak 1 

Tp2 is the retention time of peak 2 

Wp1, h/2 is the width at half-height of peak 1 

Wp2, h/2 is the width at half-height of peak 2 

 

For BP compliance, resolution is calculated by the following equation: 

 
where: 

Rp2 is the resolution of peak 2 

Tp1 is the retention time of peak 1 

Tp2 is the retention time of peak 2 

Wh1/2 is the width of peak 1 at half height (in the same time units 
as the RT measurements) 

Wh2/2  is the width of peak 2 at half height 

 
     



Processing.  411 

 

Display Data Sets 

A Batch can contain data from many Samples. For example: 

 

Each Sample run can include chromatograms from several channels. For example: 

 

Each Sample can be injected multiple times (replicates).  For example: 

 

The default view of the Post Run graphics display reflects the above structure: samples 
displayed in rows, channels in columns and replicates in layers, in a 2-D format so that any 
single layer can be displayed or all layers can be displayed at once (overlaid). You can 
change these default settings; for example the channels could be displayed in rows, the 
replicates in columns and the samples in layers. 

Since not all data sets to be displayed will contain multiples of each element (sample, 
channel, replicate), Chromera also provides other predefined views that are suitable for 
displaying simpler data sets. 





 

 

Reports (Report Format Wizard) 
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About Reports 

Chromera provides you with complete control over the data content of reports within a set of basic 
report formats. 

Most of the printed output is handled through the reporting system, with the exception of some 
direct printing from other controls (such as the Plot Control). Reports include: the output of sample 
results (both single injection and replicate injections), summaries of multiple samples, calibration 
results, method parameters and sequence information. The options of format and content available 
differ considerably for each of these categories of reports; from none for method printouts (other 
than section selection) to extensive, for sample and summary reports.  

A key benefit is that graphics are generated at the time the report is rendered and each is 
optimized for the space allocated for it in the report template; thereby providing a consistently high 
quality of plot regardless of the size.  
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About Report Templates 

You can create report templates through the Report Format Wizard for your needs. In essence 
these templates provide a set of structured containers into which you can insert the specific data 
items to report.  

Once a template has been generated using the Wizard it can be modified using essentially the 
same user interface. See Report Format Wizard for complete details. These report templates are 
stored in the database and may be referenced in Report Decision Points or as sequence-wide 
reports (Per Sample or Per Injection). 

There are five types of reports: 

Sample Single or multiple injections of one sample 

Summary Results from multiple samples 

Calibration  Calibration curves, statistics and standard results 

Sequence  Information from each defined row 

Method Instrument, processing and component parameters 

 

 Some of the report types are available in more than one basic format.  

Page Setup 

The template definition includes the orientation of the page (portrait/landscape) and the size of the 
page margins (top/bottom/left/right) but not the paper size, as this is determined when the report 
is generated. If the report is printed, it is adapted to fit (as closely as possible) the default paper 
size contained in the printer. If the report is to be saved to a file, then paper size (where 
applicable) is the default paper size in the default printer. 

Sample Reports 

Sample Reports show results from a single sample injection and those showing average results 
from multiple injections (replicate reports). There are several variations of the Sample Report but 
all are derived from a single basic structure. 
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A Sample Report consists of the following elements:  

Page Header A single line of information identifying the report that appears on 
every page (except, optionally, the first page). 

Title A text title (up to 50 characters) and optional logo graphic that 
appears at the top (but below the page header) of the first page 
(and optionally on every page). 

Data Header Information identifying the sample and/or other identifying 
information. Multiple lines of data can be defined. 

Chromatogram Plot(s) The chromatogram from the sample injection (or 
chromatograms in the case of a multi-channel or replicate 
report). The chromatogram plots block may contain one 
chromatogram (single injection sample report with one data 
channel) or several (multi-channel sample or replicate report). 
Multiple chromatograms may be overlaid on the same plot or 
displayed in separate plots.  

Peak Table   The results for components/peaks found in the run. 

Signature Block Up to two lines providing space for signatures indicating report 
review and/or approval. 

Page Footer A single line of information identifying the report that appears on 
every page (except, optionally, the first page). 
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Summary Reports 

Summary Reports shows data for identified peaks (only) from multiple sample injections. This can 
be multiple injections from one sample or single injections from multiple samples, or any 
combination. The components results are presented in a tabular form where there is one row per 
injection and a set of repeating columns for each component. There are three variants of the 
Summary Report but all of them are derived from a single basic structure: 

 

A Summary Report is generally shown in landscape orientation, but this is a user defined option.  

A Summary Report consists of six elements:  

Page Header A single line of information identifying the report that appears on every 
page (except, optionally, the first page). 

Title A text title (up to 50 characters) and optional logo graphic that appears 
at the top (but below the page header) of the first page (and optionally 
on every page). 

Data Header Information identifying the samples and/or other identifying information. 
Multiple lines of data can be defined 

Peak Table The results for components found in the runs 

Signature Lines  Up to two lines providing space for signatures indicating report review 
and/or approval. 

Page Footer A single line of information identifying the report that appears on every 
page (except, optionally, the first page) 
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Calibration Reports 

Calibration Reports show the results of calibrating a method containing a list of components with a 
set of standards. There are two basic forms of a Calibration Report:  

 
Detailed Calibration Report 

Structure            

 
Condensed Summary Calibration Report 

Structure 

1. A detailed report, which includes not only the calibration curve, equation and statistics for each 
component but also the full results from each standard run. 

2. A summary (or condensed) report that includes the calibration curve, equation, statistics and 
average results for each standard level in a much more compressed format.                

The two formats share the five common report elements. Any element can be omitted from the 
basic structure. The space on the page occupied by each block depends on the contents and 
properties defined for it. Omitted blocks occupy no space on the page: 

Page Header A single line of information identifying the report that appears on every 
page (except, optionally, the first page). 

Title A text title (up to 50 characters) and optional logo graphic that appears 
at the top (but below the page header) of the first page (and optionally 
on every page). 

Data Header Information identifying the samples and/or other identifying information. 
Multiple lines of data can be defined. 

Signature Lines  Up to two lines providing space for signatures indicating report review 
and/or approval. 

Page Footer A single line of information identifying the report that appears on every 
page (except, optionally, the first page). 
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The detailed report also contains the following elements (which are repeated for each component 
in the method): 

Calibration Curve A graph plotting the response obtained from each injection of each 
standard 

Equation Data A display of curve type, equation, intercept, slope and goodness of fit 
coefficient (r2) 

Results Table A table listing selected results from each injection of a particular standard 
level (repeated for each level) 

              

In addition to the common elements the condensed report contains an element that is a hybrid of 
some of the above: 

Calibration Data       Includes the calibration curve, the equation data and a table listing the 
average response and %RSD at each standard level 

Equation Data 

The equation data block is a simple listing of values related to the calibration equation: 

Calibration Type  The order of the equation used to fit the curve to the data (from the 
method). [Linear, Average Calibration Factor] 

Equation The equation derived from the calibration data  
[or Average Calibration Factor if that type applies] 

Curve Statistics Intercept, Slope and r2  [Intercept and Slope only appear for Linear]  
(Note that the term Correlation Coefficient is not used since it is only 
applicable to linear fits) [For Average Calibration this line is replaced with 
one that shows the %RSD for the results] 

 

NOTE: If an equation does not exist for a component for any reason then the Equation field and all related 
fields (Intercept, Slope, r2) will be blank.  

Calibration Data 

This element (used within the condensed summary calibration report) contains several of the 
elements described previously but compressed into a smaller space.  
The summary results information is preceded by display of the number of standards (levels) 
defined. The table will always contain the following columns and is not configurable: 

• Standard [standard/level name from the method] 

• %RSD  calculated from all injection at the current level 

• Avg. Response Average response (area or height) from all injections of                                    
the current standard 

NOTE: Whether the %RSD and Average Response values are calculated from area or height depends on 
which was used for the calibration curve, which in term is determined by the Quantify Using 
parameter from the calibration section of the method. 
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Sequence Report 

A Sequence Report shows information from a specific sequence. There are two basic forms of a 
Sequence Report:  

 
Sequence Detailed Report 

 

 
Sequence Summary Report 

 

1. A detailed report, which includes all data items from each sequence row, including full 
details of all decision points. 

2. A summary includes only values from columns of the sequence row selected by the user. 
This report does not include decision points. 

The two formats share the following five common report blocks. Any element can be omitted from 
the basic structure. The space on the page occupied by each block will depend on the contents and 
properties defined for it. Omitted blocks occupy no space on the page: 

Page Header A single line of information identifying the report that appears on every 
page (except, optionally, the first page). 

Title A text title (up to 50 characters) and optional logo graphic that appears 
at the top (but below the page header) of the first page (and optionally 
on every page). 

Data Header Information identifying the samples and/or other identifying 
information. Multiple lines of data can be defined. 

Signature Lines  Up to two lines providing space for signatures indicating report review 
and/or approval. 

Page Footer A single line of information identifying the report that appears on every 
page (except, optionally, the first page). 

 



Reports (Report Format Wizard).  421 

 

The detailed report also contains the following elements: 

Global Settings 
Block 

A structured listing of all the reports defined and the sample naming 
template. There can be two sections to the Global Settings Block:  

The first titled Per Sample Reports will only appear if you have 
defined at least one report to be generated on a per-sample-type. Each 
per sample report sub block always contains entries for Sample Type, 
Frequency, Report Template, Output Target and Output Name. In the 
case of a report where the Output Target is file then there will also be 
an entry for File Type. 

The second section to the Global Settings Block is titled Sample 
Naming Template and this will always be printed. Only one sample 
naming template can be defined. The fields will be Prefix, Vial Start, 
Number, Vial Increment, Suffix and Applies To. 

Sequence Data 
Block 

A structured listing of all the basic parameters in a sequence row. One 
block is reported for each row in the sequence. 

Decision Point 
Block 

A structured listing of decision point data (one block per decision point) 

Sequence Row 
Table 

A table showing selected data items from each row of the sequence. 

Method Report 

A Method Report shows instrument and processing parameters from a method. There is only one 
basic template for this report but it is a complex one since it presents a variety of data sets of both 
fixed and variable length. 

A very simplified form of the basic template is shown below. 
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The method report includes the following five common report blocks (any of which can be 
omitted):  

Page Header A single line of information identifying the report that appears on every 
page (except, optionally, the first page). 

Title A text title (up to 50 characters) and optional logo graphic that appears 
at the top (but below the page header) of the first page (and optionally 
on every page). 

Data Header Information identifying the samples and/or other identifying information. 
Multiple lines of data can be defined 

Instrument Block Within the Instrument block is a section for each device configured in the 
instrument. 

Channels Block Each channel section begins with channel identification, followed by a set 
of fixed parameters, which is followed in turn by a block of parameters 
(in two-column format) for each defined plot. 

Peaks and 
Calibration Block 

Within the Peaks and Calibration block is a section for each channel 
defined in the Instrument section. 

Signature Lines  Up to two lines providing space for signatures indicating report review 
and/or approval. 

Page Footer A single line of information identifying the report that appears on every 
page (except, optionally, the first page). 
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Report Format Wizard 

The Report Format Wizard enables you to tailor the basic report templates provided with the 
system to more closely match your requirements. The basic approach to reporting has been 
described in Reports along with the elements of each report type (sample, summary, calibration, 
sequence and method). The report format wizard provides a user interface that allows users to 
define the data items included in each report element and also to specify some basic formatting.  

After completing entries into the wizard you are able to save the tailored report format and then 
can specify that format subsequently when defining report output (via a sequence or directly from 
one of the main Chromera environments, where applicable). 

Running the Report Format Wizard 

There are two entry points into the wizard:  

One when you have chosen to create a new report format and one when you have chosen to edit 
an existing, saved format. Note that the terms new and saved are from the user's viewpoint. In the 
first case what you are really be doing is specifying a set of preferences to be applied to one of the 
basic PerkinElmer-supplied templates, and in the second case you are modifying a previously 
defined and saved set of preferences. There is no case where you are expected to create a report 
format from a blank sheet of paper. 

The difference in the wizard's form and behavior between the create new format and edit existing 
format commands is that in the latter case the page on which you select the report type (sample, 
summary, calibration, sequence or method) and basic content will not appear. 

Report Format Wizard Startup Dialog 

The Initialize Report Format Wizard dialog is displayed when the Report Format Wizard 
command is chosen from the Tools menu. Select the option within this dialog to determine the 
mode in which the Report Format Wizard will be run. 
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Control Description 

Create a new report format Select this button to run the Report Format Wizard in create new 
mode. 

Select a stored report 
format 

Select this button to run the Report Format Wizard in edit 
existing mode, operating on a report format to be selected from 
the database/ 

Open a recently edited 
report format 

Select this button to run the Report Format Wizard in edit mode, 
operating on a report format to be selected from the displayed 
recently used list. 

Group/Report Format Name A tree control that displays the names of  report formats, along 
with their associated group name, in a hierarchical 
structure  when either Select a stored report format or Open 
a recently edited report format is selected. In the former 
case, all stored report formats are displayed. In the latter case 
the most recently used (MRU) list is displayed. 

The group names are displayed in alphabetical order and the 
report formats are displayed in alphabetical order within each 
group. The MRU list can contain up to 10 names and will operate 
as a FIFO list. When ten report format names exist, editing a new 
report format will displace the oldest name from the list. 

OK This button closes the dialog and initiates action based on your 
selection: 

Create a new report format – Runs the Report Format Wizard 
in 'create new' mode. 

Select a stored report format – Opens the report format 
selected in the stored formats list in the Report Format Wizard, 
running in edit mode 

Open a recently edited report format – Opens the report 
format selected in the recently used list  within the Report Format 
Wizard  running in edit mode. 

Cancel This button closes the dialog and cancels the Report Format 
Wizard command. 
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Report Format Wizard – Overview  

The title bar identifies the window as the Chromera Report Format Wizard. The window is 
designed to display a panel at the left indicating the steps (pages) in the wizard, a title and subtitle 
for the current page and a main area displaying the controls for the current page.  

 

The buttons provided at the bottom of the window are a Cancel button always present, together 
with Back (except on the first page) and Next (replaced by Finish on the final page) buttons. On 
pages where at least one entry or selection is mandatory (e.g. the first page shown above), the 
Next button is disabled until the required entries/selections have been made. 
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Report Format Wizard – Report Type 

This is the first page displayed when you choose to generate a new report format. 

 

The Next button is disabled until you make a selection in the Report type drop-down list.  Only 
the Report Type button is displayed in the panel at the left side of the dialog until a selection has 
been made for the report type. 

The selection of report type affects both the buttons displayed in the left hand panel and the 
contents of the main display area, as shown in the examples below. 
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Sample selected:  

• Report Type, Page Setup, Page Header/Footer, Title, Data Header, Plot Options, Peak 
Table, Signatures, and Finish buttons shown. 

• Thumbnail depictions of all basic sample report formats are displayed in a grid format 
(Default selection: Col 1 Row 1). 

• Description of the sample report type and its variants is displayed at the top of the page. 

• Description of the format currently selected in the thumbnail grid is displayed below the 
thumbnails. 

• An additional drop-down list (Single or multiple injections) is displayed. Note that there is 
no default selection in the drop-down list. 

• A message displays in the bottom panel of the dialog indicating the selected report type 
and variant (this appears on all pages). 

The progressively specific selections for defining the format of the sample report is described once 
the basic layout of the report type page has been shown for each report type. 

 

Summary selected: 
• Report Type, Page Setup, Page Header/Footer, Title, Data Header, Peak Table, Signatures, 

and Finish buttons shown 

• Thumbnail depictions of all basic summary report formats are displayed 

• Description of the summary report type and its variants is displayed at the top of the page 

• Description of the format currently selected in the thumbnail grid is displayed below the 
thumbnails 

• An additional drop-down list (Single or multiple data channels) is displayed. Note that there 
is no default selection in the drop-down list. 

• A message displays in the bottom panel of the dialog indicating the selected report type 
and variant (this appears on all pages). 

The secondary selection for defining the format of the summary report is described once the basic 
layout of the report type page has been shown for each report type. 
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Calibration selected: 

• Report Type, Page Setup, Page Header/Footer, Title, Data Header, Signature, and Finish 
buttons shown. 

• Thumbnail depictions of both basic calibration report formats are displayed. 

• Description of the calibration report type and its variants is displayed at the top of the 
page. 

• Description of the format currently selected in the thumbnail grid is displayed below the 
thumbnails. 

• A message displays in the bottom panel of the dialog indicating the selected report type 
and variant (this appears on all pages). 
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Sequence selected: 

• Report Type, Page Setup, Page Header/Footer, Title, Data Header, Row Table, Signatures, 
and Finish buttons shown. 

• Thumbnail depictions of both basic sequence report formats are displayed. 

• Description of the sequence report type and its variants is displayed at the top of the page. 

• Description of the format currently selected in the thumbnail grid is displayed below the 
thumbnails. 

• A message displays in the bottom panel of the dialog indicating the selected report type 
and variant (this appears on all pages). 

 

Method selected: 

• Report Type, Page Setup, Page Header/Footer, Title, Data Header, Signatures, and Finish 
buttons shown. 

• Thumbnail depictions of basic method report format is displayed. 

• A message displays in the bottom panel of the dialog indicating the selected report type 
and variant (this appears on all pages). 

 

Sample Format Selection 

Sample Format Selection 

As shown there are twelve basic formats available for Sample type reports. Select one of these 
before continuing with the next page of the wizard. You can select a specific format in one of two 
ways: 

• By selecting a specific thumbnail in the example grid. 
• By selecting options from the progressively displayed set of drop-down lists (and then one 

of the two remaining thumbnails). 

The basic characteristics that must be defined and their effect on the report (and the report format 
wizard) are indicated in the following table: 



430 . Chromera User's Guide 

 

Setting Description 

Number of injections Defines whether the report will include results from a 
single injection of the sample or average results from 
multiple injections. 

Number of channels Defines whether the report will include results from a 
single data channel or multiple data channels. 

Peak Table format Defines whether results from multiple data channels are 
reported in separate tables or merged in a single table. 
(Only applicable to multi-channel results) 

Plot position Defines whether the plot(s) (if any) in the report will 
appear before or after the peak table. (Selected via 
thumbnail display only) 

As shown above, selection of the Sample report type causes the Single or replicate injections 
drop down list to be displayed. A selection in this control will cause another drop-down list (Single 
or multiple data channels) to appear. Selection of the Multiple channels option in this control will 
cause another drop-down list 'Separate or merged peak tables) to appear. Selection of Merge 
peak data from all channels will cause another drop-down list (Sorted by) to be displayed. As 
each selection is made the grid of report format thumbnails is updated to show only those that still 
apply. For example, the following show the effect of selecting Single Injection, then Multiple 
Channels and finally Separate Peak Tables. 

Single injection selected: 

 

Examples of replicate reports are eliminated from the thumbnail grid.  

The Single or multiple data channels drop-down list is displayed. Note that there is no default 
selection in the drop-down list. 
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Multiple channels selected: 

 

The Separate or merged peak tables drop-down list is displayed. 

The descriptive text at the top of the page is updated to reflect the user's latest selection. 

Merge peak data from all channels selected: 

 

The descriptive text at the top of the page is updated to reflect your latest selection. 

The Sorted by drop-down list is displayed, allowing you to choose the order in which peaks appear 
in the merged table (default setting is by Retention Time); 
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By making selections in the drop-down lists you are following a decision tree, with the final 
selection at the end of each branch made by selecting one of the final two thumbnails remaining. 

 

 

Sample Report Type 

A summary of the form and behavior of the drop-down list controls on the Report type page for a 
Sample report appears below. 

 
 

Control Description 

Report type Select from the drop-down list (Sample, Summary, 
Calibration, Sequence, Method) the type of data 
set to be reported. 



Reports (Report Format Wizard).  433 

 

 

For the section of the table below the assumption is that the Report type selection is Sample.  

Control Description 

Single or Replicate injections Select from the drop-down list whether the report 
includes data from a single injection (run) or 
replicate injections of the same sample. 

Single or Multiple data 
channels 

Select from the drop-down list whether the report 
includes data from a single data channel or more 
than one channel. 

Separate or Merged peak 
tables 

Select from the drop-down list whether the report 
will contain a separate peak table for each data 
channel or a single peak table with results merged 
from all data channels. 

Sorted by Select from the drop-down list (Component name 
or Retention time) the ordering of peaks in the 
merged peak list. 

The descriptive text to appear at the top of the page for each combination of settings in 
the drop-down lists is shown in Report Type Descriptive Text. 

Summary Format Selections 

As shown, there are three basic formats available for Summary type reports. You must select 
one of these before continuing with the next page of the wizard. The selection of a specific format 
can be made in one of two ways: 

• By selecting a specific thumbnail in the example set. 
• By selecting an option from the displayed drop-down list (and then one of the two 

remaining thumbnails). 

The basic characteristics to be defined and their effect on the report (and the report format wizard) 
are: 

Setting Description Effects on Report 
Element(s) 

Number of 
channels 

Whether the report will include results from a 
single data channel or multiple data channels. 

Determines format 
options available for 
peak table. 

Peak Table format Whether results from multiple data 
channels are reported in separate tables or 
merged in a single table. 

(Only applicable to multi-channel results) 

(Selected via thumbnail display only) 

Determines the number 
of peak tables in the 
report. 
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Selection of the Sample report type causes the Single or multiple data channels drop down list to 
be displayed. A selection in this control causes the thumbnails display to be reduced to one (for 
single channel) or two (for multiple channels). In the latter case the final selection of peak table 
format can be made by selecting one of the thumbnails. 

The decision tree for the Summary report type is shown below. In this case the selection between 
separate peak tables or a merged peak table for multiple channel data is made by selecting the 
appropriate thumbnail.  

 

 

Report Type - Summary 

A summary of the form and behavior of the drop-down list controls on the Report Type page for a 
Summary report appears below. 

Control Description 

Report type Select one of the following Sample, Summary, Calibration, 
Sequence, or Method from a drop-down list that determines the 
type of data set to be reported. 

For the section of the table below the assumption is that the Report type selection is Summary.  

Control Description 

Single or multiple 
channels 

Select Single channel or Multiple channels from a drop-down 
list to indicate whether the report includes data from a single 
data channel or more than one channel.  

The control and its associated label are not displayed until the 
Summary selection has been made in the Report type control. 

Separate or merged peak 
tables 

Select Separate peak table per channel or Merge peak data 
from all channels from a drop-down list to indicate whether the 
report will contain a separate peak table for each data channel or 
a single peak table with results merged from all data channels.  

The control and its associated label are only displayed if and 
when Multiple channels is selected in the Single or multiple 
channels control. 

Sorted by Select Component name or Retention time from a drop-down 
list defining the ordering of peaks in the merged peak list.  

The control and its associated label are only displayed if and when 
Multiple channels is selected in the Single or multiple channels 
control and Merge peak data from all channels is selected in the 
Separate or merged peak tables control. 
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The following example screen shows the Report Type page with all Summary report type selections 
displayed. Note the spacing of the controls; there is no 'gap' even though the Single or multiple 
injections option for the Sample report type does not appear. 

 

Calibration Format Selection 

As shown above there are two basic formats for Calibration reports. For this reason no further 
controls are necessary to reduce selections and the choice between formats can be made from the 
thumbnail depictions. The options are: 

• A condensed report, fitting basic results (curve, equation, average results) from several 
components on each page. 

• A detailed report showing results for all injections of each standard level, in addition to the 
curve and equation. The data for each component occupies as much space as required.  

Sequence Format Selection 

As shown above there are two basic formats for Sequence reports. For this reason no further 
controls are necessary to reduce selections and the choice between formats can be made from the 
thumbnail depictions. The options are: 

• A tabular summary report showing data items selected by the user (on the Row 
Table page). There is one row in the table for each row in the sequence.  

• A detailed report showing every data item and decision point for each row in the 
sequence. The definition of each row occupies as much space as required.  

Method Format Selection 

There is only a single basic format for Method reports. There are therefore no further controls for 
selection and only a single thumbnail is displayed.  
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The Method report type option exists only to allow you to customize page header/footer, title and 
data header (Identification items plus general items) for the report, for consistency with the other 
report types. 

Report Format Wizard – Page Setup 

This page displays when you click the Next button (or click Page Setup) after making a selection 
for the basic report format on the Report Type page (when a new format is being generated). This 
is the first page displayed when an existing report format is being edited.  

 

Main Display Area of the Page Setup Page 

As mentioned previously, the Default paper size setting on this page is simply to define (along with 
the other settings) the page area available for data. This information is used later in the wizard to 
guide the user with regard to the amount of information that can be fitted on the page. Although 
the margin and orientation settings are stored with the resulting report template, the paper size is 
determined at the time the report is generated. 

Since default values always exist for these settings, the Next button will always be enabled on this 
page. The Back button will also be visible and enabled. 

Control (in tab order) Description 

Default paper size Select A4, Legal, or Letter from a drop-down list to 
indicate the paper size the report is designed for.  

If computer Time Zone is GMT -2 or higher (i.e. 
higher negative number) = Letter size otherwise the 
paper size is A4 



Reports (Report Format Wizard).  437 

 

Top Use the up/down arrow buttons to select the size of 
the page top margin. A units label appearing after the 
control should match the paper size (Letter or Legal 
shows in and A4 shows cm) 
Range:  
0.0 to 1.5 in - for Letter or Legal paper size 

0.0 to 4.0 cm – for A4 paper size 

Left Use the up/down arrow buttons to select the size of 
the page left margin. A units label appearing after the 
control should match the paper size (Letter or Legal 
shows in and A4 shows cm) 

Range:  
0.0 to 1.5 in - for Letter or Legal paper size 

0.0 to 4.0 cm – for A4 paper size 

Right Use the up/down arrow buttons to select the size of 
the page right margin. A units label appearing after 
the control should match the paper size (Letter or 
Legal shows in and A4 shows cm) 

Range:  
0.0 to 1.5 in - for Letter or Legal paper size 

0.0 to 4.0 cm – for A4 paper size 

Bottom Use the up/down arrow buttons to select the size of 
the page bottom margin. A units label appearing after 
the control should match the paper size (Letter or 
Legal shows in and A4 shows cm) 

Range:  
0.0 to 1.5 in - for Letter or Legal paper size 

0.0 to 4.0 cm – for A4 paper size 

 

Select Portrait or Landscape from a graphic selection 
control indicating the page orientation for the report. 

 
NOTES: (1) If you change the setting for paper size from Letter or Legal to A4 (or vice versa) the software 

will make direct conversions of any current settings for plot sizes and table column widths. (2) If 
you make some changes that affect the printable page width (e.g. changing margins or changing 
paper size) and the change results in an existing table being too wide for the page you are given 
the choice of clearing the table contents or canceling the change(s). 

Report Format Wizard – Page Header/ Footer 

This page is displayed when you click the Next button from the Page Setup page (or click Page 
Header/Footer). 
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Main Display Area of the Page Header/Footer Page 

Since default values always exist for these settings (blank header/footer lines are quite valid), the Next 
button is always enabled on this page. The Back button is also visible and enabled. 

Page Header Controls 
(in tab order) 

Description 

Left Justified A drop-down list indicating the data item (if any) to be shown 
at the left side of the header line. 

Centered A drop-down list indicating the data item (if any) to be shown 
at the left side of the header line. 

Right Justified A drop-down list indicating the data item (if any) to be shown 
at the left side of the header line. 

Font A drop-down list indicating the font (typeface) to be used for 
the header line. 

Font size A drop-down list indicating the size of the font (in pts) to be 
used for the header line. 

Do not show header on 
first page 

A check box that indicates if the header line should be 
suppressed on the first page of the report. 

Page Footer Controls 
(in tab order) 

Description 

Left Justified A drop-down list indicating the data item (if any) to be shown 
at the left side of the footer line. 
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Center A drop-down list indicating the data item (if any) to be shown 
at the left side of the footer line. 

Right Justified A drop-down list indicating the data item (if any) to be shown 
at the left side of the footer line. 

Font A drop-down list indicating the font (typeface) to be used for 
the footer line. 

Font size A drop-down list indicating the size of the font (in pts) to be 
used for the footer line. 

Do not show header on 
first page 

A check box that indicates if the header line should be 
suppressed on the first page of the report. 

Data Items available for Page Header/ Footer 

The data items that may be selected for the page header and footer lines depend on the report 
type (and format in some cases). For any given report type the contents of the six drop-down lists 
(Left Justified/Centered/Right Justified for Header and Footer) is identical. 

The items available for any given report type/format are taken from the following:      

Acquisition Method The name of the method from which the instrument parameters used during 
acquisition were taken. 

Batch Name This is the sequence used to acquire the data or a name entered in Reprocess. 

Channel Name The name of the data channel from which the results were acquired. 

Group Name The database group associated with the sequence or method. 

Instrument Name The name of the instrument from which the results were acquired. 

Method Name The name of the method being reported. 

Page n of m Where n = current page, m = total pages in the report. 

Processing Method The name of the method from which the parameters used for processing the data 
were taken. 

Report Date The date of report generation (in Long format from Regional Settings). 

Report Date/Time The date and time of report generation (using Long date format from Regional 
Settings). 

Sample Name The name associated with the sample (from Sequence row). 

Sequence Name The name of the sequence. In the case of a Sample/Summary report this is the 
sequence (or Single Run batch) used to acquire the data. 
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Report Format Wizard – Title 

This page displays when you click the Next button from the Page Header/Footer page (or click Title). 

 

Main Display Area of the Title Page 

Since default values always exist for these settings (a blank title line is quite valid), the Next button 
is always enabled on this page. The Back button is also visible and enabled. 

Controls 
(in tab order) 

Description 

Include title A check box that indicates if the title block define on this page will 
appear in the report. 

Include on every page A check box that indicates if the title block will appear on just the 
first page or on every page of the report. 

Title text An edit box to enter the text to appear in the title block. 

Title font A drop-down list indicating the font (typeface) to be used for the title 
text. 

Title font size A drop-down list indicating the size of the font (in pts) to be used for 
the title text. 

Title font style A drop-down list indicating the text style (Regular, Bold, Italic, or 
Bold Italic) to be applied to the title text. 
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Logo 
(position) 

A set of radio buttons defining the position of the logo (if any). If 
None is selected then no logo will appear even if a logo file name is 
specified. 

Left     the logo will appear to the left of the title text. 

Right    the logo will appear to the right of the title text. 

None     no logo will appear 

Logo file name An edit box that defines the file to be used for the logo. 

 
A button that displays a File Open dialog, enabling you to browse 
for and select the logo file. 

Scale (%) A spin button control to set the scale to be applied to the logo 
graphic defined by the specified file when it is included in the report. 

Style A drop-down list that defines the type of border to appear around the 
title block.  

Thickness (pts) A spin button that determines the thickness of the border around the 
title block. 

Report Format Wizard – Data Header 

This page displays when you click the Next button from the Title page (or click Data Header).  

In the actual format of the data header in the final report each data item value is preceded by the 
name of the data item. Thus Acquisition Date/Time in the final report appears something like: 

Acquisition Date/Time:            Wednesday, February 11, 2009, 3:14:10 PM 
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Since default values always exist for these settings (a blank/non-existent data header is valid), the 
Next button is always enabled on this page. The Back button is also visible and enabled. 

The contents of the Available Data Items list depends on the currently selected report type/format, 
as described later in this section. 

Controls 
(in tab order) 

Description 

Available Data Items A list box showing the data items available to be added to the data 
header block. An item can be added to the header only once. When 
it has been added to the header it is removed from the list box. 
Conversely, when the item is deleted from the data header it is 
returned to the list box. 

The items are sorted alphabetically. 

Data Header Layout A two-column grid showing the current contents of the data header 
block. The procedure by which the user builds a data header is 
described in section Building the Data Header. A single blank row is 
shown when the page is first displayed. When a data item is added 
to either cell in the blank row a new blank row will appear at the 
bottom of the header grid. 

Font A drop-down list indicating the font (typeface) to be used for the 
data header block. These include fonts available on the system, 
excluding non-alphanumeric fonts. 

Font size A drop-down list indicating the size of the font (in pts) to be used for 
the data header block. 

Data Header Layout Popup Menu 

This popup menu appears when you right click on a row in the Data Header Layout .  

Command Description 

Add Row Adds a new blank row to the end of the grid 

Insert Row Inserts a blank row above the one under the mouse pointer when the 
right button was clicked. 

Delete Row Deletes the row under the mouse pointer when the right button was 
clicked. 

Returns any data items on the deleted row to the list box. 

Building the Data Header 

Drag-and-Drop 

To add a data item to a specific position drag it from the list and drop it in the required position. 
Whether you populate both columns in a row or just the left hand column will depend on the 
expected length of the item. For example, it would be appropriate to position Sequence 
Group/Name on a row by itself but Vial Number and Injection Number (always shown as 'n of m') 
would certainly fit on the same line. 
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• When an item has been added to the header it is removed from the list box.  

• If you drop an item onto the bottom row of the header block then a new blank row is 
appended to the header. 

• If you drop an item onto a previously occupied cell, the new data item displaces the 
previous one, which is returned to the list box.  

• To reposition an item drag it from one cell in the header block and drop it on another cell.  

• You can remove an item from the header by dragging it from the header block and 
dropping it on the list box (or by deleting the row, which also returns the item to the list 
box). 

Double-Click Operation 

If you double-click on an item in the list box, that item is added to the left hand cell in the blank 
row at the bottom of the header grid, and a new blank row is appended. This is a rapid way to add 
several items that are to occupy complete rows. Of course an additional item could be added to the 
right hand column of any of these rows subsequently via a drag-and-drop operation. 

Keyboard Operation 

If you select an item in the list box and then presses the right arrow key the item is added to left 
hand cell in the blank row at the bottom of the header grid. If this key operation is repeated then 
next item is added to the right hand column of the same row. A third keystroke would add the next 
item to the left hand cell in the new blank row at the bottom of the header grid, and so on.  

If you select an item in the list box and then presses the space bar, this acts in the same way as a 
double-click operation. That is, the item is added to the left hand cell in the blank row at the 
bottom of the header grid, and a new blank row is appended. 

Data Items available for Data Header 

The data items that may be selected for the data header block depend on the report type (and 
format in some cases).  

The items available for any given report type/format are taken from the following: 

Acquisition Date The date of acquisition of the first injection of a replicate series. 

Acquisition Date/Time The date and time of data acquisition (using Long date format from 
Regional Settings)  

Acquisition Method Group name and Method name for the method used to acquire the data 

Acquisition Method 
Last Modified 

The date and time the acquisition method was last modified (using Long 
date format from Regional Settings) prior to the acquisition. In the case of 
replicate injections this refers to acquisition of the final injection. 

Author  The full name of the user logged in when the method or sequence was 
created 

Batch Description  The description from the acquisition sequence or the description entered 
for the batch in Reprocess 

Batch Group/Name The group and name inherited from the acquisition sequence or entered in 
Reprocess 

Calibration Date/Time The date and time when the calibration was performed (or completed) 
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Channel Name The name of the data channel from which the results were acquired 

Chromera Version The version of the Chromera software generating the report 

Created On Date/Time when method or sequence was created 

Dilution Factor The dilution factor associated with the sample (from Sequence row) 

Edited On  Date/Time when method or sequence last edited  

Editor The full name of the user logged in when the method or sequence was last 
edited 

Injection Number The replicate number for the sample run and the total number of injections 
made on the sample (n of m) 

Injection Volume The volume of sample injected (from Sequence row) 

Instrument Name The name of the instrument from which the results were acquired 

Method Description The descriptive text associated with the method 

Method Group/Name The name of the method – applies to Calibration and Method reports only 

Method Notes Additional descriptive text associated with the method 

Operator The full name of the user logged in when the data were acquired 

OS Version The version of the operating system at the time of report generation 

Processing Method Group name and Method name for the method process the data and 
generate current results 

Processing Method 
Last Modified 

The date and time the acquisition method was last modified (using Long 
date format from Regional Settings) prior to processing the data. In the 
case of replicate injections this refers to processing of the final injection. 

Report Date/Time The date and time of report generation (using Long date format from 
Regional Settings) 

Run Time The actual run time for acquisition (longest of all data channels plus pump 
method) 

Sample Amount Value from the sequence row for the sample 

Sample Description Value from the sequence row for the sample 

Sample Name The name associated with the sample (from Sequence row) 

Sampling Rate The rate of data acquisition  

Sequence Description The descriptive text associated with the sequence  

Sequence 
Group/Name 

The group and name of the sequence. In the case of a Sample/Summary 
report this is the sequence (or Single Run batch) used to acquire the data. 

Vial Number The vial from which the sample was taken 
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Report Format Wizard – P lot Options 

This page is displayed when you click the Next button from the Data Header page (or click Plot 
Options). This page is only displayed for Sample report types. 

The contents of the page depends on the current report type and format. The example below 
shows the fully populated page, which is displayed only for a replicate sample report for multiple 
data channels.  

NOTE: The Apex Spectrum Plot will only be valid if a PDA has been included in the current instrument 
configuration. 

    

Main Display Area of the Plot Options Page 

Controls 
(in tab order) 

Description 

Include plot(s) in 
report 

Click in the check box to include plots in the report. 

Height Type a value in the text box to set the height of each plot to be 
included in the report. If there are multiple plots in the report they will 
all be the same height. The units in which the height is set should 
match the current paper size (Letter or Legal = in, A4 = cm) 

Width A text box to set the width of each plot to be included in the report. If 
there are multiple plots in the report they will all be the same width. 
The units in which the width is set should match the current paper size 
(Letter or Legal = in, A4 = cm) 

Number of plots 
that fit across the 
page: 

A display that indicates how many of the plots defined by the 
dimensions in the previous controls would fit across the page defined on 
the Page Setup page. This value is updated whenever a change is made 
to any of the controls that determine its value. 
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Channels: Radio buttons to set how the chromatograms from multiple data 
channels are handled. These controls only appear for Sample reports 
that have been defined to include multiple data channels. 

Injections: Radio buttons to set how the chromatograms from multiple replicate 
injections are handled. These controls only appear for Sample reports 
that have been defined to include multiple injections. 

Overlays: Radio buttons to set how overlaid chromatograms are distinguished from 
one another. These controls only appear if either Channels or Injections 
has the option to overlay chromatograms set. 

Apex Spectrum Plot 
(PDA only) 

NOTE: The Apex Spectra Plot is created by the Spectral Processing 
window. It can cover multiple pages depending on the number of spectra 
associated with the selected chromatogram. 

Click in the check box to specify if the standard chromatogram plot 
should be supplemented by Peak Apex Spectrum image provided by the 
Spectral Processing window. The Apex Spectra Plot will follow, starting 
on a new page, whatever template pages are selected in the Report 
Format Wizard. 

This option will only be valid if a PDA has been included in the current 
instrument configuration. 

Report Format Wizard - Tables 

The title and contents of this page depend on the report type and format: 

• For Sample and Summary reports the title is Peak Table,  

• For Calibration the title is Data Table, and  

• For Sequence the title is Row Table.  

NOTE:  The page does not appear for the Sequence/Detailed report format. 

There are examples of the four major variants of the Table page. The Sample/Single Injection 
and Sample/Multiple Injections variants have the same page layout but differ in the data items 
available for reporting. 

NOTE:  The examples shown here indicate the general layout of the controls on the page.  
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         Peak Table page for Sample report                           Peak Table page for Summary report 

    
Data Table page for Calibration/Detailed report       Row Table page for Sequence/Table report 

 

Sample/ Single Injection Peak Table 

Sample/Single Injection Peak Table 

The layout of the Peak Table page when creating a new template is shown above.  

Control Description 

<Page title> Peak Table 

<Page 
subtitle/description> 

Specify the content and format of the peak table. 

Available Data Items Select the data items from this list box that can be included as 
columns in the peak table. You define the peak table by moving 
items from this list to the Peak Table Format grid. 
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Table font Select the font (typeface) from this drop-down list to be used for 
the peak table. 

Table font size Select the size of the font (in pts) from this drop-down list to be 
used for the peak table. 

Report Identified peak Click in the check box to indicate that the report will include peaks 
found in the run that were matched to components defined in the 
processing method.  

Report component not 
matched to peaks 

Click in this check box to indicate that the report will include 
components from the processing method that were not matched 
with peaks found in the run. Note that unmatched components are 
not included in the Peak # count. 

Report unidentified 
peaks 

Click in this check box to indicate that the report will include peaks 
found in the run that were not matched to components defined in 
the processing method. 

Display table grid lines Click in this check box to indicate if the peak table will include 
borders around each cell. 

Column header A text control which determines the heading (two lines of up to 20 
characters each) to appear at the top of the selected column in the 
peak table. 

Column width Set the width of the selected column in the peak table. The units 
in which the width is set should match the current paper size 
(Letter or Legal = in, A4 = cm) 

Alignment Select from the drop-down to define the alignment of values in the 
selected column. 

Number format Select from the drop-down to define whether values in the 
selected column are formatted by number of significant figures or 
number of decimal places. Disabled (together with caption) when 
selected data item type is text or integer. 

<number> Select from the drop-down list (or a spin control) to indicate the 
number of decimal places when Number format = Decimal Places 
or the number of significant figures when Number format = 
Significant Figures. Disabled (together with caption) when selected 
data item type is text or integer. 

Printable page width: A read-only display that indicates the usable space based on the 
defined page setup settings. 

Current peak table 
width: 

A read-only display that indicates the width of the currently 
defined peak table.  

The units in which the width is set should match the current paper 
size (Letter or Legal = in, A4 = cm) 
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Peak Table Format A two-row grid that displays the currently defined peak table. 

The Column Header text is displayed in the top row for each column 
and a simplified representation of the data type is displayed in the 
second row. 

Nothing is editable directly in the grid. 

Peak Table Format Popup Menu 

This menu appears when you right click on a cell in the Peak Table Format. The cell clicked on also 
becomes the selected cell and the Properties of Selected Column controls are updated accordingly. 

Command Description 

Add Column Adds a new blank column to the end of the grid.  

Insert Column Inserts a blank column to the left of the one under the mouse 
pointer when the right button was clicked. 

Delete Column Deletes the column under the mouse pointer when the right button 
was clicked. 

Returns any data items on the deleted column to the list box. 

 

NOTE: The blank column at the right hand side of the peak table is purely for the purpose of allowing 
items to be added to the table. When the report is generated that column will not appear. 
However, a blank column within the peak table is valid and it is rendered when the report is 
generated (i.e. a blank column may be used to add space between other columns). 

Building the Peak Table 

Drag-and-Drop 

To add a data item to a specific column in the grid drag it from the list of available items and drop 
it in the required position. The result is the same regardless of whether you drop the item on the 
header row or the second row. The header row displays the default column header text for that 
item and the second row displays a representation of the current item format.  

For example, if the Retention Time is dropped onto the empty column (initially there is only one, 
blank column) the Peak Table Format grid would show: 

 

The 'xxx.xxx' display indicates that the default format for retention time includes three decimal 
places. Since the column into which the item is dropped becomes the selected column then the 
controls in the Properties of Selected Column group display the default properties for the data item 
(see below for more details). 
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• When an item has been added to the peak table it is removed from the list box.  

• If you drop an item onto the blank column at the end of the table then a new blank column 
is appended to the right hand side of the table. 

• If you drop an item onto a previously occupied column, the new data item displaces the 
previous one, which is returned to the list box.  

• To reposition an item drag it from one column in the peak table and drop it on another 
column.  

• Remove an item from the peak table by dragging it from the grid and dropping it on the list 
box (or by deleting the column, which also returns the item to the list box). 

Double-Click Operation 

If you double-click on an item in the list box, that item is added to the empty column at the right 
hand side of the peak table, and a new blank column is added to the table. This is a rapid way to 
add columns to the table.  

 

Keyboard Operation 

If you select an item in the list box and then press the space bar, this acts in the same way as a 
double-click operation. That is, the item is added to the empty column at the right hand side of the 
peak table, and a new blank column is added to the table 

Peak Table Scrolling 

If the number of columns assigned to the peak table exceeds the width allotted to the Peak Table 
Format area, the grid can scroll below the header bar as necessary. For example: 

 

When an item is added by double-clicking the grid is scrolled automatically, if necessary, to show 
the new column. 

Maximum Table Size 

As items are added to the peak table the accumulated column width is maintained and displayed in 
the 'Current peak table width' field. If adding a column at its default width would make the total 
peak table width exceed the printable page width then one of two possibilities exists: 

1. If there is at least 0.5 in (or 1.27 cm) available (i.e. the minimum allowed column width 
could be accommodated) then the item is added with that width instead of the normal 
default width. 
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2. If there is less than 0.5 in (or 1.27 cm) available then an error message is displayed 
('Insufficient space is available for this column') and the item will not be added to the peak 
table. 

Sorting of Peak Tables 

All peak tables containing data from a single channel are sorted by retention times and peak or 
component numbers (as appropriate for the report type) will be assigned on this basis. This 
includes all single channel reports and multiple channel reports where separate peak tables are 
used for each channel. 

In the case of merged peak tables you can select (within the report template) whether rows are 
sorted by retention time or component name. This includes both single injection and replicate 
reports. 

 

 

 

Thus the complete definition of sorting for sample reports is: 

Report Type Sort By 

Single Injection, Single Channel (Plot before or after table)  Retention Time 

Single Injection, Multiple Channel, Merged Peak Table (Plot 
before or after table)  

User selected value (RT or 
component name) 

Single Injection, Multiple Channel, Separate Peak Table 
(Plot before or after table)  

Retention Time 

Replicate Injection, Single Channel, (Plot before or after 
table)  

Retention Time 

Replicate Injection, Multiple Channel, Merged Peak Table 
(Plot before or after table)  

User selected value (RT or 
component name) 

Replicate Injection, Multiple Channel, Separate Peak Table 
(Plot before or after table)  

Retention Time 

 

Properties of Selected Column 

The controls within the Properties of Selected Column group display the settings for the 
currently selected column. When no columns exist they are blank. When a data item is added to 
the peak table these controls will display the default settings for that item. For example, if the 
Retention Time item is added the display would be 
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The display of the Retention Time column header will reflect the text in the Column header 
control, and the representation of the RT in the second row will reflect the settings of the 
Alignment and Number format controls. The actual width of the column in the Peak Table 
Format display reflects the value set in the Column Width control. The default values for all 
available data items are defined below. 

Where column properties are not applicable to the current data item then those controls (and the 
associated caption) are disabled. For example, when Component Name or Peak # is the selected 
column, the Number format controls are disabled.  

The Peak Table Format display also reflects the settings for Table font and Table font size. The 
column header is also always shown in Bold style and is centered in the header cell, regardless of 
the alignment set for the data item itself. 

NOTE:  The screen display will not match precisely the printed (or stored) output. The intent here is to 
enable you to see a close approximation to the final output. 

Modifying Column Properties 

You can modify any of the displayed properties for the selected column. Changes to all controls 
(Column header, Column Width, Alignment and Number format – both drop-down list and spin 
control) will be reflected in the grids display immediately 

The modified properties remain in effect only while the data item is included in the peak table. If a 
data item is deleted from the peak table (returned to the list box) and then subsequently re-added 
to the peak table; it is restored will its default settings. 

Data Items Available for Single Injection Peak Table 

The data items available for inclusion as columns in the peak table for a single injection Sample 
report are described below. 

Data Item Description 

Absorbance Ratio The ratio of the absorbance at two user defined wavelengths.  Can be 
used for component confirmation. 

Alpha Relative retention of the peak to the previous named peak (System 
Suitability value). 

Area Area measured for the peak. 
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Area Percent Area of the peak expressed as percentage of total area for all peaks in 
the run (channel). 

Area/Amount Ratio Ratio of the peak area to its Final Amount. 

Baseline Type The codes indicating baseline treatment at the start and end of the 
peak. 

Capacity Factor (k')  Corrected RT ratioed to unretained peak time (System Suitability 
value). 

Calibration +/- Range Flag to show if peak are is above or below range covered by calibration 
standards. 

Channel Name  The name of the data channel in which a peak was found (or Analyte 
associated with Species for ICP-MS). 

Component Name  The name of the component the peak has been matched with. 

Expected Retention 
Time  

The retention time defined in the method at which the component peak 
was expected to elute. 

Final Amount  The amount calculated for the component, including dilution factor, 
multiplier, normalization factor, etc. 

Final Amount Units  The units for the final amount as entered in the method. 

Height  Height measured for the peak. 

Internal Standard 
Amount Ratio  

The ratio of the component amount to the related internal standard 
amount. This data type applies only to peaks that have been identified 
and quantified based on the internal standard method. The amount 
ratio is always based on raw amounts, never on adjusted amounts. 

Internal Standard Name  The name of the component specified as the internal standard for the 
current component. 

Internal Standard 
Response Ratio  

The ratio of a peak's response to the response of the related internal 
standard component. This data type applies only to peaks that have 
been identified and quantified based on the internal standard method. 

Normalized Area 
Percent  

The peak's percentage contribution to the total area for all peaks (for 
which results are reported). These percentages add up to the 
normalization factor specified in the sequence file. 

Normalized Amount  The adjusted amount of the peak expressed as a percentage of the 
total reported amounts. These percentages add up to the normalization 
factor specified in the sequence. 

Peak Library Search The component name plus a hit value resulting from a search in a user 
specified spectral library on each peak apex spectrum in the 
chromatogram. 

Peak Purity An estimate of the probability that the peak is contaminated with a co-
eluting component as determined using the spectral information across 
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the peak. 

Peak #  Number of the current peak within the set being reported. 

Peak Width @5% 
Height  

The width of the peak at 5% of its height (System Suitability value). 

Peak Width @10% 
Height  

The width of the peak at 10% of its height (System Suitability value). 

Peak Width @50% 
Height  

The width of the peak at 50% of its height (System Suitability value). 

Peak Width @Base  The width of the peak at its base System Suitability value). 

Raw Amount  The amount calculated for the component directly from the calibration 
curve, before the adjustments made for dilution factor, multiplier, 
normalization factor, etc. 

Reference Peak Name  The name of the component specified as the time reference peak for 
the current component. 

Relative Retention  The ratio of the peak retention time to the component specified as the 
'RRT Component’ in the method. 

Resolution  Resolution between current peak and previous peak (System Suitability 
value). 

Retention Time  The time into the run at which the peak eluted. 

Spectral Library 
Confirmation  

The hit value plus a Pass/Fail flag for the comparison between a peak 
apex spectrum of an identified peak in the sample to the spectrum with 
the same name in a user specified spectral library  

Spectral Standard 
Confirmation  

The Absorbance Index plus a Pass/Fail flag for the comparison between 
the peak apex spectrum of an identified peak in the sample to the peak 
apex spectrum of the peak with the same name in a user defined 
standard chromatogram.  

Tailing Factor  Measure of peak asymmetry (System Suitability value). 

Theoretical Plates 
(Foley-Dorsey) 

 Measure of column efficiency for this peak (System Suitability value). 

Theoretical Plates 
(Tangential)  

Measure of column efficiency for this peak (System Suitability value). 

User Expression  A value calculated according to a user defined equation. 

Wavelength Maximum  The wavelength of the maximum absorbance in the peak apex 
spectrum.  Can be used for both component confirmation and for 
developing a wavelength program. 
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User Expressions 

In addition to the standard data items available for reporting, users can create their own 
expressions for reporting calculated values. A user expression can be reported in a column of the 
peak table in the same way as any standard numeric item. The user expression is evaluated for 
each reported peak in the table. By definition a user expression is a numeric value and has the 
properties of a numeric value, including Number format.  

• Any of the standard data items listed in the table above. Only data items associated with 
the current peak is accessible. 

• Any of the following operators: Addition, Subtraction, Multiplication, Division, 
Exponentiation, Raise e to a Power, Base 10 Logarithm, Base e Logarithm and Brackets (to 
group sub-expressions). 

• Constant numeric values 

• Any of the additional data values defined in the table below. 

Data Item Description 

Addend From the sequence row associated with the run (i.e. the same value 
for all peaks) 

Dilution Factor From the sequence row associated with the run (i.e. the same value 
for all peaks) 

Divisor From the sequence row associated with the run (i.e. the same value 
for all peaks) 

Maximum Final 
Amount 

The largest Final Amount value calculated for all peaks located in the 
channel/run 

Maximum Peak Area The largest Peak Area value for all peaks located in the channel/run 

Maximum Peak Height The largest Peak Height value for all peaks located in the 
channel/run 

Multiplier From the sequence row associated with the run (i.e. the same value 
for all peaks) 

Normalization Factor From the sequence row associated with the run (i.e. the same value 
for all peaks) 

Number of Peaks The total number of peaks found in the channel/run 

Sample Amount From the sequence row associated with the run (i.e. the same value 
for all peaks) 

Total Final Amount The total of all Final Amount values calculated for all peaks in the 
channel/run 

Total Peak Area The total of all Peak Area values calculated for all peaks in the 
channel/run 

Unretained Peak Time The Unretained Peak Time from the method for the channel 
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NOTES: (1) For reports where multiple channels are reported in separate tables, the Maximum and Total 
values are those from the channel. Where channels are merged into a single peak table, the 
Maximum and Total values are those from the merged peak set. (2) For reports where multiple 
channels are reported in separate tables, the Unretained Peak Time is that from the appropriate 
channel. Where channels are merged into a single peak table, the Unretained Peak Time is that 
from the (first) channel in the method having a 'Time Offset' value equal to zero. 

User Expression Editor Dialog 

When you add a User Expression to the peak table, the User Expression Editor dialog is displayed. 

 

User Expression Editor dialog for a new expression 

Note that the title bar of the dialog displays the index number associated with the user expression.  

Control Description 

Available Data Items A button list that displays all the data items available for 
inclusion in a user expression. 

Available Operators A button list that displays all the operators available for 
inclusion in a user expression. 

+             Addition 

-              Subtraction/Negation 

*             Multiplication 

/              Division 

^             Exponentiation 

()             Group an expression 

exp()       Raise e to a power 

log()        Base 10 logarithm 

ln()          Natural logarithm 
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Expression A edit box that displays the user expression. When this field 
has focus a text insertion point cursor is displayed (by default 
at the end of the current contents of the edit box). 

Undo A command button that reverses the last action you made. 

User Expression Editor Dialog 

Control Description 

Available Data Items Clicking on an item in the list will add it to the Expression edit box 
within square brackets, at the current position of the insertion point. 
For example: 

[Peak Width@10%] 

The insertion point will then be positioned following the closing 
bracket of the data item term. 

The list remains unchanged, since any data item can be included 
multiple times in an expression. 

Available Operators Clicking on an item in the list will add it to the Expression edit box at 
the current position of the insertion point. 

If the operator includes brackets ( ) then the insertion point is 
positioned within the brackets after the operator has been added to 
the Expression box, otherwise the insertion point is positioned at the 
end of the expression text. 

Expression The user can type freely in this edit box, although anything other 
than a numeric constant entry is liable to cause the expression to be 
invalidated. It is distinctly preferable that user entry of operators 
(and even data items) by typing in the appropriate characters (with 
complete accuracy) be accepted by the syntax check (see below). 
However, it would be acceptable if a third-party control is utilized for 
this function and it does not support such a feature. 

The user can move the insertion point within the edit box using the 
left and right arrows (and up and down arrows if this can be 
supported). 

Undo For example, undo would remove a data item just added to the 
expression or a constant value just typed into the Expression box. 
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OK When this button is clicked the expression is parsed for validity. If 
its syntax is correct then the dialog will close and the defined user 
expression is associated with the current peak table column. 

If the syntax is not correct then an error message is displayed and 
the insertion point is positioned at the point where the problem was 
found. 

The error message should provide as clear an indication of the error 
as practicable. That is, a single error message "Syntax error" (or 
similar) is inadequate.  

If the text between square brackets is found not to match one of 
the defined data items then the message "Invalid data item" (or 
similar) is displayed and the insertion point should be located within 
the brackets. This same message would be displayed if the user 
accidentally deleted an ending square bracket.  

If a ending square bracket is immediately followed by an opening 
square bracket, or a numeric constant, then the message "Missing 
operator" (or similar) is displayed.  

If two operators appear in succession then the error message 
"Operator follows operator" (or similar) is displayed.  

If any extraneous non-numeric characters (i.e. that do not represent 
a data item and operator or a constant value) appear in the 
expression then the error message "Invalid characters in 
expression" (or similar) is displayed. 

Cancel When this button is clicked the dialog is closed. If the dialog was 
displayed for a newly added expression then the expression is voided 
and the column in the peak table will remain blank. 

If the dialog was displayed for editing an existing expression then the 
expression will remain unchanged. 
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User Expression Column 

When a User Expression has been successfully added to the peak table grid it appears as follows: 

 

The default column header shows User Expr followed by the index number of the expression. The 
user can, of course, change this to any valid header text.  

The default example representation of the expression value is xxx.xxx (as shown in the table in 
section Data items Available for Page Header/Footer) and is shown right justified in the cell. 

The cell also contains a button labeled with an ellipsis. The button is shown on the left hand side of 
the cell in the example above but it could be on the right hand side as long as it does not interfere 
with the example representation of the expression value.  

When the button is clicked, the User Expression Editor dialog is displayed, with the expression itself 
(i.e. the text string making up the expression) shown in the Expression edit box. The user may then 
edit the expression as desired.  

Sample/Multiple Injection Peak Table 

The Peak Table page for the Sample/Multiple Injection report formats is identical to that of the 
Sample/Single Injection page, with the exception of the contents of the Available Data Items list. 
There are two basic kinds of value available: 

• Average values from all injections for numeric quantities such as Retention Time, Area, etc. 
• Percent relative standard deviation values for numeric quantities such as Retention Time, 

Area, etc. The user documentation should warn the user that these results only have 
statistical validity when the number of replicate injections exceeds nine. 

NOTE:  When data from only a single injection are available, average and RSD values will (obviously) not 
be shown and N/A will be displayed instead, to indicate a problem with the data. 

Summary Peak Table 

Although the table in a summary report is still termed a peak table it differs from a sample report 
peak table in three important ways: 

• A row in a sample report reports the results for a single peak (either a single injection or 
the average of several injections). A row in a summary report reports results for a single 
sample.  

• A summary report includes results from identified peaks only. 
• The summary report includes a set of columns that are repeated for each identified peak in 

the run. This frequently results in the table wrapping (as described in Summary Reports). 
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The layout of the Peak Table page when creating a new template is shown below.  

 

The key difference between this page and the Sample Peak Table page is that the Summary 
version has a peak table consisting of two sections: Columns that identify the sample on the left 
and a set of columns of peak data, which are repeated for each identified peak in the channel or 
run, on the right. 

Although some of the controls on this page are identical in form and behavior to controls on the 
Sample Peak Table page, the entire page is described in the table below for completeness. 

Control Description 

<Page title> Peak Table 

<Page 
subtitle/description> 

Specify the content and format of the component peak table. 

Sample Identification 
Items 

Select the data items in this list box that can be included as 
columns in the sample identification section of the table. You can 
define the section by moving items from this list to the Sample 
Identification grid in the Peak Table Format area. 

Available Component 
Data Items 

Select the data items in this list box that can be included as 
columns in the component section peak table. You can  define the 
section by moving items from this list to the Component Data 
Columns grid in the Peak Table Format area. 

Table font Select the font (typeface) from this drop-down list to be used for 
the peak table. 

Table font size Select the size of the font (in pts) from this drop-down list to be 
used for the peak table. 
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Include all peak in 
calculations 

Click in this check box to indicate that the values calculated for 
data items will include results from all peaks found in the run not 
just from the reported identified peaks.  

Display table grid lines Click in this check box to indicate if the peak table will include 
borders around each cell. 

Column header A text control which determines the heading (two lines of up to 20 
characters each) to appear at the top of the selected column in the 
peak table. 

Column width Set the width of the selected column in the peak table. 

The units in which the width is set should match the current paper 
size (Letter or Legal = in, A4 = cm) 

Alignment Select from the drop-down list to define the alignment of values 
(Left Justify, Center, Right Justify) in the selected column. 

Number format Select from the drop-down to define whether values in the 
selected column are formatted by number of significant figures or 
number of decimal places. Disabled (together with caption) when 
selected data item type is text or integer. 

<number> Select from the drop-down list (or a spin control) to indicate the 
number of decimal places when Number format = Decimal Places 
or the number of significant figures when Number format = 
Significant Figures. Disabled (together with caption) when selected 
data item type is text or integer. 

Show column averages Click in this check box to indicate if average results are displayed 
at the foot of each column, in an Averages row. When average 
values are calculated they are printed with the same numeric 
format as defined for the column they are derived from. 

Show column %RSD Click in this check box to indicate if the %RSD results are 
displayed at the foot of each column, in an Averages row. %RSD 
values will be printed to 3 decimal places. 

Printable page width: A read-only display that indicates the usable space based on the 
defined page setup settings. 

Components across 
page: 

A read-only display that indicates the number of component 
column sets (which are always kept together as a set) will fit 
across the page. 

It depends upon the page setup settings, the sample identification 
column settings and the component column settings. 
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Peak Table Format – 
Sample Identification  

A two-row grid that displays the currently defined sample 
identification section of the peak table. 

The Column Header text is displayed in the top row for each 
column and a simplified representation of the data type is 
displayed in the second row. 

Nothing is editable directly in the grid. 

Peak Table Format – 
Component Data 
Columns 

A two-row grid that displays the currently defined component data 
section of the peak table. 

The Column Header text is displayed in the top row for each column 
and a simplified representation of the data type is displayed in the 
second row. 

Nothing is editable directly in the grid. 

 

Building the Summary Peak Table 

The basic approach to building the Summary Peak Table is the same as for the Sample Peak 
Table. The drag-and-drop, double-click, and keystroke techniques described for the Sample Peak 
Table page are all applicable here. The key difference is that data items from the Sample 
Identification list can only be dropped on the Sample Identification grid and items from the 
Available Component Data Items list can only be dropped on the Component Data Columns 
grids. Similarly, the double click and keystroke actions on each list adds the data item to the 
appropriate grid. 

NOTE:  If you does not select at least one data item from the Sample Identification list and also at least 
one item from the Component Data list then no table will be generated when the report is 
rendered. 

The Components across page readout is updated whenever a column is added to or removed from 
either grid, or when a column width is modified.  
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User Expressions are handled exactly the same way on the Summary Peak Table as for Sample 
reports. 

Peak Table Scrolling 

When the space occupied by the defined columns exceeds the available screen width, both grids 
are scrolled together, along with their individual headers, as shown below. 

 

Data Items Available for Summary Peak Table 

The data items available for inclusion as columns in the Sample Identification section of the 
Summary report peak table are: 

Data Item Description 

Date of Acquisition Date the injection reported on the current row was acquired. 

Injection Number The original injection number of the sample. 

Sample Name The name associated with the sample (from the sequence row). 

Time of Acquisition Time the injection reported on the current row was acquired. 
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Vial Number The number of the vial from which the sample was injected. 

 
The data items available for inclusion as columns in the Component Data section of the peak table 
for a Summary report are a subset of the items available in Sample reports.  

NOTE:  When data from only a single injection are available for calculation, average and RSD values will 
not be shown and N/A will be displayed instead. 

Properties of Selected Column 

The controls within the Properties of Selected Column group display the settings for the 
currently selected column. When no columns exist they are blank. When a data item is added to 
the peak table these controls will display the default settings for that item. For example, if the 
Retention Time item is added the display would be 

 

The display of the Retention Time column header will reflect the text in the Column header 
control, and the representation of the RT in the second row will reflect the settings of the 
Alignment and Number format controls. The actual width of the column in the Peak Table 
Format display reflects the value set in the Column Width control. The default values for all 
available data items are defined below. 

Where column properties are not applicable to the current data item then those controls (and the 
associated caption) are disabled. For example, when Component Name or Peak # is the selected 
column, the Number format controls are disabled.  

The Peak Table Format display also reflects the settings for Table font and Table font size. The 
column header is also always shown in Bold style and is centered in the header cell, regardless of 
the alignment set for the data item itself. 

NOTE: The screen display will not match precisely the printed (or stored) output. The intent here is to 
enable you to see a close approximation to the final output. 

Modifying Column Properties 

You can modify any of the displayed properties for the selected column. Changes to all controls 
(Column header, Column Width, Alignment and Number format – both drop-down list and spin 
control) will be reflected in the grids display immediately 

The modified properties remain in effect only while the data item is included in the peak table. If a 
data item is deleted from the peak table (returned to the list box) and then subsequently re-added 
to the peak table; it is restored will its default settings. 
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Calibration Data Table 

Calibration Data Table 

On this page the table is reporting calibration data (one table for each standard level of each 
calibrated component) and hence is not termed a Peak Table but a Data Table. The page title 
and contents are labeled accordingly: 

 

In form the Calibration peak table page is a combination of the Sample (single Available Data Items 
list and Table Format grid subset of Table Properties) and Summary (Properties of Selected 
Column) controls.  

Control Description 

<Page title> Data Table 

<Page 
subtitle/description> 

Specify the content and format of the calibration data table. 

Available Data 
Items 

Select the data items from this list box that can be included as columns 
in the data. You can define the peak table by moving items from this 
list to the Data Table Format grid. 

Table font Select the font (typeface)from this drop-down to be used for the 
calibration data table. 

Table font size Select the size of the font (in pts) from this drop-down list to be used 
for the calibration data table. 

Display table grid 
lines 

Click in this check box to indicate if the peak table will include borders 
around each cell. 
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Column header A text control which determines the heading to appear at the top of 
the selected column in the peak table. It can be two lines of up to 20 
characters each. 

Column width Set the width of the selected column in the peak table. 

The units in which the width is set should match the current paper size 
(Letter or Legal = in (from 0.5 to 6.0 in),  A4 = cm  (from 1.0 to 
15.0 cm) 

Alignment Select from the drop-down list  the alignment (Left Justify, Center, 
Right Justify) of values in the selected column. 

Number format A drop-down list that determines whether values in the selected 
column is formatted by number of significant figures or number of 
decimal places. Disabled (together with caption) when selected data 
item type is text or integer. 

<number> Select from the drop-down list (or a spin control) to indicate the 
number of decimal places when Number format = Decimal Places or 
the number of significant figures when Number format = Significant 
Figures. Disabled (together with caption) when selected data item type 
is text or integer. 

Printable page 
width: 

A read-only display that indicates the usable space based on the 
defined page setup settings. 

Current data table 
width: 

A read-only display that indicates the width of the currently defined 
data table.  

The units in which the width is set should match the current paper size 
(Letter or Legal = in, A4 = cm) 

Data Table Format A two-row grid that displays the currently defined data table. 

The Column Header text is displayed in the top row for each column 
and a simplified representation of the data type is displayed in the 
second row. 

Nothing is editable directly in the grid. 

 

NOTE:  The display in the Data Table Format area has an associated popup menu identical to that 
described in Peak Table Format Popup Menu 

Building the Data Table 

Drag-and-Drop 

To add a data item to a specific column drag it from the list of available items and drop it in the 
required position. The result is the same regardless of whether you drop the item on the header 
row or the second row. The header row displays the default column header text for that item and 
the second row displays a representation of the current item format.  

For example, if the Retention Time is dropped onto the empty column (initially there is only one, 
blank column) the Table Format would show: 
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The 'xxx.xxx' display indicates that the default format for retention time includes three decimal 
places. Since the column into which the item is dropped becomes the selected column then the 
controls in the Properties of Selected Column group display the default properties for the data item 
(see below for more details). 

• When an item has been added to the table it is removed from the list box.  

• If you drop an item onto the blank column at the end of the table then a new blank column 
is appended to the right hand side of the table. 

• If you drop an item onto a previously occupied column, the new data item displaces the 
previous one, which is returned to the list box.  

• To reposition an item drag it from one column in the peak table and drop it on another 
column.  

• Remove an item from the peak table by dragging it from the grid and dropping it on the list 
box (or by deleting the column, which also returns the item to the list box). 

Double-Click Operation 

If you double-click on an item in the list box, that item is added to the empty column at the right 
hand side of the table, and a new blank column is added to the table. This is a rapid way to add 
columns to the table.  

Keyboard Operation 

If you select an item in the list box and then press the space bar, this acts in the same way as a 
double-click operation. That is, the item is added to the empty column at the right hand side of the 
peak table, and a new blank column is added to the table 

Peak Table Scrolling 

If the number of columns assigned to the peak table exceeds the width allotted to the Table 
Format area, you can scroll below the header bar as necessary. For example: 

 

When an item is added by double-clicking the grid is scrolled automatically, if necessary, to show 
the new column. 

Maximum Table Size 

As items are added to the table the accumulated column width is maintained and displayed in the 
'Current peak table width' field. If adding a column at its default width would make the total peak 
table width exceed the printable page width then one of two possibilities exists: 
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1. If there is at least 0.5 in (or 1 cm) available (i.e. the minimum allowed column width could be 
accommodated) then the item is added with that width instead of the normal default width. 

2. If there is less than 0.5 in (or 1 cm) available then an error message is displayed 
('Insufficient space is available for this column') and the item will not be added to the table. 

Data Items Available for Data Table 

The data items available for inclusion as columns in the data table for a detailed Calibration report 
are listed in the table below: 

Data Item Description 

Area Area measured for the current component peak. 

Area/Height Ratio Ratio of area measured for the current component peak to its height. 

Acquisition Date Date the current calibration standard injection was acquired. 

Height Height measured for the current component peak 

Injection Number An index for each injection made of a particular standard. This is not 
necessarily the injection number as originally reported since any 
calibration level could contain injections from more than one series of 
calibrations (i.e. resulting from more than one sequence row). 

Internal Standard Area The area measured for the associated internal standard peak. 

Internal Standard Area 
Ratio 

The ratio of a peak's area to the area of the associated internal 
standard peak. 

Internal Standard 
Concentration Ratio 

The ratio of the component amount to the related internal standard 
amount at the current calibration level. 

Internal Standard Height The area measured for the associated internal standard peak. 

Internal Standard Height 
Ratio 

The ratio of a peak's height to the height of the associated internal 
standard peak. 

Internal Standard Name The name of the component specified as the internal standard for the 
current component peak. 

Retention Time The time into the run at which the current component peak eluted. 

Running Average (Area) The average area for all rows up to the current row, for the current 
component peak. 

Running Average 
(Height) 

The average height for all rows up to the current row, for the current 
component peak. 

Sample Name The name associated with the sample (from Sequence row) 

Time of Acquisition Time the current calibration standard injection was acquired. 

NOTES:  (1) Average and %RSD values are only calculated for Retention Time, Area, Height and 
Area/Height Ratio data. The check boxes, Show column averages and Show column %RSD are 
disabled (and unchecked) when any other data column is selected in the table. (2) When data 
from only a single injection are available for calculation, average and RSD values are not shown 
and N/A is displayed instead. 
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Sequence Row  Data Table 

On this page the table is reporting sequence row information and hence is not termed a Peak 
Table but a Row Table. The page title and contents is labeled accordingly: 

 

This page is a simple subset of the Sample Peak Table page and the controls exhibit all the same 
behaviors. Only the available data items are unique to this page. 

Report Format Wizard – Signatures 

This page is displayed for all report types, to provide up to two signature lines for report review 
and/or approval. 
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Control Description 

Display first signature line Click in the check box to indicate if the first signature line 
is included in the report. 

Title Enter the title to appear above the first signature line. 
You can use up to 25 characters. 

Signature line:<first field> Enter the text to appear preceding the first entry space 
on the signature line. You can use up to 15 characters. 

Signature line:<second field> Enter the text to appear preceding the second entry 
space on the signature line. You can use up to 15 
characters. 

Signature line:<third field> Enter the text to appear preceding the third entry space 
on the signature line. You can use up to 15 characters. 

Display second signature line Click in the check box to indicate if the second signature 
line is included in the report. 

Title Enter the title to appear above the second signature line. 
You can use up to 25 characters. 

Signature line:<first field> Enter the text to appear preceding the second entry 
space on the signature line. You can use up to 15 
characters.  

Signature line: <second field> Enter the text to appear preceding the second entry 
space on the signature line. You can use up to 15 
characters.  

Signature line: <third field> Enter the text to appear preceding the third entry space on 
the signature line. You can use up to 15 characters. 
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Report Format Wizard – Finish 

This page is always displayed as the final page of every report type. 

 

Here you can preview the report, if desired, and save the generated format to the Chromera 
database for subsequent use. 

Control Description 

Report format 
name 

Enter the name (up to 25 characters) associated with the report format.  

Group name Enter (or select) the report format (up to 25 characters) that you want 
to assign to an existing group or to a new group.  

To use an existing group type in the group name or select it from the 
drop-down list. To create a new group and assign the method to it the 
user types in a group name that does not already exist. 

Description Enter a description of the report format (up to 50 characters). 

Preview… Click this button to display a preview of the report showing example 
data. 

Finish Click this button to save the report format to the database and close the 
Report Format Wizard. 

 





 

 

Data Selector 
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About Data Selector 
The Data Selector enables you to locate the required data set(s) based on your current 
environment (Method, Sequence, Post Run, Reprocess, etc.) either by browsing the database 
or by searching for specific values in key data fields. These are not really separate modes; 
rather the search capabilities allow you to filter the list of data sets being browsed. The 
ability to sort and group the displayed list of data sets further assists you in finding the 
required data set(s). The Data Selector displays whenever you select one or more data 
sets.  Commands that display the Data Selector include: 

• Open Method from the File menu 

• Open Sequence from the File menu 

• Open Data from the File menu 

• Reprocess from the Tools menu 

• View Current Session Logs from the Tools menu 

• View Retrieved Archived Logs from the Tools menu 

When browsing, the default sort order (i.e. the order when the Data Selector is displayed) 
with the most recently edited (or created in the case of data) items appears at the top of the 
list.  

When selecting data, batches are sorted in inverse order of Batch Created Date/Time (i.e. 
newest first) and within each batch the samples are sorted in order of Acquisition Date/Time 
(i.e. oldest first).  

About Methods and Sequences 

The browse pane consists of a list of data sets of the type to be selected. However, the data 
displayed are not a simple list but include grouping ability, in addition to simple sorting. 

Browsing and Sorting 

Methods and sequences can be stored under a Group name, so the initial level of browsing 
is using a group list, where each group can be expanded to show the methods or sequences 
assigned to it. It is also possible to group methods or sequences by Author or Editor name. 

It is also possible to select a display that eliminates the Groups and shows all methods or 
sequences in a continuous list. It is possible to sort the displayed list of methods or 
sequences, in ascending or descending order, on any field shown. The displayed fields are: 
Name, Group , Description, Created Date/Time, Last Edited Date/Time, Author, and Editor. 

The list can also be grouped by Author or Editor. Only a single level of grouping is 
supported. 

By default Sequences and Methods are listed by group; however, you can use the Organize 
menu to turn off grouping and display all Sequences and Methods as a continuous list, as 
shown in the next example screen. 
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You can use the Organize menu to select which columns are available for display. From this 
screen you can also perform the following tasks: 

•  Use the Organize menu to select which columns are to be displayed, and to 
specify sorting. 

•  Use the Organize menu to select all (or no) data sets or display the Search 
pane. 

•  Adjust column widths by dragging on the divider line between column 
headers 

•  Select a column and drag it to a new position. 

•  Right-click on the columns to display a dialog to select the columns to be 
displayed.   

• Click a column heading to sort the displayed items in ascending and 
descending order of that field. 

• Delete a sequence/method (or more than one if it is a multi-select 
environment) 

Querying 

Method queries can include the following data items: Name, Group, Created Date/Time, 
Last Edited Date/Time, Author, Editor. 

Sequence queries can include the following data items: Name, Group, Created Date/Time, 
Last Edited Date/Time, Author, Editor. 

The results of a query are displayed in the same basic format as the continuous list display 
(i.e. without grouping) and can be sorted in exactly the same way. Secondary queries can be 
applied to this collection as required. 

How  to Open a Method 

To open a method: 

1. Select the Method environment by clicking the Method button in the Navigation 
Pane. 
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2. From the File menu select Open Method.  The Data Selector dialog opens. 

3. Expand the Method group by clicking the plus sign  .  

4. Select the method you want to open by clicking the check box at the beginning of 
the row.  

5. Click the Open button, the first page of the method displays. 

About Sample Data 

Browsing and Sorting 

Sample data are normally displayed under the batch name; that is the name of the sequence 
from which the data were acquired (or the batch from which the reprocessed batch was 
derived). You can expand each batch to display the samples contained within that batch. 

You can sort the displayed batch list, in ascending or descending order, on any field shown in 
the display. The displayed fields are: Batch Name, Batch Group, Description, Created 
Date/Time, Editor (the user who reprocessed the batch), and Reprocessed Date/Time. 
Analyst is not available at this level because it is at the sample level in the sequence/batch 
database table. One type of Batch is a continuous list. 

 

Batches can also be grouped by group name and editor (user reprocessed by). Only a single 
level of grouping is supported. Any batch can be expanded to display the sample contained 
within the batch. 
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Querying 

Two levels of query are available for sample data: 

• Querying to locate a Batch with certain characteristics 
• Querying to locate sample data sets (injections) with certain characteristics, across 

batches 

The two query types have the same search items available but the results of the query are 
quite different. For example, a batch query equivalent to “where sample name contains 
‘cocaine’ and date created is May 2006” would return a list of batches, whereas a sample 
query with the same criteria would return a list of samples. 

Sample data queries can include the following items: Batch Name, Group , Description, 
Acquisition Date/Time, Analyst, Sample Type, Sample Name, Sample Description, 
Instrument, and Method Name. 
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About the Data Selector – Event Viewer 

Event logging records information about “what happens” in the system. Events are changes in 
the status of the system that can affect its operation or the data being generated. Some status 
changes are informational, and others record errors. The contents of the active Event Log 
Database can be reviewed by selecting the View Current Session Logs command from the 
Chromera Tools menu. This command is available at all times. Activating the Event Log Viewer 
launches a special mode of the Data Selector, which displays a Microsoft Windows Event Viewer 
styled listing of the current events recorded in the database. The upper frame of the selector 
displays a sortable list of all the events recorded for the current Chromera session, identified by 
the user name and timestamp of when the session began, and the lower frame displays a 
selection of tabs providing various options for viewing a selected event from the list, or for 
generating a report of all logged events from the database. 

 

Events fall into three categories in Chromera: 

User Events – Specific actions that occur within Chromera as a consequence of normal user 
interaction, such as launching Chromera, or saving a method. These are selectable by the 
end-user and can be enabled as desired. 

System Events – Actions that may occur within or outside of normal operations, which are 
not specifically user initiated, but are common and are anticipated, such as a missing vial in 
an autosampler. 

How  to Interact w ith the Event Viewer 

There is only one, single Event Log Database for all of Chromera. It is stored in the folder - 
C:\Program Files\Microsoft SQL Server\MSSQL10_50.SQLEXPRESS2008\MSSQL\DATA, along 
with most other Chromera databases. 

• Each time Chromera Manager is launched, a new SessionID is created and the 
events that occur during that session are recorded in the Event Log Database under 
that SessionID. 
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• Each time a Chromera Instrument instance or a Data Only instance is launched, a 
new SessionID is created and the events that occur during that session are 
recorded in the Event Log Database under that SessionID. 

NOTE: User and System Events cannot be configured/modified while a Chromera instance is already 
running. The Configure User Events option will be grayed-out. Close any open Chromera 
instances to enable the configuration option in the Chromera Manager Actions menu. 

Preparing to Capture Events in a Log (Chromera Manager) 

To create a new Event Log database, follow this procedure: 

1. Delete the existing Event Log Database through the Event Logs Database 
Management section of the Chromera Manager. 

2. Select Yes to the prompt to Archive the existing database if you need to preserve 
previous event logs. Otherwise, the existing Event Log Database and all events will 
be deleted. 

3. Create a new Event Log Database through the Event Logs Database Management 
section of the Chromera Manager. 

To ensure that the User and System events are enabled (they should all be ON by default) 
follow this procedure: 

1. From the Chromera Manager Actions menu, select Configure User Events. 

 

2. With the User Event Configuration window open, click through each of the 
Chromera environment sections to verify all events for that environment are set to 
ON. 
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3. Save any changes and close User Event Configuration. 

4. Launch Chromera. 

View ing and Outputting the Event Log through the Data Selector 

To view the Event Log through the Data Selector, follow this procedure: 

1. Select View Current Session Logs from the Chromera Tools menu. (Or from the 
Actions menu in Chromera Manager.) 

 
The Data Selector - Event Viewer screen appears. 
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The default is to display only the events from the current SessionID. Therefore, by 
default, only the events that have occurred since the current instance of Chromera 
was launched will be visible. 

2. Click the Show Search button and select _System_  from the Searches directory to 
choose the desired collection of events to display, and then click the Search button 
to return all of the items for that selection. 

 

3. Select All Logs; then clicking the Search button displays all of the events for all of 
the SessionIDs in the database.  
The other searches return the events that their Names imply. 

4. Select the Details - Tabular View tab to display the contents of individual events 
while scrolling through the list. 
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The Message field contains the relevant information about the selected event. Move 
through the list using the Up and Down arrow keys or scroll bar 

To output the Event log, follow this procedure: 

1. Select the View Session Logs tab, and then click the Show Report button to print 
the complete list of events from the selected search. 

 

2. Click the Export button on the Toolbar, and select Excel, PDF, or Word as the file 
type to export.  
Selecting an Excel file type allows the greatest flexibility for viewing, sorting, and 
filtering the exported data. 
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Using Event Log Archives (Chromera Manager) 

To create an archive of the Event Log for future viewing, follow this procedure: 

1. From the Chromera Manager, select the Archive tab from the Event Logs 
Database Management section. 

 

2. Choose the option for Full Archive to copy the complete database, with all events, 
or just a Selective Archive, to copy only the events from a specified date range. 

NOTE: Both of these options will remove the associated events from the active Event Log database. 

3. Select a name and a location for the .archive file. The default is to create a file name 
from the date/timestamp of the archive range, and to save into the folder 
C:\Program Files\PerkinElmer\Chromera\LogPool. 

4. Click the Save button, and then Start Archive.  
This will copy the selected records to the .archive file, and then delete them from the 
current Event Log Database. The .archive file then can be copied to another 
computer for subsequent review. 

To view an Archive Event Log file, follow this procedure: 

1. Copy the .archive file to the LogPool folder (the default location) if it is not already 
there. 

2. From the Chromera Manager, select the Retrieve tab from the Event Logs 
Database Management section. 
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3. Select the appropriate .archive file from the LogPool folder and click the Open 
button. 

 
This will convert the .archive file back into a database formatted file. It WILL NOT 
copy the archived records into the active Event Log Database. 

4. Launch Chromera and select View Retrieved Archive Logs from the Tools menu. 
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5. Select the desired database from the drop-down list and click the Go button. 

 
This allows browsing of the events from the Retrieved database in exactly the same 
manner as browsing the active Event Log Database. 
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Selecting Data 

Each row in the data list (representing a data set) includes a Select check box. Whenever at 
least one item is checked the Open button is enabled.  

Rows can be checked or unchecked in the following ways:  

1. Clicking in the Select box will toggle the state of the check for that row. If the row is 
a batch row then changing its state also sets all sample rows within that batch to the 
same state.  

2. Choosing the Select All command from the Organize menu will cause all items 
displayed in the Browse grid to be checked.  

3. Choosing the Select None command from the Organize menu will cause all items 
displayed in the Browse grid to be unchecked. 

4. Making an extended selection using Shift + Click. If the Shift key is held down while 
a row is checked or unchecked and then a second row is clicked, all rows from the 
first up to and including the second row will assume the state of the first clicked row. 
Note that an extended selection can only include rows at the same level. An 
extended selection of sample rows cannot extend from one batch to another. 

NOTE: When the data selector is opened in any mode, double-clicking on an item will open that item 
(as it would in a standard Windows File Open dialog). Thus double-clicking an item is a 
shortcut for checking the item and then clicking the Open button.  
When the Open button is clicked the Data Selector closes and the selected data 
set(s) return to the function that initiated the data selector. 
 

Button/ Menu Commands 

The Data Selector uses the following button and menu commands. 

Menu Command Description 

 
Open A command button that opens your 

selection. This duplicates the Actions/Open 
command 

Organize Select All Selects all of the results displayed on the 
screen. Enabled when the Data Selector is 
in multi-select mode and items are 
available for browsing. 

 Select None Selects none of the results displayed on 
the screen. 

 List Displays all items in a continuous list. 
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 Group by ►  

            Analyst         

           Batch Group 

Reprocessed By         
         Expand all groups 
        Collapse all groups 

  

Displays a submenu containing items the 
list can be grouped by. 

 

 

 

 Search pane Toggles display of the Search pane.   

 Preview Toggles display of the Preview pane (see 
Overview of the Search Pane). 

 Select Columns Displays the Select Columns dialog for 
customizing the list columns.  

Actions Open Opens the selected data items and closes 
the data selector window.  

 Delete Displays a confirmation dialog Are you 
sure you want to delete the selected 
item(s)?. Clicking the Yes button deletes 
the selected items and the updates the 
displayed list of data items. Clicking No, 
then no action is taken. 

 Delete A simple command button that duplicates 
the action of the Actions/Delete command 
described above. 

 

Group by submenu contents: 

Method Author, Editor, Method Group 

Sequence Author, Editor, Sequence Group 

Batch/Samples Batch Group, Reprocessed By 

                                          

               

How  to Customize the Browse Data List 

The basic approach to customizing the data list display is the same for all data types; 
however, the two-level display of sample data necessitates the ability to customize the 
display columns for both the batches and the samples. 
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To add or remove columns in the data list: 

1. Click the Organize button to display the menu items, then click Select Columns. 
The form of this dialog will depend on the type of data being displayed.  For 
example: 
 

 
 

 

 
                       

 
Select Columns dialog for display of 
Methods 

 
Select Columns dialog for display of 
Sequences 

2. From the Select Columns dialog you can either add a column or remove a column. 
To add a column, check the check box next to a column name in the available 
columns list. To remove a column, uncheck the check box next to a column. 

3. You can also use the Move Up and Move Down buttons to change the order in 
which columns are displayed.    



Data Selector.  489 

 

To move a column up or down select that column name in the list, and then use the Move 
Up and Move Down buttons to move it up or down the list. 
(The order of columns can also be modified by direct drag-and-drop within the grid display.) 

To sort the items in the data list: 

1. Click on the column heading of the data item to be sorted. 

2.  A drop down arrow appears next to the text on the column to indicate whether the 
column is sorted in ascending or descending order.  An arrow facing upwards 
indicates the column is sorted in ascending order.  An arrow facing downwards 
indicates the column is sorted in descending order. The order toggles each time the 
column heading is clicked.  

Toolbar Commands 

The Data Selector contains the following icon buttons for standard interactions that are 
typically performed frequently. 

Toolbar Button Associated Command 

 New search definition 

 Save search (enabled only when an existing search is being 
edited and it is a valid search) 

 Save search as (enabled only when a search has been 
defined) 

 Display Help file 

 Exit - Close the Data Selector 

Overview  of the Search Pane 

To set up a search definition, click on the Show Search button and the Search pane 
appears in the upper part of the window. Initially the Search pane is set to display Saved 
Searches. These are saved under a user defined folder hierarchy. This is a Windows 
Explorer-like display with the folder structure displayed in a tree control on the left and the 
searches contained within the selected folder displayed in a list view on the right. When a 
saved search is selected in the list view, the search definition is displayed in the lower pane 
on the right. This display is the text Show data where: followed by the search definition. 
Where the search definition includes bracketed expressions (see below) then these are 
include in the statement.  For example: Show data where: Acquisition date/time is between 
6/5/07 and 7/7/07 and (Sample name contains 'iso' or Sample name contains 'propanol') 

Note that literal strings are shown enclosed in quotes. 
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Data Selector showing Search pane with display of saved searches 

The relative size of all three panes within the Search pane is adjustable using the splitter 
bars. The sizes of these panes are retained within user preferences and restored when that 
user opens the window. 

Clicking the New Search toolbar button or the Edit Search button (when an editable saved 
search is selected in the tree) will display the Search pane in edit mode: 

 

Data Selector showing Search pane set to edit mode  
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NOTE:  Entering the edit mode by the latter route displays the currently selected search ready for 
editing. Clicking the New  Search toolbar button displays the edit mode with a blank search 
definition. 

 

Data Selector showing Search pane after New Search command 

NOTE:  Although not shown in the above examples, when the edit mode of Search is displayed the 
name of the currently shown search definition (or Untitled if not yet saved) is shown in the 
title bar.  
When a valid search is shown (see below for procedure for defining a search) the 
Search button is enabled. Clicking this button will cause the search to be executed 
and the results are displayed in the browse pane at the bottom of the screen.  

NOTE:  A search can also be run directly from the Saved Searches view by clicking the Search button 
when the desired saved search is selected. 
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Data Selector showing results of Search 

When the optional Preview pane is displayed, the screen will appears as follows: 

 

The preview pane displays the chromatograms associated with the sample row selected in 
the data grid. This would include all channels for all replicate injections (scrolled as required).  
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Data Selector: Saved Searches 

Selecting Saved Searches displays the folder structure in which searches are saved. 
Functionally this operates in an identical way to the directory tree within Windows Explorer. 
Folders are displayed in ascending alphabetical order. 

 

The Searches root is always displayed. It is possible to store searches in the root folder and 
so when this node is selected the display in the upper right pane will list any such searches. 
However, the icon used for the root will not change when it is selected. 

When you right-click on the tree, the popup menu described below is displayed. If you click 
on a node in the tree then that node first becomes the selected node, and hence the 
command will relate to that node. 

Command Description 

New Folder Creates a new folder as a sub folder to the currently selected folder 
(as in Windows Explorer). 

If you did not click on a node then the new folder is at the first 
level (i.e. in the root folder). 

Delete Folder Deletes the selected folder, provided it contains no saved searches. 
If it is not empty then a message is displayed: The selected 
folder cannot be deleted as it is not empty. 

Expand Expands the selected folder to show all its subfolders. 

Expand All Expands all folder (recursively) to show all subfolders 

Collapse Closes the selected folder, hiding its subfolder 

Collapse All Closes all subfolders so that only the folders at the top level are 
displayed. 
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Data Selector: Saved Searches List 

This is a list view showing all the searches saved within the folder selected in the tree. The 
list view contains the following columns: 

Name The name you give to the search 

Author The name of the person who created (saved) the search 

Created 
Date/Time 

The date and time (in format defined by regional settings) that the 
search was first saved 

Editor The name of the person who last edited (and saved!) the search. 
This is blank if the search has not been modified since its original 
creation. 

Edited 
Date/Time Last 

The date and time (in format defined by regional settings) that the 
search was last edited. 

 

You can change the order of these columns using drag-and-drop. The searches will initially 
be listed in ascending alphabetical order where you should be able to sort on any column by 
clicking on the header (toggling between ascending and descending) in the usual way. 

When you right-click on the list view, the popup menu described below is displayed. If you 
click on a row in the list then that row first becomes the selected row, and hence the 
command will relate to that node. 

Command Description 

Delete Search Deletes the selected search. There is no confirmation dialog. 

Run this Search Executes the selected search and displays the results in the 
lower part of the screen. 

Search Definition 

This pane displays the selected search in pseudo-sentence form. However, for clarity, when 
parentheses are used in the search definition these are shown in the sentence. All literal 
strings entered by the user as search criteria (e.g. sample names, instrument names, etc) 
are displayed in quotes.  

Data Selector: Edit Search View  

Available Search Fields List 

This displays the search fields that can be used within a search for the data set type being 
searched for. Each category heading is a button that can be clicked to display or hide the list 
of fields within that category. 
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Clicking on any item within a section (when the Field part of the search definition is selected 
will cause that field to be added to the search definition. 

The fields displayed in the list depend on the data set type, as defined below: 

Method Search 

Category Field  Comment 

Identification Method Name Displayed as Method Name in the search 
definition. 

 Method Group Displayed as Method Group in the search 
definition. 

 Author The person who created the method 

 Created Date/Time  The date and time when the method was first 
saved 

 Editor The person who last modified the method 
(blank if the method has not been modified 
since it was created). 

 Last Edited 
Date/Time  

The date and time when the method was last 
changed. 

Sequence Search 

Category Field  Comment 

Identification Sequence Name Displayed as Sequence Name in the search 
definition. 

 Sequence Group Displayed as Sequence Group in the search 
definition. 

 Author The user who created the sequence 

 Created Date/Time  The date and time when the sequence was first 
saved 
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 Editor The user who last modified the sequence 
(blank if the sequence has not been modified 
since it was created). 

 Last Edited Date/Time  The date and time when the sequence was last 
changed. 

Data Search 

Category Field  Comment 

Instrument Instrument Name The instrument on which the data were 
acquired. Displayed as Instrument Name in the 
search definition. 

Batch Batch Name  

 Batch Group Displayed as Batch Group in the search 
definition. 

 Batch Description Displayed as Batch Description in the search 
definition. 

 Created Date/Time  The date and time when the batch was created 
(acquisition was started). 

 Reprocessed By The user who last reprocessed data in the batch. 
This is blank if the data has not been 
reprocessed since original; post-run processing. 

 Reprocessed The date and time when the batch (or any 
channel in it) was last reprocessed. 

Sample Acquisition Date/Time  Date/Time of injection of first sample injection. 

 Sample Name Displayed as Sample Name in the search 
definition. 

 Sample Type Displayed as Sample Type in the search 
definition. 

 Sample Description Displayed as Sample Description in the search 
definition. 

 Method Name The name of a method associated with this 
sample (acquisition or processing method) 

 Analyst  The user who acquired the data. 
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Search Definition 

The basic fields within the display are described below. 

Control Description 

Operator Select from the drop-down list the operator (AND, OR, AND(, 
OR(   ) to be applied between clauses of the search definition.  

For the first row of the search definition this is a read-only field 
which displays the term Where. 

If the selection is AND( or OR( then a secondary band is 
displayed below the current row. 

Field Displays the name of the field selected from the Available Search 
Fields list. 

Condition Use the drop down list to select the nature of the search that 
applies to a criteria field.  The drop down list contents depend on 
the type of field selected to search on. 

Text fields:  is, contains, does not contain, starts with 

Numeric fields: is equal to, is not null, less than or equal to, 
greater than or equal to, is between 

Date fields: after, before, between, on 

Value 1 The nature of this field will depend on the Field selection.  Ideally 
the appearance of the cell is distinct for each Field type but if this 
cannot be achieved with the control then a text field with an 
associated button should be used. The button would display the 
date selector for a date field but be inactive for text and numeric 
fields. 

Text fields: Any text string up to 50 characters 

Numeric fields: Any valid number 

Data fields: A date selected from the popup date selector. 

Value 2 The nature of this field will depend on the Field selection. This field 
will only be enabled when the selected Condition is 'is between' 
(numeric) or 'between' (date). 

Text fields: Any text string up to 50 characters 

Numeric fields: Any valid number 

Data fields: A date selected from the popup date selector. 

<close 
parenthesis> 

Select from the drop-down list the end of a sub-expression. This 
field ONLY appears on secondary bands. Selection of ')' will cause 
the blank secondary band row below the current one to be hidden 
and the Operator field of the blank entry band at the next higher 
level is selected. 
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Search Definition Popup Menu 

The popup menu defined below is displayed when you right-click on the search definition. 
The right-click action also first selects the cell beneath the mouse pointer. (If the you click on 
a header or on blank space then the popup menu will not be displayed.)  

Command Description 

Clear Entry Clears the entry in the selected cell. This command is only enabled 
on cells in which the user types an entry, not on drop-down list 
cells or date cells. 

Delete Row Deletes the selected row and any child rows associated with it. If 
the deleted row is a child row containing the closing parenthesis 
then either:  
(i) If a preceding child row exists then the closing parenthesis is 
added to that row. 

(ii) If there is no other child row then a blank child row is displayed 
below the parent row and the query is invalid until a child row has 
been added or the parent row deleted. 

Enabled whenever the selected row is not a blank (entry) row. 

NOTE: A row can also be deleted by selecting that row and then 
pressing the Delete key. 

Insert Row 
Above 

Inserts a new row above the currently selected one. This will always 
be at the same level as the selected row.  
Thus if the first secondary row of a sub clause is selected the new 
row is an addition at the secondary level.  
If the selected row is the very first row (containing the read-only 
'Where' operator) then the new row will show 'Where' as its 
operator and the selected row's Operator field will become enabled 
and set to 'AND' by default. 
Enabled whenever the selected row is not a blank (entry) row. 

Data Selector: System Searches 

A number of default search definitions are provided with the software. These searches are 
unique in the following ways: 

• They cannot be edited 
• They cannot be deleted 
• They contain dynamic criteria. That is, the search parameters are not fixed values 

but depend on the environment in which the search is executed. 

The proposed default searches are: 

1. Sample data associated with any instrument acquired or reprocessed in the past 24 
hours 

2. Sample data associated with the current instrument acquired or reprocessed in the 
past 24 hours 

3. Sample data associated with any instrument acquired or reprocessed in the past 7 
days 

4. Sample data associated with the current instrument acquired or reprocessed in the 
past 7 days 
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5. All sample data associated with any instrument.  This is the default case and 
therefore does not require an explicit saved search. 

6. All sample data associated with the current instrument 

7. Sequences created in the past 7 days 

8. Sequences edited in the past 7 days 

9. All sequences. This is the default case and therefore does not require an explicit 
saved search. 

10. Methods created in the past 7 days 

11. Methods edited in the past 7 days 

12. All methods. This is the default case and therefore does not require an explicit saved 
search. 

In all cases the date range for the search is determined when the query is run. For searches 
2 and 4 the instrument associated with the current instance of Chromera will act as an 
additional filter (if no instrument is associated with the instance then these searches will 
return no results). 

The default searches are displayed in the 'Saved Searches' tree within the folder 'System'. 

Searching for Methods, Sequences or Sample Data 

By selecting available search fields and setting search criteria for those fields, it is possible to 
generate a very specific search of the database.  

1. From the browse pane of the Data Selector click Show Search. 
The Search pane appears, with a blank search definition and the Field cell selected: 

 

2. To choose a field to search on click on an item in the Available Search Fields list 
(expanding and/or collapsing sections as required). When a field has been clicked it 
is displayed in the field cell and the Condition cell is selected. 
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NOTE:  The name that appears in the Field cell is sometimes a composite of the category and field 
name (for example Instrument Name not just Name). 

 

3. From the drop-down list in the Condition cell, select the desired search 
criterion/condition. The available conditions depend on the field selected as defined 
above. When a Condition has been selected, the Value 1 cell is selected. 

 

4. Depending on the Field type either enter a value (text or numeric) into the Value 1 
cell or choose a date from the popup calendar displayed when the button associated 
with the cell is clicked. If the Condition selected requires two values then the Value 2 
cell is selected (immediately for date selection, or when user presses Tab or Enter for 
text or numeric entry), otherwise the Operator field in the next row is selected. This 
is a row at the same level for the first search clause. 

5. If the Condition selected requires two values then enter or choose a value as for 
Value 1. When you leave that field the Operator field in the next row is selected and 
a new blank line will appear at the bottom of the grid. 

 

6. At this point the search is valid and the Save Search and Search buttons are enabled. 

7. To add additional search criteria select an Operator from the drop-down list. If 'AND' 
or 'OR' is selected then a new blank row at the same level is displayed below the 
current entry row. If 'AND(' or 'OR(' is selected then a blank secondary band entry 
row is displayed. 
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8. Steps 2 - 6 may be repeated to add additional search criteria. The procedure for 
search criteria grouped within parentheses is basically the same as described above. 
The user signals the end of the grouped search criteria by selecting ')' from the drop-
down list in the final cell of the secondary entry row. Only a single level of nesting of 
bracketed criteria is allowed. 

 

9. Once you complete the search definition the search can be activated by clicking 
Search. 
The search begins and the mouse pointer will change to an hour glass to indicate 
that a search is in progress.  When the search has completed the mouse pointer will 
change back to the pointer icon and the search results will appear in the Browse grid 
below the Search pane. 

To save a search definition 

Click Save. If the search has not previously been saved then the Save Search As dialog will 
appear. This dialog allows the user to select the folder the search is saved in and to enter the 
name under which the search is saved. 
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Control Description 

Author Displays the name of the logged-on user. 

Search name Enter the name under which the search will be saved. 

<search folders 
tree>  

A tree control displaying the folders in which searches can be 
saved 

New Folder Click this button to create a new folder in the search folders tree 
where you can enter a name for the folder. The name entered 
must be unique in the tree. 

Save Click this button to save the search under the specified name 
within the selected folder. This command also closes the dialog. 

Cancel Click this button to cancel the save operation and close the dialog. 

Selecting a Data Set 

To select a set of samples (for example, in the Post Run environment): 

1. Choose Open Data from the File menu in Post Run to display the Data Selector. 

2. Click the New Search button (assuming the required data is not contained in the list 
displayed when the Data Selector opens). 

3. Set search parameters, based on information known about the required samples. 

4. Click the Search button to retrieve sample data meeting the entered criteria. 

5. Review the displayed list of Batches. You can group the batches and/or expand one 
or more batches to review the constituent sample information. 

6. Select a complete batch (or batches) by checking the Select box on the batch 
row(s), or select specific samples by clicking on the Select box on sample rows. 

7. Click the Open button to open the selected data set in the Post run environment. 
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Search Messages 

The following search messages are displayed depending on the circumstance.  

Unsaved Search Definition 

If you attempt to close the Data Selector window or go to open the selected items without 
saving the current search definition, then the following message appears: 

Do you want to save changes to this search before closing? 

                                                                              Yes    No     Cancel 

• Clicking Yes, displays the Save Search dialog from where you can save the search. 
• Clicking Cancel, returns you to the Data Selector. 
• Clicking No, closes the Data Selector window.   

Search Name Ex ists 

If you try to save a search with a name that already exists, then you are prompted with the 
following message: 

The search “name” already exists.  Do you want to replace it? 

                                                                    OK    Cancel 

• Clicking Cancel, returns you to the Data Selector. 
• Clicking OK, overwrites the existing search with the new definition. 

Preview  Pane 

The Preview pane displays the chromatograms associated with the sample row highlighted in 
the data area. This includes all channels for all replicate injections. A row appears in the 
display for each injection associated with the selected sample. A column appears for each 
data channel, as well as a column indicating the injection number. The display of the 
chromatograms show the data stored with each raw data set. If no thumbnail is available for 
any given cell then that cell will be blank. The entire pane is blank when a batch is selected. 
Two different sizes of thumbnail are available. Select the size to display in the Preview pane 
via a popup menu. 

 

Selection of Single Injection 

When the Data Selector is opened in single injection selection mode the Preview pane 
displays automatically. In this case there is also a Select column as the first column in the 
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display. Only a single injection can be selected; checking any injection row will cause all 
other rows to be unchecked. 

Preview  Pane Popup Menu 

When you right-click on the Preview pane the following menu is displayed: 

Command Description 

Enable Magnify  When this item is checked, hovering the mouse pointer over a 
thumbnail chromatogram will cause a larger version of the 
chromatogram to be displayed in a tooltip-like window. 

Show Large Image  When this item is checked the larger of the two thumbnail images 
will be displayed in the Preview pane for each channel of each 
injection. 

Show Small Image  When this item is checked the smaller of the two thumbnail 
images will be displayed in the Preview pane for each channel of 
each injection. 

 



 

 

Data Transfer (Import/ Export) 
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Import 

The Import functions are accessed from the Import submenu in the Tools menu. The 
distinct import functions are: 

• Import TotalChrom data (index files, raw data, or component names) 

• Import Chromera Results (from a previously exported Chromera 3.x database file) 

• Import Chromera Methods (from a previously exported Chromera 3.x database file) 

• Import Chromera Sequences (from a previously exported Chromera 3.x database file) 

• Migrate (Import) Chromera 2.0 Data 

• Report Templates 

Importing Chromera Data 

NOTE:  This function retrieves data from the database file format used by the Chromera 2.x or the 
3.x Export function. The migration of Chromera version 1.2 results is handled by a separate 
utility in the Database Utilities of Chromera Manager.  

This function is similar to that of the Retrieve operation in the Database Utilities with one 
significant difference. Whereas Retrieve uses the Data Selector to enable you to browse or 
search the archive database and displays only the selected batches in the retrieve list, this 
dialog displays all the batches contained in the export file directly in the list. You then select 
which batches are to be imported by selecting them in the list. This difference in behavior is 
a reflection of the fact that an export database, by definition, likely to be much smaller than 
an archive database, and therefore querying for the required batches would not be required. 

To import Chromera results: 

1. From the Tools menu selecting Chromera Results from the Import submenu, 
displays the following dialog: 

 

2. Enter the following information to import your results files. 
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Field Description 

Source file name  Displays the name of the database from which the data will be 
imported. Select this file by clicking the Browse button.   

 <Browse 
button> 

The Browse button displays a standard Open dialog to select 
a directory containing an exported results file that you want to 
import. After selecting a directory and file (and if necessary, 
entering a File name) click the Open button. 

Select batches to 
import  
<displayed in a 
table of data 
selected for 
import> 

A table that displays the Name, Description, Creation 
Data/Time, and Last Modified Data/Time for each batch 
contained in the export file. If the selected file was not a valid 
results export database file then an error message (Selected 
export file does not contain Chromera data batches) will be 
displayed in the Messages box and the table will remain 
empty. 
Click on the desired displayed file. 

Server Displays the name of the server configured for the selected 
instrument. The field is populated automatically from the 
configuration of the current instrument. 

Import to results 
database 

Displays the name of the results database configured for the 
selected instrument. The field is populated automatically from 
the configuration of the current instrument. 

Import Click this button to start the import process. When this button 
is clicked the software attempts to import the selected batches 
in the export database into the main results database defined 
in the fields above.  

As the operation proceeds the progress bar underneath the 
Import and Cancel buttons is progressively filled in. 

The result of the import operation is indicated in the 
Messages box. This button is only enabled when one or more 
batches in the table are selected. 

Cancel This button that can be used to cancel a import operation 
while it is in progress. 

Messages A box that displays messages associated with the Import 
Results function. If the selected file is not a valid Chromera 
results export database file then a message will be displayed 
here and the selection list will remain empty. 

Any existing messages (from a previous operation) will be 
cleared when a new export file is selected, the Refresh Items 
button is clicked or the Import button is clicked. 

If the Import operation is successful a message indicating this 
is displayed. 

Close This button closes the Import Results dialog Use of this button 
will not cancel an import operation in progress; the dialog 
closes when the import is complete. 
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Import Chromera Methods 

To import Chromera methods: 

1. From the Tools menu selecting Chromera Methods from the Import submenu, 
displays the following dialog: 

 

2. Enter the following information to import your method files. 
 

Field Description 

Group names You can type in the group name or select it from the drop-
down list.  

Select methods to 
import  
<displayed in a table 
of data selected for 
import> 

A table that displays the Name, Description, Creation 
Data/Time, and Last Modified Data/Time for each 
method contained in the export file. If the selected export 
file does not contain Chromera methods, then a error 
(Selected export file does not contain Chromera methods) 
is displayed in the Messages box and the table will remain 
empty. 

Server Displays the name of the server configured for the selected 
instrument. This field is populated automatically from the 
configuration of the current instrument. 

Database Displays the name of the methods database configured for 
the selected instrument. This field is populated 
automatically from the configuration of the current 
instrument. 

Export file name Select this file by clicking the Browse button. 
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   <Browse 
button> 

The Browse button displays a standard Open dialog for 
you to select a directory containing an exported method file 
that you want to import. After selecting a directory and file 
(and if necessary, entering a File name) click the Open 
button. 

Import This button starts the import process. When this button is 
clicked the software attempts to import the selected 
batches in the export database into the main results 
database defined in the fields above.  

As the operation proceeds the progress bar underneath the 
Import and Cancel buttons is progressively filled in. 

The result of the import operation is indicated in the 
Messages box. This button is only enabled when one or 
more batches in the table are selected. 

Cancel This button that can be used to cancel a import operation 
while it is in progress. 

Messages A box that displays messages associated with the Import 
Results function. If the selected file is not a valid Chromera 
results export database file then a message will be 
displayed here and the selection list will remain empty. 

Any existing messages (from a previous operation) will be 
cleared when a new export file is selected, the Refresh 
Items button is clicked or the Import button is clicked. 

If the Import operation is successful a message indicating 
this is displayed. 

Close This button closes the Method Import dialog. Use of this 
button will not cancel an import operation in progress; the 
dialog  closes when the import is complete. 

 

Unique Naming of Methods 

Each method must have a unique name within the group to which it is assigned.  The 
complications arising when methods and sequences are imported require some additional 
actions, since many methods can be imported in one operation and separately renaming in 
the case of each ‘collision’ would be impractical and annoying. 

When one or more methods are to be imported the software will determine in advance 
whether one or more ‘name collisions’ will occur. If so, you will be presented with a list of the 
methods involved and will be asked to create a new group (this must therefore be a new and 
unique name). You will be given the option of assigning only those methods for which a 
name collision occurs to the new group or all of the methods being imported. The imported 
methods will be updated with the new group name as required. 
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Import Chromera Sequences 

To import Chromera sequences: 

1. From the Tools menu selecting Chromera Sequences from the Import submenu, 
displays the following dialog: 

 

2. Enter the following information to import your sequence files. 
 

Field Description 

Group names You can type in the group name or select it from the drop-
down list.  

Select sequences to 
import  
<displayed in a table 
of data selected for 
import> 

A table that displays the Name, Description, Creation 
Data/Time, and Last Modified Data/Time for each 
sequence contained in the export file. If the selected export 
file does not contain Chromera sequences then a error 
(Selected export file does not contain Chromera sequences) 
is displayed in the Messages box and the table will remain 
empty. 

Server Displays the name of the server configured for the selected 
instrument. This field is populated automatically from the 
configuration of the current instrument. 

Database Displays the name of the methods database configured for 
the selected instrument. This field is populated 
automatically from the configuration of the current 
instrument. 

Export file name Select this file by clicking the Browse button. 

  <Browse 
button> 

The Browse button displays a standard Open dialog for 
you to select a directory containing an exported sequence 
file that you want to import. After selecting a directory and 
file (and if necessary, entering a File name) click the Open 
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button. 

Import This button starts the import process. When this button is 
clicked the software attempts to import the selected 
batches in the export database into the main results 
database defined in the fields above.  

As the operation proceeds the progress bar underneath the 
Import and Cancel buttons is progressively filled in. 

The result of the import operation is indicated in the 
Messages box. This button is only enabled when one or 
more batches in the table are selected. 

Cancel This button that can be used to cancel a import operation 
while it is in progress. 

Messages A box that displays messages associated with the Import 
Results function. If the selected file is not a valid Chromera 
results export database file then a message will be 
displayed here and the selection list will remain empty. 

Any existing messages (from a previous operation) will be 
cleared when a new export file is selected, the Refresh 
Items button is clicked or the Import button is clicked. 

If the Import operation is successful a message indicating 
this is displayed. 

Close This button closes the Sequence Import dialog. Use of this 
button will not cancel an import operation in progress; the 
dialog closes when the import is complete. 

  

Unique Naming of Sequences 

When one or more sequences are to be imported the software will determine in advance 
whether one or more name collisions will occur for both the sequences and the associated 
methods. Collisions of sequence names and methods names are handled separately from 
each other but each will be treated in a similar way to that described in Unique Naming of 
Methods in the section Import Chromera Methods.  You will be given the option of assigning 
all sequences to the new group or only those for which a name collision occurs. The 
imported sequences will be updated with the new group name as required.   

If methods referenced in any sequence have to be assigned to a new group because of a 
name collision then you will have the option of assigning all methods to the new group or 
only those which a collision occurs. The sequences will be updated as necessary with the 
revised method references/indices, and the methods will be updated with the new group 
name as required 

Import Chromera 2.0 Data 

Data acquired in Chromera 2.0 can be imported (migrated) into Chromera 3.0.  Although 
Methods created in Chromera 2.0 cannot be imported directly, they can be extracted from 
the data after it has been imported.  Sequences created in Chromera 2.0 cannot be imported 
into Chromera 3.0.   
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The following procedure shows how to import (migrate) data acquired in Chromera 2.0 into 
Chromera 3.0 and how to extract the Methods. To import Chromera 2.0 data , follow this 
procedure: 

3. Select Chromera 2.0 Data from Import in the Tools menu. 

The Database Settings dialog appears: 

 

4. Click the browse button  to display the Select Chromera 2.0 Result File dialog. 

 

5. Locate your desired Source Files by navigating to the directory that contains your 
Chromera 2.0 data. 

6. Select the .BAK file then click Open. 
This file then appears to the right of Chromera 2.0 Backup (.BAK). 
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7. Select a Group Name from the drop-down list or type a new Group Name. 

8. Select the type you want to import: Result, Method, or Sequence. 

9. The Destination Database displays the Server Name, Batch Result Database, and 
Method/Sequence Database. 

10. Click the Select button. 
The files populate the table under Migration. 

11. Select individual data or select all batches by clicking in the Select all Batches 
checkbox. 

12. Click the Migrate button to save these batches to your database. 
A status message appears in the lower left corner of this dialog (for example, 
Status: Data Imported successfully). 

13. When done click the Close button. 
The data is now in the Chromera v3.0 format. 

To view the data: 

14. Click on the Post Run button to enter the Post Run environment, and select Open 
Data from the File menu.   
In the Data Viewer, the Batches which were imported are present.  The Batch 
Description for the Imported Data displays Imported from Chromera 2.0.  Data 
previews are not available for Chromera 2.0 data. 

15. Check the check box next to the data you want to open, and click the Open 
button.  The data will not appear in the Post Run window. 

16. To view the Method associated with the 2.0 data, click the Method button to enter 
the Method environment. 

17. Select Extract Method from Results from the File menu. 
The Data Selector opens. 
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18. Click on the  next to the desired batch, click in the check box of the appropriate 
sample, then on the bottom of the screen, click in the check box of the appropriate 
injection where the chromatogram preview would be.  Finally, click the Open button. 

19. The Save As dialog will open. Enter an appropriate Name and Group, then click Ok.  

 

20. The Method is now saved into the Chromera 3 database and can be treated as any 
method which was created in Chromera 3. 

Import Report Templates 

To import Chromera report templates: 

1. From the Tools menu selecting Report Templates... from the Import submenu, 
displays the following dialog. 
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2. Enter the following information to import your template files. 
 

Field Description 

Select templates to 
import  
<displayed in a table 
of data selected for 
import> 

A table that displays the Name, Description, Creation 
Data/Time, and Last Modified Data/Time for each 
template contained in the export file. If the selected file 
was not a valid template file then an error message 
(Selected export file does not contain Chromera templates) 
will be displayed in the Messages box and the table will 
remain empty. 

Server Displays the name of the server configured for the selected 
instrument. The field is populated automatically from the 
configuration of the current instrument. 

Export file name  Displays the name of the file from which the data will be 
imported. Select this file by clicking the Browse button. 

 <Browse 
button> 

The Browse button displays a standard Open dialog for 
you to select a directory containing an exported template 
file that you want to import. After selecting a directory and 
file (and if necessary, entering a File name) click the Open 
button. 

Import This button starts the import process. When this button is 
clicked the software attempts to import the selected 
batches in the export database into the main results 
database defined in the fields above.  

As the operation proceeds the progress bar underneath the 
Import and Cancel buttons is progressively filled in. 

The result of the import operation is indicated in the 
Messages box. This button is only enabled when one or 
more batches in the table are selected. 
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Cancel This button that can be used to cancel a import operation 
while it is in progress. 

Messages A box that displays messages associated with the Import 
Results function. If the selected file is not a valid Chromera 
results export database file then a message will be 
displayed here and the selection list will remain empty. 

Any existing messages (from a previous operation) will be 
cleared when a new export file is selected, the Refresh 
Items button is clicked or the Import button is clicked. 

If the Import operation is successful a message indicating 
this is displayed. 

Close This button closes the Import Results dialog Use of this 
button will not cancel an import operation in progress; the 
dialog closes when the import is complete. 

 

Importing TotalChrom Data 

Chromera supports importing raw data and some parts of methods from TotalChrom versions 
that utilize the latest file raw and method file versions only. For each imported file in which 
items that could not be imported, a log is created that contains a record indicating the 
parameter and the nature of the problem. At the end of the import operation you are 
informed of files that generated such logs. Observe the following points about importing 
TotalChrom data: 

• It is not necessary for TotalChrom to be installed on the Chromera workstation 
on which the import is performed. Chromera is able to access and read the 
TotalChrom files directly, without the need for TotalChrom or TCAccess. 

• Only the latest version of each TotalChrom file type (Raw and Method) is 
imported. Earlier file versions will have to be updated using TotalChrom before 
they can be imported. 

• A Chromera method will not be automatically created based on information 
contained in a TotalChrom RAW data file. Only the absolute minimum of 
information required to make sense of the raw data (i.e. sampling rate and end 
time) will be saved in the Chromera batch with the raw data; no instrument or 
other parameters will be extracted from the TotalChrom instrument method in 
the raw file. However, it will be possible to construct a valid (if minimal) 
Chromera method by extracting the method from the batch result. For this 
purpose a TotalChrom device will be utilized by Chromera to construct each 
data channel. 

Importing TotalChrom Raw  Data 

When multiple files are imported the raw data files will be assigned to batches given the 
same name as the sequence file associated with the TotalChrom RAW file. 

The information necessary to construct the batch records are determined from the contents 
of the various RAW file header sections as described in a separate document.  In particular, 
sample identification, sample weights and values, and Instrument Method parameters can be 
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used to map the appropriate fields. Some of the fields present in the TotalChrom file headers 
will not be used in the Chromera environment. 

1. A single TotalChrom RAW file represents one sample row in a Chromera Batch. The 
header information and Sequence Cycle record stored within that RAW file will allow 
the construction of that Batch record. 

2. Since a TotalChrom sequence does not have a Number of Injections field (e.g. 3 
injections of the same sample requires 3 rows in a TotalChrom sequence), that field 
in Chromera will always be determined by gathering all raw files that share the same 
Sample Name, Sample Number and Vial Number as replicates. 

3. It must be considered that TotalChrom Sequence Cycle Numbers for RAW files to be 
imported are not necessarily exactly sequential. Cycles in a TotalChrom sequence 
may represent non-data rows, such as User Programs or Cleanup-Shutdown rows. 

4. The Instrument Method information from the RAW file will only be used to populate 
the Instrument Method section of the Chromera batch record to the minimum extent 
required to make the data usable within Chromera. This means the channel identifier 
(used to create a Chromera channel of the same name) and the data sampling rate. 
Only references to the identification of the TotalChrom Process and Calibration 
methods will be found in the RAW file header. Therefore, the Peak and Calibration 
sections of that batch record will be left blank (or default values). Descriptive fields 
from the TotalChrom method (Method Description and Header text) should be 
included in the Chromera Method Description and Notes fields respectively. 

5. There is no peak information or result data associated with the Batch record created 
form the RAW file. These fields are left blank. This is the same situation that would 
result within Sirius by acquiring data with processing being suppressed. That, too, 
would cause the creation of a batch record containing no peak information or results. 

GC Raw Data 

There is no fundamental difference in the structure of a RAW file from GC vs. HPLC, but 
there are a few considerations that must be made. 

1. Data from a GC (Clarus or AutoSystem, or Agilent 5890/6890) may be dual channel 
in nature. That is, the data may come from two different detectors on the same 
instrument for the same sample.  
The acquisition sequence for that sample will have both the A and B channels fully 
populated. This is reflected in the header information of the raw data files. One file 
will represent the A channel data and the other will represent the B channel data.  
The sample information and Instrument Method is common for both the A and B 
channels. The Process and Calibration methods may be different for the two 
channels (but these are irrelevant since none of the parameters are imported). 

2. The raw data may still be single channel in nature, but may come from either 
Channel A or Channel B of the Instrument Method. Therefore, the Instrument 
Method for GC data may indicate Channel A, or Channel B, or Dual.  

3. The only relevant Instrument Method information that can be imported from a 
TotalChrom GC raw data file are: 
Description (Free text) 
Header Text (Instrument description) 
Data Channel and source (Detector A, Detector B, etc.) 
Sampling Rate (in points per second) 
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A/D Converter Raw Data 

The ability to import raw data generated by an NCI or 900 Series A/D interface is supported 
in this release of Sirius. 

There is no fundamental difference in the structure of a RAW file from GC vs. HPLC, but 
there are a few considerations that must be made. 

1. Data from an NCI or 900 Series interface may be dual channel in nature. That is, the 
data may come from two different detectors on the same instrument for the same 
sample. 
The acquisition sequence for that sample will have both the A and B channels fully 
populated. This is reflected in the header information of the raw data files. One file 
will represent the A channel data and the other will represent the B channel data. 
The sample information and Instrument Method is common for both the A and B 
channels. The Process and Calibration methods is different for the two channels (but 
these are irrelevant since none of the parameters are imported). 

2. The raw data may still be single channel in nature, but may come from either 
Channel A or Channel B of the instrument. Therefore, the Instrument method may 
indicate Channel A, or Channel B, or Dual. These are indicated in the method by the 
following codes: 
41 = Channel A  
42 = Channel B  

3. The only relevant Instrument Method information that can be imported from a 
TotalChrom A/D raw data file are: 
Description (Free text) 
Header Text (Instrument description) 
Data Channel (Channel A, or Channel B) 
Sampling Rate (in points per second) 

Importing TotalChrom Methods 

TotalChrom Methods are not imported directly or in their entirety; instead the following two 
functions are provided. 

Import of Component Information 

It is possible to import component (and optionally calibration and baseline events) 
information into an existing Chromera method. This obviates the need to handle the 
generation of Chromera detector devices and data channels from TotalChrom parameters. 
Specific information to be imported will be component retention times, names, identification 
windows, Use Tallest flag, peak type (analyte, reference peak, internal standard), associated 
reference peak and/or internal standard (if any). Optionally baseline events, calibration 
standard names, and amounts can also be imported. 

Import of Component Names  

A separate function is the importation into the Chromera component dictionary of all unique 
component names from TotalChrom method files located within a specified directory tree. 
The basic process is as follows: 

1. If you have specified a particular set of methods then only these will be examined for 
component names, otherwise all valid methods found within the specified directory 
tree (starting nodes and all subdirectories beneath that node) will be examined. 
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2. A composite list of all unique component names within the examined methods will be 
generated. Duplicate names, based on case-insensitive comparison, will be 
eliminated from the list. 

3. The list of component names from TotalChrom will be merged with the Chromera 
component name dictionary. As before, duplicate names, based on case-insensitive 
comparison, will be eliminated. NOTE: In such cases, the original name from the 
dictionary will be retained and the version originating from TotalChrom will be 
eliminated. 
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Import TotalChrom Data Wizard 

Selecting the TotalChrom Data option from the Import submenu in the Tools menu, 
displays a dialog that guides you through the import process. The purpose of the wizard is to 
guide you through importation of either TotalChrom raw data or component names from 
TotalChrom methods (into the Chromera dictionary). 

Import Data Type 

This initial page displays for you to select the type of TotalChrom data to be imported (TotalChrom 
Index Files Data, TotalChrom raw data, TotalChrom Spectral data (SPC file), or TotalChrom 
component names) and select the source directory containing the TotalChrom files. 

After selecting the source directory click the Next button. 

NOTE:  Next button will not be enabled until you select a directory containing files corresponding to 
the selected data type. For example, if you select TotalChrom Index Files Data, the 
directory must contain IDX files. 

 

About the Settings on this Page 

Control Description 

TotalChrom Index Files 
Data 

Selecting TotalChrom Index Files Data indicates data will 
be imported from TotalChrom Index files. 
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TotalChrom raw data Selecting TotalChrom raw data indicates data will be 
imported from TotalChrom raw files. 

When Chromera imports TotalChrom raw data it examines 
the header information to determine which files within the 
specified directory form part of the same data set. File 
referencing the same sequence file name will be gathered 
into a single Chromera Batch. Files that share the same 
sample name, sample number and vial number will 
designated as replicate injections of the same sample. 
Separate data channel designations will be identified in the 
case of dual channel data. 

TotalChrom spectral data 
(SPC file) 

Selecting TotalChrom spectral data (SPC file) indicates 
data will be imported from TotalChrom spectral files. 

When Chromera imports a TotalChrom spectral file, it uses 
the name if the file you have selected to find its location. 
Spectral data from a single sequence will be gathered into a 
Chromera Batch and a Chromera Batch structure created. 

TotalChrom component 
names 

Selecting TotalChrom component names indicates 
component names from one or more TotalChrom methods 
will be imported into the Chromera component name 
dictionary. 

This function merges the component names found in 
TotalChrom method files into the Chromera component 
name dictionary. You have the option of importing names 
from specific methods or from all methods found within a 
specified directory tree. 

Select the source 
directory for the 
TotalChrom files: 

A browse control that allows you to select the directory 
containing the required TotalChrom files. 

Search subdirectories for 
methods 

Select this check box to indicate that methods from all 
subdirectories found in the tree of which the selected 
directory is the root will be examined and all components 
from all of these methods will be extracted.  

This check box is only displayed when the TotalChrom 
component names option is selected. 

Back  Click this button to display the previous page in the wizard. 

Next  Click this button to display the next page in the wizard. 

Cancel  Click this button to close the Import Wizard window without 
any data being imported. 
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TotalChrom Index Files Data Selection 

This Data Selection screen displays if you selected TotalChrom Index Files Data on the 
first wizard page, chose a directory that contains the index file data, and clicked the Next 
button. 

 

This option enables you to import a group of TotalChrom RAW data files by selecting the 
Index (IDX) file that points to them. This creates a corresponding Chromera Batch as a 
consequence. 

The software reads each file in the selected directory with a .idx extension and determines if 
it is a valid TotalChrom index file. For the purposes of import into Chromera, valid means 
that its format is the latest TotalChrom index file revision. If the file is valid, an entry for it 
will be included in the upper pane display list. Also, a list of raw files for each index file is 
displayed in the lower pane (the view is same as seen in raw file import). The first row is 
selected and highlighted in the IDX file pane, and the first raw file is highlighted with its 
information and chromatogram displayed in the bottom two panes. 

 



Data Transfer (Import/Export).  523 

 

This screen contains the following information. 

Control Description 

Check box next to File 
Name 

You can select all / deselect all option by clicking in this check 
box.  This selects / deselects all valid IDX and all its 
corresponding valid raw files.  Also, selecting any raw file will 
automatically select its corresponding IDX file. 

List of Index Files All valid index and valid raw files are checked and ready to 
import. The first row is selected and highlighted in index file 
pane. This displays the associated raw files and highlights the 
first raw file. This raw file information and chromatogram 
displays in the bottom two panes. 

The Status column in the 
Idx file pane 

Contains the following information: 
• No raw files found (color code : red)  

If a search fails those IDX files are marked in red and 
also its corresponding raw (one/more/all) will be 
marked in red. If a missing file is found in other 
location, you can paste it in the IDX path or IDX folder 
then click next to refresh the raw file information. This 
selection preserves all states of check/uncheck for raw 
and IDX still present in that directory. 

• Few raw files found (color code : blue) 

• Invalid IDX file (color code : red) 

• Blank IDX file - Created during setup but data not 
acquired (color code : red) 

Idx Information Information about the selected index file. 

Raw Files Associated with the selected index file.  You can select 
individual raw files from total available raw files by clicking in 
each check box. 

The Status column in 
RAW file pane 

Contains the following information: 

• A File missing at acquired path or a File missing in IDX 
folder (a tool tip indicates the path where the raw file 
is expected to be) 

• Invalid raw file (color code : red)  

Back Click this button to display the previous page in the wizard. 

Next Click this button to display the next page (Review Batch Data) 
in the wizard. This button is disabled unless at least one file is 
checked in the list. 

Cancel Click this button to close the Import Wizard window without 
any data being imported. Enabled at all times. 
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Index Files Review  Batch Data 

1. After clicking Next on the previous Data Selection screen the following screen 
appears. 

2. When reviewing batch data from an index file, you can rename the batch name to 

the right of  by right-clicking on it, selecting Rename Node, and typing a new 
name. 

3. Clicking Next on the index files data selection page displays the Review Batch 
Data page for you to review the batch structure the data will be imported into. 

4. Clicking on a raw file displays the information and chromatogram associated with the 
raw file in the top right and lower right boxes. 

 

Right-clicking on any node other than the batch name displays a popup menu containing the 
commands Collapse All or Expand All. 

Control Description 

Display of the data tree A tree view that displays the Index File data that will be 
imported into Chromera. Clicking on a node displays the 
information for that node in the upper box on the right and 
lower box on the right. You can you can rename the batch 
name by right-clicking on it, selecting Rename Node, and 
typing a new name. 

Properties Display 
<upper box on the right> 

Displays the properties of the selected file. Properties are 
shown when a file is selected (highlighted) in the list. 

Chromatogram Display 
<lower box on the right> 

Displays the chromatogram from the selected file. The 
chromatogram will be shown when a file is selected 
(highlighted) in the list. 
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Group Name Select a name from the drop-down list or enter the name of 
the Chromera group to which the imported data will be 
assigned. All imported batches are assigned to this group. All 
groups currently defined in Chromera are displayed in the 
drop-down list. 

If you enter a group name that does not yet exist in Chromera, 
that group will be created. 

Back Click this button to display the previous page (file selection 
page) in the wizard. 

Import Click this button to begin the actual import process. 

Cancel Click this button to close the Import Wizard window without 
any data being imported. 

5. Select or enter a Group Name and click Import to import the TotalChrom index 
files into Chromera. 

TotalChrom Raw  Data Selection 

This Data Selection screen displays if you selected TotalChrom raw data on the first 
wizard page, chose a directory that contained the raw data, and clicked the Next button. 

 

This option enables you to import a group of TotalChrom RAW data files by selecting them 
directly from a folder. A corresponding Chromera Batch will be created as a consequence. 

The software reads each file in the selected directory with a .raw extension and determines 
if it is a valid TotalChrom raw file. For the purposes of import into Chromera, "valid" means 
that its format is the latest TotalChrom raw file revision. If the file is valid, an entry for it will 
be included in the display list. 



526 . Chromera User's Guide 

 

 

A progress bar on the bottom of the screen displays while files are examined. The progress is 
updated based on the percentage of raw files contained in the directory that have been 
examined. The Select All, Clear All and Back buttons are disabled during this process. 

The displayed File Name list contains the valid TotalChrom raw files (only) from the 
directory selected on the first page of the wizard. 

Control Description 

Display of the files Displays the valid TotalChrom raw files from the selected 
directory. The files will be displayed in alphabetical order. 

This is a single selection list: Only one line can be selected 
(highlighted) at a time. Of course any number can be checked. 
Clicking on the file name selects (highlights) the file but does not 
check it. Clicking on the check box both selects the file and 
toggles the state of the check box. 

File Name Displays the file name, including extension. 

Analyst Displays the user who acquired the data.  

Acquisition Date/Time Displays the date and time the analysis was started. 

Select All Clicking this button causes all files in the list to be checked. This 
button is labeled Select All but what it really does is Check All. 

Clear All Click this button to clear the checks from all files in the list. 

<left-hand box> Displays the properties of the selected file. Properties will be 
shown when a file is selected (highlighted) in the list. 

<right-hand box> Displays the chromatogram from the selected file. The 
chromatogram will be shown when a file is selected (highlighted) 
in the list. 
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Back Click this button to display the previous page in the wizard. 

Next Click this button to display the next page in the wizard. This 
button is disabled unless at least one file is checked in the list. 

Cancel Click this button to close the Import Wizard window without any 
data being imported. Enabled at all times. 

Display of File Details 

Details of a selected file are in the boxes at the bottom of the page. A typical details display 
is shown below: 

 

Click on the File Name to highlight it and display its Properties in the lower left box and 
Chromatogram in the lower right box. Clicking on the file name highlights the file and 
display its information but does not select it. Clicking in the check box both selects the file 
and toggles the state of the check box. 

Properties Display 

The file details are displayed in a typical properties-style expanding list with several sections. 
The sections and the items in each section are defined below (not in the picture).  

Section Items 
Batch Info Batch Date 
 Batch Name 
 Data Modified 
 File Description 

 
Section Items 
Data Method Name 
 Run Time (min) 
 Sampling Rate (pts/s) 
 Sequence Name 
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Instrument Analyst 
 Channel 
 Instrument Name 
Sample Acquisition Date/Time 
 Name 
 Sample Number 
 Sample Type 
 Vial 

NOTE:  The above properties include Analyst and Acquisition Date/Time even though these values 
are included in the file list. This is mainly for consistency with the properties display on the 
next wizard page, which does not include the file list.  

Chromatogram Display 

The chromatogram from the raw file is displayed at default scaling (i.e. with the maximum 
data point set to full scale). Only the curve will be displayed, without axes, labels or 
annotations of any kind. This is also the plot that will be stored, along with the raw data 
itself, as a thumbnail representation of the chromatogram, for use elsewhere in Chromera. 

Review Batch Data 

Clicking Next on the raw data selection page displays the Review Batch Data page for you 
to review the batch structure the data will be imported into. 

Right-clicking on any node other than the root (Chromera Data) of the data tree displays a 
popup menu containing the command Remove Node. Selecting this command will cause 
the node clicked on, and all its child nodes, to be removed from the tree. The data 
associated with deleted nodes will not be imported when you click Import. 
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You can set the following in this dialog. 

Control Description 

Display of the data tree A tree view that displays the raw data that will be imported 
into Chromera.   

Properties Display 
<upper box on the 
right> 

Displays the properties of the selected file. Properties are 
shown when a file is selected (highlighted) in the list. See 
Display of File Details. 

Chromatogram Display 
<lower box on the 
right> 

Displays the chromatogram from the selected file. The 
chromatogram will be shown when a file is selected 
(highlighted) in the list. See Display of File Details. 

Group Name Select a name from the drop-down list or enter the name of 
the Chromera group to which the imported data will be 
assigned. All imported batches are assigned to this group. All 
groups currently defined in Chromera are displayed in the 
drop-down list. 

If you enter a group name that does not yet exist in Chromera, 
that group will be created. 

Back Click this button to display the previous page (file selection 
page) in the wizard. 

Import Click this button to begin the actual import process. 

Cancel Click this button to close the Import Wizard window without 
any data being imported. 

• Select or enter a Group Name and click Import to import the TotalChrom raw data 
into Chromera. 

About the Batch Data Tree 

The batch tree indicates the data structures that will be created in the Chromera database to 
accommodate the imported data. The structure will be based on data found within the raw 
file headers. There are five levels in the tree: 

Level Icon Description 
1   

 

The root node of the tree which indicates that this will be the structure of 
the set of selected raw data once it is imported into Chromera. Only one 
node of this type will be present. 

2   

 

Represents a Chromera batch. One of these nodes will be present in the 
tree for each unique sequence name references within the selected 
TotalChrom index files or raw data files. 

3 

 

Represents a sample contained within the parent batch. All TotalChrom 
files that reference a given sequence name will be included as children of 
that batch node. A sample node will be created for each unique 
combination of Sample Name + Sample Number + Vial Number found in 
the raw data file headers. It is this combination (referred to as the 
‘Sample ID’ here) that is used as the label for the sample node. 

4  

 

Represents a channel of data associated with the parent sample. A 
channel node will be created for each unique TotalChrom channel 
designator found within the set of raw data files associated with each 
sample. The maximum number of channels from TotalChrom data will be 
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two. The text version of the channel designator (‘A’ or ‘B’) will be used as 
the label for the node. 

5 

 

Represents an chromatogram (i.e. the raw data) associated with the 
parent channel. An injection node will be created for each raw file found 
having the identical combination of: sequence name + Sample ID + 
channel name. The node label will be the raw file name. 

 Example of the Review Batch Data Tree 

The following example describes the structure of the tree.  This example shows a set of data 
files ready to be imported. The tree indicates the data consist of: 

Two samples: Identified as Sample 1 and Sample 2 

Two data channels in each sample: Identified as A and B 

 

Two injections of each sample: 
Sample 1 Injection 1 Channel A: 
'A1242-01-2A.raw' 
Sample 1 Injection 1 Channel B: 
'A1242-01-2B.raw' 
Sample 1 Injection 2 Channel A: 
'A1242-01-2A-020061016-153816.raw' 
Sample 1 Injection 2 Channel B: 
'A1242-01-2B-020061016-153817.raw' 
Sample 2 Injection 1 Channel A: 
'A1242-05-2A.raw' 
Sample 2 Injection 1 Channel B: 
'A1242-05-2B. raw' 
Sample 2 Injection 2 Channel A: 
'A1242-05-2A-020061020-113808.raw' 
Sample 2 Injection 2 Channel B: 
'A1242-05-2B-020061020-113809.raw' 
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TotalChrom spectral data (SPC file) Selection 

Use the Data Selection screen to import TotalChrom spectral data (SPC file).  It uses 
the name of the raw file you have selected to find its location. Spectral data from a single 
sequence will be gathered into a Chromera Batch and a Chromera Batch structure 
created.  The selection of a data file that has an associated spectra file, imports the spectral 
into the appropriate spectral format and any necessary links between the chromatogram and 
spectra file being established.  This conversion occurs independent of the current instrument 
configuration; i.e., a PDA need not be configured into the current instrument for this 
conversion to occur. 

This screen displays the spectral files found with their details. 

 

Column headers displayed in the File selection list will be identical to those shown for 
TotalChrom raw files. Only raw files with associated spectra will be included in this list. 

Review Batch Data (SPC) 

The Review Batch page displays when you click Next on the raw Data Selection page (This 
follows the behavior of the Chromera Platform).  Raw file names are displayed when 
importing via the .raw files.  Result file names are displayed when importing via the .rst files. 
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1. Click Import to import spectral files using the raw file as the identifier of the 
chromatogram. This file will be imported as a batch (with only injections) and will not 
have any associated  channel or method.  

2. After importing the spectral file, you will need to manually reprocess the file  to 
extract the channels.  

3. Once it is reprocessed, the behavior will be similar to any other batch in Chromera. 

TotalChrom Component Names Selection 

This page is displayed if you selected TotalChrom component names on the first wizard 
page, chose a directory, and clicked the Next button. 

 

This option enables you to populate the Chromera Component Dictionary with the complete 
list of component names read from all the TotalChrom methods found in a selected folder 
and subfolders. 

NOTE:  The Search subdirectories for methods: check box indicates that methods from all 
subdirectories found in the tree of which the selected directory is the root will be examined 
and all components from all of these methods will be extracted. 

The software reads each file in the selected directory with a .mth extension and determines if 
it is a valid TotalChrom method file. A progress bar is displayed while files are examined. For 
the purposes of import into Chromera, valid here means that its format is the latest 
TotalChrom method file revision. If the file is valid it will be included in the check list box.  
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Control Description 

Right-hand box displays 
component names 

Displays the component names from the highlighted file. 

Import component 
names from all methods 

Click on this check box to indicate component names will be 
extracted from all valid method files found in the designated 
path(s). 

Back Click on this button to display the previous page (data type 
selection page) in the wizard. 

Next Click on this button to display the next page in the wizard. 
This button is disabled if the ‘Import component names from 
selected methods only’ option is selected and no methods 
are checked in the list. 

Cancel Click on this button to close the Import Wizard window 
without any data being imported. 

4. Click on the method name to highlight it and display the method’s components in the 
right pane. 
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5. Highlight each method to see if it contains the components you want. If the method 
contains your desired components, click in the check box to select the method. You 
can continue to highlight methods to see components and select methods that 
contain the components you want. 

6. Click in a check box to select a method. 

7. After selecting the methods that contain your desired components, click Next. 
A list of components shown will be merged into the Chromera directory. 

 

Component Names Final Page 

Clicking Next on the Select Method page displays this page: 
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The list contains the complete set of component names from all of the selected methods to 
be merged into the Chromera component name dictionary. This list will be compiled as 
described in Import of Component Names. 

5. Click Import to import the component names into the Chromera Component 
Dictionary. 

Control Description 

The set of unique component 
names found within the 
requested methods: 

Displays the list of component names that will be merged 
into the Chromera component name dictionary. 

Back Click this button to display the previous page (Select 
Method page) in the wizard. 

Import Click this button to initiate the merging of the displayed 
component names into the Chromera component name 
dictionary. 

Cancel Click this button to close the Import Wizard window 
without any data being imported. 

 

Method and Sequence Formats 

Method Formats: 

• Chromera 2.x database structure (to provide 100% lossless transfer of data between 
Chromera systems) 

• XML 

• CSV 



536 . Chromera User's Guide 

 

Each of the above formats will contain all data from the method, including calibration 
replicate information. 

Sequences Formats: 

• Chromera 2.x database structure (to provide 100% lossless transfer of data between 
Chromera systems) 

• XML 
• CSV 

Each of the above formats will contain all data from the sequence. 

How  to Copy Components from TotalChrom 

This dialog displays when you select the From TotalChrom Method… command from the 
Copy Components submenu of the Actions menu within the Method Editor. 

 
Control Description 

Copy from 
TotalChrom method 

Displays the source of the components to be copied. The field is 
populated by selecting a file from a standard File Open dialog displayed 
when the browse button is clicked. 

 A browse button that displays files with .mth extension in a standard 
Windows File Open dialog, enabling you to select a TotalChrom method 
file. 

Copy to channel A checkbox list to set the data channel(s) the components will be 
copied to. The list is populated with all data channels from the method. 
You can copy the components to more than one channel by selecting 
the required channels within this control. 

Include integration 
events 

Check this box to copy the integration events from the TotalChrom 
method to the destination channel. 

Include calibration 
standards 

Check this box to copy the calibration standard amounts with the other 
component information. 

<component list>  A display listing the components found in the TotalChrom method, 
together with their retention times. 

 

NOTE:  The OK button is disabled until you select a TotalChrom method and at least one destination 
channel (as required). 

When the OK button is clicked the components from the TotalChrom method are copied to 
the destination channel(s). In general, the copied components are merged with the existing 
components and will not replace them. However, if a component with exactly the same 
retention time exists in the destination channel then that component will not be copied.  All 
components will be copied; any selection made in the component list has no impact on the 
component copied. 
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Data Mapping – TotalChrom Raw  File to Chromera 

The raw data values from TotalChrom are in counts but Chromera will convert them to either 
mAU (for LC UV-Visible data) or mV (for GC or A/D data). The appropriate conversion 
functions are: 

 

Where:     Counts is the raw data point value from TotalChrom  

Sampling Rate Factor is an adjustment factor for sampling rate used only 
for AutoSystem and Clarus GC data. In the TotalChrom raw file it is stored 
as d_ps_conversion in the INST_CONFIG structure. 

Voltage Conversion Factor represents the number of counts per microvolt. 
In the TotalChrom raw file it is stored as d_volt_conversion in the 
INST_CONFIG structure. 

 

Where:      Counts is the raw data point value from TotalChrom  

Offset is a zero adjustment. In the TotalChrom raw file it is stored 
d_plot_offset in the INST_CONFIG structure. 

Conversion Factor represents the number of counts per Absorbance unit. 
In the TotalChrom raw file it is stored as d_plot_conversion in the 
INST_CONFIG structure. 

Import Messages 

Duplicate Batch Name 

When importing multiple files you have the option of associating all the data sets in a single 
batch or importing each as its own batch. By default, the Batch is given the same name as 
the sequence file associated with the TotalChrom RAW file. If a Batch by that name already 
exists, you are notified, and a dialog is presented to specify how to proceed. You may enter 
a new name for the Batch, or add the new data to the existing batch. The ability to associate 
separate TotalChrom raw data files into a single dual channel Chromera sample run would be 
of significant value. If this can be achieved without extensive effort it is supported. 

If you try to import a batch with a name that already exists, then the following message is 
displayed: 

The batch '<batchname>' already exists. How would you like to proceed? 

        [ Enter a new name for the batch ]     [ Add new data to existing batch ]   [ Cancel ] 

• Click Cancel, to return to the Import dialog. 
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• Click Enter a new name for the batch, then a dialog appears to specify a new 
name for the batch. 

• Click Add new data to existing batch, then the new data is added to the existing 
batch. 

Import Errors 

For each imported file in which items that could not be imported were encountered a log is 
created that contains a record indicating the parameter and the nature of the problem.  At 
the end of the import operation you are informed of files that generated such logs .   

You can view any errors associated with importing a data item, by clicking on a data item in 
the Data Conversion Tree that has an icon with a red border and viewing the error message 
in the Details pane.   

Below is a list of the error messages that you may encounter: 

•  No Error 

•  File Read Error 

•  File Write Error 

•  Header Checksum Error 

• File Checksum Error 

• File or Path not Found 

• Invalid TotalChrom Signature 

• Invalid TotalChrom RAW File 

• Invalid TotalChrom Method File 

• Invalid TotalChrom File Type 

• Invalid TotalChrom Revision (Must be v6.2.0) 

• Invalid TotalChrom technique 

• Database Write Error 
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Export 

About Export 

You can export batches, methods and sequences in Chromera database format. The 
procedure for each of the data types will be basically the same: You will use the data 
Selector to select the data sets to be exported and specify a file name and path for the 
export file. 

Exporting Data  

Export of methods, sequences and data (raw/results) to various formats are supported. No 
information is changed in the source database during this process. 

NOTE:  You cannot export all three items at the same time. 

Chromera 3.x 

Only export of complete batches is supported. The export format is itself be a database 
export, which allows all relationships to be maintained intact. This allows the batch to be 
imported into another Chromera system as an entity. 

Excel 

It will be possible to export the results from a set of samples displayed in the Post Run 
environment to an Excel spreadsheet. This will be a manual function in this release, that will 
save the results for all samples in the batch to a single Excel spreadsheet. It will also be 
possible to save the raw data from a data channel (from a single injection) to an Excel 
spreadsheet, as a manual operation. 

Methods 

Chromera 3.x database structure provides 100% transfer without loss of data between 
Chromera systems. 

Sequences 

Chromera 3.x database structure provides 100% transfer without loss of data between 
Chromera systems. 
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Export Chromera Results 

To Export Chromera results: 

1. From the Tools menu select Chromera Results from the Export submenu.  The 
following, dialog displays. 
 

 

Enter the following information to export your batches. 

Field Description 

Select ... Clicking this button displays the Chromera Data Selector in the 
Multiple Batches mode so you can locate and select the 
results to be exported.  

When you select one or more batches and click the Open button 
the Data Selector closes and information about the selected 
batches appears in the Batches to export table. 

Batches to export 
<displayed in a table 
of data selected for 
import> 

A table that displays the Name, Description, Creation 
Data/Time, and Last Modified Data/Time for each batch 
contained in the export file. If the selected file was not a valid 
results export database file then an error message (Selected 
export file does not contain Chromera data batches) is displayed 
in the Messages box and the table remains empty. 

Server Displays the name of the server configured for the selected 
instrument. This field is populated automatically from the 
configuration of the current instrument. 

Results database Displays the name of the results database configured for the 
selected instrument. This field is populated automatically from 
the configuration of the current instrument. 
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Export file name Select a file by clicking the Browse button or you can enter a 
fully-qualified file name into the field. 

<Browse 
button> 

The Browse button displays a standard Save As dialog for you 
to select a directory for your exported file. After selecting a 
directory (and if necessary, entering a File name) click the Save 
button. 

Export This button starts the export  process and the software will 
attempt to export the selected batches in the Chromera results 
database into the specified file.  

As the operation proceeds the progress bar underneath the 
Export and Cancel buttons is progressively filled in. 

The result of the export operation is indicated in the Messages 
box.  

Cancel This button that can be used to cancel a export operation while 
it is in progress. 

Messages A box that displays messages associated with the Export Results 
function. If the Export operation is successful a message 
indicating this is displayed. 

Close This button closes the Database Export dialog.  Use of this 
button will not cancel an export operation in progress; the dialog 
closes when the export is complete. 

 
 
 
 
 



542 . Chromera User's Guide 

 

Export Chromera Methods 

To Export Chromera methods: 

1. From the Tools menu selecting Methods from the Export submenu, displays the 
following dialog. 

 

2. Enter the following information to export your method files. 
 

Field Description 

Select ... Clicking this button displays the Chromera Data Selector in the 
Multiple Methods mode, to select the methods to be exported.  

When you select one or more methods and click the Open button 
the Data Selector closes and information about the selected 
batches appears in the Methods to export table. 

Methods to export 
<displayed in a table 
of data selected for 
import> 

A table that displays the Name, Description, Creation 
Data/Time, and Last Modified Data/Time for each method 
contained in the export file. If the selected file was not a valid 
method export database file then an error message (Selected 
export file does not contain Chromera methods) is displayed in 
the Messages box and the table remains empty. 

Server Displays the name of the server configured for the selected 
instrument. This field is populated automatically from the 
configuration of the current instrument. 

Database Displays the name of the database configured for the selected 
instrument. This field is populated automatically from the 
configuration of the current instrument. 
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Export file name Select a file by clicking the Browse button or you can enter a 
fully-qualified file name into the field. 

 
<Browse button> 

The Browse button displays a standard Save As dialog to select 
a directory for you exported file. After selecting a directory (and if 
necessary, entering a File name) click the Save button. 

Export This  button starts the export  process and the software will 
attempt to export the selected methods in the Chromera database 
into the specified file.  

As the operation proceeds the progress bar underneath the 
Export and Cancel buttons is progressively filled in. 

The result of the export operation is indicated in the Messages 
box.  

Cancel This button that can be used to cancel a export operation while it 
is in progress. 

Messages A box that displays messages associated with the Export Methods 
function. If the Export operation is successful a message 
indicating this is displayed. 

Close This button closes the Method Export dialog.  Use of this button 
will not cancel an export operation in progress; the dialog closes 
when the export is complete. 
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Export Chromera Sequences 

To Export Chromera sequences: 

1. From the Tools menu selecting Sequences from the Export submenu, displays the 
following dialog. 

 

2. Enter the following information to export your sequence files. 
 

Field Description 

Select ... Clicking this button displays the Chromera Data 
Selector in the Multiple Sequences mode, to select 
the sequences to be exported.  

When you select one or more sequences and click the 
Open button the Data Selector closes and information 
about the selected batches appears in the Sequences 
to export table. 

Sequences to export 
<displayed in a table of 
data selected for 
import> 

A table that displays the Name, Description, 
Creation Data/Time, and Last Modified 
Data/Time for each sequence contained in the export 
file. If the selected file was not a valid sequence export 
database file then an error message (Selected export 
file does not contain Chromera sequences) is displayed 
in the Messages box and the table remains empty. 

Server Displays the name of the server configured for the 
selected instrument. This field is populated 
automatically from the configuration of the current 
instrument. 
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Database Displays the name of the database configured for the 
selected instrument. This field is populated 
automatically from the configuration of the current 
instrument. 

Export file name Select a file by clicking the Browse button or you can 
enter a fully-qualified file name into the field. 

<Browse button> 
The Browse button displays a standard Save As 
dialog to select a directory for your exported file. After 
selecting a directory (and if necessary, entering a File 
name) click the Save button. 

Export This  button starts the export process and the software 
will attempt to export the selected sequences in the 
Chromera database into the specified file.  

As the operation proceeds the progress bar underneath 
the Export and Cancel buttons is progressively filled in. 

The result of the export operation is indicated in the 
Messages box.  

Cancel This button that can be used to cancel a export 
operation while it is in progress. 

Messages A box that displays messages associated with the 
Export Sequences function. If the Export operation is 
successful a message indicating this is displayed. 

Close This button closes the Sequence Export dialog.  Use of 
this button will not cancel an export operation in 
progress; the dialog closes when the export is 
complete. 
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Export Report Templates 

To export Chromera report templates: 

1. From the Tools menu selecting Report Templates... from the Export submenu, 
displays the following dialog. 
 

 

2. Enter the following information to import your files. 
 

Field Description 

Select templates to 
export  
<displayed in a table of 
data selected for 
import> 

A table that displays the Name, Description, Creation 
Data/Time, and Last Modified Data/Time for each 
template contained in the export file. If the selected file 
was not a valid template file then an error message 
(Selected export file does not contain Chromera 
templates) will be displayed in the Messages box and 
the table will remain empty. 

Server Displays the name of the server configured for the 
selected instrument. The field is populated 
automatically from the configuration of the current 
instrument. 

Export file name  Displays the name of the file from which the data will 
be imported. Select this file by clicking the browse 
button.  Using the Open dialog, navigate to the 
directory containing the file, select the name of the 
stored template file then click the Open button. 
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 <Browse button> 

The Browse button displays a standard file selector 
dialog in single selection mode, enabling you to select a 
previously exported results database. After selecting an 
export file and closing the Open dialog, information 
about the batches in the export file will appear in the 
table. 

Export This button starts the Export process. When this button 
is clicked the software attempts to export the selected 
templates into the main results database defined in the 
fields above.  

As the operation proceeds the progress bar underneath 
the Export and Cancel buttons is progressively filled in. 

The result of the export operation is indicated in the 
Messages box. This button is only enabled when one or 
more batches in the table are selected. 

Cancel This button that can be used to cancel an export 
operation while it is in progress. 

Messages A box that displays messages associated with the 
Import Results function. If the selected file is not a 
valid Chromera results export database file then a 
message will be displayed here and the selection list 
will remain empty. 

Any existing messages (from a previous operation) will 
be cleared when a new export file is selected, the 
Refresh Items button is clicked or the Import button is 
clicked. 

If the Import operation is successful a message 
indicating this is displayed. 

Close This button closes the Import Results dialog Use of this 
button will not cancel an import operation in progress; 
the dialog closes when the import is complete. 

 
 
 





 

 

Dictionaries 
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About Dictionaries 

Chromera maintains several dictionaries to facilitate the consistent entry various names into 
method and other user-entry fields. The supported dictionaries are for component names, 
solvent descriptors, concentration units, and calibration standard names. The functionality of 
these dictionaries will be identical. 

Dictionary Editor 

This dialog displays when you choose the Dictionary Editor command from the Tools 
menu. The same dialog provide access for editing all system dictionaries. 

 

 

Control Description 

Select Dictionary A set of radio buttons to select the dictionary to be edited. 

<combo box> Select an existing or enter a new dictionary item to be modified or 
deleted. The drop-down list display the current contents of the 
selected dictionary. 

Add  Click the button to add the name in the combo box to the selected 
dictionary. 

Remove Click the button to delete the item displayed in the combo box from 
the selected dictionary. 

Change  Click the button to display a dialog enabling to change the item 
displayed in the combo box within the selected dictionary. 

Apply  Click the button to save all changes made within the editing session 
to the database. The Cancel button will therefore not function to undo 
these changes. The dialog will remain open. 

OK  Click the button to save all changes made within the editing session 
to the database and closes the dialog. 

Cancel  Click the button to undo all changes made since the last click of the 
apply button. The dialog closes. 
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<status bar>  Displays messages relating to operation of the Dictionary 
editor.  When a dictionary is selected using the radio buttons the 
name of the selected dictionary is displayed, along with a count of its 
contents. 

     For example: Components Dictionary (124)  

When a command is issued, the status panel will display a message 
indicating the result. 

     For example: The item was successfully added to the Components 
Dictionary 
      or 

     The Solvents Dictionary was successfully updated 

 

NOTE:  If the Add, Remove or Change button is clicked when the combo box is empty (or does not 
contain an existing dictionary entry) then an error message will be displayed. This approach 
has been chosen over the alternative, of disabling the buttons when there is no entry, so that 
the error message can be used to provide guidance on how to perform the function. The 
specific error message for each button will be: 

• Add - Please enter the item you want to add to the selected dictionary before clicking the 
Add button. 

• Remove - Please enter (or select) the item you want to remove from the selected 
dictionary before clicking the Remove button. 

• Change - Please enter (or select) the item you want to change before clicking the 
Change button. 

Choosing Names 

When entering one of the supported identifier types into the method, sequence, etc. you will 
be able to easily select a name from the associated dictionary. This is an auto-complete style 
of interaction where you are offered choices as you type in the first few characters of a 
name.  

NOTE:  The dictionary will NOT be available in controls where you are not entering a name but 
selecting an existing one from the method. For example, in the Relative Reference 
Component field of the Channel parameters, the Reference Peak field of the Peak Detection 
parameters or the Internal Standard Component field of the Peak Detection parameters. 

Adding Names 

When you type into one of the dictionary-supported fields a name that does not already exist 
in the associated dictionary, that name will be added to the dictionary. 

Saving Names 

When you enter one of the supported names types into the method or sequence a copy of 
the complete name will be stored in the data set (and not just a pointer to the dictionary 
entry). 

This is a practical necessity when considering the import and export of methods (and 
sequences). It is also not necessarily desirable that a change to the spelling of a name in the 
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dictionary should affect stored methods (as would occur if indexes to the dictionary were 
stored in the method). 

Editing Names 

Since typing in a misspelled name would result in a new entry to the dictionary (as described 
in Adding Names), a dictionary editor is provided.  

Note that changes to the dictionary will not affect names already stored in methods (as 
explained in section Saving Names). 

 

 
 



 

 

Typical LC Workflows 
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About LC Workflows 

The following are examples of some typical LC workflows. In some cases they describe the 
actions you need to perform in order to carry out a specific task, whether or not a data 
system were to be used. In other cases the workflow is only performed because it is 
necessary in the context of a data system and hence use of some kind of software tool is 
assumed. However, even in the latter case the description is as generic as possible, so as to 
minimize the assumptions made about the software behavior. 
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Starting Conditions 

Instrument Method Development 

The following is an overview of the steps for method development. 

Starting Conditions 

Instrument operational 

Set Run Conditions 

Modify active method to set up trial instrument conditions. 

Set Up Run 

Enter parameters required to set up and identify sample run, according to preference. This 
will likely include vial for injection and some kind of sample or run identification. 

Run Sample 

Inject sample. Examine chromatogram produced. Optionally integrate the chromatogram for 
accurate determination of relative peak size to get information about peak separation order. 

Evaluation 

Compare latest chromatogram with those obtained earlier in the session. 

I teration 

Repeat Set Run Conditions through Evaluation until satisfied with the separation achieved. 

 

Instrument Startup from a Shutdown State 

Starting Conditions 

The instrument is in standby (pump operating at reduced flow, detector lamp may be on or 
off) or shutdown (pump off, detector lamp off) state, following previous day’s analyses. 

Instrument Startup from Shutdown 

(This step is not performed if the instrument in standby state - see step Startup Instrument 
from Standby 

1. Replenish solvents (if required) 

2. Purge the pump 

3. Set the analytical pump flow conditions 

4. Turn the detector lamp on 
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5. Purge the autosampler 

6. Go to step Preparation Activities 

Startup Instrument from Standby 
7. If solvent replenishment required, turn off pump and replenish the solvents 

8. Set analytical pump flow conditions 

9. Turn detector lamp on (if off) 

10. Purge autosampler 

Preparation Activities 

Following steps are likely performed in parallel 

Monitor Instrument 

Evaluate noise and drift of detector signal. 

Evaluate pump pressure stability. 

Review Prior Data 

(See separate workflow) 

If previous day’s results indicate remedial action is required on the instrument this workflow 
will terminate. 

Prepare Samples and Sequence 

Prepare samples for injection and place in autosampler. 

Create/edit the sequence to be used for analysis of the samples. 

Run validation sample 

Provided the general instrument indicators are acceptable a sample is run to confirm 
chromatographic performance is acceptable for sample analysis. (If noise/drift/pressure 
stability indicate remedial action is required on the instrument this workflow will terminate.) 

This validation sample may be run as an isolated analysis or as the first row of the sequence, 
depending on SOP and/or confidence level in the instrument system. 

If the results from the validation sample (which could be suitability values, absolute peaks 
areas and/or calibration results) are not acceptable remedial action is required on the 
instrument and this workflow will terminate. 

Run/Continue Sequence 

Chromera has this under control. 

Starting Conditions 

The instrument is in standby (pump operating at reduced flow, detector lamp may be on or 
off) or shutdown (pump off, detector lamp off) state, following previous day’s analyses. 
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Instrument Startup from Shutdown 

(This step is not performed if the instrument in standby state - see step Startup Instrument 
from Standby 

1. Replenish solvents (if required) 

2. Purge the pump 

3. Set the analytical pump flow conditions 

4. Turn the detector lamp on 

5. Purge the autosampler 

6. Go to step Preparation Activities 

Startup Instrument from Standby 
7. If solvent replenishment required, turn off pump and replenish the solvents 

8. Set analytical pump flow conditions 

9. Turn detector lamp on (if off) 

10. Purge autosampler 

Preparation Activities 

Following steps are likely performed in parallel 

Monitor Instrument 

Evaluate noise and drift of detector signal. 

Evaluate pump pressure stability. 

Review Prior Data 

(See separate workflow) 

If previous day’s results indicate remedial action is required on the instrument this workflow 
will terminate. 

Prepare Samples and Sequence 

Prepare samples for injection and place in autosampler. 

Create/edit the sequence to be used for analysis of the samples. 

Run validation sample 

Provided the general instrument indicators are acceptable a sample is run to confirm 
chromatographic performance is acceptable for sample analysis. (If noise/drift/pressure 
stability indicate remedial action is required on the instrument this workflow will terminate.) 

This validation sample may be run as an isolated analysis or as the first row of the sequence, 
depending on SOP and/or confidence level in the instrument system. 
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If the results from the validation sample (which could be suitability values, absolute peaks 
areas and/or calibration results) are not acceptable remedial action is required on the 
instrument and this workflow will terminate. 

Run/Continue Sequence 

Chromera has this under control. 

Instrument Method Development 

The following is an overview of the steps for method development. 

Starting Conditions 

Instrument operational 

Set Run Conditions 

Modify active method to set up trial instrument conditions. 

Set Up Run 

Enter parameters required to set up and identify sample run, according to preference. This 
will likely include vial for injection and some kind of sample or run identification. 

Run Sample 

Inject sample. Examine chromatogram produced. Optionally integrate the chromatogram for 
accurate determination of relative peak size to get information about peak separation order. 

Evaluation 

Compare latest chromatogram with those obtained earlier in the session. 

I teration 

Repeat Set Run Conditions through Evaluation until satisfied with the separation achieved. 

 



 

 

Errors 
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About Errors 

Errors are divided into three classes: 

1. Errors relating to instrument operation. These include both errors reported by the 
device itself and any errors occurring in the communication between a device and 
the software. 

2. Errors occurring during background operations such as end-of-run processing or 
batch reprocessing. 

3. Errors occurring in interactive sessions where the user can be assumed to be 
present. 
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Error Logs 

The Instrument Event Viewer displays when Instrument Error Log command is selected 
from the Tools menu. The Instrument Event Viewer displays all errors associated with 
connection to, and communication with, the devices in the current instance for the current 
instrument configuration. In addition it displays errors relating to processing and other 
system operations. 

 
 

 

Closing an Instance 

If a sequence is running, or data acquisition is in progress under method setup (single run) 
mode, on an instrument then are not allowed to close that online instance of Chromera. Any 
attempt to do so results in an error message (You cannot shut down Chromera while the 
instrument is active) and the Chromera window will remain open. 
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Method Changed 

The current version of this method in the database contains changes made within the Run 
Time or Reprocess environment since you opened it with the Method Editor.  

These changes could involve one or more of the following: 

• Modifications you made to the method and saved from Run Time 

• Updating of the calibration information within the method as a result of running a 
calibration sample 

• Calculation of suitable Area and Noise Threshold values during automatic processing 
to replace blank values in the method. 

It is recommended not to overwrite the updated method with the version displayed here, 
unless you are certain you wish to do so. You can save the displayed method under a new 
name by choosing No within the message box and then choosing the Save as command 
from the File menu. 
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Overview  of Spectral Processing 

In Spectral Processing you can manipulate, process, and display spectral data associated with 
chromatograms obtained using the PerkinElmer photo diode-array (PDA) detectors.  

W ith spectral processing software you can: 

• View chromatographic data as a chromatogram, as a contour map, or as a three-
dimensional plot. 

• Gain access to all of a chromatogram’s associated spectra, and perform various 
calculations using those spectra. 

• Conduct on-screen spectral comparisons, or use the software to perform more complex 
operations such as adding, subtracting, dividing, and obtaining derivatives of spectra. 

• Identify peaks and calculate peak purity. 

• Confirm the identity of chromatographic peaks by comparing them with other peaks or 
standards 

• Annotate chromatograms with spectral positions, retention times, component names, or 
calculated values such as concentrations or purity indices.  

• You can select positions on any of the displayed chromatograms and call up their spectra 
in a separate window. 

• Chromatograms and Spectra can be normalized, offset-normalized, or displayed full scale 
to help you compare them visually.  

• The software also allows you to create and browse through spectral libraries, to search 
those libraries for spectral matches to an unknown spectrum, and to confirm peak 
identities by matching their spectra to those of known peaks in the libraries. 

• Use a two-dimensional contour map to find chromatographic peaks, which may not be 
showing at the wavelength used for the chromatogram.  You can use the contour map to 
obtain a spectrum and chromatogram at any point on the display. The time, absorbance, 
and wavelength display axes can be scaled independently. 

• View chromatographic data on a three-dimensional plot that provides a scaleable 
perspective on the complete data set. 

• Print chromatograms, spectra, and other data using a color printer.  You can annotate 
and export screen displays to other Windows programs to generate presentation 
graphics or documentation. You can also export numerical data to programs such as 
Microsoft Excel for additional study. 
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About the Spectral Processing Window  

Chromera Spectral Processing is designed so that you can easily process, manipulate, and display 
spectral data associated with chromatograms from one main window.  Each instance of Chromera 
will use one or multiple separate instances of Spectral Processing and each instance will not be 
shared between different instances of Chromera. 

The following topics provide a high-level look at the user interface.   

Tell me about the Menu bar 

The Menu Bar, located along the top of the program window, contains the menu commands 
that enable you to process, manipulate, and display spectral data associated with 
chromatograms, as described below: 

NOTE:  The symbol  in front of an item indicates that this is an on/off toggle command.  The check 
mark appears in front of the item when the function is active or selected.  The default for these 
commands is switched on. 

Menu Command Description 

File Remove Removes the currently selected spectrum from the Data tree.  
  

Remove all 
spectra 

Removes all spectra from the Data tree.  
  

Print Displays a Print dialog from where you specify which details you want to 
print from the current view and which printer you want to use. Enabled 
at all times.  

Apex Spectrum 
Plot Setup 

Displays the Apex Spectrum Plot Setup...dialog. This option is available 
at all times and in all environments in the Spectra Processing window 
but will display an error dialog if no channel is selected in the data tree. 

When not in Graphics Method Editor (GME) the command will also yield 
an information dialogue that the Apex Spectra Plot report parameters 
can only be set in the Method environment of the Spectral Processing 
window. 

Exit Closes this application.  

Edit Copy Object Copies the selected object to the clipboard.  If the cursor is in either a 
chromatogram or spectrum region then the numerical values of that 
trace will be placed on the clipboard.  This allows export of data to 
spreadsheet programs such as Excel.   

Copy Screen As 
►Bitmap 

►Metafile 

Bitmap - Copies the entire screen as a bitmap image to the clipboard. 

Metafile - Copies the entire screen as a Windows metafile to the 
clipboard. 

View Chromatogram 
Baselines 

Displays or hides baselines on all chromatograms.  Baselines are 
displayed as a solid red line. 
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Baseline Spectra Adds the baseline spectra for the selected spectra to the Data Tree.  
The baseline spectra are identified by the retention time of the spectrum 
(or, if a range of spectra are being used, the start and end times of the 
range) followed by the word base; and they appear immediately after 
the parent spectrum in the tree. This command is enabled when a 
spectrum is selected in the data tree.  The command does not work if a 
baseline spectrum is selected.  

Baseline 
Corrected Spectra 

On the Main and Chrom/Spectra view the command will toggle the 
displayed spectra to be baseline corrected or uncorrected.   

On the Contour Map and 3D Plot the command will toggle the ghost 
spectra to be baseline corrected or uncorrected but has no affect on 
previously captured spectra. 

This command has no affect in any of the Spectral Operations views 
which are all controlled by the Baseline Corrected Spectra in the 
parameter list for that operation. 

Overlay 
Chromatograms 

Displays the contents of all chromatogram windows with all 
chromatograms being displayed on the one set of axes.  When selected 
the menu item changes to Stack Chromatograms, and selecting the 
option returns all chromatograms to being displayed on separate axes.   

Stack Spectra Displays the contents of all spectral windows split onto separate axes.  
When selected the menu item changes to Overlay Spectra, and selecting 
the option again will return to Stack Spectra. 

 Cursor Toggles the cross-hair cursor On or Off.  Enabled when a 
chromatogram, spectrum or contour map is selected on a view (not an 
operation). 

Toolbars Toggles whether or not the toolbars are displayed.  When Toolbars is 
checked, all three tool bars are displayed.  

View tree Toggles whether or not the View tree is displayed. 
  

Data tree Toggles whether or not the Data Tree is displayed. 
  

Parameters Toggles whether or not the Parameters pane for Operations is 
displayed. Enabled only on Operations.   

NOTE:  The Parameters pane always includes the Display or Hits list.  

Panes ► 

Chromatogram 

Spectrum 

Contour Map 

3D Plot 

This command allows you to select whether or not a pane, selected in 
the menu, is displayed on the page.  When you hide a pane, a Custom 
View is formed.   

Shown panes are checked, hidden panes are unchecked. 

Enabled for all View pages.  This command is disabled on Operation 
pages.   

NOTE: Hiding a pane does NOT unload the chromatogram or extracted 
spectra. This command only hides/shows the pane.  The contents do 
not change.    
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View Template ► 

Save As 

Delete 

Export 

Import 

 

Save As… - Displays the Save View As dialog. 

Delete - Deletes the selected custom view. Enabled only when a 
custom view is selected. 

Export - Displays a standard file selector enabling the selected custom 
view to be exported to disk.  Enabled only when a custom view is 
selected. 

Import - Displays a standard file selector enabling a custom view 
exported to disk to be imported into this view tree. 

Log Displays the log file. 

Actions Zoom control ► 

X axis 

Y axis 

Z axis 

Sets the control over the zoom slider. 

All three are independent toggles enabling any combination to be 
switched on at the same time to create a multi-directional zoom.  

X and Y are enabled when a 2D graph is selected, all three when a 3D 
plot is selected. 
  

Autoscale ► 

X and Y 

Y only 

Rescales the selected graph to the maximum range of the data 
displayed, in either just the Y direction or both, depending on the 
command selected. 

Enabled when a 2D graph is selected and the full range is not currently 
shown. 
  

Normalize ► 

X and Y 

Y only 

Offset 

Point 

Rescales the selected graph in line with the command selected. 

X and Y and Y only will operate based on the full graph. 

Offset will normalize to the maximum point to the right of the X-axis 
cursor. 

Point on a spectrum or chromatogram will normalize at the current X-
axis cursor position, while on a contour map this command will assign 
all absorbance values above the current X-axis cursor position to the top 
contour.  

Zero This command only applies to contour maps.  When a Contour Map 
pane is selected, this command assigns all absorbance values below the 
mid-point of the cursor to the bottom of the contour. Enabled at all 
times.  

Previous scale Returns the selected graph to the previous scaling, stepping back one at 
a time through previous scale changes. Enabled only when the selected 
2D or 3D graph has been scaled, normalized or zoomed.   

3D Rotation 
Controls ► 

X only  

Y only 

 

Rotate X - Sets rotation slider to rotate around the X axis. 

Rotate Y - Sets rotation slider to rotate around the Y axis. 
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Label 
Chromatograms 

Displays the Label Chromatograms dialog. Enabled any time a 
chromatogram is selected on a View (not an Operation). 
  

Annotations ► 

Add 

Edit 

Delete 

Delete All 

Add - Opens an empty Edit Annotations dialog. Enabled when a graph 
is selected. 

Edit - Opens the Edit Annotations dialog with the details of the selected 
annotation available to edit.  Enabled when an annotation is selected. 

Delete - Removes the selected annotation. Enabled when an annotation 
is selected. 

Delete All - Removes all annotations from the selected graph.  Enabled 
when a graph is selected that has at least one annotation. 
  

Range This command is used to display all the spectra within a given time 
range.  When this command is selected a green range box is displayed 
on the chromatogram:  

• Positioning the mouse pointer in the range box and clicking 
actives the range box.  When activated: 

    Handles are displayed on the left and right edges of the box. 

            Positioning the mouse pointer over the left or right handles of the 
box changes it to a horizontal two-headed arrow and click and 
hold enables the edge to be stretched.  Upon releasing the mouse 
the range box is deactivated. 

          Positioning the mouse pointer over the left or right edge of the 
box (except for the position of the handles) changes it to a four-
headed arrow and click and hold enables the complete box to be 
moved.  Upon releasing the mouse the range box is deactivated. 

• Positioning the mouse pointer within the box and double-clicking 
loads all the spectra enclosed by the box into the Data Tree and 
sets them as selected.  The range box is cleared. 
 
Clicking on the chromatogram but outside of the box clears the 
range box.   

   NOTE: Range is also an option in the Context menu for a stacked 
chromatogram. 
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Add All to View Used both for adding spectra that have come from library searches, 
mathematical operations, etc, to the Data Tree so they can be viewed 
on other pages and for permanently displaying spectra temporarily 
displayed on a View. 

Enabled in Views at any time a spectrum is temporarily viewed or in 
Operations when a spectral graph is selected that includes spectra that 
are not currently part of the Data Tree.  

When the user selects the Add All to View command in any Operation, 
a Response dialog appears that informs you that spectra have been 
added to the Data Tree.  In any Operations, all the displayed/checked 
hit spectra will be added to the Data tree under the appropriate 
chromatogram. Derivative Spectra will be named with the time of the 
source spectrum plus the label “Derivative” and the derivative order.  
Spectra from Math operations will be labeled “MATH #” where # will 
increment to provide a unique name.  Information on the math 
spectrum will yield the source chromatograms and spectra and all 
necessary parameter values. They will be shown in the non-operation 
views. If the spectrum already exists in the Data tree, the spectrum will 
not be duplicated.  

Individual spectra may be added by context menus in the specific 
operation.  

Tools View Library Displays a file select to select the library to be displayed followed by the 
View Library dialog.  

Build Library ► 

Create 

Add Apexes 

Edit 

Displays a file selector either to select the library to be edited or to 
name the new one, followed by the Edit Library dialog. 

Create - Displays a file selector titled New Library.  From the New 
Library dialog you specify a name and location for the new library.  
Once you specify a new library, the Create Library dialog appears.   

Add Apexes - Displays a file selector titled New Library.  From this 
dialog you specify a name and location for the new library.  Once you 
specify a library, the Create Library dialog appears.  This in turn will be 
followed by the Edit Library dialog.  The Edit Library dialog shows all the 
named peaks from the selected chromatogram in the Library list by 
component name.  Enabled only if a single chromatogram is selected 
and it has named peaks in it. 

Edit - Displays a file selector titled Open Library  Once you select a 
library to open, the Edit Library dialog appears.  Enabled at all times.  

Chromera ► 

Reprocess 

Graphic Method 
Edit 

 

Opens the selected application with the selected chromatogram passed 
to the application. 

Enabled at all times a single chromatogram is selected. 
  

Format Graphs Displays the Format Graphs dialog and either goes to the correct tab for 
the currently active graph type or the Chromatogram tab if no graph is 
active.  Changes made here effect the defaults, to change the current 
graph only use the context menu for the graph.  
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Spectral Baseline 
correction 

Displays the Spectral Baseline correction dialog. Enabled only if a single 
chromatogram is selected in the Data tree. 

NOTE: This command is also available as context menu for 
chromatograms only.  

Override save 
dialog 

Displays the dialog that enables you to set whether the you want to turn 
off the automatic save dialog .  

Edit Default 
Method 

Displays the Method Editor dialog for the default method, enabling it to 
be edited. 

Help Contents and 
Index 

Displays the opening page of the HTML Help. 

Display Tooltips Toggles the tool tips on and off. Enabled at all times. Default is on.  

PerkinElmer on 
the Web 

Goes to www.perkinelmer.com. Enabled at all times, if there is a web 
browser installed and connected to an ISP. 
  

About Displays the About dialog. 

Tell me about the Tool bars 

There are three default tool bars located below the menu bar.  The tool bars contain icons for 
standard interactions that will be performed frequently.  The default tool bars are as follows: 

Main Tool Bar 

The Main Tool bar contains the following commands: 

Icon Associated menu 
command 

Description 

 Remove Removes the currently selected items in the Data 
tree.  

 Information… Enables you to review the information associated with 
a file.  

 Print Prints details from the current view or operation. 

 Exit Closes the application.  

 Copy Object Copies the selected object to the Windows clipboard.  

 Baseline Corrected 
Spectra 

Determines whether spectra are shown in their 
baseline corrected state or not.  

 Cursor Displays or hides the cursor.  

 Label Chromatograms… Enables you to choose the labels to be displayed on 
chromatograms.  
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 Add/Edit Annotation Enables you to add or edit text on a graph.  

 View Tree Switches on and off the View Tree.  

 Data Tree Switches on and off the Data Tree.  

 Parameters Switches on and off the Parameters pane.  

 Range Displays a range box enabling you to add all the 
spectra within the box to be added to the Data tree.  

 Add All to View… Enables you to add spectra from Operations to the 
Data Tree.  

 Format Graph Enables you to change the formatting of the selected 
graph.  

 Help Displays the Help File.  

 Display Tool tips Determines whether tool tips are displayed or not.  

 PerkinElmer on the web Links to www.perkinelmer.com.  
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2D Graph Tool Bar 

This tool bar contains commands that allow you to modify how chromatograms and spectra are 
displayed. 

Icon Associated Menu 
Command 

Description 

 
Stack/Overlay Switches the currently selected pane between a 

stacked display and an overlaid display.  

 
Autoscale X and Y Rescales the graph to the maximum and minimum of 

all data in the X and Y directions.  

 
Autoscale Y only Rescales the graph to the maximum and minimum of 

all data in the Y direction only.   

 Normalize X and Y Normalizes the graph so all plots are full scale.  

 
Normalize Y only Normalizes the graph so all plots are full scale without 

changing the X axis.   

 
Offset Normalize Normalizes all plots to the highest point to the right of 

the cursor position.  

 Normalize Point Normalizes all plots at the cursor position.   

 Zero Sets the point at the cursor position to zero.   

 Previous scale Steps back through previous scale changes. 

 Zoom X Sets whether the zoom slider works on the X axis. 

 Zoom Y Sets whether the zoom slider works on the Y axis. 

 Zoom Z Sets whether the zoom slider works on the Z axis. 

 Zoom slider Zooms in on the graph as set by the zoom tools. 

3D Graph Tool Bar 

This toolbar contains commands for rotating a 3D Plot. 

Icon Associated Menu Command Description 

 
Rotate X Sets rotation slider to rotate around 

the X axis.  

 
Rotate Y Sets rotation slider to rotate around 

the Y axis.  

 
Rotation slider Rotate around the set 3D rotation 

control axis.  



Appendix 1 PDA Spectral Processing . 573 

 

Tell me about the Views Tree 

The Views Tree appears in the upper left hand pane of the window, and it is your means of 
navigation.  The Views Tree will change depending on the environment from which it was 
opened (Method/GME or Post-Run/GRE).  From the Views Tree you select what you want 
displayed in the right-hand portion of the screen.     

When you select an item on the Views Tree, the right-hand portion of the window displays the 
selected view.  If you select a header item, such as Operations or Custom View, the right-hand 
side of the window displays empty panes. 

Tell me about the Views and Operations that are listed on 
the Views Tree 

When in Spectral Processing, you work with Views and Operations.   Basically, Views allow 
you to view chromatograms and spectra on the right-hand side of the window.  Meanwhile, 
Operations, which are also displayed on the right hand side of the window, are used to obtain 
important information on chromatograms and to help you analyze spectra.  All of the Views and 
Operations that can be displayed on the window are listed on the Views Tree. 

Views 

The Main View is displayed by default.  This view is divided into four panes:  a Chromatogram 
pane, a Spectra pane, a Contour Map pane, and a 3D Plot pane.  

In addition to the Main View, you have four other default views that you can select from the 
Views Tree.  The four other default views are labeled: Chrom/Spectra View, Contour Map View, 
Spectra 3D View, and Compare View.  

You can also create your own Custom View by modifying an existing view.  You can also create 
your own Custom View page by modifying an existing view.  

Operations 

Operations that you can perform on chromatograms and spectra are listed under the 
Operations node of the Views Tree.  The operations listed on the Views tree provide you with a 
number of options for identifying, storing, and performing calculations on spectra; and for 
obtaining important information about your chromatograms, such as verifying the purity of 
chromatographic peaks, or building your own libraries of stored spectra that can be used in a 
search to identify an unknown spectrum.  

When you click on an Operation, such as Wavelength Maximum, the right-hand side of the 
window displays panes for displaying the required Chromatogram or Spectrum (which you select 
from the Data Tree), a Parameters pane, which is used to set and investigate the various 
parameters used to determine the results of a particular operation, a Results pane where the 
result of an operation is displayed, and a Display List that contains a list of items you can select 
to display on the Results pane. 

Tell me about the Data Tree 

The Data Tree serves two functions.  On the Main View, Chrom/Spectra View, and 
Compare View, the Data Tree displays a list of currently loaded chromatograms and spectra 
that are grouped by the parent chromatogram.  On these Views, you use the Data Tree to select 
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the chromatograms and spectra you want to see in the relevant panes (chromatograms are 
displayed in the Chromatogram pane, Spectra are displayed in the Spectra pane).  Items that 
appear checked on the Data Tree are displayed in the relevant panes; while unchecked items on 
the Data Tree are not displayed. 

When specialized Views are displayed, such as the 3D Spectra View or the Contour Map 
View, the Data Tree displays a list of open chromatograms.  From the Data Tree, you select the 
chromatogram you want to display.  Only one chromatogram can be selected at a time.   

NOTE:  When the 3D Spectra View or the Contour Map View is displayed, the spectra that appeared on 
the Data Tree prior to accessing either view, are not shown on the Data Tree.  Only opened 
chromatograms are displayed on the Data Tree for the 3D Spectra View and the Contour Map 
view.  The spectra are not lost and will reappear when you change the view.   

 It should also be noted that when you extract spectra from a chromatogram displayed on a 3D 
Plot or Contour Map, the spectra are not displayed in the Data Tree until you select another view 
such as the Main View or Chrom/Spectra View.  In addition, chromatograms that are extracted 
on these views are temporary and will be cleared from the chromatogram pane when you select 
a different view. 

Tell me about the right-hand side of the w indow 
The right-hand side of the window can consist of multiple panes for displaying chromatograms 
and spectra.  The type of panes displayed on the right-hand side of the window depends on 
whether you are looking at a View or an Operation.   

The screen below shows the panes that are displayed when the Main View is selected on the Views 
Tree. In the Main View you can display chromatograms, spectra, contour maps, and 3D plots. 

 

• The Main View, Chrom/Spectra View, Contour Map View, Spectra 3D View, and Compare 
View, have a predefined set of panes for displaying chromatographic data.  You cannot 
add panes to these predefined Views.  However, you can hide a pane that is associated 
with the view in order to create a Custom View.   

• If an Operation is selected on the Views Tree, the panes that appear in the right-hand 
portion of the window consist of:  panes for displaying the required Chromatogram or 
Spectrum (which you select from the Data Tree), a Parameters pane, which is used to 
set and investigate the various parameters used to determine the results of a particular 
operation, a Results pane where the result of an operation is displayed, and a Display 
List that contains a list of items you can select to display on the Results pane. 

  



 

 

View ing Chromatograms 
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About the Chromatogram Pane 

The Chromatogram pane shows one more chromatograms, which have been selected on the 
Data Tree.  The chromatograms displayed on this pane are color coded to match the 
chromatogram names listed on the Data Tree.  

You can display chromatograms either stacked or overlaid, as determined by the 
Stack/Overlay Chromatograms command. 

 

This section shows you how to work with 
chromatograms displayed on the 
Chromatogram pane.   

• To work with the Chromatogram pane, 
you must first select the pane by 
clicking anywhere inside the plot region 
of the pane.  When the Chromatogram 
Pane is selected, the border of the pane 
turns blue.   

How  do I work w ith the Chromatogram Pane? 

When the Chromatogram Pane is selected, the border of the pane turns blue.  Once you 
have selected the Chromatogram pane you can do the following: 

• If the Cursor command appears checked on the View menu, you can click 
anywhere on the displayed chromatogram and cross hairs appear at the point in the 
chromatogram region where you clicked the cursor.  The exact positions of the X and 
Y axes are also displayed as text boxes on the axes.   

• On any Chromatogram pane, when you move the mouse pointer close to any edge 
of the plot region the pointer changes into a four headed arrow. 

 
A drag operation, when the mouse pointer is in this form, drags the graph around the plot 
region. 

•  If the Chromatogram pane is stacked, as indicated when the stacked icon appears 

to be pressed down ,  a separate scale is shown for each curve.   

• If overlaid, as indicated when the stack/overlay icon appears , a single Y scale 
is shown, unless the Y values for the selected spectra are too dissimilar, in which 
case, the Y axis has no labels and the curves are artificially overlaid. 

• On the MainView, Chrom/Spectra, and Compare Views, the Stack/Overlay 
command can be used to display chromatograms as either stacked or overlaid.  If 
the Chromatogram pane is stacked, as indicated when the stacked icon appears to 

be pressed down ,  a separate scale is shown for each curve.   
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If overlaid, as indicated when the stack/overlay icon appears  , a single Y scale 
is shown, unless the Y values for the selected spectra are  

• The tool bar buttons along the upper right-hand side of the window allow you to 
zoom in on portions of the displayed data and to re-scale the data.  

 
For more information on scaling chromatograms, see Scaling Chromatograms. 

 

What happens when I open a chromatogram? 

For information on opening a chromatogram, see the topic titled Opening Chromatograms. 

Each time you open a new chromatogram the following occurs: 

The file name of the chromatogram you just opened is listed at the bottom of the Data Tree.   

Depending upon the View you have selected you can specify whether or not a chromatogram 
is displayed on the view by doing the following: 

• To have the chromatogram displayed on the current view, check the chromatogram.   

• Or, if the current view only allows one chromatogram to be displayed on the View, 
you can select which chromatogram you want displayed on the view by selecting it 
on the Data Tree.   

For example, on the Main View each chromatogram that appears checked on the Data Tree 
is displayed on the Chromatogram pane, on the Contour Map pane, and the 3D Plot pane.     

 

NOTE:  In order for you to easily identify the newly opened chromatogram, please note that the 
chromatogram graph is color coded to match the chromatogram name listed on the Data 
Tree.     
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If you are looking at a view where multiple chromatograms can be displayed, and the 
Chromatogram pane is set to Stacked mode, the newly opened chromatogram appears at the 
top of the Chromatogram pane; this is the reverse order of how chromatograms are listed on 
the Data Tree.  The Contour Map and 3D plot for the newly opened chromatogram are 
displayed in the same position as shown on the Chromatogram pane.    

Tell me about the context menu that appears when I right mouse click on 
the Chromatogram Pane. 

When you right click on the Chromatogram pane a context menu appears that contains the 
following commands: 

NOTE:  When the Chromatogram Pane is in Stacked mode, each of the chromatograms has its own 
context menu.  When the Chromatogram Pane is in Overlay mode, the context menu items 
apply to all chromatograms.  

Command Description 

Print Pane… Prints the current pane.   

 Chromatogram Baselines Displays or hides baselines on all chromatograms as a red line.  

Overlay 
Chromatograms/Stack 
Chromatograms 
 

This command toggles between Stack Chromatograms and 
Overlay Chromatograms, and determines how the contents of 
the pane are displayed.  This option is not available when the 
Chromatogram pane is displayed on an Operation. 

•       When Overlay Chromatograms is selected all 
chromatograms are displayed on one set of axes and 
the menu command changes to Stack 
Chromatograms. 

•  When Stack Chromatograms is selected, all 
chromatograms are displayed on separate exes and 
the menu command changes to Overlay 
Chromatograms.   

Cursor Toggles the cross-hair cursor on and off.    

Hide Pane 
 

Hides the chromatogram pane forming a custom view.   
This option is not available when the Chromatogram pane is 
displayed on an Operation.  

Label Chromatograms… 
 

Displays the Label Chromatograms dialog.   
This option is not available when the Chromatogram pane is 
displayed on an Operation.   

Range 
 

Displays a green range box on the chromatogram.  
This option is not available when the Chromatogram pane is 
displayed on an Operation.   

Add to View… 
 

Adds the spectrum temporarily displayed from a selected point 
on the chromatogram to the Data Tree and selects it.  
This option is not available when the Chromatogram pane is 
displayed on an Operation. 
NOTE: To use this option you must have the Chromatogram 
pane in Stacked mode and the Spectra pane in Overlay mode.  
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Format Graphs Displays the Format Graphs dialog at the Chromatogram tab. 
Changes made here effect the current graph only.  

Spectral Baseline Correction Displays the Spectral Baseline Correction dialog.   

How  do I label Chromatograms? 

NOTE:  Labels can only be applied to chromatograms that are displayed on a View.  You can not 
select a label for a chromatogram that is displayed on an Operation. 

You can apply labels to all chromatograms that appear in a Chromatogram pane, or, if the 
current view displays chromatograms as stacked, you can apply a label to a single 
chromatogram.  

To apply a label to all currently loaded chromatograms: 

1. From any of the Views, select Actions > Label Chromatograms.  
The Label Chromatograms dialog appears. 
  

 

2. From the Label drop down, select a label you wish to apply. 

3. Check Apply to all chromatograms. 

4. Click OK to close the Label Chromatograms dialog. 

 

To apply a label to a single chromatogram: 

1. From any of the Views, click on the Chromatogram pane that contains the 
chromatogram you wish to label. 

2. A blue border appears around the selected Chromatogram pane. 

3. From the Actions menu select Actions > Label Chromatograms. 

4. The Label Chromatograms dialog appears. 
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5. From the Label drop down list, select a label you wish to apply to the chromatogram. 

6. Uncheck the Apply to all chromatograms check box. 

7. Click OK. 
The selected label is applied to the chromatogram. 

How  do I extract and/ or display spectra from a chromatogram? 

To view spectra associated with a particular chromatogram, as well as extract 
spectra from a chromatogram, the Chromatogram pane use a Stacked display, and 
the Spectrum pane must use an Overlaid display.   

• You can set the display modes for both panes by selecting Stack Chromatograms 
and Overlay Spectra from the View menu. 

To extract spectra: 

1. Click on any area in the white space of the Chromatogram pane. 

2. Set the selected Chromatogram pane to Stacked mode by clicking on the icon so 

that the icon appears to be pushed down   

3. Float your mouse pointer over a point on the chromatogram to temporarily view, in 
the Spectra pane, the spectrum from that point.  As you continue to float your 
mouse pointer over the chromatogram, the Spectra pane automatically updates, so 
that the spectrum from the current location of your mouse pointer is displayed in the 
appropriate pane. 

4. If you see a spectrum that you want extract, just double click on the spot in the 
chromatogram that contains the spectrum you want to extract. 
The spectrum at the wavelength and time you clicked appears in the Spectra pane.   
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View ing Chromatograms 

Now that you have a general understanding of the user interface, this section will introduce 
you to the most basic element, the chromatogram.  Chromera Spectral Processing is 
designed to answer the question “What chromatographic information can I get from 
the spectra associated with this chromatogram?” — or, perhaps more clearly, “What 
information about the peaks in this chromatogram and the components in the 
sample can I get from the spectra associated with this chromatogram?” It’s not 
surprising, then, that the basic element is the chromatogram. Most operations begin with 
chromatograms. 
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Scaling Chromatograms 

There are a variety of options to scale a chromatogram.  You can: 

• Visually specify an area of the display to zoom into using the Box Zoom function. 

• Scale chromatograms by specifying the axis range from the Format Graphs dialog. 

• Autoscale only the absorbance axis, to fit the chromatogram between 10% and 
90% of the display, or you can scale both axes to display the full retention time 
range and re-scale the absorbance to fit between 10% and 90% of the display. 

• Zoom in a continuous fashion. 

• Normalize an entire chromatogram using the Normalize X and Y command  
(i.e. all points in the displayed chromatogram), normalize along the Y axis only using 
the Normalize Y command , normalize at the current cursor position using the 
Normalize Point command , or you can normalize to the maximum absorbance 
value to the right of the current cursor position using the Offset Normalize 
command . 

Following is an overview of the scaling options that are available to you when you are 
working with a Chromatogram pane: 

How  do I visually specify an area of the display to zoom into using the Box 
Zoom function? 

To zoom into a visually defined region: 

1. Move the mouse cursor inside the plot region and position it at a corner of the area 
you want to zoom. 

2.  Hold down the left mouse button and drag the mouse to form a box around the area 
to be zoomed.  

3. Release the mouse button. 

4. The region you wish to zoom into will be outlined with a box containing eight control 
points.  The box can be resized by clicking and dragging on any of the control points. 

5.  Move the mouse pointer into the zoom region and click the left mouse button. 

6. The zoomed area now fills the trace display region.  

7.  You can abort the zoom before step 4 by clicking the left mouse button outside the 
zoom box. 

8. To return to a view of the entire trace, select Actions > Autoscale > X and Y. 



Viewing Chromatograms.  583 

 

How  do I view  and change the ax is range for a particular chromatogram? 

1. You can view and change the axis range for particular chromatogram by right mouse 
clicking on a chromatogram and selecting Format Graphs from the context menu 
that appears.    

2. The Format Graphs window appears with the Chromatogram tab selected.  This 
window allows you to set the minimum and maximum values for the selected 
chromatogram on both the X and Y axes. 

 

3. From the Chromatogram tab page specify the Maximum and Minimum values for the 
X and Y axes. 

4. Click OK to apply changes and close the Format Graphs dialog. 

How  do I use the Autoscale tools? 

The autoscale commands allow you to rescale the data in the chromatogram pane so that all 
of the data are visible.  There are two commands which you can use to scale a 
chromatogram to fit the display region.  Autoscale X and Y  scales the chromatogram to 
between 10% and 90% of the absorbance axis as well as displaying the full retention time 
range of the chromatogram.  Autoscale Y only scales only the absorbance axis without 
changing the retention time range. 

To autoscale the absorbance only:  

1. Click inside the Chromatogram pane that contains the chromatogram/s that you 
want to autoscale in the Y direction. 

2. Select Actions > Autoscale > Y only.  
OR 
Click on the Autoscale Y icon . 
The absorbance axis of the selected chromatogram is scaled to fill 80% of the 
display. 



584 . Chromera User’s Guide - Spectral Processing 

 

To autoscale both the retention time and absorbance: 

1. Click inside the Chromatogram pane that contains the chromatogram/s you want to 
autoscale in the X and Y directions. 

2.  Select Actions > Autoscale > X and Y.   
OR 
Click on the Autoscale X and Y icon . 
The retention time axis of the selected chromatogram is scaled to fill the region.  All 
other chromatograms will be re-scalled to this retention time range.  The absorbance 
axis is scaled to fill 80% of the display.  

How  do I zoom in a continuous fashion? 

You can zoom a chromatogram in a continuous fashion using the slider zoom feature in 
conjunction with the Zoom X  and Zoom Y  icons.  The slider zoom enables you to 
expand or contract the chromatogram in a continuous manner.  The Zoom X and Zoom Y 
commands determine what is zoomed when you are interacting with the zoom slider. 

To continuously zoom a chromatogram: 

1. Before performing the zoom, place the cursor at the position that you want to zoom, 
since the zoom is around the position of the cross-hair cursor.   

2. Click on the ZoomX axis icon  and or the Zoom Y axis  icon on the tool bar to 
set the required zoom mode. 
You can select both the X and Y axis icons to create an X and Y zoom. 
The buttons appear depressed when active. 

3.  Push the tool bar slider to the right or left. 

How  do I use the use the Normalization commands to scale a 
chromatogram? 

The Normalization commands are useful when multiple, overlaid chromatograms are 
displayed, as these commands are used to find subtle differences in the plot.  Basically, the 
Normalize commands help you compare the exact shapes of peaks by converting all of the 
displayed peaks to the same maximum height.    

NOTE:   For a detailed description of how the Normalization commands can be used, refer to Viewing 
Spectra -  Detailed Description of Normalization commands.   

The Normalization commands are as follows: 

Icon Associated menu 
command 

Description 

 Normalize X and Y Normalizes the graph so all plots are full scale. 

 Normalize Y only Normalizes the graph so all plots are full scale 
without changing the X axis.  
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 Offset Normalize Normalizes all plots to the highest point to the right 
of the cursor position. 

 Normalize Point Normalizes all plots at the cursor position.  

 

NOTE:  The Normalize Y command is useful if you have zoomed in on a specific region of the 
chromatogram and want to normalize without resetting the X axis, since Normalize All 
evaluates all points in the chromatogram, and therefore, resets the X axis. 

To normalize both the retention time and absorbance: 

1. Click anywhere inside the chromatogram pane that contains the chromatogram/s you 
want to scale. 

2. Click on the Normalize X and Y icon . 
OR 
Select Actions > Normalize > X and Y from the menu bar. 
The retention time axis of the selected chromatogram is scaled to fill the region.  All 
other chromatograms will be re-scaled to this retention time range.  The absorbance 
axis is scaled to fill 80% of the display.  

To normalize along the Y axis only: 

1. Click the region below the point where you wish normalization to occur. 

2. Click on the Normalize Y icon .  
OR 
Select Actions > Normalize > Y only from the menu bar. 
The chromatogram will be normalized at the maximum point in the displayed region without 
changing or resetting the X axis value. 

To normalize to the highest point to the right of the cursor: 

1. Click the region below the point where you wish normalization to occur. 

2. Click on the Offset Normalize  icon. 
OR 
Select Actions > Normalize > Offset from the menu bar 
The chromatogram is normalized to the maximum point above the cursor position. 

To normalize at the position of the cursor: 

1. Click the region at the point where you wish normalization to occur. 

2.  Click on the Normalize Point icon . 
OR 
Select Actions > Normalize > Point from the menu bar. 
The chromatogram is normalized at the cursor position. 
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Labeling Chromatograms 
You can label individual chromatographic peaks.  There are 14 different labels 
available for annotating the chromatograms, however, only one type of label can 
displayed at a time.  You may change the type of labeling on one or all of the 
chromatograms any time you are viewing chromatograms.  You cannot apply a label 
to a chromatogram from an Operation.    

How  do I apply a label to chromatograms? 

NOTE:  Labels can only be applied to chromatograms that are displayed on a View.  You can not 
select a label for a chromatogram that is displayed on an Operation. 

You can apply labels to all chromatograms that appear in a Chromatogram pane, or, if you 
are on a View where the Chromatogram panes are stacked, you can apply a label to a single 
chromatogram.  

To apply a label to all currently loaded chromatograms: 

1. From any of the Views, select Actions > Label Chromatograms. 

The Label Chromatograms dialog appears. 

2. From the Label drop down, select a label you wish to apply. 

3. Check Apply to all chromatograms. 

4. Click OK to close the Label Chromatograms dialog. 

 

To apply a label to a single chromatogram: 

1. From any of the View pages click on the Chromatogram pane that contains the 
chromatogram you wish to label. 

A blue border appears on the selected Chromatogram pane. 

2. From the Actions menu select Actions > Label Chromatograms. 
The Label Chromatograms dialog appears. 

3. From the Label drop down list, select a label you wish to apply to the 
chromatogram. 

4. Uncheck the Apply to all chromatograms check box. 

5. Click OK. 
The selected label is applied to the chromatogram. 
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Temporarily Displaying Extracted Chromatograms 

Chromatograms can be temporarily captured and displayed on the 3D Spectra View, and the 
Contour Map View.  The chromatograms you capture and display on these views are not 
added to the Data Tree and are cleared when you select another View. 

To temporarily display extracted chromatograms: 

1. Click on an area inside the white space of the pane that you wish to extracting from. 
A blue border appears around the selected pane. 

2. Set the selected pane to stacked mode, as indicated when the stacked icon appears 

to be pressed down . 
You used a stacked display whenever you want to extract data from a pane. 

3. Click on any area in the white space of the Chromatogram pane. 
A blue border appears around the selected pane. 

4. Set the Chromatogram to Overlay mode, as indicated when the stack/overlay icon 

appears . 
The pane that you are extracting data into must be in Overlay mode.  

5. You can now "float” the mouse pointer on the pane you are extracting from and 
have the associated chromatogram displayed on the Chromatogram pane. 
OR 
Double click on a specific area of the pane to temporarily extract a chromatogram at 
the selected wavelength. 
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Extracting and Displaying Spectra from a 
Chromatogram pane 

To view spectra associated with a particular chromatogram, as well as extract spectra from a 
chromatogram, the Chromatogram pane must use a Stacked display, and the Spectrum 
pane must use an Overlaid display.   

• You can set the display modes for both panes by selecting Stack Chromatograms 
and Overlay Spectra from the View menu. 

To extract spectra: 

1. Click on any area in the white space of the Chromatogram pane. 

2. Set the selected Chromatogram pane to Stacked mode by clicking on the   icon 

so that the icon appears to be pushed down   

3. Float your mouse pointer over a point on the chromatogram to temporarily view, in 
the Spectra pane, the spectrum from that point.  As you continue to float your 
mouse pointer over the chromatogram, the Spectra pane automatically updates, so 
that the spectrum from the current location of your mouse pointer is displayed in the 
appropriate pane. 

4. If you see a spectrum that you want extract, just double click on the spot in the 
chromatogram that contains the spectrum you want to extract. 
The spectrum at the wavelength and time you clicked appears in the Spectra pane.   



 

 

View ing Spectra 
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About View ing Spectra 

Now that you’ve opened a chromatogram, you can look at its associated spectra. You can 
use the Main View and Chrom/Spectra View to open, extract, and view spectra from a 
chromatogram. 

In this Help topic we first describe how spectra are collected for viewing.  You will also learn 
how to examine spectra on the various Views as well as learn how to modify the spectrum 
display so that you can more easily compare spectra.   

 

Spectral Formats 

Spectra are stored in three different formats: chromatographic, independent and library 
spectra. 

Chromatographic Spectra - These are the spectra associated with a chromatogram.  
These spectra can be accessed from the chromatogram, when the chromatogram is selected 
on the Data Tree and displayed on the current View.  

To see spectra associated with a chromatogram, simply float your mouse pointer over the 
chromatogram; and the spectrum from that point is temporarily displayed on the Spectra 
pane on the current view.  We recommend you use the Main View, Chrom/Spectra View, 
Contour Map View, or Spectra 3D View to perform this task.     

You can also capture spectra by double clicking your mouse over an area on the 
chromatogram, and the spectrum at the wavelength and time you clicked appears in the 
Spectra pane for the current view.  The spectrum is also added to the Data Tree under the 
chromatogram from which the spectrum was extracted.  

NOTE:   A “captured” spectrum is a spectrum extracted from its source and displayed permanently in 
the Spectra Pane. A captured spectrum can be hidden and/or removed. 

• Individual Spectra -These are the files that result when you select a 
chromatographic spectrum that you have extracted, and then select the spectrum on 
the Data Tree. 

• Library Spectra - You can use the Add Apexes command to automatically create a 
spectral library using the apex spectra from named peaks in a chromatogram.  You 
can also add a previously stored, individual spectrum to a library; to do this you must 
first open this spectrum, and then use the Build Library commands, located under 
the Tools menu.  In addition, spectra extracted from a chromatogram can be added 
to a spectral library by using the Build Library commands, located under the Tools 
menu.  

For more information on set up a library of stored spectra, refer to Spectral Libraries. 
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View ing Chromatographic Spectra 

This Help topic shows you how to capture and display a spectrum from a chromatogram in a 
chromatogram pane, contour map, or 3D plot pane using the Main View.  For more 
information on extracting spectra using the other Views, refer to the individual Help on each 
of the default views. 

NOTE:   A “captured” spectrum is a spectrum extracted from its source and displayed permanently in 
the Spectra Pane. A captured spectrum can be hidden and/or removed. 

How  do I see spectra associated w ith a chromatogram? 

• You can see spectra associated with a chromatogram without capturing the spectra 
permanently in the Spectra pane. If you do not want permanently capture a spectrum from 
a chromatogram, simply float your mouse pointer over the chromatogram, 3D plot or 
contour map, and the spectrum from that point is temporarily displayed on the Spectra 
pane of the current View. 

NOTE:  To preview spectra associated with a particular chromatogram, as well as extract spectra 
from a chromatogram, the pane you are extracting from must be set to a Stacked display, 
and the Spectra pane must be set to an Overlaid display. 

 

How  do I capture a spectrum from a Chromatogram pane?  

To view spectra associated with a particular chromatogram, as well as extract spectra from a 
chromatogram, the Chromatogram pane must use a Stacked display, and the Spectrum 
pane must use an Overlaid display.   

• You can set the display modes for both panes by selecting Stack Chromatograms 
and Overlay Spectra from the View menu. 

To extract spectra: 

1. Click on any area in the white space of the Chromatogram pane. 
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2. Set the selected Chromatogram pane to Stacked mode by clicking on the icon so 

that the icon appears to be pushed down   

3. Float your mouse pointer over a point on the chromatogram to temporarily view, in 
the Spectra pane, the spectrum from that point.  As you continue to float your 
mouse pointer over the chromatogram, the Spectra pane automatically updates, so 
that the spectrum from the current location of your mouse pointer is displayed in the 
appropriate pane. 

4. If you see a spectrum that you want extract, just double click on the spot in the 
chromatogram that contains the spectrum you want to extract. 
The spectrum at the wavelength and time you clicked appears in the Spectra pane.  

How  do I capture a spectrum from a Contour Map? 

To extract and display a spectrum from a point on the Contour Map: 

1. On the Main View, check the chromatogram on the Data Tree that you want 
displayed as a contour map. 

The chromatogram is displayed on the Chromatogram pane, Contour Map pane, and 
3D Plot pane. 

2. Float your mouse pointer over a point on the contour map plot to temporarily view, 
in the Spectra pane, the spectrum from that point.  As you continue to float your 
mouse pointer over the contour map, the Spectra pane automatically updates, so 
that the spectrum from the current location of your mouse pointer is displayed in the 
appropriate pane. 

3. If you see a spectrum that you want extract, just double click on that area in the 
contour map; and the spectrum at the wavelength and time you clicked appears in 
the Spectra pane and is now listed on the Data Tree.   

NOTE:  Unlike the Main View, where extracted spectra are displayed on the Data Tree, when you extract 
a spectrum from the Contour Map View, the spectrum is added to the Data Tree; however, you 
will not see the extracted spectrum on the Data Tree until you exit the Contour Map View.  The 
reason for this is because on the Contour Map View, the Data Tree is used only for selecting the 
chromatogram that you want displayed.  You will be able to see all of the spectra you have 
extracted once you select a different view such as the Main View or the Chrom/Spectra View.       

How  do I capture a spectrum from a 3D Plot? 

To extract and display a spectrum from a point on the Contour Map: 

1. On the MainView, check the chromatogram on the Data Tree that you want 
displayed as the 3D Plot. 

The chromatogram is displayed on the Chromatogram pane, Contour Map pane, and 
3D Plot pane. 

2. Float your mouse pointer over a point on the 3D Plot to temporarily view, in the 
Spectra pane, the spectrum from that point.  As you continue to float your mouse 
pointer over the 3D Plot, the Spectra pane automatically updates, so that the 
spectrum from the current location of your mouse pointer is displayed in the 
appropriate pane. 
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3. If you see a spectrum that you want extract, just double click on that area in the 3D 
Plot; and the spectrum at the wavelength and time you clicked appears in the 
Spectra pane.   

NOTE:  Unlike the Main View, where extracted spectra are displayed on the Data Tree, when you 
extract a spectrum from the Spectra 3D View, the spectrum is added to the Data Tree; 
however, you will not see the extracted spectrum on the Data Tree until you exit the Spectra 
3D View.  The reason for this is because on the Spectra 3D View, the Data Tree is used only 
for selecting the chromatogram that you want displayed.  You will be able to see all of the 
spectra you have extracted once you select a different View such as the Main View or the 
Chrom/Spectra View.       

What Views should I  use to capture spectra? 

Although you can use the Main View to capture spectra from a chromatogram that is 
displayed on a Chromatogram pane, Contour Map, and/or 3D Plot, we recommend you use 
the following Views to capture spectra: 

• If you want to capture spectra from a chromatogram use the Chrom/Spectra View, 
or the Main View. 

• If you want to capture spectra from a point on a contour map, use the Contour Map 
View. 

• If you want to, capture spectra from a point on a 3D plot use the 3D Spectra View. 

NOTE:  Unlike the Main View, where extracted spectra are displayed on the Data Tree, when you 
extract a spectrum from the Contour Map View or 3D Spectra View, you will not see the 
extracted spectrum on the Data Tree until you exit the Contour Map View or 3D Spectra 
View.  The reason for this is because while you are viewing the Contour Map View or 3D 
Spectra View, the Data Tree is used only for selecting the chromatogram that you want 
displayed on the view.  You will be able to see all of the spectra you have extracted once you 
select a different View such as the Main View or the Chrom/Spectra View.      

How  do I use the Range Box to extract spectra? 

NOTE:  The Range command is enabled only on Views, not Operations, when the View contains a 
Chromatogram pane with a single chromatogram displayed.  This command is also available 
from the context menu for a stacked chromatogram. 

This Range command , located on the tool bar, is used to display all the spectra within a 

given time range.  When the Range icon  is selected a green range box is displayed on 
the chromatogram.  To activate the range box, simply position your mouse pointer in the 
range box and click.  

When the range box is activated: 

• Handles are displayed on the left and right edges of the green range box. 

• Positioning your mouse pointer over the left or right handles of the box changes it to 
a horizontal two-headed arrow; and if you click and hold you can stretch the edge of 
the range box.  When you release the mouse, the range box is deactivated. 
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• Positioning your mouse pointer over the left or right edge of the box (except for the 
position of the handles) changes the handles to a four-headed arrow.  When the 
four-headed arrow appears you can move the entire range box by clicking and 
holding.  Upon releasing the mouse the range box is deactivated. 

• Positioning the mouse pointer in the middle of the range box changes it to a four-
headed arrow and click and hold enables the box to be moved. 

• Positioning the mouse pointer within the box and double-clicking loads all the spectra 
enclosed by the box into the Data Tree and sets them as selected.  When you 
release the mouse, the range box is cleared. 

• Clicking on the chromatogram, in an area outside of the box, clears the range box.  
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About the Spectra Pane 

Previously stored, individual spectrums can be opened and viewed on the Main View, 
Chrom/Spectra View, and the Compare View.  Meanwhile, spectra associated with a 
chromatogram are accessed from the chromatogram.  You can view the spectra in a 
chromatogram from the Main View, Chrom/Spectra View, Spectra 3D View, Contour Map 
View, and Compare View.   

 

You can see spectra associated with a 
chromatogram without capturing the spectra 
permanently in the Spectra pane. If you do 
not want permanently capture a spectrum 
from a chromatogram, simply float your 
mouse pointer over the chromatogram, 3D 
plot or contour map, and the spectrum from 
that point is temporarily displayed on the 
Spectra pane of the current View. 

On the various Views referenced above, spectra are displayed on the Spectra pane.  On this 
pane spectra are color coded to match the spectra that are checked on the Data Tree; 
however, if you have extracted spectra on the Spectra 3D View or the Contour Map View, the 
spectra you extracted will appear on the Spectra pane, but they will not be displayed on the 
Data Tree until you select a different view such as the Chrom/Spectra View.   

The Spectra pane can display spectra as either stacked or overlaid, as determined by Stack 
Spectra/Overlay Spectra, which is available from the View menu.  If a stacked display is 
selected, a separate Y scale is shown for each curve.  If an overlaid display is selected, a 
single Y scale is shown, unless the Y values for the selected spectra are too dissimilar in 
which case the Y axis has no labels and the curves are artificially overlaid.  

How  do I work w ith the Spectra Pane? 

• To work with the Spectra pane, you must first select the pane by clicking on the 
white space of the pane.   

The pane appears selected and the border of the pane turns blue. 
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• If a Stacked display is being used on the Chromatogram pane and an Overlaid 
display is being used on the Spectra pane, you can float the cursor over a point on 
the Chromatogram pane and have the associated spectrum displayed.    

• When the mouse pointer is moved close to any edge of the plot region it changes 
into a four headed arrow. 

 
A drag operation when the mouse pointer is in this form, drags the graph around the plot 
region. 

• You can also scale spectra with a large selection of tools.  For more information on 
scaling spectra, see Scaling Spectra. 

Tell me about the context menu that appears when I right click on a 
Spectra Pane. 

When you right click on the Spectra Pane a context menu appears that contains the following 
commands: 

Command Description 

Print Pane… Prints just the current pane.  
  

Baseline Spectra Adds the baseline spectrum for the selected spectrum 
to the Data Tree and displays the baseline spectrum 
on the Spectra pane.   The baseline spectrum is 
identified by the retention time of the spectrum (or if 
a range of spectra are being used, the start and end 
times of the range) followed by the word base. 
  

Stack Spectra/Overlay 
Spectra This command toggles between Stack Spectra and 

Overlay Spectra and determines how the contents of 
the pane are displayed.   

The menu command displays Overlaid Spectra when 
the current display is set to Stacked.  If an overlaid 
display is selected and all plots are plotted on the same 
Y scale a single Y scale is shown.  If each plot is plotted 
with its own Y scale then the Y axis has no labels. 

When Stack Spectra is selected, all spectra are split 
onto separate axes and the menu command changes to 
Overlay Chromatograms.  

Cursor Toggles the cross-hair cursor. 
  

Hide Pane Closes the selected pane forming a custom view. 
  

Format Graphs Displays the Format Graphics dialog at the Spectrum 
tab. Changes made here effect the current graph only. 
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Scaling Spectra 

The default display protocol for spectra displayed is an X/Y autoscale mode that 
automatically scales the display so that every spectrum is completely visible in both the X 
and Y axis directions. If you add a new spectrum with a wider range, the display’s range is 
adjusted to accommodate it. 

In addition you are provided with a number of features that let you modify the spectrum 
display so that you can more easily compare spectra. This section begins with a brief 
description of the scaling commands available to you. 

Options for scaling spectra 

This section describes the available scaling commands used to modify the spectrum display.  
You will find that the information in this section is useful when multiple, overlaid spectra are 
displayed. 

Please note that before you use any of the scaling commands to modify how spectra are 
displayed, you must first select the Spectra pane by clicking on the white space of the pane.  
When the Spectra pane is selected a blue border appears around the pane.  Now that you 
have the Spectra pane selected you can use the scaling commands described below to more 
easily compare spectra.  

Tell me about Autoscaling Spectra. 

The autoscale commands allow you to rescale the data in the Spectra pane so that all of the 
data are visible.  As noted earlier, the autoscale commands are particularly useful when 
multiple, overlaid spectra are displayed. 

There are two commands which you can use to scale spectra to fit the display region: 

• The Autoscale X and Y command  rescales spectra on the current view in both 
the X and Y directions, so that all of the data are visible.  This command is 
particularly useful when multiple overlaid spectra are displayed, because clicking on 
this command rescales the data so that all points for the largest data set, in both the 
X and Y axis directions, fit in the window. 

NOTE:  Most LC solvents absorb strongly in the low UV and so allow very little energy to reach the 
pixels of the array at those wavelengths, making any data suspect. Scaling on the Y-axis is 
always done above the pixel threshold. Thus, if the first valid pixel is 210 nm, the scale will 
be determined by the minimum and maximum absorbance values found in the region (210–
700 nm for the Series 200 DAD). With strong end absorbance, this may mean that the 
spectrum below 210 nm is off-scale. 

• The Autoscale Y Only command  works like the Autoscale X and Y command 
described above, except that it leaves the X axis unchanged and scales only the Y 
axis. 

Tell me about Normalizing Spectra. 

The Normalization commands are useful when multiple, overlaid spectra are displayed and 
you want to find subtle differences between spectra.  Basically, the Normalize commands 



598 . Chromera User’s Guide - Spectral Processing 

 

help you compare the exact shapes of peaks by converting all of the displayed peaks to the 
same maximum height.   

The Normalization commands are as follows: 

NOTE:  If you are trying to scale a single chromatogram or spectrum, only Offset Normalize and 
Normalize Point commands are useful commands.   

• The Normalize X and Y command  is useful when multiple, overlaid spectra 
are displayed.  This command scales the maximum Y value in the active window to 
90% for each spectrum and sets the X axis scale so that the entire largest spectrum 
is displayed. 

• The Normalize Y Only command , works like “Normalize All,” except it rescales 
only the Y axis. 

• The Offset Normalize command  is useful when multiple, overlaid spectra are 
displayed, or when a single spectrum is displayed.  This command scales the data 
point with the maximum Y value to the right of the current cursor position to 90% in 
the region for each spectrum. 

• The Normalize Point command  is useful when multiple, overlaid spectra are 
displayed, or when a single spectrum is displayed.  This command scales the Y value 
at the current cursor point to 90%. The new (90%) scaling is applied to every 
spectrum. 

In addition to the Autoscale and Normalize commands, the following additional options are 
available for scaling spectra: 

• Use the  Box Zoom function to visually specify an area of the display you want to 
zoom into. 

• Use the Format Graphs dialog to scale spectra by specifying the axis range. 

• Zoom in a continuous fashion. 

How do I visually specify an area of the display to zoom into using the Zoom Box 
function? 

It is possible to zoom into a visually defined region of a spectrum using the Box Zoom.  To 
scale individual spectra set the Spectra pane to Stacked mode. 

To zoom into a visually defined region: 

1. Move the mouse cursor inside the plot region and position it at a corner of the area 
you want to zoom. 

2. Hold down the left mouse button and drag the mouse to form a box around the area 
to be zoomed.  

3. Release the mouse button. 
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The region you wish to zoom into will be outlined with a box containing eight control 
points.  The box can be resized by clicking and dragging on any of the control points. 

4. Move the mouse pointer into the zoom region and click the left mouse button. 

NOTE:  You can individually scale the absorbance of each spectrum.  All spectra, however, share the 
same wavelength axis, so zooming into the wavelength range on one spectrum zooms into 
that wavelength range for all spectra.  

5. You can abort the zoom before step 4 by clicking the left mouse button outside the 
zoom box. 

6. To return to a view of the entire trace, select Actions> Autoscale > X and Y. 
OR 

Use the Previous Scale command , which is also located under the Actions 
menu. 

How  do I view  and change the ax is range for spectra? 

1. You can view and change the axis range for spectra by right mouse clicking on a 
spectra pane and selecting Format Graphs from the context menu that appears.   

The Format Graphs window appears with the Spectra tab selected.  This window 
allows you to set the minimum and maximum values on both the X and Y axes.. 

2. From the Spectra tab page specify the Maximum and Minimum values for the X and 
Y axes. 

3. Click OK to apply changes and close the Format Graphs dialog. 

NOTE:  Changes in the wavelength range always affect all the spectra. 

How  do I Zoom in a continuous fashion? 

 

You can zoom spectra in a continuous fashion using the slider zoom feature in conjunction 
with the ZoomX  and ZoomY  icons.  The slider zoom enables you to expand or 
spectra in a continuous manner about the cursor position.  The Zoom X and Zoom Y 
commands determine what is zoomed when you are interacting with the zoom slider. 

To zoom a spectrum: 

1. Click on the Spectra pane that you wish to zoom. 

2. Click on the Zoom X axis icon  and or the Zoom Y axis  icon on the Toolbar to 
set the required zoom mode. 
You can select both the X and Y axis icons to zoom the X and Y axes simultaneously. 
The buttons appear depressed when active. 

3. Push the Toolbar slider to the right or left. 
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Defining How  You are Going to Perform the 
Baseline Correction of the Spectra 

The Spectra Baseline Correction dialog allows you to define how you are going to perform 
the baseline correction of the spectra.  Baseline correction is achieved by subtracting the 
appropriate absorbance baseline spectrum from the absorbance spectrum. 

 

On the Spectral Baseline Correction dialog you can select from three options available to you 
for calculating/selecting the baseline spectrum.  You can correct baseline spectra within a 
chromatogram using the dialog.  Baseline correction is achieved by subtracting the 
appropriate absorbance baseline spectrum from the absorbance spectrum. 

Your options are: 

• Peak Start Only – This option selects the spectrum at the Baseline Start position 
before the current chromatographic peak as the baseline spectrum.  (If all peaks are 
baseline separated, each peak in the chromatogram would have a different baseline 
spectrum.)  This spectrum will be used for baseline correction until the next Baseline 
Start position. 

For spectra before the first start of the first peak in the chromatogram the first baseline 
spectrum will be used for all spectra before the first peak. 

For spectra after the first end of the last peak in the chromatogram the last baseline spectrum 
will be used for all spectra after the last peak. 

• Selected Spectrum – This option uses a spectrum at a point you select on the 
chromatogram, currently displayed on this dialog, as the baseline spectrum.   

When you select this option, a vertical marker is displayed on the graph (at the start 
of the chromatogram).  You then drag the marker to the required position.  The 
baseline spectrum will now be the spectrum from this point. This marker will be re-
displayed whenever Spectrum Type is selected as the Peak Label. 
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• Average of range - This option creates the baseline spectrum by averaging the 
spectra in a range that you select on the chromatogram that is currently displayed 
on the Spectral Baseline Correction dialog.   
When this option is enabled a square is displayed on the graph that you drag to the 
required position and resize to select a range of spectra. 

Removing Spectra 

Removing Spectra from the Data Tree 

 If you want to remove all of the spectra from the Data Tree select File > Remove 
All Spectra. 
All of the spectra are removed from the Data Tree.   

 If you want to remove a spectrum from the Data Tree, right mouse click on the 
spectrum you want to remove and select Close from the context menu that appears. 

Hiding Spectra from Being Displayed 

 If you do not want to display a spectrum on the Main View or Chrom/Spectra View 
you can hide it by unchecking the spectrum on the Data Tree. 
 
 





 

 

View ing the Data 
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About View ing the Data 

You examine chromatograms and spectra from the five default Views: Main View, 
Chrom/Spectra View, Contour Map View, Spectra 3D View, and Compare. By default, the 
Main View is displayed. However, you can select any one of the five default views, which are 
listed on the Views Tree, to display the selected view on the right hand portion of the 
spectral processing window.  The menu bar and tool bars always appear on the window. 

You can also create your own Custom Views by modifying an existing view.  You can modify 
existing views by selecting to hide or show a particular pane.  To hide or show a pane on a 
view, select View > Panes from the menu bar.  The Panes sub menu allows you to select 
whether or not a Chromatogram pane, Spectrum pane, Contour Map pane, or 3D Plot 
pane is displayed on the View.  Once you have modified an existing view you can save it as a 
Custom View by selecting View > View Template > Save As...  from the menu bar.  
Custom Views appear under the Custom node on the Views tree.   

The data that is displayed on a View is controlled by the Data Tree.  From the Data Tree you 
select the chromatogram/s and or spectra that you wish to display.   

This chapter describes the five default views as well as provides you with information on 
creating Custom Views. 

• Main View 

• Chrom/Spectra View 

• Contour Map View 

• Spectra 3D View 

• Custom Views 
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Main View  

Launching Spectral Processing displays the Main View.  This view allows you to look at 
chromatograms and their associated spectra, as well as the contour map and 3D plot for a 
chromatogram.     

NOTE:  You can scale each of the four panes that are displayed on the Main View with a wide 
selection of tools.  For more information on scaling chromatograms, see Scaling 
Chromatograms.  For more information on scaling spectra, see Scaling Spectra.  For more 
information on scaling the Contour Map, see Scaling a Contour Map.  For more information 
on scaling a 3D Plot, see Scaling a 3D Plot Pane 

 

Tell me about the Main View 

The Main view consists of the following areas: 

NOTE:  The area to the right of the Views Tree and Data Tree is referred to as the Main Pane, and in 
the Main View consists of four pane. 

 Views Tree - The Views Tree provides you access to the Main View.  The Main View 
is displayed by default.   

 

 Data Tree - The Data Tree displays a list of currently loaded chromatograms and 
spectra.  You use the Data Tree to select the chromatograms and spectra that you 
want to see in the relevant panes (chromatograms are displayed in the 
Chromatogram pane, Contour Map pane, and 3D Spectra pane, while spectra are 
displayed in the Spectra pane).  Items that appear checked on the Data Tree are 
displayed; while unchecked items on the Data Tree are not displayed.  

NOTE: When you extract spectra from a chromatogram, the extracted spectra are listed on the Data 
Tree under the parent chromatogram.   Meanwhile, previously stored individual spectrum 
files, that you have opened by selecting File > Open > Spectrum… , appear as individual 
branches on the Data Tree.    
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 Chromatogram Pane -  The Chromatogram pane displays the chromatograms that 
are checked on the Data Tree.   

 
When this pane is in Stacked mode, as indicated when the stacked icon appears to 

be pressed down , and the Spectra pane is set to Overlay mode, as indicated 

when the stack/overlay icon appears , you can float your cursor over a point on 
the Chromatogram pane and have the associated spectrum temporarily displayed in 
the Spectrum pane.  You can also extract a spectrum by double clicking on the area 
in the Chromatogram pane that contains the spectrum you wish to extract.  The 
extracted spectrum is added to the Data Tree and displayed in the Spectrum pane.. 

 Spectra Pane - The Spectra pane displays the spectra that are checked on the Data 
Tree.   
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 Contour Map - This pane displays contour maps for all chromatograms that appear 
checked on the Data Tree.  When multiple chromatograms are checked on the Data 
Tree, this pane displays stacked contour maps.  The stacked contour maps appear in 
the same order as the chromatograms displayed on the Chromatogram pane.  

 
You can float your mouse pointer over the Contour Map to temporarily view a single spectrum 
and chromatogram from a point on the Contour Map.  Or, if you want to extract spectra from 
this pane:  click on any area inside the white space of the Spectra pane and set the Spectra 
pane to Overlay mode, as indicated when the stack/overlay icon for the Spectra pane appears 

as follows:  , and then double click on the area in the Contour Map that contains the 
spectrum you want to extract.  
You can also temporarily view a chromatogram from a point on the contour map.  To display a 
chromatogram from a point on a contour map, first make sure the Chromatogram pane is set 
to an Overlaid display.  Then, simply float your mouse pointer over the contour map, and the 
chromatogram from that point is temporarily displayed on the Chromatogram pane in the Main 
View.   
If you want to temporarily capture a chromatogram from the Contour Map, first make sure the 
Chromatogram pane is set to an Overlaid display.  Then, just double click on an area in the 
Contour Map; and the chromatogram at the wavelength and time you clicked appears in the 
Chromatogram pane.   

NOTE:  Chromatograms that are captured from a contour map are only temporary and will be 
cleared when you leave the Main View. 
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 3D Plot Pane - This pane displays a three-dimensional perspective plot for each 
chromatogram that is checked on the Data Tree.  When multiple chromatograms are 
checked on the Data Tree, this pane displays stacked 3D plots .  The stacked plots 
appear in the same order as the chromatograms displayed on the Chromatograms 
pane.   

 

You can float your mouse pointer over the 3D Plot to temporarily view a single 
spectrum and chromatogram from  a point on the 3D Plot.  (NOTE: The 
Chromatogram and Spectra panes must be set to an Overlaid Display)  

If you want to extract spectra from the 3D plot:  click on any area inside the white 
space of the Spectra pane, set the Spectra pane to an Overlaid display, and then 
double click on the area in the 3D plot that contains the spectrum you want to 
extract.   

   
If you want to temporarily capture a chromatogram from the 3D plot, just double click on an 
area in the 3D plot; and the chromatogram at the wavelength and time you clicked appears in 
the Chromatogram pane in the Main View.   

NOTE:  Chromatograms that are captured from a 3D plot are only temporary and will be cleared 
when you leave the Main View. 

 

How do I adjust the pane width and height? 

You can adjust the height and widths of any of these panes to make them smaller or larger. 

To adjust panes: 

1. Place the pointer over the edge of the pane that you want to adjust. 

The pointer turns into a line with arrows on each end . 

2. Press the left mouse button and drag up, down, left or right. The pane is resized 
after you release the mouse button. 
The program maintains these settings until you adjust the panes again. 
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How do I open and display chromatograms? 

 You can open chromatograms by clicking in the check box corresponding to your 
chromatogram in the Data Tree. 
The chromatogram is displayed in the chromatogram pane.  If you do not want the 
chromatogram displayed, uncheck the chromatogram in the Data Tree.    

NOTE:  You can find information on a chromatogram - the number of spectra and how they were 
collected - before it is opened by selecting the Information command in the File menu and 
then selecting the chromatogram you wish to view more information on from the Open 
Chromatogram dialog that appears. 

How do I capture a spectrum from a Chromatogram pane?  

To view spectra associated with a particular chromatogram, as well as extract spectra from a 
chromatogram, the Chromatogram pane must use a Stacked display, and the Spectrum 
pane must use an Overlaid display.   

• You can set the display modes for both panes by selecting Stack Chromatograms 
and Overlay Spectra from the View menu. 

To extract spectra: 

1. Click on any area in the white space of the Chromatogram pane. 

2. Set the selected Chromatogram pane to Stacked mode by clicking on the icon so 

that the icon appears to be pushed down   

3. Float your mouse pointer over a point on the chromatogram to temporarily view, in 
the Spectra pane, the spectrum from that point.  As you continue to float your 
mouse pointer over the chromatogram, the Spectra pane automatically updates, so 
that the spectrum from the current location of your mouse pointer is displayed in the 
appropriate pane. 

4. If you see a spectrum that you want extract, just double click on the spot in the 
chromatogram that contains the spectrum you want to extract. 
The spectrum at the wavelength and time you clicked appears in the Spectra pane.  

How do I capture a spectrum from a Contour Map? 

To extract and display a spectrum from a point on the Contour Map: 

1. On the MainView, check the chromatogram on the Data Tree that you want 
displayed as a contour map. 

The chromatogram is displayed on the Chromatogram pane, Contour Map pane, and 
3D Plot pane. 

2. Float your mouse pointer over a point on the contour map plot to temporarily view, 
in the Spectra pane, the spectrum from that point.  As you continue to float your 
mouse pointer over the contour map, the Spectra pane automatically updates, so 
that the spectrum from the current location of your mouse pointer is displayed in the 
appropriate pane. 
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3. If you see a spectrum that you want extract, just double click on that area in the 
contour map; and the spectrum at the wavelength and time you clicked appears in 
the Spectra pane and is now listed on the Data Tree.   

NOTE:  Unlike the Main View, where extracted spectra are displayed on the Data Tree, when you 
extract a spectrum from the Contour Map View, the spectrum is added to the Data Tree; 
however, you will not see the extracted spectrum on the Data Tree until you exit the Contour 
Map View.  The reason for this is because on the Contour Map View, the Data Tree is used 
only for selecting the chromatogram that you want displayed.  You will be able to see all of 
the spectra you have extracted once you select a different view such as the Main View or the 
Chrom/Spectra View.       

How do I capture a spectrum from a 3D Plot? 

To extract and display a spectrum from a point on the Contour Map: 

1. On the MainView, check the chromatogram on the Data Tree that you want 
displayed as the 3D Plot. 

The chromatogram is displayed on the Chromatogram pane, Contour Map pane, and 
3D Plot pane. 

2. Float your mouse pointer over a point on the 3D Plot to temporarily view, in the 
Spectra pane, the spectrum from that point.  As you continue to float your mouse 
pointer over the 3D Plot, the Spectra pane automatically updates, so that the 
spectrum from the current location of your mouse pointer is displayed in the 
appropriate pane. 

3. If you see a spectrum that you want extract, just double click on that area in the 3D 
Plot; and the spectrum at the wavelength and time you clicked appears in the 
Spectra pane.   

NOTE:  Unlike the Main View, where extracted spectra are displayed on the Data Tree, when you 
extract a spectrum from the Spectra 3D View, the spectrum is added to the Data Tree; 
however, you will not see the extracted spectrum on the Data Tree until you exit the Spectra 
3D View.  The reason for this is because on the Spectra 3D View, the Data Tree is used only 
for selecting the chromatogram that you want displayed.  You will be able to see all of the 
spectra you have extracted once you select a different View such as the Main View or the 
Chrom/Spectra View.       

How do I temporarily capture a chromatogram from a Spectra pane?  

On the Main View, you can temporarily preview and capture chromatograms from a 
spectrum.  However, it is important to note that any chromatograms you capture from the 
Spectra pane are temporary and will be cleared from the display when you select a different 
view.    

To temporarily preview and capture a chromatogram from a spectrum displayed on the 
Spectra pane, the Chromatogrampane must use an Overlaid display, and the 
Spectrumpane must use an Stacked display.   

• You can set the display modes for both panes by selecting Overlay 
Chromatograms and Stack Spectra from the View menu. 

To temporarily capture a chromatogram: 

1. Click on any area in the white space of the Chromatogram pane. 
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2. Set the selected Chromatogram pane to an Overlaid display by selecting 
OverlayChromatograms from the View menu. 

3. Click on any area in the white space of the Spectra pane and set the pane to a 
Stacked display by selecting Stack Spectra from the View menu. 

4. Float your mouse pointer over a point on a displayed spectrum to temporarily view, 
in the Chromatogram pane, the chromatogram from that point.  As you continue to 
float your mouse pointer over the spectrum, the Chromatogram pane automatically 
updates, so that the chromatogram from the current location of your mouse pointer 
is displayed in the appropriate pane. 

5. If you see a chromatogram that you want to temporarily capture, just double click on 
the spot in the spectrum that contains the chromatogram you want to extract. 
The chromatogram at the point you clicked appears in the Chromatogram pane. 

NOTE: Chromatograms that are captured from a Spectra pane are only temporary and will be 
cleared when you select a different view. 

How do I temporarily capture a chromatogram from a Contour Map? 

On the Main View, you can temporarily capture chromatograms from a Contour Map.  
However, it is important to note that any chromatograms you capture from the Contour Map 
pane are temporary and will be cleared from the display when you select a different view.      

To temporarily capture a chromatogram from a Contour Map pane, the Chromatogram 
pane must use an Overlaid display, and the Contour Map pane must use a Stacked 
display.   

To temporarily extract and display a chromatogram from a point on the Contour 
Map: 

1. On the Main View, check the chromatogram on the Data Tree that you want 
displayed as a contour map. 

The chromatogram is displayed on the Chromatogram pane, Contour Map pane, and 
3D Plot pane. 

2. Make sure that the Chromatogram pane is set to an Overlaid display. 

3. Float your mouse pointer over a point on the contour map plot to temporarily view, 
in the Chromatogram pane, the chromatogram from that point.  As you continue to 
float your mouse pointer over the contour map, the Chromatogram pane 
automatically updates, so that the chromatogram from the current location of your 
mouse pointer is displayed in the appropriate pane. 

4. If you see a chromatogram that you want to temporarily capture, just double click on 
that area in the contour map; and the chromatogram from the location you clicked 
appears in the Chromatogram pane. 

NOTE: Chromatograms that are captured from a Contour Map are only temporary and will be 
cleared when you select a different view. 
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How do I temporarily capture a chromatogram from a 3D Plot? 

On the Main View, you can temporarily capture chromatograms from a 3D Plot.  However, it 
is important to note that any chromatograms you capture from the 3D Plot pane are 
temporary and will be cleared from the display when you select a different view.      

To temporarily capture a chromatogram from a 3D Plot pane, the Chromatogrampane 
must use an Overlaid display. 

To temporarily extract and display a chromatogram from a point on the 3D Plot: 

1. On the Main View, check the chromatogram on the Data Tree that you want 
displayed as the 3D Plot. 

The chromatogram is displayed on the Chromatogram pane, Contour Map pane, and 
3D Plot pane. 

2. Make sure that the Chromatogram pane uses an Overlaid display. 

3. Float your mouse pointer over a point on the 3D Plot to temporarily view, in the 
Chromatogram pane, the chromatogram from that point.  As you continue to float 
your mouse pointer over the 3D Plot, the Chromatogram pane automatically updates, 
so that the chromatogram from the current location of your mouse pointer is 
displayed in the appropriate pane. 

4. If you see a chromatogram that you want to temporarily extract, just double click on 
that area in the 3D Plot; and the chromatogram at the at the point you clicked 
appears in the Chromatogram pane.   

NOTE: Chromatograms that are captured from a 3D Plot are only temporary and will be cleared 
when you select a different view. 
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Chrom/ Spectra View  

The Chrom/Spectra View functions similar to the Main View; both views are designed for 
viewing unlimited chromatograms and spectra at one time.  However, unlike the Main View 
page, which shows you chromatograms, spectra, contour maps, and 3D plots, the 
Chrom/Spectra page just shows you the chromatograms and spectra that are checked on the 
Data Tree.  For more information on how to use the Chrom/Spectra View you can refer to 
the Main View Help topic. 
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Contour Map View  

The Contour Map View is intended to help you explore complex chromatographic data. This 
view gives you a wide array of tools for visual investigation of chromatographic and 
spectroscopic features.  

NOTE: Although this page allows you view spectral and chromatographic data during analysis, the 
data cannot be stored for use in other areas of the program.  

More specifically, the Contour Map view allows you to obtain a plot of spectral data that 
resembles a geographical contour map, except that the lines represent equal absorbance 
rather than equal altitude.  The axes for the display are Retention Time and Wavelength.  
The contour levels show the absorbances.  There are 100 colored levels on the Contour Map. 
The color at each level is fixed, starting with blue at the bottom and finishing with white at 
the top. The absorbance range covered can be set using the various scaling commands on 
the view, for more information see the topic titled Scaling a Contour Map. 

 

Tell me about the Contour Map. 

The Contour Map view consists of the following areas: 

 Views Tree - The Views Tree provides you access to the Contour Map View.   

 

 Data Tree - The Data Tree displays a list of opened chromatograms.  From the Data 
Tree you select the required chromatogram for the contour map. Only one 
chromatogram can be selected and displayed on this page at a time.  
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 Contour Map Pane - This pane displays the contour map of a chromatogram that 
is selected on the Data Tree.  The display includes a crosshair cursor which is used 
to select a point on either the retention time axis or the wavelength axis and the 
relevant chromatogram and spectrum will be shown in the corresponding panes 
below.  The contour levels show the absorbances.     

 

 Chromatogram Pane -The Chromatogram pane displays the chromatogram from 
the wavelength axis point selected on the Contour Map pane. 
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To display a chromatogram on this pane, simply float your mouse pointer over the 
Contour Map, and the chromatogram from that point is temporarily displayed on the 
Chromatogram pane.   

If you want to temporarily extract a chromatogram from the Contour Map, just 
double click on an area in the Contour Map; and the chromatogram at the 
wavelength and time you clicked appears in the chromatogram pane.   

NOTE: Chromatograms that are captured from the Contour Map pane are only temporary and will be 
cleared when you leave the Contour Map View.  

 Spectra Pane - This pane displays the spectrum from the point selected on the 
Contour Map.  To display a spectrum on this pane, simply float your mouse pointer 
over the Contour Map, and the spectrum from that point is temporarily displayed on 
the Spectra pane.    

If you want to extract a spectrum from the Contour Map, just double click on an area 
in the Contour Map; and the spectrum at the wavelength and time you clicked 
appears in the Spectra pane.   

NOTE: When you extract a spectrum from the Contour Map View, the spectrum is added to the Data 
Tree; however, you will not see the extracted spectrum listed on the Data Tree until you exit 
the Contour Map View.  The reason for this is because while you are viewing the Contour 
Map View, the Data Tree is used only for selecting the chromatogram that you want 
displayed on the view.  You will be able to see the extracted spectra once you select a 
different view, such as the Main View or the Chrom/Spectra View.         

 

How do I adjust the pane width and height? 

You can adjust the height and widths of any of these panes to make them smaller or larger. 

To adjust panes: 

1. Place the pointer over the edge of the pane that you want to adjust. 

The pointer turns into a line with arrows on each end . 

2. Press the left mouse button and drag up, down, left or right. The pane is resized 
after you release the mouse button. 
The program maintains these settings until you adjust the panes again. 
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How do I view chromatograms and spectra using the Contour Map? 

In this section you will learn how to capture and display spectra and chromatograms from a 
contour map. 

NOTE:  A “captured” spectrum is a spectrum extracted from its source and displayed permanently in 
the Spectra pane and is listed on the Data Tree.  A captured spectrum can be hidden and/or 
removed. 

To extract and display a chromatogram and spectrum from a point on the Contour 
Map: 

1. From the Views tree select ContourMap View. 

The Contour Map View displays. 

2. From the Data Tree, click on the chromatogram you want displayed as the contour 
map. 

3. Float your mouse pointer over a point on the Contour Map plot to temporarily view, 
in their respective panes, the chromatogram and spectrum from that point.  As you 
continue to float your mouse pointer over the Contour Map, the Chromatogram and 
Spectra panes automatically update, so that the chromatogram and spectrum from 
the current location of your mouse pointer are displayed in the appropriate panes. 

4. If you see a chromatogram/spectrum that you want extract, then double click on the 
Contour Map at the wavelength of the chromatogram you want to see. 
The chromatogram and spectrum, at the wavelength and time you clicked, are 
displayed in their respective panes.   
Please note that chromatograms are only temporarily displayed and will be cleared 
when you change the view.  On the other hand, the spectra that are displayed on 
the page are extracted and therefore added to the Data Tree.  However, you won’t 
see the extracted spectra listed on the Data Tree until you select another view, such 
as the Main View or Chrom/Spectra View. 
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Spectra 3D View  

The Spectra 3D View is intended to help you explore complex chromatographic data. This 
view gives you a wide array of tools for visual investigation of chromatographic and 
spectroscopic features. Although it does let you view spectral and chromatographic data 
during analysis, the data cannot be stored for use in other areas of the program.  

When a chromatogram is selected on the Data Tree, and the Spectra 3D View is selected, 
the spectrum and chromatogram positions come from the projection of the mouse cursor 
position down onto the plane of the perspective outline box.  Once you click on the 3D 
display at the point of interest, the cursor position is identified by a cross-hair marker and is 
defined in the information bar at the bottom of the Spectra 3D window on the X (time) axis, 
the Y (absorbance) axis, and the Z (wavelength) axis. 

 

Tell me about the Spectra 3D View. 

The Spectra3D page is comprised of the following areas: 

 ViewsTree - The Views Tree provides you access to the Spectra 3D View. 

  

 Data Tree - The Data Tree displays a list of opened chromatograms.  From the Data 
Tree you select the required chromatogram for 3D plot. Only one chromatogram can 
be selected and displayed on this page at a time.   
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 3D Plot Pane – This pane displays the Spectra 3D View from the chromatogram 
selected on the Data Tree.  The display includes a crosshair cursor which is used to 
select a point on either the retention time axis or the wavelength axis and the 
relevant chromatogram or spectrum will be shown in the corresponding panes below. 

 

 

 Chromatogram Pane - The Chromatogram pane displays the chromatogram from 
the wavelength axis point selected on the 3D Plot pane.  To display a chromatogram 
on this pane, simply float your mouse pointer over the 3D Plot, and the 
chromatogram from that point is temporarily displayed on the Chromatogram pane.   

If you want to temporarily extract a chromatogram from the 3D Plot, just double 
click on an area in the 3D Plot; and the chromatogram at the wavelength and time 
you clicked appears in the Chromatogram pane.   

NOTE: Chromatograms that are displayed on this pane are only temporary and will be cleared when 
you leave the Spectra 3D View. 

 

 Spectra Pane - This pane displays the spectrum from the retention axis point 
selected on the 3D Plot pane.  To display a spectrum on this pane, simply float your 
mouse pointer over the 3D Plot, and the spectrum from that point is temporarily 
displayed on the Spectra pane.    

If you want to extract a spectrum from the 3D Plot, just double click on an area in 
the 3D Plot; and the spectrum at the wavelength and time you clicked appears in the 
Spectra pane.   
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NOTE: When you extract a spectrum from the Spectra 3D View, the spectrum is added to the Data 
Tree; however, you will not see the extracted spectrum listed on the Data Tree until you exit 
the Spectra 3D View.  The reason for this is because while you are viewing the 3D Spectra 
View, the Data Tree is used only for selecting the chromatogram that you want displayed on 
the view.  You will be able to see the extracted spectra once you select a different view such 
as the Main View page or the Chrom/Spectra View.       

• The Add to View command from the context menu will add the Spectrum to the 
Data Tree, or drag-drop of the label can be used 

 

How do I adjust the pane width and height? 

You can adjust the height and widths of any of these panes to make them smaller or larger. 

To adjust panes: 

1. Place the pointer over the edge of the pane that you want to adjust. 

The pointer turns into a line with arrows on each end . 

2. Press the left mouse button and drag up, down, left or right. The pane is resized 
after you release the mouse button. 
The program maintains these settings until you adjust the panes again. 

How do I display and extract a chromatogram and spectrum from the 3D Plot? 

In this section you will learn how to capture and display spectra and chromatograms from 
the 3D Plot on the Spectra 3D View. 

NOTE:  A “captured” spectrum is a spectrum extracted from its source and displayed permanently in 
the Spectra pane and is listed on the Data Tree.  A captured spectrum can be hidden and/or 
removed. 

To extract and display a chromatogram and spectrum from a point on the 3D Plot: 

1. From the Views Tree select Spectra 3D View. 

The 3D Spectra View page displays. 

2. From the Data Tree, click on the chromatogram you want displayed as a 3D plot. 
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3. Float your mouse pointer over a point on the 3D plot to temporarily view, in their 
respective panes, the chromatogram and spectrum from that point.  As you continue 
to float your mouse pointer over the 3D plot, the Chromatogram and Spectra panes 
automatically update, so that the chromatogram and spectrum from the current 
location of your mouse pointer are displayed in the relevant panes. 

NOTE:  The horizontal cursor on the 3D Plot indicates exactly where you are viewing the 
chromatogram. 

4. If you see a chromatogram/spectrum that you want extract, while you are floating 
your mouse pointer over the 3D plot, just double click. 

 

The chromatogram and spectrum at the wavelength and time you clicked are 
displayed in their respective panes.   
Please note that chromatograms are only temporarily displayed and will be cleared 
when you change the view.  On the other hand, the spectra that are displayed on 
the view are extracted and therefore added to the Data Tree.  However, you won’t 
see the extracted spectra listed on the Data Tree until you select another View, such 
as the Main View or Chrom/Spectra View. 

How do I rotate the display? 

You can rotate the 3D Plot around one axis at a time to identify chromatographic or spectral 
characteristics more accurately.  To rotate the 3D plot, you must first select the axis that you 
wish to rotate the 3D plot around; you can then use the Rotation slider to rotate the 3D Plot 
a set number of degrees around the selected axis. 

To rotate the 3D Display: 

1. First select the rotation controls for rotating the 3D plot. 

2. Click on the Rotate X  icon if you want to rotate the 3D plot around the X axis. 

OR 
Click on the Rotate Y  if you want to rotate the 3D plot around the Y axis. 
The selected icon appears to be pressed down to indicate that the 3D plot will be roated 
around the selected axis. 

3. Use the Rotation slider   to rotate the 3D Plot a set number 
of degrees around the axis you selected in step 1.   
Move the slide to the right to rotate the plot to the right, or the “up” direction.   
Move the slide to the left to move the plot in the reverse direction.   

4. Release the slider to return it to the center position.   
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Creating Custom Views 

You can create your own Custom views by modifying an existing view page.  You can modify 
existing views by selecting to hide or show a particular pane.   

 
 To hide or show a pane on a view page select View > Panes from the menu bar.  

The Panes sub menu allows you to select whether or not a Chromatogram pane, 
Spectrum pane, Contour Map pane, or 3D Plot pane is displayed on the View.   

OR 

Right mouse click on the pane you wish to hide, and select Hide Pane from the 
context menu that appears. 

 
 
 Once you have modified an existing view you can save it as a Custom View by 

selecting View > View Template > Save As... from the menu bar.   
The name of the view you saved now appears under the Custom node on the Views 
tree. 



 

 

Scaling Tools 
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Scaling Spectra 

The default display protocol for spectra displayed is an X/Y autoscale mode that 
automatically scales the display so that every spectrum is completely visible in both the X 
and Y axis directions. If you add a new spectrum with a wider range, the display’s range is 
adjusted to accommodate it. 

In addition you are provided with a number of features that let you modify the spectrum 
display so that you can more easily compare spectra. This section begins with a brief 
description of the scaling commands available to you. 

Options for scaling spectra 

This section describes the available scaling commands used to modify the spectrum display.  
You will find that the information in this section is useful when multiple, overlaid spectra are 
displayed. 

Please note that before you use any of the scaling commands to modify how spectra are 
displayed, you must first select the Spectra pane by clicking on the white space of the pane.  
When the Spectra pane is selected a blue border appears around the pane.  Now that you 
have the Spectra pane selected you can use the scaling commands described below to more 
easily compare spectra.  

Tell me about Autoscaling Spectra. 

The autoscale commands allow you to rescale the data in the Spectra pane so that all of the 
data are visible.  As noted earlier, the autoscale commands are particularly useful when 
multiple, overlaid spectra are displayed. 

There are two commands which you can use to scale spectra to fit the display region: 

• The Autoscale X and Y command  rescales spectra on the current view in both 
the X and Y directions, so that all of the data are visible.  This command is 
particularly useful when multiple overlaid spectra are displayed, because clicking on 
this command rescales the data so that all points for the largest data set, in both the 
X and Y axis directions, fit in the window. 

NOTE:  Most LC solvents absorb strongly in the low UV and so allow very little energy to reach the 
pixels of the array at those wavelengths, making any data suspect. Scaling on the Y-axis is 
always done above the pixel threshold. Thus, if the first valid pixel is 210 nm, the scale will 
be determined by the minimum and maximum absorbance values found in the region (210–
700 nm for the Series 200 DAD). With strong end absorbance, this may mean that the 
spectrum below 210 nm is off-scale. 

• The Autoscale Y Only command  works like the Autoscale X and Y command 
described above, except that it leaves the X axis unchanged and scales only the Y 
axis. 

Tell me about Normalizing Spectra. 

The Normalization commands are useful when multiple, overlaid spectra are displayed and 
you want to find subtle differences between spectra.  Basically, the Normalize commands 
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help you compare the exact shapes of peaks by converting all of the displayed peaks to the 
same maximum height.   

The Normalization commands are as follows: 

NOTE:  If you are trying to scale a single chromatogram or spectrum, only OffsetNormalize and 
NormalizePoint commands are useful commands.   

• The Normalize X and Y command  is useful when multiple, overlaid spectra 
are displayed.  This command scales the maximum Y value in the active window to 
90% for each spectrum and sets the X axis scale so that the entire largest spectrum 
is displayed. 

• The NormalizeYOnly command , works like “Normalize All,” except it rescales 
only the Y axis. 

• The OffsetNormalize command  is useful when multiple, overlaid spectra are 
displayed, or when a single spectrum is displayed.  This command scales the data 
point with the maximum Y value to the right of the current cursor position to 90% in 
the region for each spectrum. 

• The NormalizePoint command  is useful when multiple, overlaid spectra are 
displayed, or when a single spectrum is displayed.  This command scales the Y value 
at the current cursor point to 90%. The new (90%) scaling is applied to every 
spectrum. 

In addition to the Autoscale and Normalize commands, the following additional options are 
available for scaling spectra: 

• Use the  Box Zoom function to visually specify an area of the display you want to 
zoom into. 

• Use the Format Graphs dialog to scale spectra by specifying the axis range. 

• Zoom in a continuous fashion. 

How do I visually specify an area of the display to zoom into using the Zoom Box function? 

It is possible to zoom into a visually defined region of a spectrum using the Box Zoom.  To 
scale individual spectra set the Spectra pane to Stacked mode. 

To zoom into a visually defined region: 

1. Move the mouse cursor inside the plot region and position it at a corner of the area 
you want to zoom. 

2. Hold down the left mouse button and drag the mouse to form a box around the area 
to be zoomed.  

3. Release the mouse button. 
The region you wish to zoom into will be outlined with a box containing eight control 
points.  The box can be resized by clicking and dragging on any of the control points. 
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4. Move the mouse pointer into the zoom region and click the left mouse button. 

NOTE:  You can individually scale the absorbance of each spectrum.  All spectra, however, share the 
same wavelength axis, so zooming into the wavelength range on one spectrum zooms into 
that wavelength range for all spectra.  

5. You can abort the zoom before step 4 by clicking the left mouse button outside the 
zoom box. 

6. To return to a view of the entire trace, select Actions> Autoscale > X and Y. 
OR 

Use the Previous Scale command , which is also located under the Actions 
menu. 

How  do I view  and change the ax is range for spectra? 

1. You can view and change the axis range for spectra by right mouse clicking on a 
spectra pane and selecting Format Graphs from the context menu that appears.   

The Format Graphs window appears with the Spectra tab selected.  This window 
allows you to set the minimum and maximum values on both the X and Y axes.. 

2. From the Spectra tab page specify the Maximum and Minimum values for the X and 
Y axes. 

3. Click OK to apply changes and close the Format Graphs dialog. 

NOTE:  Changes in the wavelength range always affect all the spectra. 

How  do I Zoom in a continuous fashion? 

 

You can zoom spectra in a continuous fashion using the slider zoom feature in conjunction 
with the Zoom X  and Zoom Y  icons.  The slider zoom enables you to expand or 
spectra in a continuous manner about the cursor position.  The Zoom X and Zoom Y 
commands determine what is zoomed when you are interacting with the zoom slider. 

 
To zoom a spectrum: 

1. Click on the Spectra pane that you wish to zoom. 

2. Click on the Zoom X axis icon  and or the Zoom Y axis  icon on the Toolbar to 
set the required zoom mode. 
You can select both the X and Y axis icons to zoom the X and Y axes simultaneously. 
The buttons appear depressed when active. 

3. Push the Toolbar slider to the right or left. 
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Scaling Chromatograms 

There are a variety of options to scale a chromatogram.  You can: 

• Visually specify an area of the display to zoom into using the Box Zoom function. 

• Scale chromatograms by specifying the axis range from the Format Graphs dialog. 

• Autoscale only the absorbance axis, to fit the chromatogram between 10% and 
90% of the display, or you can scale both axes to display the full retention time 
range and re-scale the absorbance to fit between 10% and 90% of the display. 

• Zoom in a continuous fashion. 

• Normalize an entire chromatogram using the Normalize X and Y command  
(i.e. all points in the displayed chromatogram), normalize along the Y axis only using 
the Normalize Y command , normalize at the current cursor position using the 
Normalize Point command , or you can normalize to the maximum absorbance 
value to the right of the current cursor position using the Offset Normalize 
command . 

Following is an overview of the scaling options that are available to you when you are 
working with a Chromatogram pane: 

How  do I visually specify an area of the display to zoom into using the Box 
Zoom function? 

To zoom into a visually defined region: 

1. Move the mouse cursor inside the plot region and position it at a corner of the area 
you want to zoom. 

2. Hold down the left mouse button and drag the mouse to form a box around the area 
to be zoomed.  

3. Release the mouse button. 
The region you wish to zoom into will be outlined with a box containing eight control 
points.  The box can be resized by clicking and dragging on any of the control points. 

4.  Move the mouse pointer into the zoom region and click the left mouse button. 
The zoomed area now fills the trace display region.  

5.  You can abort the zoom before step 4 by clicking the left mouse button outside the 
zoom box. 

6. To return to a view of the entire trace, select Actions > Autoscale > X and Y. 

How  do I view  and change the ax is range for a particular chromatogram? 

1. You can view and change the axis range for particular chromatogram by right mouse 
clicking on a chromatogram and selecting Format Graphs from the context menu that 
appears.    
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The Format Graphs window appears with the Chromatogram tab selected.  This 
window allows you to set the minimum and maximum values for the selected 
chromatogram on both the X and Y axes. 

 

2. From the Chromatogram tab page specify the Maximum and Minimum values for 
the X and Y axes. 

3. Click OK to apply changes and close the Format Graphs dialog. 

How  do I use the Autoscale tools? 

The autoscale commands allow you to rescale the data in the chromatogram pane so that all 
of the data are visible.  There are two commands which you can use to scale a 
chromatogram to fit the display region.  Autoscale X and Y  scales the chromatogram to 
between 10% and 90% of the absorbance axis as well as displaying the full retention time 
range of the chromatogram.  Autoscale Y only scales only the absorbance axis without 
changing the retention time range. 

To autoscale the absorbance only:  

1. Click inside the Chromatogram pane that contains the chromatogram/s that you 
want to autoscale in the Y direction. 

2. Select Actions > Autoscale > Y only.  
OR 

Click on the Autoscale Y icon . 

The absorbance axis of the selected chromatogram is scaled to fill 80% of the 
display. 

To autoscale both the retention time and absorbance: 

1. Click inside the Chromatogram pane that contains the chromatogram/s you want to 
autoscale in the X and Y directions. 
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2.  Select Actions > Autoscale > X and Y.   
OR 

Click on the Autoscale X and Y icon . 

The retention time axis of the selected chromatogram is scaled to fill the region.  All 
other chromatograms will be re-scalled to this retention time range.  The absorbance 
axis is scaled to fill 80% of the display.  

How  do I zoom in a continuous fashion? 

You can zoom a chromatogram in a continuous fashion using the slider zoom feature in 
conjunction with the Zoom X  and Zoom Y  icons.  The slider zoom enables you to 
expand or contract the chromatogram in a continuous manner.  The Zoom X and Zoom Y 
commands determine what is zoomed when you are interacting with the zoom slider. 

To continuously zoom a chromatogram: 

1. Before performing the zoom, place the cursor at the position that you want to zoom, 
since the zoom is around the position of the cross-hair cursor.   

2.  Click on the Zoom X axis icon  and or the Zoom Y axis  icon on the tool bar 
to set the required zoom mode. 
You can select both the X and Y axis icons to create an X and Y zoom. 
The buttons appear depressed when active. 

3.   Push the tool bar slider to the right or left. 

How  do I use the use the Normalization commands to scale a 
chromatogram? 

The Normalization commands are useful when multiple, overlaid chromatograms are 
displayed, as these commands are used to find subtle differences in the plot.  Basically, the 
Normalize commands help you compare the exact shapes of peaks by converting all of the 
displayed peaks to the same maximum height.    

NOTE:  For a detailed description of how the Normalization commands can be used, refer to Viewing 
Spectra -  Detailed Description of Normalization commands.   

The Normalization commands are as follows: 

Icon Associated menu 
command 

Description 

 Normalize X and Y Normalizes the graph so all plots are full scale. 

 Normalize Y only Normalizes the graph so all plots are full scale 
without changing the X axis.  

 Offset Normalize Normalizes all plots to the highest point to the right 
of the cursor position. 

 Normalize Point Normalizes all plots at the cursor position.  
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NOTE: The Normalize Y command is useful if you have zoomed in on a specific region of the 
chromatogram and want to normalize without resetting the X axis, since Normalize All 
evaluates all points in the chromatogram, and therefore, resets the X axis. 

To normalize both the retention time and absorbance: 

1. Click anywhere inside the chromatogram pane that contains the chromatogram/s you 
want to scale. 

2. Click on the Normalize X and Y icon . 
OR 
Select Actions > Normalize > X and Y from the menu bar. 
The retention time axis of the selected chromatogram is scaled to fill the region.  All 
other chromatograms will be re-scaled to this retention time range.  The absorbance 
axis is scaled to fill 80% of the display.  

To normalize along the Y axis only: 

1. Click the region below the point where you wish normalization to occur. 

2. Click on the Normalize Y icon .  
OR 
Select Actions > Normalize > Y only from the menu bar. 

The chromatogram will be normalized at the maximum point in the displayed region 
without changing or resetting the X axis value. 

To normalize to the highest point to the right of the cursor: 

1.  Click the region below the point where you wish normalization to occur. 

2.  Click on the Offset Normalize  icon. 
OR 
Select Actions > Normalize > Offset from the menu bar 
The chromatogram is normalized to the maximum point above the cursor position. 

To normalize at the position of the cursor: 

1. Click the region at the point where you wish normalization to occur. 

2.  Click on the Normalize Point icon . 
OR 
Select Actions > Normalize > Point from the menu bar. 
The chromatogram is normalized at the cursor position. 
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Scaling a Contour Map 

The most useful scaling commands for a Contour Map view are the Normalize Point and 
Zero commands. Both commands  adjust the scale based on the current position of the 
cross-hair cursor.  However, you are not limited to using the Normalize Point and Zero 
commands to scale a Contour Map.  In fact, you can scale a Contour Map performing any 
one of the following options: 

• Use the Normalize and Zero commands to set the absorbance range covered by 
the map. 

• Zoom into a visually defined wavelength and/or time region on the contour map 
using the Box Zoom. 

• Use the Autoscale commands to return the map to its default scaling. 

• Scale all three axes on the Contour Map page by specifying Limits on the Format 
Graphs dialog. 

How  do I scale the Contour Map using the Normalize Point and Zero 
commands? 

As stated earlier, probably the two most useful scaling commands on the contour map are 
the Normalize Point and Zero commands in the Tool bar.  

On a Contour Map the Normalize Point command adjusts the scale so that the absorbance 
at the cursor position is represented by the top color in the scale. If the absorbance at the 
cursor position was originally less than the highest absorbance, this has the effect of 
stretching the scale and revealing more detail in the map. 

The Zero command does the opposite action and assigns a specified absorbance to the 
bottom contour.  All data below this level is displayed in the bottom color (blue) and thus is 
hidden. 

By combining the use of the two commands you can set any absorbance range on the map 
to examine specific areas of interest. 

 
To assign an absorbance to the top contour: 

1. Click in the map at the point to be assigned to the top contour. 

2. Click on the Normalize Point  icon. 
All absorbance values equal to or above the absorbance at this point will be assigned 
to the top contour (white).  All absorbance values between the value at the zero 
level and the new top level will be assigned to the remaining fourteen contours.  

To assign an absorbance to the bottom contour: 

1. Click in the map at the point to be assigned to the bottom contour. 

2. Click on the Zero  icon. 



632 . Chromera User’s Guide - Spectral Processing 

 

All absorbance values equal to or below the absorbance at this point will be assigned 
to the bottom contour (black).  All absorbance values between the value at the top 
level and the new bottom level will be assigned to the remaining fourteen contours. 

How  do I use the  Box Zoom on the Contour Map? 

It is possible to zoom into a visually defined wavelength and/or time region on the 
contour map using the box zoom.  
To zoom into a visually defined wavelength and/or time region: 

1. Move the mouse cursor inside the plot region and position it at a corner of the area 
you want to zoom. 

2. Hold down the left mouse button and drag the mouse to form a box around the area 
to be zoomed.  

3. Release the mouse button. 
The region you wish to zoom into will be outlined with a box containing eight control 
points.  The box can be resized by clicking and dragging on any of the control points. 

4. Move the mouse pointer into the zoom region and click the left mouse button. 
The zoomed area now fills the trace display region.  

5. You can abort the zoom before step 4 by clicking the left mouse button outside the 
zoom box. 

6. To return to a view of the entire trace, select Actions > Autoscale > X and Y. 
 

How  do I use the Autoscale tools on the Contour Map? 

Both the Autoscale Y and Autoscale X and Y commands are useful tools in scaling the 
Contour Map. 

 
To autoscale the absorbance without changing the wavelength or time 
axes: 

Use this command to scale the absorbance range after a zoom on the wavelength and/or 
time axis. 

1. Click anywhere on the map. 

2. Click on the Autoscale Y icon .  
The absorbance range is scaled such that the lowest absorbance in the displayed 
data is set to the bottom contour and the top absorbance is set to the top contour. 

To return to the full display of the map: 

Use this command to return to the full display of the map. 

1. Click anywhere on the map. 

2. Click on the Autoscale X and Y icon . 
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The wavelength and time axes are returned to their full range. The absorbance 
range is scaled such that the lowest absorbance in the displayed data is set to the 
bottom contour and the top absorbance is set to the top contour.  

How  do I scale the Time, Absorbance, and Wavelength axes on the 
Contour Map? 

To scale the Time, Absorbance, and Wavelength axes on the Contour Map: 

3. You can scale all three axes on a Contour Map by right mouse clicking on the 
Contour Map, and selecting Format Graphs from the context menu that appears. 

The Format Graphs window appears with the Contour Map tab selected.  From this 
tab page you can scale each of the three regions independently by specifying the 
limits for the Time, Wavelength, and Absorbance axes; and you can preview the 
effect of the values you specify for the axes directly on the screen.  The display 
shows you how the plot will appear.  You can hover your mouse over the controls on 
the tab page to view information about the control. 

4. After you have specified the limits for all 3 axes click OK. 
The Format Graphs dialog closes and the new limits are applied. 
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Scaling a 3D Plot 

Most of the panning and zooming tools that can be used on other panes are not particularly 
useful or do not operation on 3D panes.  Scaling a 3-D Plot view is best done using the 
Format Graphs command, which is located under the Tools menu bar.   From the Format 
Graphs dialog you can scale all three axes:  wavelength, retention time, and absorbance, on 
the plot as well as select to reverse the wavelength axis to "look behind" large peaks.  In 
addition to using the Format Graphs dialog to scale a 3-D plot you can also use the 
Autoscale commands to bring all data into view. 

How  do I specify limits for a 3D plot and reverse the Wavelength Ax is? 

The 3D Plot tab on the Format graphs dialog allows you specify limits for all three axes as 
well as reverse the wavelength axis (Z axis).   

To specify limits for a 3D plot: 

1. On the 3D Plot tab of the Format Graphs dialog specify the minimum and maximum 
values for the X, Y, and Z axes. 

The six spin boxes on this page represent the minimum and maximum values for the 
X, Y, and Z axes.  When you specify values for the three axes on this dialog, you can 
preview the effect directly on the Format Graphs dialog. 

 

 

2. When you are finished setting the numerical limits for the plot click OK. 
The Format Graphs dialog closes and the selected plot is scaled according to the 
limits you specified. 
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How  do I reverse the wavelength ax is of a 3-D Plot? 

To reverse the Wavelength Axis on a 3D plot:  

The 3D Plot tab page on the Format Graphs dialog contains a switch for reversing the 
wavelength axis.  Most UV spectra have very high absorbance in the low UV.  Therefore, the 
3-D plot is normally displayed reversed,, i.e. with the low UV at the back of the display so it 
does not obscure the information in the mid-UV range, 220 - 300 nm.    The switch is useful 
if you want to display the low UV at the front, or if you want to look behind one of the peaks 
in the display. 

1. On the 3D Plot tab page of the Format Graphs dialog click on the Reverse Z Axis 
check box to preview the effect. 

 
The check mark is cleared or returned depending on its previous state.    
When this option appears checked the 3D plot is displayed reversed.  

2. Click OK. 
The Format Graphs dialog closes and the plot is redrawn with wavelength axis 
reversed from its previous state.  

How  do I use the Autoscale commands to scale a 3D Plot? 

The Autoscale X and Y and Autoscale Yonly commands can be used on any plot region 
to bring all the data into view.  Autoscale Y only can be used after a change on the 
wavelength and/or time axis to re-scale the absorbance range only. Autoscale X and Y can 
be used to return to the full display of the plot.  However, since the initial scaling for the 3D-
Plots and Contour Maps is based on the scaling in the previous view the Autoscale commands 
will not necessarily return them to their initial states. 

To autoscale the absorbance without changing the wavelength or time axes: 

Use this command to scale the absorbance range after a change on the wavelength and/or 
time axis. 

1. Click anywhere on the region to be re-scalled. 
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2. Click on the AutoscaleY icon . 
The Absorbance axis is automatically scaled to fill 80% of the display region. 

To return to the full display of the plot: 

Use this command to return to the full display of the plot. 

1. Click anywhere on the region to be re-scaled. 

2. Click on the Autoscale X and Y icon   . 
The wavelength and/or time axis will be returned to their full range. The Absorbance 
axis is automatically scaled to fill 80% of the display region. 



 

 

Spectral Libraries 



638 . Chromera User’s Guide - Spectral Processing 

 

About Spectral Libraries 

You can identify a spectrum by searching one or multiple libraries for a match to an unknown 
spectrum, to build your own libraries of stored spectra, build a library directly from the peak 
apex spectra in a chromatogram, as well as browse through the individual spectra in a 
library, and if necessary, edit that library. 

Note:   When copying spectral libraries used by the Spectral Processing window within Chromera, 
three files need to be copied [Spectral Library].alb, [Spectral Library].idx and [Spectral 
Library].aud.  Unless all three are copied to the new location the library will not work the 
next time it is used. 

This section provides you with information on the following topics: 

• Automatically Creating a Library from Named Peaks 

• Manually Creating a Library 

• Viewing a Library 

• Editing a Library 

• Identifying a Spectrum using the Library Match operation 
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Automatically Creating a Library from Named Peaks 

The Add Apexes command is accessed by selecting Tools > Build Library > Add 
Apexes.  This command allows you to automatically create a spectral library using the apex 
spectra from named peaks in a chromatogram.  This feature is particularly useful when you 
wish to create a library for use with the Spectral Library Confirmation function, since this 
function requires that the names of the peaks in the chromatogram are identical to the 
component names in the library. 

NOTE: If the chromatogram you have selected contains no identified peaks, an error is displayed 
that tells you that you cannot add the apex spectra. 

How  do I create a spectral library using the apex spectra from named 
peaks in a chromatogram? 

1. From the DataTree, select a chromatogram that has named peaks. 

2. Select Tools > Build Library > Add Apexes. 
The New Library dialog appears. 

3. Select location to save the new library and enter a name for the library in the File 
name field. 
  

 

4. Click Save. 
The Create Library dialog appears. 
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5. From the Create Library dialog, use either the default values for the Library 
Minimum and Maximum Wavelengths.  
OR 
If you are working in a different range, enter new Minimum and Maximum 
Wavelength values that cover the range of spectra collected.   
For example, specify a range of 190-400 for UV only data, or specify 400-700 for 
visible only data, or 190-700 for UV and visible data 

6. Click OK to close the Create Library dialog. 

            

7. Click OK to exit the Edit Library dialog. 
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Manually Creating a Library 

The Create Library Command, found under the Tools menu by selecting Tools > Build 
Library > Create, allows you to create new libraries. You may find this function useful for 
creating a library for each general class of compound that you work with. This reduces the 
number of spectra that must be searched when you are trying to match an unknown, (you 
can match an unknown spectra by accessing the Library Match Operation). It also decreases 
the risk of false matches, because the search can be restricted to the most likely class of 
compounds. (If no matches are found, it is always possible to widen the search by adding 
other libraries to the search list.) 

You can also create a spectral library automatically with the apex spectra from named peaks 
in a chromatogram using the Add Apexes command.   

There are three steps involved in creating a new library.  

1. Select Tools > Build Library > Create. 
The New Library Dialog appears and from this dialog you specify a name for the 
library as well as select a location where the library will be saved. 

2. Once you have specified a library name and location where the library will be saved, 
click Save. 
The Create Library dialog appears.  This dialog is used to specify the Library 
Minimum and Maximum Wavelengths.   

3. From the Create Library dialog make sure that the Library Minimum and Maximum 
Wavelengths values cover the range of the spectra collected.   

For example, specify a range of 190-400 for UV only data, or specify 400-700 for visible only 
data, or 190-700 for UV and visible data.   

Once you have specified the Library Minimum and Maximum Wavelengths the Edit Library 
dialog appears.  At this point, the new library has been created, although it does not contain 
spectra.  Spectra may be added to the library at any time.  Therefore, you may exit at this 
point, and add the spectra later, or you may continue and add any displayed spectra that you 
want to include in the library.   

The following procedures describe how to create a new library.   

The following procedure describes how to create a new library.  For information on adding, 
deleting, or replacing spectra in the library as well as how to browse the library once spectra 
have been added, refer to the topic titled Edit Library. 

How  do I create a new  library? 

To create a new library: 

1. From the Tools menu select Build Library > Create. 

The New Library dialog appears. 
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2. From the Save in drop down list select the folder where you wish to save the Library 
you are creating. 

3. Enter a name for the Library in the Filename field. 

4. Click Save. 
The Create Library dialog appears. 

 

5. From the Create Library dialog, use either the default values for the Library 
Minimum and MaximumWavelengths. 
OR  
If you are working in a different range, enter new Minimum and Maximum 
Wavelength values that cover the range of spectra collected.   
For example, specify a range of 190-400 for UV only data, or specify 400-700 for 
visible only data, or 190-700 for UV and visible data. 

6. Click OK to close the Create Library dialog. 
At this point, the new library has been created, although it contains no spectra.  
Spectra may be added to the library at any time.   
Refer to the topic titled Edit Library for information on using the Edit Library dialog. 
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View ing a Library 

The View Library dialog allows you to view information about a selected library, such as the 
compounds in the library and their spectra.    

How  do I access the View  Library dialog? 

To access the view Library dialog: 

1. From the Tools menu select View Library. 

The Open Library dialog appears. 

 

2. Select the Library you wish to view and click Open. 
The View Library dialog appears. 
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Tell me about the View  Library dialog. 

The View Library dialog displays the following information: 

Control Description 

Name  The name of the library file you opened appears here. 

Description A description of the library appears here.   
NOTE: You can specify a description for the library when you 
are editing/creating a library and the Edit Library dialog is 
displayed.  For more information on entering a description for 
the library, see Editing a Library.   

Minimum Wavelength The library's minimum wavelength value appears here. 

Maximum Wavelength The library's maximum wavelength value appears here. 

Spectra List The Spectra List shows all the spectra currently in the Library 
by component name. You can click on a spectrum from this list 
to have the selected spectrum displayed the graph below.  If 
you right mouse click, on a select spectrum and select 
Properties, a dialog appears that displays the source, the 
chromatogram and retention, the baseline, and who added the 
spectrum and when. 

Baseline corrected This check box allows you to select whether or not the spectra 
displayed on this dialog have been baseline corrected. 
NOTE: This checkbox only determines what is displayed on the 
View Library dialog; it does not determine whether or not 
baseline corrected spectra are used in library operations. 

Show Baseline This checkbox allows you to select whether or not the baseline 
spectrum is also displayed on the graph. 
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Editing a Library 

The Edit Library dialog is used to add, replace, or delete spectra; in addition, this dialog can 
be used to browse through the spectra in a library.  The Edit Library dialog automatically 
appears after you have created a new library.  However, this dialog can also be accessed by 
selecting Tools > Build Library > Edit..., and then selecting the library you wish to edit 
from the Library File Selector dialog box.   

Tell me about the Edit Library Dialog. 

Click here to see a screen shot of the Edit Library dialog. 

 

The Edit Library dialog consists of the following controls: 

Control Description 

Name The file name of the library appears here. 

Description You can enter or edit a description for the library in this text box.  The 
description you enter here will help you identify the library later on 
when you are performing Operations that require you to select a list 
of libraries to be searched. 
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Minimum 
Wavelength 

The minimum wavelength of the spectra in the library is displayed 
here. 

Maximum 
Wavelength 

The maximum wavelength of the spectra in the library is displayed 
here. 

Current spectra This list box shows all the spectra currently listed on the Data Tree, 
branched by chromatogram.  

• You can select a spectrum from this list and then use the Add 
command to add the Spectra to a Library.  When you add a 
selected spectrum you are prompted to enter the component 
name of the spectra before it is added to the library. 

OR  
• You can select a spectrum from this list that you wish to use 

to replace a Library component.  To replace a component you 
must first select the component from the Library list box, then 
select the replacement spectrum from the Current Spectra list 
box, and finally click the Replace button. 

Add This command button allows you to add a spectrum that is currently 
selected on the Current Spectra list to the Library. 
When you select a spectrum from the Current Spectra list box and 
click Add, the Add to Library dialog box appears.  From this dialog 
box you enter the component name for the spectrum. 
NOTE: Make sure that you enter the component name correctly, on 
the Add to Library dialog box, before you click OK.  The component 
name cannot be edited once it has been entered into the library. 

Exclude  This command button is enabled when a spectrum, that has not 
already been excluded, is selected from the Library list box.  This 
command permanently excludes a selected spectrum, so it is 
not used for operations.  
When a spectrum is excluded it remains in the Library list box and 
you can still click on the spectrum and view a graph of the selected 
spectrum.  However, when an excluded spectrum is selected the Add, 
Exclude, and Replace command buttons are disabled. 

Replace This command button deletes the spectrum that is selected on the 
Library list box and replaces it with the spectrum that is currently 
selected in the Current Spectra list box. This command is only 
enabled when a spectrum is selected from both lists. 

Library This list box shows all the spectra currently listed in the library, 
alphabetically by component name. You can select a spectrum from 
this list to view a graphical display of the spectrum in the pane 
directly below the Current Spectra and Library list boxes.   

• You can view additional information about a component by 
right mouse clicking on a Library spectrum and selecting 
Properties from the context menu that appears.  A dialog 
appears that shows the source, the chromatogram and 
retention, the baseline, and who added the spectrum and 
when.   

Baseline 
corrected 

This check box allows you to select whether or not the spectra 
displayed on this dialog have been baseline corrected.   

NOTE: This checkbox only determines what is displayed on the Edit 
Library dialog; it does not determine whether or not baseline 
corrected spectra are used in library operations. 

Show Baseline This checkbox allows you to select whether or not the baseline 
spectrum is also displayed on the graph. 



Spectral Libraries.  647 

 

How  do I access the Edit Library dialog? 

To access the Edit Library dialog: 

1. From the Tools menu select Build Library > Edit. 

The Open Library dialog appears. 

 

2. Select the Library you wish to view and click Open. 
The Edit Library dialog appears. 

How  do I add extracted spectra into a library? 

1. From the Edit Library dialog select the spectrum you want to add from the Current 
Spectra list. 

2. Click the Add button. 
The Add to Library dialog box appears and prompts you to enter a Component 
Name. 

 

3. Enter the name of the component carefully.   

NOTE: Make sure that you enter the component name correctly before you click OK.  The 
component name cannot be edited once it has been entered into the library. 
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4. Click OK. 
The dialog closes and you are returned to the Edit Library dialog, from where the 
newly added spectrum is displayed in the Library list.   

How  do I exclude a spectrum in the Library List? 

NOTE:  The exclude command permanently excludes a selected spectrum; you cannot undo this 
action. 

To permanently exclude a library spectrum: 

1. Select the spectrum you wish to exclude from the LibraryList. 

The Exclude button is enabled. 

2. Click Exclude. 
A dialog appears that prompts you to select whether or not you want to permanently 
exclude the selected spectrum. 

3. Click Yes to permanently exclude the spectrum. 
The spectrum still appears in the Library List; however, if you click on the spectrum 
the Add, Exclude, and Replace buttons are disabled, and the Spectrum Display shows 
that the selected spectrum is excluded. 

How  do I replace a spectrum in the Library List w ith one of the Current 
Spectra? 

The Replace command button deletes the spectrum you have selected from the Library list 
box and replaces it with the spectrum you select from the Current spectra list box. 

To replace a Library spectrum with a spectrum listed in the Current Spectra list 
box: 

1. Click on the spectrum in the Library List that you want to delete. 

2. Click on a replacement spectrum in the Current Spectra list. 
The Replace button is enabled. 

3. Click Replace. 
A dialog appears that informs you that the spectrum selected on the Library list box 
will be replaced with the spectrum selected on the Current Spectra list box. 

4. Click Yes. 
The Library List spectrum is replaced with the spectrum selected on the Current 
Spectra list. 
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Library Match 

You use the Library Match operation to match a selected spectrum against the spectra in a 
list of libraries.  The results of this match allow you to identify the sample spectrum.  You can 
access the Library Match Operation by selecting Operations > Library Match from the 
Views tree. 

NOTE: Prior to accessing the Library Match operation, the spectrum you wish to identify must 
already be extracted and displayed on the Data Tree.   

Tell me about the Library Match view . 

The Library Match operation is comprised of the following areas: 

 Views Tree - From the Views tree you select Operations > Library Match to 
access the Library Match operation. 

 

 Data Tree - The Data Tree displays a list of extracted spectra that are grouped by their 
parent chromatogram.  From the Data Tree you select the spectrum you wish to identify. 
When you click on a spectrum listed in this tree, a graphical representation of the 
spectrum appears in the Spectra pane.  The spectrum selected on the Data Tree is 
highlighted in blue.     
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NOTE: Whenever you select a spectrum from the Data Tree, the software automatically runs a 
search, using the parameters specified on this page, and updates the Hits List and Hits Pane. 

 Spectrum Pane - This pane displays the spectrum that you selected from the Data 
Tree. 

 

 Parameters - The Parameters pane is where you set and investigate the various 
parameters (including the list of libraries that will be searched) that control the 
matching process.  Whenever you change a parameter displayed on this page, and 
have a spectrum selected on the Data Tree, the software automatically re-runs a 
search and updates the Hits List and Hits pane. 
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 Hits List - The Hits List contains a list of the spectra from the library(s) that best 
match the sample spectrum, in hit order.  These matching spectra are listed by their 
“hit quality” and name.  The hit quality is displayed as a numeric value; a hit quality 
of 0 indicates a perfect match.   

The spectra that appear checked on this list are displayed in the Hits Pane.  
Therefore, it should also be noted that the first spectrum that is always listed on the 
Hits List is the Sample Spectrum.  You can check the Sample Spectrum, listed here, 
to compare it to matching spectra that are also checked on this list.   

 

 

NOTE:  Spectra that appear checked on this list can be added to the Data Tree by selecting Actions 
> Add All to View . 

 Hits Pane - The Hits pane provides a graphical display of the spectra that are 
checked on the Hits List.  From this pane you can compare the sample spectrum with 
selected Hits; the spectra that appear on this graph are color coded to match the 
Hits List.  
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How  do I identify a spectrum by matching it to a spectral library or 
libraries? 

To match a spectrum to one or multiple libraries: 

NOTE:  Before you perform the Library Match Operation, the spectrum you wish to identify must 
already be extracted from a chromatogram and displayed on the Data Tree. From the Views 
Tree, select Operations> Library Match. 

If you have already selected a spectrum on the Data Tree, and a list of libraries has 
been built, prior to you selecting the Library Match view, then, as soon as the Library 
Match view is displayed, Chromera matches the selected spectrum and displays the 
results on the page.   

OR 
If you have not already selected a list of libraries to search, the Libraries List dialog appears.   

1. From the Libraries List dialog select the libraries you wish to search. 

NOTE: From the Library Match page you can open the Libraries List dialog by clicking on the Library 
list button. 

2. Once you have selected the libraries you wish to search, click OK to close the 
Libraries List dialog and return to the Library Match page. 

3. Select the spectrum in the Data Tree that you want to identify. 
The match is immediately performed and the results are automatically displayed on 
the Hits List.   
The original, selected spectrum appears first in the Hits List.  The subsequent hits 
are displayed in the order of the best match.  Each hit is listed first by its Hit Quality 
value, the numeric value representing how close a match the library spectrum is to 
the currently selected sample spectrum, and then by its library component name. 

NOTE:  The Hit Quality is a measure of the similarity of the sample spectrum and the library 
spectrum.  Lower numbers are better matches; 0 means a perfect match. 
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4. If you want to compare the sample spectrum to specific matches, check the Sample 
Spectrum check box and check any additional spectra listed on the Hits List that 
you want displayed on the Hits Pane. 

NOTE:  At any time you, can select a different spectrum from the Data Tree that you want to 
identify. 

To modify the wavelength range used to perform the Library Match:  

 Enter a new Minimum Wavelength and Maximum Wavelength in the 
corresponding spin boxes. 

To restrict the search to spectra from peaks with similar retention times: 

1. Check the Match retention time check box. 

A % spin box is enabled. 

2. From the % spin box, enter a percentage window for the retention time match. 

 

To examine the effect of using baseline corrected spectra on the Library 
Match: 

 Check the Baseline corrected check box to use baseline corrected spectra for the 
match. 

How  do I add spectra from the Hit List to the Data Tree? 

1. Check the items on the Hits List that you wish to add to the Data Tree. 

2. Select Actions > Add All to View. 
A dialogue box is displayed with the message “The data was added successfully”.  
The selected spectra now appear in the Data Tree and are labelled with the Hit 
Quality and component name. 

How  do I build or modify the list of libraries to be searched? 

NOTE: The list you build is remembered by the system, and will be used on subsequent searches, 
unless you modify the list of selected libraries to be searched. 

1. From the Library Match view click on the Library List... button. 

The Libraries List dialog appears. 

2. Specify the directory path where the libraries you wish to search are located by 
typing the directory path in the Look in text box, or by clicking on the Browse... 
button and selecting a directory path from the Browse for Directory dialog box.   
Once you have specified a directory path, a list of libraries available for selection 
appears on the Libraries list dialog. 

3. From the Available libraries list, click on the libraries you wish to search and then 
click on the Add button. 
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You can either click on a single library to add it to the Libraries list, or you can select 
multiple libraries to add to the Libraries List by using CTRL+click or SHIFT+click. 
The selected libraries now appear in the Libraries List. 

4. To remove a library from the Libraries list click on the library and then click Delete. 
The selected library is removed from the Libraries list and reappears in the Available 
Libraries list. 

5. You can view a description of a library by clicking on the library, from either list.  The 
Description of the selected library appears below the list boxes. 

6. Click OK. 
You are returned to the Library Match view, and the results your search are 
displayed in the Hits pane. 
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How  do I specify search parameters? 

The Parameters Pane on the Library Match page contains the following parameters, which 
you can modify so that the software re-runs the match and updates the Hits List and Hits 
Pane: 

Control Description 

Minimum Wavelength This spin box is where you set the minimum wavelength to be 
used for the match. 

Maximum Wavelength This spin box is where you set the maximum wavelength to be 
used for the match. 

Match retention time 
window 

Check this field to select the retention time of the spectrum as 
one of the search criteria.  When this field is checked a % spin 
box appears from where you specify the search window, as ± 
percent of retention time 

Baseline corrected Check this field so that the sample spectrum and the spectra 
in the libraries being searched are used with baseline 
correction.  If this field is not checked, baseline corrected 
spectra will not be used for the library match. 

NOTE: Checking this option affects the results of the 
operation; however, this option does not change the sample 
spectrum displayed in the top pane.  To baseline correct the 
sample spectrum, displayed in the top pane, select View  > 
Baseline Corrected Spectra. 

Library List Click on this command button to display the Library List dialog 
from where you select the libraries that will be searched. 

 

NOTE: If Match retention time w indow  is checked, the search first creates a list of all spectra in 
the library that fall within the window; it then does a spectrum-by-spectrum comparison. If 
Match retention time window is not checked, the comparison is made with all spectra in the 
library. 
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Spectral Operations 
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Spectral Derivative 

The Spectral Derivative operation allows you to you calculate the first, second, third, or forth 
derivative for a selected spectrum.  You can access this operation from the Views tree by 
selecting Operations > Spectral Derivative.  In order to calculate spectral derivatives you 
must select a spectrum from the Data Tree. 

Tell me about the Spectral Derivative view . 

The Spectral Derivatives view consists of the following areas: 

 Views Tree - This pane provides you access to the Spectral Derivatives view.  

 

 Data Tree - The Data Tree displays a list of extracted spectra that are grouped by 
their parent chromatogram.  From the Data Tree, you select a spectrum for 
calculating spectral derivatives.  Only one spectrum can be selected at a time; and 
the selected spectrum is displayed in the Spectrum Pane.  As different spectra are 
selected the software re-calculates the derivatives and updates the Derivatives 
graph. 
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NOTE:  If you will be performing the Spectral Derivative operation on spectra extracted from a 
chromatogram, the extracted spectra must be displayed on the Data Tree prior to accessing 
the Spectral Derivative view.  

 Spectrum Pane - This pane displays the original sample spectrum that you have 
selected from the Data Tree. 

 

 

 Parameters - The Parameters Pane allows you to set the minimum and maximum 
wavelengths used for calculating spectral derivatives as well as select whether or not 
you wish to use the baseline corrected spectrum for the derivative. 

 

 Display List - You use the Display List to select which spectra you want to see on 
the Derivatives Pane.  Items that appear checked are displayed on the Derivatives 
Pane, while unchecked items are not displayed.   

You can select to display the Sample Spectrum, First Derivative, Second 
Derivative, Third Derivative, and/or the Fourth Derivative.  When you select or 



660 . Chromera User’s Guide - Spectral Processing 

 

deselect any one of the check boxes in the Display list, the Derivatives Pane is 
automatically updated.     

 

 

NOTE:  The check box options from the Display List and the curves on the Derivatives Pane have 
matching color coding. 

 Derivatives Pane - This pane provides a graphical display of the derivative spectra 
that appear checked on the Display List.  It should also be noted that whenever you 
select a new sample spectrum, change the parameters for the calculation, or 
select/deselect an item on the Display List, the Derivatives Pane is automatically 
updated.     

 

How  do I calculate spectral derivatives? 

To calculate spectral derivatives: 

NOTE:  If you want to calculate spectral derivatives on a spectrum extracted from a chromatogram, 
the spectrum must be extracted and displayed on the Data Tree prior to accessing the 
Spectral Derivative operation. 

1. From the Views Tree select Operations > Spectral Derivative. 

The Spectral Derivatives view is displayed. 
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2. Click on a spectrum listed on the Data Tree. 
The selected sample spectrum is displayed in the Spectrum Pane.  The spectral 
derivatives are automatically calculated using the Parameters specified on this page.  
The Derivatives Pane displays the spectral derivatives that appear checked on the 
Display List. 

3. If you want to change the parameters used to calculate spectral derivatives for the 
sample spectrum, you may do so by modifying the following parameters: 

• Select the lower limit of the spectrum range to be included in the calculation from the 
Minimum Wavelength spin box.  
  

• Select the upper limit of the spectrum range to be included in the calculation from the 
Maximum Wavelength spin box.  
  

• Check the Baseline corrected check box to use the baseline corrected spectrum for the 
derivative. 

4. From the Display List, check the spectral derives you wish to be displayed on the 
Derivatives Graph.  You can select to display the Sample spectrum, the First 
Derivative, Second Derivative, Third Derivative, and Fourth Derivative. 
The Derivatives Graph updates to display what is checked on the Display List.  

How  do I add result spectrum to the Data Tree? 

• From the menu bar select Actions > Add All to View to add all the derivative 
spectra that appear checked in the Display List to the Data Tree.  
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Spectral Math 

The Spectral Math operation allows you to perform mathematical operations (add, subtract, 
and divide) on spectra and view the results.  On the Spectral Math view, you select two 
spectrums that you wish to add, subtract, or divide, as well as specify the wavelength range 
of the operation, and the Absorbance Threshold if necessary.  The results of the calculation 
are displayed in the lower portion of this screen, and can be added to the Data Tree using 
the Add to View command. 

Tell me about the Spectral Math view . 

The Spectral Math view consists of the following areas: 

 Views Tree -  This pane provides you access to the Spectral Math operation.  You can 
access the Spectral Math view by selecting Operations > Spectral Math from the 
Views Tree. 

 

 Data Tree:  The Data Tree displays a list of extracted spectra that are grouped by 
their parent chromatogram.  From the Data Tree you select spectra that will be used 
to perform mathematical operations on this page.  You must select two spectra from 
the Data Tree in order to perform operations on this view. 

NOTE: If you will be performing the Spectral Math operation on spectra extracted from a 
chromatogram, the extracted spectra must be displayed on the Data Tree prior to accessing 
the Spectral Math view.    
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NOTE:  The Spectrum Panes remain blank until a spectrum is selected for the pane, and the Result 
pane is blank until both spectrum have been selected.   

 Spectrum A Pane -  This pane displays the spectrum you selected on the Data Tree 
to represent Spectrum A for mathematical operations performed on this page.   

If you do not have a spectrum already selected on the Data Tree, when you first 
access the Spectral Math page, the Spectrum A Pane appears blank.  To display a 
spectrum in this pane, you must click on the Spectrum A Pane, and then select a 
spectrum that is listed on the Data Tree.   
On the other hand, if a spectrum is already selected on the Data Tree, before you 
access this page, the selected spectrum is automatically displayed in this pane.  If 
the spectrum currently displayed on this pane is not the spectrum you wish to use 
for the operation, simply click on an area inside the white space of the pane, and 
then select a different spectrum from the Data Tree.  The new spectrum is now 
displayed on the Spectrum A Pane. 

 

 Spectrum B Pane - This pane displays the spectrum you selected on the Data Tree 
to represent Spectrum B for mathematical operations performed on this page. 
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When you first access the Spectral Math page this pane appears blank.  To add a 
spectrum to this pane you must first click on an area inside the whites pace of the 
pane, and then click on a spectrum listed on the Data Tree.  The selected spectrum 
now appears on this pane. 

 

 

 Display List - You use the Display List to select the information you want displayed 
on the Results Pane.  When items appear checked on this list, they are displayed in 
the Results Pane.  Meanwhile, unchecked items are not displayed. 

 

 Parameters Pane -  The Parameters pane displays the wavelength range for the 
calculation, whether or not baseline corrected spectra are used for the spectral math, 
as well as the Threshold controls. You can modify these parameters and the Results 
pane automatically updates.  
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More specifically, the Parameters Pane allows you to specify the following parameters: 

• Minimum Wavelength -  Sets the lower limit of the spectrum range to be included in a 
calculation. 

• Maximum Wavelength - Lets you set the upper limit of the spectrum range to be 
included in the calculation.  

• Baseline Corrected -  Check this option to use baseline corrected spectra for the 
spectral math. 

  NOTE: Checking this option affects the results of the operation; however, this option does not 
change the sample spectrum displayed in the top pane.  To baseline correct the sample 
spectrum, displayed in the top pane, select View  > Baseline Corrected Spectra. 

• Auto A -  Select this option to automatically calculate the minimum absorbance value that 
can be used in the calculation for Spectrum A.  If the value at a specific wavelength falls 
below this threshold, the calculated result for that wavelength will be set to 0. 

• Auto B - Select this option to automatically calculate the minimum absorbance value that 
can be used in the calculation for Spectrum B. 

• Manual A - Select this option to manually set the minimum absorbance value for 
Spectrum A. 

• Manual B - Select this option to manually set the minimum absorbance value for 
Spectrum B. 

Calculation Parameters - This area is where you define the mathematical operation to be 
performed (add, subtract, or divide) as well as specify multiplication factors for Spectrum A 
and B, and whether or not you wish to switch Spectrum A and B and their multiplication 
factors, in the function. 
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 Result Pane  -  This pane displays a graphical representation of the items that are 
checked on the Display List.  You can view Spectrum A, Spectrum B, and the Result 
Spectrum on this pane. 

 
 

How  do I select spectra for performing mathematical operations? 

You must have two spectrums selected in order to perform mathematical operations on 
spectra.  Once you select two spectrum the software automatically calculates and displays 
the result of the mathematical operation that is currently defined on this page.  You can 
modify any of the parameters on this page to recalculate and display a different result. 

To select spectra: 

1. From the Spectral Math page click on the top Spectrum Pane, this is the spectrum 
pane that represents Spectrum A for any mathematical operations you perform on 
this page. 

A blue border appears around the pane to indicate that the pane is selected. 
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2. From the Data Tree click on the spectrum that you wish to use as Spectrum A for 
performing mathematical operations. 
The selected spectrum appears in the top Spectrum pane and will be considered 
Spectrum A in the mathematical operations you perform on this page. 

   
You must now select a second spectrum to be used in the calculation, this spectrum 
will be considered Spectrum B in the mathematical operations you perform on this 
page. 

3. To select the second spectrum click on the lower Spectrum pane (Spectrum B), this 
pane is below the Spectrum A pane. 
A blue border appears around the pane to indicate that the pane is selected. 

4. From the Data Tree click on the spectrum that you wish to use as Spectrum B for 
performing mathematical operations on this page. 
The selected spectrum appears in the Spectrum B pane; and the program 
automatically calculates and displays the result of the currently defined mathematical 
operation, using the two selected spectrum and the parameters defined on this page.  
The results of the currently defined operation are displayed on the Result Pane of 
this page.   
You can change any of the parameters used in the calculation, as well as modify the 
calculation you wish to perform; and Chromera will automatically recalculate the 
result and display it in the Result Pane. 

How  do I perform mathematical operations on spectra? 

The summary below illustrates how to use the Spectral Math page to perform 
mathematical operations on any two spectra that are listed on the Data Tree.  Please 
note that if you are working with spectra extracted from chromatograms, the two 
spectra must be present in the Data Tree before you access the Spectral Math page.  
Once you have selected the two spectra for the operation, Chromera automatically 
calculates and displays the result of the operation using the parameters currently 
displayed on the page.  You can modify any of the parameters on this page and the 
new result is automatically displayed. 

To select spectra: 

1. If you are working with spectra extracted from chromatograms, the two spectra 
must be present in the Data Tree prior to displaying the Spectral Math view.     

2. From the Views tree, expand the Operations node and click on Spectral Math. 
The Spectral Math view displays. 

3. From the Spectral Math view, click anywhere inside the white space of the top 
Spectrum pane, this is the spectrum pane that represents Spectrum A for any 
mathematical operations you perform on this view. 
A blue border appears around the pane to indicate that the pane is selected. 

4. From the Data Tree, click on the spectrum that you wish to use as Spectrum A for 
performing mathematical operations. 
The selected spectrum appears in the top Spectrum pane and will be considered 
Spectrum A in the mathematical operations you perform on this view.   
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You must now select a second spectrum to be used in the calculation, this spectrum will 
be considered Spectrum B in the mathematical operations you perform on this page. 

5. To select the second spectrum click anywhere inside the white space of the lower 
Spectrum pane (Spectrum B), this pane is below the Spectrum A pane. 
A blue border appears around the pane to indicate that the pane is selected. 

6. From the Data Tree click on the spectrum that you wish to use as Spectrum B for 
performing mathematical operations on this page. 
The selected spectrum appears in the Spectrum B pane; and Chromera automatically 
calculates and displays the result of the currently defined mathematical operation, 
using the two selected spectra and the parameters currently displayed on this page.     

NOTE: You can change any of the parameters used in the calculation, as well as modify the 
calculation you wish to perform; and Chromera will automatically recalculate the result and 
display it in the Results Pane. 

To perform a mathematical operation on two spectra using a different set 
of parameters: 

Once you have selected Spectrum A and Spectrum B, Chromera automatically performs the 
calculation, using the current parameter values displayed on your screen.  You can then 
modify any of the parameters displayed on the page; for example, you can specify new 
multiplication factors for Spectrum A and B, or select a different mathematical operation to 
perform, and with each parameter you modify, the results are automatically recalculated and 
displayed on the page.     

To select new multiplication factors for Spectrum A and B: 

1. Select a multiplication factor for Spectrum A using the spin box next to A* 

. 

2. Select a multiplication factor for Spectrum B using the spin box next to B* 

. 

To select a different operator: 

 From the drop down list, located between A* and B* select an operator  
for the calculation. 
You can select to add spectra, subtract spectra, or divide spectra. 

To reverse the order of a Division or Subtraction operation: 

 Check the Reverse Equation check box to switch Spectrum A and B and their 
multiplication factors in the function.  For example, a function that read A*1-B*2, 
becomes B*2-A*1 when Reverse equation is checked.  This option is only enabled 
when the operator is / or -. 

How  do I add the Result Spectrum to the Data Tree? 

• From the menu bar select Actions > Add all to View. 
The Result Spectrum is added to the Data Tree. 



 

 

 

Chromatogram Operations 



670 . Chromera User’s Guide - Spectral Processing 

 

Performing Operations on Chromatograms 

There are a number of built-in functions that allow you to obtain important information about 
your chromatograms.  These functions include Peak Purity (which checks the homogeneity of 
each peak in the chromatogram), Peak Library Search (which identifies each peak in the 
chromatogram by comparing its spectrum to a spectral library), and Spectral Standard 
Confirmation (which confirms the identity of each peak in the chromatogram by comparing 
its spectrum to the spectrum from the same named peak in a reference chromatogram).  

This section shows you how to perform operations, such as Peak Purity, and Peak Library 
Search to investigate a chromatogram.   

More specifically, you will learn how to: 

• Use the Peak Purity operation to check the purity of chromatographic peaks. 

• Use the Absorbance Ratio operation to calculate the Absorbance Ratio of 
chromatographic peaks. 

• Use the Wavelength Maximum operation to determine the Wavelength Maximum of 
chromatographic peaks. 

• Use the Spectral Library Confirmation operation to verify the identity of 
chromatographic peaks by comparing to a spectral library. 

• Use the Peak Library Search operation to identify chromatographic peaks. 

• Use the Preview Chromatograms operation to output new channel definitions that 
will be added to the controlling method. 

• Use the Apex Optimized Chromatogram operation to create a chromatogram with the 
optimum wavelength set for each peak 

• Save the results of the operations you performed on a chromatogram, so that the 
corresponding file is updated with this information and the corresponding spectral 
method files are updated with the parameter values used to calculate the results. 
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Peak Purity 

The purity of a chromatographic peak can be checked by comparing the spectra on the 
upslope and down slope of the peak.  If the two spectra are not the same, then two or more 
components with different spectra must be present in the peak envelope.  Use the Peak 
Purity operation to calculate the peak purity for all peaks in a specific chromatogram. 

 To access the Peak Purity operation, expand the Operations node on the Views 
tree and select Peak Purity. 

Calculating the Purity of a Chromatographic Peak 

In order to perform the Peak Purity operation, you must first select a chromatogram from the 
Data Tree. The selected chromatogram is displayed on the page in the upper graph 
(Chromatogram pane) and each peak in the chromatogram is annotated with a Purity Index  
and a pass fail rating. The purity indices and corresponding pass fail ratings are calculated 
according to the wavelength range, pass threshold, data point threshold, and absorbance 
threshold values that are currently displayed on the page.  You can modify any of these 
parameters; and the software automatically recalculates and displays the new purity indices 
for each peak in the chromatogram.   

The Purity Index is calculated by dividing the peak upslope and down-slope spectra at each 
wavelength; and then dividing the maximum value in the resulting plot by the minimum 
value.  If the two spectra were identical then the division of the two spectra would result in a 
straight line and dividing the maximum value by the minimum value in this plot would give a 
value of 1.00.  A Peak Index of 1.00 would therefore mean that the upslope and downslope 
spectra matched exactly and thus the peak was spectrally homogeneous, most likely 
consisting of a single component.  A value above 1.00 implies that the two spectra are 
different.  Because of noise and other variables a peak with a value of 1.00 to 1.50 is usually 
considered pure. 

If you are interested in seeing how the peak purity was evaluated for a specific peak, simply 
click on that peak.  The Results pane, located beneath the chromatogram display, provides 
you with a graphical representation of the  upslope, down slope, and baseline spectra for the 
selected peak, as well as a graphical representation of the purity difference, which is a plot 
resulting from the division of the upslope and down slope spectra.  For more information on 
how the software calculates Peak Purity, refer to Calculation Algorithms. 

NOTE: Use the Display List to specify what is displayed on the Results pane.  Items that appear 
checked on the Display List are plotted on the Results pane. 

Tell me about the Peak Purity operation. 

The Peak Purity operation consists of the following areas: 

 Views Tree - The Views Tree provides you access to the Peak Purity operation. 
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 Data Tree - The Data Tree displays a list of currently loaded chromatograms.  You use 
the Data Tree to select the chromatograms that you want to use in the operation.  The 
chromatogram you select from the Data Tree is displayed in the upper pane 
(Chromatogram pane) for this operation. 

 

 Chromatogram Pane - This pane displays the chromatogram that you selected 
from the Data Tree.   

Each peak on the displayed chromatogram is labelled with its purity index and an 
associated Pass/Fail Rating.  If the purity index for a peak exceeds the Purity Limit 
value currently displayed on the Parameters pane, then the peak is considered 
impure and an F appears next to the purity value.  If the purity index for a peak is 
less than or equal to the Purity Limit currently defined on the Parameters pane, then 
the peak is considered pure and a P is displayed next to the purity value.   

NOTE:  A purity index of 1.00 means that a peak is homogeneous, most likely consisting of a single 
component.  A high value means that the upslope and downslope spectra are quite different, 
and the peak is highly impure.  Typically, a peak with a purity value of 1.00 to 1.50 is 
considered pure.  Chromera uses an initial default value of 1.5 for the Purity Limit; however, 
you can specify a different maximum value at which the upslope and downslope spectra are 
considered to match, using the Purity Limit parameter that is displayed on this view. 
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 Parameters Pane - This pane is where you set and investigate the various parameters 
used to calculate Peak Purity.  Whenever you change a parameter displayed on this 
operation, and have a chromatogram selected on the Data Tree, the Display List and 
Results pane are automatically updated with the modified results. 

 

 Display List - You use the Display List to select the information you want displayed 
on the Results pane (including the spectra used in the calculation of the purity and 
the purity result).  Items that appear checked are displayed on the Results pane, 
while unchecked items are not displayed.   

The following items are available for selection on the Display List: 
Upslope spectrum - Check Upslope spectrum to display the upslope spectrum from the 
current peak.   

NOTE:  You can define at what position of the peak height the upslope and downslope spectra are 
obtained. The position is defined on the Parameters pane as a percentage of the 
chromatographic peak height.  The lower the percentage value that is entered for the Use at 
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% of Peak Height parameter, the closer to the baseline are the spectra taken.  When looking 
for possible impurities, spectral differences will be increased as you move further out on the 
peak, I.e. closer to the baseline, but the signal-to-nosie will decrease and therefore increase 
the risk of false positives. 

• Downslope spectrum – Check Downslope spectrum to display the downslope 
spectrum from the current peak. 

• Baseline - Check Baseline to display the baseline spectrum from the current peak.  
• Purity Result - Check Purity Result to display the plot resulting from the division of the 

upslope and down slope spectra at each wavelength.   

 

 Results Pane - This pane displays a graphical representation of the items that are 
checked on the Display List.  In addition, in the right hand corner of this pane, the 
Purity Index for currently selected peak is displayed.  If the peak’s purity value 
exceeds the Purity Limit currently defined on the Parameters pane, then the Purity 
Index is shown in red.  If the peak’s purity value is less than or equal to the currently 
defined Purity Limit, then the Purity Index is shown in blue.  
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NOTE:  Whenever you select a different peak, change the parameters for the operation, or 
select/deselect an item on the Display List, the Result pane is automatically updated to 
reflect the change.  

How  do I modify the parameters that are used to calculate Peak Purity? 

Peak Purity Parameters 

The Parameters pane is where you set and investigate the various parameters for calculating 
Peak Purity.  At any time you can optimize/adjust the parameters that are listed on the Peak 
Purity operation; and the Peak Purity value labels are updated for every peak in the 
chromatogram. 

Below is a list of the Peak Purity parameters you can modify: 

Parameter Description 

Minimum Wavelength This parameter allows you to set the lower limit of the 
spectrum range to be included in calculation.   
  

Maximum Wavelength This parameter allows you to set the upper limit of the 
spectrum range to be included in the calculation.  
  

Minimum Data Points The absorbance threshold value will eliminate certain data 
points from the calculation of the result. If too many data 
points are eliminated, the result becomes questionable. 
Therefore, the Minimum Data Points parameter is used to set 
the minimum number of data points that must be present for 
a valid result.  The default value is twenty.  If the number of 
data points falls below this number, the result is reported as 0 
and the test is considered as a fail. 
  

Baseline Correct Spectra Check this box use baseline corrected spectra in the 
calculation. 
  

Purity Limit This parameter allows you to set the maximum value at which 
the two spectra are considered to match.  If the two spectra 
match exactly then the value will be 1.  To allow for noise and 
other errors in the system, this value is normally set at 1.5.  
You can reduce or increase this value to fit your own criteria.   
Values that exceed this number are labeled in red on the 
Results pane. 
  



676 . Chromera User’s Guide - Spectral Processing 

 

Use at % of Peak Height This parameter allows you to change the position from where 
the upslope and downslope spectra are extracted.  The 
position is defined as a percentage of the chromatographic 
peak height – the lower the percentage, the closer to the 
baseline are the spectra taken.   
This parameter is useful if you are looking for possible 
impurities.  When you specify a lower percentage value and 
thereby move further out on the peak, i.e. closer to the 
baseline, you will notice that spectral differences are 
increased.  However, it should be noted that by setting a lower 
percentage value for this parameter, the signal-to-noise will 
decrease, thereby increasing the risk of false positives.      

Absorbance Threshold 
The result of dividing two noisy small numbers can be very 
unstable; therefore, you can use the Threshold controls to set 
the minimum absorbance values above the system noise and 
therefore obtain a more reproducible result.     
When Auto is selected, the absorbance threshold values are 
calculated automatically by the system and are set to either 
0.0005 A.U. or 2% of the maximum absorbance in the 
spectrum, whichever is greater. The entry field is grayed when 
Auto is selected. 
When Manual is selected, enter the required value in the entry 
field, by either typing directly or using the spin buttons.  When 
Manual is first selected the minimum absorbance value 
calculated by the Auto function is displayed in the Manual 
threshold field. 
  

Summary of Operation:  Peak Purity 

The summary below illustrates how to calculate the purity of peaks in a chromatogram, and 
then save the new results and parameters used in the calculation.     

How  do I review  and recalculate Peak Purity values for the peaks in a 
chromatogram? 

1. From the Views Tree expand the Operations node and click on Peak Purity. 

The Peak Purity operation displays. 

2. Select a chromatogram from the Data Tree. 
The selected chromatogram is displayed.  The first peak is selected.  
The Results pane, located directly below the chromatogram, shows, for the selected 
peak, its Purity Index, its upslope and downslope spectra, the plot resulting from the 
division of the upslope and downslope spectra at each wavelength, and optionally its 
baseline spectrum.  

How  do I view  the Peak Purity value for a different peak?  

 Select the required peak by clicking on it in the chromatogram.  
The Results pane is updated to show the Purity Index, the upslope and downslope 
spectra for the current peak, and the baseline spectrum for the selected peak.  The 
Purity Result for the current peak is also displayed (The Purity Result is the plot 
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resulting from the division of the upslope and downslope spectra at each 
wavelength). 

How  do I examine the Purity Values at different wavelengths? 

 Enter a new value for the Minimum Wavelength and/or Maximum Wavelength. 
The Peak Purity value labels are updated for every peak in the chromatogram. 

How  do I examine the effect of using baseline corrected spectra on the 
Peak Purity values? 

 Check Baseline Correct Spectra. 
The Peak Purity value labels are updated for every peak in the chromatogram. 

How  do I change the minimum absorbance value that is used in the 
calculation of the Peak Purity values and set the Minimum Data Points? 

The Peak Purity operation is very sensitive, and two spectra are rarely absolutely identical. 
We have found in practice that a value between 1.00 and 1.50 will usually indicate that the 
spectra are the same and that the peak is pure.  However, two practical factors have to be 
considered when actually performing the Peak Purity operation. The first is that a result of 
dividing two noisy numbers close to zero is very unstable and could easily affect the 
minimum or maximum value in the final calculation. To avoid such errors, you can set an 
absorbance threshold above the system noise.  Absorbances in the spectra that fall below 
this threshold are not used in the calculation.  

The second factor results from the threshold just described. Clearly, the threshold removes 
some data points from the calculation. It is possible for low- absorbance spectra, especially if 
the minimum and maximum wavelength has to be set to a narrow range, to have insufficient 
points for a valid calculation to be performed. A second threshold, labeled Minimum Data 
Points, is therefore applied, which determines if the calculation can be performed. This 
value defaults to 20, but it can be changed.  

1. Select the Manual radio button. 

The Manual spin box is enabled 

2. Use the spin box to specify a new minimum absorbance value. 
The Peak Purity value labels are updated for every peak in the chromatogram. 

How  do I return to automatically calculating the minimum absorbance 
value? 

 Select the Auto radio button if you wish to have IRIS automatically calculate the 
minimum absorbance value that can be used in the calculation. 
The Peak Purity value labels are updated for every peak in the chromatogram. 

 

How  do I add the displayed spectra in the results pane to the Data Tree? 

 Select Actions > Add All to View. 
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A dialogue box is be displayed with the message “The data was added successfully”.  
On re-displaying the Main or Chrom/Spectra views the added spectra will appear in 
the Data Tree. 

How  do I save the results and parameters used in the calculation? 

Once you are satisfied with the purity results, you can save the updated purity values and the 
parameters used in the calculation, by selecting File > Save Results in the main Chromera 
application.  Once you have saved the updated purity values, they can be included in a report.   

1. In the main Chromera application, select File > Save Results 

A save dialog appears that asks you to confirm whether or not you want to save the 
new values. 
 
Or 
If you select another item in the Spectral Processing Window the following dialog 
appears: 

 

2. Click Yes to save the results and calculation parameters.  
The saved results can now be displayed as peak labels when the chromatogram is 
displayed in the Main View or Chrom/Spectra  
View.  In addition, when you select this chromatogram again on the Peak Purity 
page, the saved results and the parameters used are displayed on the page. 

How  do I display the Peak Purity results in the Main View  or 
Chrom/ Spectra View? 

1. Select Actions > Label Chromatograms...  

2. Select Purity from the list of available Label Types. 

How  do I review  for any chromatogram previously calculated Peak Purity 
values and the parameters used? 

 Select this chromatogram again on the Peak Purity operation. 
The saved results and the calculation parameters are automatically displayed. 
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Absorbance Ratio 

The Absorbance Ratio of a compound is defined as the ratio of the absorbance at two 
specified wavelengths in its peak apex spectrum.  This value is constant for any given 
component, and its value can therefore be used to confirm identification and purity.  

You use the Absorbance Ratio operation to optimize/adjust the absorbance ratio for each 
peak in an open and visually selected chromatogram.   

 To access this operation, expand the Operations node on the Views tree and 
select Absorbance Ratio. 

About the Absorbance Ratio Operation 

In order to use this page you must first select a chromatogram that is listed on the Data 
Tree. The selected chromatogram is displayed on the page in the upper graph 
(Chromatogram pane) and each peak in the chromatogram is labeled with the Absorbance 
Ratio value.  As noted in the previous section, the Absorbance Ratio of a compound is 
defined as the ratio of the absorbance at two specified wavelengths in its peak apex 
spectrum.  The value is independent of concentration, characteristic for the compound but 
not necessarily unique. 

Chromera calculates the absorbance ratio values using the parameters that are currently 
displayed on the page.  At any time you can recalculate the absorbance ratio values by 
modifying the two wavelength values used in the calculation, specifying a different 
absorbance threshold, as well as by selecting whether or not baseline corrected spectra are 
used in the calculation.  Chromera automatically updates the Absorbance Ratio page to 
display the recalculated results.   

If you are interested in the absorbance ratio for a specific peak, click on the peak; and, in the 
bottom graph (Results pane), the apex and baseline spectra are displayed for the peak as 
well as the Absorbance Ratio value.  The apex spectra are annotated with the positions of 
the two wavelengths used and the absorbances at each wavelength.   

NOTE: Use the Display List to determine what is displayed on the Results Pane.  Items that appear 
checked on the Display List are plotted on the Results Pane. 

Tell me about this window 

The Absorbance Ratio page consists of the following areas: 

 Views Tree - The Views Tree provides you access to the Absorbance Ratio 
operation.   You can access this operation by selecting Operations >Absorbance 
Ratio from the Views Tree. 
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 Data Tree - The Data Tree displays a list of currently loaded chromatograms.  You 
use the Data Tree to select the chromatograms that you want to use in the 
operation.  The chromatogram you select from the Data Tree will is displayed in the 
upper pane (Chromatogram pane) for the Operation. 

 

 Chromatogram Pane - This pane displays the chromatogram that you selected 
from the Data Tree. 



Chromatogram Operations.  681 

 

 

 Parameters Pane - This pane is where you set and investigate the various 
parameters used to calculate the Absorbance Ratio values.  Whenever you change a 
parameter displayed on this operation, and have a chromatogram selected on the 
Data Tree, the Display List and Results pane are automatically updated with the 
modified results. 

 

 Display List - You use the Display List to select the information you want displayed 
on the Results Pane. When items appear checked on this list, they are displayed in 
the Results Pane.  Meanwhile, unchecked items are not displayed. 

The following items are available for selection on the Display List: 
• Apex - Check this option to display the apex spectrum from the currently selected 

peak on the Results pane. 
• Baseline - Check this option to display baseline spectrum associated with the 

currently selected peak on the Results pane.  
• Absorbance Ratio -  This option is only available when Apex is checked. When 

Absorbance Ratio is checked, the apex spectrum, currently displayed in the Results 
pane, is annotated with the position of the two wavelengths and the absorbances used 
for calculating the Absorbance Ratio. 
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NOTE:  You can select Actions > Add All to View  to add all selected spectra in the Display list to the 
Data Tree. 

 

 Results Pane - This pane displays a graphical representation of the items that are 
checked on the Display List.  In addition, when a peak is selected on the 
chromatogram, the Results pane displays the Absorbance Ratio for the selected 
peak.   The Absorbance Ratio is labeled as:  Ratio (A/B) =. 

 

NOTE:  Whenever you select a different peak, change the parameters for the calculation, or 
select/deselect an item on the Display List, the Results pane is automatically updated to 
reflect the change.  

How  do I modify the parameters that are used to determine the 
Absorbance Ratio values? 

Absorbance Ratio Parameters 

The Parameters pane displays the values that are currently used in the operation.  At any 
time you can optimize/adjust the parameters that are listed on the Absorbance Ratio 
operation; the display updates with the new results. 
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Below is a list of the parameters you can modify: 

Parameter Description 

Wavelength A and 
Wavelength B  

These spin boxes show the two wavelengths used for the ratio, 
which you can modify.  The ratio is always calculated A/B.  
Wavelength A may be less than, equal to or greater than 
Wavelength B. 
  

Baseline correct 
spectra 

Check this option to use the baseline corrected spectra in the 
calculation. 
  

Absorbance Threshold To ensure that the Absorbance Ratios are calculated for small peaks, 
but the baseline noise is not interpreted as peaks, you can use this 
parameter to set the minimum absorbance  values above the system 
noise, and therefore, obtain more reproducible results.     
When Auto is selected, the absorbance threshold values are 
calculated automatically by the system and are set to either 0.0005 
A.U. or 2% of the maximum absorbance in the spectrum, whichever is 
greater. The entry field is grayed when Auto is selected. 
When Manual is selected, enter the required value in the entry field, 
by either typing directly or using the spin buttons.  When Manual is 
first selected the minimum absorbance value calculated by the Auto 
function is displayed in the Manual threshold field. 
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Summary of Operation:  Absorbance Ratio 

The summary below illustrates how to optimize/adjust the Absorbance Ratios for a 
chromatogram and then save the new results and parameters used in the calculation.     

How  do I review  and recalculate Absorbance Ratios for a chromatogram? 

1. From the Views Tree expand the Operations node and click on Absorbance 
Ratio. 

The Absorbance Ratio operation displays. 

2. Select a chromatogram from the Data tree. 
The selected chromatogram is displayed.  The first peak is selected.  
The results pane, directly below the chromatogram, shows, for the selected peak, its 
peak apex spectrum annotated with the position of the two wavelengths and 
absorbances, its Absorbance Ratio value, in the top right corner of the pane, and 
optionally its baseline spectrum.  

How  do I view  the Absorbance Ratio for a different peak? 

 Select the required peak by clicking on it in the chromatogram.  
The results pane is updated to show the peak apex spectrum, the Absorbance Ratio 
value, and the baseline spectrum for the selected peak. 

How do I examine the Absorbance Ratios at different wavelengths? 

  Enter a new value for Wavelength A or Wavelength B. 
The Absorbance Ratio value labels are updated for every peak in the chromatogram. 

How  do I examine the effect of using baseline corrected spectra on the 
Absorbance Ratio values?. 

 Check Baseline Correct Spectra. 
The Absorbance Ratio value labels are updated for every peak in the chromatogram. 

How  do I change the minimum absorbance value that is used in the 
calculation of the Absorbance Ratios? 

1. Select the Manual radio button. 

The minimum absorbance spin box is enabled. 

2. Use the spin box to specify a new minimum absorbance value. 
The Absorbance Ratio value labels are updated for every peak in the chromatogram. 

How  do I return to automatically calculating the minimum absorbance 
value? 

 Select the Auto radio button if you wish to automatically calculate the minimum 
absorbance value that can be used in the calculation. 
The Absorbance Ratio value labels are updated for every peak in the chromatogram. 
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How  do I add the displayed spectra in the results pane to the Data Tree? 

 Select Actions > Add All to View. 
A dialogue box is be displayed with the message “The data was added successfully”.  On re-
displaying the Main or Chrom/Spectra views the added spectra will appear in the Data Tree. 

How do I save the results and parameters used in the calculation? 

Once you are satisfied with the results, you can save the updated values and the parameters 
used in the calculation, by selecting File > Save Results in the main Chromera application.  
Once you have saved the updated values, they can be included in a report.   

1. In the main Chromera application, select File > Save Results 

A save dialog appears that asks you to confirm whether or not you want to save the 
new values. 
Or 
If you select another item in the Spectral Processing Window the following dialog 
appears: 

 

2. Click Yes to save the results and calculation parameters.  
The saved results can now be displayed as peak labels when the chromatogram is 
displayed in the Main View or Chrom/Spectra View.  In addition, when you select this 
chromatogram again, the saved results and the parameters used are displayed on 
the page. 
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Wavelength Maximum 

The Wavelength Maximum operation is used to determine the wavelength maximum of the 
apex spectrum of each peak in a chromatogram.  The Wavelength Maximum of a spectrum is 
defined as the wavelength of the highest absorbance peak in the spectrum above a 
specifiable minimum wavelength.  

 To access this operation expand the Operations node on the Views tree and select 
Wavelength Maximum. 

Determining the wavelength maximum of chromatographic peaks 

In order to use this page you must first select a chromatogram that is listed on the Data 
Tree. The selected chromatogram is displayed on the view in the upper graph 
(Chromatogram pane) and each peak in the chromatogram is labeled with a Wavelength 
Maximum value.  Chromera determines the wavelength maximum values using the 
parameter values that are currently displayed on the page.  You can modify the calculation 
parameters at any time and Chromera automatically recalculates and displays the new values 
on the page.   

If you are interested in the wavelength maximum of a specific peak, click on the peak; and, 
in the bottom graph (Results pane), the apex and baseline spectra for the peak are 
displayed. The apex spectra are annotated with the position and the absorbance of the 
wavelength maximum.  In addition, in the right hand corner of the Results pane the 
Wavelength Maximum value for the selected peak is displayed.   

NOTE: Use the Display List to specify what is displayed on the Results pane.  Items that appear 
checked on the Display List are plotted on the Results pane. 

Tell me about the Wavelength Maximum operation. 

The Wavelength Maximum operation is comprised of the following areas: 

 Views Tree - The Views Tree provides you access to the Wavelength Maximum 
operation.  You can access this operation by selecting Operations >Wavelength 
Maximum from the Views Tree. 
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 Data Tree - The Data Tree displays a list of currently loaded chromatograms.  You 
use the Data Tree to select the chromatograms that you want to use in the 
operation.  The chromatogram you select from the Data Tree is displayed in the 
upper pane (Chromatogram pane) for this operation    

 

 Chromatogram Pane - This pane displays the chromatogram that is currently 
selected on the Data Tree.  Each peak in the displayed chromatogram is labeled with 
the wavelength maxima.       

 

 Parameters Pane - This pane is where you set and investigate the various 
parameters used to determine the Wavelength Maximum values.  Whenever you 
change a parameter displayed on this operation, and have a chromatogram selected 
on the Data Tree, Chromera automatically updates the Display List and Results pane 
with the modified results. 
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 Display List - You use the Display List to select the information you want displayed 
on the Results pane. When items appear checked on this list, they are displayed in 
the Results Pane.  Meanwhile, unchecked items are not displayed. 

The following items are available for selection on the Display List: 

• Apex - Check this option to display the apex spectrum for the selected peak.   
• Wavelength Maximum- When Apex is checked you can check Wavelength Maximum to 

have the Apex spectrum annotated with the position and absorbance of the wavelength 
maximum. 

• Baseline - Check this option to display the baseline spectrum associated with the peak 
that is currently selected. 

 

 Results Pane - This pane displays a graphical representation of the items that are 
checked on the Display List.  In addition, when a peak is selected on the 
chromatogram, this pane displays the Wavelength Maximum value for the selected 
peak in the upper right hand corner as WMAX =.    
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NOTE:  Whenever you select a different peak, change the parameters for the operation, or 
select/deselect an item on the Display List, the Results pane is automatically updated to 
reflect the change.  

How  do I modify the parameters used that are used to determine the 
Wavelength Max imum values? 

Wavelength Maximum Parameters 

The Parameters pane displays the values that are currently used in the operation.  At any 
time you can optimize/adjust the parameters that are listed on the Wavelength Maximum 
operation; and the display is automatically updated with the new results. 

Below is a list of the parameters you can modify: 

Parameter Description 

Minimum Wavelength 
You can use the spin box to specify the minimum wavelength for 
the determination of the Wavelength Maximum. 
  

Maximum Wavelength  You can use the spin box to set the upper limit of the spectrum 
range to be included in the calculation. 
  

Baseline correct spectra Check this option to use the baseline corrected spectra in the 
calculation. 
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Absorbance Threshold To ensure that Chromera determines the Wavelength Maximum 
values for small peaks, but does not interpret baseline noise as 
peaks, you can use this parameter to set the minimum absorbance  
values above the system noise, and therefore, obtain more 
reproducible results.       
When Auto is selected, the absorbance threshold values are 
calculated automatically by the system and are set to either 0.0005 
A.U. or 2% of the maximum absorbance in the spectrum, whichever 
is greater. The entry field is grayed when Auto is selected. 
When Manual is selected, enter the required value in the entry 
field, by either typing directly or using the spin buttons.  When 
Manual is first selected the minimum absorbance value calculated 
by the Auto function is displayed in the Manual threshold field. 
  



Chromatogram Operations.  691 

 

Summary of Operation:  Wavelength Maximum 

The summary below illustrates how to determine the Wavelength Maximum for all the peaks 
in a chromatogram and then save the new results and parameters used in the calculation.     

How  do I determine the Wavelength Maximum of all the peaks in a 
chromatogram? 

1. From the Views tree expand the Operations node and click on Wavelength 
Maximum. 

The Wavelength Maximum operation displays. 

2. Select a chromatogram from the Data tree. 
The selected chromatogram is displayed.  The first peak is selected.  
The results pane, located directly below the chromatogram, shows, for the selected 
peak, its peak apex spectrum annotated with the position and absorbance of the 
wavelength maximum, and optionally its baseline spectrum.  In the top right corner 
of the pane, the Wavelength Maximum value is displayed.   

How  do I view  the Wavelength Maximum for a different peak? 

 Select the required peak by clicking on it in the chromatogram.  
The results pane is updated to show the peak apex spectrum, the Wavelength 
Maximum value, and optionally the baseline spectrum for the selected peak. 

How  do I examine the Wavelength Maximum values at different 
wavelengths? 

 Enter a new value for Wavelength A or Wavelength B. 
The Wavelength Maximum value labels are updated for every peak in the 
chromatogram. 

How  do I examine the effect of using baseline corrected spectra on the 
Wavelength Max imum values? 

 Check Baseline Correct Spectra. 
The Wavelength Maximum value labels are updated for every peak in the 
chromatogram. 

How  do I change the minimum absorbance value that is used to determine 
the Wavelength Max imum values? 

1. Select the Manual radio button. 

The minimum absorbance spin box is enabled 

2. Use the spin box to specify a new minimum absorbance value. 
The Wavelength Maximum value labels are updated for every peak in the 
chromatogram 
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How  do I return to automatically calculating the minimum absorbance value? 

 Select the Auto radio button if you wish to have IRIS automatically calculate the 
minimum absorbance value that can be used in the calculation. 
The Wavelength Maximum value labels are updated for every peak in the 
chromatogram. 

How  do I add the displayed spectra in the results pane to the Data tree? 

 Select Actions > Add All to View. 
A dialogue box is be displayed with the message “The data was added successfully”.  
On re-displaying the Main or Chrom/Spectra views the added spectra will appear in 
the Data Tree. 

How  do I save the results and the parameters used in the calculation? 

1. In the main Chromera application, select File > Save Results 

A save dialog appears that asks you to confirm whether or not you want to save the 
new values. 
Or 
If you select another item in the Spectral Processing Window the following dialog 
appears: 

 

2. Click Yes to save the results and calculation parameters.  
The saved results can now be displayed as peak labels when the chromatogram is 
displayed in the Main View or Chrom/Spectra  
View.   

How  do I display the Wavelength Max imum results in the Main View  or 
Chrom/ Spectra View? 

1. Select Actions > Label Chromatograms...  

2. Select WavelengthMaximum from the list of available labels. 

How  do I review  for any chromatogram previously determined 
Wavelength Max imum values and the parameters used? 

 Select this chromatogram again on the Wavelength Maximum operation. 
The saved results and the calculation parameters are automatically displayed. 
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Spectral Library Confirmation 

This Spectral Library Confirmation operation is used to check the identity of named 
peaks in a chromatogram by comparing the apex spectrum of each named peak to a 
spectrum of the same name in a library.  The comparison of the spectra is made using a 
Euclidean distance algorithm, the numerical result of which is called the Hit Quality.  

Chromera uses a Euclidean distance algorithm to evaluate the comparison between a 
selected spectrum and a library spectrum.   
 
Each normalized spectrum is defined as a point in N-dimensional space (where the number of 
dimensions is equal to the number of points in the spectrum).  The Hit Quality is simply the 
distance between the sample and library spectra.  Since the space is normalized, the 
maximum possible distance between any two spectra is root 2.  The distance between the 
spectra therefore varies between 0 and 1.4 - the lower the number, the closer the spectra 
and the better the match. 
 
For verification purposes in the Spectral Library Confirmation task and Peak Library Search 
task, a Hit Distance Threshold of 0.05 is used to confirm that the peak in the sample 
chromatogram is the same component as that in the spectral library.  A value higher than 
0.05 suggests either that the peak in the sample is impure or that it is not the same 
component as in the spectral library. 
For identification purposes in the Spectral Library Search task a lower Hit Distance Threshold 
of 0.01 is used in order to prevent false matches. 
 
The Hit Quality threshold can be modified, up or down, on the Parameters pane for each of 
these tasks.   .  You can set a maximum hit threshold value to prevent unlikely matches. 

 To access this page expand the Operations node on the Views tree and select 
Spectral Library Confirmation. 

The Spectral Library Confirmation operation displays. 
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Verifying the Identity of Chromatographic Peaks by Comparing to a 
Spectral Library 

To perform this operation you must select a chromatogram that is listed on the Data Tree.  
Next, you must specify the spectral libraries to be searched.  Chromera then matches  each 
named peak in the chromatogram to a library spectrum that has the same component name.  

As a result of the search, each named peak, on the chromatogram, that could be matched to 
a library spectrum with the same component name is labeled with the Component Name, a 
Hit Quality Value (a numerical value that indicates how close the apex spectrum matches 
to the library component of the same name), and a Pass/Fail value that indicates whether or 
not the component from the sample chromatogram matches the library component based on 
the Hit Threshold you specify.  

NOTE: If the chromatogram that you selected on the Data Tree has no identified peaks, Chromera 
informs you of the error and you will not be able to perform this operation. Only identified 
peaks can be matched.  

If you are interested in the Spectral Library Confirmation for a specific peak, simply click on 
the peak you wish to evaluate.  Below the chromatogram plot, an overlaid plot of the apex 
spectrum for the currently selected peak is displayed along with the library spectrum with the 
same component name.   

How  does Chromera perform Spectral Library Confirmation? 

As stated earlier, the Spectral Library Confirmation operation verifies the identity of named 
peaks in a sample chromatogram by comparing the apex spectrum of each named peak in 
the sample to an identically named spectrum in a spectral library.  The comparison of the 
spectra is made by calculating the Euclidean distance algorithm. 

Chromera uses a Euclidean distance algorithm to evaluate the comparison between a 
selected spectrum and a library spectrum.   
 
Each normalized spectrum is defined as a point in N-dimensional space (where the number of 
dimensions is equal to the number of points in the spectrum).  The Hit Quality is simply the 
distance between the sample and library spectra.  Since the space is normalized, the 
maximum possible distance between any two spectra is root 2.  The distance between the 
spectra therefore varies between 0 and 1.4 - the lower the number, the closer the spectra 
and the better the match. 
 
For verification purposes in the Spectral Library Confirmation task and Peak Library Search 
task, a Hit Distance Threshold of 0.05 is used to confirm that the peak in the sample 
chromatogram is the same component as that in the spectral library.  A value higher than 
0.05 suggests either that the peak in the sample is impure or that it is not the same 
component as in the spectral library. 
For identification purposes in the Spectral Library Search task a lower Hit Distance Threshold 
of 0.01 is used in order to prevent false matches. 
 
The Hit Quality threshold can be modified, up or down, on the Parameters pane for each of 
these tasks. The numerical result of this comparison is called the Hit Quality; and this value 
can vary between 0 and 1.4.  The lower the Hit Quality number, the closer the spectra and 
the better the match.   

For identification purposes in the Spectral Library Confirmation, it is recommended that a Hit 
Quality threshold of 0.01 be used in order to confirm that the component in the sample is the 
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same component as that in the spectral library.  This low value of 0.01 for the Hit Quality 
Threshold is used to prevent false matches.  However, it should be noted that you can 
determine the value that you want to use for the Hit Quality threshold and are not required 
to use the recommended Hit Quality threshold of 0.01.  

Tell me about the Main Window . 

The Spectral Library Confirmation operation is comprised of the following areas: 

 Views Tree - The Views Tree provides you access to the Spectral Library 
Confirmation operation.  To access this operation, expand the Operations node and 
click on Spectral Library Confirmation. 

 

 Data Tree - The Data Tree displays a list of currently loaded chromatograms.  You 
use the Data Tree to select the chromatograms that you want to use in the 
operation.  The chromatogram you select from the Data Tree is displayed in the 
upper pane (Chromatogram pane) for this operation. 

 

 Chromatogram Pane - This pane displays the chromatogram that you selected 
from the Data Tree.  Named peaks in the displayed chromatogram are labeled with 
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their Component Name, the Hit Quality Value, and either a P or an F to indicate 
a Pass or Fail status, which is dependent on the current value of the Hit Distance 
Threshold. 

   

 Parameters Pane - This pane is where you set and investigate the various 
parameters used to perform the Spectral Library Confirmation operation.  Whenever 
you change a parameter displayed on this operation, and have a chromatogram 
selected on the Data Tree, Chromera automatically updates the Display List and 
Results pane with the modified result. 

 

 Hit Details - The file name and path for the library spectrum, that has the same 
name as the peak selected on the chromatogram, is displayed here.  

You can right mouse click on this section and select Properties from the context 
menu that appears to view detailed information on the library spectrum, such as the 
source, the chromatogram and retention, the baseline, and who added the spectrum 
and when. 

. 
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 Display List - You use the Display List to select the information you want displayed 
on the Results pane. When items appear checked on this list, they are displayed in 
the Results Pane.  Meanwhile, unchecked items are not displayed. 

The following items are available for selection on the Display List: 
• Apex - Check this item to display the apex spectrum from the chromatogram on the 

Results pane. 
• Library - Check this item to display the matching named spectrum from the library on 

the Result pane. 
• Spectrum baseline - Check this item to display the baseline spectrum used for the apex 

spectrum on the Results pane. 
• Library baseline - Check this item to display the baseline spectrum used for the library 

spectrum on the Results pane.  

 

 Results Pane - The Results pane displays the items that are checked on the Display List.   
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How  do I modify the parameters used in the search? 

 Spectral Library Confirmation Parameters 

The Parameters pane is where you set and investigate the various parameters for perform 
the Spectral Library Confirmation on a chromatogram that is currently selected on the Data 
Tree.  Once you have a chromatogram selected on the Data Tree, you can optimize/adjust 
the parameters that are displayed on the screen at any time; and Chromera automatically 
updates the display with the new results. 

Below is a list of the parameters you can optimize/adjust: 

Parameter Description 

Minimum 
Wavelength 

Use the Minimum Wavelength spin box to set the lower limit of the 
spectrum range to be used in the calculation. 
  

Maximum 
Wavelength 

Use the Maximum Wavelength spin box to set upper limit of the 
spectrum range to be used in the calculation. 
  

Hit distance 
threshold 

Use the Hit Distance Threshold spin box to specify the Hit Quality 
above which two spectra will not be considered a match.  The results 
of the match are displayed as labels for each peak on the 
chromatogram.  If the match for a peak on the chromatogram meets 
the Hit Distance Threshold specified, then the peak is labeled with a 
P, to indicate the test passed.  If the match for a peak on the 
chromatogram does not fall within the Hit Distance Threshold, then 
the peak is labeled with an F, indicating that the test failed.    
  

Baseline corrected Check this option to use the baseline corrected spectra in the 
operation. 
  

Library list Select this command button to display the Libraries List dialog.  
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Summary of Operation:  Spectral Library Confirmation 

The summary below illustrates how to optimize/adjust the Spectral Library Confirmation 
results for a chromatogram and then save the new results and parameters used in the 
operation.     

How  do I review  and adjust the Spectral Library Confirmation values for a 
chromatogram? 

1. From the Views tree, expand the Operations node and click on Spectral Library 
Confirmation. 

The Spectral Library Confirmation operation displays. 

2. If necessary open the required chromatogram using File > Open > 
Chromatogram... 

3. Select a chromatogram from the Data Tree. 
The selected chromatogram is displayed.  The first peak is selected.  
The results pane, directly below the chromatogram, shows, for the selected peak, its 
peak apex spectrum, the matching library spectrum, and optionally the  baseline 
spectrum for the peak selected on the chromatogram and the baseline spectrum for 
the matching library spectrum. 

How  do I view  the Spectral Library Confirmation values for a different 
peak? 

 Select the required peak by clicking on it in the chromatogram.  
The results pane is updated to show the peak apex spectrum, the matching library spectrum, 
and optionally the baseline spectrum for the selected peak and the matching library spectrum.   

How  do I examine the Spectral Library Confirmation values at different 
wavelengths? 

 Enter a new value for Wavelength A or Wavelength B. 
The Spectral Library Confirmation value labels are updated for every peak in the 
chromatogram. 

How  do I examine the effect of using baseline corrected spectra on the 
Spectral Library Confirmation values? 

 Check Baseline Correct Spectra. 
The Spectral Library Confirmation value labels are updated for every peak in the 
chromatogram. 

How do I change the spectral library/libraries that are used in the match? 

Select the Library List…  button. 

The Libraries List dialog appears. 

1. Specify the directory path where the libraries you wish to search are located by 
typing the directory path in the Look in text box, or by clicking on the Browse... 
button and selecting a directory path from the Browse for Directory dialog box.   
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Once you have specified a directory path, a list of libraries available for selection 
appears on the Libraries list dialog. 

2. From the Available libraries list, click on the spectral library/libraries you want to 
use and then click on the Add button. 
You can either click on a single library to add it to the Libraries list, or you can select 
multiple libraries to add to the Libraries List by using CTRL+click or SHIFT+click. 
The selected libraries now appear in the Libraries List. 

3. To remove a library from the Libraries list click on the library and then click Delete. 
The selected library is removed from the Libraries list and reappears in the Available 
Libraries list. 

4. Click OK. 
You are returned to the Spectral Library Confirmation operation, and each peak that 
Chromera was able to match is labeled with the identically named spectrum from the 
spectral library, along with the Hit Quality of the match, and a Pass/Fail flag that 
indicates whether or not the test passed or failed. 

 

How do I add the spectra that are displayed in the Results pane to the Data Tree? 

 Select Actions > Add All to View. 
A dialogue box is displayed with the message “The data was added successfully”.  On re-
displaying the Main View or Chrom/Spectra View the added spectra will appear in the Data 
Tree. 

How  do I save the results and parameters used in the calculation? 

1. In the main Chromera application, select File > Save Results. 

A save dialog appears that asks you to confirm whether or not you want to save the 
new values. 
Or 
If you select another item in the Spectral Processing Window the following dialog 
appears: 

2. Click Yes to save the results and calculation parameters.   

3. The saved results can now be displayed as peak labels when the chromatogram is 
displayed in the Main View or Chrom/Spectra View. 

How  do I display the Spectral Library Confirmation results in the Main 
View  or Chrom/ Spectra View? 

1. Select Actions > Label Chromatograms...  

2. Select Spectral Library Confirmation from the list of available labels 

How  do I review  for any chromatogram previously calculated Spectral 
Library Confirmation values and the parameters used? 

 Select this chromatogram again on the Spectral Library Confirmation operation.  
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Peak Library Search 

The Peak Library Search operation allows you to easily identify all the peaks in a 
chromatogram by comparing the apex spectrum of each peak in a chromatogram to spectra 
contained in libraries that you specify.    

 To access this operation, expand the Operations node on the Views tree and 
select Peak Library Search 

Identifying Chromatographic Peaks 

In order to perform a Peak Library Search you must first select a chromatogram from the 
Data Tree. At this point you may be prompted to select a list of libraries to search, if a search 
has not been previously performed on the chromatogram.  If you have already performed a 
search on the chromatogram, Chromera uses the previously defined set of libraries for the 
search. At any time, however, you can modify the list of libraries that are used in the search 
by clicking on the Library List button, which is located in the right-hand portion of the Peak 
Library Search operation.    

Once you have selected a chromatogram and built a list of libraries to be searched, 
Chromera automatically searches the specified spectral libraries for a match to the apex 
spectrum of each peak in the chromatogram; and the results are immediately displayed on 
the screen.  Notice that each identified peak on the displayed chromatogram is labeled with 
the Component Name of the best match as well as the Hit Quality Value (a numerical 
value that indicates how close a match the currently displayed peak is to the component 
name from the matching library spectrum, the lower the Hit Quality Value, the closer the 
match).  If a match for a peak could not be found, the unmatched peak is labeled with “Not 
Found.”   

If you want to evaluate how the best match for a specific peak was calculated, then click on 
that peak.  In the pane located below the chromatogram plot, the apex spectra for the 
currently selected peak is displayed along with the library spectrum considered to be the best 
match.   

In addition, in the lower right hand corner of the Peak Library Search operation, a list of 
library spectra check boxes is displayed.  The Library spectra checkboxes are listed by their 
Hit Quality, then by component name; the spectra with the lowest Hit Quality number is 
considered the best match.  To visually compare how close the apex spectrum of the 
currently selected peak matches to additional library spectra, check the Sample check box, 
and then check any number of library spectra listed on the Hits List that you wish to 
compare.  The selected spectra are displayed in the Results pane, which is located directly 
below the Chromatogram pane.     

How  does is a Peak Library Search performed? 

As stated earlier, the Peak Library Search operation searches spectral libraries for a match to 
the apex spectrum of each peak in the chromatogram.  The comparison of the spectra is 
made by calculating the Euclidean distance algorithm; the numerical result of which is called 
the Hit Quality.  The Hit Quality Value, or distance between the two spectra, can very 
between 0 and 1.4.  The lower the Hit Quality number, the closer the spectra and the better 
the match.   

When the Peak Library Search operation is performed, and a peak is selected on the 
chromatogram you will notice that a list of all the library spectra that are considered a match 
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to the peak apex spectrum of the currently selected peak are displayed. The library spectra 
displayed here are considered a match, because the distance between these library spectra 
and the peak apex spectrum (for the currently selected peak) fall within a user-specified Hit 
Distance Threshold.   

For verification purposes, Chromera uses a default Hit Distance Threshold of 0.05 to confirm 
which peak apex spectrum is the same component as that in the spectral library.  Therefore, 
when the distance between a sample spectrum and a library spectrum is less than 0.05, the 
sample peak is labeled with the component name of the best matching library spectrum.  It 
should be noted that, a Hit Quality value higher than 0.05 suggests either the peak in the 
sample is impure or that it is not the same component as in the spectral library.   

You can modify the Hit Distance Threshold value, to include or exclude library spectra as a 
match to a spectrum at the peak apex  in the chromatogram.  For instance, to prevent 
unlikely matches you may wish to set a lower maximum hit threshold. 

Tell me about the Peak Library Search Operation. 

The Peak Library Search operation is comprised of the following areas: 

 Views Tree - The Views Tree provides you access to the Peak Library Search 
operation.  You can access this operation by expanding the Operations node and 
selecting Peak Library Search. 

 

 Data Tree - The Data tree here shows only a list of chromatograms and is used to 
select the required chromatogram from the ones available.  The selected 
chromatogram is displayed in the top graph (Chromatogram pane). 

As different chromatograms are selected the nearest peak is selected, the other two 
graphs are updated and chromatogram labels are updated. 
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 Chromatogram Pane - When a chromatogram is selected on the Data Tree, the 
chromatogram is displayed on this pane and the peak maxima are labelled with the 
top library hit name, as calculated by the current settings or with "Not found" when 
unable to find a match for the peak.  The labels are automatically updated with every 
change in parameters.  When a chromatogram is loaded or changed these labels are 
calculated and displayed as soon as possible. 

 

 Parameters Pane - From this pane you can change the minimum and maximum 
wavelengths to be used for the search; you can also change the Hit Threshold value, 
which defines whether a valid match has been found, and you can specify whether 
retention time is to be used to restrict the search, as well as whether or not you wish 
to use baseline corrected spectra for the library match. 
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 Hits List - The Hits List contains a list of check boxes for selecting what is displayed 
on the Results Pane.  Items that appear checked on this list are displayed in the 
Results pane, unchecked items are not displayed in the Results pane.  

The first item in the list, labeled Sample, is the apex spectrum of the currently 
selected peak.  You can check this item to compare how close the apex spectrum of 
the currently selected peak matches any of the library spectra that are listed here as 
hits.    
The remaining items, that appear on this list, are the hits from the library match, 
listed in hit order, with the best hit first.  Each hit is listed by the Hit Quality value, 
and component name.  You can right mouse click on a hit and select Properties from 
the context menu that appears to display additional information about the spectrum.   

 

 Results Pane - The Results pane displays the items that are checked on the Hits 
List. You can use this pane to compare how close the apex spectrum of the currently 
selected peak matches to the hits returned from the search.   
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How  do I modify the parameters used in the search? 

Peak Library Search Parameters 

The Parameters pane displays the values that are currently used in the search.   At any time 
you can modify the parameters that are listed on the Peak Library Search Page; and the 
display automatically updates with the recalculated results. 

Below is a list of the parameters you can modify: 

Parameter Description 
Minimum 
Wavelength 

Use the Minimum Wavelength spin box to set the lower limit of the 
spectrum range to be used for the match.  

Maximum 
Wavelength 

Use the Maximum Wavelength spin box to set upper limit of the 
spectrum range to be used for the match.  

Match retention 
time window 

Check this option if you wish to use the retention time of the spectrum 
as one of the search criteria.  When this option is checked the % spin 
box is enabled.  

%  This spin box specifies the search window, as ± percent of retention 
time, if you have checked the Retention Time Search option. 
If you use retention time as a search criterion, the search first creates a 
list of all spectra in the library that fall within the window; it then does a 
spectrum-by-spectrum comparison. If you don't use the retention time 
option, the comparison is made with all spectra in the library.  

Hit distance 
threshold 

Use the Hit Distance Threshold spin box to specify the Hit Quality above 
which two spectra will not be considered a match. 

Baseline corrected Check this option if you wish to use baseline corrected spectra for the 
library match.  

Library List Click this button to display the Libraries List dialog.  

Update Component 
List 

Click this button to update the component list in the Chromera method 
with the new component names and retention times.  The new identified 
peaks and their retention times will simply be added to the current 
component list. 
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Summary of Operation:  Peak Library Search 

The summary below illustrates how to perform the Peak Library Search Operation for a 
chromatogram and then label the peaks in that chromatogram with the results. 

How  do I identify the peaks in a chromatogram using a library/ s of 
standard spectra? 

1. From the Views tree expand the Operations node and click on Peak Library 
Search. 

The Peak Library Search operation displays. 

2. Select a chromatogram from the Data Tree. 

NOTE:  If the Peak Library Search operation has not been previously performed on the 
chromatogram that you just selected, the Libraries List dialog is displayed from where you 
must select the spectral libraries you want to search.  This dialog is not displayed if the Peak 
Library Search operation has already been performed on the chromatogram and the results 
were saved via the File > Save Results command.  Instead, the Peak Library Search 
operation is displayed and the previously selected library/s are automatically selected for the 
operation.  

The selected chromatogram is displayed and the first peak is selected. 
Note that each identified peak on the chromatogram is labeled with the Component 
Name of the best match as well as the Hit Quality Value (a numerical value that 
indicates how close the peak apex spectrum matches the component name from the 
matching library spectrum, the lower the Hit Quality Value, the closer the match). If 
a match for a peak is not found, the unmatched peak is labeled with “Not Found.”   
In addition, the Results pane, directly below the chromatogram, shows, for the 
selected peak the apex spectrum of the peak, and optionally its baseline spectrum.  
The spectrum from the library with the lowest Hit Quality is also displayed in the 
Results pane. 

How do I view the Peak Library Search values for a different peak? 

 Select the required peak by clicking on it in the chromatogram.  
The Results pane is updated to show the peak apex spectrum and the spectrum from the 
library with the lowest Hit Quality. 

How  do I visually compare how  close the apex spectrum of the currently 
selected peak matches to additional library spectra?  

1. Check Sample on the Hits List. 

The peak apex spectrum from the currently selected peak is displayed. 

2. Check any number of library spectra on the Hits List that you want to compare.   
The selected spectra are displayed in the Results pane. 

How  do I examine the Peak Library Search values at different 
wavelengths? 

 Enter a new value for Wavelength A or Wavelength B. 
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The Peak Library Search value labels are updated for every peak in the 
chromatogram. 

How  do I examine the effect of using baseline corrected spectra on the 
Peak Library Search values? 

 Check Baseline Correct Spectra. 
The Peak Library Search value labels are updated for every peak in the chromatogram. 

How  do I add the displayed spectra in the results pane to the Data Tree? 

 Select Actions > Add All to View. 
A dialogue box is be displayed with the message “The data was added successfully”.  On re-
displaying the Main View or Chrom/Spectra View the added spectra will appear in the Data 
Tree. 

How  do I save the results and parameters used in the calculation? 

NOTE: When you save the results of this operation, any existing component lists are deleted and a 
new component list is created. 

1. In the Chromera main application, select File > Save Results 

A save dialog appears that asks you to confirm whether or not you want to replace 
the component list in the chromatogram’s file and asks you to confirm whether or 
not you wan to save the new values to the chromatogram's file, and save the 
parameters that were used calculate the new values to the associated spectral 
method files.   

2. Click Yes. 
A dialog appears that asks you to confirm that you are sure you want to replace the 
component list in the chromatogram’s result file. 

3. Click Yes. 
Peak Library Search values added to the result file.   

How  do I display the Peak Library Search results in the Main View  or 
Chrom/ Spectra View? 

1. Select Actions > Label Chromatograms...  

2. Select Peak Library Search from the list of available labels. 

 

How do I review for any chromatogram previously calculated Peak Library Search 
values and the parameters used? 

 Select this chromatogram again on the Peak Library Search operation.  
The saved results and the search parameters are automatically displayed. 
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Preview  Chromatograms 

The purpose of this function is to automatically generate the optimum wavelength program. 
No chromatogram will actually be created by the Spectral Processing window (other than that 
used to preview within the Spectral Processing window the resulting chromatogram), instead 
a wavelength program channel description will be generated which will be added to the 
method being edited in GME. Preview Chromatograms has no controlling parameters and is 
used simply to preview possible extracted chromatograms.  It is not stored with the method 
but will revert to default values each time it is called, even within the same session. Preview 
Chromatograms is only accessible when you are in Graphics Method Editor (GME). 

Note:  The result from the Spectral Processing window function Preview Chromatograms is not 
included in this list since the output from this function is not a numerical value but a 
chromatogram which is not of course a result in the terms used here.  A user may add the 
definition of the parameters required for the generation of this chromatogram (Analytical and 
Reference wavelengths and bandwidths) to the PDA channels section of the method if they 
so wish when saving the results from the Spectral Processing window back into Chromera. 

The Preview Chromatogram operation allows you to preview chromatograms from a 
spectral file and automatically process them. 

• To access this page expand the Operations node on the Views tree and select 
Preview Chromatograms. 

Preview ing Chromatograms at Different Wavelengths 

To preview chromatograms at different wavelengths you must first select a Channel in the 
Data Tree.  The selected chromatogram is displayed in the top graph of this page.  You can 
then use the bottom graph to preview a chromatograms.  To preview chromatograms all you 
need to do is enter an analytical Wavelength for the chromatogram you want to 
preview.   This operation also provides you with the ability to specify the following additional 
parameters for each channel you want to preview:  Bandwidth, Reference Wavelength, and 
Reference Bandwidth. 

After you have finished establishing the preview parameters click the Add to Method 
button.  Once the parameters are saved, you can then use Reprocess to reprocess the batch.  

For example... 

In the following example a chromatogram named Example 2 - identified but with 
coelution is selected for the operation and the following parameters are specified to 
produce 1 chromatogram: 

AnalyticalWavelength of 260 

Bandwidth of 1 

Reference Wavelength of 400 

ReferenceBandwidth of 1 

Tell me about the Preview  Chromatograms operation. 

The Preview Chromatograms operation is comprised of the following areas: 
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• Views Tree - The Views Tree provides you access to the Extract Chromatograms 
page.  You can access this page by expanding the Operations node and selecting 
Extract Chromatograms. 

 

• Data Tree -The Data Tree displays a list of the current batches open in 
Chromera.  You use the Data Tree to select the channel that you want to use in the 
operation.  The channel you select from the Data Tree is displayed in the upper pane 
(Chromatogram pane) for this operation.   

 

• Chromatogram pane - When you select a channel from the Data Tree, the 
selected channel is displayed here.  To the right of the displayed channel are 
the parameters under which the channel was originally extracted. 
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• Preview Chromatograms pane – Once you have selected a channel from the 

Data Tree, you can use the Preview Chromatograms pane to view the sample 
chromatogram at different wavelengths.    
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Preview  Chromatograms Parameters 

You can specify the following parameters for the chromatogram you want to preview: 

Control Description 

Wavelength Enter the analytical wavelength for the extracted chromatogram 
in this text box. 

The available wavelength range for this text box depends upon 
the range available from the original spectrum. 
  

Bandwidth Enter the analytical bandwidth for the extracted chromatogram in 
this text box. 

The bandwidth is the total width of the wavelengths used.  The 
Analytical or Reference Wavelength is centered in this range, 
thus an Analytical Wavelength of 250 nm and a Bandwidth of 
10nm would use data in the range of 245-255nm. 

Note:  The Bandwidth cannot be set such that it would result in 
data stretching past either end of the current wavelength 
range.  Thus, if you are working in the UV range, 190-400 nm, 
and set an analytical wavelength of 195 nm, the maximum 
bandwidth you can set is 10 nm, +/- 5nm. 

Setting a bandwidth too wide or too close to the end of the 
range for the current bandwidth will result in an error message 
that provides you with assistance in setting valid values.  

Reference  Enter the reference wavelength to be used in this text box. 
  

Reference 
bandwidth 

A text box for entering the reference bandwidth to be used. 

Note:  To turn off the Reference Channel enter 0 as the value 
for Reference bandwidth.  A message will appear when you enter 
0 that informs you that when you enter 0 the Reference Channel 
is turned off, to re-enable the Reference Channel. 

Add to Method This command adds the channel description created by the 
Preview Chromatogram operation to the channels section of the 
method.  This operation is therefore always synchronized to the 
Channels section of the Chromera method. 
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Summary of Operation:  Preview  Chromatograms 

The following procedure shows you how to preview a chromatogram at conditions other than 
the original conditions. 

1. From the Views Tree expand the Operations node and select Preview 
Chromatograms. 

2. The Preview Chromatograms operation displays. 

3. Select a channel from the Data Tree.   

4. The selected chromatogram is displayed in the top pane of this page.  

5. In the bottom pane, specify the Analytical Wavelength, Bandwidth, Reference 
Wavelength, and Reference Bandwidth for the chromatogram you wish to 
extract.     

6. As soon as you enter a valid Analytical Wavelength, the chromatogram is displayed.   

7. After entering the parameters, click the Add to Method button to add this new 
channel to the method. 
You can use this method with new channel information to acquire or when you 
reprocess data.  
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About Calculation Algorithms 

The following two major calculation algorithms are used: 

• Peak Purity Algorithm 

• Euclidean Distance Algorithm 

Peak Purity Algorithm  

If a chromatographic peak is homogeneous, then the spectra on the leading edge of the peak 
should be identical to those on the trailing edge. If, however, two or more components are 
eluting in a single peak envelope, then as long as the two components do not have the identical 
retention time, the leading edge of the peak will have a higher concentration of the faster 
eluting component. Spectra from the leading edge will differ from those on the trailing edge. 

You therefore can check the homogeneity or purity of a peak by comparing the spectra from 
its front and back edge. Spectra taken close to the peak start will obviously have a higher 
percentage of the earlier-eluting component than those taken at the peak apex. Similarly, 
spectra taken close to the end of the peak will have a higher percentage of the later-eluting 
component. In practice, of course, the closer to the baseline the spectra are taken, the lower 
the signal-to-noise will be in the spectrum. 

For all spectra collected from the Series 200 DAD, spectra are collected continuously across 
the peak. Within the spectral processing software, you can therefore select where on the 
peak you want to take the two spectra. 

To check the peak purity, the software first divides the two spectra. If they are identical 
except for concentration, the result of this division will be a straight line, parallel to the 
wavelength axis. If, however, the two spectra are different, then deviations from the straight 
line will occur. The greater the difference between the two spectra, in terms of both the 
shape of the spectral peak and its wavelength maximum, the greater will be this deviation. 
The deviation is quantitated simply by dividing the maximum in the resulting plot by the 
minimum. 

If the spectra are identical, the resulting plot is a straight line, and the Purity Index will  be 
1.00. Note that this result is independent of the concentration of the components in the two 
spectra. 

If the two spectra are not identical, then the plot deviates from the straight line and the 
Absorbance or Purity Index will always be greater than 1.00. 

The test is very sensitive, and two spectra are rarely absolutely identical. We have found in 
practice that a value between 1.00 and 1.50 will usually indicate that the spectra are the 
same and that the peak is pure. 

Two practical factors have to be considered when actually performing the test. The first is 
that a result of dividing two noisy numbers close to zero is very unstable and could easily 
affect the minimum or maximum value in the final calculation. To avoid such errors, an 
absorbance threshold is set in the calculation. Absorbances in the spectra that fall below this 
threshold are not used in the calculation. The default value for this absorbance threshold is 
0.0005 AU, or 2% of the maximum absorbance in the spectrum, whichever is the greater. 
This threshold value can be changed within the application.  
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The second factor results from the threshold just described. Clearly, the threshold removes 
some data points from the calculation. It is possible for low- absorbance spectra, especially if 
the minimum and maximum wavelength has to be set to a narrow range, to have insufficient 
points for a valid calculation to be performed. A second threshold, the Minimum Data Points 
threshold, is therefore applied, which determines if the calculation can be performed. This 
value defaults to 20, but it can be changed.  

Euclidean Distance Algorithm 

The Euclidean Distance is basically a vector product correlation calculation. If S is an array of 
absorbances for the “unknown” sample, and L is an array of a spectrum in a library, the HQI 
(Hit Quality Index) for the Euclidean Distance method is calculated by: 

HQI = sqrt(2) * sqrt(1-(sum(S * L)/[(sum(S * S)) * (sum(L * L))]) 

The “sum(S * S)”, etc. items indicate a dot product operation. The dot product operation 
results in a single value that is the sum of the multiplication of two vectors (arrays). Once 
additional note is that both the sample S and library L spectra are normalized to have a 
minimum value of zero (0) and a maximum value of one (1) before the HQI calculation. As 
you can see, if the S and L vectors are identical, the algebra works out to give an HQI of zero 
(0) indicating a perfect match. If the S and L vectors are exact “antispectra,” then the HQI 
will return the maximum allowed value of sqrt(2) which is ~1.414. In practice, neither of 
these cases ever happens. Basically, the smaller the HQI, the better the match. 

One thing to remember about searching is that, although you will always get a hit list, this 
does not mean that the hit with the lowest HQI in the list is the actual compound you 
measured. It only means it is the most similar one in the library. Unfortunately, there is no 
statistical significance or cutoff level that can be assigned to the HQI to determine whether 
you actually have the same compound as the library spectrum. In other words, it is a fairly 
relative measure. What is more useful, in many cases, is to look at the whole hit list for 
compounds with similar chemical makeup to elucidate the class of the “unknown” compound. 

 



 

 

Printing and Presentations 
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Printing and Presentations 

You can easily create high-quality presentation output. 

• You can add your own annotations to the views 

• You can copy chromatograms and spectra other programs  

• You can print chromatograms and spectra at high resolution and in color 
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Annotations 

You can create freehand labels in any view page, and then print the annotated view at high 
resolution.  The annotations are free-floating text and are not associated with a specific 
position on a chromatogram or spectrum. If you annotate a specific point on a 
chromatogram and then change the scaling, the annotation will not move its position on the 
screen. 

NOTE:   It should be noted that annotations are associated with a view; annotations on a 
chromatogram are not associated with that chromatogram. For example, annotations on a 
chromatogram in the Chrom/Spectra view will not be displayed in the any other view page.  
They will, however, stay with the Chrom/Spectra view and will be restored when the view is 
re-displayed. 

How  do I add an annotation? 

To create freehand labels in any view: 

1. Click on the pane where you want to add an annotation. 

2. From the menu bar select Actions > Annotations >Add. 
The Edit Annotations dialog appears.  From this dialog you enter the text of the 
annotation and specify the text color, justification, and orientation, as well as the 
font, size, and style. 

3. Make your choices and click OK 
The text appears in a box that is the same size as the final annotation. 

4. Move the box to the exact location you want. 

5. Click outside the box 
The text is placed on the screen. 

6. The text can be selected and moved at any time by clicking on it and dragging.  

How  do I modify an annotation? 

You can modify the font and style of any annotation you have placed on the screen as well 
as several of the automatic text labels (the chromatogram and spectrum labels fall into this 
category) by selecting Actions > Annotations > Edit from the menu bar.   

To modify an annotation: 

The Edit Annotation command operates only on a selected annotation.  

1. Select the annotation to be changed by clicking on it. 

The cursor turns into a four-way cursor, a box appears around the label and the text 
color is changed to white. 

2. Select Actions > Annotations > Edit from the menu bar.  
The Edit Annotations dialog appears and from this dialog you can change the 
annotation or its font, size, and style.   
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3. Click on the Annotation tab to modify the Text and Orientation.   

4. Click on the Font tab to select a Font, Font Size, Style, Color, and to select 
whether or not the label is underlined. 
This tab page provides you with a preview that shows you the name of the selected 
font formatted as set on the two tabs, and is automatically updated for each 
selection made on the dialog. 

5. Once you have finished making your changes click OK. 
The dialogue box is closed and the selected label with the changes appears. 

6. Move the box to the exact location you want. 

7. Click outside the box 
The text is placed on the screen. 

How  do I delete annotations? 

• You can delete any annotation you have placed on the screen as well as several of 
the automatic text labels by selecting the annotation you wish to delete and then 
selecting  Actions > Annotations > Delete from the menu bar.   

• If you wish to delete all annotations that appear on a page select Actions > 
Annotations > Delete All.   
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Copying Images to other Locations 

You can copy complete screen images and paste them into applications, such as, Microsoft 
Word for Windows.  

How  do I copy the pixels of the screen display as a bitmap image? 

To copy the view as a bitmap image: 

 From the menu bar select Edit > Copy Screen As > Bitmap. 
The entire screen is copied to the clipboard.  You can now paste this image into any Windows 
application that supports bitmap images.  If you wish to edit the image you can past the 
image into an application such as Microsoft Windows Paintbrush.   

How  do I export the numerical values of a trace for a displayed 
chromatogram or spectra to spreadsheet programs such as Microsoft 
Excel? 

To export the numerical values of a trace: 

You can export data displayed on a chromatogram or spectra pane to spreadsheet programs 
such as Microsoft Excel by using the Edit > Copy Object command.  This command copies 
the numerical values of the trace to the clipboard. 

1. Click on the chromatogram or spectra pane that you wish to copy. 

NOTE:  You can only copy contents from a stacked chromatogram or spectra pane. 

2. From the menu bar select Edit > Copy Object. 
The numerical values of the trace are copied to the clipboard.  You can paste these 
values into a spreadsheet program such as Microsoft Excel. 
Spectra data are copied to the clipboard in wavelength/absorbance pairs in 1nm 
resolution from 195nm to 365nm. Chromatographic data are copied to the clipboard 
in retention time/absorbance pairs.  The resolution of the data is at the original data 
collection rate. 
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Printing Chromatograms and Spectra 

The Print dialog allows you to specify the format for printing chromatograms and spectra that 
are currently displayed.   

 To print chromatograms and spectra from a view select File > Print... from the 
menu bar.   

NOTE:  Operations can only be printed as the view displayed on your screen.  You can, however, 
select a printer and set the printer preferences. 

Tell me about the Print dialog. 

The print dialog consists of three tab pages: 

 General tab page - This tab page is always enabled and allows you to select where 
and what you would like to print.   

 

The following options are available to on the General tab page: 

 Printer - Select a printer from the drop down list.  

 Preferences - Click on the Preferences button to define the settings for the printer. 

 Print What -  Select one of the following radio buttons: 

• All Panes in View - Prints the current workspace. 
• Selected Pane Only - Prints only the contents of the pane that is currently selected.  

When this option is selected the Chromatograms and Spectra tab pages are enabled. 
  

• Apex Spectra -  Allows you to print the parent chromatogram and associated apex 
spectra. When this radio button is selected you must also select whether or not you wish 
to print All of the apex spectra, or just the apex spectra from known peaks, or to print the 
apex spectra for peaks that are above the set absorbance limit. 
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• Chromatogram tab page  -  This tab is enabled when a chromatogram pane is 
selected on a View page and the Selected Pane only radio button is selected on 
the General tab of the Print dialog.  

From the Chromatograms tab page you can select define whether or not you want 
the chromatograms to be printed as overlaid on one plot, stacked on one plot, or 
printed on separate plots.  You can also specify which label will be displayed on the 
printed chromatograms. 

 

The following options are available to you on the Chromatograms tab page: 

Curves - From this section you select how chromatograms will be displayed on the print-out. 

  As View - Prints an image of the chromatogram pane that is currently selected. 

  1 Overlaid - Prints the currently displayed chromatograms overlaid on one plot. 
 1 Stacked - Prints the currently displayed chromatograms stacked on one plot. 
 Separate Plots - Prints each chromatogram on a separate plot.  When this option is 

selected you the per page spin box is enabled; and from this spin box you must specify 
the number of plots that will be printed on each page. 

Labels - From this section you specify which label will be displayed on the printout. 

   
• As View - Prints the label currently displayed on the workspace for the selected 

chromatogram pane. 
• Specified - Enables a drop down menu from where you select a specific label for the 

printout. 

Spectra tab page -  This tab page is enabled when a spectra pane is selected on the View page 
and the Selected Pane only radio button is selected on the General tab of the Print dialog.  

From the Spectra tab page you can define the print layout for the spectra displayed in the 
currently selected pane.  You can select to print the currently displayed spectra overlaid on one 
plot, or stacked on one plot, or you can select to print separate plots for each currently 
displayed spectrum. 
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The following options are available to you on the Spectra tab page:  

• All Panes in View - Prints an image of the spectra pane that is currently selected. 

• 1 Overlaid - Prints the currently displayed spectra overlaid on one plot. 

• 1 Stacked - Prints the currently displayed spectra stacked on one plot. 

• Separate Plots - Prints each spectrum on a separate plot.  When this option is selected 
you the per page spin box is enabled; and from this spin box you must specify the 
number of plots that will be printed on each page. on a separate plot.  When this option is 
selected you the per page spin box is enabled; and from this spin box you must specify 
the number of plots that will be printed on each page. 

What information is included on the printouts? 

The first page of each print out provides you with the following information: 

• A title for the document being printed.   
This title is set by the software. 

• The complete source identification information for all displayed objects in the report.  
The first page(s) of the printout color coded list all of the chromatograms/spectra printed on 
the report, so that you can easily identify the source.  Please note that this information may 
be printed on more than one page. 

• A date and time stamp of the printing in the time zone where the printing occurred. 

• The User name and full name of the person generating the report, that is the person 
logged in to the software. 

• The page number in the form of Page X of N 

All subsequent pages include the title of the document being printed, the date and time 
stamp, the user name and full name of the person generating the report, and the page 
number in the form of Page X of N. 
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Apex Spectrum Plot Setup 

The Apex Spectrum Plot is a special report type for use with UV spectral data acquired from a 
Photo Diode Array (PDA) detector. This report, which must be based upon a Chromera Single 
Injection, Multi-Channel report format, will generate a chromatographic plot of the current 
injection, as well as a separate plot of the spectrum at the apex of each of the desired peaks 
from that chromatogram. These reports can be produced either manually, from the File Print 
command within Post Run or Graphic Method Edit, or automatically from a sequence in Run 
Time or Batch Reprocess. 

The selection to generate an Apex Spectrum Plot is made though the Plot Options of the 
Chromera Report Format Wizard, and the settings for which spectra to print are made 
through the Apex Spectrum Plot Setup dialog of the Spectral Processing Window (SPW), 
shown below.  These settings are then saved in the Spectral Operations section of the 
associated Chromera method. 

1. From the menu bar select File > Apex Spectrum Plot Setup… 
The Apex Spectrum Plot Setup dialog appears. 

 

2. Select one of the following options to indicate for which peaks Apex Spectra are to 
be printed: 

• Named Peaks Only - Select this option to print the apex spectra only for 
identified peaks. 

• Peaks with Absorbance Over - Select this option to print the apex spectra 
only for peaks that are above the absorbance limit that you enter in the box. By 
setting this threshold value to zero, the report will produce an apex spectrum 
plot for every detected peak in the chromatogram. 

3. Click OK when are finished. 

How  to Prepare for Printing an Apex Spectrum Plot Report  

NOTE: The following steps must be performed in the order described before preparing 
chromatograms to be annotated with apex spectra through the Plot Options of the Chromera 
Report Format Wizard's. This procedure presumes a PDA method has already been created 
to acquire or reprocess representative spectral data.  

1. First, prepare a method that will be used for automated printing of apex spectra.  
You can open an existing PDA method with representative data in the Chromera 
Graphic Method Editor (GME), or open previously acquired PDA spectral data in the 
Graphic Results Editor (GRE). 
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NOTE: A PDA method and associated data must be opened in either GME or GRE, and not through 
the basic Method Editor, in order to have access to the Spectral Processing Window, which is 
required to complete the method setup described below. 

2. Select a data Channel (e.g., 254:10:400:10) from the Peaks section of the Method. 

 

3. Select the option to Edit Spectral Operation Graphically from the Actions menu. 
(This command will be visible only from the Peaks or Operations section of the Method.  It 
will be hidden for all other method sections.) 
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This opens the Spectral Processing window in the Peak Purity Spectral Operation 
view, displaying the same chromatogram that is open in the Graphic Method Edit 
environment within Chromera, with the Peak Purity parameters being those shown in 
the Operations section of the method in GME. 

4. To view detailed information associated with the selected channel, right mouse click 
on the chromatogram in the Data tree and select Information from the popup 
menu that appears. 

   
An information dialog appears that shows Channel Information associated with the 
selected chromatogram.  When done viewing the information, click OK to close the 
dialog box. 

5. Make sure that the chromatogram that you just selected is still selected highlighted 
in the Data tree. 

6. From the menu bar select the item File > Apex Spectrum Plot Setup… 
The Apex Spectrum Plot Setup dialog appears. 

 

7. From the dialog, select one of the following options to indicate for which peaks Apex 
Spectra are to be printed: 

• Named Peaks Only - Select this option to print the apex spectra only for 
identified peaks. 

• Peaks with Absorbance Over - Select this option to print the apex spectra 
only for peaks that are above the absorbance limit that you enter in the box. By 
setting this threshold value to zero, the report will produce an apex spectrum 
plot for every detected peak in the chromatogram. 

8. Click OK when finished, and these settings will be transferred back to the Spectral 
Operations Section of the method open in GME, or they will be inserted into the 
embedded method for the chromatogram open in GRE. 
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Once the appropriate plot settings have been made through the Spectral Operations section, 
return to the Chromera application to complete the setup of the report to include the Apex 
Spectrum plots.  

9. In the main Chromera application, select Report Format Wizard from the Tools 
menu to create a new report format or modify an existing one to select the option of 
generating Apex Spectrum Plots. For this type of report, it is important to select 
Single Injection and Multiple channels For the report type. 

 

10. Continue in the Report Format Wizard to adjust the report layout as appropriate. 

11. In the Plot Options dialog, select the Apex Spectrum Plot check box. 

This is the only report option necessary for generating these plots. The actual 
spectra printed will depend upon the peak selection option set in the Spectral 
Operations section of the Chromera method. 

 

12. Complete the Report Format Wizard as desired, then move to the Finish dialog.  
Enter a Report Name and Group Name for the template, then click the Finish button.  

The modified report will now be available for producing Apex Spectrum Plots either 
manually, or from Run Time or Reprocess. 
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